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Chapter

Getting Started
Thank you for purchasing Bentley SewerGEMS V8i. At Bentley Systems, we pride 
ourselves in providing the very best engineering software available. Our goal is to 
make software that is easy to install and use, yet so powerful and intuitive that it antic-
ipates your needs without getting in your way.

When you first use Bentley SewerGEMS V8i, use the intuitive interface and interac-
tive dialog boxes to guide you. If you need more information, use the online help by 
pressing the F1 key or selecting Bentley SewerGEMS V8i Help from the Help menu. 
A help topic describing the area of the program in which you are working appears.

• “What is Bentley SewerGEMS V8i?” on page 1-1

What is Bentley SewerGEMS V8i?
Bentley SewerGEMS V8i is the first and only fully-dynamic, multi-platform (GIS, 
CAD, and Stand-Alone) sanitary and combined sewer modeling solution. With 
Bentley SewerGEMS V8i, you will analyze all sanitary and combined sewer system 
elements in one package and have the option of performing the analyses with the 
SWMM algorithm or our own implicit solution of the full Saint Venant equations.

Simply put, Bentley SewerGEMS V8i offers the most comprehensive solution avail-
able for optimizing Best Management Practice (BMP) designs and meeting sanitary 
sewer overflow (SSO) and combined sewer overflow (CSO) regulations.

With Bentley SewerGEMS V8i, you can:

• Develop system master plans

• Assess the impact of inflow and infiltration on SSOs

• Develop SSO and CSO remediation programs

• Perform system evaluations associated with US EPA CMOM and NPDES

• Optimize lift station and system storage capacities

• Determine developer connection fees
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Installation, Upgrades, and Updates
• Implement real-time control strategies

• Model relief sewers, overflow diversions, and inverted siphons

• Accurately simulate operations with variable-speed pumping and logical controls

• Simulate out-of-service or proposed sewers within the same model 

Related Topics

• “Documentation” on page 1-4

• “Quick Start Lessons” on page 1-5

• “Contacting Us” on page 1-6

• “About Haestad Methods” on page A-919

Installation, Upgrades, and Updates
For instructions on installing, registering, activating, and updating the software please 
refer to the Readme.pdf in the Program Files/Bentley/SewerGEMS V8i directory. 

Municipal License Administrator Auto-Configuration

At the conclusion of the installation process, the Municipal License Administrator will 
be executed, to automatically detect and set the default configuration for your product, 
if possible. However, if multiple license configurations are detected on the license 
server, you will need to select which one to use by default, each time the product 
starts. If this is the case, you will see the screen below. Simply press OK to clear the 
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Warning dialog, then press Refresh Configurations to display the list of available 
configurations. Select one and press Make Default, then exit the License Adminis-
trator. (You only need to repeat this step if you decide to make a different configura-
tion the default in the future.)

Software Updates via the Web and Bentley SELECT

Note: Your PC must be connected to the Internet to use the Check for 
Updates button.

Bentley SELECT is the comprehensive delivery and support subscription program 
that features product updates and upgrades via Web downloads, around-the-clock 
technical support, exclusive licensing options, discounts on training and consulting 
services, as well as technical information and support channels. It’s easy to stay up-to-
date with the latest advances in our software. Software updates can be downloaded 
from our Web site, and your version of Bentley SewerGEMS V8i can then be 
upgraded to the current version quickly and easily. Just click the Check for Updates 
button on the toolbar to launch your preferred Web browser and open our Web site. 
The Web site automatically checks to see if your installed version is the latest avail-
able, and if not, it provides you with the opportunity to download the correct upgrade 
to bring it up-to-date. You can also access our Knowledgebase for answers to your 
Frequently Asked Questions (FAQs). 

For more information, see “Technical Support” on page 1-6.
Bentley SewerGEMS V8i User’s Guide 1-3



Documentation
Troubleshooting

Because of the multitasking capabilities of Windows, you may have applications 
running in the background that make it difficult for software setup and installations to 
determine the configuration of your current system. If you have difficulties during the 
installation or uninstallation process, please try these steps before contacting our tech-
nical support staff:

1. Shut down and restart your computer.

2. Verify that there are no other programs running. You can see applications 
currently in use by pressing Ctrl+Shift+Esc in Windows 2000 and Windows XP. 
Exit any applications that are running.

3. Disable any antivirus software that you are running.

Caution: After you install Bentley SewerGEMS V8i, make certain that 
you restart any antivirus software you have disabled. Failure 
to restart your antivirus software leaves you exposed to 
potentially destructive computer viruses.

4. Try running the installation or uninstallation again (without running any other 
program first).

If these three steps fail to successfully install or uninstall the product, contact our 
Technical Support staff. For more information, see “Contacting Us” on page 1-6.

Documentation
Bentley SewerGEMS V8i documentation comes in three parts:

Online help: The online help is accessible from the Help menu or 
by pressing F1. Additionally, when you are using 
Bentley SewerGEMS V8i, you can call the online 
help at any time by clicking a help button in any 
dialog box or window.

The context-sensitive online help is designed to make 
it easy for you to quickly find specific information 
about a feature you are using in Bentley SewerGEMS 
V8i. The online help makes extensive use of 
hyperlinks and provides a table of contents, index, 
and keyword search to help you locate the 
information you need.
1-4 Bentley SewerGEMS V8i User’s Guide



Getting Started
Online PDF Book: The content in the online help is also available in .pdf 
format and is available at docs.bentley.com. This pdf 
contains the same content as the online help, but 
includes hypertext and is designed to be printed by 
you from a local printing device. As well as being 
more easily printable than the online help, the online 
book also uses hypertext and is searchable. 

Note: On-screen display of graphics in .pdf files is dependent on the 
zoom level you use. For more optimal viewing of graphics in 
Adobe® Acrobat® Reader, try using 167% and 208% zoom.

• “What is Bentley SewerGEMS V8i?” on page 1-1

Quick Start Lessons
The lessons quickly introduce you to specific features of Bentley SewerGEMS V8i. 
To access the lessons, select Quick Start Lessons from the Help menu. Run a lesson 
by selecting one of the entries in the list.

• “What is Bentley SewerGEMS V8i?” on page 1-1
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Contacting Us
Contacting Us
Contact Bentley Systems if you want product information, to upgrade your software, 
or need technical support.

• “What is Bentley SewerGEMS V8i?” on page 1-1

Sales

Bentley Systems, Inc.’ professional staff is ready to answer your questions. Please 
contact your sales representative for any questions regarding Bentley Systems, Inc.’ 
latest products and prices.

Toll-free U.S. Phone: 800-727-6555

Worldwide Phone: +1-203-755-1666

Fax: +1-203-597-1488

Email: sales@bentley.com 

Technical Support

We hope that everything runs smoothly and you never have a need for our technical 
support staff. However, if you do need support, our highly-skilled staff offers their 
services seven days a week, and may be contacted by phone, fax, email, and the 
Internet.

When calling for support, in order to assist our technicians in troubleshooting your 
problem, please be in front of your computer and have the following information 
available:

• Your computer’s operating system.

• Name and build number of the Bentley Systems, Inc. software you are calling 
about. The build number can be determined by clicking Help > About Bentley 
SewerGEMS V8i. The build number is the number in brackets located in the 
lower-left corner of the dialog box that opens.

• A note of exactly what you were doing when you encountered the problem.

• Any error messages or other information displayed on your screen.
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When emailing or faxing for support, please provide the following details, in addition 
to the above, to enable us to provide a more timely and accurate response:

• Company name, address, and phone number

• A detailed explanation of your concerns

• If you are emailing us, the Bentley SewerGEMS V8i.log files located in the 
product directory (e.g., C:\Documents and Settings\<User Name>\Local 
Settings\Application Data\Bentley\SewerGEMS V8i\8)

Support Hours

:Technical Support is available 24 hours a day, seven days a week.

You can contact our technical support team at:

Phone: +1-203-755-1666

Fax: +1-203-597-1488

Email: support@bentley.com 

Addresses

Use this address information to contact us:

Internet: http://www.bentley.com 

Email: support@bentley.com 

sales@bentley.com 

Toll-free U.S. Phone: 800-727-6555

Worldwide Phone: +1-203-755-1666

Fax: +1-203-597-1488

Mail: Bentley Systems, Inc., Incorporated

Haestad Methods Solutions Center

Suite 200W

37 Brookside Road

Watertown, CT 06795
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Contacting Us
Your Suggestions Count 

Bentley Systems, Inc. strives to continually provide you with sophisticated software 
and documentation. We are very interested in hearing your suggestions for improving 
the Bentley SewerGEMS V8i software, online help, and printed manual. Your feed-
back guides us in developing products that make your work easier.

Please let us hear from you!
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Chapter

Introducing the
Workspace
The Workspace
You use Bentley SewerGEMS V8i in one of these modes:

• “Stand-Alone Editor” on page 2-9

• “MicroStation Mode” on page 2-10

• “ArcGIS Mode” on page 2-11

• “AutoCAD Mode” on page 2-11

Stand-Alone Editor

The Stand-Alone Editor is the workspace that contains the various managers, toolbars, 
and menus, along with the drawing pane, that make up the Bentley SewerGEMS V8i 
interface. The Bentley SewerGEMS V8i interface uses dockable windows and tool-
bars, so the position of the various interface elements can be manually adjusted to suit 
your preference. 
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The Workspace
By default, the Bentley SewerGEMS V8i environment looks like this: 

MicroStation Mode

MicroStation mode lets you create and model your network directly within your 
primary drafting environment. This gives you access to all of MicroStation‘s drafting 
and presentation tools, while still enabling you to perform Bentley SewerGEMS V8i 
modeling tasks like editing, solving, and data management. This relationship between 
Bentley SewerGEMS V8i and MicroStation enables extremely detailed and accurate 
mapping of model features, and provides the full array of output and presentation 
features available in MicroStation. This facility provides the most flexibility and the 
highest degree of compatibility with other CAD-based applications and drawing data 
maintained at your organization.

Note: For more information about runnning Bentley SewerGEMS V8i in 
MicroStation mode, see “MicroStation Environment” on page 12-
700.
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ArcGIS Mode

ArcGIS mode lets you create and model your network directly in ArcMap. Each mode 
provides access to differing functionality—certain capabilities that are available 
within ArcGIS mode may not be available when working in the Bentley SewerGEMS 
V8i Stand-alone Editor. All the functionality available in the Stand-alone Editor are, 
however, available in ArcGIS mode. 

Note: For more information about running SewerGEMS V8i in ArcGIS 
mode, see “Working in ArcGIS Mode” on page 11-665.

AutoCAD Mode

AutoCAD mode lets you create and model your network directly within your primary 
drafting environment. This gives you access to all of AutoCAD’s drafting and presen-
tation tools, while still enabling you to perform Bentley SewerGEMS V8i modeling 
tasks like editing, solving, and data management. This relationship between Bentley 
SewerGEMS V8i and AutoCAD enables extremely detailed and accurate mapping of 
model features, and provides the full array of output and presentation features avail-
able in AutoCAD. This facility provides the most flexibility and the highest degree of 
compatibility with other CAD-based applications and drawing data maintained at your 
organization.

Note: For more information about runnning Bentley SewerGEMS V8i in 
AutoCAD mode, see “Working in AutoCAD Mode” on page 13-709.

Menus
Menus are located at the top of Bentley SewerGEMS V8i stand-alone editor window 
and provide access to program commands, which are broken down by type of func-
tionality. 

The following menus are available: 

• “File Menu” on page 2-12

• “Edit Menu” on page 2-15

• “Analysis Menu” on page 2-16

• “View Menu” on page 2-19

• “Tools Menu” on page 2-22

• “Report Menu” on page 2-24

• “Help Menu” on page 2-24
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Menus
File Menu

The File menu contains the following commands:

New Creates a new project. When you select this 
command, a new untitled project is created.

Open Opens an existing project. When you select this 
command, the Open dialog box appears, allowing 
you to browse to the project to be opened.

Close Closes the current project without exiting the 
program.

Close All Closes all currently open projects.

Save Saves the current project.

Save As Saves the current project under a new project name 
and/or to a different directory location.

Save All Saves all currently open projects.
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ProjectWise Opens a submenu containing the following 
commands:

• Open—Open an existing SewerGEMS V8i 
project from ProjectWise. You are prompted to 
log into a ProjectWise datasource if you are not 
already logged in.

Note: Only projects that were 
originally saved into 
ProjectWise from the 
SewerGEMS V8i application can 
be opened

• Save As—Saves the current project to a 
ProjectWise datasource. You are prompted to 
log into a ProjectWise datasource if you are not 
already logged in.

• Change Datasource—Lets you connect to a 
different ProjectWise datasource for future 
Open and Save As operations.

• Import—Lets you import the following file types 
into the ProjectWise project:

• SWMM v5—Opens a Windows Browse 
dialog box, allowing you to choose the 
SWMM v5 file to import.

• Bentley SewerGEMS V8i Database—Lets 
you import a Bentley SewerGEMS V8i 
project database file.

• SewerCAD Exchange Database—Lets 
you import a SewerCAD Exchange Data-
base file (.swr.mdb file).

• StormCAD Exchange Database—Lets 
you import a StormCAD Exchange Data-
base file (.stm.mdb file).

Note: For more information about 
using SewerGEMS V8i with 
ProjectWise, see “Considerations 
for ProjectWise Users” on page 4-
158
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Import Opens a submenu containing the following 
commands:

• SWMM v5—Opens a Windows Browse dialog 
box, allowing you to choose the SWMM v5 file 
to import.

• Bentley SewerGEMS V8i Database—Lets you 
import a Bentley SewerGEMS V8i project data-
base file.

• SewerCAD Exchange Database—Lets you 
import a SewerCAD Exchange Database file 
(.swr.mdb file).

• StormCAD Exchange Database—Lets you 
import a StormCAD Exchange Database file 
(.stm.mdb file).

• Bentley Wastewater Import—Lets you import 
a an model .mdb and geometry data file (.dat) 
that was previously exported from Bentley 
Wastewater application.

Export Opens a submenu containing the following 
commands:

• DXF—Lets you export the current network 
layout as a DXF drawing.

• SWMM v5—Lets you export the current project 
to SWMM format.

Print Setup Defines the print settings that will be used when the 
current view is printed.

Print Preview Opens the Print Preview window, displaying the 
current view exactly as it will be printed.

Print Prints the current view.

Recent Files When the Recent Files Visible option is selected in 
the Options dialog box, the most recently opened 
files will appear in the File menu. See “Options 
Dialog Box - Global Tab” on page 4-147 for more 
information.

Exit Closes the program.
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Edit Menu

The Edit menu contains the following commands:

Undo Cancels the last data input action on the currently 
active dialog box. Clicking Undo again cancels 
the second-to-last data input action, and so on. 

Redo Cancels the last undo command.

Delete Deletes the currently highlighted element.

Select By Polygon Lets you select elements in your model by 
drawing a polygon in the drawing pane. Click in 
the drawing pane to draw each side of the 
polygon. After the polygon has been drawn, right-
click to select from the following options:
• As Selected - All elements contained within 

the polygon will be selected. Elements that 
were selected before the Select By Polygon 
opperation will be de-selected.

• Add to Selection - All elements contained 
within the polygon will be selected in addition 
to any elements that were selected before the 
Select By Polygon operation were performed.

• Invert Selection - All elements contained 
within the polygon that were selected before 
the operation will be de-selected; all elements 
contained within the polygon that were not 
selected before the operation will be selected

• Remove From Selection - All elements 
contained within the polygon that were 
selected before the operation will be de-
selected.

Select All Selects all of the elements in the network.

Invert Selection Selects all currently unselected elements and 
deselects all currently selected ones.

Select by Element Opens a submenu listing all available element 
types. Select one of the element types from the 
submenu to select all elements of that type in the 
model.
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Analysis Menu

The Analysis menu contains the following commands:

Select by Attribute Opens a menu listing all available attribute types. 
Select one of the attribute types from the menu 
and the Query Builder dialog box opens.

Clear Selection Deselects the currently selected element(s).

Clear Highlight Removes Network Navigator highlighting for all 
elements.

Find Element Lets you find a specific element by entering the 
element’s label.

Scenarios Opens the Scenario Manager, which lets you 
create, view, and manage project scenarios.

Alternatives Opens the Alternative Manager, which lets you 
create, view, and manage alternatives.

Calculation Options Opens the Calculation Options Manager, which 
lets you create, view, and manage calculation 
settings for the project.

EPS Results Browser Opens the EPS Results Browser dialog box, which 
lets you manipulate the currently displayed time 
step and to animate the drawing pane.

Calculation Summary Opens the calculation summary report, which 
reports the details of the calculations performed 
on your model.

User Notifications Opens the User Notifications Manager, allowing 
you to view warnings and errors uncovered by the 
validation process.
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Components Menu

The Components menu contains the following commands:

Validate Runs a diagnostic check on the network data to 
alert you to possible problems that may be 
encountered during calculation. This is the manual 
validation command, and it checks for input data 
errors. It differs in this respect from the automatic 
validation that SewerGEMS V8i runs when the 
compute command is initiated, which checks for 
network connectivity errors as well as many other 
things beyond what the manual validation checks. 
Pressing CTRL+F7 also selects this command.

Compute Hydrology Lets you perform the hydrologic calculations for 
the current scenario. Pressing CTRL+F8 also 
selects this command.

Compute Calculates the network. Before calculating, an 
automatic validation routine is triggered, which 
checks the model for network connectivity errors 
and performs other validation. For more 
information, see “Calculating Your Model” on 
page 8-431. Pressing F9 also selects this 
command.

Always Compute 
Hydrology

Lets you turn hydrology calculations on and off 
whenever the model is calculated. Turning 
hydrology computation off improves performance 
and is recommended when the hydrology input 
will not change.

Storm Events Opens the Storm Events dialog box, which lets 
you create, edit, and delete storm events. These 
storms are available for you to select for a 
catchment. For more information, see “Adding 
Storm Events” on page 7-395.

Global Storm Events Opens the Global Storm Event Settings dialog 
box, which lets you define project-wide global 
storm event data. For more information, see 
“Adding Global Storm Events” on page 7-405.
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Dimensionless Unit 
Hydrographs

Opens the Dimensionless Unit Hydrographs 
dialog box, Which lets you create, edit, and delete 
dimensionless unit hydrographs.

RTK Tables Opens the RTK Tables dialog box, which lets you 
create wet weather flow hydrographs using the 
RTK method. For more information, see “Adding 
Hydrographs Based On the RTK Method” on 
page 7-415.

Pipe Catalog Opens the Catalog Pipe dialog box, which lets you 
create, edit, and view catalog pipes. Catalog pipes 
are an efficient way to reuse common physical 
pipe definitions. For more information, see “Pipe 
Catalog Dialog Box” on page 6-291.

Pump Curve 
Definitions

Opens the Pump Curve Definitions dialog box, 
which lets you view, edit, and create pump curve 
definitions. For more information, see “Pump 
Curve Definitions Dialog Box” on page 6-233.

SWMM Extensions Opens a submenu containing the following 
SWMM-specific commands: 

• Evaporation—Opens the Evaporation dialog 
box, allowing you to view and edit evaporation 
data for use in SWMM calculations. 

• Aquifers—Opens the Aquifers dialog box, 
allowing you to view and edit aquifer data for 
use in SWMM calculations. 

• Control Sets—Opens the Control Sets dialog 
box, allowing you to view, edit, and create 
control sets for use in SWMM calculations. 

• Pollutants—Opens the Pollutants dialog box, 
allowing you to view and edit pollutant data for 
use in SWMM calculations. 

• Pollutographs—Opens the Pollutograph 
dialog box, allowing you to view and edit pollu-
tograph data for use in SWMM calculations.

• Land Uses—Opens the Land Use dialog box, 
allowing you to view and edit land use data for 
use in SWMM calculations.

For more information, see “Using the SWMM 
Water Quality Solver” on page 6-294.
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View Menu

The View menu contains the following commands:

Time Series Field 
Data

Opens the Time Series Field Data dialog, which 
allows you to define time series field data for the 
elements in the model.

Unit Sanitary (Dry 
Weather) Loads

Opens the Unit Sanitary (Dry Weather) Loads 
dialog box, which lets you create, edit, and delete 
unit sanitary loads. For more information, see 
“Adding Unit Sanitary (Dry Weather) Loads” on 
page 7-370.

Patterns Opens the Pattern Manager where you can create 
and edit diurnal loading patterns for use with 
extended period simulations. For more 
information, see “Defining Patterns” on page 7-
362.

Pattern Setups Opens the Pattern Setup Manager where you can 
associate diurnal patterns with the appropriate unit 
sanitary loads for a given scenario. For more 
information, see “Defining Pattern Setups” on 
page 7-365.

Engineering Libraries Opens the Engineering Libraries Manager.

Element Symbology Opens the Element Symbology Manager, which 
lets you create, view, and manage annotation and 
color-coding in your project.

Background Layers Opens the Background Layers Manager, which 
lets you create, view, and manage the background 
layers associated with the project.

Network Navigator Opens the Network Navigator.

Selection Sets Opens the Selection Sets Manager, which lets you 
create, view, and manage selection sets associated 
with the project.
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Queries Opens the Query Manager, which lets you create 
SQL expressions for use with selection sets and 
FlexTables. For more information, see 

Prototypes Opens the Prototypes Manager, which lets you 
enter default values for elements in your model. 
Prototypes can reduce data entry requirements 
dramatically if a group of network elements share 
common data. For more information, see 

FlexTables Opens the FlexTables Manager, which lets you 
create, view, and manage the tabular reports for 
the project.

Graphs Opens the Graph Manager, which lets you create, 
view, and manage graphs for the project.

Profiles Opens the Profile Manager, which lets you create, 
view, and manage the profiles for the project.

Contours Opens the Contours manager where you can create 
and edit contour definitions.

Named Views Opens the Named Views manager where you can 
create, edit, and use Named Views.

Aerial View Opens the Aerial View navigation window.

Properties Turns the Properties Editor display on or off.

Auto-Refresh Turns automatic updates to the main window view 
on or off whenever changes are made to the 
Bentley SewerGEMS V8i datastore. When 
selected, a check mark appears next to this menu 
command, indicating that automatic updates are 
turned on.

Refresh Drawing Updates the main window view according to the 
latest information contained in the Bentley 
SewerGEMS V8i datastore.
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Zoom Opens a submenu containing the following 
commands:

• Zoom Extents—Sets the view so that the 
entire network is visible in the drawing pane.

• Zoom Window—Activates the manual zoom 
tool, which lets you specify a portion of the 
drawing to enlarge.

• Zoom In—Enlarges the size of the model in 
the drawing pane.

• Zoom Out—Reduces the size of the model in 
the drawing pane.

• Zoom Realtime—Enables the realtime zoom 
tool, which lets you zoom in and out by 
moving the mouse while holding down the left 
mouse button.

• Zoom Center—Opens the Zoom Center 
dialog box, which lets you enter drawing coor-
dinates that will be centered in the drawing 
pane.

• Zoom Previous—Resets the zoom level to 
the last setting.

• Zoom Next—Resets the zoom level to the 
setting that was active before a Zoom 
Previous command was executed.

Pan Activates the Pan tool, which lets you move the 
model within the drawing pane. When you select 
this command, the cursor changes to a hand, 
indicating that you can click and hold the left 
mouse button and move the mouse to move the 
drawing.

Toolbars Opens a submenu that lists each of the available 
toolbars. Select one of the toolbars in the submenu 
to turn that toolbar on or off. For more 
information, see “Toolbars” on page 2-25.

Reset Workspace Resets the Bentley SewerGEMS V8i workspace 
so that the dockable managers appear in their 
default factory-set positions.
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Tools Menu

The Tools menu contains the following commands:

Active Topology 
Selection

Opens a Select dialog to select elements in the 
drawing to make them Inactive or Active.

LoadBuilder Opens the LoadBuilder manager where you can assign 
demands to model nodes using data from outside 
sources.

Hyperlinks Lets you associate external files, such as pictures or 
movie files, with elements. For more information, see 
“Adding Hyperlinks to Elements” on page 6-324.

ModelBuilder Opens the ModelBuilder Connections Manager, which 
lets you create, edit, and manage ModelBuilder 
connections to be used in the model-building/model-
synchronizing process. For more information, see 
“ModelBuilder Connections Manager” on page 5-173.

User Data Extensions User Data Extensions—Opens the User Data 
Extension dialog box, which lets you add and define 
custom data fields. For example, you can add new 
fields such as the pipe installation date. For more 
information, see “User Data Extensions” on page 6-
335.

Inflow Control Center Opens the Inflow Control Center, allowing you to 
create, edit, and delete sanitary inflow definitions.

Sanitary Load Control 
Center

Opens the Sanitary Load Control Center, allowing you 
to create, edit, and delete sanitary load definitions.
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Database Utilities Opens a submenu containing the following 
commands:

• Compact Database—When you delete data from 
a Bentley SewerGEMS V8i project, such as 
elements or alternatives, the database store that 
Bentley SewerGEMS V8i uses can become frag-
mented, causing unnecessarily large data files, 
which impact performance substantially. 
Compacting the database eliminates the empty 
data records, thereby defragmenting the datastore 
and improving the performance of the file.

Note: Every tenth time a file is saved, 
Bentley SewerGEMS V8i will 
automatically prompt you to 
compact the database. If you open 
a file without saving it, the count 
does not go up. If you open and 
save a file multiple times in the 
same session, the count only goes 
up on the first save. If you open, 
save, and close the file, the count 
goes up. Click Yes to compact the 
database, or no to close the prompt 
dialog box without compacting. 
Since compacting the database can 
take time, especially for larger 
models, you may want to postpone 
the compact procedure until a later 
time. You can modify how Bentley 
SewerGEMS V8i compacts the 
database in the Options dialog box. 
For more information, see “Options 
Dialog Box - Global Tab” on page 4-
147.

• Synchronize Drawing—Synchronizes the current 
model drawing with the project database.

Layout Opens a submenu that lists each of the available 
element types. Select one of the element types in the 
submenu to place that element in your model.

External Tools Run an existing external tool or create a new one by 
opening up the External Tools manager.
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Report Menu

The Report menu contains the following commands:

Help Menu

The Help menu contains the following commands:

Options Opens the Options dialog box, which lets you change 
global settings such as display pane settings, drawing 
scale, units, display precision and format used, and 
element labeling.

Element Tables Opens a submenu that lets you display FlexTables 
for any link or node element. These predefined 
FlexTables contain most of the input data and 
results for each instance of the selected element in 
the model.

Scenario Summary Opens the Scenario Summary Report.

Calculation Executive 
Summary

Opens the calculation executive summary report, 
which reports a summary of the calculations 
performed on your model. For more 
information, see “Calculation Executive Summary 
Dialog Box” on page 8-439.

Project Inventory Opens the Project Inventory Report, which 
contains the number of each of the various 
element types that are in the network.

Report Options Opens the Report Options box where you can set 
Headers and Footers for the predefined reports.

Bentley SewerGEMS 
V8i Help

Opens the online help Table of Contents.

Quick Start Lessons Opens the online help to the Quick Start Lessons 
Overview topic.

Welcome Dialog Opens the Welcome dialog box.
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Toolbars
Toolbars provide access to frequently used menu commands and are organized by the 
type of functionality offered. Many of the toolbars have additional buttons available 
that are not displayed by default. You can display these additional buttons by 
following the procedure in “Adding and Removing Toolbar Buttons” on page 2-38.

The following toolbars are available:

• “File Toolbar” on page 2-26

• “Edit Toolbar” on page 2-27

• “Analysis Toolbar” on page 2-27

• “Scenarios Toolbar” on page 2-29

• “Compute Toolbar” on page 2-30

• “View Toolbar” on page 2-31

• “Help Toolbar” on page 2-32

Check for Updates Opens your Web browser to the our Web site, 
allowing you to check for Bentley SewerGEMS 
V8i updates.

Bentley Institute 
Training

Opens your browser to the Bentley Institute 
Training web site.

Bentley Professional 
Services

Opens your browser to the Bentley Professional 
Services web site.

Online Support Opens your browser to SELECTservices area of 
the Bentley web site.

Discussion Groups Opens your browser to Bentley’s Haestad 
Discussion Groups.

Haestad.com Opens to the Haestad page on the Bentley web 
site.

Bentley.com Opens the home page on the Bentley web site.

About Bentley 
SewerGEMS V8i

Opens the About Bentley SewerGEMS V8i dialog 
box, which displays copyright information about 
the product, registration information, and the 
current version number of this release.
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• “Layout Toolbar” on page 2-33

• “Zoom Toolbar” on page 2-36

File Toolbar

The File toolbar contains the following buttons:

New Creates a new Bentley SewerGEMS V8i project. 
When you select this command, the Select File to 
Create dialog box appears, allowing you to 
define a name and directory location for the new 
project.

Open Opens an existing Bentley SewerGEMS V8i 
project. When this command is initialized, the 
Select Bentley SewerGEMS V8i Project to Open 
dialog box appears, allowing you to browse to the 
project to be opened.

Save Saves the current project.

Print Preview Opens the Print Preview window, displaying the 
current view exactly as it will be printed.

Print Prints the current view of the network as 
displayed in the drawing pane.
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Edit Toolbar

The Edit toolbar contains the following buttons:

Analysis Toolbar

The Analysis toolbar contains the following buttons:

Undo Cancels your most recent action.

Redo Lets you redo the last cancelled action.

Find Element Lets you find a specific element by choosing it 
from a menu containing all elements in the 
current model.

Storm Events Opens the Storm Events dialog box, which lets 
you create, edit, and delete storm events.

Global Storm 
Event

Opens the Global Storm Event Settings dialog 
box, which lets you define project-wide global 
storm event data.

RTK Tables Opens the RTK Tables dialog box, which lets 
you create wet weather flow hydrographs using 
the RTK method.

Pipe Catalog Opens the Catalog Pipe dialog box, which lets 
you create, edit, and view catalog pipes. Catalog 
pipes are an efficient way to reuse common 
physical pipe definitions.
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Pump Curve 
Definitions

Opens the Pump Curve Definitions dialog box, 
which lets you view, edit, and create pump curve 
definitions.

Patterns Opens the Pattern Manager where you can 
create and edit diurnal loading patterns for use 
with extended period simulations. 

Unit Sanitary 
(Dry Weather) 
Loads

Opens the Unit Sanitary (Dry Weather) Loads 
dialog box, which lets you create, edit, and 
delete unit sanitary loads.

Pattern Setups Opens the Pattern Setup Manager where you can 
associate diurnal patterns with the appropriate 
unit sanitary loads for a given scenario. This 
button does not appear in the toolbar by default, 
but can be added. For more information, see 
“Adding and Removing Toolbar Buttons” on 
page 2-38.
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Scenarios Toolbar

The Scenario toolbar contains the following buttons:

Scenario List 
Box

Lets you quickly change the current scenario.

Scenarios Opens the Scenario manager, which lets you 
create, view, and manage project scenarios.

Alternatives Opens the Alternative manager, which lets you 
create, view, and manage project alternatives.

Calculation 
Options

Opens the Calculation Options manager, which 
lets you create different profiles for different 
calculation settings.
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Compute Toolbar

The Compute toolbar contains the following buttons:

Validate Runs a diagnostic check on the network data to 
alert you to possible problems that may be 
encountered during calculation. This is the 
manual validation command, and it checks for 
input data errors. It differs in this respect from 
the automatic validation that SewerGEMS V8i 
runs when the compute command is initiated, 
which checks for network connectivity errors as 
well as many other things beyond what the 
manual validation checks.

Compute 
Hydrology

Performs hydrology calculations.

Compute Calculates the network. Before calculating, an 
automatic validation routine is triggered, which 
checks the model for network connectivity 
errors and performs other validation. For more 
information, see “Calculating Your Model” on 
page 8-431.

User 
Notifications

Opens the User Notifications Manager, allowing 
you to view warnings and errors uncovered by 
the validation process. This button does not 
appear in the toolbar by default, but can be 
added. For more information, see “Adding and 
Removing Toolbar Buttons” on page 2-38.
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View Toolbar

The View toolbar contains the following buttons, which give you easy access to many 
of the managers in Bentley SewerGEMS V8i.:

Element 
Symbology

Opens the Element Symbology manager, 
allowing you to create, view, and manage the 
element symbol settings for the project.

Background 
Layers

Opens the Background Layers manager, 
allowing you to create, view, and manage the 
background layers associated with the project.

Selection Sets Opens the Selection Sets Manager, allowing you 
to create, view, and modify the selection sets 
associated with the project.

Network 
Navigator

Opens the Network Navigator dialog box.

Queries Opens and closes the Query Manager.

Prototypes Opens and closes the Prototypes Manager.

FlexTables Opens the FlexTables manager, allowing you to 
create, view, and manage the tabular reports for 
the project.
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Help Toolbar

The Help toolbar provides quick access to the same commands that are available in 
the Help menu. The Help toolbar contains the following buttons.

Graphs Opens the Graph manager, allowing you to 
create, view, and manage the graphs for the 
project. 

Profiles Opens the Profile manager, allowing you to 
create, view, and manage the profiles for the 
project.

Properties Opens and closes the Property Editor.

EPS Results 
Browser

Opens the EPS Results Browser manager, 
allowing you to manipulate the currently 
displayed time step and to animate the drawing 
pane.

Help Opens the Bentley SewerGEMS V8i online 
help.

Check for 
Updates

Opens your Web browser to our Web site, 
allowing you to check for Bentley SewerGEMS 
V8i updates.

Support Opens your Web browser to the Support Center 
of the Haestad Methods' Web site.
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Layout Toolbar

You use the Layout toolbar to lay out your model in the drawing pane. The Layout 
toolbar contains the following buttons:

Select Changes your mouse cursor into a selection 
tool. The selection tool behavior varies 
depending on the direction in which the mouse 
is dragged after defining the first corner of the 
selection box, as follows:
If the selection is made from left-to-right, all 
elements that fall completely within the 
selection box that is defined will be selected.
If the selection is made from right-to-left, all 
elements that fall completely within the 
selection box and that cross one or more of the 
lines of the selection box will be selected.
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Layout Changes your mouse cursor into a network 
layout tool. Right-click to change the type of 
element and the type of link.

• Pressure Pipe—Lets you place an 
element through which water moves under 
pressure. Pressure pipes typically 
discharge from a pumping station located 
upstream in the sewer collection system.

• Conduit—Lets you place a closed section 
element through which water moves. A 
conduit has a constant roughness and 
cross section shape along its entire length. 
Available conduit shapes consist of both 
open and closed cross sections.

• Channel—Lets you place an open-section 
element through which water moves. The 
shape of the channel is defined by the 
cross-section at one or both ends, so a 
channel does not have a constant rough-
ness or cross section shape, because 
these attributes are interpolated along the 
length of the channel according to the 
respective values defined at the adjacent 
cross section nodes.

• Gutter—Lets you place an open-section 
element that models overflow. A gutter 
accepts the inflows that are not being taken 
in by an inlet because of capacity 
constraints. In addition, a gutter also takes 
in the overflow from an inlet due to 
flooding. There can only be one gutter 
downstream of any element and the gutter 
cannot be the only way water can leave an 
element, there must also be a channel or a 
conduit. Gutters are only used for routing; 
no dynamic calculations are performed for 
gutter elements.

Catch Basin Changes your mouse cursor into a catch basin 
element symbol. Clicking the left mouse button 
while this tool is active causes a catch basin 
element to be placed at the location of the 
mouse cursor.
2-34 Bentley SewerGEMS V8i User’s Guide



Introducing the Workspace
Manhole Changes your mouse cursor into a manhole 
element symbol. Clicking the left mouse button 
while this tool is active causes a manhole 
element to be placed at the location of the 
mouse cursor.

Cross Section 
Node

Changes your mouse cursor into a cross section 
node element symbol. Clicking the left mouse 
button while this tool is active causes a cross 
section element to be placed at the location of 
the mouse cursor.

Junction 
Chamber

Changes your mouse cursor into a junction 
chamber element symbol. Clicking the left 
mouse button while this tool is active causes a 
junction chamber element to be placed at the 
location of the mouse cursor.

Pressure 
Junction

Changes your mouse cursor into a pressure 
junction element symbol. Clicking the left 
mouse button while this tool is active causes a 
pressure junction element to be placed at the 
location of the mouse cursor.

Pond Outlet 
Structure

Changes your mouse cursor into a pond outlet 
structure element symbol. Clicking the left 
mouse button while this tool is active causes a 
pond outlet structure element to be placed at 
the location of the mouse cursor.

Outfall Changes your mouse cursor into an outfall 
element symbol. Clicking the left mouse button 
while this tool is active causes an outfall 
element to be placed at the location of the 
mouse cursor.

Wet Well Changes your mouse cursor into a wet well 
element symbol. Clicking the left mouse button 
while this tool is active causes a wet well 
element to be placed at the location of the 
mouse cursor.

Pump Changes your mouse cursor into a pump 
element symbol. Clicking the left mouse button 
while this tool is active causes a pump element 
to be placed at the location of the mouse cursor.

Catchment Changes your mouse cursor into a catchment 
element symbol. When this tool is active, click 
in the drawing pane to begin drawing a polygon 
that represents the catchment.
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Zoom Toolbar

The Zoom toolbar provides access to the zooming and panning tools. It contains the 
following buttons:

Pond Changes your mouse cursor into a pond 
element symbol. When this tool is active, click 
in the drawing pane to begin drawing a polygon 
that represents the pond.

Border Changes your mouse cursor into a border 
symbol. When the border tool is active, you can 
draw a simple box in the drawing pane using 
the mouse. For example, you might want to 
draw a border around the entire model.

Text Changes your mouse cursor into a text symbol. 
When the text tool is active, you can add 
simple text to your model. Click anywhere in 
the drawing pane to display the Text Editor 
dialog box, which lets you enter text to be 
displayed in your model.

Line Changes your mouse cursor into a line symbol. 
When this tool is active, you can draw lines and 
polygons in your model using the mouse. 

Zoom Extents Sets the view so that the entire model is visible in 
the drawing pane.

Zoom In Magnifies the current view in the drawing pane.

Zoom Out Reduces the current view in the drawing pane.

Zoom 
Realtime

Enables the realtime zoom tool, which lets you 
zoom in and out by moving the mouse while the 
left mouse button is depressed.
2-36 Bentley SewerGEMS V8i User’s Guide



Introducing the Workspace
Zoom Center Opens the Zoom Center dialog box, which lets 
you enter drawing coordinates that are centered in 
the drawing pane.

Zoom Previous Returns the zoom level to the most recent 
previous setting.

Pan Activates the Pan tool, which lets you move the 
model within the drawing pane. When you select 
this command, the cursor changes to a hand, 
indicating that you can click and hold the left 
mouse button and move the mouse to move the 
drawing.

Refresh 
Drawing

Updates the main window view according to the 
latest information contained in the Bentley 
SewerGEMS V8i datastore.
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Customizing the Toolbars
You can customize Bentley SewerGEMS V8i toolbars in any of the following ways:

• “Adding and Removing Toolbar Buttons” on page 2-38

• “Controlling Toolbars” on page 2-38

Adding and Removing Toolbar Buttons

Toolbar buttons represent Bentley SewerGEMS V8i menu commands. You can 
remove buttons from any toolbar, and add commands to any toolbar on the Commands 
tab of the Customize dialog box.

To add or remove a button from a toolbar:

1. Click the down arrow on the end of the toolbar you want to customize. A series of 
submenus appear, allowing you to select or deselect any button in that toolbar.

2. Click Add or Remove Buttons then move the mouse cursor to the right until all 
of the submenus appear, as shown in the following figure:

3. Click the space to left of the toolbar button you want to add. A check mark 
appears in the submenu and the button appears in the toolbar.

or

Click the check mark next to the toolbar button you want to remove. The button 
will no longer appear in the toolbar.

Controlling Toolbars

You can control toolbars in Bentley SewerGEMS V8i on the Toolbars tab of the 
Customize dialog box. You can turn toolbars on and off, or move the toolbar to a 
different location in the workspace.
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To turn toolbars off:

Click View > Toolbars, then click the check mark next to the toolbar you want to turn 
off.

To turn toolbars on:

Click View > Toolbars, then click in the space to the left of the toolbar you want to 
turn on.

To move a toolbar to a different location in the workspace:

Move your mouse to the vertical dotted line on the left side of any toolbar, then drag 
the toolbar to the desired location. If you move a toolbar away from the other toolbar, 
the toolbar becomes a floating dialog box.

Dynamic Manager Display
You access most of the features in Bentley SewerGEMS V8i through a system of 
dynamic windows called managers. For example, the look of the elements is 
controlled in the Element Symbology manager while animation is controlled in 
the EPS Results Browser manager.

When you first start Bentley SewerGEMS V8i, only two managers are displayed: the 
Element Symbology and Background Layers managers. This is the default workspace. 
You can display as many managers as you want and move them to any location in the 
Bentley SewerGEMS V8i workspace.

To return to the default workspace:

Click View > Reset Workspace.

• If you return to the default workspace, the next time you start Bentley Sewer-
GEMS V8i, you will lose any customizations you might have made to the 
dynamic manager display.

Opening Managers

To open a manager:

1. Do one of the following:

– Select the desired manager from the View menu.
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– Click a manager’s button on one of the toolbars.

– Press the keyboard shortcut for the desired manager.

2. If the manager is not already docked, you can drag it to the top, left- or right-side, 
or bottom of the SewerGEMS V8i window to dock it. For more information on 
docking managers, see “Customizing Managers” on page 2-42.

Bentley SewerGEMS V8i Managers

The following table lists all the Bentley SewerGEMS V8i managers, their toolbar 
buttons, and keyboard shortcuts.

Toolbar 
Button Manager

Keyboard 
Shortcut

Scenarios—lets you build a model run 
from alternatives. For more information, 
see “Scenario Manager” on page 9-469.

ALT+1

Alternatives—lets you create and manage 
alternatives. For more information, see 
“Alternative Manager” on page 9-473.

ALT+2

Calculation Options—lets you set 
parameters for the numerical engine. For 
more information, see “Calculation Options 
Manager” on page 8-431.

ALT+3

Element Symbology—controls how 
elements look and what attributes are 
displayed. For more information, see 
“Element Symbology Manager” on 
page 10-538.

CTRL+1

Background Layers—lets you control the 
display of background layers. For more 
information, see “Background Layer 
Manager” on page 10-529.

CTRL+2

Selection Sets—lets you create and 
manage selection sets. For more 
information, see “Selection Sets Manager” 
on page 6-274.

CTRL+3

Network Navigator—helps you find nodes 
in your model. For more information, see 
“Using the Network Navigator” on page 6-
281.

CTRL+4
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Queries—lets you create SQL expressions 
for use with selection sets and FlexTables 
For more information, see “Using Queries” 
on page 6-327.

CTRL+5

Prototypes—lets you create and manage 
prototypes. For more information, see 
“Using Prototypes” on page 6-285.

CTRL+6

FlexTables—lets you display and edit 
tables of elements. For more information, 
see “FlexTables Manager” on page 10-
557.

CTRL+7

Graphs—lets you create and manage 
graphs. For more information, see “Graph 
Manager” on page 10-577.

CTRL+8

Profiles —lets you draw profiles of parts of 
your network. For more information, see 
“Profiles Manager” on page 10-549.

CTRL+9

Property Editor—displays properties of 
individual elements or managers. For more 
information, see “Property Editor” on 
page 6-265.

F4

EPS Results Browser—controls animated 
displays. For more information, see 
“Animating Profiles” on page 10-550.

F7

User Notifications—presents error and 
warning messages resulting from a 
calculation.

Note: Although the toolbar 
button for this manager 
does not appear by 
default, you can add it to 
the Compute toolbar.

F8

Toolbar 
Button Manager

Keyboard 
Shortcut
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Customizing Managers

When you first start Bentley SewerGEMS V8i, you will see the default workspace, in 
which a limited set of dockable managers are visible. You can decide which managers 
will be displayed at any time and where they will be displayed. You can also return to 
the default workspace any time.

There are four states for each manager: 

Floating—A floating manager sits above the Bentley SewerGEMS V8i workspace 
like a dialog box. You can drag a floating manager anywhere and continue to work. 

You can also:

• Resize a floating manager by dragging its edges. 

• Close a floating manager by clicking on the x in the top right-hand corner of the 
title bar. 

• Change the properties of the manager by right-clicking on the title bar.

• Switch between multiple floating managers in the same location by clicking the 
manager’s tab.

• Dock the manager by double-clicking the title bar.

Docked static—A docked static manager attaches to any of the four sides of the 
Bentley SewerGEMS V8i window. If you drag a floating manager to any of the four 
sides of the Bentley SewerGEMS V8i window, the manager will attach or dock itself 
to that side of the window. The manager will stay in that location unless you close it or 
make it dynamic. A vertical pushpin in the manager’s title bar indicates its static state; 
click the pushpin to change the manager’s state to dynamic. When the push pin is 
pointing downward (vertical push pin), the manager is docked. 

You can also:

• Close a docked manager by left clicking on the x in the upper right corner of the 
title bar. 

• Change a docked manager into a floating manager by double-clicking the title bar, 
or by dragging the manager to the desired location (for example, away from the 
side of the Bentley SewerGEMS V8i window).

• Change a static docked manager into a dynamically docked manager by clicking 
the push pin in the title bar.

• Switch between multiple docked managers in the same location by clicking the 
manager’s tab.
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Docked dynamic—A docked dynamic manager also docks to any of the four sides of 
the Bentley SewerGEMS V8i window, but remains hidden except for a single tab. 
Show a docked dynamic manager by moving the mouse over the tab, or by clicking 
the tab. When the manager is showing (not hidden), a horizontal pushpin in its title bar 
indicates its dynamic state. 

You can also:

• Close a docked manager by left clicking on the x in the upper right corner of the 
title bar. 

• Change a docked dynamic manager into a docked static manager by clicking the 
push pin (converting it from vertical to horizontal). 

• Switch between multiple docked managers in the same location by moving the 
mouse over the manager’s tab or by clicking the manager’s tab.

Closed—When a manager is closed, you cannot view it. Close a manager by clicking 
the x in the right corner of the manager’s title bar. Open a manager by selecting the 
manager from the View menu (for example, View > Element Symbology), or by 
selecting the button for that manager on the appropriate toolbar.

Using Named Views
The Named View dialog box is where you can store the current views X and Y coordi-
nates. When you set a view in the drawing pane and add a named view, the current 
view is saved as the named view. You can then center the drawing pane on the named 
view with the Go To View command. 

Choose View > Named Views to open the Named View dialog box.
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The toolbar contains the following controls: 

Copying and Pasting Data To and From Tables
This topic describes the best practices used to copy and paste data from and to the 
various tables.

Copying data from a table

New Contains the following commands:

• Named View—Opens a Named View 
Properties box to create a new named 
view.

• Folder—Opens a Named Views Folder 
Properties box to enter a label for the 
new folder.

Delete Deletes the named view or folder that is 
currently selected.

Rename Rename the currently selected named view 
or folder.

Go to View Centers the drawing pane on the named 
view.

Shift Up and Shift 
Down

Moves the selected named view or folder up 
or down.

Expand All or 
Collapse All

Expands or collapses the named views and 
folders.

Help Displays online help for Named Views.
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There are generally 3 ways to copy data from tables.

1. The first is to highlight (or select) the data by clicking in the top-left corner of the 
table.

This will highlight all the data in the table including the column headers:

When you use the windows short combination, CTRL-C, it will copy the high-
lighted data to the windows clipboard.  The data copied will include the column 
headers (in this case Time (hours) and Flow (ft^3/s)) and the rows below it.  This 
also includes the last row which is blank.

It will not copy the row headers (numbered 1 - 5 in this case).
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2. The second approach is to highlight the two columns (in this case).

This is similar to the first approach except it does not highlight the row headers.  
When you use the CTRL-C combination it will again copy the header data along 
with the row data including the last blank row.

3. The best approach for copying the data is to highlight just the rows you want to 
copy without highlighting the column headers.  To do this you can just click on 
the first row (#1 here) and drag your mouse down while holding the left mouse 
button.  This will highlight the table as follows:
2-46 Bentley SewerGEMS V8i User’s Guide



Introducing the Workspace
When you use the CTRL-C combination in this case it will copy only the data that 
you want. The column and row headers will not be copied. You can also use the 
CTRL-<left click> approach to copy non-consecutive rows. 

Pasting data into a table

When you paste data into one of our tables you want to make sure you do not include 
any header data.  If you include any non-numerical data a row will be inserted and the 
default values for the columns will be used in place of any text or non-numerical data 
that was pasted.

For example, if you copy using the first approach described above, you will get the 
following results:

The first row is the row that represents the column headers that were pasted into the 
table.  The last row of 0's is the blank row at the end of the table.
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Note: We advise that you delete any rows containing “0” values that 
may be inadvertently created during a copy-paste operation.

If you used the 3rd approach described above by just highlighting the rows you want 
to copy and then paste, you will get a more desirable result as follows:

As a result, the first row is exactly what you wanted along with the last row.  There are 
no unexpected values pasted into the grid.
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Chapter

Quick Start Lessons
Overview
The Quick Start lessons give you hands-on experience with many of the features and 
capabilities of SewerGEMS V8i. These detailed lessons will help you get started 
exploring and using the software.

• “Lesson 1: Overview of the SewerGEMS V8i Workspace” on page 3-50

• “Lesson 2: Laying Out a Network” on page 3-57

• “Lesson 3: Entering Data” on page 3-64

• “Lesson 4: Validating and Calculating a Model” on page 3-78

• “Lesson 5: Presenting Calculated Results” on page 3-84

• “Lesson 6: Creating Multiple Storm Events” on page 3-114

• “Lesson 7: Working With the ArcMap Client” on page 3-125

• “Lesson 8: Adding Hydrographs Using the RTK Runoff Method” on page 3-137

Another way to become acquainted with Bentley SewerGEMS V8i is to run and 
experiment with the included sample files, located in the C:/Program Files/Bentley/
SewerGEMS/Sample directory. To open one of these existing examples:

From the Welcome to Bentley SewerGEMS V8i dialog, click the Open Existing 
project button and browse to the C:/Program Files/Bentley/SewerGEMS/Sample 
directory. Highlight a sample file and click Open. 

If the Welcome to Bentley SewerGEMS V8i dialog is not open, click the File pull-
down menu and select the Open command. Then browse to the C:/Program Files/
Bentley/SewerGEMS V8i/Sample directory. Highlight a sample file and click Open.

Remember, you can right-click or press the F1 key to access the context-sensitive 
online help at any time. 
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Lesson 1: Overview of the SewerGEMS V8i 
Workspace
SewerGEMS has an extensively customizable user interface. In this lesson you will 
learn how to personalize SewerGEMS’s toolbars, managers, and other interface 
elements. The following lessons guide you through the process of setting up the 
SewerGEMS interface in an alternate configuration, starting from the default configu-
ration that is in use when the software is first installed. The advantage of the alternate 
configuration is that it increases the size of the drawing pane.

To return the interface to the default component placement settings, click View > 
Reset Workspace.

Part 1: Workspace Components Overview

The SewerGEMS workspace contains three different type of components: the drawing 
pane, toolbars, and dockable managers. The behavior and use of these components is 
discussed in the following parts of this lesson. When starting Bentley SewerGEMS 
V8i for the first time, the default interface settings will be used. 

Let’s begin by starting up Bentley SewerGEMS V8i. If SewerGEMS V8i is already 
open, skip step one and click the File pulldown menu and select the Open command 
instead, then proceed to step two.

1. In the Welcome to Bentley SewerGEMS V8i dialog that appears, click the Open 
Existing Project button.

2. Browse to the C:/Program Files/Bentley/SewerGEMS V8i/Lessons folder, high-
light Lesson_1.swg, then click Open.

The example network will appear in the drawing pane, and the interface will look like 
this:
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Part 2: Working With the Drawing Pane

The drawing pane is where you create and view your model. You can pan and zoom 
your model in this pane.

If you have already completed Part 1 of this lesson, proceed to the Panning section 
below. Otherwise, complete the following steps before proceeding to the Panning 
section:

1. Start Bentley SewerGEMS V8i.

2. In the Welcome to Bentley SewerGEMS V8i dialog that appears, click the Open 
Existing Project button.

3. Browse to the C:/Program Files/Bentley/SewerGEMS/Lessons folder, highlight 
Lesson_1.swg, then click Open.

Drawing PaneToolbarPulldown Menu

Dockable Manager
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Panning

You can change the position of the drawing view in the network by using the 
Pan tool. Alternatively, if your mouse is equipped with a mousewheel, you can 
pan by simply holding down the mousewheel and moving the mouse to reposi-
tion the current view. This changes the mouse cursor to the Pan icon, allowing you to 
reposition the current view in the same manner—click on the drawing, hold down the 
mouse button, and move the mouse to reposition the current view.

Zooming

You can perform a number of zooming operations in the drawing pane to change the 
current view of your model.

The simple Zoom In and Zoom Out commands let you increase or 
decrease, respectively, the zoom level of the current view by one step 
per mouse click.

The Zoom Extents command automatically changes the zoom level so that the 
entire network is displayed in the drawing pane.

The Zoom Realtime command lets you dynamically scale up and down the 
zoom level. The zoom level is defined by the magnitude of mouse movement 
while the tool is active.

The Zoom Center command opens the Zoom Center dialog, allowing you to 
center the drawing pane view on the coordinates you enter, at the zoom level 
you specify in the Zoom menu.

Click the Zoom Center button, and enter 75 in the X field, 30 in the Y field, and 
choose 200 in the Zoom menu, then click OK. The drawing pane will center on the 
manhole element MH-5 at a magnification of 200%.

Part 3: Working With Toolbars

Toolbars provide efficient access to frequently used commands. All of the toolbars in 
SewerGEMS are customizable both in terms of the buttons that they display and in the 
position that they occupy within the interface.
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If you have already completed Part 2 of this lesson, proceed to the Adding and 
Removing Toolbar Buttons section below. Otherwise, complete the following steps 
before proceeding to the following section:

1. Start Bentley SewerGEMS V8i.

2. In the Welcome to Bentley SewerGEMS V8i dialog that appears, click the Open 
Existing Project button.

3. Browse to the C:/Program Files/Bentley/SewerGEMS V8i/Lessons folder, high-
light Lesson_1.swg, then click Open.

Adding and Removing Toolbar buttons

You can add and remove buttons to/from toolbars to suit your preference.

Let’s begin by adding a button to the File toolbar:

1. Click the arrow button that is located on the far right of the File toolbar (the one 
with New, Open, Save, etc.) and move the mouse cursor over the Add or Remove 
Buttons command that appears.

2. In the shortcut menu that appears, move the mouse cursor over the Close All 
command.

3. Your toolbar should now look like this:

Now let’s remove a button from the Zoom toolbar.

4. Click the arrow button that is located on the far right of the Zoom toolbar (the 
Zoom toolbar is the one with the zoom and pan buttons) and move the mouse 
cursor over the Add or Remove Buttons command that appears.

5. Note that in the submenu that appears, there is a menu item for each of the buttons 
available to the Zoom toolbar. Most of the items have a checked box next to them, 
indicating that they are all visible on the toolbar. Click the Zoom Realtime menu 
item.

6. The Zoom Realtime button disappears from the toolbar, and the corresponding 
menu item loses its check.

Your toolbar should now look like this:
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Repositioning Toolbars

You can reposition any toolbar so that the toolbar is floating (not docked, or attached, 
to the toolbar areas of the interface), and you can move any toolbar to a new docked 
location.

Reposition the Layout toolbar (the Layout toolbar is the one along the left side of the 
interface that contains all of the element layout tools) so that it is situated horizontally 
underneath the other toolbars.

1. Hover the mouse cursor over the top edge of the toolbar, in the “textured” area 
indicated by a line of dots. 

2. When the mouse cursor changes to a four-directional arrow icon, click and hold 
down the mouse button.

3. Drag the mouse to the area beneath the set of horizontal toolbars along the top of 
the interface and release the mouse button.

Part 4: Working With Dockable Manager Components

By default, the dockable managers occupy the majority of the interface. They are 
called dockable managers because they can be docked, or attached, to the edges of the 
Bentley SewerGEMS V8i window. You can position any of the managers along the 
top, bottom, left, or right of the Bentley SewerGEMS V8i window, and when more 
than one manager is situated in the same spot, the docked pane becomes tabbed, 
allowing you to switch between all of the managers that are docked in the same area.

If you have already completed Part 3 of this lesson, proceed to the paragraph starting 
“In this part of the lesson...” below. Otherwise, complete the following steps before 
proceeding to the following section:

1. Start Bentley SewerGEMS V8i.

2. In the Welcome to Bentley SewerGEMS V8i dialog that appears, click the Open 
Existing Project button.

Browse to the C:/Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight 
Lesson_1.swg, then click Open.
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In this part of the lesson, we will create an alternate interface setup that makes certain 
frequently used interface components more accessible. Specifically, we will add the 
EPS Results Browser dialog as a floating window, and add the Property Editor to the 
interface as a dockable manager.

1. Open the EPS Results Browser dialog box. Click Analysis > EPS Results 
Browser.

2. Click the EPS Results Browser tab and hold the mouse, and drag the window, 
represented by a grey outline, to the bottom left corner of the drawing pane.

3. Hover the mouse cursor over the bottom right corner of the EPS Results Browser 
dialog box, until the mouse cursor turns into diagonal two-headed arrow and 
resize the dialog box until it is as small as possible while still accommodating all 
of the controls, like this:

4. Open the Property Editor. Click View > Properties.

5. Click the heading of the Property Editor, and, while holding down the mouse 
button, drag the mouse to the upper-right corner of the interface, just below the 
bottom toolbar. The dialog box is correctly positioned when the grey outline 
representing the dialog box occupies the length of the right side of the interface, 
like this:
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6. Resize the width of the dockable managers on the left and the Property Editor on 
the right so that the drawing pane is larger, displaying more of the network at 
once. Hover the mouse cursor over the right and left edges, respectively, until the 
mouse cursor changes to the double-headed horizontal arrow cursor, then click, 
hold, and drag the mouse until the desired size is obtained.

7. Click the Zoom Extents button to view the entire network in the drawing pane.

8. The Property Editor will be gray, with the message Select a single element. Click 
on an element to see the attributes associated with it in the Property Editor.

9. Your interface should now look like this:
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When the managers are docked, they can be in static or dynamic mode. When in static 
mode, the managers are always visible. When a manager is in dynamic mode, it isn’t 
visible unless the mouse cursor is hovered over the associated tab. When the mouse 
cursor is moved away from the tab, the manager retracts. To switch between the two, 
click the pushpin toggle button in the top-right corner of the manager. A horizontal 
pushpin indicates that the manager is in dynamic mode. When the pushpin is vertical, 
the manager is in static mode.

Lesson 2: Laying Out a Network
SewerGEMS is an extremely efficient tool for laying out a storm or sanitary sewer 
network. It is easy to prepare a schematic or scaled model and let SewerGEMS take 
care of the link-node connectivity. 
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In constructing the network for this lesson, you do not need to be concerned with 
assigning labels to pipes and nodes, because the software assigns labels automatically. 
A schematic drawing is one in which pipe lengths are entered manually, in the user-
defined length field. In a scaled drawing, pipe lengths are automatically calculated 
from the position of the pipes’ bends and start and stop nodes in the drawing pane. For 
the purposes of this lesson, we will build a schematic model.

Part 1: Laying Out Catchments and Ponds

Let’s begin by starting up Bentley SewerGEMS V8i. If you already have SewerGEMS 
V8i open from the previous lesson, click the Open button and skip ahead to step 2.

1. In the Welcome to Bentley SewerGEMS V8i dialog box that appears, click the 
Open Existing Project button.

2. Browse to the C:/Program Files/Bentley/SewerGEMS V8i/Lessons folder, high-
light Lesson_ 2_1.swg, then click Open.

Catchments and ponds are polygon elements that graphically depict the area 
represented by the element. Begin by laying out the two catchments by tracing the 
catchment outlines shown in the .dxf background, as follows:

3. Select the Catchment layout tool.

4. Click on one of the corners of the catchment outline for CM-1. Drag the 
mouse to the next corner, and click again.

5. Continue laying out the catchment boundaries by clicking each corner until you 
click the last one. Right-click and select Done from the submenu that appears.

Repeat steps 4 and 5 for the remaining catchment. Your model should now look 
like this:

6. In a schematic model, where the shape isn’t necessarily important, SewerGEMS 
V8i provides a shortcut for laying out catchments and ponds. Rather than drawing 
a polygon line-by-line, you can also use a default shape by holding down the Ctrl 
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key while clicking to define the center point of the element, then dragging the 
mouse to define the size and orientation of the pentagon. Clicking again places the 
element. 

This concludes this part of the lesson. The next part of the lesson continues where 
this part leaves off, so you can keep the same project open if you plan to continue 
immediately. If you plan to begin the next lesson at a later time, you can either 
save the current project, or use the Lesson_2_2.swg project located in the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder.

Part 2: Laying Out Nodes and Links

The term Nodes refers to any of the available point element types:

• catch basins

• Manholes

• Cross Section Nodes

• Junction Chamber

• Pressure Junction

• Outlet Structures

• Outfalls

• Wet Wells

• Pumps

The term links refers to any of the available line elements:

• Pressure Pipe

• Conduits

• Channels

• Gutters

In this part of the lesson, we’ll begin by laying out all of the nodes, and then connect 
them using links.
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If you’ve already completed Part 1 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_2_2.swg, 
then click Open.

1. Select the Catchbasin layout tool and click in the lower-right corner of 
CM-1 to place a catch basin node there, at the spot indicated on the dxf 
background. Place another as indicated in the background in CM-2.

2. Select the Manhole layout tool and click each of the locations indicated 
by the dxf background, 6 in all. Note that the element labeled Diversion 
Chamber in the background is also a manhole.

3. Select the Outfall layout tool and click each of the locations indicated by 
the dxf background, 2 in all. In the dxf background, the outlets are labeled 
Treatment and Overflow.

Your model should now look like this (when the dxf background is turned off - 
click the checkbox next to LessonLayout in the Background Layers manager to 
turn off the background):

Now lay out link elements to connect the nodes, as follows:

4. Click the Layout tool and select the Conduit tool 
from the submenu that appears.

5. Click on MH-1 and drag the mouse to MH-2, and 
click again to lay out the conduit. Right-click and 
select Done from the submenu to complete the 
conduit.
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6. Click CB-1, drag the mouse to MH-2, and click to lay out a second conduit. The 
conduit tool is still active, so drag the mouse to MH-3 and click again to lay out a 
third conduit. Drag and click on MH-4 to lay out a fourth. Right-click and select 
Done from the submenu.

7. Click CB-2 drag the mouse to MH-4, and click. Drag the mouse to MH-5 and 
click again. Drag to and click on MH-6. Right-click and select Done from the 
submenu.

8. Click OF-1, drag the mouse to MH-6, and click again. Drag the Mouse to OF-2 
and click to lay out the final conduit. Right-click and select Done from the 
submenu.

Your model should now look like this:

The last step in laying out the network is establishing the connectivity between the 
polygon elements and the node elements.

9. Click the View pulldown menu and select the Properties command. 

10. Dock the Property Editor dialog that appears to the right side of the Sewer-
GEMS V8i window (For a description of how to do this, see Lesson 1, Part 4, Step 
5).

11. Highlight CM-1. The attributes associated with the catchment will appear in the 
Property Editor.

12. Click the pulldown menu in the Outflow Node field, and choose the <Select...> 
command.

13. Your mouse cursor changes into a Pick Element tool. Click on CB-1.

14. Highlight CM-2, click the pulldown menu in the Outflow Node field, 
and choose the <Select...> command. Click on CB-2.
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Your model should now look like this:

Note the dashed lines indicating the connectivity between the polygon and node 
elements.

This concludes this part of the lesson. The next part of the lesson continues where this 
part leaves off, so you can keep the same project open if you plan to continue immedi-
ately. If you plan to begin the next part of the lesson at a later time, you can either save 
the current project, or use the Lesson_2_3.swg project located in the C:/Program 
Files/Bentley/SewerGEMS V8i/Lessons folder.

Part 3: Moving Element Labels

If you’ve already completed Part 2 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson 
_2_3.swg, then click Open.

As you can see, the default placement of the element labels can sometimes interfere 
with the visibility of other elements and labels. You can manually move the labels by 
clicking on them until just the label is highlighted. Note that when an element is high-
lighted, the label is highlighted as well. To move the label, make sure that only the 
label is highlighted.
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When the label is highlighted, you will see a small square, or “grip”, near the label, as 
shown below:

Click on this grip and move the label to the new position, such that it doesn’t interfere 
with the visibility of other labels and elements. Repeat this process with the other 
element labels in the model.

When you have done so, the model should look like this:

By default, labels for link elements are positioned so that they are placed at an angle 
parallel to the link. You can change the angle of orientation by right-clicking a label 
and selecting the Rotate command from the submenu that appears. By moving your 
mouse up and down while this command is active, you can rotate the label angle 
around a pivot point. When you are finished rotating the label, right-click and select 
Done from the submenu that appears.

This concludes Lesson 2. The next lesson continues where this one leaves off, so you 
can keep the same project open if you plan to continue immediately. If you plan to 
begin the next lesson at a later time, you can either save the current project or use the 
Lesson_3_1.swg project located in the C:/Program Files/Bentley/SewerGEMS V8i/
Lessons folder.
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Lesson 3: Entering Data
Input data in SewerGEMS V8i can be divided into two categories: element input data 
and global project data. This lesson explains the difference between the two and 
describes how to define both types of data.

Part 1: Entering Element Input Data

Element input data refers to the data associated with the elements in the model. It can 
be entered using the Property Editor, as described in Lesson 2, through FlexTables, or 
through the Alternatives Editor, as described in the “ Editing Alternatives” topic.

Each method offers different advantages:

• The Property Editor is easily accessible and can be positioned next to the drawing 
pane so you can see the visual context of the element whose data is being modi-
fied. 

• The FlexTables are categorized according to element type, so they are best suited 
for entering data for large groups of elements at once. They also provide global 
editing and filtering functionality to allow you to enter data common to a large 
number of elements quickly and easily.

• The Alternatives Editor allows you to use data inheritance functionality 
(discussed in “ Editing Alternatives”) and the categorized nature of the data (alter-
natives are grouped according to the type of data they contain, such as physical 
data, inflow data, hydrologic data, etc.), can be useful.

Let’s begin by using the Property Editor to define the attributes for the individual 
elements in the model.

If you’ve already completed Lesson 2, you can continue using the same model. Other-
wise, begin by clicking the File/Open button, then browse to the C:/Program Files/
Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_3_1.swg, then click 
Open.

1. Highlight CB-1.

2. The fields that are available for a given element type vary depending on the 
settings in other fields. Change the Structure Shape Type to Rectangular Struc-
ture. Note that the Diameter field disappears, and a Length field and a Width 
field appear in its place.

3. Change the Inlet Type to Inflow-Capture Curve.

4. Click the ellipsis button in the Inflow-Capture Curve field to open the Inflow 
Capture Curve dialog.
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5. Using Windows Explorer, browse to the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder and open the text document entitled CB Inlet Data.txt. High-
light all of the data in the text file, and press Ctrl+C on your keyboard to copy the 
data.

6. Back in the Inflow-Capture Curve dialog, press Ctrl+V to copy the data into the 
dialog. (If the copy command doesn’t work immediately, click the first column 
heading, hold down the mouse button, and drag the cursor over to the second 
column to highlight both columns, then press Ctrl+V).

7. Click OK in the Inflow-Capture Curve dialog to close it.

8. Enter the following data in the specified fields:

9. Highlight CB-2.

10. Change the Structure Shape Type to Rectangular Structure, leaving the default 
values for Length and Width at 3.00 ft.

11. Change the Inlet Type to Inflow-Capture Curve.

12. Click the ellipsis button in the Inflow-Capture Curve field to open the Inflow 
Capture Curve dialog. Press Ctrl+V to copy the data you copied during step 5 
into the dialog. 

Table 3-1: CB-1 Attribute Values

Field Name Value 

Ground Elevation 106.00 ft.

Invert Elevation 102.00 ft.
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13. Enter the following data in the specified fields:

14. Highlight MH-1.

15. Enter a local inflow (local inflow is inflow that occurs at a specific element, as 
opposed to the inflow from global storm events, which is applied over the whole 
model). Click the ellipsis button in the Inflow Collection field.

16. In the Inflow Collection dialog that appears, click the New button, then click 
Hydrograph Inflow in the submenu that appears.

17. Using Windows Explorer, browse to the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder and open the text document entitled MH1 Inflow Collec-
tion.txt. Highlight all of the data in the text file, and press Ctrl+C on your 
keyboard to copy the data.

18. Back in the Inflow-Collection dialog, press Ctrl+V to copy the data into the 
dialog. (If the copy command doesn’t work immediately, click the first column 
heading, hold down the mouse button, and drag the cursor over to the second 
column to highlight both columns, then press Ctrl+V).

19. Click OK in the Inflow Collection dialog to close it.

Table 3-2: CB-2 Attribute Values

Field Name Value 

Ground Elevation 101.00 ft.

Invert Elevation 97.00 ft.
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20. Enter the following data in the specified fields:

For the other elements in the model, of which there are more than one of each 
type, let’s enter the data using FlexTables.

21. Click the View pulldown menu and select the FlexTables command.

22. Under the Tables - Predefined node, double-click the Manhole Table.

23. Enter the following data in the Manhole Table dialog that appears:

24. Change the Label for MH-6 to Diversion Chamber. When you have entered the 
data, close the Manhole Table. In the FlexTables dialog, double-click the Catch-
ment Table node.

Table 3-3: MH-1 Attribute Values

Field Name Value

Ground Elevation 107.00 ft.

Invert Elevation 103.00 ft.

Diameter 3.00 ft.

Table 3-4: Manhole Attributes

Element Ground 
Elevation

Invert 
Elevation

Diameter)

MH-2 105.00 ft 101.00 ft 3.00 ft.

MH-3 103.00 ft 99.00 ft 3.00 ft.

MH-4 100.00 ft 96.00 ft 3.00 ft.

MH-5 99.00 ft 95.00 ft 3.00 ft.

MH-6 97.00 ft 93.00 ft 3.00 ft.
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25. Enter the following data in the Catchment Table dialog that appears (if one or 
more attributes does not appear in the FlexTable by default, you will have to add 
them to the FlexTable. For instructions on adding attributes to a FlexTable, see 
Lesson 1 Part 2):

26. When you have entered the data, close the Catchment Table. In the FlexTables 
dialog, double-click the Conduit Table node.

27. Enter the following data in the Conduit Table that appears (note that the stop and 
start inverts are defined by the values of the adjacent nodes, since the Set Invert 
To Start/Stop Node fields are set to True by default):

Table 3-5: Catchment Attributes

Element Area (acres) SCS CN Tc (hours)

CM-1 10.000 80.000 0.400

CM-2 13.000 82.000 0.500

Table 3-6: Conduit Attributes

Element Has User 
Defined 
Length

User 
Defined 
Length (ft.)

Diameter 
(in)

Start Invert 
(ft.)

CO-1 True 250.00 24.0 Automatically 
Assigned

CO-2 True 50.00 24.0 Automatically 
Assigned

CO-3 True 500.00 30.0 Automatically 
Assigned

CO-4 True 500.00 30.0 Automatically 
Assigned

CO-5 True 50.00 24.0 Automatically 
Assigned
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28. When you have entered the data, close the Conduit Table. 

29. Click on CO-9 in the drawing pane.

30. In the Properties Editor, change the Has Start Control Structure? value to 
True. Click the ellipsis button in the Start Control Structure field.

31. In the Conduit Control Structure dialog that appears, click the New button and 
select Weir from the submenu.

32. Change the Crest Elevation to 94.50 ft. Change the Structure Top Elevation to 
97.00 ft. Change the Weir Length to 2.00 ft. Click the Close button.

33. In the drawing pane, an icon appears on the upstream end of CO-9 to indicate that 
a control is present.

CO-6 True 500.00 36.0 Automatically 
Assigned

CO-7 True 300.00 36.0 Automatically 
Assigned

CO-8 True 300.00 30.0 Automatically 
Assigned

CO-9 True 300.00 30.0 Automatically 
Assigned

Table 3-6: Conduit Attributes

Element Has User 
Defined 
Length

User 
Defined 
Length (ft.)

Diameter 
(in)

Start Invert 
(ft.)
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34. In the FlexTables dialog, double-click the Outfall Table node.

35. In the Outfall Table dialog that appears, enter the following data:

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_3_2.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 2: Entering Global Project Data

Global project data refers to information that applies to the project as a whole. This 
includes project properties, storm events, and global storm events.

Defining Project Properties

Project Properties are purely informational data that store the Project Title, Engineer’s 
Name, Company Name, and the Date, along with any notes associated with the project

Table 3-7: Outfall Attributes

Element Ground 
Elevation 
(ft.)

Set Invert 
Elevation 
to Ground 
Elevation

Invert 
Elevation 
(ft.)

Change 
Label To

OF-1 95.00 False 91.00 Treatment

OF-2 95.00 False 91.00 Overflow
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This data, if entered, will be added to the footer of any of the preformatted reports that 
are generated by SewerGEMS V8i, with the exception of the data entered in the Notes 
field, which will not be displayed.

If you’ve already completed Part 1 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_3_2.swg, 
then click Open.

1. Click the File menu and select the Project Properties command.

2. In the Project Properties dialog that appears, enter the following information in 
the specified fields:

3. The date is automatically entered using the information in your system calendar. 
The dialog should now look like this:

4. Click the OK button.

Table 3-8: Project Properties

Field Name Value

Title Lesson Model

Engineer <Your Name Here>

Company: <Your Company 
Name Here>
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5. To see how the information will appear on the preformatted reports, click the 
Report pulldown menu and select the Project Inventory command.

6. In the Project Inventory report dialog, scroll to the bottom of the page to view 
the footer.

Defining Storm Events

A storm event is a single curve that represents one rainfall event for a given recurrence 
interval. Once the storm event is created it can either be used locally at a catchment, or 
it can be used globally, as discussed in the next section of this part of the lesson.

This example shows how to retrieve and paste an external rainfall data source file into 
SewerGEMS as a cumulative rainfall data table. See Lesson 7 for a detailed example 
on how to set up multiple return events from synthetic rainfall data (such as SCS Type 
I, IA, II, III distributions).

1. Click the Components pulldown menu and select the Storm Events command.

2. In the Storm Events dialog that appears, click the New button and select Cumu-
lative from the submenu that appears.

3. In the Time Settings dialog that appears, enter the following data:
Table 3-9: Time Settings

Field Name Value (hrs)

Start Time 0.000

Increment 0.100

End Time 24.000
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4. The start and end times define the duration of the storm event, while the increment 
defines the amount of time between each ordinate when the storm is calculated. 
Click the OK button to close the Time Settings dialog.

5. In the Return Event field, enter a value of 10 years.

6. Using Windows Explorer, browse to the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder and open the text document entitled Storm Event Data.txt. 
Highlight all of the data in the text file, and press Ctrl+C on your keyboard to 
copy the data.

This procedure demonstrated how you can copy storm data from a predefined 
storm event, created from external rainfall data sources.   Lesson 6 describes a 
detailed example on how to set up multiple return events from synthetic rainfall 
data (such as SCS Type I, IA, II, III distributions)

7. Back in the Storm Events dialog, highlight the Depth column of the Time vs. 
Depth table on the right side of the dialog and press Ctrl+V on your keyboard to 
paste the data into the table.

8. Click the Close button to close the Storm Events dialog.
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Defining Global Storm Events

As mentioned in the last section, once a storm event is created, it can be assigned 
locally to one or more catchments, or assigned to the project globally. When a storm 
event is defined as a global event, it applies the storm event to every catchment in the 
scenario that does not have localized rainfall.

1. To apply the storm event we just created globally, click the Components pull-
down menu and select the Global Storm Events command.

2. In the Global Storm Event dialog that appears, click the arrow button in the 
Global Storm Event field. Select the only event in the list, Storm Event - 1.

3. Note that the other fields in the dialog, colored yellow to denote their read-only 
status, are filled in automatically with the data associated with the selected storm 
event. Click the Close button to close the Global Storm Events dialog.

Adding Sanitary Loads

In this part of the lesson, we will set up a unit sanitary load and a pattern sanitary load. 
A unit sanitary load can be set up once and then used at multiple nodes, and can also 
be saved as an engineering library for use in other models (see “Adding Unit Sanitary 
(Dry Weather) Loads” on page 7-370). A pattern sanitary load is a load that varies 
over time. 

1. To create a new unit sanitary load, click the Components menu and select the 
Unit Sanitary (Dry Weather) Loads command.

2. In the dialog that appears, click the New button and select Area from the submenu 
that appears.

3. Right-click the gal/min label to the right of the Unit Load field and select the 
Units and Formatting command from the submenu that appears.

4. In the Set Field Options dialog that appears, change the Unit value to gal/day. 
Click OK.
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5. Back in the Unit Sanitary Loads dialog, enter 720 in the Unit Load field. Click 
the Close button.

6. Highlight MH-3 in the drawing pane. 

7. In the Properties Editor, click the ellipsis button in the Sanitary Loads field.

8. In the Sanitary (Dry Weather) Flow dialog that appears, click the New button 
and select the Unit Load - Unit Type and Count command from the submenu 
that appears.

9. Enter 6.5 in the Loading Unit Count field.

10. Click the Unit Sanitary Load pulldown menu and select Unit Sanitary Load - 1. 
Click OK.

11. Highlight MH-4 and repeat steps 7 - 10.

12. Highlight MH-2.
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13. In the Properties Editor, click the ellipsis button in the Sanitary Loads field.

14. In the Sanitary (Dry Weather) Flow dialog that appears, click the New button 
and select the Pattern Load - Base Flow and Pattern command from the 
submenu that appears.

15. Enter 7200 in the Base Flow field. 

16. Click the ellipsis button next to the Pattern field. In the Patterns dialog that 
appears, click the New button. Enter 0.5 for the Starting Multiplier.

17. Using Windows Explorer, browse to the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder and open the text document entitled Sanitary Load 
Pattern.txt. Highlight all of the data in the text file, and press Ctrl+C on your 
keyboard to copy the data.

18. Back in the Patterns dialog, click the Time From Start column heading, hold 
down the mouse button, and drag the cursor over to the Multiplier column to 
highlight both columns, then press Ctrl+V. Click the Close button.
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19. Back in the Sanitary (Dry Weather) Flow dialog, click the Pattern pulldown 
menu and select Pattern - 1. Click OK.

20. To apply the pattern to the unit load we created, you must create a Pattern Setup. 
Click the Components pulldown menu and select the Pattern Setups command.

21. In the Pattern Setups dialog, click the New button to create a new pattern setup.

22. Click the pulldown menu in the Setup Pattern column and select Pattern - 1.

23. Click the Close button.

24. Finally, change the calculation option so that the Pattern Setup is applied. Click 
the Analysis pulldowm menu and select the Calculation Options command.
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25. Change the Pattern Setup value to Pattern Setup - 1.

This concludes Lesson 3. The next lesson continues where this one leaves off, so you 
can keep the same project open if you plan to continue immediately. If you plan to 
begin the next lesson at a later time, you can either save the current project or use the 
Lesson_4.swg project located in the C:/Program Files/Bentley/SewerGEMS V8i/
Lessons folder.

Lesson 4: Validating and Calculating a Model
In Lessons 2 and 3 we created the model and entered the required input data. The 
model is now ready to be calculated. When you execute the Compute command, 
SewerGEMS V8i performs a validation routine to detect any errors or input data that 
will interfere with the successful calculation of the model. Alternatively, you can also 
validate your model at any time, without calculating.

If you’ve already completed Lesson 3, you can continue using the same model. Other-
wise, begin by clicking the File/Open button, then browse to the C:/Program Files/
Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_4.swg, then click Open.

1. Click the Validate button in the toolbar, or click the Analysis menu and 
select the Validate command.

2. A Bentley SewerGEMS V8i Problem dialog appears, informing you that one or 
more validation errors were found. Click OK in this box.

3. The User Notifications dialog appears. This dialog lists data entry errors that 
prevent the model from calculating successfully. These types of errors are marked 
with a red icon. 
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4. Double-click the first message in the list, “Outfall is boundary element type, no 
boundary element selected.”

5. The drawing pane centers on the element referenced by the error message, and the 
element is highlighted. In the Property Editor, change the Boundary Condition 
Type to Free Outfall.

6. Repeat the above step with the second message in the list.

7. Close the User Notifications dialog.

8. Click the Compute button. When the model has been computed, the 
Calculation Executive Summary appears. This dialog displays some of 
the important calculated results.
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9. You can generate an executive summary report by clicking the Report button in 
this dialog.

10. Close the Calculation Executive Summary report dialog.

11. Click the Detailed Summary button. The Detailed Summary dialog appears. 
The Detailed summary contains information divided by category:

– Calculation Detailed Summary - Calculation Options (see “Calculation 
Options Tab” on page 8-441 for more details).
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– Calculation Detailed Summary - Catchment Summary (see “Catchment 
Summary Tab” on page 8-442 for more details).

– Calculation Detailed Summary - General Summary (see “General Summary 
Tab” on page 8-443 for more details).
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– Calculation Detailed Summary - Node Summary (see “Node Summary Tab” 
on page 8-444 for more details).

• Calculation Detailed Summary - Gutter Summary (see “Gutter Summary Tab” on 
page 8-445 for more details).
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12. As with the Executive Summary, you can generate a report using the Report 
button.

13. Click the Analysis menu and select User Notifications. Note that there are still 
messages listed here, although the model did compute successfully. These 
messages, marked with an orange icon, are warnings (in contrast with errors, 
marked in red). Warnings do not interfere with the calculations, and do not neces-
sarily invalidate the results. They simply call attention to certain conditions within 
the network that may be a result of incorrect input data, or that the user might not 
be immediately aware of.

This concludes Lesson 4. The next lesson continues where this one leaves off, so you 
can keep the same project open if you plan to continue immediately. If you plan to 
begin the next lesson at a later time, you can either save the current project or use the 
Lesson_5_1.swg project located in the C:/Program Files/Bentley/SewerGEMS V8i/
Lessons folder.
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Lesson 5: Presenting Calculated Results
An important feature in all software is the ability to present results clearly. This lesson 
outlines several of Bentley SewerGEMS V8i’s reporting features, including: 

• Reports, which display and print information on any or all elements in the 
system.

• Tabular Reports (FlexTables), for viewing, editing, and presentation of selected 
data and elements in a tabular format.

• Graphs, to display calculated result attribute values over time for any element in 
the model.

• Profiles, to graphically show, in a profile view, how a selected attribute, such as 
hydraulic grade, varies along an interconnected series of pipes over time.

• Element Annotation, for dynamic presentation of the values of user-selected 
variables in the plan view.

• Color Coding, which assigns colors based on ranges of values to elements in the 
plan view. Color coding is useful in performing quick diagnostics on the network.
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Part 1: Generating Preformatted Reports

Bentley SewerGEMS V8i has the ability to generate a number of different prefor-
matted reports. Two of these reports were mentioned in the previous lesson, the Calcu-
lation Executive Summary and the Calculation Detailed Summary.

If you’ve already completed Lesson 4, you can continue using the same model. Other-
wise, begin by clicking the File/Open button, then browse to the C:/Program Files/
Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_1.swg, then click 
Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Right-click Diversion Chamber and select Report from the shortcut menu that 
appears. You can use this function for any element in the model, allowing you to 
quickly generate a report detailing a single element’s input and output data, as 
shown below. 
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3. Close the Print Preview window.

4. You can also generate reports that detail input and output data for all elements of a 
single type. Click the Report menu, move the mouse cursor over Element 
Tables, and click the Conduit command from the submenu that appears.

5. In the FlexTable dialog (FlexTables will be discussed further in the next part of 
this lesson) that appears, click the Report button.

6. Close the Print Preview and FlexTable windows.

7. The Scenario Summary Report details the calculation options that are associated 
with the current scenario, along with the alternatives that it is comprised of 
(Scenarios are discussed in the next lesson). Click the Report menu and select the 
Scenario Summary command.
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8. Close the Print Preview window.

9. The Project Inventory Report details all of the information contained in the 
Scenario Summary Report mentioned above, along with a count of the number of 
each element type in the model. Click the Report menu and select the Project 
Inventory command.
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10. Close the Project Inventory report window.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_5_2.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 2: Generating Custom Tabular Reports

In Lesson 3, we saw how FlexTables can be used as an efficient means of data entry. 
They are also useful for creating customized reports of calculated results, as demon-
strated in this part of the lesson.
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If you’ve already completed Part 1 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_2.swg, 
then click Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Click the Analysis menu, select the EPS Results Browser command. A 
FlexTable displays the calculated results for the current time step. The EPS 
Results Browser allows you to control the time step that is displayed.

3. Click the View menu and select the FlexTables command.

4. In the FlexTables dialog, highlight the Tables-Project node, 
then click the New button and select Folder from the 
submenu that appears.

5. A folder is created in the tree view of the FlexTables dialog. 
This allows you to organize your custom tables. Highlight the newly 
created folder and click the Rename button. Rename the folder to 
Conduit Results.

6. Click the New button and select FlexTable from the 
submenu that appears.

7. The FlexTable setup dialog appears. Change the Table 
Type to Conduit.
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The Available Columns list pane on the left side of the dialog displays all of the 
attributes that are available for display in the custom table. The Selected Columns 
list pane, which is currently empty, displays all of the attributes that will be 
displayed in the custom table. You define a custom table by moving the attributes 
that you want the table to display from the Available Columns list to the Selected 
Columns list. 

Input data attributes are denoted by a blue icon.

Output data (result) attributes are denoted by a yellow icon.

8. Double-click Label to move it to the Selected Columns list.

9. Double-click each of the yellow result attributes in the Available 
Column list to move them to the Selected Columns list. Alterna-
tively, you can highlight the attributes and click the Add button.

10. When you have finished moving all of the output attributes to the Selected 
Columns list, click the OK button.
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11. The FlexTable display dialog appears. The table currently displays the results for 
each of the conduits in the model for the 00:00:00 hour timestep. Resize the 
FlexTable dialog so that more columns are visible, and position the FlexTable 
dialog so that the EPS Results Browser dialog is also visible.

12. Click and hold the Time Slider control, then slowly drag the control to the right. 
Note that the values for most of the result attributes in the table vary over time. 
Move the slider to around the halfway point.
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13. The rows in the FlexTable can be sorted according to any attribute. Right-click the 
Flow column heading and select the Sort...Descending command from the 
shortcut menu that appears. The table rows will be arranged so that the element 
with the highest flow during the current time step is at the top and the element 
with the lowest flow is at the bottom.

14. You can apply filters to any FlexTable. Filters let you change the table so 
that only rows that match the specified criteria will appear. Tables can be 
filtered according to any attribute. Click the Edit button.

15. In the FlexTable setup dialog, double-click the Diameter attribute in the Avail-
able Columns list. Click OK.

16. In the FlexTable display dialog, scroll to the Diameter column. Right-click the 
column heading and select the Filter...Filter command from the shortcut menu 
that appears.

17. In the Filter dialog, scroll to the Diameter attribute in the Fields pane and 
double-click it to add it to the query pane at the bottom of the dialog. Click the <= 
operator button. Click the refresh button above the Unique Values pane and 
double-click 24.0 in the list that appears. The dialog should now look like this:
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18. Click the Apply button, click OK in the Query Successful prompt, then click OK 
to close the Query Builder dialog.

19. In the FlexTable display dialog, note that there are only three elements displayed, 
and a message has appeared along the bottom of the dialog: “3 of 9 elements 
displayed” and a “FILTERED” notification appears to the right of the message. 
Only the elements with a diameter of 24 inches or less are shown in the table 
because of the filter we created.

20. Close the FlexTable display dialog, then close the FlexTables manager dialog.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_5_3.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 3: Using Graphs

Graphs display calculated result attribute values over time for any element in the 
model. For elements with more than one attribute available for graphing, you can 
display all of the attributes on the same graph. 

If you’ve already completed Part 2 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_3.swg, 
then click Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Right-click on CM-1 and select Graph from the shortcut menu that appears.

3. Close the Graph Series Options dialog that appears. The Graph dialog opens, 
displaying the plot of total outflow over time (the default attribute for catchment 
graphs) for CM-1 for the duration of the simulation.
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4. You can view the data on which the graph is based by clicking the Data tab.
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5. Switch back to the Graph tab and click the Graph Series Options button.

6. The Graph Series Options dialog that appears allows you to control what 
is displayed by the graph, including scenarios, elements, and attributes. 
Scenarios will be discussed in the next lesson, and we will revisit graphs at that 
time.

7. In the Fields list, clear the Total Outflow checkbox (under the Results folder) 
and click the Cumulative Precipitation checkbox (under the Results (Extended 
Catchment) folder), then click the OK button.

8. You can also display more than one attribute simultaneously on the same graph. 
Click the Graph Series Options button.

9. Click the Total Outflow checkbox in the Fields pane, then click the OK button.

10. The graph now displays both outflow and cumulative precipitation for CM-1. 
Click the Add to Graph Manager button to save the Graph and enter the name 
CM-1 Outflow and Cumulative Precipitation in the Create Graph dialog that 
appears. Close the Graph view dialog.
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11. You can graph multiple elements on the same graph. Hold down the Ctrl key on 
your keyboard and click both of the catchment elements in turn.

12. Right-click on one of the catchments and select the Graph command from the 
shortcut menu. Close the Graph Series Options dialog.
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13. You can zoom in on any area of the graph using the Zoom tool. Click the 
Zoom tool to activate it. The zoom tool behaves like the Zoom Window 
tool for the drawing pane; you define the area to be zoomed by clicking on 
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the graph to define the top-left corner of the zoom area, then hold down the mouse 
button and drag down and to the right, releasing the mouse button when the cursor 
is positioned at the bottom-right corner of the zoom area.

14. To zoom back out, click, hold, and drag to the left, then release the mouse 
button. This returns the view to the full extent zoom level, displaying the 
entire graph. Alternatively, you can click the Zoom Extents button.

15. Click the Save button and enter the name All Catchments Outflow in the Create 
Graph dialog, then click OK. Close the Graph dialog.

16. Click the View menu and select the Graphs command.

17. In the Graphs manager dialog that appears, note the saved graphs.

18. Close the Graphs manager dialog.
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This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_5_4.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 4: Generating Profiles

Profiles graphically show how a selected attribute, such as hydraulic grade, varies 
along an interconnected series of network elements over time.

If you’ve already completed Part 3 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_4.swg, 
then click Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Click the View menu and select the Profiles command.

3. In the Profiles manager that appears, click the New button.

4. In the Profile Setup dialog that appears, click the Select From Drawing 
button.

5. The mouse cursor changes to an Element Selection tool. Click on CB-1 
and MH-3. MH-2, which is the intermediate node between them, is also 
highlighted, along with the link elements that join these elements. Right-
click and select Done from the shortcut menu that appears.
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6. This returns you to the Profile Setup dialog. Note that the list pane now contains 
the elements that were highlighted in the drawing pane. These are the elements 
that will be displayed in the profile, in the order they will appear from left to right 
in the profile view. Click the Open Profile button.

7. The Profile view dialog appears, displaying the three nodes and two links that 
were highlighted. The blue line represents the calculated HGL. The green line 
represents the ground elevation. The parallel vertical lines represent the node 
elements. The red marks superimposed over the node elements represent the 
maximum HGL calculated for that node. Click the Play button to see how the 
HGL changes over the course of the simulation.

8. Close the Profile display dialog. In the Profiles manager dialog, highlight 
Profile-1 and click the Edit button.
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9. This opens the Profile Setup dialog for the highlighted profile. Click the Reverse 
button, then click the Open Profile button. 

10. Note that the direction of the profile has been reversed. Close the Profile view 
dialog.

11. In the Profiles manager, highlight Profile-1 and click the Rename button. 
Enter the name Upstream Of MH-3.

12. Click the New button. In the Profile Setup dialog, click the Select From 
Drawing button.
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13. In the drawing pane, click on CB-2, MH-5, Diversion Chamber, and Treatment. 
Right-click and select Done from the shortcut menu.

14. In the Profile Setup dialog, click the Open Profile button.

15. You can zoom in on any area of the profile using the Zoom tool. Click the 
Zoom tool to activate it. The zoom tool behaves like the Zoom Window 
tool for the drawing pane; you define the area to be zoomed by clicking on 
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the graph to define the top-left corner of the zoom area, then holding down the 
mouse button and dragging down and to the right, releasing the mouse button 
when the cursor is positioned at the bottom-right corner of the zoom area.

16. To zoom back out, click, hold, and drag to the left, then release the mouse 
button. This returns the view to the full extent zoom level, displaying the 
entire profile. Alternatively, you can click the Zoom Extents button.

17. Close the Profile view dialog. In the Profiles manager, highlight Profile-1 and 
click the Rename button. Enter the name Downstream of MH-3.

18. Close the Profiles manager dialog.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_5_5.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.
Bentley SewerGEMS V8i User’s Guide 3-103



Lesson 5: Presenting Calculated Results
Part 5: Applying Element Annotation

Element annotation functionality allows the display of values for user-selected 
attributes in the drawing pane. These values are dynamically updated when the current 
time step is changed.

If you’ve already completed Part 4 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_5.swg, 
then click Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Annotation is assigned through the Element 
Symbology manager. If you are using the default 
workspace configuration, the Element Symbology 
manager is located directly below the toolbars on 
the left side of the dialog. If not, click the View 
menu and select the Element Symbology 
command. Highlight Conduit and click the New 
button, then select New Annotation from the 
shortcut menu that appears.

3. In the Annotation Properties dialog that appears, change the Field Name to 
Velocity. In the Prefix field, type in Vel: (with a space after the colon). 

4. The X and Y Initial offset fields allow you to define, respectively, the horizontal 
and vertical distance between the element and the annotation. A positive value for 
Initial X Offset will cause the annotation to be placed to the right of the element at 
the distance specified; a negative value will cause the annotation to be placed to 
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the left of the element. A positive value for Initial Y Offset will cause the annota-
tion to be placed above the element; a negative value will cause the annotation to 
be placed below it. Enter a value of -5.00 feet for the Initial Y Offset.

5. The Initial Height Multiplier allows you to increase the size of text used for the 
annotation. Change this value to 0.750. The Selection Set control allows you to 
apply the current annotation to only those elements contained within a previously 
defined selection set. Leave this value at <All Elements>. Click the OK button.

6. In the EPS Results Browser, click and slowly drag the time slider to the right. 
Note that the velocity annotation values display the updated value for the current 
time step as it changes.

7. In the Element Symbology manager, click the New button and select New Anno-
tation from the shortcut menu that appears. 

8. Change the Field Name to Hydraulic Grade. Enter HGL: (with a space after the 
colon) in the Prefix field. Change the Y Offset to -8.00. Change the Initial 
Height Multiplier value to 0.750. Click the OK button.
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9. Note that the hydraulic grade line value is now displayed below the 
velocity annotation. However, the two annotations slightly overlap. High-
light the Hydraulic Grade annotation node in the Element Symbology 
manager and click the Edit button.

10. In the Annotation Properties dialog that appears, highlight Hydraulic Grade in 
the list pane on the left side of the dialog. Change the Y Offset to -11.00 and click 
the Apply button.

Note the Initial Offset and Initial Multiplier checkboxes. When these are checked, 
the settings for the annotation that is currently highlighted in the list pane will be 
applied to all of the elements with that particular annotation (in this case, all 
conduits). If you have manually moved some of the annotations in the drawing 
pane, you should clear the Initial Offset checkbox so that the new settings won’t 
interfere with your manually repositioned annotations.

11. In the EPS Results Browser, click and slowly drag the time slider to the right to 
see how the values change over time.

12. In the Element Symbology manager, you can create Theme Folders to organize 
the various annotations for an element type. Highlight Conduit and click the New 
button, then select New Folder from the shortcut menu that appears.

13. Highlight the newly created folder and click the Rename button. Enter the 
name Calculated Results.
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14. Click on the Velocity annotation label and hold down the mouse button, 
then drag the mouse cursor to the Calculated Results folder. Your mouse 
cursor will change to a drag object icon. Release the mouse button to 
place the Velocity annotation in the folder. Repeat this procedure with the HGL 
annotation.

15. The checkboxes next to each node in the Element Symbology manager list control 
the visibility of the associated object in the drawing pane, as follows: 

The checkbox next to the Conduit node (and the corresponding checkboxes next 
to each of the other element types) controls the visibility of conduit elements in 
the drawing pane.

The checkbox next to the Label node controls the visibility of conduit element 
labels in the drawing pane.
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The checkbox next to a folder controls the visibility of all annotation definitions 
within that folder. In the case of the Calculated Results folder, it controls the visi-
bility of the Velocity and HGL annotations for conduit elements in the drawing 
pane.

16. Clear the checkbox next to the Calculated Results folder. Note that both the 
Velocity and HGL annotations disappear from the drawing pane, while the Label 
annotation is still displayed. Click the checkbox next to the Calculated Results 
folder to turn the annotations back on.

17. The results annotations may now interfere with the visibility of other elements and 
labels. Manually reposition the element labels if this is the case, so that all of the 
labels are clearly visible (To learn how to manually reposition labels, see “Part 3: 
Moving Element Labels” on page 3-62). Your model should now look like this:

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_5_6.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 6: Applying Color Coding

Color Coding allows you to assign colors based on ranges of values for a specified 
attribute to elements in the plan view. Color coding is useful in performing quick diag-
nostics on the network.
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If you’ve already completed Part 5 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_5_6.swg, 
then click Open.

1. Click the Compute button, then close the Calculation Executive 
Summary dialog.

2. Color Coding is assigned through the Element 
Symbology manager. If you are using the default 
workspace configuration, the Element Symbology 
manager is located directly below the toolbars on 
the left side of the dialog. If not, click the View 
menu and select the Element Symbology 
command. Highlight Conduit and click the New 
button, then select New Color Coding from the shortcut menu that appears.

3. In the Color Coding Properties dialog that appears, change the Field Name to 
Velocity. The Selection Set control allows you to apply the current color coding 
to only those elements contained within a previously defined selection set. Leave 
this value at <All Elements>. 

4. Click the Calculate Range button. 

5. This fills in the Min. and Max. fields using the highest and lowest calculated 
values (over the duration of the entire simulation, not just the current time step) 
for the attribute specified in the Field Name menu. The Steps field lets you 
specify how many intermediate points are created between the minimum and 
maximum values defined by the Min. and Max. fields (with the min and max 
values each representing a point counting towards the total as well). Leave the 
Steps value at 5.
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6. Under Color Maps, leave the Options field set to Color. Click the 
Initialize button. The Color Maps table is now populated with 5 rows 
(because there were 5 steps in the range) and a different color has been 
assigned to each step.

7. Click the arrow button in the Color column of the first row and select 
Yellow. Click the Ramp button. The three middle colors are changed to 
various shades of orange. The Ramp button assigns colors to the interme-
diate rows to create a gradient between the first and last colors in the table. Click 
the OK button.

8. In the EPS Results Browser, click and slowly drag the time slider to the right. 
Note that the color of the conduit elements change according to the calculated 
velocity value for the current time step.

You can also set up color coding to change the size of an element type in the 
drawing pane according to the value of a specified attribute. 
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9. In the Element Symbology manager, click the New button and select New Color 
Coding from the shortcut menu that appears.

10. In the Color Coding Properties dialog, change the Field Name to Hydraulic 
Grade. Leave the Selection Set value at <All Elements>. Click the Calculate 
Range button. Leave the Steps value at 5.

11. Under Color Maps, change the Options value to Size. Click the Initialize button. 
For the first row, leave the Size value in the Color Maps table at 1, the value for 
the second row at 2, the third at 3, the fourth at 4, and the fifth at 5. The Size 
values are a multiplier of the default element symbol size. In the case of link 
elements like conduits, the value is a multiplier of the default line weight (width). 
So a Size value of 5 for a conduit means that a conduit displayed at that value will 
be five times wider than a default conduit. Click the OK button.
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12. In the EPS Results Browser, click and slowly drag the time slider to the right. 
Note that the color of the conduit elements change according to the calculated 
velocity value, while at the same time the size of the conduits changes according 
to the calculated HGL for the current time step.

13. In the Element Symbology manager, you can create Theme Folders to organize 
the various color coding definitions for an element type. Highlight Conduit and 
click the New button, then select New Folder from the shortcut menu that 
appears.

14. Highlight the newly created folder and click the Rename button. Enter the 
name Color Coding Definitions.
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15. Click on the Velocity color coding label and hold down the mouse button, 
then drag the mouse cursor to the Color Coding Definitions folder. Your 
mouse cursor will change to a drag object icon. Release the mouse button 
to place the Velocity color coding definition underneath the folder. Repeat this 
procedure with the HGL color coding definition.

16. The checkboxes next to each node in the Element Symbology manager list control 
the visibility of the associated object in the drawing pane, as follows: 

The checkbox next to the Conduit node (and the corresponding checkboxes next 
to each of the other element types) controls the visibility of conduit elements in 
the drawing pane.

The checkbox next to the Label node controls the visibility of conduit element 
labels in the drawing pane.

The checkbox next to a folder controls the visibility of all annotation definitions 
within that folder. In the case of the Color Coding folder, it controls the visibility 
of the Velocity and HGL color coding definitions for conduit elements in the 
drawing pane.

17. Clear the checkbox next to the Color Coding Definitions folder. Note that both 
the Velocity and HGL color codings disappear from the drawing pane, leaving the 
conduits displayed in the default color and size. Click the checkbox next to the 
Color Coding Definitions folder to turn the color coding definitions back on.

This concludes Lesson 5. The next lesson continues where this one leaves off, so you 
can keep the same project open if you plan to continue immediately. If you plan to 
begin the next lesson at a later time, you can either save the current project or use the 
Lesson_6_1.swg project located in the C:/Program Files/Bentley/SewerGEMS V8i/
Lessons folder.
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Lesson 6: Creating Multiple Storm Events
In Lesson 3, we used a predefined storm event for ease of data entry. In this lesson, we 
will set up multiple return events from synthetic rainfall data and apply them to the 
model by creating a new scenario using a new Rainfall Runoff alternative.

It is common for engineers to consider multiple storm events when designing drainage 
facilities.  Multiple rainfall events are modeled in SewerGEMS via rainfall alterna-
tives and scenario management. 

This lesson describes the process for defining and applying multiple rainfall events. 
Two 24-hour events will be applied to the SCS Type II dimensionless rainfall distribu-
tions.  This procedure can be applied to an unlimited number of design storms for use 
with different scenarios.

General Organization of Storm Events

It is important to understand the overall hierarchy of design storm data in the context 
of scenario management.  There are basically three major levels of design storm data 
that you must create and assign:

Storm Events - This tabular data represents the raw data for a single storm event.  This 
data can come from applying rainfall depth to dimensionless rainfall distributions 
(such as SCS Type I, IA, II, III), or from actual gauged data.   Storm Events are 
entered using the main menu option Analysis / Storm Events.

Rainfall Runoff Alternatives - Each rainfall alternative references an individual Storm 
Event.  Rainfall Runoff alternatives are created and edited by clicking the Alternatives 
button on the main tool bar to access the Alternatives manager.

Scenarios - Any scenario can reference any Rainfall Runoff Alternative.  This hier-
archy provides maximum flexibility for use with scenario management.  Scenarios are 
edited by clicking the Scenario button on the main toolbar.

The overall hierarchy discussed here can be illustrated as:

Scenario references > Rainfall Runoff Alternative that references > Storm Event

EXAMPLE: ENTER MULTIPLE STORM EVENTS FOR THE FOLLOWING DATA, THEN 
REFERENCE WITH RAINFALL RUNOFF ALTERNATIVES AND SCENARIOS:

10-Year, 24-Hour Depth = 4.8 inches,  SCS Type II Dimensionless Distribution

100-Year, 24-Hour Depth = 7.1 inches,  SCS Type II Dimensionless Distribution
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Part 1: Creating Unique Storm Events for Design Storms

We must first establish our raw data for each unique rainfall event.  Follow the 
sequence below to enter 2 SCS rainfall events.

If you’ve already completed Lesson 5, you can continue using the same model. Other-
wise, begin by clicking the File/Open button; then, browse to the C:/Program Files/
Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_6_1.swg, then click 
Open.

1. Click the Components menu and select Storm Events. This will display the 
Storm Events manager window.

We will now enter a SCS rainfall 10-year event.

2. In the Storm Events manager dialog, click 
the New button and select the From 
Dimensionless Curve command from the 
submenu that appears.

3. In the Engineering Libraries dialog that 
appears, the Dimensionless Rainfall 
Curves library will be displayed. Expand 
the Dimensionless Rainfall Curves node 
in the list pane on the left by clicking the 
Plus button, then expand the SCSTYPES.xml node so that all four distributions 
are shown (Types I, IA, II, III).  Select Type II 24hr, then click the Select button.
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4. In the Rainfall Curve Import Settings dialog that appears, change the Storm 
Event Data Type field to Depth and the Storm Event Depth Type to Cumula-
tive. Enter a value of 4.800 in the Depth field, then click OK.

5. SewerGEMS V8i will generate a cumulative rainfall curve by multiplying 4.8 
inches (the depth that was specified in step 4) by the SCS Type II dimensionless 
distribution (the curve type that was selected in Step 3).  The resulting cumulative 
depth table will be displayed in the Data table on the right side of the Storm 
Events dialog. Type 10 in the Return Event field above the Data table.

6. Highlight the newly created storm in the list pane on the left side of the 
dialog and click the Rename button. Type in 10 yr Event.

7. Repeat steps 2 and 3.

8. In the Rainfall Curve Import Settings dialog that appears, change the Storm 
Event Data Type field to Depth and the Storm Event Depth Type to Cumula-
tive. Enter a value of 7.100 in the Depth field, then click OK.

9. Type 100 in the Return Event field above the Data table.
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10. Highlight the newly created storm in the list pane on the left side of the dialog and 
click the Rename button. Type in 100 yr Event.

11. Close the Storm Events manager dialog.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_6_2.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 2: Creating Rainfall Runoff Alternatives to Reference Storm 
Events

In Part 1 of this lesson, we created our raw rainfall storm event data. In this part of the 
lesson, we will reference these storms by creating Rainfall Runoff Alternatives.

If you’ve already completed Part 1 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_6_2.swg, 
then click Open.

1. Click the Analysis menu and select the Alternatives command.

2. In the Alternatives manager dialog that appears, expand the Rainfall 
Runoff Alternative node by clicking the plus button next to it. Highlight 
the Base Alternative and click the Rename button. Type in 10 yr Storm.
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3. Double-click the 10 yr Storm alternative to open up the Rainfall Runoff Alter-
native editor.  Click the Global Rainfall list box.  You should see the 2 events 
that were defined in Part 1 of this lesson, along with Storm Event - 1, which was 
used in the earlier lessons. Select the 10 yr Event. Close the Rainfall Runoff 
Alternative editor.

4. In the Alternatives manager, highlight the Rainfall Runoff Alternative 
node, then click the New button and select the Base Alternative command 
from the submenu that appears.

5. Highlight the newly created base alternative and click the Rename button. Type in 
100 yr Storm.
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6. Double-click the 100 yr Storm alternative to open up the Rainfall Runoff Alter-
native editor.  Click the Global Storm Event list box and select the 100 yr Event. 
Close the Rainfall Runoff Alternative editor.

7. Close the Alternatives manager.

8. Click the Components menu and select the Global Storm Events command. The 
Global Storm Events dialog that appears provides a summary of global storm 
events, their depth, duration, and their original source of distribution data. Close 
the Global Storm Events dialog.
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This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep the same project open if you plan to continue immediately. If you 
plan to begin the next part at a later time, you can either save the current project or use 
the Lesson_6_3.swg project located in the C:/Program Files/Bentley/SewerGEMS 
V8i/Lessons folder.

Part 3: Creating Scenarios to Reference Rainfall Runoff 
Alternatives

In Part 2 of this lesson, we created Rainfall Runoff Alternatives using Storm Events 
defined in Part 1. In this lesson, we will create scenarios that reference the Rainfall 
Runoff Alternatives.

You can reference a single Rainfall Runoff Alternative from an unlimited number of 
scenarios. For example, you may want to apply the same 100-yr design storm to pre-
developed conditions, and two different proposed designs. In each of these three 
cases, you would reference the same 100-year Rainfall Runoff Alternative. This orga-
nization maximizes your flexibility for sharing storm data across different scenarios.

If you’ve already completed Part 2 of this lesson, you can continue using the same 
model. Otherwise, begin by clicking the File/Open button; then, browse to the C:/
Program Files/Bentley/SewerGEMS V8i/Lessons folder, highlight Lesson_6_3.swg, 
then click Open.

1. Click the Analysis pulldown menu and select Scenarios.

2. In the Scenarios manager, highlight the Base scenario, 
then click the New button and select Child Scenario 
from the submenu that appears.
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3. Highlight the newly created scenario and click the Rename button. Type 
in 10 yr Storm.

Tip: When creating design storm scenarios, it is important to include 
the return event description AND scenario description as part of 
the child scenario name. By using this convention, you can 
reference the same design storm from multiple scenarios, while 
clearly differentiating between each scenario when you click the 
fall down scenario list on the main tool bar. If you do not add a 
description in addition to the return event, you could potentially 
see several "100-Year" events in the fall down scenario list, even 
though they reference different topological or physical 
alternatives.

4. Double-click the 10yr Storm scenario to bring up the scenario Property Editor 
dialog.
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5. In the Property Editor, make sure the Rainfall Runoff Alternative is set to 10yr 
Storm.

6. In the Scenarios manager, highlight the Base scenario, then click the New button 
and select Child Scenario from the submenu that appears.

7. Highlight the newly created scenario and click the Rename button. Type in 100 yr 
Storm.
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8. Making sure that the 100 yr Storm scenario is still highlighted in the Scenarios 
manager, set the Rainfall Runoff Alternative to 100 yr Storm in the Property 
Editor.

9. The Base Rainfall Runoff Alternative has been renamed and revised to be a 10 yr 
Event, so highlight the Base scenario in the Scenarios manager and click the 
Rename button. Type in 10 yr Base Design.
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10. In the Scenarios manager, click the Compute button 
and select the Batch Run command from the submenu 
that appears.

11. The Batch Run dialog that appears allows you to calcu-
late a number of scenarios at the same time. Click the 
checkboxes next to 10 yr Storm and 100 yr Storm. 
Click the Batch button.

12. In the Please Confirm dialog that appears, click the Yes button. After both 
scenarios have been calculated, click OK in the Information box that appears.

13. Close the Scenarios manager.

14. In the Drawing Pane, right-click the last conduit before the Treatment outfall, 
CO-8, and select the Graph command from the shortcut menu that appears.

15. In the Graph Series Options dialog that appears, click the 10 yr Storm and 100 
yr Storm checkboxes in the Scenarios list pane. Click the Base checkbox to clear 
it. Click the OK button.

16. The Graph view dialog now displays the flow for each of the scenarios we 
computed during the batch run, allowing you to compare the two.
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This concludes Lesson 6. The next lesson will use different model files, so save your 
model even if you plan to continue immediately. Click the File pulldown menu and 
select the Save As command. Browse to the Program Files/Bentley/SewerGEMS/
Lessons folder and enter the name Lesson_7.swg, then click Save.

Lesson 7: Working With the ArcMap Client
In this lesson, we will discuss using the ArcMap client to:

• Customize the ArcMap interface

• Create a new project

• Lay out a model

• Create a project from an existing Bentley SewerGEMS V8i project

• Use GeoTables to perform ArcMap functions on live Bentley SewerGEMS V8i 
data
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Part 1: Customizing the ArcMap Interface

In this part of the lesson, we will customize the ArcMap interface to display important 
Bentley SewerGEMS V8i dialogs while providing a large area in the display pane for 
model layout and viewing.

1. Start ArcMap.

2. The first time you start ArcMap after installing Bentley SewerGEMS V8i, the 
Bentley SewerGEMS V8i toolbar will be floating (undocked). Dock it in the area 
of the ArcMap toolbars by clicking on the heading bar and holding the mouse 
button, then drag it to an empty area of the ArcMap toolbar area and release the 
mouse button.

3. Click the SewerGEMS V8i menu on the SewerGEMS V8i toolbar and hover the 
mouse cursor over the View menu, then select the Project Manager command.

4. Click the heading bar of the Project Manager dialog, hold down the mouse 
button, and drag the dialog over the middle of the ArcMap Display/Source/Selec-
tion dialog, then release the mouse button. Your interface should now look like 
this:
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5. Click the SewerGEMS V8i menu on the SewerGEMS V8i toolbar and hover the 
mouse cursor over the View menu, then select the Properties command.

6. Click the heading bar of the Properties dialog, hold down the mouse button, and 
drag the dialog to the right edge of the ArcMap window, then release the mouse 
button. Your interface should now look like this:

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep ArcMap open if you plan to continue immediately. If you plan to 
begin the next part at a later time, you can close ArcMap and the interface changes 
you made will be retained next time you open ArcMap.

Part 2: Creating a New Project in ArcMap

An ArcMap Bentley SewerGEMS V8i project consists of:

• A Bentley SewerGEMS V8i .mdb file—this file contains all modeling data, and 
includes everything needed to perform a calculation.

• A Bentley SewerGEMS V8i .swg file—this file contains data such as annotation 
and color-coding definitions.

• A geodatabase association—a project must be linked to a new or existing geoda-
tabase.
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In this part of the lesson, we will be creating an entirely new project and associating it 
to a new geodatabase. If ArcMap is not already open, start it up now. If you have not 
yet completed Part 1 of this lesson, do so now so that all of the necessary SewerGEMS 
V8i tools and dialogs are available to you.

1. In the Project Manager, click the Add Project 
button and select Add New Project from the 
submenu that appears. 

2. In the Save As dialog that appears, browse to 
the Bentley/SewerGEMS/Lessons folder and 
enter the name Lesson8_ArcMap. 

3. Click the Save button.

4. In the Attach Geodatabase dialog that appears, click the Attach Geoda-
tabase button.

5. The Import Into or Create New Geodatabase dialog that appears allows you to 
either select an existing geodatabase to associate the new project with, or to create 
a new one. Create a new geodatabase for the project by entering the file name 
Lesson8_ArcMap_GDB, then click the Save button.

6. In the Attach Geodatabase dialog, leave the default Dataset Name of 
Lesson8_ArcMap. 

7. Click the OK button.
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8. ArcMap layers for each Bentley SewerGEMS V8i element type are automatically 
created.

9. In addition, the project is listed in the Project Manager.

10. Note the icon next to the project name. This icon indicates that the project is 
the current project. Only one project can be the current project at one time; if 
there were more than one project open, only one would display this icon. 

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep ArcMap open if you plan to continue immediately. If you plan to 
begin the next part at a later time, you can close ArcMap - the project we will use for 
the next part of the lesson has been created and there is no need to save the ArcMap 
.mxd because the project is empty.
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Part 3: Laying out a Model In ArcMap

Laying out a model in the ArcMap client differs from laying one out in Stand-Alone in 
a couple of different respects. This part of the lesson describes the procedure for 
laying out polygon, node, and link elements in ArcMap.

If ArcMap is not already open, start it up now. If you have not yet completed Parts 1 
and 2 of this lesson, do so now so that all of the necessary Bentley SewerGEMS V8i 
tools and dialogs are available to you, and so that you have a new project to work 
with.

1. Click the Add Data button.

2. In the Add Data dialog that appears, browse to the Bentley/SewerGEMS 
V8i/Lessons directory. Highlight LessonLayout.dxf. The Add Data dialog 
will display two separate files with this name - use the one with the icon 
pictured to the right.

3. Click the Add button.

4. To add or move elements, you must be in an edit session. Click the 
Editor button and select the Start Editing command from the 
submenu that appears.
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5. Note that the SewerGEMS V8i toolbar becomes active. Click the Catch-
ment button.

6. Click on one of the corners of the catchment outline for CM-1. Drag the mouse to 
the next corner, and click again.

7. Continue laying out the catchment boundaries by clicking each corner until you 
click the last one. Right-click and select Finish Sketch from the submenu that 
appears.

8. Click the Manhole button.

9. Click on the location indicated by the dxf background for MH-1 to place a 
manhole there. 

10. Click on the location indicated by the dxf background for MH-2 to place a 
manhole there.

11. Click the Conduit button.

12. Click on MH-1, then click on MH-2. Right-click and select Finish Sketch 
to lay out the conduit.

13. Click the Editor button and select the Stop Editing command. A prompt will 
appear, asking Do you want to save your edits? Click the Yes button.

14. We won’t be using this project for the remainder of the lesson. In the Project 
Manager, highlight Lesson8_ArcMap.swg and click the Remove Project 
button.

15. Note the warning that appears. Be careful with the Remove Project command, 
because as the warning indicates, the operation irreparably breaks the geodatabase 
connection. You will still be able to open the project in Stand-Alone mode, but not 
in ArcMap.

16. Right-click the Layers node in the ArcMap Display dialog and click the Select 
All Layers command. 

17. Right-click one of the selected layers and click the Remove command to delete 
the layers and clear the map.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep ArcMap open if you plan to continue immediately. If you plan to 
begin the next part at a later time, you can close ArcMap - we’ll be starting a new 
project so there is nothing that needs to be saved.
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Part 4: Creating A New ArcMap Project From An Existing Bentley 
SewerGEMS V8i Project

In this part of the lesson, we will be creating a new project in the ArcMap client and 
associating it to a new geodatabase. If ArcMap is not already open, start it up now. If 
you have not yet completed Part 1 of this lesson, do so now so that all of the necessary 
Bentley SewerGEMS V8i tools and dialogs are available to you.

1. Click the Add Project button and select the 
Add Existing Project command from the 
submenu that appears.

2. In the Open dialog that appears, browse to the 
Bentley/SewerGEMS V8i/Lessons folder, 
highlight Lesson_7_Final.swg, and click the Open button.

3. In the Attach Geodatabase dialog that appears, click the Attach Geoda-
tabase button.

4. The Import Into or Create New Geodatabase dialog that appears allows you to 
either select an existing geodatabase to associate the new project with, or to create 
a new one. Create a new geodatabase for the project by entering the file name 
Lesson7_Final_ArcMap.mdb, then click the Save button.

5. In the Attach Geodatabase dialog, leave the default Dataset Name of 
Lesson_7_Final. 

6. Click the OK button.

7. ArcMap layers are created for each element type, and the network is displayed in 
the drawing pane.

This concludes this part of the lesson. The next part continues where this part leaves 
off, so you can keep ArcMap open if you plan to continue immediately. If you plan to 
begin the next part at a later time, you can close ArcMap - the project we will use for 
the next part of the lesson has been created and there is no need to save the ArcMap 
.mxd since no changes were made to the map settings.

Part 5: Using GeoTables

GeoTables allow you to use the viewing and rendering tools provided by the ArcMAP 
environment on all of your Bentley SewerGEMS V8i data, including both calculated 
results and input.
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If ArcMap is not already open, start it up now. If you have not yet completed Parts 1 
and 4 of this lesson, do so now so that all of the necessary Bentley SewerGEMS V8i 
tools and dialogs are available to you, and so that you have a completed project to 
work with.

1. Click the SewerGEMS V8i menu on the SewerGEMS V8i toolbar and hover the 
mouse cursor over the Analysis menu, then select the Compute command.

2. Click the SewerGEMS V8i menu on the SewerGEMS V8i toolbar and hover the 
mouse cursor over the View menu, then select the FlexTables command. Leave 
the FlexTable manager dialog floating (not docked), and position it so that you can 
still see the map display.

3. In the FlexTables dialog, scroll down to the GeoTables node and expand it if 
necessary by clicking the plus button. Double-click the Conduit node under the 
GeoTables heading.

4. In the FlexTable: Conduit GeoTable dialog that appears, note the 
attributes that are currently included. The attributes in the GeoTable are 
the only ones that are available for use with ArcGIS functions and 
commands. Click the Edit button.
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5. The Table: Conduit GeoTable dialog that appears allows you to add and remove 
attribute columns to/from the GeoTable. To add attributes to the GeoTable, you 
must move the desired attributes from the Available list to the Selected list. Find 
Hydraulic Grade in the Available list and double-click it to move it to the 
Selected list.

6. Click OK.

7. Note that the FlexTable: Conduit GeoTable dialog now contains a column for 
Hydraulic Grade, and the calculated HGL is displayed for each conduit. Close 
the dialog.

8. The calculated Hydraulic Grade is now available for use with ArcMap commands. 
Click the ArcMap Selection menu and choose the Select By Attributes 
command.

9. In the Select By Attributes dialog that appears, click the Layer pulldown menu 
and select Conduit. Double-click “Hydraulic_Grade” in the Fields list to add it 
to the query statement pane. Click the >= button to add it to the query. Click the 
Get Unique Values button, then double-click 100 in the Unique Values list.
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10. Click the Verify button; you should receive the message The expression was 
successfully verified. Click the Apply button.

11. Click the Close button. Note that three of the conduits in the drawing pane are 
selected.

12. Click the ArcGIS Selection menu and choose the Clear Selected Features 
command.
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13. You can also apply ArcMap symbology settings based on Bentley SewerGEMS 
V8i attributes that have been added to the appropriate GeoTable. Double click the 
Conduit layer in the ArcMap Layers dialog.

14. In the Layer Properties dialog that appears, click the Symbology tab.

15. Click Quantities in the Show: list, then highlight Graduated Colors. Click the 
Value: pulldown menu and select Hydraulic_Grade. Change the Color Ramp 
setting if desired. Leave the Normalization and Classes fields set to their 
defaults.
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16. Click the OK button.

17. Note that the conduits are now color-coded according to their calculated hydraulic 
grade.

Lesson 8: Adding Hydrographs Using the RTK 
Runoff Method
The RTK method is used to generate a hydrograph based on precipitation data. It 
forms the hydrograph by combining triangular hydrographs from three components of 
flow: 

• Rapid inflow

• Moderate infiltration

• Slow infiltration

In this lesson, we will define RTK tables and assign them to the catchments in a 
model.

Let’s begin by starting up Bentley SewerGEMS V8i. If SewerGEMS V8i is already 
open, skip step one and click the File pulldown menu and select the Open command 
instead, then proceed to step two.

1. In the Welcome to Bentley SewerGEMS V8i dialog that appears, click the Open 
Existing Project button.

2. Browse to the C:/Program Files/Bentley/SewerGEMS V8i/Lessons folder, high-
light Lesson_8.swg, then click Open.
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First, create the RTK tables that will be applied to the catchments in the model. The 
RTK parameters are a property of each catchment. However, it is not uncommon for 
many catchments with similar characteristics to share the same RTK parameters. 
Therefore, the RTK parameters are entered in a named RTK table and that table can be 
shared among many catchments.

3. Click the Components menu and select the RTK Tables command.

4. In the RTK Tables dialog that appears, click the New button.

5. Click the newly created table to select it if it’s not already highlighted, and 
click the Rename button.

6. Enter the name CM-1.
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7. With CM-1 still highlighted, enter the RTK values for the rapid inflow component 
of flow. The R, T, and K values for rapid inflow represent the following attributes:

– R—Fraction of precipitation that enters the collection system for rapid inflow. 

– T—The time from the precipitation pulse to the peak of rapid inflow of the 
hydrograph. 

– K—The ratio of the time to peak to time to end of hydrograph for rapid 
inflow.

Enter the values of R, T, and K for the rapid inflow component of flow in the 
corresponding fields of the RTK Tables dialog as follows:

8. Next, with CM-1 still highlighted, enter the RTK values for the moderate infiltra-
tion component of flow. The R, T, and K values for moderate infiltration represent 
the following attributes:

– R—Fraction of precipitation that enters the collection system for moderate 
infiltration. 

– T—The time from the precipitation pulse to the peak of moderate infiltration 
of the hydrograph. 

– K—The ratio of the time to peak to time to end of hydrograph for moderate 
infiltration.

Table 3-10: Rapid Inflow RTK Values for CM-1

Attribute Value

Rapid Inflow 
R

0.020

Rapid Inflow 
T

2.000

Rapid Inflow 
K

1.400
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9. Enter the values of R, T, and K for the moderate infiltration component of flow in 
the corresponding fields of the RTK Tables dialog as follows:

10. Finally, with CM-1 still highlighted, enter the RTK values for the slow infiltration 
component of flow. The R, T, and K values for slow inflow represent the 
following attributes:

– R—Fraction of precipitation that enters the collection system for slow infiltra-
tion. 

– T—The time from the precipitation pulse to the peak of slow infiltration of 
the hydrograph. 

– K—The ratio of the time to peak to time to end of hydrograph for slow infil-
tration.

11. Enter the values of R, T, and K for the slow infiltration component of flow in the 
corresponding fields of the RTK Tables dialog as follows:

Table 3-11: Moderate Infiltration RTK Values for CM-1

Attribute Value

Moderate 
Infiltration R

0.050

Moderate 
Infiltration T

3.000

Moderate 
Infiltration K

1.600

Table 3-12: Slow Infiltration RTK Values for CM-1

Slow 
Infiltration R

0.010

Slow 
Infiltration T

4.000

Slow 
Infiltration K

1.750
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12. The RTK table for CM-1 should now look like this:

13. Follow steps 4-11 to create three more tables for CM-2, CM-3, and CM-4 using 
the following values:

Table 3-13: 

Attribute CM-2 Value CM-3 Value CM-4 Value

Rapid Inflow R 0.001 0.120 0.200

Rapid Inflow T 0.200 1.000 1.000

Rapid Inflow K 2.000 1.500 1.500

Moderate Infiltration R 0.002 0.040 0.040

Moderate Infiltration T 1.000 2.000 2.000

Moderate Infiltration K 2.000 1.500 1.500

Slow Infiltration R 0.140 0.020 0.020

Slow Infiltration T 2.000 3.000 3.000

Slow Infiltration K 1.750 1.500 1.500
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14. The RTK Tables dialog should now look like this:

15. The RTK tables can now be assigned to the catchments in the model. Click the 
Close button to close the RTK Tables dialog. In the drawing pane, highlight catch-
ment CM-1.
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16. With CM-1 highlighted, find the Unit Hydrograph Method attribute in the 
Property Editor. Click the pulldown menu and change the value to RTK Unit 
Hydrograph.
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17. Click the pulldown menu in the RTK Table attribute field of the Property Editor 
and select CM-1.

18. Repeat steps 15-17 for catchments CM-2, CM-3, and CM-4, assigning the corre-
spondingly named RTK tables to each catchment.

19. Click the Compute button and review the results using Reports, FlexTa-
bles, Graphs, Profiles, Annotation, and Color Coding as described in 
“Lesson 5: Presenting Calculated Results” on page 3-84.

This concludes the QuickStart Lessons. For more information on any of Bentley 
SewerGEMS V8i’s functions, you can right-click or press the F1 key to access the 
context-sensitive online help at any time.
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Chapter

Starting a Project
Welcome Dialog Box
When you first start Bentley SewerGEMS V8i, the Welcome dialog box appears. The 
Welcome dialog box contains the following controls:

You can access the Welcome dialog box at any time from the Help menu in Bentley 
SewerGEMS V8i.

Quick Start Lessons Opens the online help to the Quick Start Lessons 
Overview topic.

Create New Project Creates a new Bentley SewerGEMS V8i project. 
When you click this button, an untitled Bentley 
SewerGEMS V8i project is created.

Open Existing Project Opens an existing project. When you click this 
button, the Windows Select Bentley SewerGEMS 
V8i Project to Open dialog box appears, allowing 
you to browse to the project to be opened.

Open from 
ProjectWise

Open an existing Bentley SewerGEMS V8i project 
from ProjectWise. You are prompted to log into a 
ProjectWise datasource if you are not already 
logged in.

Show This Dialog at 
Start

When selected, the Welcome dialog box appears 
whenever you start Bentley SewerGEMS V8i. 
Clear this box if you do not want the Welcome 
dialog box to appear whenever you start Bentley 
SewerGEMS V8i.
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Projects
All data for a model are stored in Bentley SewerGEMS V8i as a project. Bentley 
SewerGEMS V8i project files have the file name extension .swg. Bentley Sewer-
GEMS V8i lets you open more than one project at a time. You can assign a title, date, 
notes and other identifying information about each project using the Project Properties 
dialog box. You can have up to five Bentley SewerGEMS V8i projects open at one 
time.

Starting a New Project

To start a new project, select File > New or press Ctrl+N. An untitled project is 
opened in the drawing pane.

Opening an Existing Project

To open an existing project, select File > Open or press Ctrl+O. A dialog box appears 
allowing you to browse for the project you want to open.

Displaying Multiple Projects

To switch between multiple open projects, click the appropriate tab at the top of the 
drawing pane. The file name of the project is displayed on the tab.

Setting Project Properties
The Project Properties dialog box let you enter project-specific information to help 
identify the project. Project properties are stored with the project.

To set project properties:

Select File > Project Properties, enter information in the Project Properties dialog 
box and click OK.

Project Properties Dialog Box

The dialog box contains the following text fields and controls: 

Title Lets you type a title for the project.

File Name Displays the file name for the current project. If 
you have not saved the project yet, the file name is 
listed as “Untitled.swg.”

Engineer Lets you type name of the project engineer.
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Setting Options
You can change global settings for Bentley SewerGEMS V8i in the Options dialog 
box. The Options dialog box contains four tabs, each of which lets you change a 
different group of global settings.

Click one of the following links to learn more about the Options dialog box:

• “Options Dialog Box - Global Tab” on page 4-147

• “ Options Dialog Box - Project Tab”

• “Options Dialog Box - Drawing Tab” on page 4-151

• “Options Dialog Box - Units Tab” on page 4-152

• “Options Dialog Box - Labeling Tab” on page 4-155

• “Options Dialog Box - ProjectWise Tab” on page 4-156

Options Dialog Box - Global Tab

The Global tab lets you change general program settings for the Bentley SewerGEMS 
V8i stand-alone editor, including whether or not to display the status pane, as well as 
window color and layout settings. 

Company Lets you type the name of your company.

Date Click this field to display a calendar, which lets 
you use your mouse to set a date for the project.

Notes Lets you type additional information about the 
project.
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The Global tab contains the following controls:

General Settings

Backup Levels Indicates the number of backup copies that 
are retained when a project is saved. The 
default value is 1. 

Note: The higher this number, the 
more .BAK files (backup 
files) are created, thereby 
using more hard disk space 
on your computer.

Show recently used 
files

The checkbox turns the list of recently opened 
files on and off. The File menu has the ability 
to display a list of recently opened files, 
providing shortcuts that let you quickly access 
projects. When this check box is cleared, 
these shortcuts are not available from the File 
menu. When the box is checked, you can 
specify a number of files between 1 and 15 to 
show by typing the number in the adjacent 
field.

Compact Database 
After

When selected, the Bentley SewerGEMS V8i 
database is automatically compacted when 
you save a particular file the specified number 
of times.

Status Pane When selected, activates the Status Pane 
display at the bottom of the Bentley 
SewerGEMS V8i stand-alone editor. This 
check box is selected by default.

Show Welcome 
Page on Startup

When selected, activates the Welcome dialog 
that appears when you first start Bentley 
SewerGEMS V8i. This check box is selected 
by default.

Zoom Extents on 
Open

When this box is checked a Zoom Extents 
operation is performed upon fiel open, so that 
the entire network is displayed in the drawing 
pane.
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Window Color Settings

Background Color Displays the color that is currently assigned to 
the drawing pane background. You can 
change the color by clicking the ellipsis button 
(...) to open the Color dialog box.

Foreground Color Displays the color that is currently assigned to 
elements and labels in the drawing pane. You 
can change the color by clicking the ellipsis 
button (...) to open the Color dialog box.

Read Only 
Background Color

Displays the color that is currently assigned to 
data field backgrounds. You can change the 
color by clicking the ellipsis button (...) to open 
the Color dialog box.

Read Only 
Foreground Color

Displays the color that is currently assigned to 
data field text. You can change the color by 
clicking the ellipsis button (...) to open the 
Color dialog box.

Selection Displays the color that is currently assigned to 
elements that are selected in the drawing 
pane. You can change the color by clicking the 
ellipsis button (...) to open the Color dialog 
box.

Layout Settings

Display Inactive 
Topology

When selected, activates the display of 
inactive element in the drawing pane in the 
color defined in Ithe adjacent color box. When 
not selected, inactive elements will not be 
visible in the drawing pane. This check box is 
selected by default.

Auto Refresh Activates Auto Refresh. When Auto-Refresh is 
active, the drawing pane automatically 
updates whenever changes are made to the 
Bentley SewerGEMS V8i datastore. This 
check box is selected by default.
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Options Dialog Box - Project Tab

Sticky Tool Palette When selected, activates the Sticky Tools 
feature. When Sticky Tools is activated, the 
drawing pane cursor does not reset to the 
Select tool after you create a node or finish a 
pipe run in your model, allowing you to 
continue dropping new elements into the 
drawing without re-selecting the tool. When 
Sticky Tools is not activated, the drawing pane 
cursor resets to the Select tool after you 
create a node. This check box is selected by 
default.

Select Polygons by 
Edge

When selected, lets you select polygons in 
your model at their edges instead of anywhere 
inside the polygon. This check box is cleared 
by default.

Selection Handle 
Size In Pixels

Specifies, in pixels, the size of the handles 
that appear on selected elements. Enter a 
number from 1 to 10.

Default Drawing 
Style for New 
Projects

Choose the style in which elements are 
displayed in the drawing pane. Under GIS 
style, the size of element symbols in the 
drawing pane will remain the same regardless 
of zoom level. Under CAD style, element 
symbols will appear larger or smaller 
depending on zoom level.

Geospatial Settings

Spatial Reference Used for integration with Projectwise Geospatial. 
You can leave the field blank if there is no spatial 
information.

Element Labeling Options

Element Identifier 
Format

Specifies the format in which reference fields are 
used. Reference fields are fields that link to 
another element or support object (pump 
definitions, patterns, controls, zones, etc.). 
4-150 Bentley SewerGEMS V8i User’s Guide



Starting a Project
Options Dialog Box - Drawing Tab

This tab contains drawing layout and display settings. You can set the scale that you 
want to use as the finished drawing scale for the plan view output. Drawing scale is 
based upon engineering judgment and the destination sheet sizes to be used in the final 
presentation. The Drawing tab contains the following controls:

Result Files

Specify Custom 
Results File Path?

When checked, allows you to edit the results file 
path and format by enabling the other controls in 
this section. 

Root Path Allows you to specify the root path where results 
files are stored. You can type the path manually or 
choose the path from a Browse dialog by clicking 
the ellipsis (...) button.

Path Format Allows you to specify the path format. You can 
type the path manually and use predefined 
attributes from the menu accessed with the [>] 
button..

Path Displays a dynamically updated view of the 
custom result file path based on the settings in the 
Root Path and Path Format fields.

Drawing Scale Settings

Drawing Mode Drop-down list that lets you select either Scaled or 
Schematic mode for models in the drawing pane.

Horizontal Scale 
Factor 1 in. =:

Controls the scale of the plan view. This value 
affects the text height when printing-to-scale and 
does not affect the scaled length or area results.

Annotation Multipliers Settings

Symbol Size Mulitplier Increases or decreases the size of your symbols by 
the factor indicated. For example, a multiplier of 2 
would result in the symbol size being doubled. 
The program selects a default symbol height that 
corresponds to 4.0 ft. (approximately 1.2 m) in 
actual-world units, regardless of scale.
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Options Dialog Box - Units Tab

The Units tab lets you modify the unit settings for the current project. The Units tab 
contains the following controls:

Text Height Multiplier Increases or decreases the default size of the text 
associated with element labeling by the factor 
indicated. The program automatically selects a 
default text height that displays at approximately 
2.5 mm (0.1 in) high at the user-defined drawing 
scale. A scale of 1.0 mm = 0.5 m, for example, 
results in a text height of approximately 1.25 m. 
Likewise, a 1 in. = 40 ft. scale equates to a text 
height of around 4.0 ft.

Pipe Text Setting

Align Text with Pipes Turns text alignment on and off. When this check 
box is selected, labels are aligned to their 
associated pipes. When the check box is cleared, 
labels are displayed horizontally near the center of 
the associated pipe.

Color Element 
Annotations

When this box is checked, color coding settings 
are applied to the element annotation.

Save As Lets you save the current unit settings as a separate 
.xml file. This file allows you to reuse your Units 
settings in another project. When the button is clicked, 
a Windows Save As dialog box appears, allowing you 
to enter a name and specify the directory location of 
the .xml file.

Load Lets you load a previously created Units project .xml 
file, thereby transferring the unit and format settings 
that were defined in the previous project. When the 
button is clicked, a Windows Load dialog box appears, 
allowing you to browse to the location of the desired 
.xml file.

Reset Defaults - SI Resets the unit and formatting settings to the original 
factory defaults for the System International (Metric) 
system.
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Reset Defaults - US Resets the unit and formatting settings to the original 
factory defaults for the Imperial (U.S.) system.

Default Unit System 
for New Project

Lets you specify the unit system that is used globally 
across the project. Note that you can locally change 
any number of attributes to use system other than the 
one specified here.
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Units Table The units table contains the following columns: 

• Label—Displays the parameter measured by the 
unit. 

• Unit—Displays the type of measurement. To 
change the unit of an attribute type, click the 
choice list and click the unit you want. This option 
also allows you to use both U.S. customary and SI 
units in the same worksheet. 

• Display Precision—Sets the rounding of 
numbers and number of digits displayed after the 
decimal point. Enter a negative number for 
rounding to the nearest power of 10: (-1) rounds to 
10, (-2) rounds to 100, (-3) rounds to 1000, and so 
on. Enter a number from 0 to 15 to indicate the 
number of digits after the decimal point. 

• Format Menu—Lets you select the display format 
used by the current field. Choices include:

• Scientific—Converts the entered value to a 
string of the form "-d.ddd...E+ddd" or "-
d.ddd...e+ddd", where each 'd' indicates a 
digit (0-9). The string starts with a minus sign 
if the number is negative. 

• Fixed Point—Abides by the display precision 
setting, and automatically enters zeros after 
the decimal place to do so. With a display 
precision of 3, an entered value of 3.5 
displays as 3.500. 

• General—Truncates any zeros after the 
decimal point, regardless of the display preci-
sion value. With a display precision of 3, the 
value that would appear as 5.200 in Fixed 
Point format displays as 5.2 when using 
General format. The number is also rounded. 
So, an entered value of 5.35 displays as 5.4, 
regardless of the display precision. 

• Number—Converts the entered value to a 
string of the form "-d,ddd,ddd.ddd...", where 
each 'd' indicates a digit (0-9). The string 
starts with a minus sign if the number is nega-
tive. Thousand separators are inserted 
between each group of three digits to the left 
of the decimal point.
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Options Dialog Box - Labeling Tab

The Element Labeling tab is used to specify the automatic numbering format of new 
elements as they are added to the network. You can save your settings to an .xml file 
for later use. The Element Labeling tab contains the following controls:

Save As Lets you save your element labeling settings to an 
element label project file, which is an. xml file.

Load Lets you open an existing element label project 
file.

Reset Fills in the Next column for each element based 
on the labels already used in the model and the 
increment value that has been set. So, for example, 
if the model contains conduits CO-1, CO-2, and 
CO-3 and the Increment value is 1, clicking Reset 
will fill in the Next column with CO-4 for the 
Conduit row.
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Options Dialog Box - ProjectWise Tab

Note: These settings affect ProjectWise users only.

The ProjectWise tab contains options for using SewerGEMS V8i with ProjectWise. 

Labeling Table The labeling table contains the following columns:

• Element—Shows the type of element to 
which the label applies.

• On—Lets you turn automatic element labeling 
on and off for the associated element type.

• Next—Lets you enter the integer you want to 
use as the starting value for the ID number 
portion of the label. Bentley SewerGEMS V8i 
generates labels beginning with this number 
and chooses the first available unique label.

• Increment—Lets you enter the integer that is 
added to the ID number after each element is 
created to yield the number for the next 
element.

• Prefix—Lets you enter the letters or numbers 
that appear in front of the ID number for the 
elements in your network.

• Digits—Lets you enter the minimum number 
of digits that the ID number has. For instance, 
1, 10, and 100 with a digit setting of two would 
be 01, 10, and 100.

• Suffix—Lets you enter the letters or numbers 
that appear after the ID number for the 
elements in your network.

• Preview—Lets you see what the label looks 
like, based on the information you have 
entered in the previous fields.
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This tab contains the following controls:

For more information about using SewerGEMS V8i with ProjectWise, see “Consider-
ations for ProjectWise Users” on page 4-158.

Default Datasource Displays the current ProjectWise datasource. If 
you have not yet logged into a datasource, this 
field will display <login>. To change the 
datasource, click the Ellipses (...) button to open 
the Change Datasource dialog box. If you click 
Cancel after you have changed the default 
datasource, the new default datasource is retained.

Update server on Save When this is checked, any time you save your 
SewerGEMS V8i project locally using the File > 
Save menu command, the files on your 
ProjectWise server will also be updated and all 
changes to the files will immediately become 
visible to other ProjectWise users. This option is 
turned off by default.

Note: This option, when turned on, 
can significantly affect 
performance, especially for 
large, complex projects.
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Considerations for ProjectWise Users
Bentley ProjectWise provides managed access to SewerGEMS V8i content within a 
workgroup, across a distributed organization, or among collaborating professionals. 
When ProjectWise is integrated with SewerGEMS V8i, project files can be accessed 
quickly, checked out for use, and checked back in directly from within SewerGEMS 
V8i.

If ProjectWise is installed on your system, SewerGEMS V8i automatically installs all 
the components necessary for you to use ProjectWise to store and share your Sewer-
GEMS V8i projects.

To learn more about ProjectWise, refer to the ProjectWise online help. 
To learn more about using ProjectWise with SewerGEMS V8i, see the following 
topics:

• “General Guidelines for using ProjectWise” on page 4-158

• “Performing ProjectWise Operations” on page 4-159

General Guidelines for using ProjectWise 

Follow these guidelines when using SewerGEMS V8i with ProjectWise:

• Use the File > ProjectWise commands to perform ProjectWise file operations, 
such as Save, Open, and Change Datasource.

• The first time you choose one of the File > ProjectWise menu commands in your 
current SewerGEMS V8i session, you are prompted to log into a ProjectWise 
datasource. The datasource you log into remains the current datasource until you 
change it using the File > ProjectWise > Change Datasource command.

• Use SewerGEMS V8i’s File > New command to create a new project. The project 
is not stored in ProjectWise until you select File > ProjectWise > Save As.

• Use SewerGEMS V8i’s File > Open command to open a local copy of the current 
project.

• Use SewerGEMS V8i’s File > Save command to save a copy of the current project 
to your local computer.

• When you Close a project already stored in ProjectWise using File > Close, you 
are prompted to select one of the following options:

– Check In—Updates the project in ProjectWise with your latest changes and 
unlocks the project so other ProjectWise users can edit it.

– Unlock—Unlocks the project so other ProjectWise users can edit it but does 
not update the project in ProjectWise. Note that this will abandon any changes 
you have made since the last server update.
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– Leave Out—Leaves the project checked out so others cannot edit it and 
retains any changes you have made since the last server update to the files on 
your local computer. Select this option if you want to exit Bentley Sewer-
GEMS V8i but continue working on the project later.

• In the SewerGEMS V8i Options dialog box, there is a ProjectWise tab with the 
Update server on Save check box. This option, when turned on, can significantly 
affect performance, especially for large, complex projects. When this is checked, 
any time you save your SewerGEMS V8i project locally using the File > Save 
menu command, the files on your ProjectWise server will also be updated and all 
changes to the files will immediately become visible to other ProjectWise users. 
This option is turned off by default.

• In this release of SewerGEMS V8i, calculation result files are not managed inside 
ProjectWise. A local copy of results is maintained on your computer, but to ensure 
accurate results you should recalculate projects when you first open them from 
ProjectWise.

• SewerGEMS V8i projects associated with ProjectWise appear in the Most 
Recently Used Files list (at the bottom of the File menu) in the following format:

pwname://PointServer:_TestDatasource/Documents/TestFolder/Test1.prj

Performing ProjectWise Operations

You can quickly tell whether or not the current SewerGEMS V8i project is in Project-
Wise or not by looking at the title bar and the status bar of the SewerGEMS V8i 
window. If the current project is in ProjectWise, “pwname://” will appear in front of 
the file name in the title bar, and a ProjectWise icon will appear on the far right side of 
the status bar, as shown below.

You can perform the following ProjectWise operations from within SewerGEMS V8i:

To save an open SewerGEMS V8i project to ProjectWise:

1. In SewerGEMS V8i, select File > ProjectWise > Save As.

2. If you haven’t already logged into ProjectWise, you are prompted to do so. Select 
a ProjectWise datasource, type your ProjectWise user name and password, then 
click Log in.
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3. In the ProjectWise Save Document dialog box, enter the following information:

a. Click Change next to the Folder field, then select a folder in the current 
ProjectWise datasource in which to store your project.

b. Type the name of your SewerGEMS V8i project in the Name field. We recom-
mend that you keep the ProjectWise name the same as or as close to the 
SewerGEMS V8i project name as possible.

c. Keep the default entries for the rest of the fields in the dialog box

d. Click OK.

To open a SewerGEMS V8i project from a ProjectWise datasource:

1. Select File > ProjectWise > Open.

2. If you haven’t already logged into ProjectWise, you are prompted to do so. Select 
a ProjectWise datasource, type your ProjectWise user name and password, then 
click Log in.

3. In the ProjectWise Select Document dialog box, perform these steps:

a. From the Folder drop-down menu, select a folder that contains SewerGEMS 
V8i projects.

b. In the Document list box, select a SewerGEMS V8i project.

c. Keep the default entries for the rest of the fields in the dialog box

d. Click Open.

To copy an open SewerGEMS V8i project from one ProjectWise datasource to 
another:

1. Select File > ProjectWise > Open to open a project stored in ProjectWise.

2. Select File > ProjectWise > Change Datasource.

3. In the ProjectWise Log in dialog box, select a different ProjectWise datasource, 
then click Log in.

4. Select File > ProjectWise > Save As.

5. In the ProjectWise Save Document dialog box, change information about the 
project as required, then click OK.

To make a local copy of a SewerGEMS V8i project stored in a ProjectWise data-
source:

1. Select File > ProjectWise > Open.

2. If you haven’t already logged into ProjectWise, you are prompted to do so. Select 
a ProjectWise datasource, type your ProjectWise user name and password, then 
click Log in.
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3. Select File > Save As.

4. Save the SewerGEMS V8i project to a folder on your local computer.

To change the default ProjectWise datasource:

1. Start SewerGEMS V8i.

2. Select File > ProjectWise > Change Datasource.

3. In the ProjectWise Log in dialog box, type the name of ProjectWise datasource 
you want to log into, then click Log in.

To use background layer files with ProjectWise:

• Using File > ProjectWise > Save As—If there are background files, you are 
prompted with two options: you can copy the background layer files to the project 
folder for use by the project, or you can remove the background references and 
manually reassign them once the project is in ProjectWise to other existing 
ProjectWise documents.

• Using File > ProjectWise > Open—This works the same as the normal Project-
Wise > Open command, except that background layer files are not locked in 
ProjectWise for the current user to edit. The files are intended to be shared with 
other users at the same time.

• To add a background layer file reference to a project that exists in Project Wise—
The ProjectWise Select Document dialog box opens, and you can choose any 
existing ProjectWise document. You must have previously added these back-
ground layer files as described in the first bullet above, or by using the Project-
Wise Explorer.

• When you remove a background layer file reference from a project that exists in 
ProjectWise, the reference to the file is removed but the file itself is not deleted 
from ProjectWise.

• Using File > Save As—When you use File > Save As on a project that is already 
in ProjectWise and there are background layer files, you are prompted with two 
options: you can copy all the files to the local project folder for use by the project, 
or you can remove the background references and manually reassign them after 
you have saved the project locally.

Using ProjectWise with Bentley SewerGEMS V8i for AutoCAD

Bentley SewerGEMS V8i for AutoCAD maintains a one to one relationship between 
the AutoCAD drawing (.dwg) and the Bentley SewerGEMS V8i project file.  When 
using ProjectWise with this data, we recommend that you create a Set in the Project-
Wise Explorer.  Included in this set should be the AutoCAD drawing (example.dwg), 
the Bentley SewerGEMS V8i database (example.swg.mdb), the Bentley SewerGEMS 
V8i project file (example.swg), and optionally for stand-alone, the stand-alone 
drawing setting file (example.swg.dwh).
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If you use the Set and the ProjectWise Explorer for all of your check-in / check-out 
procedures, you will maintain the integrity of this relationship. We recommended that 
you do not use the default ProjectWise integration in AutoCAD, as this will only work 
with the .dwg file.

Using ProjectWise with Bentley SewerGEMS V8i for MicroStation

When using ProjectWise with a MicroStation SewerGEMS V8i project, we recom-
mend that you create a Set in the ProjectWise Explorer.  Included in this set should be 
the MicroStation drawing (example.dgn), the Bentley SewerGEMS V8i database 
(example.swg.mdb), the Bentley SewerGEMS V8i project file (example.swg), and 
optionally for stand-alone, the stand-alone drawing setting file (example.swg.dwh).

If you use the Set and the ProjectWise Explorer for all of your check-in / check-out 
procedures, you will maintain the integrity of this relationship. We recommended that 
you do not use the default ProjectWise integration in AutoCAD, as this will only work 
with the .dgn file.

Importing Data From Other Models
Bentley SewerGEMS V8i lets you import data from a variety of data sources, 
including Bentley SewerGEMS V8i, EPA SWMM, SewerCAD, and StormCAD.

• “Importing Data from a CivilStorm Database” on page 4-162

• “Importing Data from SewerCAD” on page 4-163

• “Importing a StormCAD Exchange Database” on page 4-164

• “Importing StormCAD V8i” on page 4-165

• “Importing Data from Bentley Wastewater” on page 4-166

Importing Data from a CivilStorm Database

You can import data from another SewerGEMS V8i project by importing the Sewer-
GEMS V8i database (.MDB) file. You might want to do this if you need to rebuild 
your model, or if you want to open a SewerGEMS V8i project sent to you by another 
SewerGEMS V8i user.

When you import a SewerGEMS V8i database (.MDB) file, the model will notice that 
the model does not have any element symbology definitions (annotations and color-
coding), project-level options, text customizations, or border and line customizations 
that may have been associated with the project. These are stored in the project’s .CSD 
and .DWH files, which are not imported.
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Note: SewerGEMS can only import CivilStorm databases created in 
CivilStorm version 8.9.20.9 or later. If the database you want to 
import was created in an older version, you will need to open the 
file in a newer version of CivilStorm before the import into 
SewerGEMS will work.

To import data from a CivilStorm project:

1. Select File > Import > CivilStorm Database.

2. In the Select Database File to Import dialog box, select the CivilStorm .mdb file 
(database file). The data will display as a new project in CivilStorm.

Importing Data from SewerCAD

You can import data from a SewerCAD model into SewerGEMS V8i. When you 
installed Bentley SewerGEMS V8i, an additional menu command was added to the 
SewerCAD File > Export menu that allows you to export SewerCAD project data. 
You must use this command to export your SewerCAD data before you can import it 
into SewerGEMS V8i.

To import SewerCAD data into SewerGEMS V8i:

1. Open SewerCAD, then open the model you want to import into SewerGEMS V8i.

2. Select File > Export > SewerCAD Exchange Database.

3. Select the file name for the exported data. The file name extension for a 
SewerCAD Exchange Database is .SWR.MDB.

4. In SewerGEMS V8i, select File > Import > SewerCAD Exchange Database.

5. Select the .SWR.MDB file that you created when you exported your model data 
from SewerCAD.

Note: A pressure junction in Bentley SewerGEMS V8i has a specific 
ground elevation; in SewerCAD, there is no specific ground 
elevation for a presure junction. Bentley SewerGEMS V8i adds 5 
feet to the SewerCAD invert elevation value to arrive at the 
appropriate Bentley SewerGEMS V8i ground elevation.
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Related Topics

• “Importing Data from a SewerGEMS Database” on page 4-165

• “Importing a StormCAD Exchange Database” on page 4-164

Importing a StormCAD Exchange Database

You can import an exchange database from StormCAD v5.6 into SewerGEMS V8i. 
When you installed Bentley SewerGEMS V8i, an additional menu command was 
added to the StormCAD File > Export menu that allows you to export StormCAD 
project data. You must use this command to export your StormCAD data before you 
can import it into SewerGEMS V8i.

During the export from StormCAD, you are prompted to define the following ranges:

• Grade Inlet Hydrologic Rating Table—the range over which the hydrologic rating 
curve is developed for each grade inlet in the model. The export process will auto-
matically generate these relationships for each inlet in the model.

• Intensity Duration Inlet Rating Definition—the range over which the IDF equa-
tion or table is developed for each inlet in the model. The export process will auto-
matically convert the IDF equation or table into a data table that follows the 
specified range definition.

To import a StormCAD exchange database into SewerGEMS V8i:

1. Open StormCAD, then open the model you want to import into SewerGEMS V8i.

2. Select File > Export > StormCAD Exchange Database.

3. In the GEMS Exchange File Export dialog box, enter the following:

a. Define the grade inlet hydrologic rating table (the range over which the 
hydrologic rating curve is developed for each grade inlet in the model) by 
entering a maximum discharge and a flow increment.

b. Define the intensity duration inlet rating (the range over which the IDF equa-
tion or table is developed for each inlet in the model) by entering a maximum 
duration and a duration increment.

4. Select the file name for the exported data. The file name extension for a 
StormCAD Exchange Database is .STM.MDB.

5. In SewerGEMS V8i, select File > Import > StormCAD Exchange Database.

6. Select the .STM.MDB file that you created when you exported your model data 
from SewerCAD.
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• “Importing Data from a SewerGEMS Database” on page 4-165

Importing StormCAD V8i

You can import a model created in StormCAD V8i into SewerGEMS V8i. Note that, 
unlike the StormCAD Exchange Database import, the StormCAD V8i import does not 
require you to create an exchange database file in StormCAD first - SewerGEMS V8i 
handles the StormCAD V8i edition model files natively.

After importing the StormCAD model database, the model will notice that the model 
does not have any element symbology definitions (annotations and color-coding), 
project-level options, text customizations, or border and line customizations that may 
have been associated with the project. These are stored in the project's .swg and .dwh 
files, which are not imported.

Because of differences between StormCAD and SewerGEMS V8i, some data will 
either not be imported or will be imported using near-equivalent substitutes, including 
the following:

• Only Mannings roughness values will be imported. 

• AASHTO and Headloss Flow Curves from StormCAD will not be imported into 
SewerGEMS V8i. 

• Catalog Inlets and Percent Capacity Inlets' are converted to Inflow-Capture 
curves.

• For StormCAD gutters, SewerGEMS V8i will set the shape as trapezoidal, set the 
appropriate side slopes, leave the bottom width = 0  and set an appropriate 
Manning's N. The depth value must be entered by the user. Additionally, gutters 
are set to inactive automatically upon import. You will need to make the gutters 
active and fill in missing data before the gutter can be included in the calculations.

• StormCAD has a Headloss Alternative, while SewerGEMS V8i does not. Head-
loss information from the StormCAD Headloss Alternative is imported into a 
child Physical alternative inheriting from the Base Physical alternative in Sewer-
GEMS V8i. This child alternative contains the headloss data.

When a StormCAD model is imported, an Inlet Flow Settings dialog will appear. The 
data entered here is required to define the inlet flow-capture curves. The two pieces of 
data required in this dialog are as follows:

• Flow Increment: The flow increment value should be a value that will give the 
flow-capture curves satisfactory resolution.

• Maximum Flow: The value entered here should exceed the highest flow expected 
at any inlet.
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Note: The flow-capture curves are only for on-grade inlets Sag inlets 
are set to "full capture".

To import a StormCAD V8i model

1. Click the File menu and select Import > StormCAD V8i Edition.

2. In the Select Database File to Import dialog, browse to the swg.mdb file for the 
StormCAD model you are importing. Highlight the file and click the Open button.

3. In the Inlet Flow Settings dialog, enter vlaues for the Flow Increment and 
Maximum Flow, then click OK.

Importing Data from Bentley Wastewater

You can import data from a Bentley Wastewater data source into SewerGEMS V8i. 
Before importing this data into SewerGEMS V8i, you must first export it from 
Bentley Wastewater into a set of output files. These output files can then be imported 
into a SewerGEMS V8i model. 

To export Bentley Wastewater data to a set of output files:

1. In the Bentley Wastewater toolbar, click the Export > Data command.

2. In the dialog that appears, select all of the listed element types.

3. Click the File button and select a destination output file.

4. Use the MicroStation Place Fence tool and draw a fence surrounding the model.

5. Click on the Start button in the Export Data dialog and click inside the fence you 
created in step 4.

To import Bentley Wastewater data into SewerGEMS V8i from a set of output 
files:

1. In SewerGEMS V8i, click the File menu and select the Import > Bentley Waste-
water Import command.

2. Follow the steps in the Bentley Wastewater Import Wizard that appears.

Bentley Wastewater Import Wizard

The Bentley Wastewater Import Wizard will guide you through the process of config-
uring the settings needed to import the data contained in the Bentley Wastewater 
output files into a SewerGEMS V8i model.

The wizard consists of the following steps:

• “Step 1: Bentley Wastewater Import” on page 4-167
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• “Step 2: Bentley Wastewater Data Source” on page 4-167

• “Step 3: Data Source Table Names” on page 4-168

• “Step 4: Unit Options” on page 4-168

• “Step 5: Import Options” on page 4-169

Step 1: Bentley Wastewater Import

This step displays the filename and directory location of the target SewerGEMS V8i 
model for the import operation. No user input is required for this step.

RELATED TOPICS

• “Bentley Wastewater Import Wizard” on page 4-166

• “Step 1: Bentley Wastewater Import” on page 4-167

• “Step 2: Bentley Wastewater Data Source” on page 4-167

• “Step 3: Data Source Table Names” on page 4-168

• “Step 4: Unit Options” on page 4-168

• “Step 5: Import Options” on page 4-169

Step 2: Bentley Wastewater Data Source

This step allows you to specify the data source and geometry file that contains the 
Bentley Wastewater data to be imported. 

The step consists of the following controls:

Select A Data Source Type—This control consists of two pulldown menus. The 
value selected in the first pulldown menu will determine the choices available in the 
second menu. For most of the Data Source Types, only one option will be available in 
the second menu. When the OLEDB data source type is chosen, the second menu will 
contain a number of OLEDB database types.

Select Data Source—This control allows you to choose the data source of the type 
selected in the Select A Data Source Type menus. Click the Browse button to bring up 
an Open dialog that will allow you to specify the data source.

Select Geometry Data File—This control allows you to choose the .dat file that 
contains the Bentley Wastewater geometry data. Click the Browse button to bring up 
an Open dialog that will allow you to specify the data file.
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Note: The Select Geometry Data File field is optional.  If the user 
wishes to import pipe geometry data which contains the pipe 
vertices (bends) into the model, then this field should point to 
the data file that can be created during the export pipe geometry 
data process.  However, if the user chooses not to import 
geometry data, this field can be left blank and the pipes will be 
imported without any bends associated with them.

Update only the elements specified in the geometry data file—When this box is 
checked, only data for those elements contained within the specified geometry data 
file will be imported. This option allows you to import just a subset of the original 
Bentley Wastewater model.

Step 3: Data Source Table Names

This step allows you to specify the tables within the Bentley Wastewater data source 
that correspond to the various SewerGEMS V8i element types. Each of the menus in 
this step allow you to choose a database table that contains the data for each of the 
associated elements.

• “Bentley Wastewater Import Wizard” on page 4-166

• “Step 1: Bentley Wastewater Import” on page 4-167

• “Step 2: Bentley Wastewater Data Source” on page 4-167

• “Step 3: Data Source Table Names” on page 4-168

• “Step 4: Unit Options” on page 4-168

• “Step 5: Import Options” on page 4-169

Step 4: Unit Options

This step allows you to define the units used for various attributes of the model and 
the network elements. The units specified should match those used in the Bentley 
Wastewater model being imported.

• “Bentley Wastewater Import Wizard” on page 4-166

• “Step 1: Bentley Wastewater Import” on page 4-167

• “Step 2: Bentley Wastewater Data Source” on page 4-167

• “Step 3: Data Source Table Names” on page 4-168

• “Step 4: Unit Options” on page 4-168

• “Step 5: Import Options” on page 4-169
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Step 5: Import Options

This step allows you to specify other options that will be applied to the SewerGEMS 
V8i model. The menu allows you to specify the friction method that will be used. 
Bentley Wastewater models can contain point nodes. If the checkbox in this step is 
checked, these point nodes will be imported as SewerGEMS V8i manhole elements.

• “Bentley Wastewater Import Wizard” on page 4-166

• “Step 1: Bentley Wastewater Import” on page 4-167

• “Step 2: Bentley Wastewater Data Source” on page 4-167

• “Step 3: Data Source Table Names” on page 4-168

• “Step 4: Unit Options” on page 4-168

• “Step 5: Import Options” on page 4-169

• “Importing Data from SewerCAD” on page 4-163

Exporting Data
You can export your SewerGEMS V8i data as a SWMM .INP file, or export the 
graphical representation of your model as a .DXF file.

Exporting a .DXF File

You can export your SewerGEMS V8i model as a .DXF file if you plan to edit the file 
in AutoCAD or another program. When you export a .DXF file, you export only the 
graphical (vector) representation of the model. The DXF file is an ASCII file.

To export the current project to a .DXF file:

1. Select File > Export > DXF.

2. Type the name of the DXF file, then click Save.

You may now open the DXF file in another program.

Exporting to SWMM 5

You can export your SewerGEMS V8i model data to a SWMM 5 .INP file.
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To export the current project to a SWMM 5 file:

1. Select File > Export > SWMM v5.

2. In the Select SWMM v5 File to Export dialog that appears, browse to the direc-
tory that you want to save the file to.

3. Type the name of the .INP file, then click Save.

Note: Only catchments using the EPA SWMM Runoff Method will be 
exported using this command.

Exporting to Shapefile

It is possible to export model elements and data to create a shapefile. Unlike the other 
export features in SewerGEMS V8i, the export to shapefile operation occurs in a 
FlexTable as opposed to the File > Export menu. Shapefiles must be created one 
element type at a time. That means there will be a separate shapefile to junctions, 
pipes, tanks, etc. 

To create a shapefile, open the FlexTable for the type of element. Use selection sets or 
filtering to reduce the size of the FlexTable to what is desired in the shapefile. Use the 
table edit feature to eliminate any columns that are not desired. 

When the FlexTable is in the correct form, pick the first button at the top left of the 
table which is the Export button. A drop down list will appear, pick Export to Shape-
file. The user is asked for the name of shapefile and path. When the user names the file 
and hits Save, the dialog below appears.

It is important to ensure that any shapefile field names are less than or equal to 10 
characters. The default name for shapefile field is the name of the column in the 
FlexTable. (If the user changes the name to something different from the FlexTable 
column name, the editor remembers it when other shapefiles are created from this 
table.) Once the names are acceptable, hit OK to create the shapefile. A shapefile 
consisting of .dbf, .shx and .shp files are created.
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Chapter

Using Modelbuilder
ModelBuilder lets you use your existing GIS asset to construct a new Bentley Sewer-
GEMS V8i model or update an existing Bentley SewerGEMS V8i model. Model-
Builder supports a wide variety of data formats, from simple databases (such as 
Access and DBase), spreadsheets (such as Excel or Lotus), GIS data (such as shape-
files, coverages, ESRI ArcGIS Geodatabases, and ArcGIS Geometric Networks), to 
high end data stores (such as Oracle, and SQL Server), and more.

Using ModelBuilder, you map the tables and fields contained within your data source 
to element types and attributes in your Bentley SewerGEMS V8i model. The result is 
that a Bentley SewerGEMS V8i model is created, either in stand-alone mode or in an 
existing ArcMap project. 

Note: ModelBuilder lets you bring a wide range of data into your 
model. However, some data is better suited to the use of the 
more specialized Bentley SewerGEMS V8i modules. For 
instance, LoadBuilder offers many powerful options for 
incorporating loading data into your model.

ModelBuilder is the first tool you will use when constructing a model from GIS data. 
The steps that you take at the outset will impact how the rest of the process goes. Take 
the time now to ensure that this process goes as smoothly and efficiently as possible. 
The following topics are included:

• “Preparing to Use ModelBuilder” on page 5-172

• “ModelBuilder Connections Manager” on page 5-173

• “ModelBuilder Wizard” on page 5-175

• “Reviewing Your Results” on page 5-180

• “Multi-select Data Source Types” on page 5-180

• “ModelBuilder Warnings and Error Messages” on page 5-181

• “ESRI ArcGIS Geodatabase Support” on page 5-184

• “Specifying Network Connectivity in ModelBuilder” on page 5-186

• “Handling Collection and Curve Data in Modelbuilder” on page 5-189
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Preparing to Use ModelBuilder
• Determine the purpose of your model—Once you establish the purpose of your 

model, you can start to make decisions about how detailed the model should be. 

• Get familiar with your data—If you obtained your GIS data from an outside 
source, you should take the time to get acquainted with it. Review spatial and 
attribute data directly in your GIS environment. Do the nodes have coordinate 
information, and do the pipes have start and stop nodes specified? If not, the best 
method of specifying network connectivity must be determined.

Contact those involved in the development of the GIS to learn more about the GIS 
tables and associated attributes. Find out the purpose of any fields that may be of 
interest, ensure that data is of an acceptable accuracy, and determine units associ-
ated with fields containing numeric data.

Ideally, there will be one GIS source data table for each Bentley SewerGEMS V8i 
element type. This isn’t always the case, and there are two other possible 
scenarios: 

Many GIS tables for one element type—In this case, there may be several tables 
in the GIS/database corresponding to a single GEMS modeling element . In this 
case each data source table must be individually mapped to the Bentley Sewer-
GEMS V8i element, or the tables must be combined into a single table in the GIS/
database before running ModelBuilder.

One GIS table containing many element types—In this case, there may be 
entries that correspond to several Bentley SewerGEMS V8i modeling elements in 
one GIS/database table. You should separate these into individual tables before 
running ModelBuilder. The one case where a single table can work is when the 
features in the table are ArcGIS subtypes. ModelBuilder handles these subtypes 
by treating them as separate tables when setting up mappings. See “Subtypes” on 
page 5-186 for more information.

Note: If you are working with an ArcGIS data source, see “ESRI ArcGIS 
Geodatabase Support” on page 5-184 for additional information.

• Preparing your data—When using ModelBuilder to get data from your GIS into 
your model, you will be associating rows in your GIS to elements in Bentley 
SewerGEMS V8i. Your data source needs to contain a Key/Label field that can be 
used to uniquely identify every element in your model. The data source tables 
should have identifying column labels, or ModelBuilder will interpret the first 
row of data in the table as the column labels. Be sure data is in a format suited for 
use in ModelBuilder. Use powerful GIS and Database tools to perform Database 
Joins, Spatial Joins, and Update Joins to get data into the appropriate table, and in 
the desired format.
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Note: When working with ID fields, the expected model input is the 
Bentley SewerGEMS V8i ID. After creating these items in your 
Bentley SewerGEMS V8i model, you can obtain the assigned ID 
values directly from your Bentley SewerGEMS V8i modeling file. 
Before synchronizing your model, get these Bentley 
SewerGEMS V8i IDs into your data source table (e.g., by 
performing a database join).

One area of difficulty in building a model from GIS data is the fact that unless the GIS 
was created solely to support modeling, it most likely contains much more detailed 
information than is needed for modeling. This is especially true with regard to the 
number of piping elements. It is not uncommon for the GIS to include every service 
line and hydrant lateral. Such information is not needed for most modeling applica-
tions and should be removed to improve model run time, reduce file size, and save 
costs.

ModelBuilder Connections Manager
ModelBuilder is available within both the Stand-Alone and ArcMap client interfaces. 
To access the ModelBuilder Connections Manager:

• In Stand-Alone: Click the Tools menu and select the ModelBuilder command.

• In ArcMap: Click the Bentley SewerGEMS V8i menu, click the Tools menu, then 
select the ModelBuilder command.

The ModelBuilder Connections manager allows you to create, edit, and manage 
ModelBuilder connections to be used in the model-building/model-synchronizing 
process. 

At the center of this window is the Connections List which displays the list of 
connections that you have defined.

There is a toolbar located along the top of the Connections list. 
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The set of buttons on the left of the toolbar allow you to manage your connections:

The button on the right of the toolbar allows you to either build or synchronize 
a model. Click the menu arrow associated with this button to access the 
following options:

• Build New Model—Starts the ModelBuilder build process using the selected 
connection. You will be prompted to interactively specify a new filename.

• Synchronize Existing Model—Starts the ModelBuilder synchronize process 
using the selected connection. You will be prompted to interactively specify an 
existing Bentley SewerGEMS V8i model filename.

Note: If you set up a ModelBuilder mapping to an Access mdb, it 
requires a primary key for that table.

After specifying your target, ModelBuilder will perform the selected operation. 
During the process, a progress-bar will be displayed indicating the step that Model-
Builder is currently working on.

When ModelBuilder completes, you will be presented with a summary window that 
outlines important information about the build process. We recommend that you save 
this summary so that you can refer to it later.

New Create a new connection using the 
ModelBuilder Wizard.

Edit Edit the selected connection using the 
ModelBuilder Wizard.

Rename Rename the selected connection.

Duplicate Create a copy of the selected connection.

Delete Permanently Remove the selected connection.
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ModelBuilder Wizard
The ModelBuilder Wizard assists in the creation of ModelBuilder connections. The 
Wizard will guide you through the process of selecting your data source and mapping 
that data to the desired input of your model.

Tip: The ModelBuilder Wizard can be resized, making it easier to 
preview tables in your data source. In addition, Step 1 and Step 3 
of the wizard offer a vertical split bar, letting you adjust the size 
of the list located on the left side of these pages.

There are 5 steps involved:

• “Step 1—Specify Project” on page 5-175

• “Step 2—Specify Data Source” on page 5-175

• “Step 3—Specify Spatial Options” on page 5-176

• “Step 4—Specify Field Mappings for each Table/Feature Class” on page 5-177

• “Step 5—Build Operation Confirmation” on page 5-179

Step 1—Specify Project

In this step, the path to the Bentley SewerGEMS V8i project is defined.

The following controls are available:

• Bentley SewerGEMS V8i Model Path—This field displays the path and file 
name of the Bentley SewerGEMS V8i model that the current build operation will 
be applied to.

• Browse—This button opens a browse dialog, allowing you to specify the Bentley 
SewerGEMS V8i model that the build operation will be applied to.

Step 2—Specify Data Source

In this step, the data source type and location are specified. After selecting your data 
source, the desired database tables can be chosen and previewed.

The following fields are available:

• Data Source type (drop-down list)—This field allows you to specify the type of 
data you would like to work with.
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Note: If your specific data source type is not listed in the Data Source 
type field, try using the OLE DB data source type. OLE DB can be 
used to access many database systems (including ORACLE, and 
SQL Server, to name a few).

• Data Source (text field)—This read-only field displays the path to your data 
source.

• Browse (button)—This button opens a browse dialog box that allows you to inter-
actively select your data source.

Note: Some Data Source types expect you to choose more than one 
item in the Browse dialog box. For more information, see “Multi-
select Data Source Types” on page 5-180.

• Table/Feature Class (list)—This pane lists the tables/feature classes that are 
contained within the data source. Use the check boxes (along the left side of the 
list) to specify the tables you would like to include.

Tip: The list can be resized using the split bar (located on the right 
side of the list).

Right-click to Select All or Clear the current selection in the list.

ModelBuilder has built in support for ArcGIS Subtypes. For more 
information, see “ESRI ArcGIS Geodatabase Support” on page 5-
184.

• Preview Pane—A tabular preview of the highlighted table is displayed in this 
pane when the Show Preview check box is enabled.

Step 3—Specify Spatial Options

In this step you will specify the spatial options to be used during the ModelBuilder 
process. The spatial options will determine the placement and connectivity of the 
model elements. The fields available in this step will vary depending on the data 
source type.

Specify the Coordinate Unit of your data source (drop-down list)—This field allows 
you to specify the coordinate unit of the spatial data in your data source.

The remaining fields are only available when working with the spatial data sources 
such as shapefiles and ArcGIS Geodatabases.

• Establish connectivity using spatial data (check box)—When this box is 
checked, ModelBuilder will connect pipes to nodes that fall within a specified 
tolerance of a pipe endpoint.
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• Tolerance (numeric field)—This field dictates how close a node must be to a pipe 
endpoint in order for connectivity to be established. The Tolerance field is avail-
able only when the Establish connectivity using spatial data box is checked.

Note: Pipes will be connected to the closest node within the specified 
tolerance.

The unit associated with the tolerance is dictated by the Specify 
the Coordinate Unit of your data source field.

For more information, see “Specifying Network Connectivity in 
ModelBuilder” on page 5-186.

• Create nodes if none found at pipe endpoint (check box)—When this box is 
checked, ModelBuilder will create a pressure junction at any pipe endpoint that: 
a) doesn’t have a connected node, and b) is not within the specified tolerance of an 
existing node. This field is active only when the Establish connectivity using 
spatial data box is checked.

Step 4—Specify Field Mappings for each Table/Feature Class

In this step, data source tables are mapped to the desired modeling element types, and 
data source fields are mapped to the desired model input attributes. You will assign 
mappings for each Table/Feature Class that appears in the list; Step 1 of the wizard 
can be used to exclude tables, if you wish.

• Tables (list)—This pane, located along the left side of the dialog box, lists the 
data source Tables/Feature Classes to be used in the ModelBuilder process. Select 
an item in the list to specify the settings for that item.

Tip: The list can be resized using the split bar.

There are two toolbar buttons located directly above Tables list (these buttons can 
be a great time saver when setting up multiple mappings with similar settings).

– Copy Mappings (button)—This button copies the mappings (associated with 
the currently selected table) to the clipboard.

– Paste Mappings (button)—This button applies the copied mappings to the 
currently selected table.

• Settings Tab—The Settings tab allows you to specify mappings for the selected 
item in the Tables list.

The top section of the Settings tab allows you to specify the common data 
mappings:
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– Table Type (drop-down list)—This field allows you to specify the target 
modeling element type that the source table/feature class represents. For 
example, a source table that contains pipe data should be associated with the 
Pressure Pipe element type.

Note: Each table in your data source can be assigned to a single 
Element Type. For this reason, individual tables in your data 
source should contain only data that will be assigned to 
elements of the same type. For instance, the source data table 
that will be designated as the Pressure Junction element type 
should contain only data that will be applied to Pressure 
Junctions, not data relating to pressure valves, tanks, etc. The 
exception to this general rule is when the source table contains 
subtypes, each of which can be assigned to different elements. 
For more information see “Subtypes” on page 5-186.

Tip: Shapefiles can be converted into Geodatabase format if you 
would like to make use of Subtypes. This can be useful if a 
single data source table needs to be mapped to multiple Bentley 
SewerGEMS V8i element types. 

– Key/Label Field (drop-down list)—This required field allows you to asso-
ciate a row in this table to a particular element in the model. The model refer-
ences each element using a unique alphanumeric label. Your data source must 
have a field that can be used to uniquely identify all elements in the model.

Note: When working with ArcGIS data sources, OBJECTID is not a 
good choice for Key field (because OBJECTID is only unique for 
that particular Feature Class). If you do not have a field that can 
be used to uniquely identify each element, you may use the 
<label> field (which is automatically generated by ModelBuilder 
for this purpose).

These optional fields are available for Pipe element types:

– Start/Stop—Select the fields in your pipe table that contain the Label of the 
start and stop nodes. For more information, see “Specifying Network Connec-
tivity in ModelBuilder” on page 5-186.

Note: When working with an ArcGIS Geometric Network data source, 
these fields will be set to <auto> (indicating that ModelBuilder 
will automatically determine connectivity from the geometric 
network).

These fields are available for Node element types:

– X/Y Field—These fields are used to specify the node X and Y coordinate 
data.
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Note: The Coordinate Unit setting in Step 2 of the wizard allows you to 
specify the units associated with these fields. 

When working with ArcGIS Geodatabase or shapefile data 
sources, these fields will be set to <auto> (indicating that 
ModelBuilder will automatically determine node geometry from 
the data source).

These optional fields are available for Pump element types:

– Suction Element (drop-down list)—For tables that define pump data, select 
a pipe label or other unique identifier to set the suction element of the Pump.

– Downstream Edge (drop-down list)—For tables that define pump or valve 
data, select a pipe label or other unique identifier to set the direction of the 
Pump.

The bottom section of the Settings tab allows you to specify additional data 
mappings.

– Field—Field refers to a field in the selected data source. The Field list 
displays the associations between fields in the database to attributes in the 
model. 

– Attribute (drop-down list)—Attribute refers to a Bentley SewerGEMS V8i 
attribute. Use the Attribute drop-down list to map the highlighted field to the 
desired attribute.

– Unit (drop-down list)—This field allows you to specify the units of the values 
in the database (no conversion on your part is required).

To map a field in your GIS to a particular Bentley SewerGEMS V8i attribute:

1. In the Field list, select the item you would like to update.

2. In the Attribute drop-down list, select the desired Bentley SewerGEMS V8i 
attribute.

3. In the Unit drop-down list, specify the unit of this field in your data source.

To remove the mapping for a particular field:

1. Select the field you would like to update.

2. In the Attribute drop-down list, select <none>.

– Preview Tab—The Preview tab displays a tabular preview of the currently 
highlighted source data table when the Show Preview check box is checked.

Step 5—Build Operation Confirmation

In this step, you are prompted to build a new model or update an existing model.
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To build a new model, click the Yes radio button under Would you like to build the 
model now?. 

If you choose No, you will be returned to the ModelBuilder Manager dialog. The 
connection you defined will appear in the list pane. To build the model from the 
ModelBuilder Manager, highlight the connection and click the Build Model button.

Reviewing Your Results
At the end of the ModelBuilder process, you will be presented with statistics, and a list 
of any warning/error messages reported during the process. You should closely review 
this information, and be sure to save this data to disk where you can refer to it later.

Note: Refer to the section titled “ModelBuilder Warnings and Error 
Messages” on page 5-181 to determine the nature of any 
messages that were reported.

Multi-select Data Source Types
When certain Data Source types are chosen in Step 1 of the ModelBuilder Wizard (see 
“Step 2—Specify Data Source” on page 5-175), multiple items can be selected for 
inclusion in your ModelBuilder connection. 

After clicking the Browse button to interactively specify your data source, use stan-
dard Windows selection techniques to select all items you would like to include in the 
connection (e.g., Ctrl+click each item you would like to include).

The following are multi-select Data Source types:

• ArcGIS Geodatabase Features

• Shapefiles

• DBase, FoxPro, HTML Export, and Paradox.
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Exporting X/Y Coordinates
SewerGEMS V8i X/Y coordinates can be exported to an external data tables, such as 
spreadsheets, using ModelBuilder. 

1. Add fields to the external data table to accept the coordinate data.

2. In “Step 5—Build Operation Confirmation” on page 5-179 of the ModelBuilder 
Wizard, click the No radio button under Build Model Now?, then click Finish.

3. In the ModelBuilder Manager, highlight the connection and click the Sync Out 
button.

ModelBuilder Warnings and Error Messages
Errors and warnings that are encountered during the ModelBuilder process will be 
reported in the ModelBuilder Summary.
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For more information, see:

• “Warnings” on page 5-182

• “Error Messages” on page 5-183

Warnings

Warning messages include:

1. Some rows were ignored due to missing key-field values.

ModelBuilder encountered missing data (e.g., null or blank) in the specified Key/
Label field for rows in your data source table. Without a key, ModelBuilder is 
unable to associate this source row with a target element, and must skip these 
items. This can commonly occur when using a spreadsheet data source. To deter-
mine where and how often this error occurred, check the Statistics page for the 
message <x> row(s) ignored due to missing key-field values.

2. Unable to create pipe <element>; start and/or stop node could not be found.

Pipes can only be created if its start and stop nodes can be established. If you are 
using Explicit connectivity, a node element with the referenced start or stop label 
could not be found. If you are using implicit connectivity, a node element could 
not be located within the specified tolerance. For more information, see “Speci-
fying Network Connectivity in ModelBuilder” on page 5-186.

3. Unable to update pipe <element> topology; (start or stop) node could not be 
found.

This error occurs when synchronizing an existing model, and indicates that the 
pipe connectivity could not be updated. For more information, see warning 
message #2 (above).

4. The downstream edge for <element> could not be found.

ModelBuilder was unable to set a Pump direction because a pipe with the refer-
enced label could not be found.

5. Directed Node <element> direction is ambiguous.

ModelBuilder was unable to set the direction of the referenced pump or valve 
because direction could not be implied based on the adjacent pipes (e.g. there 
should be one incoming and one outgoing pipe).
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Error Messages

Note: If you encounter these errors or warnings, we recommend that 
you correct the problems in your original data source and re-run 
ModelBuilder (when applicable).

Error messages include:

1. Unable to assign <attribute> for element <element>.

Be sure that the data in your source table is compatible with the expected Bentley 
SewerGEMS V8i format. For more information, see “Using Modelbuilder” on 
page 5-171.

2. Unable to create <element type> <element>.

This message indicates that an unexpected error occurred when attempting to 
create a node element.

3. Unable to create pipe <element> possibly due to start or stop connectivity 
constraints.

This message indicates that this pipe could not be created, because the pump or 
valve already has an incoming and outgoing pipe. Adding a third pipe to a pump 
or valve is not allowed.

4. Unable to update pipe <element> topology; possibly due to start element connec-
tivity constraints.

This error occurs when synchronizing. For more information, see error message 
#3 (above).

5. Operation terminated by user.

You pressed the Cancel button during the ModelBuilder process.

6. Unable to create < element>; pipe start and stop must be different.

This message indicates that the start and stop specified for this pipe refer to the 
same node element.

7. Unable to update <element> topology; pipe start and stop must be different.

This message indicates that the start and stop specified for this pipe refer to the 
same node element.

8. Unable to update the downstream edge for <element>.

An unexpected error occurred attempting to set the downstream edge for this 
pump or valve.

9. Nothing to do. Some previously referenced tables may be missing from your data 
source.
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This data source has changed since this connection was created. Verify that tables/
feature-classes in your data source have not been renamed or deleted.

10. One or more input features fall outside of the XYDomain.

This error occurs when model elements have been imported into a new geodata-
base that has a different spatial reference from the elements being created. 
Elements cannot be created in ArcMAP if they are outside the spatial bounds of 
the geodatabase.

The solution is to assign the correct X/Y Domain to the new geodatabase when it 
is being created:

a. In the Attach Geodatabase dialog that appears after you initialize the Create 
New Project command, click the Change button.

b. In the Spatial Reference Properties dialog that appears, click the Import 
button.

c. Browse to the datasource you will be using in ModelBuilder and click Add.

d. Back in the Spatial Reference Properties dialog, click the x/Y Domain tab. 
The settings should match those of the datasource.

e. Use ModelBuilder to create the model from the datasource.

ESRI ArcGIS Geodatabase Support
ModelBuilder was built using ArcObjects, and supports the following ESRI ArcGIS 
Geodatabase functionality. See your ArcGIS documentation for more information 
about ArcObjects. For more information, see:

• “Geodatabase Features” on page 5-185

• “Geometric Networks” on page 5-185

• “ArcGIS Geodatabase Features versus ArcGIS Geometric Network” on page 5-
185

• “Subtypes” on page 5-186

• “SDE (Spatial Database Engine)” on page 5-186
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Geodatabase Features

ModelBuilder provides direct support for working with Geodatabase features. A 
feature class is much like a shapefile, but with added functionality (such as subtypes).

The geodatabase stores objects. These objects may represent nonspatial real-world 
entities, such as manufacturers, or they may represent spatial objects, such as pipes in 
a network. Objects in the geodatabase are stored in feature classes (spatial) and tables 
(nonspatial).

The objects stored in a feature class or table can be organized into subtypes and may 
have a set of validation rules associated with them. The ArcInfo™ system uses these 
validation rules to help you maintain a geodatabase that contains valid objects.

Tables and feature classes store objects of the same type—that is, objects that have the 
same behavior and attributes. For example, a feature class called WaterMains may 
store pressurized water mains. All water mains have the same behavior and have the 
attributes ReferenceID, Depth, Material, GroundSurfaceType, Size, and Pressur-
eRating.

Geometric Networks

ModelBuilder has support for Geometric Networks, and a new network element type 
known as Complex Edge. When you specify a Geometric Network data source, 
ModelBuilder automatically determines the feature classes that make up the network. 
In addition, ModelBuilder can automatically establish model connectivity based on 
information in the Geometric Network.

ArcGIS Geodatabase Features versus ArcGIS Geometric Network

Note: See your ArcGIS documentation for more information about 
Geometric Networks and Complex Edges.

When working with a Geometric Network, you have two options for constructing your 
model—if your model contains Complex Edges, then there is a distinct difference. A 
Complex Edge can represent a single feature in the Geodatabase, but multiple 
elements in the Geometric Network. 

For example, when defining your Geometric Network, you can connect a lateral to a 
main without splitting the main line. In this case, the main line will be represented as a 
single feature in the Geodatabase but as multiple edges in the Geometric Network.
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Depending on the data source type that you choose, ModelBuilder can see either 
representation. If you want to include every element in your system, choose ArcGIS 
Geometric Network as your data source type. If you want to leave out laterals and you 
want your main lines to be represented by single pipes in the model, choose ArcGIS 
Geodatabase Features as your data source type.

Subtypes

Tip: Shapefiles can be converted into Geodatabase Feature Classes 
if you would like to make use of Subtypes. See your ArcGIS 
documentation for more information.

If multiple types of Bentley SewerGEMS V8i elements have their data stored in a 
single geodatabase table, then each element must be a separate ArcGIS subtype. For 
example, in a valve table PRVs may be subtype 1, PSVs may be subtype 2, FCVs may 
be subtype 3, and so on. With subtypes, it is not necessary to follow the rule that each 
GIS/database feature type must be associated with a single type of GEMS model 
element. Note that the subtype field must be of the integer type (e.g., 1, 2) and not an 
alphanumeric field (e.g., PRV). For more information about subtypes, see ArcGIS 
Help.

ModelBuilder has built in support for subtypes. After selecting your data source, 
feature classes will automatically be categorized by subtype. This gives you the ability 
to assign mappings at the subtype level. For example, ModelBuilder allows you to 
exclude a particular subtype within a feature class, or associate each subtype with a 
different element type.

SDE (Spatial Database Engine)

ModelBuilder lets you specify an SDE Geodatabase as your data source. See your 
ESRI documentation for more information about SDE.

Specifying Network Connectivity in ModelBuilder
When importing spatial data (ArcGIS Geodatabases or shapefile data contain spatial 
geometry data that ModelBuilder can use to establish network connectivity by 
connecting pipe ends to nodes, creating nodes at pipe endpoints if none are found.), 
ModelBuilder provides two ways to specify network connectivity:
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• Explicit connectivity—based on pipe Start node and Stop node (see “Step 4—
Specify Field Mappings for each Table/Feature Class” on page 5-177).

• Implicit connectivity—based on spatial data. When using implicit connectivity, 
ModelBuilder allows you to specify a Tolerance, and provides a second option 
allowing you to Create nodes if none found (see “Step 3—Specify Spatial 
Options” on page 5-176).

The method that you use will vary depending on the quality of your data. The possible 
situations include (in order from best case to worst case):

• You have pipe start and stop information—Explicit connectivity is definitely the 
preferred option.

• You have some start and stop information—Use a combination of explicit and 
implicit connectivity (use the Spatial Data option, and specify pipe Start/Stop 
fields). If the start or stop data is missing (blank) for a particular pipe, Model-
Builder will then attempt to use spatial data to establish connectivity.

• You do not have start and stop information—Implicit connectivity is your only 
option. If your spatial data is good, then you should reduce your Tolerance 
accordingly.

• You do not have start and stop information, and you do not have any node data 
(e.g., you have GIS data that defines your pipes, but you do not have data for 
nodes)—Use implicit connectivity and specify the Create nodes if none found 
option; otherwise, the pipes cannot be created.

Note: If pipes do not have explicit Start/Stop nodes and “Establish 
connectivity using spatial data” is not checked, the pipes will not 
be connected to the nodes and a valid model will not be 
produced.

Other considerations include what happens when the coordinates of the pipe ends do 
not match up with the node coordinates. This problem can be one of a few different 
varieties:

1. Both nodes and pipe ends have coordinates, and pipes have explicit Start/
Stop nodes—In this case, the node coordinates are used, and the pipe ends are 
moved to connect with the nodes.

2. Nodes have coordinates but pipes do not have explicit Start/Stop nodes—The 
nodes will be created, and the specified tolerance will be used to connect pipe 
ends within this tolerance to the appropriate nodes. If a pipe end does not fall 
within any node’s specified tolerance, a new node can be created using the Create 
nodes if none found option.

3. Pipe ends have coordinates but there are no junctions—New nodes must be 
created using the Create nodes if none found option. Pipe ends are then 
connected using the tolerance that is specified.
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Another situation of interest occurs when two pipes cross but aren’t connected. If, at 
the point where the pipes cross, there are no pipe ends or nodes within the specified 
tolerance, then the pipes will not be connected in the model. If you intend for the pipes 
to connect, then pipe ends or junctions must exist within the specified tolerance.

Sample Spreadsheet Data Source

Note: Database formats (such as MS Access) are preferable to simple 
spreadsheet data sources. The sample below is intended only to 
illustrate the importance of using expected data formats.

Here are two examples of possible data source tables. The first represents data that is 
in the correct format for an easy transition into ModelBuilder, with no modification. 
The second table will require adjustments before all of the data can be used by Model-
Builder.

In “Table 5-2: Data Format Needs Editing for ModelBuilder”on page 5-188, no 
column labels have been specified. ModelBuilder will interpret the first row of data in 
the table as the column labels, which can make the attribute mapping step of the 
ModelBuilder Wizard more difficult unless you are very familiar with your data 
source setup.

Table 5-1: Correct Data Format for ModelBuilder

Label Roughness_C Diam_in Length_ft Material_ID Subtype

P-1 120 6 120 3 2

P-2 110 8 75 2 1

P-3 130 6 356 2 3

P-4 100 10 729 1 1

Table 5-2:  Data Format Needs Editing for ModelBuilder

P-1 120 .5 120 PVC Phase2

P-2 110 .66 75 DuctIron Lateral

P-3 130 .5 356 PVC Phase1

P-4 100 .83 729 DuctIron Main

P-5 100 1 1029 DuctIron Main
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“Table 5-1: Correct Data Format for ModelBuilder”on page 5-188 is also superior to 
“Table 5-2: Data Format Needs Editing for ModelBuilder”on page 5-188 in that it 
clearly identifies the units that are used for unitized attribute values, such as length 
and diameter. Again, unless you are very familiar with your data source, unspecified 
units can lead to errors and confusion.

Finally, “Table 5-2: Data Format Needs Editing for ModelBuilder”on page 5-188 is 
storing the Material and Subtype attributes as alphanumeric values, while Model-
Builder uses integer ID values to access this input. This data is unusable by Model-
Builder in alphanumeric format, and must be translated to an integer ID system in 
order to read this data.

Handling Collection and Curve Data in Modelbuilder
ModeBuilder has the ability to import Collection and Curve data, such as pump 
curves, hydrographs, and IDF curves, among others. In the model, these data types are 
always associated to either Domain elements (pumps, pipes, …) or Components 
(pump definitions, hydrographs, …). You can just import the collection data, and 
ModelBuilder will create a default domain/component element if it doesn't yet exist, 
and if the creation option to automatically create referenced elements is enabled. But a 
better technique would be to import the domain/component element from an external 
table, and then import the collection data into those created domain/component 
elements. This gives you the ability to import the most amount of detail.

The external tabular data for a collection curve must have a label field, where the label 
field contains string values that match the label of the associated domain/component 
element. For example, if two pattern curves are defined in an external table, the table 
would look something like the following:

Table 5-3: Sample Tabular Data

Label Time from Start Multiplier Order

Normal 1.2 .8 1

Normal 1.7 .7 2

Normal 12 .2 3

Normal 17 .5 4

High 5 1.0 1

High 19 .85 3

High 12 .65 2
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This would assign 4 entries to the 'Normal' pattern, and 3 entries to the 'High' pattern. 
The Order field is optional, and is discussed below. The same approach applies to 
nodes, for such things as a variable area tank curve, or junction demands. In these 
cases, the label field would contain the name of the node that collection entries are 
being added into. 

ModelBuilder also includes an advanced feature to allow precise ordering of the 
collection records. For some collections, the order of the records does not matter and 
this feature isn't needed.  For other cases, order of the records is meaningful. For these 
types of collections, there is a Sort By Field in the ModelBuilder mapping form. By 
default, it uses the record order as the records exist in the external data source. If the 
records are not ordered correctly in the data source, then the external table must have 
an additional field that contains numeric values. These values will represent the order 
that the records should be imported.  So for the above example data, normally the 
records would be imported in the order entered (5, 19, then 12 for the High pattern). 
However the user can set the Sort By Field in the ModelBuilder form to use the 'Order' 
external field, and this will import the records based on either Ascending 'Order' 
values (5, 12, 19) or Descending 'Order' values (19, 12, 5). 
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Chapter

Creating Your Model
Elements and Element Attributes
You use the Layout toolbar to add elements to your model and edit the attributes of 
elements using the Property Editor, one of the dockable managers in Bentley Sewer-
GEMS V8i stand-alone editor. 

• “Pressure Junctions” on page 6-212

• “Junction Chambers” on page 6-211

Link Elements

Link elements connect the other elements to form the sewer network. The link 
elements are the conveyance elements that carry flow through the network to its even-
tual discharge point at an outlet. You can add any of the following link elements to 
your model, depending on the link element’s location within the network:

• Pressure pipes

• Conduits

• Channels

• Gutters

When you click the Layout tool on the Layout toolbar, you select the type of link 
element to add (pressure pipe, conduit, channel, or gutter), then select an element. You 
can place multiple elements with different kinds of connections using the Layout tool.

Layout tool
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• “Pressure Pipe Attributes” on page 15-821

Entering Additional Data to Link Elements

There are several dialog boxes that are available from the Property Editors that let you 
enter additional data for link elements.

• “Defining a Control Structure in a Conduit” on page 6-192

• “Adding a Minor Loss Collection to a Pressure Pipe” on page 6-196

• “Defining the Geometry of a Link Element” on page 6-198

• “Defining the Cross-Sectional Shape of a Link Element” on page 6-199

• “Defining Manning’s n vs. Depth Curves” on page 6-201

• “Defining Manning’s n vs. Flow Curves” on page 6-202

Defining a Control Structure in a Conduit

In SewerGEMS V8i, you can attach a control structure, such as a weir or orifice, at 
either the upstream end or the downstream end of a conduit, or at both ends of the 
conduit. A control can also have a flap gate which allows flow to travel in only one 
direction. You define control structures for conduits in the Conduit Control Structures 
dialog box, which is accessible from the Property Editor for a conduit.

Note: For more information about control structures in SewerGEMS 
V8i, see “Flow Control Structures” on page 14-748.

To define a control structure in a conduit:

1. Click a conduit in your model to display the Property Editor, or right-click a 
conduit and select Properties from the shortcut menu.

2. If the conduit has a start control structure, do the following:

a. In the Physical: Control Structure section of the Property Editor for the 
conduit, select the type of start control structure by selecting Side or Inline 
from the Start Control Structure Type submenu.

a. If the conduit contains a start control structure, set the Has Start Control 
Structure? field to True.

3. If the control structure contains a flap gate, set the Flap Gate field to True.

4. If the conduit contains a stop control structure, set the Has Stop Control Structure? 
field to True.
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5. To define a control structure, click the Ellipses (...) button next to the Start 
Control Structure field and/or the Stop Control Structure, then perform the 
following steps:

a. In the Conduit Control Structure dialog box, click the New button, then select 
the type of control structure you want to create from the submenu (Functional, 
Orifice, Depth-Flow Curve, or Weir).

b. For a Functional control structure, specify whether the structure has a flap 
gate or not, then enter values for Crest Elevation, Coefficient, and Exponent. 

c. For an Orifice control structure, specify whether the structure has a flap gate 
or not, enter values for Crest Elevation and Orifice Coefficient, select the 
Orifice Type (Bottom Outlet or Side Outlet) and Orifice Shape (Circular or 
Rectangular), then enter values for Diameter for a Circular orifice or Height 
and Width for a Rectangular orifice.

d. For a Depth-Flow Curve orifice, specify whether the structure has a flap gate 
or not, enter a value for Crest Elevation, then enter Depth and Flow values in 
the Depth-Flow table.

e. For a Weir control structure, specify whether the structure has a flap gate or 
not, enter values for Crest Elevation, Weir Coefficient, and Structure Top 
Elevation, then select the Weir Type (Inline, Side, V-Notch, or Trapezoidal) 
and enter values for the selected Weir Type.

f. Repeat Steps a - e for each additional component you want to add to the 
control structure, then click Close.

6. Perform the following optional steps:

– To delete a component from the control structure, select the item in the list 
pane then click Delete.

– To rename a control structure, select the control structure you want to rename, 
click Rename, then type the new name.

– To view a report on the control structure, click Report.

– To view a graph of a Depth-Flow curve, click Graph above the Depth-Flow 
curve table.

Conduit Control Structure Dialog Box

The Conduit Control Structure dialog box lets you add and edit control components to 
the control structure of a conduit.
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Depending on the type of control structure you select, the Conduit Control Structure 
dialog box contains the following controls:

New Lets you create a new component for 
your control structure. These attributes 
are Functional, Orifice, Depth-Flow 
Curve, and Weir.

Delete Lets you delete the selected attribute.

Rename Lets you rename the control structure. By 
default, the structure is given a unique 
name, but you can set any other unique 
name that you prefer.

Report Lets you create and view a report of the 
control structure.

Functional

Has Flap Gate? Select this check box if the component includes a 
flap gate, clear it if not. When checked, reverse 
flow is not allowed through the structure.

Crest Elevation The structure elevation at which flow starts to 
occur.

Coefficient Set the coefficient. 

Exponent Set the exponent.

Orifice

Has Flap Gate? Select this check box if the component includes a 
flap gate, clear it if not. When checked, reverse 
flow is not allowed through the structure.

Orifice Coefficient Set the coefficient. 

Orifice Type Select the type of orifice from the drop-down list: 
Side Outlet or Bottom Outlet. A Bottom Outlet 
type refers to a drop orifice (flow drops through 
it). A Side Outlet type refers to a normal flow-by 
orifice 
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Orifice Shape Choose a circular or rectangular orifice. 

Orifice Diameter Set the diameter of a circular orifice.

Orifice Height Set the height for a rectangular orifice. 

Orifice Width Set the width for a rectangular orifice.

Depth-Flow Curve

Has Flap Gate? Select this check box if the component includes a 
flap gate, clear it if not. When checked, reverse 
flow is not allowed through the structure.

Depth-Flow Set the depth and flow values that define the 
depth-flow curve. The depth-flow curve consists 
of a table of the depth and pairs that define the 
depth-flow curve. Depth in this case refers to the 
water depth above the invert on the upstream side 
of the control structure and flow is the flow 
through/over the control structure.

New Click this button to add new rows to the depth-
flow table.

Delete Click this button to remove selected rows from the 
depth-flow table. You can only remove one row at 
a time, if you have selected more than one row, 
only the last row you selected is removed

Graph Click this button to view a graph of the Depth-
Flow curve.

Weir

Has Flap Gate? Select this check box if the component includes a 
flap gate, clear it if does not. When checked, 
reverse flow is not allowed through the structure.

Side Slope Set the side slope of the weir.

Weir Coefficient Set the weir coefficient, which is also known as 
the coefficient of flow. This value is used to 
account for variables that are not otherwise 
directly accounted for in the weir equation (e.g., 
vena contracta). 
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Adding a Minor Loss Collection to a Pressure Pipe

Pressure pipes can have an unlimited number of minor loss elements associated with 
them. SewerGEMS V8i provides an easy-to-use table for editing these minor loss 
collections in the Minor Loss Collection dialog box.

Note: For more information on minor losses, see “Minor Losses” on 
page 14-747.

To add a minor loss collection to a pressure pipe:

1. Click a pressure pipe in your model to display the Property Editor, or right-click a 
pressure pipe and select Properties from the shortcut menu.

2. In the Physical: Minor Losses section of the Property Editor, click the Ellipses 
(...) button next to the Minor Loss Coefficient field.

3. In the Minor Loss Collection dialog box, each row in the table represents a single 
minor loss type and its associated headloss coefficient. For each row in the table, 
perform the following steps:

Structure Top 
Elevation

Set the structure top elevation for the weir.

Weir Type Select the type of weir from the drop-down list: 
inline, side, V-notch, or trapezoidal.

Number of 
Contractions

Set the number of contractions for an inline weir. 
This field is available only when you select Inline 
Weir as the Weir Type.

Weir Length Set the length of the weir. 

Weir Angle Set the weir angle for a V-notch weir. This field is 
available only when you select V-Notch Weir as 
the Weir Type.

Weir End Coefficient Discharge coefficient for flow through the 
triangular ends of a trapezoidal weir. Typical 
values are 2.4 - 2.8 US (1.35 - 1.55 SI). This field 
is available only when you select Trapezoidal 
Weir as the Weir Type.

Weir Side Slope Set the slope of the side of a trapezoidal weir. This 
field is available only when you select Trapezoidal 
Weir as the Weir Type.
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a. Type the number of minor losses of the same type to be added to the 
composite minor loss for the pipe in the Quantity column, then press the Tab 
key to move to the Minor Loss column.

b. Click the Ellipses (...) button in the Minor Loss column to display the Minor 
Loss Libraries in the Engineering Libraries.

c. Click the plus signs to expand the Minor Loss Libraries, then select the 
desired minor loss type and click the Select button. The minor loss type and 
its associated headloss coefficient appears in the table in the Minor Loss 
Collection dialog box. Note that the Headloss Coefficient column in the table 
is not editable.

Note: You can edit the values of a minor loss type in the Engineering 
Libraries in the Editor pane. 

4. When you are finished adding minor losses to the table, click Close. The 
composite minor loss coefficient for the minor loss collection appears in the Prop-
erty Editor.

5. Perform the following optional steps:

– To delete a row from the table, select the row label then click Delete.

– To view a report on the minor loss collection, click Report.

6. You can override the headloss coefficient for the minor loss collection by typing a 
custom value in the Minor Loss Coefficient field of the Property Editor.

Minor Loss Collection Dialog Box

The Minor Loss Collection dialog box contains buttons and a minor loss table. The 
dialog box contains the following controls:

The table contains the following columns:

New This button creates a new row in the table.

Delete This button deletes the currently highlighted 
row from the table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.
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Defining the Geometry of a Link Element

You define the geometry of a link element by entering the location and angle of bends 
for the selected link element. You enter X vs. Y points that plot the shape of the 
polyline that represents the element in the Polyline Vertices dialog box .

To define the geometry of a link element:

1. Click a link element in your model to display the Property Editor, or right-click a 
link element and select Properties from the shortcut menu.

2. In the Geometry section of the Property Editor, click the Ellipses (...) button next 
to the Geometry field.

3. In the Polyline Vertices dialog box, click the New button to add a new row to the 
table.

4. Type values for X and Y points for each row in the table.

5. To remove rows from the table, click the Delete button.

6. Click OK.

Polyline Vertices Dialog Box

This dialog box contains the X vs. Y table that allows you to define any number of 
points that plot the shape of the polyline representing the selected link element. 

The dialog box contains the following controls:

Column Description

Quantity The number of minor losses of the same type to be 
added to the composite minor loss for the pipe.

Minor Loss The type of minor loss element. Clicking the 
Ellipses button next to this field displays the 
Minor Loss Engineering Libraries, where you 
select an existing minor loss type to be included in 
your minor loss collection.

Headloss Coefficient The headloss coefficient for a single minor loss 
element of the specified type.
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Defining the Cross-Sectional Shape of a Link Element

You define the cross-sectional shapes of link elements in their respective Property 
Editor as follows:

• Define the cross-sectional shape of a conduit section by entering data in the Phys-
ical section of the element’s Property Editor.

• Define the cross-sectional shape of an irregular conduit section by entering 
Station vs. Depth data in the Station-Depth Curve dialog box. 

• Define the cross-sectional shape of an irregular channel or gutter section by 
entering Station vs. Elevation data in the Station-Elevation Curve dialog box. 

• Define the cross-sectional shape of a trapezoidal channel or gutter section by 
entering data in the Physical section of the element’s Property Editor.

• Define the circular shape of a pressure pipe by entering data in the Physical 
section of the element’s Property Editor.

You access the curve dialog boxes in the selected link element’s Property Editor.

Note: Although you can have complex channels, the algorithm does 
not support split flows or bridges. If you split the channel within 
the cross section, a constant water surface across the cross 
section is assumed. 

When the elevation of the water surface exceeds the highest 
elevation in the table, the last two unsubmerged points are 
linearly extrapolated to create a new, wider channel. 

To define the cross-sectional shape of a link element:

1. Display the Property Editor for the link element:

a. For a conduit, gutter, or pressure pipe, click the link element in your model, or 
right-click the link element and select Properties from the shortcut menu.

b. For a channel, click the connecting cross-section node in your model, or right-
click the channel and select Properties from the shortcut menu.

New This button creates a new row in the table.

Delete This button deletes the currently highlighted 
row from the table.
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2. In the Physical section of the Property Editor for the selected link element, define 
the cross-section of the selected link element as follows:

– For a cross-section (channel link element) or a gutter, select either Trape-
zoidal Channel or Irregular Channel as the Section Type. For trapezoidal 
channels, enter data in the appropriate fields. If you select Irregular Channel, 
the Station-Elevation Curve field becomes available. Click the Ellipses (...) 
button next to the Station-Elevation Curve field to display the Station-Eleva-
tion Curve dialog box, then type values for station and elevation in the table.

– For a conduit, select a section type, then enter data in the appropriate fields. If 
you select Irregular Channel as the Section Type, the Station-Depth Curve 
field becomes available. Click the Ellipses (...) button next to the Station-
Depth Curve field to display the Station-Depth Curve dialog box, then type 
values for station and depth in the table.

– For a pressure pipe, which always has a circular section shape, enter data in 
the appropriate fields.

Station-Elevation Curve/Depth Dialog Box

This dialog box allows you to enter Station vs. Elevation data for the cross-sectional 
shape of a cross-section or a gutter element, or Station vs. Depth data for the cross-
sectional shape of a conduit.

The dialog box contains the station vs. elevation table along with the following 
controls:

New This button creates a new row in the station-
elevation table.

Delete This button deletes the currently highlighted 
row from the station-elevation table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the station-
elevation curve defined by the points in the 
table
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The table contains the following columns:

Defining Manning’s n vs. Depth Curves

You can define the roughness type for a conduit or a channel by creating a Manning’s 
n vs. Depth curve. You define the curve for a channel in the Property Editor for the 
connecting cross section node.

To define a Manning’s n vs. Depth curve for a conduit or a channel:

1. Display the Property Editor for the link element:

a. For a conduit, click the conduit in your model, or right-click the conduit and 
select Properties from the shortcut menu.

b. For a channel, click the connecting cross-section node in your model, or right-
click the channel and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, select Manning’s n - Depth Curve 
as the Roughness Type. The Manning’s n-Depth Curve field becomes available.

3. Click the Ellipses (...) button next to the Manning’s n - Depth Curve field.

4. In the Manning’s n - Depth Curve dialog box, each row in the table represents a 
depth value and its associated Manning’s n roughness value. For each row in the 
table, perform the following steps:

a. Type the depth in the Depth column, then press the Tab key to move to the 
Manning’s n column.

b. Type a value in the Manning’s n column or click the Ellipses (...) button in the 
column to display the Material Libraries in the Engineering Libraries.

c. Click the plus signs to expand the Material Libraries, then select the desired 
material and click the Select button. The Manning’s n roughness value associ-
ated with the selected material appears in the table.

Column Description

Station This field allows you to define the cross-sectional 
distance at the current curve point. You can enter 
these in any order that defines the channel (e.g., 
from left-to-right, from right-to-left, with an 
upstream or downstream perspective).

Elevation/Depth This field allows you to define the elevation for 
the current curve point for a cross-section or 
gutter, or depth for a conduit. This value can be a 
negative number.
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Note: You can edit the values of a minor loss type in the Engineering 
Libraries in the Editor pane. 

5. Click the New button to add a row to the table.

6. Repeat Steps 4 and 5 for each new row of values in the table.

7. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

8. Click OK to close the dialog box and save the curve data in the Property Editor.

Manning’s n–Depth Curve Dialog Box

This dialog box lets you define a Manning’s n vs. Depth table for conduits and chan-
nels. The dialog box contains the Depth vs. Manning’s table and the following 
buttons:

The table contains the following columns:

Defining Manning’s n vs. Flow Curves

You can define the roughness type for a conduit or a channel by creating a Manning’s 
n vs. Flow curve. You define the curve for a channel in the Property Editor for the 
connecting cross section node.

New Creates a new row in the table.

Delete Deletes the currently highlighted row from 
the table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Column Description

Depth Lets you define the depth of the depth vs. 
Manning’s curve point.

Manning’ n Lets you define the roughness value at the 
specified depth in the Depth vs. Manning’s table.
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To define a Manning’s n vs. Flow curve for a conduit or a channel:

1. Display the Property Editor for the link element:

a. For a conduit, click the conduit in your model, or right-click the conduit and 
select Properties from the shortcut menu.

b. For a channel, click the connecting cross-section node in your model, or right-
click the channel and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, select Manning’s n - Flow as the 
Roughness Type. The Manning’s-Flow Curve field becomes available. 

3. Click the Ellipses (...) button next to the Manning’s n - Flow Curve field.

4. In the Manning’s n - Flow Curve dialog box, each row in the table represents a 
depth value and its associated Manning’s n roughness value. For each row in the 
table, perform the following steps:

a. Type the depth in the Flow column, then press the Tab key to move to the 
Manning’s n column.

b. Type a value in the Manning’s n column or click the Ellipses (...) button in the 
column to display the Material Libraries in the Engineering Libraries.

c. Click the plus signs to expand the Material Libraries, then select the desired 
material and click the Select button. The Manning’s n roughness value associ-
ated with the selected material appears in the table.

Note: You can edit the values of a minor loss type in the Engineering 
Libraries in the Editor pane. 

5. Click the New button to add a row to the table.

6. Repeat Steps 4 and 5 for each new row of values in the table.

7. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

8. Click OK to close the dialog box and save the curve data in the Property Editor.

Manning’s n–Flow Curve Dialog Box

This dialog box lets you define Flow vs. Manning’s n tables for conduits and channels.
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The dialog box contains the flow vs. Manning’s table and the following buttons:

The table contains the following columns:

C-Depth Table Dialog Box

This dialog box allows you to enter Depth vs. C data for a weir associated with a 
conduit.

The dialog box contains the Depth vs. C table along with the following controls:

New Creates a new row in the table.

Delete Deletes the currently highlighted row from 
the table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Column Description

Flow Lets you define the flow of the flow vs. Manning’s 
curve point. 

Manning’ n Lets you define the roughness value at the 
specified flow in the Flow vs. Manning’s table.

New This button creates a new row in the Depth 
vs. C table.

Delete This button deletes the currently highlighted 
row from the Depth vs. C table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the Depth vs. 
C curve defined by the points in the table.
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The table contains the following columns:

Depth Width Curve Dialog Box

A depth-width curve is a method of describing a closed conduit that is not a standard 
shape. The Depth Width Curve dialog box lets you enter points on a depth-width 
curve for a conduit whose Section Type is defined as Irregular Closed Section.

The dialog box contains the depth vs.width table and the following controls:

The table contains the following columns:

Column Description

Depth This field allows you to define the depth at the 
current curve point. You can enter these in any 
order that defines the weir (e.g., from left-to-right, 
from right-to-left, with an upstream or 
downstream perspective).

C This field allows you to define the C value for the 
current curve point. 

New This button creates a new row in the depth-
width table.

Delete This button deletes the currently highlighted 
row from the depth-width table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the depth-
width curve defined by the points in the table

Column Description

Depth Lets you define the depth of the curve point.

Width Lets you define the width of the conduit at a 
specific depth.
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Sections Results Dialog Box

The Section Results dialog box shows the calculated flow variables at the start, middle 
and end of a pipe, conduit, or channel section. You can view the data but you cannot 
edit it while in the dialog.

The dialog box contains a table displaying the section results and the following 
control:

The table displays the following section results:

• Section Distance

• Section Velocity

• Section Flow

• Section Hydraulic Grade

• Section Depth

• Section Flow-Width

• Section Flow-Area

• Section Is Overflowing?

• Section Froude Number

To open this dialog box, go to the Results section of the Property Editor for a pipe, 
conduit, or a channel after the model has been calculated. Then click the Ellipsis (…) 
button in the Section Results field.

What Happens When the Water Level Exceeds the Top Elevation of 
an Open Channel?

When the hydraulic grade line (HGL) exceeds the channel top elevation, the last width 
defined for the channel (or the cross section node) is extended vertically to no limit. 
So there is no overflow for these. When the channel is bounded by a manhole, over-
flow occurs at the manhole.

How Do Cross Section Nodes Control the Shape of Channel 
Cross-Sections? 

When you connect a channel between two cross section nodes, the cross-section of the 
channel is interpolated between the two cross section nodes. When there is only one 
cross-section node at either the upstream or downstream end of a channel, then the 
channel will have a constant cross-section, as defined by that one cross-section node. 

Report Opens a print preview window containing a 
report of the sections results.
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If there is a cross section node at each end of a channel, then the channel will start with 
a cross section as defined in the upstream cross-section node, and will make a transi-
tion to the cross-section defined in the downstream cross section node. 

When you connect a channel to a conduit at a cross-section node, a transition is added 
between the channel and the conduit. You can specify the type of transition in the 
Property Editor for the cross-section node as either Gradual or Abrupt. If you specify 
Abrupt, the top width of the channel cross-section is used as the length of the transi-
tion part. If you select Gradual, you enter a value for the Transition Length. If the 
Transition Length is larger than the top width of the cross-section node, the Transition 
Length value is used as the length of the transition part. 

Catch Basins

Catch basins convey surface water into a storm sewer pipe system. A catch basin 
(a.k.a., storm drain inlet, curb inlet) is an inlet to the storm drain system that typically 
includes a grate or curb inlet where stormwater enters the catch basin and a sump to 
capture sediment, debris and associated pollutants. They are also used in combined 
sewer watersheds to capture floatables and settle some solids.

When you click the catch basin element on the Layout toolbar, your mouse cursor 
changes into a catch basin element symbol. Clicking in the drawing pane while this 
tool is active causes a catch basin element to be placed at the location of the mouse 
cursor.

Inlet Type

The inflow to a catch basin does not all enter the basin. The flow that actually enters 
the basin is referred to as its “capture.”

A catch basin may:

• Capture all the flow that comes to it, which is referred to as “full capture.”

• Capture all of the flow up to a “maximum capacity,” and you specify the 
maximum flow.

• Capture flow in accordance with some curve called an inflow vs. capture curve. 
For more information on inflow vs. capture curves, see “Adding Inflow vs. 
Capture Data to a Catch Basin” on page 6-208.

Catch basin element
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Any inflow that is not captured goes to a gutter. If there is no gutter, the inflow that is 
not captured is lost from the system.

Adding Inflow vs. Capture Data to a Catch Basin

You can add an Inflow vs. Capture curve to any catch basin in your model. The Inflow 
vs. Capture curve plots the total inflow against the total captured flow for a series of 
data points that you define.

To add Inflow vs. Capture data to a catch basin:

1. Click a catch basin in your model to display the Property Editor, or right-click a 
catch basin and select Properties from the shortcut menu.

2. In the Inlet section of the Property Editor, select Inflow-Capture Curve as the 
Inlet Type. The Inflow-Capture Curve field becomes available.

3. Click the Ellipses (...) button next to the Inflow-Capture Curve field.

4. In the Inflow-Capture Curve dialog box, each row in the table represents a data 
point on the Inflow-Capture curve. Type values for the Total Inlet Flow and Inlet 
Capture for each row. Click the New button to add a row or press the Tab key to 
advance to the next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Inflow-Capture Curve Dialog Box

This dialog box allows you to define Total Inflow vs. Inlet Capture tables for catch-
ments. The dialog box contains the inflow vs. capture table along with the following 
controls:
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The table contains the following columns:

Manholes

Manholes are placed in a sewer system to provide access for inspection, maintenance, 
and emergency service. Manholes should be placed at sewer junctions (i.e., tees, wyes, 
and crosses), upstream terminal ends of sewers, and locations where there is a change 
in sewer grade or direction. Manholes are locations where loads enter the gravity 
portion of the sewer system.

New Creates a new row in the inflow-capture 
curve table.

Delete Deletes the currently highlighted row 
from the inflow-capture curve table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the 
inflow-capture curve defined by the 
points in the table.

Column Description

Total Inlet Inflow Lets you define the inflow at the current curve 
point. Total inlet flow is the cumulative flow from 
all catchments and other loads that actually 
reaches the catch basin.

Inlet Capture Lets you define the total captured flow for the 
current curve point. Inlet capture is the portion of 
the total inlet flow that actually enters the catch 
basin and is passed downstream.

Manhole element
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When you click the manhole element on the Layout toolbar, your mouse cursor 
changes into a manhole element symbol. Clicking in the drawing pane while this tool 
is active causes a manhole element to be placed at the location of the mouse cursor.

Adding Surface Depth vs. Area Data to a Catch Basin or a Manhole

You can add a Surface Depth vs. Area curve to any catch basin or manhole in your 
model. The Surface Depth vs. Area curve plots depth against area for a series of data 
points that you define.

To add Surface Depth vs. Area data to a catch basin or a manhole:

1. Display the Property Editor for a catch basin or manhole by clicking the element 
in the Drawing Pane, or by right-clicking the element then selecting Properties 
from the shortcut menu.

2. In the Physical: Surface Storage section of the Property Editor, select Surface 
Depth- Area Curve as the Surface Storage Type. The Surface Depth-Area Curve 
field becomes available.

3. Click the Ellipses (...) button next to the Surface Depth-Area Curve field.

4. In the Surface Depth-Area Curve dialog box, each row in the table represents a 
data point on the Surface Depth-Area curve. Type values for the Depth and Area 
for each row. Click the New button to add a row or press the Tab key to advance 
to the next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Surface Depth-Area Curve Editor

This dialog box allows you to define Depth vs. Area tables for manholes and catch 
basins. The dialog box contains the depth-area table and the following buttons:
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The table contains the following columns:

Cross Sections

When you click the cross section element on the Layout toolbar, your mouse cursor 
changes into a cross section element symbol. Clicking in the drawing pane while this 
tool is active causes a cross section element to be placed at the location of the mouse 
cursor.

Junction Chambers

New Creates a new row in the depth-area table.

Delete Deletes the currently highlighted row from 
the depth-area table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the surface 
depth-area curve defined by the points in the 
table.

Column Description

Depth Lets you enter the depth data for the curve.

Area Lets you enter the area data for the curve.

Cross section element

Junction chamber element
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Junction chambers are locations where upstream flows in a gravity system combine.  
No loads enter the sewer at these points.

When you click the junction chamber element on the Layout toolbar, your mouse 
cursor changes into a junction chamber element symbol. Clicking in the drawing pane 
while this tool is active causes a junction chamber element to be placed at the location 
of the mouse cursor.

Related Topics

• “Junction Chamber Attributes” on page 15-905

Pressure Junctions

Pressure junctions are connections between two or more pressure pipes of varying 
characteristics.  Loads may enter a pressure portion of a network through a pressure 
junction.

When you click the pressure junction on the Layout toolbar, your mouse cursor 
changes into a pressure junction element symbol. Clicking in the drawing pane while 
this tool is active causes a pressure junction element to be placed at the location of the 
mouse cursor.

Related Topics

• “Pressure Junction Attributes” on page 15-910

Pond Outlet Structures

Pressure junction element

Outlet structure element
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When you click the outlet structure element on the Layout toolbar, your mouse cursor 
changes into a outlet structure element symbol. Clicking in the drawing pane while 
this tool is active causes a outlet structure element to be placed at the location of the 
mouse cursor.

Note: If there are multiple discharges locations serving a pond then 
they must all be modeled in the same manner; that is, they must 
either all be modeled with outlet control structures, or all 
modeled without outlet control structures.

Defining Composite Outlet Structures

SewerGEMS V8i lets you define composite outlet structures for pond outlet structures 
in your model. A composite outlet structure can contain any combination of orifices, 
risers, and weirs. You define these outlet structures in the Composite Outlet Structures 
dialog box.

To define a composite outlet structure:

1. Click a pond outlet structure in your model to display the Property Editor, or right-
click a pond outlet structure and select Properties from the shortcut menu.

2. In the Pond Outlet section of the Property Editor, select Yes in the Has Control 
Structure field. The Control Structure field becomes available.

3. Click the Ellipses (...) button next to the Control Structure field. The Composite 
Outlet Structures dialog box appears, displaying the existing composite outlet 
structure associated with the selected pond outlet structure.

4. To create a new composite outlet structure, perform these steps:

a. Click New, then select the type of outlet structure component you want to add 
(Orifice, Riser, or Weir).

b. The right side of the dialog box displays settings for the composite outlet 
structure and for each individual component in the composite outlet structure. 
With the composite outlet structure selected in the list pane, enter values for 
Tolerance Settings and ICPM Settings.

c. Select each individual component in the list pane, then enter values for that 
component in the fields on the right.

d. If you define a weir as an Irregular Weir, you must define the cross-
sectional shape of the irregular weir by entering X (Station) vs. Y 
(Depth) data. To do this, click the Cross Section button, enter X and Y 
values in the Irregular Cross Section dialog box, then click OK to close that 
dialog box.
Bentley SewerGEMS V8i User’s Guide 6-213



Elements and Element Attributes
5. To edit an existing composite outlet structure, perform these steps:

a. If necessary, edit the Tolerance Settings and ICPM Settings for the selected 
composite outlet structure.

b. Click the plus sign (+) next to the outlet structure in the list pane to display its 
individual components.

c. Select the component (Orifice, Riser, or Weir), then edit the values for the 
component on the right side of the dialog box. 

d. If you define a weir as an Irregular Weir, you must define the cross-
sectional shape of the irregular weir by entering X (Station) vs. Y 
(Depth) data. To do this, click the Cross Section button, enter X and Y 
values in the Irregular Cross Section dialog box, then click OK to close that 
dialog box.

e. To add a new component to an existing composite outlet structure, select the 
outlet structure in the list pane then click New and select Orifice, Riser, or 
Weir from the submenu. You can also right click an existing composite struc-
ture in the list pane, then select New > Orifice, New > Riser, or New > Weir 
from the shortcut menu.

6. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To rename an existing composite outlet structure, click Rename, then type the 
new name.

– To view a report on the composite outlet structure, click Report.

– To view a plot of the composite outlet structure, click Graph. The graph will 
display multiple curves, one for each component in the composite outlet struc-
ture.

7. Click OK to close the dialog box and save your data in the Property Editor.

Composite Outlet Structures Dialog Box

This dialog box allows you to define and manage composite outlet structures for pond 
outlet structures. The dialog box is divided into three parts: the composite structure list 
pane on the left, the common settings section in the top-right, and the structure editor 
section in the bottom-right.

The Composite Outlet Structure List Pane, located on the left side of the dialog box, 
displays the composite outlet structures that are associated with the selected pond 
outlet structure. Clicking the plus sign next to each composite outlet structure displays 
the individual structures that make up the composite outlet structure. Highlighting a 
structure in the list causes the sections on the right side of the dialog box to display the 
data associated with the highlighted structure. 
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The dialog box contains the following controls:

When a composite control structure is highlighted in the list pane, controls become 
available in the right side of the dialog, allowing you to define values for attributes 
associated with the control structure. These controls are divided into two sections: the 
Tolerance Settings section and the ICPM Settings section. 

The following controls are found in the Tolerance Settings section:

New Creates a new composite outlet structure 
that uses an automatically created label.

• Orifice—Adds a new orifice struc-
ture to the current composite outlet 
structure.

• Riser—Adds a new riser structure to 
the current composite outlet struc-
ture.

• Weir—Adds a new weir structure to 
the current composite outlet struc-
ture.

Delete Deletes the currently highlighted 
composite outlet structure.

Rename Lets you rename the currently 
highlighted outlet structure.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Outlet Structure list 
pane .

Graph Lets you generate a graph of the 
composite outlet structure after you 
compute your model.

Tolerance Settings

Maximum Iterations This value specifies the maximum number of 
iterations that the program will calculate. The 
higher the number entered here, the longer the 
calculation may potentially take.
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Minimum Hw 
Tolerance

If the program is checking computed HW 
elevations during the iterative HW convergence 
computations, this tolerance value specifies the 
minimum target convergence between the 
computed value and the known headwater value.

Maximum Hw 
Tolerance

If the program is checking computed HW 
elevations during the iterative HW convergence 
computations, this tolerance value specifies the 
maximum allowable difference between the 
computed value and the known headwater value.

Minimum Tw 
Tolerance

If the program is checking computed TW 
elevations during the iterative TW convergence 
computations, this tolerance value specifies the 
minimum target convergence and the maximum 
allowable difference between the computed value 
and the known tailwater value.

Maximum Tw 
Tolerance

If the program is checking computed TW 
elevations during the iterative TW convergence 
computations, this tolerance value specifies the 
maximum allowable difference between the 
computed value and the known tailwater value.

Minimum Q Tolerance If the program is checking computed flow during 
the iterative TW convergence computations, this 
tolerance value specifies the minimum target 
convergence between the computed value, and the 
known flow value.

Maximum Q Tolerance If the program is checking computed flow during 
the iterative TW convergence computations, this 
tolerance value specifies the maximum allowable 
difference between the computed value, and the 
known flow value.

ICPM Settings

Override Hw Range Checking this box causes the three headwater 
range attribute fields to become editable, allowing 
you to override the automatically calculated 
settings.
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When a component of the control structure is highlighted in the list pane, a number of 
controls become available that allow you to define values for the various attributes 
that are associated with the structural component.

The specific controls available to you varies somewhat, depending on the type of 
component being edited. The following controls are available in this section of the 
dialog box:

Headwater Step Lets you define the interval at which headwater 
will be calculated. This field is only available for 
input when the Override Hw Range box is 
checked.

Minimum Headwater 
Elevation

Lets you define the minimum headwater 
elevation. This field is only available for input 
when the Override Hw Range box is checked.

Maximum Headwater 
Elevation

Lets you define the maximum headwater 
elevation. This field is only available for input 
when the Override Hw Range box is checked.

Override Tw Range Checking this box causes the three tailwater range 
attribute fields to become editable, allowing you 
to override the automatically calculated settings.

Tailwater Step Lets you define the interval at which tailwater will 
be calculated. This field is only available for input 
when the Override Tw Range box is checked.

Minimum Tailwater 
Elevation

Lets you define the minimum tailwater elevation. 
This field is only available for input when the 
Override Tw Range box is checked.

Elevation (Maximum 
Tailwater)

Lets you define the maximum tailwater elevation. 
This field is only available for input when the 
Override Tw Range box is checked.

Orifice Common Settings

Flow Direction Lets you specify the flow direction as bi-
directional (forward or reverse), forward only, or 
reverse only.

Elevation Lets you define the invert elevation, which is the 
elevation of the lowest point of the orifice opening 
or channel.
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# of Openings Lets you define the number of openings the orifice 
uses.

Orifice Coefficient Lets you define the orifice coefficient. Although 
the orifice coefficients vary with shape, size, and 
head depth, an average C coefficient of 0.60 is 
often used for stormwater orifice openings. 
Handbook of Hydraulics (Brater and King 1976) 
lists orifice coefficients for various heads and 
sizes of circular, square, rectangular, and 
triangular shapes. Engineering Field Manual for 
Conservation Services (U.S. Soil Conservation 
Service 1986a) provides a chart of orifice 
coefficients for orifice plates placed over pipe 
openings.

Orifice Settings The following data is required to define an Orifice 
outlet structure.

Orifice Lets you choose between a circular orifice or one 
with a known area.

Diameter Set the diameter of the clear opening for a circular 
orifice. This field is available only when the 
Orifice Type is Circular.

Orifice Area This field allows you to set the orifice area, the 
clear opening area for each individual orifice 
opening. For example, if your outlet structure has 
10 rectangular orifices that measure 2 ft. x 3 ft., 
you would enter an area of 6 sq. ft. not 60 sq. ft. 
This field is available only when the Orifice Type 
is Area.

Orifice Orientation Lets you specify whether the orifice is parallel to 
or perpendicular to the direction of flow. This 
menu is available only when the Orifice Type is 
Area.

Datum Elevation Lets you set the elevation from which to measure 
the orifice head (H) when a perpendicular orifice 
orientation is specified. This field is available only 
when the Orifice Type is Area and the Orifice 
Orientation is Perpendicular.
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Elevation (Top) Lets you define the highest elevation in the 
channel. Elevations above this value are 
considered to be overtopping the channel. For a 
perpendicular orifice, the top elevation is 
considered to be the highest point of the orifice 
opening. This field is available only when the 
Orifice Type is Area and the Orifice Orientation is 
Perpendicular.

Riser Common Settings

Flow Direction Lets you specify the flow direction as bi-
directional (forward or reverse), forward only, or 
reverse only.

Elevation Lets you define the invert elevation, which is the 
elevation of the lowest point of the orifice opening 
or channel.

Weir Coefficient This field allows you to define the weir 
coefficient, which is also known as the coefficient 
of flow. This value is used to account for variables 
that are not otherwise directly accounted for in the 
weir equation (e.g., vena contracta).

Note: Metric users must input the 
weir coefficient for U.S. 
customary units. Otherwise, a 
computational error results.

Orifice Coefficient Lets you define the orifice coefficient. Although 
the orifice coefficients vary with shape, size, and 
head depth, an average C coefficient of 0.60 is 
often used for stormwater orifice openings. 
Handbook of Hydraulics (Brater and King 1976) 
lists orifice coefficients for various heads and 
sizes of circular, square, rectangular, and 
triangular shapes. Engineering Field Manual for 
Conservation Services (U.S. Soil Conservation 
Service 1986a) provides a chart of orifice 
coefficients for orifice plates placed over pipe 
openings
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Riser Settings The following data is required to define a Riser 
outlet structure:

Riser Lets you specify whether the riser is a stand pipe 
or an inlet box.

Diameter Lets you set the diameter, which is used to 
compute the weir length (perimeter) and orifice 
area. This field is available only when the Riser 
Type is Stand Pipe.

Weir Length Lets you set the weir length, the effective weir 
length for the inlet box. This value is used for 
computing flow when the inlet box is assumed to 
be operating under weir conditions. This field is 
available only when the Riser Type is Inlet Box.

Orifice Area Lets you set the orifice area, the clear opening area 
for each individual orifice opening. For example, 
if your outlet structure has 10 rectangular orifices 
that measure 2 ft. x 3 ft., you would enter an area 
of 6 sq. ft. not 60 sq. ft. This field is available only 
when the Riser Type is Inlet Box.

Riser Advanced Options

Transition Elevation Lets you define the elevation corresponding to the 
beginning of the transition zone.

Note: If the transition elevation is left 
blank, the value is 
automatically set such that the 
center of the transition zone is 
located at the elevation where 
weir flow equals orifice flow. In 
other words, half the transition 
height is below the equilibrium 
point and half the height is 
above.

Transition Height Lets you define the height of the transition zone.
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K Reverse The value specified in this field is used when the 
stand pipe or inlet box is under submerged or 
reverse flow conditions. The K coefficient is 
multiplied by the velocity head, (V2/2g), to 
determine the additional headloss due to entrance 
and exit losses.

Weir Common Settings

Flow Direction Lets you specify the flow direction as bi-
directional (forward or reverse), forward only, or 
reverse only.

Elevation Lets you define the invert elevation, which is the 
elevation of the lowest point of the orifice opening 
or channel.

Weir Coefficient This field allows you to define the weir 
coefficient, which is also known as the coefficient 
of flow. This value is used to account for variables 
that are not otherwise directly accounted for in the 
weir equation (e.g., vena contracta).

Note: Metric users must input the 
weir coefficient for U.S. 
customary units. Otherwise, a 
computational error results.

Weir Settings The following data is required to define a Weir 
outlet structure:

Weir Lets you specify whether the weir is Rectangular, 
Irregular, or V-Notch.

V-Notch Angle Lets you define the angle of the weir notch in 
degrees. This input field is available only when 
the Weir Type is V-Notch.

Cross Section Opens the Irregular Weir Cross Section dialog 
box. This button is available only when the Weir 
Type is Irregular.

Rectangular Weir Lets you specify whether the rectangular weir is 
suppressed or contracted. This menu is available 
only when the Weir Type is Rectangular.
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Irregular Weir Cross Section Dialog Box

The Irregular Weir Cross Section dialog box allows you to define the cross-sectional 
shape of an irregular weir in a composite outlet structure by entering X (Station) vs. Y 
(Depth) data.

The Irregular Weir Cross Section dialog box is accessible only from within the 
Composite Outlet Structures dialog box when a weir component is selected in the list 
pane. For the selected weir, click the Cross Section button to display the Irregular 
Weir Cross Section dialog box.

The dialog box contains the x vs. y table along with the following controls:

The table contains the following columns:

Outfalls

Outfalls represent the ultimate termination points in a sanitary sewer network.

Weir Length Lets you define the width of the clear opening 
space for a rectangular weir. This field is available 
only when the Weir Type is Rectangular.

New This button creates a new row in the x-y 
table.

Delete This button deletes the currently 
highlighted row from the x-y table.

Column Description

X This field allows you to define the cross-sectional 
distance at the current point.

Y This field allows you to define the depth (0 at the 
weir crest) for the current point.

Outfall element
6-222 Bentley SewerGEMS V8i User’s Guide



Creating Your Model
When you click the outfall element on the Layout toolbar, your mouse cursor changes 
into a outfall element symbol. Clicking in the drawing pane while this tool is active 
causes a outfall element to be placed at the location of the mouse cursor.

Adding Time vs. Elevation Data to an Outfall

You can define tidal curve tables for outfalls in SewerGEMS V8i. You define a tidal 
curve for an outfall as a Time vs. Elevation curve.

Note: You can also add a Cyclic Time vs. Elevation curve to an outfall. 
For more information, see “Adding Cyclic Time vs. Elevation Data 
to an Outfall” on page 6-226.

To add a Time vs. Elevation curve to an outfall:

1. Click an outfall in your model to display the Property Editor, or right-click an 
outfall and select Properties from the shortcut menu.

2. In the Boundary Condition section of the Property Editor, select Time-Elevation 
Curve in the Boundary Condition Type field. The Time-Elevation Curve field 
becomes available.

3. Click the Ellipses (...) button next to the Time-Elevation Curve field.

4. In the Time-Elevation Curve dialog box, each row in the table represents a point 
on the Time-Elevation curve. Type values for the Time and Elevation for each 
row. Click the New button to add a row or press the Tab key to advance to the 
next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Time-Elevation Curve Dialog Box

This dialog box allows you to define tidal curve (time vs. elevation) tables for outfalls 
when the Boundary Condition is set to Time-Elevation Curve.
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The dialog box contains the time-vs.-elevation table and the following buttons:

The table contains the following columns:

Adding Elevation vs. Flow Data to an Outfall

You can add an Elevation-Flow (E-Q-T) curve to an outfall in SewerGEMS V8i. Each 
series of Elevation-Flow (E-Q-T) curves represents the performance curves for a pond 
outlet operating under various downstream tailwater (T) elevations.

To add an Elevation vs. Flow (E-Q-T) curve to an outfall:

1. Click an outfall in your model to display the Property Editor, or right-click an 
outfall and select Properties from the shortcut menu.

2. In the Boundary Condition section of the Property Editor, select Elevation-Flow 
Curve in the Boundary Condition Type field. The Elevation-Flow Curve field 
becomes available.

3. Click the Ellipses (...) button next to the Elevation-Flow Curve field.

New This button creates a new row in the tidal 
curve table.

Delete This button deletes the currently 
highlighted row from the tidal curve 
table.

Report This button opens a print preview 
window containing a report that details 
the input data for this dialog box.

Graph This button opens a graph window 
plotting the time-elevation curve defined 
by the points in the table.

Column Description

Time This field allows you to define the hour of the tidal 
curve point.

Elevation This field allows you to define the elevation for 
the tidal curve point.
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4. In the Elevation-Flow Curve dialog box, each row in the table represents a point 
on the Elevation-Flow curve. Type values for Elevation and Outlet Flow for each 
row. Click the New button to add a row or press the Tab key to advance to the 
next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Elevation-Flow Curve Dialog Box

The dialog box contains the elevation vs. flow table and the following buttons:

The table contains the following columns:

New This button creates a new row in the E-
Q-TW curve table.

Delete This button deletes the currently 
highlighted row from the E-Q-TW curve 
table.

Report This button opens a print preview 
window containing a report that details 
the input data for this dialog box.

Graph This button opens a graph window 
plotting the elevation-volume curve 
defined by the points in the table.

Column Description

Outlet Elevation This field allows you to define the elevation of the 
E-Q-TW curve point.

Outlet Flow This field allows you to define the flow for the E-
Q-TW curve point.
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Adding Cyclic Time vs. Elevation Data to an Outfall

SewerGEMS V8i lets you add tidal curves to outfalls in your model. You define a tidal 
curve for an outfall as a Time vs. Elevation curve.

Note: You can also add a Time vs. Elevation curve to an outfall. For 
more information, see “Adding Time vs. Elevation Data to an 
Outfall” on page 6-223.

To add a Cyclic Time vs. Elevation curve to an outfall:

1. Click an outfall in your model to display the Property Editor, or right-click an 
outfall and select Properties from the shortcut menu.

2. In the Boundary Condition section of the Property Editor, select Tidal in the 
Boundary Condition Type field. The Cyclic Time-Elevation Curve field becomes 
available.

3. Click the Ellipses (...) button next to the Cyclic Time-Elevation Curve field.

4. In the Cyclic Time-Elevation Curve dialog box, each row in the table represents a 
point on the Cyclic Time-Elevation curve. Type values for Time and Elevation for 
each row. Click the New button to add a row or press the Tab key to advance to 
the next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Cyclic Time-Elevation Curve Dialog Box

This dialog box allows you to define tidal curve (time vs. elevation) tables for outfalls 
when the Boundary Condition is set to Tidal.
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The dialog box contains the time-vs.-elevation table and the following buttons:

The table contains the following columns:

Wet Wells

Wet wells are required at a pumping station to store wastewater before it is pumped. 
Wet wells represent boundary conditions between pressure and gravity portions of a 
sewer network.  They serve as collection points for gravity systems, and as an HGL 
boundary node for the pressure system. Dry loads can also enter the sewer network at 
these locations.

When you click the wet well element on the Layout toolbar, your mouse cursor 
changes into a wet well element symbol. Clicking in the drawing pane while this tool 
is active causes a wet well element to be placed at the location of the mouse cursor.

New This button creates a new row in the tidal 
curve table.

Delete This button deletes the currently 
highlighted row from the tidal curve 
table.

Report This button opens a print preview 
window containing a report that details 
the input data for this dialog box.

Graph This button opens a graph window 
plotting the time-elevation curve defined 
by the points in the table.

Column Description

Time This field allows you to define the hour of the tidal 
curve point.

Elevation This field allows you to define the elevation for 
the tidal curve point.

Wet well element
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Adding Depth vs. Area Data to a Wet Well

You can add Depth vs. Area data to a wet well in your model. You define the Depth vs. 
Area curve for a wet well in the Wet Well Depth-Area Curve dialog box.

To add a Depth vs. Area curve to wet well:

1. Click a wet well in your model to display the Property Editor, or right-click a wet 
well and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, select Wet Well Depth-Area 
Curve in the Wet Well Boundary Type field. The Wet Well Depth-Area Curve 
field becomes available.

3. Click the Ellipses (...) button next to the Wet Well Depth-Area Curve field.

4. In the Wet Well Depth-Area Curve dialog box, each row in the table represents a 
point on the Wet Well Depth-Area curve. Type values for Depth and Area for each 
row. Click the New button to add a row or press the Tab key to advance to the 
next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Wet Well Depth-Area Curve Dialog Box

This dialog box allows you to define Depth vs. Area tables for wet wells. The dialog 
box contains the depth-area table and the following buttons:

New Creates a new row in the depth-area 
table.

Delete Deletes the currently highlighted row 
from the depth-area table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the 
surface depth-area curve defined by the 
points in the table.
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The table contains the following columns:

Pumps

In a wastewater collection system, pumps are placed where the hydraulic grade line 
must be raised. Since sewage primarily flows by gravity, a pump transports sewage 
from a low elevation to a higher elevation. The sewage then flows again by gravity to 
the next pumping station or until it reaches its destination.

When you click the pump element on the Layout toolbar, your mouse cursor changes 
into a manhole pump symbol. Clicking in the drawing pane while this tool is active 
causes a manhole pump to be placed at the location of the mouse cursor.

Defining Pump Settings

You define the on/off settings for each pump in your model in the Pumps dialog box. 
You can define a collection of pump settings for each pump.

To define pump settings:

1. Click a pump in your model to display the Property Editor, or right-click a pump 
and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, click the Ellipses (...) button next to 
the Pumps field. The Pumps dialog box appears.

3. In the Pumps dialog box, each row of the table represents a separate set of pump 
settings. Click the New button to add a row to the table.

4. For each row in the table, perform these steps:

a. Type a unique label for the pump settings.

b. Select an existing pump curve from the Pump Definition field submenu, or 
click the Ellipses button to display the Pump Curve Definitions dialog box, 
where you can create new pump curve definitions or modify existing defini-

Column Description

Depth Lets you enter the depth data for the curve.

Area Lets you enter the area data for the curve.

Pump element
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tions. Click Close to close the Pump Curve Definitions dialog box. New 
pump curve definitions automatically appear in the Pump Definitions field 
submenu.

c. Determine whether the pump is on or off by selecting On or Off in the Pump 
Setting field.

d. Type values for On and Off Elevations. If the suction element is a node, the 
elevation will be determined as the water surface elevation in that element; if 
it is a pressure pipe, then it is the water surface elevation in the node at the 
upstream end of the pressure pipe.  The pump turns on when the calculated 
elevation exceeds the "on" setting and turns off then the calculated elevations 
drops below the "off" setting. 

5. Click OK to close the Pumps dialog box and save your data in the Property Editor.

Pumps Dialog Box

This dialog allows you to define the pump settings for the currently highlighted pump. 
It consists of controls that allow you to add and delete pumps to the table, and to 
generate a report for the currently highlighted pump(s).

The table consists of the following columns:

New Creates a new entry in the Pump Table.

Delete Deletes the entry that is currently 
highlighted in the Pump Table.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the currently highlighted pumps.

Column Description

Pump Definition Lets you specify the pump curve definition to be 
associated with the current pump. The pulldown 
menu in this field lists all of the definitions that are 
associated with the current project. Clicking the 
ellipsis button in this field opens the Pump Curve 
Definitions dialog, allowing you to create new 
definitions.
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Creating Pump Curve Definitions

In SewerGEMS V8i, you can define pump curves of the following types:

• Offline Volume-Flow (Type I, step-wise curve)

• Inline Depth-Flow (Type-II, step-wise curve) 

• Inline Head-Flow (Type-III, continuous curve)

• Inline Variable-Speed Pump (Type IV, continuous curve)

Note: These pump curve types are defined in the dialog box section of 
this help topic below.

Pump Setting Lets you specify whether the pump is initially on 
or off.

On Elevation Lets you define a control elevation for the pump. 
If the water surface elevation of the element 
upstream of the pump (typically a wet well or 
pond - defined in the Suction-side Node field) 
exceeds the value entered in this field, the pump 
will turn on.

Off Elevation Lets you define a control elevation for the pump. 
If the water surface elevation of the element 
upstream of the pump (typically a wet well or 
pond - defined in the Suction-side Node field) 
exceeds the value entered in this field, the pump 
will turn off.

Column Description
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The following illustration shows the four different pump curve types.

You define pump curves in the Pump Curve Definitions dialog box. You can also 
define pump curves in the Engineering Library.

To create a pump curve definition:

1. Select Analysis > Pump Curve Definitions.

2. Click New to create a new pump curve definition.

3. For each pump curve definition, perform these steps:

a. Select the type of pump curve in the Pump Curve Type submenu (Offline 
Volume-Flow Curve, Inline Depth-Flow, Inline Head-Flow, or Inline Vari-
able Speed Pump).

b. Type values for volume vs. flow, head vs. flow, or depth vs. flow in the curve 
table. The columns change depending on which curve type you choose. 

c. Click the New button above the curve table to add a new row to the table, or 
press the Tab key to move to the next column in the table.

TYPE 1 TYPE 2

TYPE 3 TYPE 4
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Volume

Head Depth

Depth

Offline Volume-Flow Inline depth-Flow

Inline Head-Flow Inline VSD
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d. Click the Delete button above the curve table to delete the currently high-
lighted row from the table.

e. Click the Graph button above the curve table to view a plot of the curve.

4. You can save your new pump curve definition in Bentley SewerGEMS V8i’ Engi-
neering Libraries for future use. To do this, perform these steps:

a. Click the Synchronization Options button, then select Export to Library. 
The Engineering Libraries dialog box appears.

b. Use the plus and minus signs to expand and collapse the list of available 
libraries, then select the library into which you want to export your new unit 
sanitary load.

c. Click Close to close the Engineering Libraries dialog box.

5. Perform the following optional steps:

– To delete a pump curve definition, select the curve label then click Delete.

– To rename a pump curve definition, select the label of the pump curve defini-
tion you want to rename, click Rename, then type the new name.

– To view a report on a pump curve definition, select the label for the pump 
curve definition, then click Report.

6. Click Close to close the dialog box.

Pump Curve Definitions Dialog Box

This dialog box allows you to create pump curve definitions. There are two sections: 
the Pump Curve Definition Pane on the left and the tab section on the right. The Pump 
Curve Definition Pane lets you create, edit, and delete pump curve definitions. 
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The following controls are available in the Pump Curve Definitions dialog box:

New Creates a new entry in the Pump Curve 
Definition Pane.

Delete Deletes the currently highlighted entry in the 
Pump Curve Definition Pane.

Rename Lets you rename the currently highlighted 
entry in the Pump Curve Definition Pane.

Report Lets you generate a preformatted report that 
contains the input data associated with the 
currently highlighted entry in the Pump Curve 
Definition Pane.

Synchronization 
Options

Clicking this button opens a submenu 
containing the following commands:

• Browse Engineering Library—Opens 
the Engineering Library manager dialog, 
allowing you to browse the Pump Curve 
Libraries.

• Synchronize From Library—Lets you 
update a set of pump curve definition 
entries previously imported from a Pump 
Curve Engineering Library. The updates 
reflect changes that have been made to 
the library since it was imported.

• Synchronize To Library—Lets you 
update an existing Pump Curve Engi-
neering Library using current pump curve 
definition entries that were initially 
imported but have since been modified.

• Import From Library—Lets you import 
pump curve definition entries from an 
existing Pump Curve Engineering Library.

• Export To Library—Lets you export the 
current pump curve definition entries to 
an existing Pump Curve Engineering 
Library.
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The tab section includes the following controls:

Pump Curve Data Tab

Pump Curve Type This menu allows you to choose which type of pump 
curve to define. Note that the choice made here affects 
the columns in the pump curve points table.
• Offline Volume-Flow Curve—An off-line pump 

with a wet well where flow increases incrementally 
with wet well volume. The curve relates the volume 
of the source element to the outflow of the pump 
station. As the volume increases, the discharge 
increases.When this pump curve type is chosen, 
the table contains the following columns:

• Flow—This column allows you to define the 
flow at the current curve point.

• Volume—This column allows you to define the 
volume at the current curve point.

• Inline Depth-Flow Curve—An in-line pump where 
flow increases incrementally with node depth. This 
type of curve relates the depth of flow of the source 
element to the outflow of the pump. When this 
pump curve type is chosen, the table contains the 
following columns:

• Depth—This column allows you to define the 
depth at the current curve point.

• Flow—This column allows you to define the 
flow at the current curve point.

• Inline Head-Flow Curve—An in-line pump where 
flow varies continuously with head difference 
between the inlet and outlet nodes. When this 
pump curve type is chosen, the table contains the 
following columns:

• Head (Pump)—This column allows you to 
define the pump head at the current curve 
point.

• Flow—This column allows you to define the 
flow at the current curve point.

• Inline Variable Speed Pump—A variable speed 
in-line pump where flow varies continuously with 
node depth. When this pump curve type is chosen, 
the table contains the following columns:

• Depth—This column allows you to define the 
depth at the current curve point.

• Flow—This column allows you to define the 
flow at the current curve point.
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Pump Curve Dialog Box

This dialog allows you to define the points that make up the pump curve that is associ-
ated with the Pump Curve Library entry that is currently highlighted in the Engi-
neering Library Manager explorer pane.

The columns that are available in this dialog will vary depending on the Pump Curve 
Type that is selected in the menu of the same name in the Engineering Library. The 
possible columns are as follows, sorted by pump type:

Pump Curve Data 
Table

The Pump Curve Data Table, located on the 
bottom right of the Pump Curve Data tab, allows 
you to define the points that make up the pump 
curve for the definition that is currently 
highlighted in the Pump Curve Definition Pane on 
the left. The following controls are available:

• New—Adds a new row to the current table.

• Delete—Deletes the currently highlighted row 
from the table.

• Graph—Displays a plot of the current pump 
curve.

Notes Tab This tab contains a text field that allows you to 
enter descriptive notes that will be associated with 
the pump that is currently highlighted in the Pump 
Curves Definition Pane.

Library Tab This tab displays information about the pump that 
is currently highlighted in the Pump Curves 
Definition Pane. If the pump is derived from an 
engineering library, the synchronization details 
can be found here. If the pump was created 
manually for this project, the synchronization 
details will display the message Orphan (local), 
indicating that the pump was not derived from a 
library entry.

Column Description

Offline Volume-Flow 
Curve

An off-line pump with a wet well where flow 
increases incrementally with wet well volume. 
When this pump curve type is chosen, the table 
contains the following columns:
6-236 Bentley SewerGEMS V8i User’s Guide



Creating Your Model
Volume This column allows you to define the volume at 
the current curve point.

Flow This column allows you to define the flow at the 
current curve point.

Inline Depth-Flow 
Curve

An in-line pump where flow increases 
incrementally with node depth. When this pump 
curve type is chosen, the table contains the 
following columns:

Depth This column allows you to define the depth at the 
current curve point.

Flow This column allows you to define the flow at the 
current curve point.

Inline Head-Flow 
Curve

An in-line pump where flow varies continuously 
with head difference between the inlet and outlet 
nodes. When this pump curve type is chosen, the 
table contains the following columns:

Head (Pump) This column allows you to define the pump head 
at the current curve point.

Flow This column allows you to define the flow at the 
current curve point.

Inline VSD A variable speed in-line pump where flow varies 
continuously with node depth. When this pump 
curve type is chosen, the table contains the 
following columns:

Depth This column allows you to define the depth at the 
current curve point.

Flow This column allows you to define the flow at the 
current curve point.

Column Description
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Catchments

When you click the catchment element on the Layout toolbar, your mouse cursor 
changes into a catchment element symbol. Clicking in the drawing pane while this 
tool is active causes a catchment element to be placed at the location of the mouse 
cursor.

Hydrograph Methods

With the exception of purely sanitary flow systems with no wet weather effects, 
Bentley SewerGEMS V8i starts its hydraulic calculations from a hydrograph for each 
catchment. There are numerous ways of generating those hydrographs. Most involve 
starting with storm events (“Adding Storm Events” on page 7-395) then calculating a 
runoff hydrograph using one of the following methods:

• SCS

• Unit Hydrograph 

• EPA SWMM

• Modified Rational Method

• RTK Unit Hydrograph Method 

Virtually any hydrograph and loss method can be used with any numerical engine with 
the following exceptions:

1. Modified rational method only works with Implicit engine and only with peak 
intensity (IDF) rainfall.

2. If you choose the SWMM engine and specify EPA-SWMM runoff method, then 
all catchments must use that runoff method and the loss method specified on the 
calculation options manager (only Green -Amt, Horton, or SCS).

However, it is also possible to directly enter a hydrograph by specifying a user-defined 
hydrograph (“Adding User Defined Hydrographs” on page 7-359) for any catchment.

Catchment element
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Snowmelt

Bentley SewerGEMS V8i does not directly calculate snowmelt based on snow pack. If 
snow melt is significant for a given model, the user should calculate a snow melt 
hydrograph separately and enter it using a user-defined hydrograph (see “Adding User 
Defined Hydrographs” on page 7-359). For methods to determine snowmelt rates, the 
user is referred to the Haestad Press publication “Stormwater Conveyance Modeling 
and Design” (see “Bentley Institute Press” on page A-924).

Specifying a Time of Concentration (Tc) Method for a Catchment

You can add Time of Concentration (Tc) Methods to a catchment in your model. 
SewerGEMS V8i supports 13 different methods, which are listed below. You define 
the TC Method in the TC Data Collection dialog box. You can define both single and 
multiple flow segments for a catchment.

Some types of Tc equations can apply to flow segments within a multiple-segment Tc 
calculation. Other Tc methods are equations intended to model the entire average 
subarea flow distance and slope in one single flow segment. When combining 
multiple flow segments to compute Tc, it is up to you to only combine Tc methods that 
can be modeled in combination with multiple flow segments. 

To define the Tc Method for a catchment:

1. Click a catchment in your model to display the Property Editor, or right-click a 
catchment and select Properties from the shortcut menu.

2. In the Runoff section of the Property Editor, select Modified Rational Method in 
the Runoff Method field. The Tc (hours) field becomes available.

3. Click the Ellipses (...) button next to the Tc (hours) field. The Tc Data Collection 
dialog box appears.

4. Click New, then select a Tc Method from the submenu.

5. Different fields become available depending on which Tc Method you select. For 
each Tc Method, type values in the appropriate fields.

6. Click OK to close the dialog box and save your Tc Collection data (time of 
concentration in hours) in the Property Editor.

Tc Data Collection Dialog Box

This dialog box allows you to define the Time of Concentration method. Both single 
and multiple flow segments can be modeled in this dialog box.
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The dialog box contains the Tc Method display pane, which lists all of the methods 
currently assigned to the catchment, a control section that allows you to edit the 
attributes associated with the method currently highlighted in the table, and the 
following buttons:

SewerGEMS V8i supports the following 13 methods, which are listed along with the 
required input data for each:

• User Defined Tc—The user-defined time of concentration (Tc) is a method that 
allows the direct input of the Tc rather than using an equation to calculate it. This 
method would be used when the Tc needs to be calculated using a methodology 
that is not supported by Bentley SewerGEMS V8i, or when a quick estimate of Tc 
is sufficient for the analysis.

– User Defined Tc—Lets you explicitly define the Tc, rather than have it calcu-
lated for you using one of the other methods.

• Carter—This method requires the following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Slope—Lets you define the slope of the catchment section.

• Eagleson—This method requires the following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Manning’s n—Lets you enter the Manning’s roughness value of the catch-
ment section.

– Hydraulic Radius—Lets you define the hydraulic radius of the catchment 
section.

– Slope—Lets you define the slope of the catchment section.

• Espey/Winslow—This method requires the following input data:

New Displays a submenu that allows you to 
specify the Tc method to be created.

Delete Deletes the currently highlighted method 
from the table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.
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– Channel Factor—Lets you define the Espey channelization factor of the 
catchment section.

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Slope—Lets you define the slope of the catchment section. 

– Impervious—Lets you define the percentage of impervious area of the catch-
ment section.

• FAA Equation—This method requires the following input data:

– Overland Flow Length—Lets you define the length of the overland pipe 
flow of the catchment section.

– Rational Method C—Lets you define the rational C coefficient of the catch-
ment section.

– Slope—Lets you define the slope of the catchment section.

• Kerby/Hathaway—This method requires the following input data:

– Manning’s n—Lets you enter the Manning’s roughness value of the catch-
ment section.

– Slope—Lets you define the slope of the catchment section.

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

• Kirpich PA—This method requires the following input data:

– Tc Multiplier—Lets you define the time-of-concentration adjustment multi-
plier. 

– Slope—Lets you define the slope of the catchment section.

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

• Kirpich TN—This method requires the following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Slope—Lets you define the slope of the catchment section.

– Tc Multiplier—Lets you define the time-of-concentration adjustment multi-
plier. 

• Length and Velocity—This method requires the following input data:
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– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Velocity—Lets you define the velocity of flow in the catchment section.

• SCS Lag—This method requires the following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– CN—Lets you define the SCS runoff curve number of the catchment section.

– Slope—Lets you define the slope of the catchment section of the catchment 
section.

• TR-55 Sheet Flow—This number represents the sheet flow time computed for 
each column of sheet flow data. This method requires the following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Manning’s n—Lets you enter the Manning’s roughness value of the catch-
ment section.

– Slope—Lets you define the slope of the catchment section.

– 2 yr. 24 hr. Depth—Depth of 2 year 24 hour storm.

• TR-55 Shallow Conc.—This number represents the sheet flow time computed for 
each column of shallow concentrated flow data. This method requires the 
following input data:

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Is Paved—Lets you specify whether the catchment section is paved or 
unpaved.

– Slope—Lets you define the slope of the catchment section.

• TR-55 Channel Flow—This number represents the channel flow time computed 
for each column of channel flow data. This method requires the following input 
data:

– Flow Area—Lets you define the flow area of the catchment section.

– Hydraulic Length—Lets you define the flow length of the catchment 
section.

– Manning’s n—Lets you enter the Manning’s roughness value of the catch-
ment section.
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– Slope—Lets you define the slope of the catchment section.

– Wetted Perimeter—Lets you define the wetted perimeter of the catchment 
section.

Defining the Geometry of a Catchment or a Pond

You define the geometry of a polygonal element, such as a catchment or a pond, by 
entering the location and angle of bends for the selected element. You enter X vs. Y 
points that plot the shape of the polygon that represents the element in the Polygon 
Vertices dialog box .

To define the geometry of a catchment or a pond:

1. Click a catchment or pond in your model to display the Property Editor, or right-
click a catchment or pond and select Properties from the shortcut menu.

2. In the Geometry section of the Property Editor, click the Ellipses (...) button next 
to the Geometry field.

3. In the Polygon Vertices dialog box, click the New button to add a new row to the 
table.

4. Type values for X and Y points for each row in the table.

5. To remove rows from the table, click the Delete button.

6. Click OK.

Polygon Vertices Dialog Box

This dialog box lets you define X vs. Y points that plot the shape of the polygon that 
represents the selected element. The dialog box contains the X vs. Y table that allows 
you to define any number of points and the following buttons:

New Creates a new row in the table.

Delete Deletes the currently highlighted row from 
the table.
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Ponds

When you click the pond element on the Layout toolbar, your mouse cursor changes 
into a pond element symbol. Clicking in the drawing pane while this tool is active 
causes a pond element to be placed at the location of the mouse cursor.

Note: If there are multiple discharges locations serving a pond then 
they must all be modeled in the same manner; that is, they must 
either all be modeled with outlet control structures, or all 
modeled without outlet control structures.

Physical Characteristics of Ponds

There are categories of storage elements that can be modeled in Bentley SewerGEMS 
V8i:

• Outdoor ponds with a free surface

• Large underground pipes built solely to store water during storms

• Wet wells at pumping stations

The first two are modeled as “ponds” in Bentley SewerGEMS V8i. Any of these 
elements may be used as the suction side of a pump.

The following pond volume options are available:

• Elevation vs. Area

• Elevation vs. Volume

• Underground Pipe Volume

• Functional

Not all of the physical properties are needed for each method of describing pond 
(storage element) dimensions.

Pond element
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The type of attribute needed for each type of data entry is summarized in the table 
below:

For more information on the physical characteristics of ponds, see the following help 
topics:

• “Outdoor Ponds” on page 6-246

• “Elevation vs. Area” on page 6-246

Table 6-1: Required Pond Attributes

Attribute Elevation
-Volume 
Curve

Elevation
-Area 
Curve

Volume 
Function

Pipe 
Volume

Volume Type Required Required Required Required

Elevation (Invert) Required Required Required Required

Depth 
(Maximum) 

Required Required Required

Elevation-Area 
Curve 

Required

Elevation-
Volume Curve 

Required

Percent Void
Space (%)

Required Required

Number of 
Barrels 

Required

Length Required

Invert (Start) Required

Invert (Stop) Required

Pipe Diameter 

Pond Coefficient 
A 

Required

Pond Exponent 
B

Required

Pond Constant C Required
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• “Elevation vs. Volume” on page 6-247

• “Percent Void Space (%)” on page 6-248

• “Pipe Volumes” on page 6-248

• “Functional (Equation)” on page 6-248

Outdoor Ponds

The physical size of outdoor graded ponds is usually described using a depth vs. area 
or depth vs. volume curve. A typical set of curves is shown below:

Elevation vs. Area

This approach is common for outdoor ponds. The Elevation vs. Area table represents 
the grading plan contour information for the pond. The area column represents the 
water surface area with respect to the corresponding water surface elevation on the 
same row in the table. Bentley SewerGEMS V8i will calculate the cumulative volume 
at each given elevation, based on the given Elevation vs. Area data. 
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Elevation vs. Volume

This feature gives the user complete control over how to calculate pond volumes.  The 
Elevation vs. Volume table is typically used in situations where the standard elevation 
vs. area or pipe volume calculations do not apply and the user desires to perform 
custom calculations and enter the results. The volume column represents the water 
volume being stored in the pond at the corresponding water surface elevation on the 
same row in the table. 

Table 6-2: Pond Elevation vs. Area

Elevation (ft) Area (ac) Percent Void Space (%)

0 0 100

1 0.003 100

2 0.008 100

3 0.016 100

4 0.024 100

5 0.034 100

6 0.044 100

7 0.056 100

8 0.068 100

9 0.081 100

10 0.095 100

Table 6-3: Pond Depth vs. Volume

Depth (ft) Volume (ac-ft) Percent Void 
Space (%)

0 0.000 100

1 0.001 100

2 0.007 100

3 0.019 100
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Percent Void Space (%)

This option is available for both Elevation vs. Area and Elevation vs. Volume tables.  
The default value is 100%. The percent void represents the amount of real storage 
available at each elevation. For open ponds this value is 100%. This option is useful 
for situation where the pond storage area is filled with impervious material, such as 
stone or gravel. The percent void space represents the open pore areas that can store 
water. 

Example:  For 50% void space, only ½ of the calculated (or specified) total volume 
would be available as water storage.

Pipe Volumes

Another storage option models large, buried, sloped pipes. These are described to the 
model using the diameter, length and number of pipe barrels (assuming parallel buried 
pipes are of the same dimension). The stop invert elevation of the incoming pipe and 
the start invert elevation of the outgoing pipe must also be specified in order to deter-
mine the slope of the pipe, which will affect the volume calculation at each water 
surface elevation.

Functional (Equation)

Another approach for calculating pond volume is to enter the coefficients of the 
following polynomial equation:

Where:

• Area = Surface Area at given depth 

4 0.038 100

5 0.067 100

6 0.106 100

7 0.156 100

8 0.217 100

9 0.292 100

10 0.379 100

Table 6-3: Pond Depth vs. Volume

*Area Coeff DepthExp Constant= +
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• Coeff = User input value which is derived from existing volume data 

• Depth = Distance from the invert of the pond 

• Exp = User input value which is derived from existing volume data 

• Constant = The area at the bottom of the pond and is a user input value 

Note: The function parameters are based on depths in feet and areas 
in square feet.

Adding Elevation vs. Area Data to a Pond

You can add an elevation-area curve to a pond. The area-elevation points defined in 
the curve are used to calculate pond volumes. You define elevation-area curves in the 
Elevation-Area Curve dialog box.

To add an Elevation vs. Area curve to a pond:

1. Click a pond in your model to display the Property Editor, or right-click a pond 
and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, select Elevation-Area Curve in the 
Volume Type field. The Elevation-Area Curve field becomes available.

3. Click the Ellipses (...) button next to the Elevation-Area Curve field.

4. In the Elevation-Area Curve dialog box, each row in the table represents a point 
on the Elevation-Area curve. Type values for Elevation, Area, and Percent Void 
Space for each row. Click the New button to add a row or press the Tab key to 
advance to the next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Elevation-Area Curve Dialog Box

This dialog box allows you to define elevation-area curves. 
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The dialog box contains the elevation-area table and the following buttons:

The table contains the following columns:

Adding Elevation vs. Volume Data to a Pond

You can add an elevation-volume curve to a pond. The area-volume points defined in 
the curve are used to calculate pond volumes. The elevation-volume points defined in 
the table are used to calculate total pond volume. It is important that this storage rela-
tion be single-valued. This means that any volumetric quantity occurs only once in the 
table only, as Bentley SewerGEMS V8i interpolates linearly between any two values 
in the table. You define elevation-area curves in the Elevation-Volume Curve dialog 
box.

New Creates a new row in the elevation-area 
table.

Delete Deletes the currently highlighted row 
from the elevation-area table

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the area-
elevation curve defined by the points in 
the table.

Column Description

Elevation Lets you enter the elevation data for the pond.

Area Lets you enter the plan area at that elevation.

Percent Void Space Lets you enter the void space volume data for the 
pond. Void space is used on any volumes option to 
adjust the effective storage volume for rock-filled 
or other porous media filled basins or vaults. Set 
this to 100% if there are no rocks or fill to reduce 
the available volume. 
6-250 Bentley SewerGEMS V8i User’s Guide



Creating Your Model
To add an Elevation vs. Volume curve to a pond:

1. Click a pond in your model to display the Property Editor, or right-click a pond 
and select Properties from the shortcut menu.

2. In the Physical section of the Property Editor, select Elevation-Volume Curve in 
the Volume Type field. The Elevation-Volume Curve field becomes available.

3. Click the Ellipses (...) button next to the Elevation-Volume Curve field.

4. In the Elevation-Volume Curve dialog box, each row in the table represents a 
point on the Elevation-Volume curve. Type values for Elevation, Volume, and 
Percent Void Space for each row. Click the New button to add a row or press the 
Tab key to advance to the next field in the table.

5. Perform the following optional steps:

– To delete a row from the table, select the row then click Delete.

– To view a report on the curve, click Report.

– To view a plot of the curve, click Graph.

6. Click OK to close the dialog box and save your curve data in the Property Editor.

Elevation-Volume Curve Dialog Box

This dialog box allows you to define elevation-volume tables. The dialog box contains 
the elevation-volume table and the following buttons:

 

New Creates a new row in the elevation-
volume table.

Delete Deletes the currently highlighted row 
from the elevation-volume table

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the area-
volume curve defined by the points in the 
table.
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The table contains the following columns:

Other Tools

Although Bentley SewerGEMS V8i is primarily a modeling application, some addi-
tional drafting tools can be helpful for intermediate calculations and drawing annota-
tion. AutoCAD, of course, provides a tremendous number of drafting tools. Bentley 
SewerGEMS V8i provides the following tools:

• Border tool

• Text tool

• Line tool

Border Tool

The Border tool lets you add rectangles to the drawing pane.

Text Tool

Column Description

Elevation Lets you enter the cumulative volume from the 
bottom of the pond to that elevation.

Volume Lets you enter the volume data for the pond.

Void Space Lets you enter the void space volume data for the 
pond. Void space is used on any volumes option to 
adjust the effective storage volume for rock-filled 
or other porous media filled basins or vaults. Set 
this to 100% if there are no rocks or fill to reduce 
the available volume.

Border tool

Text tool
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The Text tool lets you add text to the drawing pane.

Line Tool

The Line tool lets you add lines and polylines (multisegmented lines) to the drawing 
pane.

Adding Elements to Your Model
Bentley SewerGEMS V8i provides several ways to add elements to your model. They 
include:

• Adding individual elements

• Adding elements using the layout tool

• Replacing an element with another element

To add individual elements to your model:

1. Click an element symbol on the Layout toolbar. The mouse cursor changes to the 
element symbol you selected.

2. Click in the drawing pane to add the element to your model.

3. Click again to add another element of the same type to your model.

4. To add a different element, click on the desired element symbol in the Layout 
toolbar, then click in the drawing pane.

5. To stop adding an element, right-click in the drawing pane to display a shortcut 
menu, then click Done.

To add elements using the layout tool: 

The layout tool lets you quickly add new elements to your model without having to 
select a new element button on the Layout toolbar. When the layout tool is active, you 
can right-click in the drawing pane to select different elements and pipes to add to the 
model.

Line tool
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1. Click the Layout tool on the Layout toolbar. A shortcut menu appears.

2. Click the type of pipe you want to use to connect your elements in the model.

3. Right-click in the drawing pane, then select the type of element you want to add 
from the shortcut menu. The shortcut menu displays only those element types that 
are compatible with your pipe selection.

4. Click in the drawing pane to add the element.

5. Click again to add another of the same element type. The elements you add will 
automatically be connected by the type of pipe you selected earlier.

6. To change the type of pipe, right-click and select a different type from the shortcut 
menu.

7. To change the element, right-click and select a different element from the shortcut 
menu.

8. To stop adding elements using the Layout tool, right-click anywhere in the 
drawing pane and click Done.

Note: In AutoCAD, you must hold down the mouse button to keep the 
submenu open while selecting an element from the layout 
toolbar. Alternate layout methods include using the right-click 
menu to select elements or using the command line.

Modeling Curved Pipes

You can model curved pipes in SewerGEMS V8i by using the Bend command, which 
is available by right-clicking in the Drawing Pane when placing a link element.

Bentley SewerGEMS V8i does not account for any additional head loss due to the 
curvature because in most cases the increased head loss is negligible. If you feel the 
extra head loss is significant, it is possible to increase the Manning's n value to 
account for such losses.

Layout Tool
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To model a curved pipe:

1. Select the desired link element using the Layout button on the Layout 
toolbar.

2. Place the first segment of the curved pipe in your model, then right click and 
select Bend from the shortcut menu.

3. Repeat Step 2 for each segment in the curved pipe. Be sure to insert bends to 
clearly show the curved alignment. 

4. When the curved pipe is complete, right click and select the next downstream 
element (for a conduit, this is usually a manhole). 

Connecting Elements
When building your model, you must consider these rules of connectivity:

• A network needs at least one outfall or a pond to end the network. A lone outfall 
cannot be a boundary element type unless it’s draining into a pond.

• Cross section nodes need at least one channel connected to it and a channel needs 
at least one cross section.

• Gutters cannot be the only link exiting a catch basin, or the catch basin is consid-
ered hydraulically disconnected.
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Table 6-4: Element Connectivity

Element Permissible Upstream 
Elements

Permissible Downstream 
Elements

Catchment None Catch basin, manhole, cross 
section, junction chamber, outfall, 
wet well, pond

Manhole Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure, catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction, pump

Catch basin Via a gutter: Catch basin, 
cross section, outfall
Via a channel: Cross section
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure, catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: Catch basin, cross 
section, outfall
Via a channel: Cross section
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction, pump

Cross section Via a gutter: Catch basin
Via a channel: Manhole, 
catch basin, cross section, 
wet well, outfall, pond outlet 
structure
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure, catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: Catch basin
Via a channel: Manhole, catch 
basin, cross section, wet well, 
outfall, pond outlet structure
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction, pump
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Junction 
chamber

Via a gutter: None
Via a channel: None
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure, catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: None
Via a channel: None
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction, pump

Pressure 
junction

Via a gutter: None
Via a channel: None
Via a conduit: None
Via a pressure pipe: 
Manhole, catch basin, cross 
section, junction chamber, 
pressure junction, wet well, 
pump, outfall, pond outlet 
structure

Via a gutter: None
Via a channel: None
Via a conduit: None
Via a pressure pipe: Manhole, 
catch basin, cross section, 
junction chamber, pressure 
junction, wet well, pump, outfall, 
pond outlet structure

Wet well Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure, catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction, pump

Table 6-4: Element Connectivity

Element Permissible Upstream 
Elements

Permissible Downstream 
Elements
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Pump Via a gutter: None
Via a channel: None
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure
Via a pressure pipe: 
Manhole, catch basin, cross 
section, junction chamber, 
pressure junction, wet well, 
pump, outfall, pond outlet 
structure

Via a gutter: None
Via a channel: None
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Manhole, 
catch basin, cross section, 
junction chamber, pressure 
junction, wet well, pump, outfall, 
pond outlet structure

Outfall Via a gutter: Catch basin
Via a channel: Cross section
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, pond outlet structure, 
catchment
Via a pressure pipe: 
Pressure junction, pump

Via a gutter: Catch basin
Via a channel: Cross section
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, pond 
outlet structure
Via a pressure pipe: Pressure 
junction, pump

When the Boundary Condition 
Type is set to Boundary Element, 
the flow coming into the outfall 
can be discharged to a pond, 
cross section, manhole, or catch 
basin

Pond outlet 
structure

Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, 
catch basin, cross section, 
junction chamber, wet well, 
pump, outfall, pond outlet 
structure
Via a pressure pipe: 
Pressure junction

Via a gutter: None
Via a channel: Cross section
Via a conduit: Manhole, catch 
basin, cross section, junction 
chamber, wet well, pump, outfall, 
pond outlet structure
Via a pressure pipe: Pressure 
junction

Pond Outfall, catchment Pond outlet structures, pump.
Only outfalls can drain to a pond.
The only way to drain from a 
pond is via a pond outlet 
structure.

Table 6-4: Element Connectivity

Element Permissible Upstream 
Elements

Permissible Downstream 
Elements
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When To Use a Conduit vs. a Channel vs. a Gutter

Gutters are used in Bentley SewerGEMS V8i only to model the water which exceeds 
the capacity of in catch basin inlet and must flow through a surface gutter to the next 
catch basin. A Bentley SewerGEMS V8i gutter can only receive water from a catch 
basin.

A conduit can refer to any prismatic channel or pipe that conveys flow. The cross 
section of a conduit must remain constant from one end to the next.

A channel refers to a channel that changes geometry from the upstream cross section 
to the downstream cross section. Channels can be used to model natural streams or 
swales which are not prismatic in cross section. Channels must have a cross section 
element at either end and properties are interpolated along the channel.

A uniform trapezoidal channel can either be modeled as a conduit with the shape 
defined in a conduit element or a channel with the shape defined as a property of the 
cross section elements at each end. 

What Is A Virtual Conduit?

Bentley SewerGEMS V8i’s network element layout is based on maintaining spatial 
fidelity between an element’s model representation and it's actual physical location in 
the field. Similar to a pond outlet, a pump station is modeled as an element attached to 
a storage node or a manhole node and linked downstream to a force main pipe, and 
multiple pumps with different characteristics can be added into the element. 

Virtual pipes are a special compatibility element included in Bentley SewerGEMS 
V8i to help modelers achieve fidelity between the Bentley SewerGEMS V8i model 
and other storm modeling solutions that model pumps and control structures such as 
weirs, orifices, and rating tables as network links. SWMM 5 models pumps, weirs, 
orifices, and rating tables as links. Virtual links are a useful means for mapping such 
elements into Bentley SewerGEMS V8i in a literal way. So, if you import a SWMM 
model containing pumps and/or control structures into Bentley SewerGEMS V8i, 
virtual links will be imported to provide equivalent hydraulic representations.

The virtual conduit has no physical properties such a length and diameter. It has no 
hydraulic effect in the model other than define hydraulic connectivity and preserve 
continuity relationships.

For example, in SWMM, it is possible to have the discharge side of a pump connected 
to a node thousands of feet away with no consideration of the interconnecting force 
main. However in Bentley SewerGEMS V8i, to model that connection, a virtual pipe, 
which shows up in the drawing pane as a dashed line, is used to show the connectivity.

For more information on virtual conduits, see “Virtual Link Types” on page 14-742.
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How Do I Get Rainfall from a Catchment Into the Rest of My Model?

To get rainfall to move from a catchment into the rest of your model, you must specify 
an Outflow Node. 

To set the outflow node for a catchment:

1. If the Property Editor is not open, click View > Properties (F4) to open it.

2. Click the catchment for which you want to set an outflow node.

3. In the Catchment section of the Property Editor, click the Outflow Node field to 
enable the selection drop-down.

4. Click Select if you want to select the outflow node from the model, or select the 
outflow node from the drop-down list.

Connecting a Pump to a Wet Well

Bentley SewerGEMS V8i assumes that either the pump is a submersible pump in the 
wet well or the pump is connected to the wet well through a short piece of pressure 
pipe with negligible head loss. 

Do not connect a conduit or channel between the wet well and pump. 

Pumps can also use ponds or manholes as suction elements. If a pressure pipe is used 
as the suction element, it is assumed that the distance is so short that the head loss is 
negligible. If head loss is significant in determining pump flow, then add pipe length 
or minor loss to the discharge pipe.

To specify the relationship between a wet well and a pump:

1. Double-click the pump in your model to open the Property Editor for the pump.

2. Select Select Suction Element as the Suction Side Node. 

SewerGEMS V8i prompts you to select the suction side node or link from your 
model (which can be a wet well, pond, pressure pipe, or manhole).

3. Select the appropriate node in your model. A dashed line appears to connect the 
two elements. If a manhole is used as a suction line, it cannot be the most down-
stream end of a gravity network.

How Do I Model Weirs in Conduits?

Sharp crested weirs can be placed as control structures in conduits. Other control 
structures include orifices, functional structures and depth discharge curves. 
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To insert weirs into the start or stop ends of a conduit:

1. Set Has Start Control Structure? or Has Stop Control Structure? to True in 
the Physical:Has Control Structure section of the Property Editor for the conduit.

2. Click the Ellipse (…) button that appears next to the Start Control Structure or 
Stop Control Structure field. This opens the Conduit Control Structure dialog box.

3. Select New > Weir.

Weirs can be placed in any shape of conduit but the weir structure itself is treated as 
being in a rectangular section. The weir length is the distance across this section 
measured perpendicular to the flow (for all except side weirs).

Manipulating Elements
You can manipulate elements in your model in any one of the following ways:

• Select elements—manually select individual elements, manually select multiple 
elements, select all elements, or select all elements of a single element type

• Move elements

• Delete elements

• Split pipes

Plan View

Manhole

Inlet

Pipe

Outlet

Pipe 1

Outlet

Pipe 2

Weir
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To manually select an element:

Click the element. Selected elements appear in red.

Note: You can change the selection color in the Options dialog box, 
which is accessible by selecting Tools > Options.

To manually select multiple elements:

Click the first element, then click additional elements while holding down Shift or 
Ctrl.

To select all elements:

To select all of the elements in your model, select Edit > Select All.

To select all elements of the same type:

To select all elements of the same type (for example, all junction chambers), select 
Edit > Select by Element, then click the desired element type.

All elements of the selected type appear in red, including connecting pipes.

To clear selected elements:

Click the Select tool then click any blank space in the drawing pane.

or

Click Edit > Clear Selection.

or

Press the Esc key.

You can also clear a selected element by clicking a different element.

To move an element in the model:

1. Click the Select tool on the Layout toolbar.

2. Select the element(s) you want to move, then drag it to its new location. Pipe 
connections move with the element.
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To delete an element:

Select the element, then press Delete.

or

Select Edit > Delete.

Splitting Pipes

You may encounter a situation in which you need to add a new element in the middle 
of an existing pipe. For example, you may want to insert a new manhole to maintain 
maximum access hole spacing. 

To split an existing pipe:

1. Select the desired element symbol on the Layout toolbar.

2. In the drawing pane, place the cursor over the pipe you want to split and click.

3. You are prompted to confirm that you want to split the pipe. 

– If you choose to split the pipe, the element will be inserted and two new pipes 
will be created with the same characteristics as the original pipe (lengths are 
split proportionally).

– If you choose not to split the pipe, the new element will be placed on top of 
the pipe without connecting to anything.

If you accidentally split a pipe, this action can be undone by selecting Edit > Undo. 

You can also split an existing pipe with an existing element: 

To do this in the Stand-Alone version, drag the element into position along the pipe to 
be split, then right-click the node and select Split <Pipe Label> from the shortcut 
menu (where <Pipe Label> is the name of the pipe to be split). 

To do this in the MicroStation version, drag the element into position along the pipe to 
be split. Hold down the Shift key, then right-click the node and select Split <Pipe 
Label> from the shortcut menu (where <Pipe Label> is the name of the pipe to be 
split).
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Disconnecting and Reconnecting Pipes

In certain circumstances, you may wish to disconnect a pipe from a node without 
deleting and redrawing the pipe in question. For example, if the model was built from 
a database and the Establish By Spatial Data option was used to determine pipe 
connectivity, pipes may have been connected to the wrong nodes.

To disconnect and reconnect a pipe: 

1. Right-click the pipe to be disconnected.

2. A context menu will appear. Two reconnect options will be displayed, one for 
each of the end nodes of the pipe. Select the node from which you want to discon-
nect the pipe.

3. A broken line will appear, joining the node from which the pipe is being discon-
nected and your mouse cursor. Hover the mouse cursor over the junction to which 
you would like to connect the pipe and click the left mouse button. The pipe will 
now be connected to this junction.

How Do I Model a Split in a Channel?

If you have a channel with a control structure and you're trying to model a split in that 
channel, you should put the control structure on the upstream end of the branching 
links rather than the downstream end of the main link.

Editing Element Attributes
You edit element properties in the Property Editor, one of the dockable managers in 
Bentley SewerGEMS V8i.

To edit element properties:

Double-click the element in the drawing pane. The Property Editor displays the 
attributes of the selected element.

or

Select the element whose properties you want to edit, then select View > Properties 
or click the Properties button on the Analysis toolbar.
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Property Editor

The Property Editor is a contextual dialog box that changes depending on the status of 
other dialog boxes. For example, when a network element is highlighted in the 
drawing pane, the Property Editor displays the attributes and values associated with 
that element. When one of the manager dialog boxes is active, the Property Editor 
displays the properties pertaining to the currently highlighted manager element.

Attributes displayed in the Property Editor are grouped into categories. An expanded 
category can be collapsed by clicking the plus (+) button next to the category heading. 
A collapsed category can be expanded by clicking the minus (-) button next to the 
category heading.

For the most efficient data entry in Text Box style fields, instead of clicking on the 
Field, click on the label to the left of the field you want to edit, and start typing. Press 
Enter to commit the value, then use the Up/Down keyboard arrows to navigate to the 
next field you want to edit. You can then edit the field data without clicking the label 
first; when you are finished editing the field data, press the Enter key, and proceed to 
the next field using the arrow keys, and so on.

Find Element

The top section of the Property Editor contains the Find Element tool. The Find 
Element tool lets you:

• Quickly find a recently-created or added element in your model. The Element 
menu contains a list of the most recently-created and added elements. Click an 
element in the Element menu to center the drawing pane around that element and 
highlight it.

• Find an element in your model by typing the element label or ID in the Element 
menu then clicking the Find button or pressing Enter. The drawing pane centers 
around the highlighted element.

• Find all elements of a certain type by using an asterisk (*) as a wild-card char-
acter. For example, if you want to find all of the conduits in your model, you type 
co* (this is not case-sensitive) then click the Find button. The drawing pane 
centers around and highlights the first instance of a conduit in your model, and 
lists all conduits in your model in the Element menu. Once the Element menu is 
populated with a list of elements, you can use the Find Next and Find Previous 
buttons to quickly navigate to the next or previous element in the list.

Note: See the ”Using the Like Operator’ topic for more information about 
wildcard symbols.
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The following controls are included:

Relabeling Elements

You can relabel elements from within the Property Editor.

Element Type an element label or ID in this field then 
click the Find button to quickly locate it in 
your model. The element selected in this menu 
will be centered in the drawing pane when the 
Zoom To command is initiated, at the 
magnification level specified by the Zoom 
Level menu. The drop-down menu lists 
recently-created or added elements, elements 
that are part of a selection set, and that are part 
of the results from a recent Find operation.

Find Previous This button allows you to find the previous 
element in the list of results from a recent Find 
operation.

Find Zooms the drawing pane view to the element 
typed or selected in the Element menu at the 
magnification level specified in the Zoom 
Level menu.

Find Next This button allows you to find the next 
element in the list of results from a recent Find 
operation.

Help Displays online help for the Property Editor.

Zoom Level Allows you to specify the magnification level 
at which elements are displayed in the drawing 
pane when the Zoom To command is initiated.

Alphabetic Displays the attribute fields in the Property 
Editor in alphabetical order.

Categorized Displays the attribute fields in the Property 
Editor in categories. This is the default.
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To relabel an element:

1. Select the element in the Drawing Pane then, if the Property Editor is not already 
displayed, select View > Properties.

2. In the General section of the Property Editor, click in the Label field, then type a 
new label for the element.

Set Field Options Dialog Box

The Set Field Options dialog box lets you set the units for a specific attribute without 
affecting the units used by other attributes or globally.

To use the Set Field Options dialog box, right-click any numerical field that has units, 
then select Units and Formatting.

Value Displays the value of the currently selected item.

Unit Displays the type of measurement. To change the 
unit, select the unit you want to use from the drop-
down list. This option also lets you use both U.S. 
customary and S.I. units in the same worksheet.

Display Precision Sets the rounding of numbers and number of digits 
displayed after the decimal point. Enter a negative 
number for rounding to the nearest power of 10: (-1) 
rounds to 10, (-2) rounds to 100, (-3) rounds to 
1000, and so on. Enter a number from 0 to 15 to 
indicate the number of digits after the decimal point.
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What Length is Used for Conduits, Channels, and Gutters When I 
Don't Enter a User-defined Length?

If you do not enter a user-defined length in the attributes for conduits, channels, and 
gutters, the length used in Bentley SewerGEMS V8i is the plan view distance between 
the coordinates at each end of the link element. This length is used as the actual length 
in hydraulic calculations. However, as the slope increases, the difference between the 
plan length and the actual length also increases as shown below. 

The table below shows the difference between the actual and plan length as a function 
of slope. Note that for most reasonable slopes, the difference between the actual and 
plan view length is less than one percent. (100% slope is 1:1 slope.) As the slope 
approaches vertical, you must enter the actual length.

Format Lets you select the display format used by the 
current field. 
Choices include:

• Scientific—Converts the entered value to a 
string of the form "-d.ddd...E+ddd" or "-
d.ddd...e+ddd", where each 'd' indicates a digit 
(0-9). The string starts with a minus sign if the 
number is negative. 

• Fixed Point—Abides by the display precision 
setting, and automatically enters zeros after the 
decimal place to do so. With a display precision 
of 3, an entered value of 3.5 displays as 3.500.

• General—Truncates any zeros after the 
decimal point, regardless of the display preci-
sion value. With a display precision of 3, the 
value that would appear as 5.200 in Fixed Point 
format displays as 5.2 when using General 
format. The number is also rounded. So, an 
entered value of 5.35 displays as 5.4 regardless 
of the display precision.

• Number—Converts the entered value to a 
string of the form "-d,ddd,ddd.ddd...", where 
each 'd' indicates a digit (0-9). The string starts 
with a minus sign if the number is negative. 
Thousand separators are inserted between 
each group of three digits to the left of the 
decimal point.
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* The model’s generalized friction formulation is only valid for slopes less than 10%.

If you are not satisfied with the plan view length, you can enter a user-defined length, 
which you can determine using the following equation:

What is the Difference Between a User Defined Unit Hydrograph 
and a 
Hydrograph Entered in the Inflow Collection Editor?

Within Bentley SewerGEMS V8i, you can enter a hydrograph (in flow units) at any 
node element (e.g. catch basin, manhole, catchment, cross section, wet well). You can 
also enter a unit hydrograph, but only at a catchment node. 

To enter a hydrograph (in flow units) using the Inflow Collection Editor:

1. Select the element in your model. 

2. In the Property Editor, click the Ellipsis button (...) in the Inflow Collection field.

3. In the Inflow Collection dialog box, click the New button and select Hydrograph 
Load.

4. Enter values into the table of flow vs. time, then click OK.

To enter a unit hydrograph at a catchment:

1. Select a catchment in your model. 

2. In the Property Editor, select Unit Hydrograph as the Runoff Method.

3. In the Property Editor, select Generic Unit Hydrograph as the Unit Hydrograph 
Method.

Table 6-5: Actual and Plan Length as a Function of Slope

Slope, % * Actual/Plan Length

0 1.000

10 1.005

20 1.020

30 1.044

))100/(%1( 22 lopesPlanActual +=
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Changing the Drawing View
4. Click the Ellipsis button (...) in the Unit Hydrograph Data field.

5. In the Unit Hydrograph Data dialog box, enter values into the table of flows (for a 
unit of rainfall) vs. time, then click OK.

Other hydrographs used by Bentley SewerGEMS V8i are calculated within Bentley 
SewerGEMS V8i.

Changing the Drawing View
You change the drawing view of your model by using the pan tool or one of the zoom 
tools:

• “Panning” on page 6-270

• “Zooming” on page 6-271

Panning

You can change the position of your model in the drawing pane by using the Pan tool. 

To use the Pan tool:

1. Click the Pan button on the Tools toolbar. 

The mouse cursor changes to the Pan icon. 

2. Click anywhere in the drawing, hold down the mouse button and move the mouse 
to reposition the current view. 

or

If your mouse is equipped with a mousewheel, you can pan by simply holding down 
the mousewheel and moving the mouse to reposition the current view.

or

Select View > Pan, then click anywhere in the drawing, hold down the mouse button 
and move the mouse to reposition the current view

Pan tool
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Zooming

You can enlarge or reduce your model in the drawing pane using one of the following 
zoom tools:

Zoom In and Out

The simple Zoom In and Zoom Out commands allow you to increase or decrease, 
respectively, the zoom level of the current view by one step per mouse click.

To use Zoom In or Zoom Out, click the desired button on the Tools toolbar, or select 
View > Zoom > Zoom In or View > Zoom > Zoom In.

If your mouse is equipped with a mousewheel, you zoom in or out by simply moving 
the mousewheel up or down respectively.

Zoom Window

The Zoom Window command lets you zoom in on an area of your model defined by a 
window that you draw in the drawing pane.

To use Zoom Window, select View > Zoom > Zoom Window button, then click and 
drag the mouse inside the drawing pane to draw a rectangle. The area of your model 
inside the rectangle will appear enlarged.

Note: If you use the Zoom Window command frequently, you might 
find it more convenient to add them to the Tools toolbar. See 
“Adding and Removing Toolbar Buttons” on page 2-38 for more 
information.

Zoom Extents

The Zoom Extents command automatically sets the zoom level such that the entire 
model is displayed in the drawing pane. 

Zoom In 

Zoom Out 
Bentley SewerGEMS V8i User’s Guide 6-271



Changing the Drawing View
To use Zoom Extents, click the Zoom Extents button on the Tools toolbar. The entire 
model is displayed in the drawing pane.

or

Select View > Zoom > Zoom Extents.

Zoom Realtime

The Zoom Realtime command lets you dynamically scale up and down the zoom 
level. The zoom level is defined by the magnitude of mouse movement while the tool 
is active. 

Zoom Previous and Zoom Next

Zoom Previous returns the zoom level to the most recent previous setting. To use 
Zoom Previous, click the Zoom Previous button on the Tools toolbar.

or

Select View > Zoom > Zoom Previous.

Zoom Next returns the zoom level to the setting that was active before a Zoom 
Previous command was executed. To use Zoom Previous, click View > Zoom > 
Zoom Next.

Zoom Extents 

Zoom Realtime 

Zoom Previous 
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Note: If you use the Zoom Next command frequently, you might find it 
more convenient to add them to the Tools toolbar. See “Adding 
and Removing Toolbar Buttons” on page 2-38 for more information.

Using the Zoom Center Command

The Zoom Center command lets you enter drawing coordinates that will be centered 
in the drawing pane.

To use the Zoom Center command:

1. Select View > Zoom > Zoom Center. The Zoom Center dialog box appears.

2. Enter the X and Y coordinates.

3. Select the zoom factor from the Zoom drop-down, then click OK.

Zoom Center Dialog Box

The Zoom Center dialog box contains the following options:

Using Selection Sets
Selection sets are user-defined groups of network elements. They allow you to 
predefine a group of network elements that you want to manipulate together. You 
manage selection sets in the ”Selection Sets Manager’.

Bentley SewerGEMS V8i contains powerful features that let you view or analyze 
subsets of your entire model. You can find these elements using the Network Navi-
gator (see “Using the Network Navigator” on page 6-281). The Network Navigator 
lets you choose a selection set, then view the list of elements in the selection set or 
find individual elements from the selection set in the drawing.

In order to use the Network Navigator, you must first create a selection set. There are 
two ways to create a selection set:

X Defines the X coordinate of the point at which the 
model will be centered.

Y Defines the Y coordinate of the point at which the 
model will be centered.

Zoom Factor Defines the zoom level that will be applied 
when the zoom center command is initiated. 
Available zoom levels are listed in percentages 
of 25, 50, 75, 100, 125, 150, 200 and 400.
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• From a selection of elements—You create a new selection set in the Selection Sets 
Manager, then use your mouse to select the desired elements in the drawing pane.

• From a query—Create a query in the Queries Manager, then use the named query 
to find elements in your model and place them in the selection set.

The following illustration shows the overall process.

You can perform the following operations with selection sets:

• “Viewing Elements in a Selection Sets” on page 6-276

• “Creating a Selection Set from a Selection” on page 6-277

• “Creating a Selection Set from a Query” on page 6-277

• “Adding Elements to a Selection Set” on page 6-279

• “Removing Elements from a Selection Set” on page 6-280

Selection Sets Manager

The Selection Sets Manager allows you to create, edit, and navigate to selection sets. 
The Selection Sets Manager consists of a toolbar and a list pane, which displays all of 
the selection sets that are associated with the current project. 
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The toolbar contains the following buttons:

New Contains the following commands:

• Create from Selection—Creates a new 
static selection set from elements you 
select in your model.

• Create from Query—Creates a new 
dynamic selection set from existing 
queries.

Delete Deletes the selection set that is currently 
highlighted in the list pane. This command 
is also available from the short-cut menu, 
which you can access by right-clicking an 
item in the list pane.
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You can view the properties of a selection in the Property Editor by right-clicking the 
selection set in the list pane and selecting Properties from the shortcut menu.

Viewing Elements in a Selection Sets

You use the Network Navigator to view the elements that make up a selection set.

Edit • When a selection-based selection set is 
highlighted when you click this button, 
opens the Selection Set Element 
Removal dialog box, which lets you edit 
the selection set. This command is also 
available from the short-cut menu, 
which you can access by right-clicking 
an item in the list pane.

• When a query-based selection set is 
highlighted when you click this button, 
opens the Selection By Query dialog 
box, which lets you add or remove 
queries from the selection set. This 
command is also available from the 
short-cut menu, which you can access 
by right-clicking an item in the list pane.

Rename Lets you rename the selection set that is 
currently highlighted in the list pane. This 
command is also available from the short-
cut menu, which you can access by right-
clicking an item in the list pane.

Select In Drawing Lets you quickly select all the elements in 
the drawing pane that are part of the 
currently highlighted selection set. Once you 
have selected the elements in a selection set 
using Select In Drawing, you can delete 
them all at once or create a report on them. 
This command is also available from the 
short-cut menu, which you can access by 
right-clicking an item in the list pane.

Help Displays online help for the Selection Sets 
Manager.
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To view the elements that make up a selection set:

1. Open the Network Navigator by selecting View > Network Navigator or clicking 
the Network Navigator button on the View toolbar.

2. Select a selection set from the Selection Set drop-down list. The elements in the 
selection set appear in the Network Navigator.

Tip: You can double-click an element in the Network Navigator to 
select and center it in the Drawing Pane.

Creating a Selection Set from a Selection

You create a new selection set by selecting elements in your model.

To create a new selection set from a selection:

1. Select all of the elements you want in the selection set by either drawing a selec-
tion box around them or by holding down the Ctrl key while clicking each one in 
turn. 

2. When all of the desired elements are highlighted, right-click and select Create 
Selection Set.

3. Type the name of the selection set you want to create, then click OK to create the 
new selection set. Click Cancel to close the dialog box without creating the selec-
tion set.

4. Alternatively, you can open the Selection Set Manager and click the New button 
and select Create from Selection. Bentley SewerGEMS V8i prompts you to 
select one or more elements.

Create Selection Set Dialog Box

This dialog box appears when you create a new selection set. It contains the following 
field:

Creating a Selection Set from a Query

You create a dynamic selection set by creating a query-based selection set. A query-
based selection set can contain one or more queries, which are valid SQL expressions.

New selection set name Lets you type the name of the new selection set.
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To create a new selection set from a query:

1. In the Selection Sets Manager, click the New button and select Create from 
Query. The Selection by Query dialog box appears.

2. Available queries appear in the list pane on the left; queries selected to be part of 
the selection set appear in the list pane on the right. Use the arrow buttons in the 
middle of the dialog to add one or all queries from the Available Queries list to the 
Selected Queries list, or to remove queries from the Selected list.

– You can also double-click queries on either side of the dialog box to add them 
to or remove them from the selection set.

Selection by Query Dialog Box

The Selection by Query dialog box lets you create selection sets from available 
queries. The dialog box contains the following controls:

Available Queries Contains all the queries that are available for your 
selection set. The Available Columns list is 
located on the left side of the dialog box. 

Selected Queries Contains queries that are part of the selection set. 
To add queries to the Selected Queries list, select 
one or more queries in the Available Queries list, 
then click the Add button [>].
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Adding Elements to a Selection Set

You can add a single or multiple elements to a static selection set.

To add an element to a static selection set:

1. Right-click the element to be added, then select Add to Selection Set from the 
shortcut menu.

2. In the Add to Selection Set dialog box, select the selection set to which you want 
to add the element.

3. Click OK to close the dialog box and add the element to the selected selection set. 
Click Cancel to close the dialog box without creating the selection set.

To add a group of elements to a static selection set all at once:

1. Select all of the elements to be added by either drawing a selection box around 
them, or by holding down the Ctrl key while clicking each one in turn. 

2. When all of the desired elements are highlighted, right-click and select Add to 
Selection Set.

Query Manipulation 
Buttons

Lets you select or clear queries to be used in the 
selection set:

• [  >  ] Adds the selected items from the Avail-
able Queries list to the Selected Queries list.

• [ >> ] Adds all of the items in the Available 
Queries list to the Selected Queries list.

• [  <  ] Removes the selected items from the 
Selected Queries list.

• [ << ] Removes all items from the Selected 
Queries list.

Note: You can select multiple queries 
in the Available Queries list by 
holding down the Shift key or 
the Control key while clicking 
with the mouse. Holding down 
the Shift key provides group 
selection behavior. Holding 
down the Control key provides 
single element selection 
behavior.
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3. In the Add to Selection Set dialog box, select the selection set to which you want 
to add the element.

4. Click OK to close the dialog box and add the element to the selected selection set. 
Click Cancel to close the dialog box without creating the selection set.

Add To Selection Set Dialog Box

This dialog box appears when you select the Add to Selection Set command. It 
contains the following field:

Removing Elements from a Selection Set

You can easily remove elements from a static selection set in the Selection Set 
Element Removal dialog box. 

To remove an element from a static selection set:

1. Display the Selection Sets Manager by selecting View > Selection Sets or 
clicking the Selection Sets button on the View toolbar.

2. In the Selection Sets Manager, select the desired selection set then click the Edit 
button.

3. In the Selection Set Element Removal dialog box, find the element you want to 
remove in the table. Select the element label or the entire table row, then click the 
Delete button. 

4. Click OK.

Selection Set Element Removal Dialog Box

This dialog appears when you click the edit button from the Selection Set Manager. It 
allows you to remove elements from the selection set that is highlighted in the Selec-
tion Sets Manager when the Edit button is clicked. 

Performing Group-Level Operations on Selection Sets

SewerGEMS V8i lets you perform group-level deletions on elements in a selection set 
using the Select In Drawing button in the Selection Sets Manager.

Add to: Drop-down menu that lets you select the selection 
set to which the currently highlighted element or 
elements will be added.
6-280 Bentley SewerGEMS V8i User’s Guide



Creating Your Model
Note: While it is not possible to directly edit groups of elements in a 
selection set, you can use the Next button in the Network 
Navigator to quickly navigate through each element in the 
selection set and edit its properties in the Property Editor.

To delete multiple elements from a selection set:

1. Open the Selection Sets Manager by selecting View > Selection Sets or clicking 
the Selection Sets button on the View toolbar.

2. In the Selection Sets Manager, highlight the selection set that contains elements 
you want to delete.

3. Click the Select In Drawing button in the Selection Sets Manager to highlight all 
of the selection set’s elements in the drawing pane.

– If there is only one selection set listed in the Selection Set Manager, you don’t 
have to highlight it before clicking the Select In Drawing button.

4. Shift-click (hold down the Shift key and click the left mouse button) any selected 
elements that you do not want to delete.

5. Right-click and select Delete. The highlighted elements in the selection set are 
deleted from your model.

Using the Network Navigator

The Network Navigator consists of a toolbar and a table that lists the Label and ID of 
each of the elements contained within the current selection. The selection can include 
elements highlighted manually in the drawing pane, elements contained within a 
selection set, or elements returned by a query.
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To open the Network Navigator, click the View menu and select the Network Navi-

gator command, press <Ctrl+3>, or click the Network Navigator button  on the 
View toolbar.

The following controls are included in Network Navigator:

Query Selection 
List

Choose the element sets to use in the query.
Once a query is selected, it can be executed 
when you click the > icon.

If there is already a Query listed in the list 
box, it can be run when the Execute icon is 
clicked.

Execute Click to run the selected query.

Previous Zooms the drawing pane view to the 
element prior to the currently selected one in 
the list.

Zoom To Zooms the drawing pane view to the 
selected element in the list.
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Predefined Queries

The Network Navigator provides access to a number of predefined queries grouped 
categorically, accessed by clicking the [>] button. Categories and the queries 
contained therein include:

Bolted Manholes

The Bolted Manholes query identifies manholes that have the Bolted Cover value set 
to True.

Next Zooms the drawing pane view to the 
element below the currently selected 
element in the list.

Copy Copies the elements to the Windows 
clipboard.

Remove Removes the selected element from the list.

Select In Drawing Selects the elements in the drawing pane and 
performs a zoom extent based on the 
selection.

Highlight When this toggle button is on, elements 
returned by a query will be highlighted in 
the drawing pane to increase their visibility.

Refresh Drawing Refreshes the current selection.

Help Opens SewerGEMS V8i Help.
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Control Structures

The Pond Outlet Control Structures query identifies pond outlet control structure 
elements.

Drawing Queries

Drawing Queries include the following:

• Dead End Nodes - Identifies nodes that are only connected to one link.

• Duplicate Links - Identifies instances in the model where a link shares both end 
nodes with another link.

• Link Split Candidates- Identifies nodes near a link that may be intended to be 
nodes along the link. The tolerance value can be set for the maximum distance 
from the link where the node should be considered as a link split candidate.

• Links Missing Nodes - Identifies which links are missing either one or both end 
nodes.

• Nodes In Close Proximity - Identifies nodes within a specific tolerance.

• Orphaned Nodes - Identifies nodes that are not connected to a link in the model.

Flooding

Flooding queries include the following:

• Is Flooded? - Identifies elements that are flooded during the current time step.

• Is Flooded Ever? - Identifies elements that are flooded at any point in time during 
an extended period simulation.

Hydrology

Runoff Methods - Identifies elements that use one of the runoff methods found in the 
submenu of this query.

Using Local Rainfall - Identifies catchments using the Local Rainfall hydrology 
method.

Inactive Elements

Identifies elements marked Inactive. The elements available under this query are 
divided into three subgroups: points (node elements), polygons (catchments and 
ponds), and polylines (link elements). 

Inlet Types

• Inflow Capture Curve Inlets - Identifies nodes using inflow-capture curve inlets.

• Maximum Capacity Inlets - Identifies nodes using maximum capacity inlets.
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Pipes

• Culverts - Identifies culvert link elements.

• Dry Pipes - Identifies link elements with no flow during the simulation.

• Exceed Capacity - Identifies link elements whose flow exceeds their capacity at 
some point during the simulation.

• Shapes - Identifes all link elements of the specified shape.

Pollutant Point Sources

Identifies elements that are pollutant point sources. This query is divided into 
subgroups for each element type.

Slopes

• Horizontal Slopes - Identifies link elements with horizontal slopes.

• Near Horizontal - Slopes Identifies link elements that have near-horizontal 
slopes.

• Negative Slopes - Identifies link elements with negative slopes (links whose 
upstream elevation is lower than their downstream elevation).

Surface Storages

• Catch basins with Surface Storage - Identifies catchbasin elements with surface 
storage capacity.

• Manholes with Surface Storage - Identifies manhole elements with surface 
storage capacity.

Using Prototypes
Prototypes allow you to enter default values for elements in your network. These 
values are used while laying out the network. Prototypes can reduce data entry 
requirements dramatically if a group of network elements share common data. 

For example, if a section of the network contains all three foot-diameter manholes , 
use the manhole prototype to set the Diameter field to 3.00 ft. When you create a new 
manhole in your model, its diameter attribute will default to 3.00 ft. 
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Note: Changes to the prototypes are not retroactive and will not affect 
any elements created prior to the change. 

If a section of your system has distinctly different 
characteristics than the rest of the system, adjust your 
prototypes before laying out that section. This will save time 
when you edit the properties later.  

For instructions on how to create prototypes, see “Creating Prototypes” on page 6-
286.

Creating Prototypes

Prototypes contain default values for Bentley SewerGEMS V8i elements. You create 
prototypes in the Prototypes Manager. 

To create a prototype:

1. Open your Bentley SewerGEMS V8i project or start a new project.

2. Select View > Prototypes or press Ctrl+6.

The Prototypes Manager opens. All Bentley SewerGEMS V8i element types are 
displayed in an expanding and collapsing list. 

3. Select the element type for which you want to create a prototype, then click the 
New button.

The element type in the list expands to display all the prototypes that exist for that 
element type. 

Each element type contains a default prototype, which is not editable, and any 
prototypes that you have created. The current set of default values for each 
element type is identified by the Make Current icon. 

4. Double-click the prototype you just created. The Property Editor for the element 
type opens.

5. Edit the attribute values in the Property Editor as required.

6. To make the new prototype the default, click the Make Current button in the 
Prototypes Manager. 

The icon next to the prototype changes to indicate that the values in the prototype 
will be applied to all instances of that element type that you add to your current 
project. 

7. Perform the following optional steps:

– To rename a prototype, select the prototype in the list and click the Rename 
button.
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– To delete a prototype, select the prototype in the list and click the Delete 
button.

– To view a report of the default values in the prototype, select the prototype in 
the list and click the Report button.

Prototypes Manager

The Prototypes Manager allows you to create prototypes, which contain default 
common data for each element type. The Prototypes Manager consists of a toolbar and 
a list pane, which displays all of the elements available in Bentley SewerGEMS V8i. 

The list of elements in the Prototypes Manager list pane is expandable and collapsible. 
Click on the Plus sign to expand an element and see its associated prototypes. Click on 
the Minus sign to collapse the element. 

Each element in the list pane contains a default prototype; you cannot edit this default 
prototype. The default prototypes contains common values for each element type; if 
you add elements to your model without creating new prototypes, the data values in 
the default prototypes appear in the Property Editor for that element type. 

The toolbar contains the following buttons: 

New Creates a new prototype of the selected 
element.

Delete Deletes the prototype that is currently 
highlighted in the list pane.
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Engineering Libraries
Engineering Libraries are powerful and flexible tools that you use to manage specifi-
cations of common materials, objects, or components that are shared across projects.  
Some examples of objects that are specified through engineering libraries include pipe 
materials, storm events, and unit sanitary loads.  You can modify engineering libraries 
and the items they contain by using the Engineering Libraries command in the Tools 
menu, or by clicking the ellipsis (…) buttons available next to the fields in dialog 
boxes that make use of engineering libraries.

Note: The data for each engineering library is stored in an XML file in 
your Bentley SewerGEMS V8i program directory. We strongly 
recommend that you edit these files only using the built-in tools 
available by selecting Tools > Engineering Libraries.

You work with engineering libraries and the items they contain in the Engineering 
Libraries dialog box, which contains all of the project’s engineering libraries. Indi-
vidual libraries are compilations of library entries, along with their attributes. For 
more information about working with engineering libraries, see “Working with Engi-
neering Libraries” on page 6-289.

By default, each project you create in SewerGEMS V8i uses the items in the default 
libraries. In special circumstances, you may wish to create custom libraries to use with 
one or more projects.  You can do this by copying a standard library or creating a new 
library.

Rename Lets you rename the prototype that is 
currently highlighted in the list pane.

Make Current Lets you make the prototype that is currently 
highlighted in the list pane the default for 
that element type. When you make the 
current prototype the default, every element 
of that type that you add to your model in 
the current project will contain the same 
common data as the prototype.

Report Lets you view a report of the data associated 
with the prototype that is currently 
highlighted in the list pane. 

Help Displays online help for the Prototypes 
Manager.
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When you change the properties for an item in an engineering library, those changes 
affect all projects that use that library item.  At the time a project is loaded, all of its 
engineering library items are synchronized to the current library.  Items are synchro-
nized based on their label.  If the label is the same, then the item’s values will be made 
the same.

The default libraries that are installed with Bentley SewerGEMS V8i are editable. In 
addition, you can create a new library of any type, and can then create new entries of 
your own definition.

• Library types are displayed in the Engineering Library manager in an expanding/
collapsing tree view.

• Library types can contain categories and subcategories, represented as folders in 
the tree view.

• Individual library entries are contained within the categories, subcategories, and 
folders in the tree view.

• Libraries, categories, folders, and library entries are displayed in the tree view 
with their own unique icons. You can right-click these icons to display submenus 
with different commands.

Working with Engineering Libraries

When you select a library entry in the tree view, the attributes and attribute values 
associated with the entry are displayed in the editor pane on the right side of the dialog 
box.

Working with Libraries

Right-clicking a Library icon in the tree view opens a shortcut menu containing the 
following commands:

Create Library Creates a new engineering library of the currently 
highlighted type.

Add Existing Library Lets you add an existing engineering library that 
has been stored on your hard drive as an .xml file 
to the current project.
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Working with Categories

Right-clicking a Category icon in the tree view opens a shortcut menu containing the 
following commands:

Working with Folders

Right-clicking a Folder icon in the tree view opens a shortcut menu containing the 
following commands:

Working with Library Entries

Right-clicking a Library Entry icon in the tree view opens a shortcut menu containing 
the following commands:

Add Item Creates a new entry within the current library.

Add Folder Creates a new folder under the currently 
highlighted library.

Save As Lets you save the currently highlighted category 
as an .xml file that can then be used in future 
projects.

Remove Deletes the currently highlighted category from 
the library.

Add Item Creates a new entry within the current folder.

Add Folder Creates a new folder under the currently 
highlighted folder.

Rename Lets you rename the currently highlighted folder.

Delete Deletes the currently highlighted folder and its 
contents.

Rename Lets you rename the currently highlighted entry.

Delete Deletes the currently highlighted entry from the 
library.
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Engineering Libraries Dialog Box

The Engineering Libraries dialog box contains an explorer tree-view pane on the left, 
a library entry editor pane on the right, and the following buttons above the explorer 
tree view pane:

Sharing Engineering Libraries On a Network

You can share engineering libraries with other SewerGEMS V8i users in your organi-
zation by storing the engineering libraries on a network drive. All users who will have 
access to the shared engineering library should have read-write access to the network 
folder in which the library is located.

To share an engineering library on a network, open the Engineering Libraries in 
SewerGEMS V8i and create a new library in a network folder to which all users have 
read-write access.

Pipe Catalog Dialog Box

This dialog box allows you to create, edit, and view catalog pipes. Catalog pipes are 
an efficient way to reuse common physical pipe definitions.

New Opens a submenu containing the following 
commands:

• Create Library—Creates a new engi-
neering library.

• Add Existing Library—Lets you add an 
existing engineering library that has 
been stored on your hard drive as an 
.xml file to the current project.

Delete Removes the currently highlighted 
engineering library from the current project.

Rename Lets you rename the currently highlighted 
engineering library.
Bentley SewerGEMS V8i User’s Guide 6-291



Engineering Libraries
The dialog box contains a toolbar, a Pipe Catalog list pane, and two tabs. The toolbar 
contains the following buttons:

New Creates a new entry in the Pipe Catalog 
List Pane.

Delete Deletes the entry that is currently 
highlighted in the Pipe Catalog List 
Pane.

Rename Lets you rename the entry that is 
currently highlighted in the Pipe Catalog 
List Pane.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Pipe Catalog List 
Pane.

Synchronize Clicking this button opens a submenu 
containing the following commands:
• Browse Engineering Library—This 

command opens the Engineering Library 
manager dialog, allowing you to browse 
the Pipe Catalog Library.

• Synchronize From Library—This 
command allows you to update a pipe 
catalog that was previously imported 
from a Pipe Catalog Engineering Library 
to reflect changes that have been made 
to the library since it was imported.

• Synchronize To Library—This 
command allows you to update an 
existing Pipe Catalog Engineering 
Library using current Pipe Catalog 
entries that were initially imported but 
have since been modified.

• Import From Library—This command 
allows you to import catalog entries from 
an existing Pipe Catalog Engineering 
Library.

• Export To Library—This command 
allows you to export the current catalog 
entries to an existing Pipe Catalog Engi-
neering Library.
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The following table describes the rest of the controls in the Pipe Catalog dialog box.

Pipe Catalog List Pane Located on the left side of the dialog box, displays 
a list of all of the catalog pipes that have been 
defined in the current project. Highlighting a 
catalog pipe in this list causes the Cross Section 
Shape and Roughness Sections to display the 
associated information with the highlighted pipe.

Cross Section Shape Located in the top-right corner of the Pipe Catalog 
tab, contains controls that allow you to define the 
size and shape of the catalog pipe currently 
highlighted in the List Pane. The controls that 
appear change according to the Cross Section 
Type that is selected.

Cross Section Type Lets you define the type of cross section for the 
currently highlighted catalog pipe.

Diameter Lets you define the diameter of the pipe. This field 
is only available for Circular catalog pipes.

<Section Type> Rise Lets you define the rise (height) of the catalog 
pipe. This field is available for all cross section 
types except Circular. 

<Section Type> Span Lets you define the span (width) of the catalog 
pipe. This field is available for all cross section 
types except Circular.

Roughness Located in the bottom-right corner of the Pipe 
Catalog tab, lets you define the roughness 
attributes of the catalog pipe currently highlighted 
in the List Pane. The controls that are available 
change depending on the Roughness Type 
selected.

Roughness Type Lets you specify which of the available roughness 
methods to be applied to the catalog pipe currently 
highlighted in the List Pane. The other controls 
available in section are dependent on the 
selection made in this box.

Material Lets you enter a material label. This field is 
informational only, and will not affect the 
roughness properties of the associated catalog 
entry.
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Using the SWMM Water Quality Solver
Bentley SewerGEMS V8i can perform water quality modeling using the SWMM 
water quality solver.  In order to make a water quality run choose the SWMM5 
Explicit Engine from the Analysis > Calculation Options > Engine Type dialog.

You must then define the pollutant being modeled using the Component > SWMM 
Extensions > Pollutants dialog (see ”Pollutants Dialog Box’). In the Pollutants 
dialog, the enter a name for the pollutant and define the properties.

If water quality data is present in a scenario, water quality calculations will be 
performed. 

There are two methods for loading pollutants in a water quality simulation. 

1. Point (node) load, which involves assigning a pollutograph (see ”Adding Polluto-
graphs to a Node’) to a node element (such as a manhole or a cross section). This can 
be done in the element property grid or under the water quality alternative of the alter-
native manager for that element. This method is used for point loads such as industrial 
dischargers or normal domestic customers.

Manning’s n Lets you define the roughness value for the 
catalog pipe. This field is available only when the 
Roughness Type is Single Manning’s n.

Depth vs. Manning’s 
Table

Lets you define a depth vs. roughness curve for 
the catalog pipe. This field is available only when 
the Roughness Type is Manning’s n-Depth Curve.

Manning’s vs. 
Discharge Table

Lets you define a flow vs. roughness curve for the 
catalog pipe. This field is available only when the 
Roughness Type is Manning’s n-Flow.

Library Tab Displays information pertaining to the catalog 
entry that is currently highlighted in the List Pane, 
including:

• ID

• Label

• Modified Date

• Library Source

• Library Modified Date

• Synchronization Status
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2. Catchment runoff, where the pollutant enters the system based on one of several 
different washoff functions for each land use assigned to a catchment. Land uses and 
washoff (and optional buildup/treatment) functions are defined under Components > 
SWMM Extensions > Land Use. Then under, Alternatives > Water Quality > 
Catchments, define what fraction of the catchment is associated with each land use 
(see ”Land Uses Collection Dialog Box’) and the initial buildup of pollutants (see 
”Initial Buildup Collection Dialog Box’) at the start of the run. In long-term runs, you 
can specify the rate at which pollutants build up on the catchment surface (and are 
possibly removed by treatments such as street sweeping).

It is not possible to view the water quality results using the standard graphing. Instead, 
you must open the property grid for the element, scroll down to Results > Pollutant 
and open the collection by clicking on the ellipsis button. This will display a graph of 
concentration vs. time. Switching to the Data tab will give tabular results.

An overview of the water quality modeling process is shown below.

Note: When SewerGEMS V8i is running calculations using the Implicit 
Engine Type (this setting is found in the Calculation Options 
Manager), SWMM attributes and their associated values are not 
considered. Only when the SWMM Engine Type is used will the 
data contained in these dialog boxes have any effect on the 
calculated results.

See also:

• “Evaporation Dialog Box” on page 6-297

• “Aquifers Dialog Box” on page 6-298
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• “Control Sets Dialog Box” on page 6-299

• “Pollutants Dialog Box” on page 6-305

• “Adding Pollutographs to a Node” on page 6-307

• “Land Uses Dialog Box” on page 6-311

• “Adding Treatment to a Node” on page 6-321

• “Initial Buildup Collection Dialog Box” on page 6-323

SWMM Hydrology

You can use the Explicit (SWMM 5) engine in Bentley SewerGEMS V8i to route 
flows through the system. However, in order to use SWMM hydraulics, you must load 
the model through inflows at nodes, or you must select EPA-SWMM Runoff as the 
runoff method for a catchment. If you are not familiar with SWMM hydrology, we 
strongly recommend that you read SWMM 5 documentation for a detailed discussion 
of the topic. 

The overall process through which precipitation is converted to flow in conduits and 
channels is summarized in the following figure. 

Figure 6-1: Conversion of Precipitation to Flow
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The parameters used in determining runoff can be divided into two categories: 

Parameters that are shared by the SWMM model and the Bentley SewerGEMS V8i/
SewerGEMS native hydrology calculations. These include SCS runoff curve number, 
Horton max and min infiltration rates, etc. You can enter these parameters in the Prop-
erty Editor or in the FlexTable for a specific catchment.

Parameters that are unique to the SWMM model. These include evaporation rates, 
aquifer conductivity, and wilting point. To enter these parameters, you must select 
Analysis > SWMM Extensions, then select the appropriate SWMM dialog.

Evaporation Dialog Box

This dialog box allows you to define the evaporation that can occur for standing water 
on subcatchment surfaces, for subsurface water in groundwater aquifers, and from 
water held in storage units.

Access this dialog box by selecting Analysis > SWMM Extensions > Evaporation.

The following controls are available in this dialog box are as follows: 

Note: Available controls vary, depending on the Evaporation Type that 
is chosen.

Label Displays the label of the current evaporation rate.

Evaporation Type Allows you to specify the type of evaporation rate. The 
setting controls will vary according to the type chosen 
here, as follows:
• Constant Evaporation—Use this choice if evapo-

ration remains constant over time. Enter the rate of 
evaporation in the Constant Evaporation field that 
appears when this type is chosen.

• Monthly Evaporation—Use this choice to supply 
an average rate for each month of the year. Enter 
the value for each month in the appropriate data 
fields that appear when this type is chosen. Note 
that rates remain constant within each month.

• Time-Series Evaporation—Select this choice if 
evaporation rates will be specified in a time series. 
Enter the evaporation value for each of the time 
series points. Note that for each date specified in 
the time series, the evaporation rate remains 
constant at the value supplied for that date until the 
next date in the series is reached (i.e., interpolation 
is not used on the series).
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Aquifers Dialog Box

Aquifers are sub-surface groundwater areas used to model the vertical movement of 
water infiltrating from the subcatchments which lie above them. They also permit the 
infiltration of groundwater into the conveyance system, or exfiltration of surface water 
from the conveyance system, depending on the hydraulic gradient that exists.

Access this dialog box by selecting Analysis > SWMM Extensions > Aquifers.

This dialog box contains a toolbar, a list pane on the left that displays all of the aqui-
fers that have been defined in the current project, and the attribute fields on the right 
that permit the values to be defined for the aquifer that is currently highlighted in the 
list pane. The toolbar contains the following buttons:

The attribute fields along the right side of the dialog box include:

Report This button creates a report based on your evaporation 
settings.

New Creates a new entry in the Aquifer List 
Pane.

Delete Deletes the entry that is currently 
highlighted in the Aquifer List Pane.

Rename Lets you rename the entry that is 
currently highlighted in the Aquifer List 
Pane.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Aquifer List Pane.

Porosity Lets you define the volume of voids / total soil 
volume for the currently highlighted aquifer.

Wilting Point Lets you define soil moisture content at which 
plants cannot survive for the currently highlighted 
aquifer.
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Control Sets Dialog Box

This dialog box allows you to create, view, and manage SWMM controls. 
Access it by selecting Analysis > SWMM Extensions > Control Sets.

Field Capacity Lets you define soil moisture content after all free 
water has drained off for the currently highlighted 
aquifer.

Aquifer Conductivity Lets you define the soil's saturated hydraulic 
conductivity for the currently highlighted aquifer.

Conductivity Slope Lets you define the slope of conductivity vs. soil 
moisture content curve for the currently 
highlighted aquifer.

Tension Slope Lets you define the slope of soil tension vs. soil 
moisture content curve for the currently 
highlighted aquifer.

Upper Evaporation 
Fraction

Lets you define the fraction of total evaporation 
available for evapotranspiration in the upper 
unsaturated zone for the currently highlighted 
aquifer.

Lower Evaporation 
Depth

Lets you define the maximum depth into the lower 
saturated zone over which evapotranspiration can 
occur for the currently highlighted aquifer.

Lower Groundwater 
Loss Rate

Lets you define the rate of percolation from the 
saturated zone to deep groundwater when water 
table is at ground surface for the currently 
highlighted aquifer.

Elevation (Bottom) Lets you define the elevation of the bottom of the 
aquifer for the currently highlighted aquifer.

Water Table Elevation Lets you define the elevation of the water table in 
the aquifer at the start of the simulation for the 
currently highlighted aquifer.

Unsaturated Zone 
Moisture

Lets you define the moisture content of the 
unsaturated upper zone of the aquifer at the start of 
the simulation for the currently highlighted 
aquifer.
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This dialog box contains a toolbar, a list pane on the left that displays all of the 
controls that have been defined in the current project, and a control editor pane on the 
right that allows you to enter and edit the currently highlighted SWMM control defini-
tion. The toolbar contains the following buttons:

The Control Editor Pane allows you to define SWMM controls. Each control rule is a 
series of statements of the form:

RULE  ruleID 

IF    condition_1 

AND   condition_2 

OR    condition_3 

AND   condition_4 

Etc. 

THEN  action_1 

AND   action_2 

Etc. 

ELSE  action_3 

New Creates a new entry in the Control List 
Pane.

Delete Deletes the entry that is currently 
highlighted in the Control List Pane.

Rename Lets you rename the entry that is 
currently highlighted in the Control List 
Pane.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Control List Pane.
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AND   action_4 

Etc. 

PRIORITY value 

where keywords are shown in boldface and ruleID is an ID label assigned to the rule, 
condition_n is a Condition Clause, action_n is an Action Clause, and value is a 
priority value (e.g., a number from 1 to 5). 

Only the RULE, IF and THEN portions of a rule are required; the other portions are 
optional. 

Blank lines between clauses are permitted and any text to the right of a semicolon is 
considered a comment. 

When mixing AND and OR clauses, the OR operator has higher precedence than 
AND, i.e., 

IF A or B and C  

is equivalent to 

IF (A or B) and C 

If the interpretation was meant to be 

IF A or (B and C)  

then this can be expressed using two rules as in 

IF A THEN …

IF B and C THEN … 

The PRIORITY value is used to determine which rule applies when two or more rules 
require that conflicting actions be taken on a link. A rule without a priority value 
always has a lower priority than one with a value. For two rules with the same priority 
value, the rule that appears first is given the higher priority.
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Note: Remember the pump icon represents a collection of pumps.  
When setting up controls be sure to reference the individual 
pumps in the pump collection, not the overall pump object.  For 
example,  PMP-1 will have pump in its collection PMP-1.1, PMP-
1.2.  Use the labels as defined in the pump collection dialog, not 
the overall pump station name.

Control Set Formats

Formats 

Each control set consists of a series of statements of the form: 

RULE  ruleID 
IF    condition_1
AND   condition_2 
OR    condition_3 
AND   condition_4  

Etc. 

THEN  action_1 
AND   action_2  

Etc. 

ELSE  action_3 
AND   action_4  

Etc. 

PRIORITY value  

where keywords are shown in boldface and ruleID is an ID label assigned to the rule, 
condition_n is a Condition Clause, action_n is an Action Clause, and value is a 
priority value (e.g., a number from 1 to 5). 

Condition Clauses 

A Condition Clause of a Control Rule has the following format: 

object id attribute relation value 

Where:

object = a category of object 
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id = the object's ID label 

attribute = an attribute or property of the object 

relation = a relational operator (=, <>, <, <=, >, >=) 

value = an attribute value 

Some examples of condition clauses are: 

NODE N23 DEPTH > 10 
PUMP P45 STATUS = OFF 
SIMULATION CLOCKTIME = 22:45:00 

The objects and attributes that can appear in a condition clause are as follows: 

Action Clauses 

An Action Clause of a Control Rule can have one of the following formats: 

PUMP id STATUS = ON/OFF 
ORIFICE id SETTING = value 
WEIR id SETTING = value  

Table 6-6: Objects and Attributes in Condition Clauses

Object Attribute Value

NODE DEPTH
HEAD
INFLOW

numerical value
numerical value
numerical value

LINK FLOW
DEPTH

numerical value
numerical value

PUMP STATUS
FLOW

ON or OFF
numerical value

ORIFICE
WEIR

SETTING fraction open

SIMULATION TIME
DATE
CLOCKTIME

elapsed time in decimal hours or 
hr:min:sec 
month/day/year 
time of day in hr:min:sec 
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Where SETTING is the fractional amount that an orifice is fully open or to the frac-
tional amount of the original height between the crest and the top of a weir that 
remains (i.e., weir control is accomplished by moving the crest height up and down). 

Some examples of action clauses are: 

PUMP P67 STATUS = OFF 
ORIFICE O212 SETTING = 0.5  

Only the RULE, IF and THEN portions of a rule are required; the other portions are 
optional. 

Blank lines between clauses are allowed, and any text to the right of a semicolon is 
considered a comment. 

When mixing AND and OR clauses, the OR operator has higher precedence than AND, 
i.e., 

IF A or B and C 

is equivalent to 

IF (A or B) and C. 

If the interpretation was meant to be 

IF A or (B and C) 

then this can be expressed using two rules as in 

IF A THEN ...
IF B and C THEN ...  

The PRIORITY value is used to determine which rule applies when two or more rules 
require that conflicting actions be taken on a link. A rule without a priority value 
always has a lower priority than one with a value. For two rules with the same priority 
value, the rule that appears first is given the higher priority. 

Examples 

The following are examples of control rules. 

Simple time-based pump control 
6-304 Bentley SewerGEMS V8i User’s Guide



Creating Your Model
RULE R1 
IF SIMULATION TIME > 8 
THEN PUMP 12 STATUS = ON 
ELSE PUMP 12 STATUS = OFF ;  

Multi-condition orifice gate control 

RULE R2A 
IF NODE 23 DEPTH > 12 AND LINK 165 FLOW > 100 
THEN ORIFICE R55 SETTING = 0.5  
RULE R2B 
IF NODE 23 DEPTH > 12 AND LINK 165 FLOW > 200 
THEN ORIFICE R55 SETTING = 1.0  
RULE R2C 
IF NODE 23 DEPTH <= 12 OR LINK 165 FLOW <= 100 
THEN ORIFICE R55 SETTING = 0 ;  

Pump station operation (as in a SWMM4 Type5 pump) 

RULE R3A 
IF NODE N1 DEPTH > 5 
THEN PUMP N1A STATUS = ON  
RULE R3B 
IF NODE N1 DEPTH > 7 
THEN PUMP N1B STATUS = ON  
RULE R3C 
IF NODE N1 DEPTH <= 3 
THEN PUMP N1A STATUS = OFF AND PUMP N1B STATUS = OFF 

Pollutants Dialog Box

This dialog box allows you to track the generation, inflow and fate of any number of 
user-specified pollutants. In addition, pollutant X can have a co-pollutant Y, meaning 
that the runoff concentration of X will have some fixed fraction of the runoff concen-
tration of Y added to it.

Pollutant buildup and washoff on subcatchment areas are determined by the Land 
Uses assigned to those areas. 

Input loadings of pollutants from external and dry weather inflows are supplied 
through time series data associated with particular nodes of the collection system. 

Access this dialog box by selecting Analysis > SWMM Extensions > Pollutants.
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This dialog box contains a toolbar, a list pane on the left that displays all of the pollut-
ants that have been defined in the current project, and the attribute fields on the right 
that permit the values to be defined for the pollutant that is currently highlighted in the 
list pane. The toolbar contains the following buttons:

The attribute fields along the right side of the dialog box include:

New Creates a new entry in the Pollutant List 
Pane.

Delete Deletes the entry that is currently 
highlighted in the Pollutant List Pane.

Rename Lets you rename the entry that is 
currently highlighted in the Pollutant List 
Pane.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Pollutant List Pane.

Rain Concentration Lets you define the concentration of the pollutant 
in rain water for the currently highlighted 
pollutant.

Groundwater 
Concentration

Lets you define the concentration of the pollutant 
in groundwater for the currently highlighted 
pollutant.

Decay Coefficient Lets you define the first-order decay coefficient 
for the currently highlighted pollutant.

Co-Pollutant Lets you define the name of another pollutant 
runoff concentration the current pollutant is 
dependent on for the currently highlighted 
pollutant.

Co-Fraction Lets you define the fraction of the co-pollutant's 
runoff concentration that contributes to the runoff 
concentration for the currently highlighted 
pollutant.
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Adding Pollutographs to a Node

Pollutographs are plots of time vs. mass rate or time vs. concentration, depending on 
which constituent inflow type you choose (mass or concentration). You create polluto-
graphs in the Pollutographs dialog box and add them to individual manholes in your 
model using the node's Property Editor. 

To add a pollutograph to a node:

1. Change the engine type to Explicit (SWMM 5) by performing these steps:

a. Select View > Calculation Options.

b. In the Calculation Options Manager, double-click Base Calculation Options 
or any other calculation options profile you have created.

c. In Calculation Options section of the Property Editor, select Explicit 
(SWMM 5) as the Engine Type.

2. Define a pollutant by performing these steps:

a. Select Analysis > SWMM Extensions > Pollutants. 

b. In the Pollutants dialog box, click the New button to create a new pollutant, 
then enter all the data that define the pollutant.

c. Click Close to close the Pollutants dialog box and save your pollutant(s).

3. Create a pollutograph by performing these steps:

a. Select Analysis > SWMM Extensions > Pollutographs.

b. In the Pollutographs dialog box, click the New button, then click Mass or 
Concentration to create a new pollutograph.

c. Enter all the data that define the pollutograph. 

For pollutographs based on mass, select a Pollutant, enter a Mass Conversion 
Factor, then enter Time vs. Mass Rate data points. 

For pollutographs based on concentration, select a Pollutant, then enter Time 
vs. Concentration data points. 

I & I Concentration Lets you define the concentration of the pollutant 
in any Infiltration/Inflow.
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Note: Bentley SewerGEMS V8i validates your data as you enter it and 
displays errors and warnings in the status bar at the bottom of 
the Pollutographs dialog box. Be sure to check this status bar 
for any errors or warnings as you enter data.

d. Optionally, view a report or plot of your pollutograph.

e. Click Close to save the pollutograph.

4. Click the desired manhole in your model. The Property Editor for the manhole 
appears. (If the Property Editor is not already displayed, you must double-click 
the node in your model.)

5. In the SWMM Extended Data section of the Property Editor, click the Polluto-
graphs field, then click the Ellipses (...) button.

6. In the Pollutograph Collection dialog box, add pollutographs to the pollutograph 
collection by performing these steps:

a. Click the New button to add a row to the Pollutograph table.

b. Click the down arrow in the first row then select an existing pollutograph. If 
there are no pollutographs in your project, you can click the Ellipses (...) 
button to display the Pollutographs dialog box, where you can create new 
pollutographs.

c. Repeat Steps a and b for every pollutograph you wish to add to the collection.

d. Press OK to close the dialog box and add the collection to the node.

7. Complete your model, then click the Compute button on the Compute toolbar.

8. When the model has been successfully computed, open the Property Editor for the 
node the contains the Pollutograph Collection.

9. In the Results section of the Property Editor, click the Ellipses (...) button in the 
Pollutants field to view pollutant results.

Pollutograph Dialog Box

This dialog box contains a toolbar, a list pane on the left that displays all of the pollu-
tographs that have been defined in the current project, and attribute fields on the right 
that let you enter values for the pollutograph that is currently highlighted in the list 
pane. 
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The toolbar contains the following buttons:

The attribute fields along the right side of the dialog box include:

New Opens a submenu containing the 
following options:

• Mass—Lets you create a plot of time 
vs. mass rate.

• Concentration—Lets you create a 
plot of time vs. concentration.

Delete Deletes the currently-highlighted 
pollutograph from the list pane.

Rename Lets you rename the currently-
highlighted pollutograph.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the currently-highlighted 
pollutograph.

Pollutant Lets you select the pollutant for the pollutograph. 
Select the pollutant from the drop-down menu or 
click the Ellipses (...) button to open the SWMM 
Pollutants dialog box, where you can define new 
pollutants.

New This button adds a new row to the pollutograph 
table. 

Delete This button removes the current row from the 
pollutograph table.

Report Displays a report of the data in the pollutograph 
table. 

Graph Displays a plot of the data in the pollutograph 
table.

Mass Conversion 
Factor

Lets you enter a mass conversion factor. . This 
field is available only for pollutographs using 
mass as the constituent inflow type. 
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There is also a status bar located at the bottom of the dialog box that displays any 
errors and warnings that may occur when you enter data.

Pollutograph Collection Dialog Box

The Pollutograph Collection dialog box lets you add multiple pollutographs to a node 
in your model. You access this dialog box from the SWMM Extended Data section of 
the Property Editor for the selected node. 

The dialog box contains the following toolbar buttons: 

The dialog box also contains the following controls: 

Pollutants Results Dialog Box

The Pollutants Results dialog box displays a plot for each pollutant after you success-
fully calculate your model. You access this dialog box by clicking the Ellipses (...) 
button in the Pollutants field in the Results section of the Property Editor. 

Pollutograph Table Lets you define the pollutograph by entering Time 
vs. Mass Rate points for pollutographs using mass 
as the constituent inflow type, or Time vs. 
Concentration points for pollutographs using 
concentration as the constituent inflow type. 

New Adds a new row to the Pollutograph 
table. Click in the row to select a 
pollutograph from the drop-down menu, 
or click the Ellipses (...) button to create 
new pollutographs.

Delete Deletes the current row from the table.

Report Lets you view a report of the collection.

Pollutograph Table Displays the pollutographs you have added to the 
collection. You add a pollutograph to the 
collection by clicking the New button, then 
selecting a pollutograph from the drop-down 
menu in the table row.
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The Pollutants Results dialog box contains a list pane on the left that displays all the 
pollutants assigned to the selected node, and a two tabs on the right:

Land Uses Dialog Box

Land Uses are categories of activities or land surface characteristics that are assigned 
to catchment elements. Examples of land use activities are residential, commercial, 
industrial, and undeveloped. Land surface characteristics might include roof tops, 
lawns, paved roads, undisturbed soils, etc. Land uses are used solely to allow spatial 
variation in pollutant buildup and washoff rates.

You have complete freedom in defining land uses and assigning them to catchment 
elements. One approach is to assign a mix of land uses to each subcatchment, in which 
case all land uses in the subcatchment will have the same pervious/impervious charac-
teristics. If this is not appropriate, the user can create subcatchments that have just a 
single land use classification along with a set of pervious/impervious characteristics 
that reflects the classification. 

Access this dialog box by selecting Analysis > SWMM Extensions > Land Uses.

This dialog box contains a toolbar, a list pane on the left that displays all of the land 
uses that have been defined in the current project, and three tabs on the right that 
together permit the values to be defined for the land use that is currently highlighted in 
the list pane. 

Time vs. Concentration 
Tab

Displays a plot of Concentration over Time for 
each pollutant displayed in the list pane.

Data Tab Displays the time (hours by default) vs. 
concentration (ppm by default) data points for 
each pollutant displayed in the list pane.
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The toolbar contains the following buttons:

The right side of the dialog contains the following tabs:

• ”Land Use General Tab’

• ”Land Use Buildup Tab’

• ”Land Use Washoff Tab’

Land Use General Tab

The General tab contains controls related to street cleaning. Street cleaning can be 
used on each land use category to periodically reduce the accumulated buildup of 
particular pollutants. This tab contains the following controls:

Land Use Buildup Tab

Pollutant Buildup that accumulates over a category of land use is described by either a 
mass per unit of subcatchment area or per unit of curb length, as specified by the 
Normalizer field described below. 

New Creates a new entry in the Land Use List 
Pane.

Delete Deletes the entry that is currently 
highlighted in the Land Use List Pane.

Rename Lets you rename the entry that is 
currently highlighted in the Land Use 
List Pane.

Report Lets you generate a preformatted report 
that contains the input data associated 
with the entry that is currently 
highlighted in the Land Use List Pane.

Street Cleaning 
Interval

Amount of time between cleaning.

Availability The fraction of buildup of all pollutants that is 
available for removal by cleaning 

Last Cleaned Amount of time since land use category has last 
been cleaned.
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The buildup is usually given as mass of pollutant per unit area although they may be 
given as counts (in the case of coliforms) per unit curb length.  Therefore B (and C1 in 
the functions below) can be given as lbs/acre, kg/hectare, coliform/acre, lbs/ft curb 
length, etc. Time in the functions refers to the number of antecedent dry days. Buildup 
is only used when the exponential washoff function is used to determine quality of 
runoff quality from catchments.

Three different functions can be used to describe buildup. The functions are all mono-
tonically increasing. The figure below gives their relative shape.

Figure 6-2: Buildup Function Types

The amount of buildup as a function of days of dry weather can be computed using 
one of the following functions:

• Power Function: Pollutant Buildup (B) accumulates proportional to time (t) 
raised to some power, until a maximum limit is achieved.

(6.1)
B Min C C tc= ( )1 2

3,
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The effect of each coefficient is shown in the figure below.

Figure 6-3: Effect of Power Function Coefficients

• Exponential Function: Buildup follows an exponential growth curve that 
approaches a maximum limit asymptotically.

(6.2)

Where B = buildup, mass(count/area(length)

C1 = maximum possible build-up, mass (count)/
area(length)

C2 = build-up rate

C3 = time exponent

B C t= ( )1 1-e-c2
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The effect of each coefficient is shown in the figure below.

Figure 6-4: Effect of Exponential Function Coefficients

• Saturation Function: Buildup begins at a linear rate which proceeds to decline 
constantly over time until a saturation value is reached.

(6.3)

Where B = buildup, mass(count)/area(length)

C1 = maximum possible build-up, mass(count)/
area(length)

C2 = build-up rate constant, 1/day

Where B = buildup, mass(count)/area(length)

C1 = maximum possible build-up, mass(count)/
area(length)

C2 = build-up rate constant, 1/day

B
C t

C t
=

+
1

2
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The effect of each coefficient is shown in the figure below.

Figure 6-5: Effect of Saturation Function Coefficients

This tab contains a table with the following attribute columns:

Column Description

Pollutant This menu contains all of the pollutants that have 
been defined in the Pollutants dialog box for the 
current project. Select the one that should be used 
for the land use currently highlighted in the list 
pane.

Max. Buildup This field allows you to define the value of C1 in 
the above equations.

Rate Constant This field allows you to define C2 in the Power 
and Exponential equations described above.

Buildup Function This menu allows you to specify which of the 
buildup functions described above will be used for 
the land use currently highlighted in the list pane.
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Land Use Washoff Tab

Washoff refers to the amount of pollutants washed off from a catchment during a wet 
weather period. The user can select any of the three washoff functions described 
below:

• Exponential Washoff: The washoff load (W) in units of mass per hour is propor-
tional to the product of runoff raised to some power and to the amount of buildup 
remaining.

(6.4)

Power Constant This field allows you to define C3 in the Power 
equation described above.

Half Saturation 
Constant

This field allows you to define C2 in the Saturation 
equation described above.

Normalizer Allows you to specify the method by which 
pollutant buildup is described for the land use 
currently highlighted in the list pane. Choices 
include Area (mass per unit of subcatchment area) 
or Curb (mass per unit of curb length).

Where C1 = washoff coefficient

C2 = washoff exponent

q = runoff rate per unit area

B = pollutant build-up in a mass per unit area or curb 
length

W C q Bc= 1
2
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The effect of coefficients on washoff is shown in the following figure:

Figure 6-6: Effect of Exponential Function Coefficients on Washoff

• Rating Curve Washoff: The rate of washoff W in mass per second is propor-
tional to the runoff rate raised to some power.

(6.5)

• Event Mean Concentration (EMC): This is a special case of Rating Curve 
Washoff where the exponent (C2) is 1.0 and the coefficient C1 represents the 
concentration of any and all runoff in mass per liter.

Where C1 = washoff coefficient

C2 = washoff exponent

Q = runoff rate, cfs (m3/s)

W C Qc= 1
2
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The effect of coefficients on washoff is shown in the following figure:

Figure 6-7: Effect of Rating Curve Coefficients on Washoff

This tab contains a table with the following attribute columns:

Column Description

Pollutant This menu contains all of the pollutants that have 
been defined in the Pollutants dialog box for the 
current project. Select the one that should be used 
for the land use currently highlighted in the list 
pane.

Washoff Function This menu allows you to specify which of the 
buildup functions described above will be used for 
the land use currently highlighted in the list pane.

Washoff Coefficient This field allows you to define C1 in the equations 
described above.
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Land Uses Collection Dialog Box

The Land Uses Collection dialog box lets you add multiple land uses as a collection to 
a catchment. You access the Land Uses Collection dialog box from the Property Editor 
for a catchment that uses EPA-SWMM Runoff as the runoff method.

The dialog box contains the following buttons: 

The Land Uses Collection dialog box also contains a table with the following 
columns:

Washoff Exponent This field allows you to define C2 in the 
Exponential and Rating Curve equations described 
above.

Cleaning Efficiency The fraction of available buildup for each 
pollutant removed by cleaning.

Removal Efficiency Washoff loads for a given pollutant and land use 
category can be reduced by a fixed percentage by 
specifying a Removal Efficiency in this field 
which reflects the effectiveness of any BMP 
controls associated with the land use.

New Adds a new row to the Land Uses 
table. Each row in the table contains a 
single land use entry.  

Delete  Deletes the current row from the Land 
Uses table.

Column Description

Catchment Land Use Lets you select a land use entry to include in the 
collection. Click in the row to select a land use 
entry from the drop-down menu, or click the 
Ellipses (...) button to create new land uses. 

Percent of Catchment 
Area (%) 

Lets you specify the percent of the catchment area 
affected by the land. 
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Adding Treatment to a Node

You can model the removal of pollutants from the flow entering any drainage system 
by assigning treatment functions to the node. In Bentley SewerGEMS V8i, you assign 
treatment functions to a node by adding a treatment collection, which contains one or 
more pollutants and their associated treatment expressions.

A treatment expression involves the pollutant concentration of the mixture of all flow 
streams entering the node (use the pollutant name to represent a concentration), or the 
removal of other pollutants (use R_ prefixed to the pollutant name to represent 
removal).

Treatment expressions have the general form:

R = f(P, R_P, V) 

or

C = f(P, R_P, V) 

Where:

R = fractional removal

C = outlet concentration

P = one or more pollutant names

R_P = one or more pollutant removals, (add R_ to the front of the pollutant name)

V = one or more of the following process variables:

– FLOW for flow rate into node (in user-defined flow units)  

– DEPTH for water depth above node invert (ft or m)  

– AREA for node surface area (ft2 or m2)  

– DT for routing time step (sec)  

– HRT for hydraulic residence time (hours)  

The result of the treatment function can be either a concentration (denoted by the letter 
C) or a fractional removal (denoted by R). For example, a first-order decay expression 
for BOD exiting from a storage node might be expressed as: 

C = BOD * exp(-0.05*HRT) 

or the removal of some trace pollutant that is proportional to the removal of total 
suspended solids (TSS) could be expressed as: 

R = 0.75 * R_TSS 
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To add a treatment collection to a node:

Note: Make sure you set the Engine Type to Explicit (SWMM 5) in the 
Calculation Options for your project before computing results.

1. Add a node to your model or select an existing node, then display the Property 
Editor for the node (double-click the node or press F4).

2. In the SWMM Extended Data section of the Property Editor, set Apply Treat-
ment? to True. The Treatment field becomes available.

3. Click the Ellipses (...) button in the Treatment field (where “<Collection: 0 
items>” is displayed) to display the Treatment Collection dialog box.

4. The Treatment Collection dialog box displays each pollutant and its associated 
treatment expression as a row in a table. Click the New button to add a row to the 
table.

5. Click in the Pollutant field, then select an existing pollutant from the drop-down 
menu, or click the Ellipses (...) button to display the Pollutants dialog box, where 
you define pollutants in your model.

6. Type a treatment expression in the Treatment column.

7. Repeat Steps 4 - 6 for each pollutant you wish to add to the treatment collection.

8. Click OK to close the dialog box and add the collection to the node.

Treatment Collection Dialog Box

The Treatment Collection dialog box lets you add multiple pollutants and their associ-
ated treatment expressions to a node for the purpose of removing pollutants in your 
model. You access this dialog box from the SWMM Extended Data section of the 
Property Editor for the selected node. 

The dialog box contains the following toolbar buttons: 

New Adds a new row to the Pollutants table. 
Click in the row to select an existing 
pollutant from the drop-down menu, or 
click the Ellipses (...) button to define 
new pollutants.

Delete Deletes the current row from the table.

Report Lets you view a report of the collection.
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The dialog box also contains the following controls: 

Initial Buildup Collection Dialog Box

The Initial Buildup Collection dialog box lets you specify the amount of pollutant 
buildup existing over a catchment at the start of the simulation. 

You access this dialog box from the SWMM Extended Data section of the Property 
Editor for the selected catchment. 

The dialog box contains the following toolbar buttons: 

The dialog box also contains the following table: 

Column Description

Pollutant Lets you add a pollutant to the collection. Click 
the down-arrow to select an existing pollutant 
from the drop-down menu, or click the Ellipses 
(...) button to define new pollutants.

Treatment Lets you type a valid treatment expression to the 
pollutant.

New Adds a new row to the Initial Buildup 
table. Click in the row to select an 
existing pollutant from the drop-down 
menu, or click the Ellipses (...) button to 
define new pollutants.

Delete Deletes the current row from the table.

Report Lets you view a report of the collection.

Column Description

Pollutant Lets you add a pollutant to the collection. Click 
the down-arrow to select an existing pollutant 
from the drop-down menu, or click the Ellipses 
(...) button to define new pollutants.
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Adding Hyperlinks to Elements
The Hyperlinks feature lets you associate external files, such as pictures or movie 
files, with elements. You can perform the following operations with hyperlinks:

• “Adding a Hyperlink” on page 6-326

• “Deleting a Hyperlink” on page 6-327

To use hyperlinks, select Tools > Hyperlink. The Hyperlink dialog box opens.

The hyperlink tool enables the user to associate a photo, word processing document, 
spreadsheet or other file with a given model element. Opening the hyperlink opens the 
file using its associated program (Picture Manager, Word, Excel, etc.). 

The hyperlink can also be opened from the Property grid by picking the Hyperlink 
property from the grid and clicking the ellipse button which will open the hyperlink 
tool.

If a model file is moved to a different computer, the hyperlink will no longer work 
unless the associated file is moved to a comparable path on the same computer.

Hyperlinks Dialog Box

The Hyperlinks dialog contains a toolbar and a tabular view of all your existing hyper-
links. 

Initial Buildup Lets you type an initial buildup value for the 
pollutant in the table row. If no buildup value is 
supplied for a pollutant, it is assumed to be 0.
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The toolbar contains the following buttons:

The table contains the following columns:

New Lets you create a new hyperlink. 
Launches the Add Hyperlink dialog box.

Delete Deletes the currently highlight hyperlink.

Edit Lets you edit the currently highlighted 
hyperlink. Launches the Edit Hyperlink 
dialog box.

Launch Launches the external file associated 
with the currently highlighted hyperlink.

Column Description

Element Type Displays the element type of the element 
associated with the hyperlink.

Element Displays the label of the element associated with 
the hyperlink. 

Link Displays the complete path of the hyperlink.

Description Displays a description of the hyperlink, which you 
can optionally enter when you create or edit the 
hyperlink.
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Adding a Hyperlink 

To add a hyperlink: 

Note: You can add more than one associated file to an element using 
the hyperlink feature, but you must add the associations one at a 
time. 

1. Select Tools > Hyperlink. The Hyperlink dialog box opens.

2. Click Add to add a hyperlink. The Add Hyperlink dialog box opens.

3. Select the element to which you want to associate an external file.

4. Browse to the external file you want to use. This might be something like a picture 
of the element or a movie about the element.

Add Hyperlink Dialog Box

You create new hyperlinks in the Add Hyperlink dialog box. The dialog box contains 
the following controls:

Editing a Hyperlink 

You can edit existing hyperlinks using the Edit Hyperlink dialog box.

Element Type Lets you select an element type from the drop-
down list.

Element Lets you select an element from a drop-down list 
of specific elements from your model. Only those 
element types selected in the Element Type drop-
down list are displayed. 

Link Lets you enter the complete path of the external 
file you want to associate with the selected 
element. You can type the path yourself or click 
the Ellipsis (...) button to search your computer 
for the file. 
Once you have selected the file, you can 
test the hyperlink by clicking the Launch 
button. 

Description Lets you type a description of the hyperlink.
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To edit a hyperlink: 

1. Select Tools > Hyperlink. The Hyperlink dialog box opens.

2. Select the hyperlink you want to edit.

3. Click Edit to modify a hyperlink. The Edit Hyperlink dialog box opens.

4. Select the element you want to edit.

5. Edit the hyperlink by adding or deleting an associated file.

Edit Hyperlink Dialog Box

You edit existing hyperlinks in the Edit Hyperlink dialog box. The dialog box contains 
the following controls:

Deleting a Hyperlink 

To delete a hyperlink:

1. Select Tools > Hyperlink. The Hyperlink dialog box opens.

2. Select the hyperlink you want to edit.

3. Click Edit to modify a hyperlink. The Edit Hyperlink dialog box opens.

4. Select the element you want to delete.

5. Click Delete.

Using Queries
A query in Bentley SewerGEMS V8i is a user-defined SQL expression that applies to 
a single element type. You use the Queries Manager to create and store queries; you 
use the Query Builder dialog box to construct the actual SQL expression. 

Link Lets you edit the complete path of the external file 
associated with the selected hyperlink. You can 
type the path yourself or click the Ellipsis (...) 
button to search your computer for the file. 
Once you have selected the file, you can 
test the hyperlink by clicking the Launch 
button. 

Description Lets you edit an existing description of the 
hyperlink or type a new description.
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You can create the following types of queries:

• Project queries—Queries you define that are available only in the Bentley Sewer-
GEMS V8i project in which you define them.

• Shared queries—Queries you define that are available in all Bentley SewerGEMS 
V8i projects you create. You can edit shared queries.

• Predefined queries—Factory-defined queries included with Bentley SewerGEMS 
V8i that are available in all projects you create. You cannot edit predefined 
queries.

You can also use queries in the following ways:

• Create dynamic selection sets based on one or more queries. For more informa-
tion, see “Creating a Selection Set from a Query” on page 6-277.

• Filter the data in a FlexTable using a query. For more information, see “Sorting 
and Filtering FlexTable Data” on page 10-566.

For more information on how to construct queries, see “Creating Queries” on page 6-
330.

Queries Manager

The Queries Manager is a docking manager that displays all queries in the current 
project, including predefined, shared, and project queries. You can create, edit, or 
delete shared and project queries from within the Queries Manager, as well as use it to 
select all elements in your model that are part of the selected query.

The Queries Manager consists of a toolbar and a tree view, which displays all of the 
queries that are associated with the current project. The toolbar contains the following 
buttons:
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Query Parameters Dialog Box 

Some predefined queries require that a parameter be defined. When one of these 
queries is selected, the Query Parameters dialog box will open, allowing you to type 
the parameter value that will be used in the query. For example, when the Pipe Split 
Candidates query is used the Query Parameters dialog will open, allowing the Toler-
ance parameter to be defined.

New Contains the following commands:

• Query—Lets you create a new SQL 
expression as either a project or shared 
query, depending on which item is high-
lighted in the tree view.

• Folder—Creates a folder in the tree 
view, allowing you to group queries. You 
can right-click a folder and create 
queries or folders in that folder.

Delete Deletes the currently-highlighted query or 
folder from the tree view. When you delete a 
folder, you also delete all of its contents (the 
queries it contains).

Rename Lets you rename the query or folder that is 
currently highlighted in the tree view.

Edit Opens the Query Builder dialog box, 
allowing you to edit the SQL expression that 
makes up the currently-highlighted query.

Expand All and 
Collapse All

Expands or collapses the named views and 
folders.

Select in Drawing Lets you quickly select all the elements in 
the drawing pane that are part of the 
currently highlighted query. Once you have 
selected the elements in a selection set using 
Select In Drawing, you can delete them all 
at once.

Help Displays online help for the Queries 
Manager.
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Creating Queries

A query is a valid SQL expression that you construct in the Query Builder dialog box. 
You create and manage queries in the Queries Manager. You also use queries to filter 
FlexTables and as the basis for a selection set.

To create a query from the Queries Manager:

1. Open the Queries Manager by selecting View > Queries, clicking the Queries 
button on the View toolbar, or by pressing CTRL+5.
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2. Perform one of the following steps:

– To create a new project query, highlight Queries - Project in the list pane, 
then click the New button and select Query.

– To create a new shared query, highlight Queries - Shared in the list pane, 
then click the New button and select Query.

Note: You can also right-click an existing item or folder in the list pane 
and select New > Query from the shortcut menu.

3. In the Select Element Type dialog box, select the desired element type from the 
drop-down menu. The Query Builder dialog box appears.

4. All input and results fields for the selected element type appear in the Fields list 
pane, available SQL operators and keywords are represented by buttons, and 
available values for the selected field are listed in the Unique Values list pane. 
Perform the following steps to construct your query:

a. Double-click the field you wish to include in your query. The database 
column name of the selected field appears in the preview pane.

b. Click the desired operator or keyword button. The SQL operator or keyword 
is added to the SQL expression in the preview pane.

c. Click the Refresh button above the Unique Values list pane to see a list of 
unique values available for the selected field. Note that the Refresh button is 
disabled after you use it for a particular field (because the unique values do 
not change in a single query-building session).

d. Double-click the unique value you want to add to the query. The value is 
added to the SQL expression in the preview pane.

Note: You can also manually edit the expression in the preview pane.

e. Click the Validate button above the preview pane to validate your SQL 
expression. If the expression is valid, the word “VALIDATED” is displayed in 
the lower right corner of the dialog box.

f. Click the Apply button above the preview pane to execute the query. If you 
didn’t validate the expression, the Apply button validates it before executing 
it.

g. Click OK.
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5. Perform these optional steps in the Queries Manager:

– To create a new folder in the tree view, highlight the existing item or folder in 
which to place the new folder, then click the New button and select Folder. 
You can create queries and folders within folders.

– To delete an existing query or folder, click the Delete button. When you delete 
a folder, you also delete all of its contents (the queries it contains).

– To rename an existing query or folder, click the Rename button, then type a 
new name.

– To edit the SQL expression in a query, select the query in the list pane, then 
click the Edit button. The Query Builder dialog box appears.

– To quickly select all the elements in the drawing pane that are part of the 
currently highlighted query, click the Select in Drawing button.

Query Builder Dialog Box

You construct the SQL expression that makes up your query in the Query Builder 
dialog box. The Query Builder dialog box is accessible from the Queries Manager and 
from within a FlexTable. 

Preview pane

Validate 
button

Apply button

Click the desired operator 
or keyword button to add it 
to the SQL expression in 
the preview pane

Double-click the 
desired field to add it 
to the preview pane

Double-click the 
desired unique 
value to add it to 
the SQL 
expression in the 
preview pane

Click the Refresh 
button to display the 
list of available 
unique values
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The top part of the dialog box contains all the controls you need to construct your 
query: a list pane displaying all available attributes for the selected element type, a 
SQL control panel containing available SQL keywords and operators, and list view 
that displays all the available values for the selected attribute. The bottom part of the 
dialog box contains a preview pane that displays your SQL expression as you 
construct it.

All the dialog box controls are described in the following table. 

Fields Lists all input and results fields 
applicable to the selected element type. 
This list displays the labels of the 
fields, while the underlying database 
column names of the fields become 
visible in the preview pane when you 
add them to the expression. Double-
click a field to add it to your SQL 
expression.

SQL Controls These buttons represent all the SQL 
operators and controls that you can use 
in your query. They include =, >, <, _, 
?, *, <>, >=, <=, [ ], Like, And, and 
Or. Click the appropriate button to add 
the operator or keyword to the end of 
your SQL expression, which is 
displayed in the preview pane.

Unique Values When you click the Refresh button, 
this list displays all the available 
unique values selected field. Double-
click a value in the list to add it to the 
end of your SQL expression, which is 
displayed in the preview pane. If you 
select a different field, you must click 
the Refresh button again to update the 
list of unique values for the selected 
field. When you first open the Query 
Builder dialog box, this list is empty.

Refresh Updates the list of unique values for 
the selected field. This button is 
disabled after you use it for a particular 
field.

Copy Copies the entire SQL expression 
displayed in the preview pane to the 
Windows clipboard.
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Using the Like Operator

The Like operator compares a string expression to a pattern in an SQL expression.

Syntax

expression Like “pattern”

The Like operator syntax has these parts:

You can use the Like operator to find values in a field that match the pattern you 
specify. For pattern, you can specify the complete value (for example, Like 
“Smith”), or you can use wildcard characters to find a range of values (for example, 
Like “Sm*”).

Paste Pastes the contents of the Windows 
clipboard into the preview pane at the 
location of the text cursor. For 
example, if your cursor is at the end of 
the SQL expression in the preview 
pane and you click the Paste button, 
the contents of your clipboard will be 
added to the end of the expression.

Validate Validates the SQL expression in the 
preview pane. If the expression is not 
valid, a message appears. When you 
click this button and your SQL 
expression passes validation, the word 
“VALIDATED” appears in the lower 
right corner of the dialog box.

Apply Executes the query. The results of the 
query are displayed at bottom of the 
Query Builder dialog box in the form 
“x of x elements returned.”

Preview Pane Displays the SQL expression as you 
add fields, operators and/keywords, 
and values to it.

Part Description

expression SQL expression used in a WHERE clause .

pattern String or character string literal against which expression is 
compared.
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In an expression, you can use the Like operator to compare a field value to a string 
expression. For example, if you enter Like “C*” in an SQL query, the query returns 
all field values beginning with the letter C. In a parameter query , you can prompt the 
user for a pattern to search for.

The following example returns data that begins with the letter P followed by any letter 
between A and F and three digits:

Like “P[A-F]###”

The following table shows how you can use Like to test expressions for different 
patterns.

User Data Extensions
User data extensions are a set of one or more attribute fields that you can define to 
hold data to be stored in the model. User data extensions allow you to add your own 
data fields to your project. For example, you can add a field for keeping track of the 
date of installation for an element, or the type of area serviced by a particular element.

Kind of match Pattern
Match
(returns True)

No match
(returns False)

Multiple characters a*a aa, aBa, aBBBa aBC

*ab* abc, AABB, Xab aZb, bac

Special character a[*]a a*a aaa

Multiple characters ab* abcdefg, abc cab, aab

Single character a?a aaa, a3a, aBa aBBBa

Single digit a#a a0a, a1a, a2a aaa, a10a

Range of characters [a-z] f, p, j 2, &

Outside a range [!a-z] 9, &, % b, a

Not a digit [!0-9] A, a, &, ~ 0, 1, 9

Combined a[!b-m]# An9, az0, a99 abc, aj0
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Note: The user data does not affect the hydraulic model calculations. 
However, their behavior concerning capabilities like editing, 
annotating, sorting and database connections is identical to any 
of the standard pre-defined attributes.  

User data extensions exhibit the same characteristics as the predefined data used in 
and produced by the model calculations. This means that user data extensions can be 
imported or exported through database and shapefile connections, viewed and edited 
in the Property Editor or in FlexTables, included in tabular reports or element detailed 
reports, annotated in the drawing, color coded, and reported in the detailed element 
reports.

Note: The terms “user data extension” and “field” are used 
interchangeably here. In the context of the User Data Extension 
feature, these terms mean the same thing.

You define user data extensions in the User Data Extensions dialog box.

To define a user data extension:

1. Select Tools > User Data Extensions.

2. In the list pane on the left, select the element type for which you want to define a 
new attribute field.

3. Click the New button to create a new user data extension. A user data extension 
with a default name appears under the element type. You can rename the new field 
if you wish.

4. In the Property Editor for the new field, enter the following:

– Type the name of the new field. This is the unique identifier for the field. The 
name field in the Property Editor is the name of the column in the data source.

– Type the label for the new field. This is the label that will appear next to the 
field for the user data extension in the Property Editor for the selected element 
type. This is also the column heading if the data extension is selected to 
appear in a FlexTable.

– Click the Ellipses (...) button in the Category field, then use the drop-down 
menu in the Select Category dialog box to select an existing category in which 
the new field will appear in the Property Editor. To create a new category, 
simply type the category name in the field.

– Type a number in the Field Order Index field. This is the display order of 
fields within a particular category in the Property Editor. This order also 
controls the order of columns in Alternative tables. An entry of 0 means the 
new field will be displayed first within the specified category.

– Type a description for the field. This description will appear at the bottom of 
the Property Editor when the field is selected for an element in your model. 
You can use this field as a reminder about the purpose of the field.
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– Select an alternative from the drop-down menu in the Alternative field. This is 
the alternative that you want to extend with the new field. 

– Select a data type from the drop-down menu in the Data Type field.

- If you select Enumerated, an Ellipses (...) button appears in the Default 
Value field. Enumerated user data extensions are fields that present 
multiple choices.

– Enter the default value for the new field. If the data type is Enumerated, click 
the Ellipses (...) button to display the Enumeration Editor dialog box, where 
you define enumerated members.

5. Perform the following optional steps:

– To import an existing User Data Extension XML File, click the Import 
button, then select the file you want to import. User Data Extension XML 
Files contain the file name extension .xml or .udx.xml.

– To export existing user data extensions, click the Export to XML button, then 
type the name of the udx.xml file. All user data extensions for all element 
types defined in the current project are exported.

– To share the new field among two or more element types, select the user data 
extension in the list pane, then click the Sharing button or right-click and 
select Sharing. In the Shared Field Specification dialog box, select the check 
box next to the element or elements that will share the user data extension. 
The icon next to the user data extension changes to indicate that it is a shared 
field. For more information, see “Sharing User Data Extensions Among 
Element Types” on page 6-342.

– To delete an existing user data extension, select the user data extension you 
want to delete in the list pane, then click the Delete button, or right-click and 
select Delete.

– To rename a the display label of an existing user data extension, select the 
user data extension in the list pane, click the Rename button or right-click and 
select Rename, then type the new display label.

– To expand the list of elements and view all user data extensions, click the 
Expand All button.

– To collapse the list of elements so that no user data extensions are displayed, 
click the Collapse All button.

6. Click OK to close the dialog box and save your user data extensions. The new 
field(s) you created will appear in the Property Editor for every instance of the 
specified element type in your model.
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User Data Extensions Dialog Box

The User Data Extensions dialog box displays a summary of the user data extensions 
associated with the current project. The dialog box contains a toolbar, a list pane 
displaying all available Bentley SewerGEMS V8i element types, and a property 
editor. The toolbar contains the following controls:

Import Lets you merge the user data 
extensions in a saved User Data 
Extension XML file (.udx.xml or 
.xml) into the current project. 
Importing a User Data Extension 
XML file will not remove any of the 
other data extensions defined in your 
project. User data extensions that 
have the same name as those already 
defined in your project will not be 
imported.

Export to XML Lets you save existing user data 
extensions for all element types in 
your model to a User Data Extension 
XML file (.udx.xml) for use in a 
different project.

New Lets you create a new user data 
extension for the currently 
highlighted element type.

Sharing Lets you share the current user data 
extension with another element type. 
When you click this button, the 
Shared Field Specification dialog 
box opens. For more information, 
see “Sharing User Data Extensions 
Among Element Types” on page 6-
342.
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The Property Editor contains the following controls:

and the following fields, which define your new user data extension:

Delete Deletes the currently highlighted 
user data extension

Rename Lets you rename the display label of 
the currently highlighted user data 
extension.

Expand All Expands all of the branches in the 
hierarchy displayed in the list pane.

Collapse All Collapses all of the branches in the 
hierarchy displayed in the list pane.

Alphabetized Displays the attribute fields in the 
Property Editor in alphabetical 
order.

Categorized Displays the attribute fields in the 
Property Editor in categories. This 
is the default.

Table 6-7: 

Attribute Description

General

Name The unique identifier for the field. The name field in the 
Property Editor is the name of the column in the data source.

Label The label that will appear next to the field for the user data 
extension in the Property Editor for the selected element type. 
This is also the column heading if the data extension is 
selected to appear in a FlexTable.

Category The section in the Property Editor for the selected element 
type in which the new field will appear. You can create a new 
category or use an existing category. For example, you can 
create a new field for manholes and display it in the Physical 
section of that element’s Property Editor.
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Field Order 
Index

The display order of fields within a particular category in the 
Property Editor. This order also controls the order of columns 
in Alternative tables. An entry of 0 means the new field will be 
displayed first within the specified category.

Field 
Description

The description of the field. This description will appear at the 
bottom of the Property Editor when the field is selected for an 
element in your model. You can use this field as a reminder 
about the purpose of the field.

Alternative Lets you select an existing alternative to extend with the new 
field.

Referenced 
By

Displays all the element types that are using the field. For 
example, if you create a field called "Installation Date" and you 
set it up to be shared, this field will show the element types that 
share this field. So for example, if you set up a field to be 
shared by manholes and catch basins, the Referenced By field 
would show "Manhole, Catch Basin".

Units

Data Type Lets you specify the data type for the user data extension. 
Click the down arrow in the field then select one of the 
following data types from the drop-down menu:
• Integer—Any positive or negative whole number.

• Real—Any fractional decimal number (for example, 3.14). 
It can also be unitized with the provided options.

• Text—Any string (text) value up to 255 characters long.

• Long Text—Any string (text) up to 65,526 characters long.

• Date/Time—The current date. The current date appears 
by default in the format month/day/year. Click the down 
arrow to change the default date.

• Boolean—True or False.

• Enumerated—When you select this data type, an Ellipses 
button appears in the Default Value field. Click the 
Ellipses (...) button to display the Enumeration Editor 
dialog box, where you can add enumerated members and 
their associated values. For more information, see 
“Enumeration Editor Dialog Box” on page 6-344.

Table 6-7: 

Attribute Description
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Default Value The default value for the user data extension. The default 
value must consistent with the selected data type. If you chose 
Enumerated as the data type, click the Ellipses (...) button to 
display the Enumeration Editor.

Dimension Lets you specify the unit type. Click the drop-down arrow in the 
field to see a list of all available dimensions. This field is 
available only when you select Real as the Data Type.

Storage Unit Lets you specify the storage units for the field. Click the drop-
down arrow in the field to see a list of all available units; the 
units listed change depending on the Dimension you select. 
This field is available only when you select Real as the Data 
Type.

Numeric 
Formatter

Lets you select a number format for the field. Click the drop-
down arrow in the field to see a list of all available number 
formats; the number formats listed change depending on the 
Dimension you select. For example, if you select Flow as the 
Dimension, you can select Flow, Flow - Pressurized Condition, 
Flow Tolerance, or Unit Load as the Numeric Formatter. This 
field is available only when you select Real as the Data Type.

Table 6-7: 

Attribute Description
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User Data Extensions Import Dialog Box

The Import dialog box opens after you initiate an Import command and choose the 
xml file to be imported. The Import dialog displays all of the domain elements 
contained within the selected xml file. Uncheck the boxes next to a domain element to 
ignore them during import.

Sharing User Data Extensions Among Element Types

You can share user data extensions across multiple element types in Bentley Sewer-
GEMS V8i. Shared user data extensions are displayed in the Property Editor for all 
elements types that share that field.

The icons displayed next to the user data extensions in the User Data Extensions 
dialog box change depending on the status of the field:

• Indicates a new unsaved user data extension.

• Indicates a user data extension that has been saved to the data source. 

• Indicates a user data extension that is shared among multiple element types 
but has not been applied to the data source.

• Indicates a user data extension that is shared among multiple element types 
and that has been applied to the data source. Fields with this icon appear in 
the Property Editor for any elements of the associated element types that appear in 
your model.
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Observe the following rules when sharing user data extensions:

• You can select any number of element types with which to share the field. The list 
is limited to element types that support the Alternative defined for the Field. For 
example, the Physical Alternative may only apply to five of the element types.  In 
this case, you will only see these five items listed in the Alternative drop-down 
menu.

• You cannot use the sharing feature to move a field from one element type to 
another. Validation is in place to ensure that only one item is selected and if it is 
the same as the original, default selection. If it is not, a message appears telling 
you that when sharing a field, you must select at least two element types, or select 
the original element type.

• To unshare a field that is shared among multiple element types, right-click the user 
data extension you want to keep in the list pane, then select Sharing. Clear all the 
element types that do not want to share the field with and click OK. If you leave 
only one element type checked in the Shared Field Specification dialog box, it 
must be the original element type for which you created the user data extension.

– The fields that were located under the catch basin and conduit element type 
root nodes will be removed completely.

– You can also unshare a field by using the Delete button or right-clicking and 
selecting Delete. This will unshare and delete the field.

To share a user data extension:

1. Open the User Data Extensions dialog box by selecting Tools > User Data Exten-
sions.

2. In the list pane, create a new user data extension to share or select an existing user 
data extension you want to share, then click the Sharing button. 

3. In the Shared Field Specification dialog box, select the check box next to each 
element type that will share the user data extension.

4. Click OK.

5. The icon next to the user data extension in the list pane changes to indicate that it 
is a shared field.

Shared Field Specification Dialog Box

You select element types to share a user data extension in the Shared Field Specifica-
tion dialog box. The dialog box contains a list of all possible element types with check 
boxes. 
Bentley SewerGEMS V8i User’s Guide 6-343



User Data Extensions
Select element types to share the current user data extension by selecting the check 
box next to the element type. Clearing a selection if you no longer want that element 
type to share the current field.

Enumeration Editor Dialog Box

The Enumeration Editor dialog box appears when you select Enumerated as the Data 
Type for a user data extension, then click the Ellipses (...) button in the Default Value 
field. Enumerated fields are fields that contain multiple selections - you define these 
as members in the Enumeration Editor dialog box. 

For example, suppose you want to identify conduits in a model of a new subdivision 
by one of the following states: Existing, Proposed, Abandoned, Removed, and 
Retired. You can define a new user data extension with the label “Pipe Status” for 
conduits, and select Enumerated as the data type. Click the Ellipses (...) button in the 
Default Value field in the Property Editor for the user data extension to display the 
Enumeration Editor dialog box. Then enter five members with unique labels (one 
member for each unique pipe status) and enumeration values in the table. After you 
close the User Data Extensions dialog box, the new field and its members will be 
available in the Property Editor for all conduits in your model. You will be able to 
select any of the statuses defined as members in the new Pipe Status field.

You can specify an unlimited number of members for each user data extension, but 
member labels and values must be unique. If they are not unique, an error message 
appears when you try to close the dialog box.

The dialog box contains a table and the following controls:

• New—Lets you add a new row to the table. Each row in the table represents a 
unique enumerated member of the current user data extension.

• Delete—Deletes the current row from the table. The enumerated member defined 
in that row is deleted from the user data extension.

You define enumerated members in the table, which contains the following columns:

• Enumeration Member Display Label—The label of the member. This is the 
label you will see in Bentley SewerGEMS V8i where ever the user data extension 
appears (Property Editor, FlexTables, etc.).

• Enumeration Value—A unique integer index associated with the member label. 
Bentley SewerGEMS V8i uses this number when it performs operations such as 
queries.
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External Tools
Use the External Tool Manager to manage custom menu commands, which are then 
located in the Tools menu for quick accessibility. 

Click Tools>External Tools to create a custom menu command from any executable 
file. Executable file types include: 

• .exe

• .com

• .pif

• .bat

• .cmd

The External Tool Manager consists of the following elements: 

• External Tool List Pane—This pane lists the external tools that have been 
created. All of the tools listed in this pane will be displayed in the Tools > 
External Tools menu. 

• New—Creates a new external tool in the list pane. 

• Delete—Deletes the currently highlighted tool. 

• Rename—Allows you to rename the currently highlighted tool.

• Command—This field allows you to enter the full path to the executable file that 
the tool will initiate. Click the ellipsis button to open a Windows Open dialog to 
allow you to browse to the executable.

• Arguments—This optional field allows you to enter command line variables that 
are passed to the tool or command when it is activated. Click the > button to open 
a submenu containing predefined arguments. Arguments containing spaces must 
be enclosed in quotes. The available arguments are: 

– Project Directory—This argument passes the current project directory to the 
executable upon activation of the tool. The argument string is %(ProjDir).

– Project File Name—This argument passes the current project file name to the 
executable upon activation of the tool. The argument string is %(ProjFile-
Name).

– Project Store File Name—This argument passes the current project datastore 
file name to the executable upon activation of the tool. The argument string is 
%(ProjStoreFileName).

– Working Directory—This argument passes the current working directory to 
the executable upon activation of the tool. The argument string is %(Proj-
WorkDir).
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• Initial Directory—Specifies the initial or working directory of the tool or 
command. Click the > button to open a submenu containing predefined directory 
variables. The available variables are: 

– Project Directory—This variable specifies the current project directory as 
the Initial Directory. The variable string is %(ProjDir).

– Working Directory—This variable specifies the current working directory as 
the Initial Directory. The variable string is %(ProjWorkDir).

Test—This button executes the external tool using the specified settings.

Hydraulic Reviewer Tool
This version of SewerGEMS V8i includes a hydraulic reviewer tool to quickly assess 
the convergence and stability of the model. To begin using the tool click

Tools > Hydraulic Reviewer. 

This opens a dialog which initially looks like this.

The user first selects the name of the scenario for which the hydraulic reviewer will be 
performed using a drop down list of scenarios. The calculation of the scenario must 
already have been run and the output file should not have been deleted.

Once the scenario has been selected, the user chooses between two tabs

Storage Element Volume Balance 

The Storage Element Volume Balance tab determines the overall balance of flows at 
any node which can have storage which can include

• Wet Wells 
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• Catch basins

• Manholes

• Ponds

The user can also use a drop down list of any previously created selection set of node 
elements on which to perform the review. The default is All Active Nodes.

Picking the green Go arrow starts the calculation which for each node determines the 
inflow, outflow and overflow volumes over the course of the runs and the percent 
deviation from perfect flow balance as

Flow Deviation (node) = 100% (In - out - over - change in storage)/Duration

Deviation (node) = 100% (In - out - over - change in storage)/In

Deviation (system) = 100% (In - out - over - change in storage)/Total System Inflow

The results are presented in decreasing order based on Error. Any column can be 
sorted, filtered or have the display format changed as with any other flex table.

On some occasions the Deviation (node)  may appear large but this is primarily due to 
the inflow volume being very small. Users may want to discount the importance of 
any errors at nodes where the inflow rates (and deviations) are on the order of 0.1 cfs 
or less.

Pipe Flow Statistics 

The Pipe flow statistics tab provides an indication of the change of flow rates from 
one time step to the next. 
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To use this tab, the user can chose All Pipes (the default) or any selection set of pipes. 
The calculation is run by picking the green Go arrow. It will display a table like the 
one below, sorted in order of decreasing Maximum Deviation.

High values for Maximum Deviation do not necessarily indicate that the model 
contains errors or is unstable. Some pipe links have very large changes in flow from 
one time step to another such as in the case of a pump cycling on an off. In some 
cases, numerical models can overshoot the calculated flow when the flow rate changes 
abruptly. This effect usually dies out after one or two time steps. Nevertheless, the 
Maximum Deviation can serve as an indicator of locations with possible stability 
issues.

Once the calculations have been performed, the user can export the values to a previ-
ously created User Defined Property so that the values can be used in color coding, 
flex tables, etc. Click on Export to Model to reach the dialog below and select Export 
to actually export the numerical values.

If the user defined property doesn't exist, the user can create one by picking the ellipse 
button and following the instructions for user data extensions.

TRex Wizard
The TRex Wizard steps you through the process of automatically assigning elevations 
to specified nodes based on data from a Digital Elevation Model or a Digital Terrain 
Model. 
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Step 1: File Selection

The DEM, DTM, DDF, or SHP (contour shapefile) file, the SewerGEMS V8i model, 
and the features to which elevations will be assigned are specified. 

• Data Source Type—This menu allows you to choose the type of file that contains 
the input data you will use.

• File—This field displays the path where the DXF, XML, or SHP file is located. 
Use the browse button to find and select the desired file.

• Spatial Reference (ArcGIS Mode Only)—Click the Ellipsis (...) next to this 
field to open the Spatial Reference Properties dialog box, allowing you to specify 
the spatial reference being used by the elevation data file.

• Select Elevation Field—Select the elevation unit.

• X-Y Units—This menu allows the selection of the measurement unit type associ-
ated with the X and Y coordinates of the elevation data file.

• Z Units—This menu allows the selection of the measurement unit type associated 
with the Z coordinates of the elevation data file.

• Clip Dataset to Model—In some cases, the data source contains elevation data 
for an area that exceeds the dimensions of the area being modeled. When this box 
is checked, TRex will calculate the model’s bounding box, find the larger dimen-
sion (width or height), calculate the Buffering Percentage of that dimension, and 
increase both the width and height of the model bounding box by that amount. 
Then any data point that falls outside of the new bounding box will not be used to 
generate the elevation mesh. If this box isn’t checked, all the source data points 
are used to generate the elevation mesh. Checking this box should result in faster 
calculation speed and use less memory. 

• Buffering Percentage—This field is only active when the Clip Dataset to Model 
box is checked. The percentage entered here is the percentage of the larger dimen-
sion (width or height) of the model’s bounding box that will be added to both the 
bounding box width and height to find the area within which the source data 
points will be used to build the elevation mesh.

• Spatial Reference (ArcGIS Mode Only)—Click the Ellipsis (...) next to this 
field to open the Spatial Reference Properties dialog box, allowing you to specify 
the spatial reference being used by the SewerGEMS V8i model file.

• Also update inactive elements—Check this box to include inactive elements in 
the elevation assignment operation. When this box is unchecked, elements that are 
marked Inactive will be ignored by TRex.

• All—When this button is selected, TRex will attempt to assign elevations to all 
nodes within the SewerGEMS V8i model.

• Selection—When this button is selected, TRex will attempt to assign elevations to 
all currently highlighted nodes.
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• Selection Set—When this is selected, the Selection Set menu is activated. When 
the Selection Set button is selected, TRex will assign elevations to all nodes 
within the selection set that is specified in this menu.

Note: If the SewerGEMS V8i model (which may or may not have a 
spatial reference explicitly associated with it) is in a different 
spatial reference than the DEM/DTM (which does have a spatial 
reference explicitly associated with it), then the features of the 
model will be projected from the model’s spatial reference to the 
spatial reference used by the DEM/DTM.
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Step 2: Completing the TRex Wizard

The results of the elevation extraction process are displayed and the results can be 
applied to a new or existing physical alternative. 

• Results Preview Pane—This tabular pane displays the elevations that were 
calculated by TRex. The table can be sorted by label by clicking the Label column 
heading and by elevation by clicking the Elevation column heading. You can filter 
the table by right-clicking a column in the table and selecting the Filter...Custom 
command. You can also right-click any of the values in the elevation column to 
change the display options.

• Use Existing Alternative—When this is selected, the results will be applied to 
the physical alternative that is selected in the Use Existing Alternative menu. This 
menu allows the selection of the physical alternative to which the results will be 
applied. 

• New Alternative —When this is selected, the results will be applied to a new 
physical alternative. First, the currently active physical alternative will be dupli-
cated, then the results generated by TRex will be applied to the newly created 
alternative. The name of this new alternative must be supplied in the New Alter-
native text field.

• Parent Alternative—Select an alternative to duplicate from the menu, or select 
<None> to create a new Base alternative.

• Export Results—This exports the results generated by TRex to a tab or comma-
delimited text file (.TXT). These files can then be re-used by SewerGEMS V8i or 
imported into other programs.

• Click Finish when complete, or Cancel to close without making any changes.
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Chapter

Loading
• “Sanitary (Dry Weather) Flow Collections” on page 7-390

• “LoadBuilder” on page 7-393

Loading
The word "loading" is used in Bentley SewerGEMS V8i to describe flow entering the 
sewer system. Depending on the type of system, available data and level of detail, 
there are numerous ways of loading Bentley SewerGEMS V8i models. Some of the 
distinctions relate to whether the system is a combined or sanitary system, whether the 
loads are existing with flow data or proposed loads with only land use descriptions, 
whether the flow refers to dry weather sanitary flows or wet weather flow.

Note: For more information on loading, see Chapter 6 "Dry weather 
wastewater flows" and Chapter 7 "Wet weather wastewater 
flows" in the book Wastewater Collection System Modeling and 
Design" by Haestad Press.

With the exception of known fixed flows, the loading to the model consists of a table 
of flow or pattern values vs. time. The generic word "collection"  is used to describe 
inputs to Bentley SewerGEMS V8i that are not a single value but are some type of 
table. For example, you will see Inflow Collections, which are simply a table of inflow 
vs. time.

Methods for Entering Loads

There are several methods for entering loads into Bentley SewerGEMS V8i. In 
general, most of the methods described can be applied to any node type element (i.e. 
manhole, cross section, catch basin, pond, pressure junction but not outfall). Some 
such as stormwater loading must be applied to catchments and conduit infiltration can 
only be applied to conduits. They are summarized below and described in more detail 
later in this chapter.

• Inflow consists of data which may be:
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– Known constant flow

– Hydrograph - flow vs. time

– Pattern Load - baseline flow times multiplier

In general, the hydrograph input is used for wet weather events while pattern 
loads are used for sanitary flows which repeat from one day to the next. For more 
information, see “Inflows” on page 7-377.

• Sanitary loading consists of data which may be 

– Know constant flow

– Hydrograph - flow vs. time

– Pattern Load - baseline flow times multiplier

– Unit loads - number of units (e.g. houses) times unit load (e.g. flow/house/
day)

Sanitary loads are generally used to describe dry weather contribution to flow 
from domestic, commercial and industrial customers. For more information, see 
“Sanitary (Dry Weather) Flow Collections” on page 7-390.

• Load Builder consists of using the LoadBuilder model to place loads on nodes 
using ArcGIS functions. Unlike the methods above which are applicable when the 
loads are already known for each node, LoadBuilder is used when the loading data 
is not yet associated with individual nodes. For example, the data can be in the 
form of:

– Customer water use billing data

– Area-wide flow measurement

– Load  (e.g. population or land use assigned to polygons) times unit loading 
factors (e.g. flow/day/area)

This method must be started from ArcMap or ArcCatalog. For more information, 
see “LoadBuilder” on page 7-393.

• Rainfall Derived Infiltration and Inflow in Sanitary Systems (RDII) lets you load 
sanitary systems with I/I flow based on flow monitoring data. This usually 
involves entering a precipitation event and comparing the predicted catchment 
outflow with the model results. You can adjust the catchment parameters to match 
the observed outflow using generic unit hydrographs or RTK method. For more 
information, see “Rainfall Derived Infiltration and Inflow (RDII)” on page 7-394.

• Stormwater flow can be used to model inflow into a collection system based on 
rainfall events and any number of hydrologic models including:

– Generic unit hydrographs
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– SCS unit hydrograph 

– Modified rational method

– SWMM runoff method

Losses (i.e. precipitation not entering runoff) can be modeled using several 
methods including:

– SCS 

– Green Ampt

– Horton

– fLoss

These methods can be used for modeling stormwater collection systems and 
combined sewer systems but not sanitary systems because they do not account for 
the defects which allow wet weather flow to enter sanitary systems. These 
methods can only be applied to catchment elements, not other node elements. For 
more information, see “Stormwater Flow” on page 7-394.
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• Conduit infiltration can be used to model infiltration into pipes along the length of 
the pipe. This can be specified as:

– Known unit flow based on Length, Area, Diameter-length, or Count.

– Hydrograph

– Pattern

For more information, see “Pipeline Infiltration” on page 7-427.

Summary

In general:

• Dry weather load can be entered using Inflow, Sanitary Loading and LoadBuilder.

• Wet weather flow in sanitary systems can be entered using inflow, RDII or conduit 
infiltration.

• Wet weather flow in stormwater and combined systems can be entered using 
Inflow, Stormwater flow or Conduit infiltration.

Types of Loads
Within each of the loading methods available in Bentley SewerGEMS V8i, there are 
several ways to enter (add) data. For example, under the method Inflow for loading 
the model, there are three types of inflow - fixed, hydrograph and pattern load. These 
loading types may be used by several methods. For example, pattern loading is used 
by the Inflow, Sanitary and Pipeline Infiltration methods. The dialogs for each of these 
types are the same regardless of the method being used.
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The following table illustrates which types of loads are available in each method.

*LoadBuilder used GIS based calculations described in [hot link].

*Conduit infiltrations uses fixed flows on a per length or area basis.

• “Hydrograph vs. Pattern Loads” on page 7-358

• “Pattern Loads” on page 7-360

• “Unit Sanitary Loading” on page 7-367

Adding Fixed Loads

A fixed load can be entered as a:

• Known flow under sanitary loading

• Pattern load with the multiplier set to 1

• Hydrograph inflow with "fixed" specified

• “Hydrograph vs. Pattern Loads” on page 7-358

• “Pattern Loads” on page 7-360

Table 7-1: Types of Loads

Method

Inflow X X X

Sanitary Load X X X X

LoadBuilder *

RDII Inflow X X

Stormwater X X X X

Conduit infiltration * X X X
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• “Unit Sanitary Loading” on page 7-367

Hydrograph vs. Pattern Loads

Hydrographs and pattern loads are two distinct ways to describe how flow varies over 
time.  Ultimately, you can attain the same results using either type but there are some 
behavioral and semantic differences that should be noted.

Pattern loads consists of a single average base load and a series of dimensionless 
multipliers used to delineate how the load varies over time.  A hydrograph, simply, is 
a time-discharge series.

Hydrographs are usually applied as wet weather loads, and are generated using hydro-
logic methods, while patterns are more typically applied to sanitary loads. Pattern 
multipliers are usually developed based on flow monitoring data for the system under 
consideration. The multipliers are used to account for time-of-day variations in sewer 
loads. Usually a handful of patterns are developed (e.g. residential area, commercial 
area, large industry) and these patterns are assigned to the appropriate nodes. These 
statements represent typical usage of both loading types; they do not represent hard 
and fast rules.

During an extended period simulation if the duration of the simulation exceeds the 
duration of a pattern then the pattern will repeat itself.  If the duration of the simula-
tion exceeds the duration of a hydrograph the last point of the hydrograph will remain 
constant for the extent of the remaining time.

The following figure shows the difference between a hydrograph and pattern load.

Figure 7-1: Difference between a Hydrograph and Pattern Load
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• “Pattern Loads” on page 7-360

• “Unit Sanitary Loading” on page 7-367

Adding User Defined Hydrographs

You can directly associate a user-defined unit hydrograph to any node element (e.g. 
manhole, catchment, cross section, pressure junction) for runoff calculations.

To add a user defined hydrograph to a catchment:

1. Click a node in your model to display the Property Editor, or right-click a node 
and select Properties from the shortcut menu.

2. In the Runoff section of the Property Editor, select User Defined Hydrograph as 
the Runoff Method.

3. Click the Ellipses (...) button next to the Runoff Hydrograph field. The User 
Defined Hydrograph dialog box appears.

4. Click the New button to add a row to the Time vs. Flow table.

5. Enter Time vs. Flow data into the table. Press Enter after typing a value to add a 
new row to the table (or click the New button to add a new row).

To insert a row at a time in between two other times, simply insert at the bottom of 
the table. When you close the table then reopen it, the row will be in the correct 
position.

Note: Time and flow units must be consistent with time and flow units 
used throughout the model.

6. Click the Graph button to view a plot of the Time vs. Flow data.

7. Click OK to close the dialog box and add the hydrograph to the Property Editor 
for the node.

User Defined Hydrograph Dialog Box

This dialog box allows you to define Time vs. Flow unit hydrographs. 
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The dialog box contains the time-vs.-flow table and the following buttons:

The table contains the following columns:

• “Hydrograph vs. Pattern Loads” on page 7-358

• “Pattern Loads” on page 7-360

• “Unit Sanitary Loading” on page 7-367

Pattern Loads

A pattern load consists of a base flow and a pattern, which is a set of multipliers used 
to adjust base flow over the course of a day (or some other period). Patterns can also 
be used with unit loads by assigning a pattern setup for a particular scenario.

For more information on building patterns, see “Defining Patterns” on page 7-362. 
For more information on pattern setups, see “Defining Pattern Setups” on page 7-365.

Related Topics

• “Adding Fixed Loads” on page 7-357

• “Hydrograph vs. Pattern Loads” on page 7-358

New Creates a new row in the hydrograph 
table.

Delete Deletes the currently highlighted row 
from the hydrograph table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the unit 
hydrograph defined by the points in the 
table.

Column Description

Time Lets you define the hour of the hydrograph point.

Flow Lets you define the flow for the hydrograph point.
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• “Adding User Defined Hydrographs” on page 7-359

• “Unit Sanitary Loading” on page 7-367

Working with Patterns

A dynamic analysis is actually a series of Steady State analyses run against time-vari-
able loads such as sewer inflows, demands, or chemical constituents.  Patterns allow 
you to apply automatic time-variable changes within the system. The most common 
application of patterns is for residential or industrial loads. Diurnal curves are patterns 
that relate to the changes in loads over the course of the day, reflecting times when 
people are using more or less water than average. Most patterns are based on a multi-
plication factor versus time relationship, whereby a multiplication factor of one repre-
sents the base value (which is often the average value).

Using a representative diurnal curve for a residence as illustrated below, we see that 
there is a peak in the diurnal curve in the morning as people take showers and prepare 
breakfast, another slight peak around noon, and a third peak in the evening as people 
arrive home from work and prepare dinner. Throughout the night, the pattern reflects 
the relative inactivity of the system, with very low flows compared to the average. 

Note: This curve is conceptual and should not be construed as 
representative of any particular network.

There are two basic forms for representing a pattern: stepwise and continuous. A step-
wise pattern is one that assumes a constant level of usage over a period of time, and 
then jumps instantaneously to another level where it remains steady until the next 
jump.  A continuous pattern is one for which several points in the pattern are known 
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and sections in between are transitional, resulting in a smoother pattern.  For the 
continuous pattern in the figure above, the multiplication factor and slope at the start 
time and end times are the same.  This is a continuity that is recommended for patterns 
that repeat.

Because of the finite time steps used for calculations, this software converts contin-
uous patterns into stepwise patterns for use by the algorithms.  In other words for a 
time step a multiplier is interpolated from the pattern curve.  That multiplier is then 
used for the duration of the time step, until a new multiplier is selected for the next 
time step.

Patterns provide a convenient way to define the time variable aspects of system loads.

Click one of the following links to learn more about working with patterns:

• “Defining Patterns” on page 7-362

• “Defining Pattern Setups” on page 7-365

Defining Patterns

A pattern is a series of time step values, each having an associated multiplier value.  
During a dynamic analysis each time step of the simulation uses the multiplier from 
the pattern corresponding to that time.  If the duration of the simulation is longer than 
the pattern, the pattern is repeated.  The selected multiplier is applied to any baseline 
load that is associated with the pattern.

Patterns must begin and end with the same multiplier value. This is because patterns 
will be repeated if the duration of the dynamic analysis is longer than the pattern dura-
tion. In other words, the last point in the pattern is really the start point of the pattern's 
next cycle.

A dynamic analysis is actually a series of Steady State analyses for which the 
boundary conditions of the current time step are calculated from the conditions at the 
previous time step. This software will automatically convert a continuous pattern 
format to a stepwise format so that the demands and source concentrations remain 
constant during a time step.

An individual node can support multiple hydraulic demands.  Furthermore, each load 
can be assigned any hydraulic load pattern.  This powerful functionality makes it easy 
to combine two or more types of load patterns (such as residential and institutional) at 
a single loading node.

To define a pattern:

1. Select Analysis > Patterns or click the Patterns button on the Analysis toolbar.

2. In the Patterns dialog box, click the New button to create a new pattern.
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3. On the right side of the dialog box, enter values for Start Time and Starting Multi-
plier.

4. Select Stepwise or Continuous in the Pattern Type field.

5. In the time step points table, enter values for Time from Start and Multiplier. 

– The Time from Start for row 1 in the table (the first point in the pattern) must 
be greater than zero.

– The last point in the pattern must have the same multiplier as the starting 
multiplier. This is how the pattern duration is defined, and it ensures an infi-
nitely repeating pattern.

Note: Bentley SewerGEMS V8i validates your data as you enter it and 
displays errors and warnings in the status bar at the bottom of 
the Patterns dialog box. Be sure to check this status bar for any 
errors or warnings as you enter data.

6. Perform the following optional steps:

– To delete an existing pattern, select the pattern label in the list pane, then click 
the Delete button.

– To rename an existing pattern, select the pattern label in the list pane, then 
click the Rename button and type the new name of the pattern.

– To view a report on an existing pattern, select the pattern label in the list pane, 
then click the Report button.

– To view a plot of a pattern, select the pattern label in the list pane, then click 
the Graph button above the time step points table.

– To delete a row from the time step points table, select the row then click the 
Delete button above the table.

7. Click Close.

Patterns Dialog Box

You create, edit, and delete patterns in the Patterns dialog box. The dialog box 
contains a list pane on the left and several input fields and a table on the right:

The dialog box contains the following controls above the list pane:
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The following fields and controls appear on the right side of the dialog box:

New Creates a new pattern in the list pane.

Delete Deletes the currently highlighted pattern.

Rename Lets you rename the currently highlighted 
pattern.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted pattern.

Start Time The first time step in the pattern.

Starting Multiplier The multiplier value of the first time step point in 
your pattern. Any real number can be used for this 
multiplier (it does not have to be 1.0).

Pattern Type Lets you select the type of pattern you want to 
create:

• Stepwise—The multiplier values are consid-
ered to be the average value for the interval 
between the specified time and the next time. 
Patterns using this format will have a "stair-
case" appearance. Multipliers are set at the 
specified time and held constant until the next 
point in the pattern.

• Continuous—The multipliers are considered 
to be the instantaneous values at a particular 
time. Patterns using this format will have a 
"curvilinear" appearance. Multipliers are set at 
the specified time, and are linearly increased 
or decreased to the next point in the pattern.
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The following controls are located above the time step points table on the right:

The time step points table contains the following columns:

There is also a status bar located at the bottom of the dialog box that displays any 
errors and warnings that may occur when you enter data.

Related Topic

• “Working with Patterns” on page 7-361

• “Defining Pattern Setups” on page 7-365

Defining Pattern Setups

A pattern setup allows you to match unit sanitary (dry weather) loads with appropriate 
loading patterns.  A pattern setup is associated with each scenario as specified in the 
Calculation Options Manager.  Each scenario can use a different pattern setup, thus 
allowing you to model different loading alternatives for different extended period 
simulations. 

New Creates a new row in the time step points 
table.

Delete Deletes the currently highlighted row 
from the time step points table.

Graph Displays a graph of a pattern that 
represents the multiplier variable of the 
pattern over time.

Column Description

Time from Start Lets you specify the amount of time from the Start 
Time of the pattern to the time step point being 
defined.

Multiplier Lets you specify the multiplier value associated 
with the time step point.
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Note: You must have at least one unit sanitary (dry weather) load set 
up in your model and at least one pattern defined before you can 
define a pattern setup.

To define a pattern setup:

1. Define at least one unit sanitary (dry weather) load in your current project. For 
more information, see “Adding Unit Sanitary (Dry Weather) Loads” on page 7-
370.

2. Define at least one pattern in your current project. For more information, see 
“Defining Patterns” on page 7-362.

3. Select Analysis > Pattern Setups or click the Pattern Setups button on the Anal-
ysis toolbar.

4. In the Pattern Setups dialog box, click the New button to create a new pattern 
setup.

5. The table on the right side of the dialog box displays all of the unit sanitary (dry 
weather) loads currently associated with your current project. For each unit load 
in the table, select an existing pattern from the Setup Pattern submenu.

6. Perform the following optional steps:

– To delete an existing pattern setup, select the pattern setup label in the list 
pane, then click the Delete button.

– To rename an existing pattern setup, select the pattern setup label in the list 
pane, then click the Rename button and type the new name of the pattern 
setup.

– To view a report on an existing pattern setup, select the pattern setup label in 
the list pane, then click the Report button.

7. Click Close.

Pattern Setups Dialog Box

The Pattern Setups dialog box lets you define a list of pattern setups. The dialog box 
contains a list pane on the left and a table on the right:
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The dialog box contains the following controls above the list pane:

The right side of the dialog contains a table with the following fields:

Related Topics

• “Adding Fixed Loads” on page 7-357

• “Hydrograph vs. Pattern Loads” on page 7-358

• “Adding User Defined Hydrographs” on page 7-359

• “Working with Patterns” on page 7-361

• “Defining Patterns” on page 7-362

• “Unit Sanitary Loading” on page 7-367

Unit Sanitary Loading

A unit loading consists of a unit (person, building, area) multiplied by a unit load (gal/
capita/day, litres/sq m/day, cfs/acre). The units are assigned to individual nodes 
elements (manholes, pressure junctions) while the unit loads are created using the Unit 
Sanitary (Dry Weather) Loads dialog box.

New Creates a new pattern setup in the list pane.

Delete Deletes the currently highlighted pattern 
setup.

Rename Lets you rename the currently highlighted 
pattern setup.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted pattern setup.

Column Description

Unit Load Each row displays a unit sanitary (dry weather) 
load in the current project.

Set Pattern Lets you select an existing pattern to apply to the 
unit load.
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Unit loads are calculated as: Load (flow Units) = Unit load (flow/number) x number 
of Loading units. For example: 100 gallons/capita/day x 40 people = 4000 gallons per 
day.

If the unit loads are not assigned to nodes but to polygons in a GIS, then it is best to 
use LoadBuilder to import the loads. For more information, see “LoadBuilder” on 
page 7-393.

For more information, see “Adding Unit Sanitary (Dry Weather) Loads” on page 7-
370 and “Types of Unit Sanitary (Dry Weather) Loads” on page 7-368.

Unit loads correspond to a baseline load and time of day patterns can be assigned to 
scenarios. For more information, see “Defining Pattern Setups” on page 7-365.

Default unit load information is not stored with the project but with a library that can 
be shared between projects. Default values are provided in the library called "HMI 
Unit Sanitary (Dry Weather) Loads.xml"

Related Topics

• “Adding Fixed Loads” on page 7-357

• “Hydrograph vs. Pattern Loads” on page 7-358

• “Adding User Defined Hydrographs” on page 7-359

• “Pattern Loads” on page 7-360

Types of Unit Sanitary (Dry Weather) Loads

The following types of unit sanitary loads are supported in Bentley SewerGEMS V8i:

Population-based

The most common way of specifying sanitary loads to a sewer system is to make them 
proportional to the contributing population.  Population-based unit sanitary loads 
define loads as a function of adjusted contributing population.  You can select the 
population loading units that will be used and the unit load per population unit.  For 
example, the unit sanitary load, Home (Average), specifies Resident as the population 
loading unit, and 280 l/d per Resident as the unit load per population unit. 

Non-population-based

Non-population-based unit sanitary loads can be area-based (function of contributing 
area), discharge-based (function of direct discharge), or count-based (function of a 
user-defined count).
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Area-based

Area-based unit sanitary loads are commonly used to specify industrial loads and 
steady inflows. Use these unit sanitary loads whenever your load is specified as a 
function of contributing area. For example, you may use "area residential" (in hectare) 
as a property of each node and 400 L/day/hectare as the unit loading.

Discharge-based

Discharge-based unit sanitary loads are used to directly specify loads without speci-
fying them on the basis of some other count, such as population or area.

There are two general ways to use discharge based loads:

• Specify 1.0 discharge unit (e.g. l/day, gpd, cfs, etc.) as the unit load.  Then, when 
using the load, specify the total desired load for the loading unit count. For 
example, you can create a load called Liter per Day whose loading unit type is 
Discharge, loading unit is l/day, and unit load is 1.0.  When you use this load at a 
manhole, a wet well, or a pressure junction, you specify 50.0 as the loading unit 
count. This yields a base load of 50 l/day.

• Specify total desired load as the unit load.  Then, when using the load, only 
specify 1.0 as the loading unit count. For example, you can create a load called 
Industry XYZ whose loading unit type is Discharge, loading unit is l/day, and unit 
load is 2000.0. When you use this load at the manhole, wet well, or pressure junc-
tion, you would specify 1.0 as the loading unit count. This yields a base load of 
2000 l/day.

In other words, you can specify a unit load of 1.0 in the Unit Sanitary Load Library 
and determine the total load at each node through the loading unit count, or you can 
specify the total load in the Unit Sanitary Load Library and then have a loading unit 
count of 1.0.

Count-based

Count-based unit sanitary loads should be used for any load that is not area, popula-
tion, nor discharge-based.  These loads allow you to specify any loading unit such as 
loading per vehicle, machine, or anything else.

Loading units in user-defined counts are treated only as labels.  Conversion between 
these units is always 1 to 1.

Related Topic

• “Unit Sanitary Loading” on page 7-367
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Adding Unit Sanitary (Dry Weather) Loads

Bentley SewerGEMS V8i defines unit sanitary loads in editable Engineering 
Libraries, allowing you to edit predefined unit sanitary loads and insert new ones. A 
unit sanitary load is used to specify loads to a sewer system for a user-selected loading 
unit. Unit sanitary loads can be either population-based or non-population-based.  
Population-based unit sanitary loads specify a load to the sewer system as a function 
of the contributing population.  Non-population-based loads specify loads based on 
service area, discharge, or user-defined counts.

You add unit sanitary loads using the Unit Sanitary (Dry Weather) Loads dialog box or 
Bentley SewerGEMS V8i’ Engineering Libraries.

To add a unit sanitary (dry weather) load:

1. Select Component > Unit Sanitary (Dry Weather) Loads, or click the Unit 
Sanitary (Dry Weather) Loads button on the Analysis toolbar.

2. In the Unit Sanitary (Dry Weather) Loads dialog box, click the New button, then 
select the type of unit sanitary load you want to create from the submenu (Area, 
Count, Discharge, or Population).

3. On the Unit Sanitary Load tab, enter the following data:

– For area-based loads, select the desired unit from the Area Unit drop-down 
menu.

– For discharge-based loads, select the desired unit from the Discharge Units 
drop down menu.

– For count-based loads, type the base unit used to define the count-based load 
in the Count Load Unit field. You can specify any unit you want, such as 
loading per vehicle, machine, or anything else.

– For population-based loads, select the desired unit from the Population Units 
drop-down menu.

– Type the amount of flow contributed per loading unit in the Unit Load field.
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– Type the count of adjusted population per loading unit in the Population 
Equivalent field. For area based loads, this is essentially a population density, 
or population per unit area.

– Check the Report Adjusted Population check box to report the adjusted popu-
lation with other populations. If you clear this check box, the adjusted popula-
tion will be not be reported as part of the total population.

4. You can save your new load in Bentley SewerGEMS V8i’ Engineering Libraries 
for future use. To do this, perform these steps:

a. Click the Synchronization Options button, then select Export to Library. 
The Engineering Libraries dialog box appears.

b. Use the plus and minus signs to expand and collapse the list of available 
libraries, then select the library into which you want to export your new unit 
sanitary load.

c. Click Close to close the Engineering Libraries dialog box.

5. Perform the following optional steps:

– To delete a load, select the load label then click Delete.

– To rename an load, select the load label you want to rename, click Rename, 
then type the new name for the load.

– To view a report on a load, select the load label for which you want a report 
then click Report.

6. Click Close to close the Unit Sanitary (Dry Weather) Loads dialog box.

To add a unit sanitary load in the Engineering Library:

1. Select Tools > Engineering Libraries to display the Engineering Libraries dialog 
box.

2. Click the plus sign next to the Unit Sanitary (Dry Weather) Loads Library to 
expand the list of items (categories and folders) included in that library. This 
library includes a category entitled Unit Sanitary (Dry Weather) Loads. 

Note: You can add new items to a category or a folder, add new folders 
to categories, and add new categories to libraries. For more 
information, see “Engineering Libraries” on page 6-288.

3. Right-click the Unit Sanitary (Dry Weather) Loads category (or a different cate-
gory or folder) and select New Item.
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4. Define the new unit sanitary load in the Editor pane on the right as described in 
the following steps:

a. Type the unit load in the Unit Load field.

b. Select the load type from the Loading Unit Type drop-down (Area Based, 
Count Based, Discharge Based, or Population Based).

c. Select the load units from the Sanitary Unit Load Units drop-down. For count-
based loads, you can specify any unit you want, such as loading per vehicle or 
machine.

d. For area-, count-, and discharge-based loads, type the count of adjusted popu-
lation per loading unit in the Pop.Equivalent (Capita) field. For area based 
loads, this is essentially a population density, or population per unit area.

e. For area-, count-, and discharge-based loads, select True from the Report 
Adjusted Population drop down to report the adjusted population with other 
populations. Select False if you don’t want to report the adjusted population 
as part of total population.

5. Click Close. Your new unit sanitary load is now part of the Engineering Libraries 
and can be re-used any time.

Unit Sanitary (Dry Weather) Load Dialog Box

This dialog box allows you to create unit sanitary (dry weather) loads. There are two 
sections: the list pane on the left and the tab section on the right. The list pane lets you 
create, edit, and delete unit sanitary loads and the tab section contains entry fields for 
each type of unit sanitary load. 
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The following controls are available in the Unit Sanitary (Dry Weather) Load dialog 
box:

New Creates a new unit sanitary load that uses 
an automatically created label.

• Area—Adds a new area-based unit 
sanitary load to the list pane. An area-
based unit sanitary load is a function of 
contributing service area.

• Count—Adds a new count-based unit 
sanitary load. A count-based unit sani-
tary load is a function of a user-defined 
count. Count-based unit sanitary loads 
should be used for any load that is not 
area-, discharge-, or population-based.

• Discharge—Adds a new discharge-
based unit sanitary load. A discharge-
based unit sanitary load is a function of 
direct discharge.

• Population—Adds a new population-
based unit sanitary load. A population-
based unit sanitary load is a function of 
adjusted contributing population.
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Delete Deletes the currently highlighted unit 
sanitary load.

Rename Lets you rename the currently highlighted 
unit sanitary load.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted unit sanitary load.

Synchronization 
Options

Clicking this button opens a submenu 
containing the following commands:

• Browse Engineering Library—
Opens the Engineering Library 
manager dialog, allowing you to 
browse the Unit Sanitary (Dry 
Weather) Load Engineering Libraries.

• Synchronize From Library—Lets you 
update a set of unit sanitary loads 
previously imported from a Unit Sani-
tary (Dry Weather) Load Engineering 
Library. The updates reflect changes 
that have been made to the library 
since it was imported.

• Synchronize To Library—Lets you 
update an existing Unit Sanitary (Dry 
Weather) Load Engineering Library 
using current unit sanitary loads that 
were initially imported but have since 
been modified.

• Import From Library—Lets you 
import a unit sanitary load from an 
existing Unit Sanitary (Dry Weather) 
Load Engineering Library.

• Export To Library—Lets you export 
the current unit sanitary load to an 
existing Unit Sanitary (Dry Weather) 
Load Engineering Library.
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The tab section includes the following controls:

Unit Sanitary Load Tab

Area Unit Lets you specify the base unit used to define the 
area-based load.

Unit Load Lets you specify the amount of flow contributed 
per loading unit.

Population Equivalent Lets you specify the count of adjusted population 
per loading unit. For area based loads, this is 
essentially a population density, or population per 
unit area. The Population equivalent field is 
optional and simply converts area or count into 
equivalent popultion, based on the Population 
equivalent value.

Report Adjusted 
Population

If this option is toggled ON, the adjusted 
population will be reported with other 
populations.  If the option is OFF, adjusted 
population will be not be reported as part of the 
total population.

Count Load Unit Lets you specify the base unit used to define the 
count-based load. You can specify any unit you 
want, such as loading per vehicle, machine, or 
anything else.

Discharge Units Lets you specify the base unit used to define the 
discharge-based load.

Population Units Lets you specify the base unit used to define the 
unit load. 

Library Tab This tab displays information about the unit 
sanitary load that is currently highlighted in the 
list pane. If the load is derived from an 
engineering library, the synchronization details 
can be found here. If the load was created 
manually for this project, the synchronization 
details will display the message Orphan (local), 
indicating that the pump was not derived from a 
library entry.
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Composite Hydrographs
A composite hydrograph graphs the total flow over time from multiple defined fixed/
unit loads, hydrographs, and pattern loads.

You can access the composite hydrograph and its corresponding data table from the 
Inflow Collection dialog boxand the Sanitary (Dry Weather) Flow Collection Editor 
dialog box, both of which are available from the Property Editor for selected elements. 
For example, a manhole has properties for Inflow Collection and Sanitary Loading.

This graph is dynamic and is generated automatically each time it is requested.

The time step in a composite hydrograph is determined by going from time 0 to the 
Total Simulation Time divided by Calculation Time Step. You can define the Total 
Simulation Time and Calculation Time Step values in the Calculation Options 
Manager. For more information, see “Calculation Options Manager” on page 8-431.

Composite Hydrograph Window

This window displays the composite hydrograph from multiple fixed/unit loads, 
hydrographs, and pattern loads defined in either the Inflow Collection dialog box or 
Sanitary (Dry Weather) Flow Collection Editor dialog box.

You access the Composite Hydrograph window by clicking the Graph button in the 
Inflow Collection dialog box or Sanitary (Dry Weather) Flow Collection Editor dialog 
box. If you have only one load or hydrograph defined, the graph displays the data for 
that single load or hydrograph.

The Composite Hydrograph window contains the following button:

Composite Hydrograph Data Table Window

This window displays a table of all the data points in a composite hydrograph from 
multiple fixed/unit loads, hydrographs, and pattern loads defined in either the Inflow 
Collection dialog box or Sanitary (Dry Weather) Flow Collection Editor dialog box.

The data table displays the same data used in the composite hydrograph in numerical 
form. The table contains two columns: the first column displays the time steps and the 
second column displays the flows. The values in this table can not be edited. 

Chart Settings Opens the Chart Options dialog box, 
allowing you to change graph display 
settings.
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You access the Data Table window by clicking the Data Table button in the Inflow 
Collection dialog box or Sanitary (Dry Weather) Flow Collection Editor dialog box. If 
you have only one load or hydrograph defined, the Data Table displays the data for 
that single load or hydrograph.

The Composite Hydrograph Data Table window contains the following buttons:

Inflows
The word "inflow" is used in two ways in sewer modeling. It is used first to describe 
wet weather flows to sewer systems that do not infiltrate through the ground [hot link 
- inflow and infiltration loading] and it is used in Bentley SewerGEMS V8i to 
describe any flow which enters a node element whether it is a fixed inflow, 
hydrograph or pattern load. The type of load available depends on the element type. 
The descriptions below, refer to the Bentley SewerGEMS V8i definition of inflow.

Inflows can be specified at any node element except a pond outlet and an outfall. 
Inflows are not a single value but are a collection (i.e. a table of flow vs. time) and as 
such must be specified from Property Editor for an element. For more information, see 
“Defining Inflow Collections” on page 7-378.

Inflow hydrographs are hydrographs with flow units and are not unit hydrographs. For 
more information, see “What is the Difference Between a User Defined Unit 
Hydrograph and a Hydrograph Entered in the Inflow Collection Editor?” on page 6-
269.

Copy Copies the contents of the data table to the 
Windows clipboard. You can then paste the 
data into a different application or document.

Paste Pastes the contents of the Windows clipboard 
into the data table. This is useful if you’ve 
got the data defined in a different document 
or application and want to simply copy and 
paste it into a composite hydrograph.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.
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The following diagram defines various flows.

Defining Inflow Collections

You can define an inflow collection for any node element in SewerGEMS V8i. An 
inflow collection can contain any combination of fixed, hydrograph, or pattern 
inflows.

To define an inflow collection:

1. Click a node element in your model to display the Property Editor, or right-click a 
node element and select Properties from the shortcut menu.

2. In the Inflow Collection section of the Property Editor, click the Ellipses (...) 
button. The Inflow Collection Editor appears.

3. Click the New button, then select the type of inflow you want to create from the 
submenu (Fixed Inflow, Hydrograph Inflow, Pattern Inflow).

4. For a Hydrograph Inflow, enter the data points in the hydrograph table. For Fixed 
and Pattern Inflows, enter the data in the appropriate fields.
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Note: For a hydrograph, if the last time in the table is less than the total 
simulation time, the simulation time and last flow will be 
appended to the hydrograph table.

5. Repeat steps 3 and 4 for each inflow you want to add to the collection.

6. Click the Composite Hydrograph button to see a graph of the composite 
hydrograph.

7. Click the Composite Hydrograph Data Table button to see a tabular view of all 
the data points in the composite hydrograph.

8. Click OK to close the dialog box and add the collection data to the Property 
Editor.

Inflow Collection Editor

This dialog box lets you define fixed loads, hydrograph loads, and pattern inflows for 
any node element. A node may have any combination of fixed loads, hydrograph 
loads, and pattern inflows.

The dialog box contains an Inflow list pane and the following controls:

New Opens a submenu containing the following 
options:

• Fixed Inflow—Adds a new Fixed Load 
inflow to the Inflow list pane.

• Hydrograph Inflow—Adds a new 
Hydrograph inflow to the Inflow list pane.

•

Delete Lets you delete the currently highlighted 
load.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Composite 
Graph

Opens a graph window plotting a curve of a 
selected single sanitary load or the composite 
hydrograph of all loads.

Composite 
Hydrograph

Opens a window listing all the data points in 
the curve of a selected single sanitary load or 
in the composite hydrograph of all loads.
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The Inflow Collection Editor also contains the following controls:

Inflow Control Center

The Inflow Control Center is an editor for manipulating all the inflows in your model. 
Using the Inflow Control Center, you can add new inflows, delete existing inflows, or 
modify the values for existing inflows using standard SQL select and update queries. 

The Inflow Control Center provides demand editing capabilities which can: 

• open on all inflow nodes, or subset of inflow nodes,

• sort and filter based on inflow criteria,

Hydrograph Table Lets you define the hydrograph by entering Time 
vs. Flow points. This table is available only when 
a Hydrograph Load inflow is highlighted in the 
Inflow list pane. If the last time in the table is less 
than the total simulation time, the simulation time 
and last flow will be appended to the hydrograph 
table.

Fixed Load Lets you define a fixed load value. This field is 
available only when a Fixed Load inflow is 
highlighted in the Inflow list pane. Set the fixed 
flow that affects the manhole.

Base Inflow Lets you enter the average inflow over the 
duration of the simulation.

Inflow Pattern Lets you select the pattern for the selected pattern 
inflow. Patterns are selected, edited, and created in 
the Pattern Manager, which you access by clicking 
the ellipsis (...) button next to this field.
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• add, edit, and delete individual inflows,

• globally edit inflows.

The Inflow Control Center consists of a pane consisting of tabs for each element type 
that list all of the inflows for all of the elements in the model and a pane that displays 
Hydrograph Load collections for the currently highlighted element. 

It also contains the following controls:
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New Clicking the New button opens a submenu containing the following 
commands:
• Add Fixed Load to Element—Adds a new Fixed Load to the element 

currently selected in the list pane.
• Add Hydrograph Load to Element—Adds a new Hydrograph Load to 

the element currently selected in the list pane.
• Add Pattern Load to Element—Adds a new pattern load to the 

element currently selected in the list pane.
• Add Inflows—Return the view to the drawing pane, allowing you to 

select an element from the drawing. After an element has been 
selected, the Apply Inflow Type to Selection dialog opens, allowing 
you to enter a Fixed or Hydrograph Load to the element you selected.

• Initialize Fixed Loads for All Elements—Adds a Fixed Load to each 
element of the current type in the model that does not currently have 
an inflow defined. The loads added by this command have an initial 
value of 0.0.

• Initialize Hydrograph Loads for All Elements—Adds a Hydrograph 
Load to each element of the current type in the model that does not 
currently have an inflow defined. The hydrographs added by this 
command are initially blank.

• Initialize Pattern Load for All Elements—Adds a Pattern Load to each 
element of the current type in the model that does not currently have 
an inflow defined. The loads added by this command have an initial 
value of 0.0.

• Initialize Fixed Load for Selection—Adds a Fixed Load to each 
element that is currently selected in the list pane that does not 
currently have an inflow defined. The loads added by this command 
have an initial value of 0.0.

• Initialize Hydrograph Load for Selection—Adds a Hydrograph Load to 
each element that is currently selected in the list pane that does not 
currently have an inflow defined. The hydrographs added by this 
command are initially blank.

• Initialize Pattern Load for Selection—Adds a Pattern Load to each 
element that is currently selected in the list pane that does not 
currently have an inflow defined.The loads added by this command 
have an initial value of 0.0.

Note: You can only use one type of Initialize operation 
in any given element. For example, if you 
perform an Initialize Fixed Loads for All 
Elements operation, you will not then be able to 
then perform an Initialize Hydrograph Loads for 
All Elements on the model.

If you wish to add another inflow of a different 
type than the one that was Initialized, you must 
do so for each individual element.

Delete Deletes the currently selected row from the list. Delete commands can not 
be undone.

Report Opens a report containing the inflow information displayed in each tab of 
the list pane.

Create or Add to 
a Selection Set

Clicking this button opens a submenu containing the following 
commands:

• Create Selection Set—Creates a new selection set 
consisting of the currently highlighted elements.

• Add to Selection Set—Adds the currently selected elements 
to an existing selection set.

• Remove from Selection Set—Removes the currently 
selected elements from an existing selection set.
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Zoom To Centers the drawing pane view on the currently selected element.

Find Opens the Find Element dialog, allowing you to search for a 
specific element.

Options Allows you to sort and/or filter the contents of the list pane.

Help Opens the online help.
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Apply Sanitary Inflow Type to Selection Dialog

This dialog allows you to assign an inflow to the currently selected element or 
elements. The dialog appears after you have used the Add Inflows command in the 
Inflow Control Center. To add an inflow, choose the inflow type, then enter inflow 
data and click OK for a Fixed Inflow or just click OK for a Hydrograph Inflow. If a 
Hydrograph Inflow is selected, the hydrograph must then be defined in the hydrograph 
pane of the Inflow Control Center.

•

The Sanitary Load Control Center consists of a pane consisting of tabs for each 
element type that list all of the loads for all of the elements in the model and a pane 
that displays Hydrograph Load collections for the currently highlighted element, 
along with the following controls:
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New Clicking the New button opens a submenu containing the 
following commands:
• Add Unit Load to Element—Adds a new Unit Load to the 

element currently selected in the list pane.
• Add Sanitary Hydrograph to Element—Adds a new sanitary 

hydrograph to the element currently selected in the list pane.
• Add Pattern Load to Element—Adds a new pattern load to 

the element currently selected in the list pane.
• Add Sanitary Loads—Return the view to the drawing pane, 

allowing you to select an element from the drawing. After an 
element has been selected, the Apply Sanitary Load to 
Selection dialog opens, allowing you to enter a Sanitary 
Hydrograph, Unit Load, or Pattern Load to the element you 
selected.

• Initialize Unit Loads for All Elements—Adds a Unit Load to 
each element of the current type in the model that does not 
currently have an inflow defined. The loads added by this 
command have an initial value of 0.0.

• Initialize Hydrograph Loads for All Elements—Adds a 
Hydrograph Load to each element of the current type in the 
model that does not currently have an inflow defined. The 
hydrographs added by this command are initially blank.

• Initialize Pattern Load for All Elements—Adds a Pattern Load 
to each element of the current type in the model that does 
not currently have an inflow defined. The loads added by this 
command have an initial value of 0.0.

• Initialize Unit Loads for Selection—Adds a Unit Load to each 
element that is currently selected in the list pane that does 
not currently have an inflow defined. The loads added by this 
command have an initial value of 0.0.

• Initialize Hydrograph Load for Selection—Adds a 
Hydrograph Load to each element that is currently selected 
in the list pane that does not currently have an inflow defined. 
The hydrographs added by this command are initially blank.

• Initialize Pattern Load for Selection—Adds a Pattern Load to 
each element that is currently selected in the list pane that 
does not currently have an inflow defined.The loads added 
by this command have an initial value of 0.0.

Note: You can only use one type of Initialize 
operation for any given element. For 
example, if you perform an Initialize 
Hydrograph Loads for All Elements 
operation, you will not then be able to 
then perform an Initialize Pattern Load for 
All Elements on the model.

If you wish to add another load of a 
different type than the one that was 
Initialized, you must do so for each 
individual element.

Delete Deletes the currently selected row from the list. Delete commands 
can not be undone.
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Apply Sanitary Load to Selection Dialog

This dialog allows you to assign a sanitary load to the currently selected element or 
elements. The dialog appears after you have used the Add Sanitary Loads command in 
the Sanitary Load Control Center. To add a load, choose the load type, then enter load 
data and click OK for a Sanitary Unit Load or Sanitary Pattern Load. Click OK for a 
Sanitary Hydrograph. If a Sanitary Hydrograph is selected, the hydrograph must then 
be defined in the hydrograph pane of the Sanitary Load Control Center.

Defining CN Area Collections for Catchments

SewerGEMS V8i lets you define infiltration for a catchment based on CN (SCS Curve 
Number) and Area data that you specify. You define and save this data in a CN Area 
collection.

Report Opens a report containing the load information displayed in each 
tab of the list pane.

Create or Add 
to a Selection 
Set

Clicking this button opens a submenu containing the following 
commands:

• Create Selection Set—Creates a new selection set 
consisting of the currently highlighted elements.

• Add to Selection Set—Adds the currently selected elements 
to an existing selection set.

• Remove from Selection Set—Removes the currently 
selected elements from an existing selection set.

Zoom To Centers the drawing pane view on the currently selected element.

Find Opens the Find Element dialog, allowing you to search for a 
specific element.

Options Allows you to sort and/or filter the contents of the list pane.

Help Opens the online help.
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In the SCS and EPA-SWMM methods in SewerGEMS V8i, the sub-basin runoff is 
defined solely by the CN input for each watershed. The CN Area Collection dialog 
box automatically computes weighted CN values as a function of soil hydrologic class 
and cover characteristics, based on the CN Engineering Library entries that you select 
when you create a CN Area collection.

Note: The USDA has classified its soil types into four hydrologic soil 
groups. For a complete description of the CN values for various 
land uses and cover characteristics for each soil classification, 
see “The Runoff Curve Number” on page 14-798. 

To define a CN Area collection for a catchment:

1. Click a catchment in your model to display the Property Editor, or right-click a 
catchment and select Properties from the shortcut menu.

2. In the Runoff section of the Property Editor, select Unit Hydrograph as the 
Runoff Method. The Loss Method field becomes available.

3. Select SCS CN as the Loss Method. the SCS CN field becomes available.

4. Click the Ellipses (...) button next to the SCS CN field. The CN Area Collection 
dialog box appears.

5. Type a description for the collection in the Description field, or click the Ellipses 
(...) button to display the CN Libraries in the Engineering Libraries.

6. Click the plus signs to expand the list of items in the CN Libraries until you find 
the CN Value for the soil hydrologic class and cover characteristics that you want 
to use.

7. Click Select to close the Engineering Libraries dialog box and add the CN Value 
to the table in the CN Area Collection dialog box.

8. SewerGEMS V8i automatically fills in the values for SCS CN and Area. Type 
values for Percent Connected Impervious Area and Percent Unconnected Imper-
vious Area.

Note: You can change the SCS CN value by clicking the Ellipses (...) 
button next to the SCS CN field, then selecting a different CN 
Value from the CN Engineering Libraries.

9. Repeat Steps 5 - 8 for each item you want to add to the CN Area collection.

10. Click OK.
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CN Area Collection Dialog Box

This dialog box lets you define infiltration based on Cn and Area data. The dialog box 
contains the Cn-Area table and the following buttons:

The table contains the following columns:

New Creates a new row in the cn-area table.

Delete Deletes the currently highlighted row 
from the cn-area table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Column Description

Description Lets you enter a description for the catchment.

CN Lets you define the Cn value for the catchment.

Area Lets you define the area for the catchment.

Percent Connected 
Impervious Area

This field allows you to enter the percent 
connected impervious area. 
This value represents the percentage of the area 
(for the current line of data) that contains directly 
connected impervious cover. Precipitation that 
falls on these types of impervious areas flow to the 
outfall point without ever flowing over pervious 
cover areas. 
An adjustment to the Cn for this line of data is 
made based on the % connected impervious areas 
(0% yields no adjustment). 
An example sequence of directly connected 
impervious areas are rainfall drops onto a concrete 
driveway, driveway drains to a paved gutter, gutter 
drains into a storm sewer, and storm sewer into a 
detention pond.
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Sanitary (Dry Weather) Flow Collections
You can define a sanitary (dry weather) flow collection for any node element in your 
model. A sanitary flow collection can contain any combination of hydrograph, unit, or 
pattern loads.

To define a sanitary (dry weather) flow collection:

1. Click an element in your model to display the Property Editor, or right-click an 
element and select Properties from the shortcut menu.

2. In the Sanitary Loads section of the Property Editor, click the Ellipses (...) button. 
The Sanitary (Dry Weather) Flow Collection Editor appears.

3. Click the New button, then select the type of sanitary load you want to create from 
the submenu (Hydrograph - Flow vs. Time, Unit Load - Unit Type and Count, or 
Pattern Load - Base Flow and Pattern).

4. For a Hydrograph, enter the data points in the hydrograph table. For Unit and 
Pattern Loads, enter the data in the appropriate fields.

Note: For a hydrograph, if the last time in the table is less than the total 
simulation time, the simulation time and last flow will be 
appended to the hydrograph table.

5. Repeat steps 3 and 4 for each load you want to add to the collection.

Percent Unconnected 
Impervious Area

Enter the percent unconnected impervious area. 
This value represents the percentage of the area 
(for the current line of data) that contains 
unconnected impervious cover. Precipitation 
falling on these types of impervious areas 
eventually flows over pervious areas before 
reaching the outfall. 
An adjustment to the Cn for this line of data is 
made based on the % unconnected impervious 
areas (0% yields no adjustment). 
An example sequence of directly unconnected 
impervious areas are rainfall drops onto a paved 
tennis court at a grassed park, water sheet flowing 
across a paved tennis court, water flowing off the 
tennis court onto a grass field in a park (there are 
no inlet drains on the court), and some of the water 
then being absorbed into the soil.

Column Description
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6. Click the Composite Hydrograph button to see a graph of the composite 
hydrograph.

7. Click the Composite Hydrograph Data Table button to see a tabular view of all 
the data points in the composite hydrograph.

8. Click OK to close the dialog box and add the collection data to the Property 
Editor.

Sanitary (Dry Weather) Flow Collection Editor

This dialog box lets you define collections of sanitary (dry weather) loads for the 
selected element in your model. Sanitary loads correspond to loads produced by resi-
dential, commercial, recreational, and industrial activity.  A sanitary load represents 
the base load to the sewer system.
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The dialog box contains a list pane and the following controls:

Depending on the type of sanitary load you select in the list pane, the following 
controls appear:

New Opens a submenu containing the following 
options:

• Hydrograph - Flow vs. Time—Adds a 
new hydrograph load to the list pane. 
This is a flow vs. time distribution.

• Unit Load - Unit Type and Count—
Adds a new unit load to the list pane. 
Unit Type refers to the type of Unit Load 
and Count refers to the number of units 
associated with the unit load. For 
example, 5000 passengers at an airport.

• Pattern Load - Base Flow and 
Pattern—Adds a new pattern load to the 
list pane. A pattern load is a direct, 
known sanitary load with a set pattern.

Delete Lets you delete the currently highlighted 
load.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Composite 
Graph

Opens a graph window plotting a curve of a 
selected single sanitary load or the composite 
hydrograph of all loads.

Composite 
Hydrograph

Opens a window listing all the data points in 
the curve of a selected single sanitary load or 
in the composite hydrograph of all loads.

Hydrograph Table Lets you define the hydrograph by entering Time 
From Start vs. Sanitary Flow points. This table is 
available only when a hydrograph load is 
highlighted in the list pane. If the last time in the 
table is less than the total simulation time, the 
simulation time and last flow will be appended to 
the hydrograph table.
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Related Topics

• “Composite Hydrographs” on page 7-376

• “Working with Patterns” on page 7-361

• “Adding Unit Sanitary (Dry Weather) Loads” on page 7-370

LoadBuilder
LoadBuilder is a tool used to assign flows to elements in Bentley SewerGEMS V8i. If 
you already knows what flows to assign to an element, then you should use the other 
methods such as inflow, sanitary loads, or stormwater loading. The power of Load-
Builder is that it can take loading information from a variety of GIS based sources 
such as customer meter data, system flow meter or polygons with known population 
or land use and assign those flows to elements. LoadBuilder is oriented to the types of 
data available to describe dry weather flows and other methods in Bentley Sewer-
GEMS V8i are more amenable to wet weather flows.

For more information about using LoadBuilder, see “Using LoadBuilder to Assign 
Loading Data” on page 11-679.

Unit Sanitary Load Lets you select the type of the load (for example 
Apartment or Airport).  Unit sanitary loads are 
selected, edited, and created in the Unit Sanitary 
(Dry Weather) Load dialog box, which you access 
by clicking the ellipsis (…) button next to this 
field. 

Unit Sanitary Loading 
Unit

Lets you enter the local count of loading units for 
the selected unit sanitary load.

Unit Sanitary Base 
Flow

Lets you enter the average inflow over the 
duration of the simulation.

Pattern Load Lets you select the pattern for the selected pattern 
load. Pattern loads are selected, edited, and 
created in the Pattern Manager, which you access 
by clicking the ellipsis (...) button next to this 
field.
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Rainfall Derived Infiltration and Inflow (RDII)
Rainfall derived infiltration and inflow (RDII) is the flow contribution to sanitary 
sewers from wet weather events. In Bentley SewerGEMS V8i, the most appropriate 
method for loading that flow is to derive unit hydrographs based on flow monitoring 
and enter them using the procedure described in “Adding Generic Unit Hydrographs” 
on page 7-411. Other methods may be added in the future.

Stormwater Flow
While it is possible to directly specify an inflow hydrograph at virtually any node 
element, users may wish to load models during wet weather with flow that are derived 
from precipitation.  For this approach to be workable, you must specify:

• Storm event

• Catchment characteristics

– Catchment size

– Loss method

– Hydrograph method

Flow calculated from stormwater runoff can only be placed on catchment elements. 
The methods described in this section are primarily intended for stormwater runoff or 
the wet weather contribution to combined sewer systems. For sanitary systems, “Rain-
fall Derived Infiltration and Inflow (RDII)” on page 7-394.

Snowmelt must be converted into equivalent precipitation to use the methods in this 
section.

The steps in using loss methods and hydrograph methods to generate a hydrograph 
from precipitation data are summarized in the following diagram.
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Adding Storm Events

A storm event is a single rainfall curve that represents one rainfall event for a given 
recurrence interval. The rainfall curve can be represented in one of three ways.

• Intensity 

• Incremental 

• Cumulative 

Once the storm event is created it can either be used locally at a catchment, or it can be 
used globally by selecting Analysis > Global Storm Events. This will apply the storm 
event to the current scenario. This storm event will then be applied to all catchments 
during analysis that do not have localized rainfall. Because Bentley SewerGEMS V8i 
dynamically routes flow through the system, it requires a complete storm hyetograph 
(i.e. a table with rainfall vs. time). There are many methods including actual historical 
storms and synthetic storms. These can be entered as cumulative precipitation or 
incremental precipitation.
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For background on rainfall data, see the Modeling Rainfall chapter in Stormwater 
Conveyance Modeling and Design or the Wet weather flow chapter in Wastewater 
Collection System Modeling and Design. Both books are published by and available 
from Bentley Institute Press.

A storm event can be created one of two ways, both from within the Storm Events 
dialog box:

• You can manually create a storm event by selecting Cumulative, Incremental, 
Intensity, or IDF Storm Event when selecting New to create a new curve in the 
Storm Event dialog.

• You can construct a storm event from a dimensionless rainfall curve stored in the 
associated Dimensionless Rainfall Curve engineering library. To do so select 
From Dimensionless Curve when selecting New to create a new storm event in 
the Storm Event dialog box.

To add a storm event:

1. Select Analysis > Storm Events or click the Storm Events button on the Analysis 
toolbar.

– You can define a local storm event for a specific catchment in the Rainfall 
section of the catchment’s Property Editor. Set Use Local Rainfall? to True, 
then select the ellipses (<...>) from the Local Storm Event submenu. 

2. In the Storm Events dialog box, click the New button, then select the type of storm 
event you want to create from the submenu (Cumulative, Incremental, Intensity, 
IDF Storm Event, or From Dimensionless Curve).

3. Define Cumulative, Incremental, Intensity, and IDF storm events on the Data tab 
by performing the following steps:

a. For Cumulative, Incremental, and Intensity storm events, type the Start Time, 
Increment, and End Time in the Time Settings dialog box, then click OK. The 
Time Settings dialog box appears as soon as you select one of these storm 
events from the New submenu.

b. For Cumulative, Incremental, Intensity, and IDF storm events, type the 
number of years in the Return Event field.

c. For Cumulative, Incremental, and Intensity storm events, enter Depth or 
Intensity data values in the table. The Time values are automatically filled in 
based on the time settings you defined for the storm event. To edit the time 
settings, click the Edit button on the Data tab.

d. For an IDF Storm Event, enter Time and Intensity data values into the table. 
Pressing Tab or Enter after typing a value creates a new row in the table.
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4. To define a From Dimensionless Curve storm event, perform these steps:

a. Select From Dimensionless Curve from the New submenu. The Engineering 
Libraries dialog box appears, showing the Dimensionless Rainfall Curve 
Library. 

b. Click the plus sign next to the library to expand it, select the dimensionless 
rainfall curve you want to use, then click Select. 

c. The Rainfall Curve Import Settings dialog box appears. Select the Storm 
Event Data Type (Intensity or Depth), the Storm Event Depth Type (Incre-
mental or Cumulative), then type values for Depth and Duration. Click OK to 
close the Rainfall Curve Import Settings dialog box.

d. The storm event appears in the Storm Events dialog box. Double-click the 
event to edit the import settings.

Note: In a Cumulative Dimensionless Depth rainfall curve, time is in 
hours and depth is dimensionless. In a Cumulative 
Dimensionless rainfall curve, both time and depth are 
dimensionless.

5. You can save your new storm events in Bentley SewerGEMS V8i’ Engineering 
Libraries for future use. To do this, perform these steps:

a. Select the storm event you want to save.

b. Click the Synchronization Options button, then select Export to Library. 
The Engineering Libraries dialog box appears.

c. Use the plus and minus signs to expand and collapse the list of available 
libraries, then select the library into which you want to export your new storm 
event.

d. Click Close.

6. Perform the following optional steps:

– To delete an event, select the event label then click Delete.

– To rename an event, select the event label you want to rename, click Rename, 
then type the new name for the event.

– To view a report on an event, select the event label for which you want a 
report then click Report.

– To graph the rainfall for an event, select the event label for which you want a 
graph then click Graph.

7. Click Close to close the Storm Events dialog box.
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To add a storm event in the Engineering Libraries:

1. Select Tools > Engineering Libraries to display the Engineering Libraries dialog 
box.

2. Click the plus sign next to the Storm Event Library to expand the list of items 
(categories and folders) included in that library.

Note: You can add new items to a category or a folder, add new folders 
to categories, and add new categories to libraries. For more 
information, see “Engineering Libraries” on page 6-288.

3. Right-click a category or folder in the Storm Event Library and select New Item. 
The new item appears at the bottom of the list of items in the selected category or 
folder.

4. Define the new storm event in the Editor pane on the right as described in the 
following steps:

a. Select the type of storm event from the Storm Event Type submenu (Time vs. 
Depth, Time vs. Intensity, or Rational Method IDF Curve).

b. For Time vs. Depth or Time vs. Intensity storm events, type the start time, 
increment, and end time in the appropriate fields.

c. For a Time vs. Depth storm event, select the depth type from the Depth Type 
submenu (Incremental or Cumulative).

d. For a Time vs. Depth storm event, click the Ellipses (...) button next to the 
Depths field, then enter Time vs. Depth data in the Storm Event dialog box. 
Click OK to close the Storm Event dialog box when you are done.

e. For a Time vs. Intensity storm event, click the Ellipses (...) button next to the 
Intensities field, then enter Time vs. Intensity data in the Storm Event dialog 
box. Click OK to close the Storm Event dialog box when you are done.

f. For a Rational Method IDF Curve storm event, click the Ellipses (...) button 
next to the IDF Curve field, then enter data values in the Rational Method IDF 
Curve dialog box. Click OK to close the Ration Method IDF Curve dialog 
box when you are done.

5. To create a Dimensionless Rainfall Curve in the Engineering Libraries, perform 
these steps:

a. Right-click the category or folder in the Dimensionless Rainfall Curves 
library in which you want to store your new dimensionless rainfall curve, then 
select New Item. The new item appears at the bottom of the list of items 
contained in the category or folder.

b. Select the new item, then define the curve in the Editor pane. Select the 
Dimensionless Time Type (Time or Dimensionless Time), then type values 
for the Start Time, Increment, and End Time.
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c. Click the Ellipses (...) button next to the Dimensionless Depth field. The 
Rainfall Curve Dictionary dialog box appears.

d. Time or Synthetic Time values are automatically inserted into the data table 
based on the start time, increment, and end times you entered. Type values for 
Depth, then click OK.

e. Click Close to close the Engineering Libraries.

Note: In a Cumulative Dimensionless Depth rainfall curve, time is in 
hours and depth is dimensionless. In a Cumulative 
Dimensionless rainfall curve, both time and depth are 
dimensionless.

6. Click Close. Your storm event is now part of the Engineering Libraries and can be 
re-used any time.

Storm Events Dialog Box

You create, edit, and delete storm events in the Storm Events dialog box. 
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The dialog box contains a list pane on the left and tabbed area on the right and 
includes the following controls:

New Creates a new storm event that uses an 
automatically created label.

• Cumulative—Adds a new storm event 
to the list pane of the type Cumulative.

• Incremental—Adds a new storm 
event to the list pane of the type Incre-
mental.

• Intensity—Adds a new storm event to 
the list pane of the type Intensity.

• IDF Storm Event—Adds a new IDF 
(intensity-duration-frequency) storm 
event to the list pane.

• From Dimensionless Curve—Opens 
the Engineering Library, where you can 
select an existing dimensionless rain-
fall curve to add as a new storm event.

Delete Deletes the currently highlighted storm 
event.
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Rename Lets you rename the currently highlighted 
storm event.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted storm event.

Graph Graphs a plot of the current storm event.

Synchronization 
Options

Clicking this button opens a submenu 
containing the following commands:

• Browse Engineering Library—
Opens the Engineering Library 
manager dialog, allowing you to 
browse the Storm Event and Dimen-
sionless Rainfall Curves Libraries.

• Synchronize From Library—Lets you 
update a set of storm events previ-
ously imported from a Storm Event or 
Dimensionless Rainfall Curve Library. 
The updates reflect changes that have 
been made to the library since it was 
imported.

• Synchronize To Library—Lets you 
update an existing Storm Event or 
Dimensionless Rainfall Curve Library 
Library using current storm events that 
were initially imported but have since 
been modified.

• Import From Library—Lets you 
import a storm event from an existing 
Storm Event or Dimensionless Rainfall 
Curve Library.

• Export To Library—Lets you export 
the current storm event to an existing 
Storm Event or Dimensionless Rainfall 
Curve Library.
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The following fields and controls appear in the tabbed area:

Time Settings Dialog Box

You define the temporal attributes of a storm event in the Time Settings dialog box.

This dialog automatically appears when you select Cumulative, Incremental, or Inten-
sity as a new storm event in the Storm Events dialog box. After you create one of these 
storm events, you can access the Time Setting dialog box by clicking the Edit button 
that appears above the table in the Storm Events dialog box.

This dialog box contains the following controls:

Data Tab

Edit Button Displays the Time Settings dialog box, which lets 
you define the temporal attributes of the storm 
event.

Return Event Lets you enter the return event value for the storm 
event.

Storm Event Data 
Table

Lets you define the points that make up the 
currently highlighted storm event (time vs. 
intensity or time vs. depth).

Notes Tab This tab contains a text field that allows you to 
enter descriptive notes that will be associated with 
the currently highlighted storm event. 

Library Tab This tab displays information about the storm 
event that is currently highlighted in the list pane. 
If the storm event is derived from an engineering 
library, the synchronization details can be found 
here. If the storm event was created manually for 
this project, the synchronization details will 
display the message Orphan (local), indicating 
that the storm event was not derived from a library 
entry. 

Start Time Lets you define the time for the first ordinate in a 
storm event.

Increment Lets you define the duration of the time step 
between ordinates in a storm event.
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Storm Event Dialog Box

This dialog box lets you define Time vs. Depth and Time vs. Intensity storm events 
from within Bentley SewerGEMS V8i’ Engineering Libraries.

Access the Storm Event dialog box by clicking the Ellipsis (...) button next to the 
Depths or Intensities field when for a Storm Event entry in the Engineering Library 
explorer pane. 

The dialog box includes the following controls:

The Storm Event dialog box also includes the following controls:

Rainfall Curve Import Settings Dialog Box

This dialog box appears when you create a new From Dimensionless Curve 
storm event and after you select a dimensionless rainfall curve in the Engineering 
Libraries to import into the Storm Events dialog box. The Rainfall Curve Import 
Settings dialog box lets you define the data type, depth type, depth, and dura-
tion for a storm event created from a dimensionless curve. 

End Time Lets you define the time for the last ordinate in a 
storm event.

Edit Opens the Time Settings dialog (see 
“Time Settings Dialog Box” on page 7-
402 for more information), allowing you 
to define the start time, stop time, and 
increment for the current storm event.

Graph Graphs a plot of the current storm event.

Return Event Lets you enter the return event, a value that 
reflects the average time between similar storm 
events.

Time vs. Depth or 
Intensity table

Allows you to define time vs. depth or time vs. 
intensity points that describe the current storm 
event. Which table is displayed in the dialog 
depends on the Storm Event Type specified in the 
library entry.
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The dialog box contains the following controls: 

Rainfall Curve Dictionary Dialog Box

This dialog lets you define dimensionless rainfall curves. These curves are stored in 
the Dimensionless Rainfall Curves Engineering Library, and can be used to define 
Global and local Storm Events (see “Adding Global Storm Events” on page 7-405 and 
“Adding Storm Events” on page 7-395 for more information).

The Rainfall Curve Dictionary dialog box is accessible by clicking the Ellipsis button 
of the Dimensionless Depths field when a Dimensionless Rainfall Curve entry is high-
lighted in the Engineering Library explorer pane. 

The dialog contains the following controls:

The Rainfall Curve Dictionary dialog box also contains the following table:

Storm Event Data Type Lets you specify the data type as Depth or 
Intensity. If you select Intensity, the Storm Event 
Type field becomes inactive.

Storm Event Depth 
Type

Lets you specify the depth type as Cumulative or 
Incremental. This field is unavailable if the Storm 
Event Data Type is Intensity.

Depth Lets you specify the depth of the storm event.

Start Time Lets you specify the time at which the translated 
dimensionless curve begins. The default and 
suggested value is 0.00 hours.

Duration Lets you specify the duration of the storm event.

Edit Opens the Time Settings dialog box (see 
“Time Settings Dialog Box” on page 7-
402 for more information), allowing you 
to define the start time, stop time, and 
increment for the current rainfall curve.

Graph Graphs a plot of the current rainfall 
curve.
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Rational Method IDF Curve Dialog Box

This dialog allows you to define intensity-duration-frequency curves. These curves 
are stored in the Storm Events Engineering Library, and can be used to define Global 
and local Storm Events (see “Adding Global Storm Events” on page 7-405 and 
“Adding Storm Events” on page 7-395 for more information).

The Rational Method IDF Curve dialog box is accessible by clicking the Ellipsis 
button of the Depths field when a Rational Method IDF Curve entry is highlighted in 
the Engineering Library explorer pane. 

The dialog contains the following controls:

Adding Global Storm Events

Individual catchments in your model can have local storm events assigned to them. 
These are the storm events you create in the Storm Events dialog box or in the Storm 
Events Engineering Library. For catchments that do not use local rainfall (Use Local 
Rainfall setting in the Property Editor is set to False), project-wide global storm events 
apply. Project-wide global storm events are associated with Hydrology alternatives.

You define project-wide global storm events in the Global Storm Events dialog box.

Time vs. Depth table lets you define time vs. depth points that describe 
the current rainfall curve. The time column will be 
either Synthetic Time or Time, depending on 
whether the Dimensionless Time Type specified in 
the library entry is Dimensionless Time or Time, 
respectively.

Return Event Lets you enter the return event, a value that 
reflects the average time between similar storm 
events.

Time vs. Intensity table Allows you to define time vs. depth or time vs. 
intensity points that describe the current storm 
event. Which table is displayed in the dialog 
depends on the Storm Event Type specified in the 
library entry.
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To add a global storm event:

1. Select Analysis > Global Storm Events or click the Global Storm Events button 
on the Analysis toolbar.

2. In the Global Storm Events dialog box, each row in the table represents a 
Hydrology alternative. In the Global Storm Event column, select the storm event 
from the submenu or click the Ellipses (...) button to display the Storm Events 
dialog box, where you can create a new storm event.

3. The rest of the data is automatically added to the table based on the settings of the 
selected storm event. Click Close.

Global Storm Event Settings Dialog Box

This dialog box lets you define project-wide global storm event data. You access the 
Global Storm Events Settings dialog box by selecting Analysis > Global Storm 
Events or clicking the Global Storm Event button on the Analysis toolbar.

The dialog box a table with the following columns:

Alternative Displays the name of the Hydrology alternative 
that is used by the current scenario.

Global Storm Event Lists all of the rainfall curves that have been 
defined for the current project in the Storm Events 
dialog box, which is accessible by clicking the 
ellipsis button.

Source Displays the location of the library file for storm 
events that are derived from an engineering library 
entry. 

Return Event Displays the return event that is associated with 
the storm event. The return event is a value that 
reflects the average time between similar storm 
events.

Depth Displays the rainfall depth of the storm as defined 
by the currently selected storm event.

Duration Displays the duration of the storm as defined by 
the currently selected storm event.
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Catchment Characteristics

The precipitation that falls on a catchment can only be converted into a flow to a 
sewer if the user specifies the following:

• Area to determine magnitude of available flow
(For more information, see “Entering Area” on page 7-407.)

• Runoff method which consists of:

– Loss method to determine the amount of available flow that actually runs off

– Hydrograph method to determine the shape of the runoff hydrograph

The modified rational method does not explicitly have a loss method associated with 
it.

Entering Area

There are two ways to specify area in a catchment. 

The first involves directly entering the area in the Property Editor or FlexTable for the 
catchment.

The second is based on the scaled area from the drawing. This can only be used if the 
drawing is scaled and the units have been correctly identified. Bentley SewerGEMS 
V8i displays the scaled area in the Property Editor for the catchment and you must 
copy that value in the Area attribute. For more information, see “Catchment—Geom-
etry” on page 15-890.

It is possible to have an area that is not uniform in terms of runoff. For more informa-
tion, see “Defining CN Area Collections for Catchments” on page 7-387.

For more information, see “Catchment—Catchment” on page 15-890.

Defining CN Area Collections for Catchments

SewerGEMS V8i lets you define infiltration for a catchment based on CN (SCS Curve 
Number) and Area data that you specify. You define and save this data in a CN Area 
collection.

In SewerGEMS V8i, the sub-basin runoff is defined solely by the CNinput for each 
watershed. The CN Area Collection dialog box automatically computes weighted CN 
values as a function of soil hydrologic class and cover characteristics, based on the CN 
Engineering Library entries that you select when you create a CN Area collection.
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Note: The USDA has classified its soil types into four hydrologic soil 
groups. For a complete description of the CN values for various 
land uses and cover characteristics for each soil classification, 
see “The Runoff Curve Number” on page 14-798. 

To define a CN Area collection for a catchment:

1. Click a catchment in your model to display the Property Editor, or right-click a 
catchment and select Properties from the shortcut menu.

2. In the Runoff section of the Property Editor, select Unit Hydrograph as the 
Runoff Method. The Loss Method field becomes available.

3. Select SCS CN as the Loss Method. the SCS CN field becomes available.

4. Click the Ellipses (...) button next to the SCS CN field. The CN Area Collection 
dialog box appears.

5. Type a description for the collection in the Description field, or click the Ellipses 
(...) button to display the CN Libraries in the Engineering Libraries.

6. Click the plus signs to expand the list of items in the CN Libraries until you find 
the CN Value for the soil hydrologic class and cover characteristics that you want 
to use.

7. Click Select to close the Engineering Libraries dialog box and add the CN Value 
to the table in the CN Area Collection dialog box.

8. SewerGEMS V8i automatically fills in the values for SCS CN and Area. Type 
values for Percent Connected Impervious Area and Percent Unconnected Imper-
vious Area.

Note: You can change the SCS CN value by clicking the Ellipses (...) 
button next to the SCS CN field, then selecting a different CN 
Value from the CN Engineering Libraries.

9. Repeat Steps 5 - 8 for each item you want to add to the CN Area collection.

10. Click OK.

CN Area Collection Dialog Box

This dialog box lets you define infiltration based on Cn and Area data. The dialog box 
contains the Cn-Area table and the following buttons:
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The table contains the following columns:

New Creates a new row in the cn-area table.

Delete Deletes the currently highlighted row 
from the cn-area table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Column Description

Description Lets you enter a description for the catchment.

CN Lets you define the Cn value for the catchment.

Area Lets you define the area for the catchment.

Percent Connected 
Impervious Area

This field allows you to enter the percent 
connected impervious area. 
This value represents the percentage of the area 
(for the current line of data) that contains directly 
connected impervious cover. Precipitation that 
falls on these types of impervious areas flow to the 
outfall point without ever flowing over pervious 
cover areas. 
An adjustment to the Cn for this line of data is 
made based on the % connected impervious areas 
(0% yields no adjustment). 
An example sequence of directly connected 
impervious areas are rainfall drops onto a concrete 
driveway, driveway drains to a paved gutter, gutter 
drains into a storm sewer, and storm sewer into a 
detention pond.
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Runoff Method

Bentley SewerGEMS V8i supports the following runoff methods which can be 
selected by the user in the Property Editor or FlexTable under the attribute Runoff 
Method. They include:

• None - no runoff 

• Modified rational method

• Unit hydrograph

• EPA SWMM

• User defined hydrograph

The data required varies for each method. The data requirements are summarized in 
“Catchment—Runoff” on page 15-891. The data needs for each method are described 
in their individual sections. 

The input parameters for each method are listed below. Each of these methods is 
described in standard hydrology and stormwater references such as Stormwater 
Modeling Conveyance and Design, published Haestad Press.

Input Parameters for Unit Hydrograph Runoff Methods

• Loss method

Percent Unconnected 
Impervious Area

Enter the percent unconnected impervious area. 
This value represents the percentage of the area 
(for the current line of data) that contains 
unconnected impervious cover. Precipitation 
falling on these types of impervious areas 
eventually flows over pervious areas before 
reaching the outfall. 
An adjustment to the Cn for this line of data is 
made based on the % unconnected impervious 
areas (0% yields no adjustment). 
An example sequence of directly unconnected 
impervious areas are rainfall drops onto a paved 
tennis court at a grassed park, water sheet flowing 
across a paved tennis court, water flowing off the 
tennis court onto a grass field in a park (there are 
no inlet drains on the court), and some of the water 
then being absorbed into the soil.

Column Description
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– Green Ampt

- Capillary suction

- Ks

- Moisture deficit

– SCS Curve Number

– Horton

- fc

- fo

- Initial abstraction

- K

- Recovery constant

- Maximum volume

– fLoss

• Time of Concentration 
(For more information, see “Specifying a Time of Concentration (Tc) Method for 
a Catchment” on page 6-239.)

• Unit hydrograph method 
(For more information, see “Unit Hydrograph Methodology” on page 14-807.)

- Generic unit hydrograph 
(For more information, see “Generic Unit Hydrographs” on page 14-808.)

- RTK Method
(For more information, see “Adding Hydrographs Based On the RTK 
Method” on page 7-415.)

- SCS 
(For more information, see “Using the SCS Unit Hydrograph Runoff 
Method” on page 7-421.)

For more information on unit hydrograph runoff methods, see “Unit Hydrograph 
Runoff Methods” on page 14-811.

Adding Generic Unit Hydrographs

You can directly associate a user-defined unit hydrograph to a subarea (catchment) for 
runoff calculations. In dynamic flow routing, the hydraulics of the system are modeled 
over time.
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The coefficients for the generic unit hydrographs are usually developed based on a 
linear correlation analysis between precipitation data and flow measurement. Usually 
flow monitoring data are only available at a handful of locations in a collection 
system. Therefore, when using generic unit hydrograph, you only need to load a 
model at points corresponding to flow monitoring locations. This lumping of wet 
weather loads will model flows downstream of the monitoring point accurately but 
will underestimate flow immediately upstream of the monitoring location. 

In this method, the rainfall is converted into catchment outflow in discrete time inter-
vals, called convolution time steps. Usually, it is best to set the convolution time step 
to the same value as the increment in the unit hydrograph that you enter. Smaller inter-
vals won't produce greater accuracy while larger intervals will lose resolution.

For more information on unit hydrographs, see “Generic Unit Hydrographs” on 
page 14-808 and “Soil Conservation Service (SCS)” on page 14-809.

Note: Implementation of generic unit hydrographs in PondPack is not 
the same as generic unit hydrographs in CivilStorm and 
SewerGEMS.

To add a unit hydrograph to a catchment:

1. Click a catchment in your model to display the Property Editor, or right-click a 
catchment and select Properties from the shortcut menu.

2. In the Runoff section of the Property Editor, select Unit Hydrograph as the 
Runoff Method.

3. Select Generic Unit Hydrograph in the Unit Hydrograph Method drop-down.

4. Click the Ellipses (...) button next to the Runoff Hydrograph field. The Unit 
Hydrograph Data dialog box appears.

5. Click the New button to add a row to the Time vs. Flow table.

6. Enter Time vs. Flow data into the table. Press Enter after typing a value to add a 
new row to the table (or click the New button to add a new row).

7. Click the Graph button to view a plot of the Time vs. Flow data.

8. Click OK to close the dialog box and add the hydrograph to the Property Editor 
for the catchment.

Unit Hydrograph Data Dialog Box

This dialog box allows you to define Time vs. Flow unit hydrographs. The dialog box 
contains the time-vs.-flow table and the following buttons:
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New Creates a new row in the hydrograph 
table.

Delete Deletes the currently highlighted row 
from the hydrograph table.

Report Opens a print preview window 
containing a report that details the input 
data for this dialog box.

Graph Opens a graph window plotting the unit 
hydrograph defined by the points in the 
table.
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The table contains the following columns:

EPA SWMM

The input parameters for each method are listed below.

• Loss method

– Green Ampt

- Capillary suction

- Ks

- Moisture deficit

– SCS Curve Number

– Horton

- fc

- fo

- Initial abstraction

- K

- Recovery constant

- Maximum volume

– fLoss

• Storage (Impervious Depression)

• Storage (Pervious Depression)

• Impervious Manning's n

• Pervious Manning's n

• Percent impervious

• Slope

• Subarea routing

– Impervious

– Pervious

Column Description

Time Lets you define the hour of the hydrograph point.

Flow Lets you define the flow for the hydrograph point.
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– Outlet

• Percent routed

If you are using the EPA SWMM runoff method with the SWMM engine, you must:

1. Use the EPA-SWMM runoff for all catchments;

2. Use the same loss method for all catchments;

3. Set the Infiltration Method under Calculation Options to the loss method used by all 
catchments.

For more information on SWMM input data, see “Using the SWMM Water Quality 
Solver” on page 6-294.

Adding Hydrographs Based On the RTK Method

The RTK method is used to generate a hydrograph based on precipitation data. It 
forms the hydrograph by combining triangular hydrographs from three components of 
flow:

• Rapid inflow

• Moderate infiltration

• Slow infiltration

A typical RTK hydrograph is shown below. Q1, Q2 and Q3 refer to the three compo-
nents of flow which must be summed to determine the flow.
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Figure 7-2: A Typical RTK Hydrograph

For information on the theory behind this method, see “RTK Methods” on page 14-
815. RTK methods are described further in the wet weather flow chapter of “Waste-
water Collection System Modeling and Design,” available from Bentley Institute 
Press.

The RTK method is most appropriate for determining RDII (Rainfall Derived Infiltra-
tion and Inflow) to sanitary sewers. It treats the system between the rainfall and flow 
in the sewer as a black box which can be represented by the three parameters R, T and 
K. In storm sewer systems, most of the flow moves over the surface and enters the 
sewer at known locations; a method such as the SCS hydrograph method is more 
appropriate in these systems.

The RTK method requires that the storm event be specified as a hyetograph, not 
simply a peak intensity. The resulting hydrograph from the catchment will have time 
steps equal to the time step size in the hyetograph. For example if precipitation is 
specified in 0.25 hr increments, flow will be calculated in those increments.

For more information about RTK methods, see:
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• “Assembling RTK Parameters” on page 7-417

• “Creating an RTK Table and Assigning it to a Catchment” on page 7-418

• “RTK Tables Dialog Box” on page 7-420

• “RTK Methods” on page 14-815

Assembling RTK Parameters

The RTK parameters are:

• R - fraction of precipitation that enters the collection system for that component

• T - the time from the precipitation pulse to the peak of that component of the 
hydrograph

• K- the ratio of the time to peak to time to end of hydrograph for that component.

There is no theoretical method to determine R, T and K. They must be determined 
empirically for each system based on a comparison of a measured rainfall hyetograph 
with measured wet weather sewer flow. 

In general, R will be higher for systems that have significant infiltration and inflow 
problems than tight systems. T will be larger for larger catchments and will be larger 
for slow infiltration than rapid inflow. K is usually on the order of 1.5 to 2.5. The sum 
of the R values for all components should be positive but less than 1. The default units 
for T is hours while R and K are dimensionless. 

Determining R, T and K for a particular catchment (or group of catchments) and event 
involve constructing a model, then trying different values of R, T and K that, when 
combined with sanitary dry weather flow, match the measured system hydrograph.

In some cases, the RTK parameters may have been determined for a large area, say 
several square kilometers (square miles) but the model is being loaded based on catch-
ments on the order of a few hectares (acres). In this case, the R and K values are likely 
to be valid but the T values may need to be decreased to reflect the shorter time of 
concentration of these smaller catchments.

It is best to calibrate the RTK method using several storm events.
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Note: The word "infiltration" is used in two different ways in wet 
weather flow monitoring:

1. It is the precipitation that seeps into the ground.

2. It is the precipitation that seeps through the groundwater into 
collection systems. 

In Bentley SewerGEMS V8i, generally the first definition is used. 
In the RTK method, the second definition is typically used.

Creating an RTK Table and Assigning it to a Catchment

The RTK parameters are a property of each catchment. However, it is not uncommon 
for many catchments with similar characteristics to share the same RTK parameters. 
Therefore, the RTK parameters are entered in a named RTK table and that table can be 
shared among many catchments.

The RTK table is a set of RTK parameters that is available to be assigned to catch-
ments. The following table shows some example ranges of RTK values.

In most cases, the RTK hydrograph implicitly accounts for infiltration so when using 
RTK, you should set this type of infiltration to zero. This can be done by setting the 
infiltration rate to zero in the fLoss method or setting fc and fo to zero in the Horton 
(generic) method.

To create a RTK table:

1. Open your project in Bentley SewerGEMS V8i, then do one of the following:

– Select Analysis > RTK Tables.

– Double-click a catchment in your model, then in the Property Editor for the 
catchment, select Unit Hydrograph as the Runoff Method, RTK Unit 
Hydrograph as the Unit Hydrograph Method, then New as the RTK Table.

– Open a catchment FlexTable, then click the Ellipse (...) button in the RTK 
Table cell.

Table 7-2: Example RTK Values

Component R T K

Rapid Inflow 0.08 2 1.5

Moderate Infiltration 0.04 3.5 1.75

Slow Infiltration 0.06 7 1.67
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2. Click the New button to create a new RTK table, then type a new name for the 
RTK table.

3. Enter RTK values for Rapid Inflow, Moderate Infiltration, and Slow Infiltration. 
You can use the Tab key to quickly move from one field to the next.

Note: If you do not use one of the flow components, set the R value of 
that component to zero.

Bentley SewerGEMS V8i validates your RTK data as you enter it 
and displays errors and warnings in the status bar at the bottom 
of the RTK Tables dialog box. Be sure to check this status bar for 
any errors or warnings as you enter data.

4. Click Close to close the dialog box and save the RTK table.

5. In the Property Editor for the catchment, select the new RTK table from the drop-
down menu in the RTK Table field.

To assign an RTK table to a catchment:

The advantage of using FlexTables to assign RTK tables to catchments is that the 
hydrograph types can be assigned globally.

1. To assign an RTK table to a catchment using the Property Editor, perform these 
steps:

a. Double-click a catchment in your model.

b. In the Property Editor, select Unit Hydrograph as the Runoff Method.

c. Select RTK Unit Hydrograph as the Unit Hydrograph Method.

d. In the RTK Table field, select the desired RTK table from the drop-down 
menu, or select New to create a new RTK table.

2. To assign an RTK table to a catchment using a FlexTable, perform these steps:

a. Open or create a catchment FlexTable. 

For information on creating FlexTables, see “Creating a New FlexTable” on 
page 10-563. For information on adding columns to an existing FlexTable, see 
“Editing FlexTables” on page 10-564.

b. Add the following columns to the FlexTable:

- Runoff Method

- Unit Hydrograph Method

- RTK Table

c. In the Runoff Method cell in the FlexTable, select Unit Hydrograph.
Bentley SewerGEMS V8i User’s Guide 7-419



Stormwater Flow
d. In the Unit Hydrograph Method cell, select RTK Unit Hydrograph.

e. In the RTK Table cell for the catchment, select the appropriate RTK table or 
click the Ellipses (...) button to create a new table.

RTK Tables Dialog Box

You create RTK tables in the RTK Tables dialog box. The dialog box contains a list 
pane with the following controls:

The RTK Tables dialog box also contains the following controls:

New Creates a new RTK table that uses an 
automatically created label.

Delete Deletes the currently highlighted RTK 
table.

Rename Lets you rename the currently highlighted 
RTK table.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted RTK table.

Duplicate Lets you create an exact copy of the 
selected RTK table with a new name.

Rapid Inflow Lets you enter RTK values for the rapid inflow 
component of flow:

• R—Fraction of precipitation that enters the 
collection system for rapid inflow.

• T—The time from the precipitation pulse to the 
peak of rapid inflow of the hydrograph.

• K—The ratio of the time to peak to time to end 
of hydrograph for rapid inflow.
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There is also a status bar located at the bottom of the dialog box that displays any 
errors and warnings that may occur when you enter data.

Using the SCS Unit Hydrograph Runoff Method

When the SCS Unit Hydrograph Runoff Method is assigned to a catchment, Bentley 
SewerGEMS V8i allows you to choose between the following three dimensionless 
methods to further customize the hydrograph:

• Default Curvilinear—This method uses the standard dimensionless curvilinear 
unit hydrograph ordinates, as defined in “Chapter 4” of the National Engineering 
Handbook, Section 4.

• Triangular Unit Hydrograph—This method uses a triangular unit hydrograph 
shape to define the coordinates for the unit hydrograph. The default shape factor is 
484 (37.5% of the volume on the rising limb of the unit hydrograph).

• Dimensionless Unit Hydrograph—This method allows you to customize the Q/
Qp-T/Tp unit hydrograph that is used with the SCS Unit Hydrograph method. See 
““ Soil Conservation Service (SCS)”on page 14-811Adjusting the Q/Qp-T/Tp 
Unit Hydrograph” on page 7-422 for more information.

Moderate Infiltration Lets you enter RTK values for the moderate 
infiltration component of flow:

• R—Fraction of precipitation that enters the 
collection system for moderate infiltration.

• T—The time from the precipitation pulse to the 
peak of moderate infiltration of the 
hydrograph.

• K—The ratio of the time to peak to time to end 
of hydrograph for moderate infiltration.

Slow Infiltration Lets you enter RTK values for the slow infiltration 
component of flow:

• R—Fraction of precipitation that enters the 
collection system for slow infiltration.

• T—The time from the precipitation pulse to the 
peak of slow infiltration of the hydrograph.

• K—The ratio of the time to peak to time to end 
of hydrograph for slow infiltration.
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“ Soil Conservation Service (SCS)”on page 14-809Adjusting the Q/Qp-T/Tp Unit 
Hydrograph

Q/Qp-T/Tp is a dimensionless unit hydrograph that is used with the SCS Unit 
Hydrograph method. The Qp and Tp are determined based on subarea characteristics. 
Typically, the SCS method uses a default curvilinear unit hydrograph. SewerGEMS 
V8i allows you to assign your own Q/Qp-T/Tp hydrograph to better suit your local 
conditions.

To create a new Q/Qp-T/Tp Unit Hydrograph:

1. Highlight a catchment in the model. 

2. In the Property Editor, change the value in the Runoff Method field to Unit 
Hydrograph.

3. Change the Unit Hydrograph Method to SCS Unit Hydrograph.

4. Change the Unit Hydrograph Method Type to Dimensionless Unit Hydrograph.

5. Click the Dimensionless Unit Hydrograph field and select the Edit Dimensionless 
Unit Hydrograph command.

6. In the Dimensionless Unit Hydrographs dialog that appears, click the New button.

To import a Q/Qp-T/Tp Unit Hydrograph from an Engineering Library:

1. Highlight a catchment in the model. 

2. In the Property Editor, change the value in the Runoff Method field to Unit 
Hydrograph.

3. Change the Unit Hydrograph Method to SCS Unit Hydrograph.

4. Change the Unit Hydrograph Method Type to Dimensionless Unit Hydrograph.

5. Click the Dimensionless Unit Hydrograph field and select the Edit Dimensionless 
Unit Hydrograph command.

6. In the Dimensionless Unit Hydrographs dialog that appears, click the Synchroni-
zation Options button and select the Import From Library command from the 
menu that appears.

7. In the Engineering Libraries dialog that appears, find the desired library, highlight 
it, and click the Select button to import it.

Dimensionless Unit Hydrograph Dialog

This dialog allows you to create the Q/Qp-T/Tp unit hydrographs that are used with the 
SCS Unit Hydrograph method. 
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The following controls are available in the Dimensionless Unit Hydrograph dialog 
box:

New Creates a new unit hydrograph that uses an 
automatically created label.

Delete Deletes the currently highlighted unit 
hydrograph.
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Rename Lets you rename the currently highlighted 
unit hydrograph.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted unit hydrograph.

Graph Lets you plot a graph based on the input 
data associated with the currently 
highlighted unit hydrograph.

Synchronization 
Options

Clicking this button opens a submenu 
containing the following commands:

• Browse Engineering Library—
Opens the Engineering Library 
manager dialog, allowing you to 
browse the Dimensionless Unit 
Hydrograph Engineering Libraries.

• Synchronize From Library—Lets you 
update a set of unit sanitary loads 
previously imported from a Dimension-
less Unit Hydrograph Engineering 
Library. The updates reflect changes 
that have been made to the library 
since it was imported.

• Synchronize To Library—Lets you 
update an existing Dimensionless Unit 
Hydrograph Engineering Library using 
current unit hydrograph ordinates that 
were initially imported but have since 
been modified.

• Import From Library—Lets you 
import a unit hydrograph from an 
existing Dimensionless Unit 
Hydrograph Engineering Library.

• Export To Library—Lets you export 
the current unit hydrograph to an 
existing Dimensionless Unit 
Hydrograph Engineering Library.
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The tab section includes the following controls:

New This button creates a new row in the Q/Qp-T/
Tp table.

Delete This button deletes the currently highlighted 
row from the Q/Qp-T/Tp table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the Q/Qp-T/
Tp curve defined by the points in the table.

Synchronization 
Options

Clicking this button opens a submenu 
containing the following commands:

• Browse Engineering Library—Opens 
the Engineering Library manager dialog, 
allowing you to browse the Dimension-
less Unit Hydrograph Library.

• Synchronize From Library—Lets you 
update a set of storm events previously 
imported from a Dimensionless Unit 
Hydrograph Library. The updates reflect 
changes that have been made to the 
library since it was imported.

• Synchronize To Library—Lets you 
update an existing Dimensionless Unit 
Hydrograph Library using current storm 
events that were initially imported but 
have since been modified.

• Import From Library—Lets you import a 
storm event from an existing Dimension-
less Unit Hydrograph Library.

• Export To Library—Lets you export the 
current storm event to an existing 
Dimensionless Unit Hydrograph Library.

Unit Hydrograph Data 
Tab
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Dimensionless Unit Hydrograph Curves Library Editor

This dialog allows you to create engineering library entries containing the Q/Qp-T/Tp 
unit hydrographs that are used with the SCS Unit Hydrograph method. The following 
controls are available in the Dimensionless Unit Hydrograph Curves dialog box:

T/Tp Column Q/Qp is the ratio of actual flow to the peak flow of 
the unit hydrograph.

Q/Qp Column T/Tp is the ratio of actual time to the time-to-peak.

Notes Tab This tab provides a text field that lets you enter 
descriptive notes for the unit hydrograph that is 
currently highlighted in the list pane. 

Library Tab This tab displays information about the unit 
hydrograph that is currently highlighted in the list 
pane. If the hydrograph is derived from an 
engineering library, the synchronization details 
can be found here. If the hydrograph was created 
manually for this project, the synchronization 
details will display the message Orphan (local), 
indicating that the hydrograph was not derived 
from a library entry.

New Creates a new unit hydrograph that uses an 
automatically created label.

Delete Deletes the currently highlighted unit 
hydrograph.

Rename Lets you rename the currently highlighted 
unit hydrograph.

Report Lets you generate a preformatted report 
that contains the input data associated with 
the currently highlighted unit hydrograph.

Graph Lets you plot a graph based on the input 
data associated with the currently 
highlighted unit hydrograph.
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Modified Rational
The modified rational methods used in Bentley SewerGEMS V8i are listed below.

• Rational C

• Time of concentration
(For more information, see “Specifying a Time of Concentration (Tc) Method for 
a Catchment” on page 6-239.)

• Receding limb multiplier
(For more information, see “Calculation Profile Attributes” on page 8-433.)

Time of Concentration
You can add Time of Concentration (Tc) Methods to a catchment in your model. 
SewerGEMS V8i supports 13 different methods.

For more information, see “Specifying a Time of Concentration (Tc) Method for a 
Catchment” on page 6-239.

Pipeline Infiltration
To model infiltration along a pipeline, it is possible to specify infiltration as:

• Pipe length

• Pipe area

• Pipe diameter-length

• Count

• Hydrograph

• Pattern load

The first four types of infiltration are constant rates while the last two are time varying 
inflows. For more information on entering data for each type of infiltration, see 
“Conduit—Infiltration” on page 15-827.
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Note: Infiltration loading will be ignored by the calculation engine if it 
is assigned to a conduit whose upstream element is a Pond 
Outlet Structure.

Conduit infiltration flow is added after the upstream section of 
the conduit by the calculation engine. Therefore, when viewing 
flow results,you will see the infiltration flow in the middle section 
and the downstream section of the conduit.

Hydrograph Curve Dialog Box

This dialog box allows you to enter Hydrograph Time vs. Flow data to create Hydro-
graphs for use with the Hydrograph Infiltration Load type.

The dialog box contains the Hydrograph Time vs. Flow table along with the following 
controls:

The table contains the following columns:

New This button creates a new row in the time-
flow table.

Delete This button deletes the currently highlighted 
row from the time-flow table.

Report Opens a print preview window containing a 
report that details the input data for this 
dialog box.

Graph Opens a graph window plotting the 
hydrograph curve defined by the points in the 
table

Column Description

Hydrograph Time This field allows you to define time of the 
hydrograph curve point.

Flow This field allows you to define flow at the 
specified time for the hydrograph curve point.
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Pond Infiltration
Ponds can lose water by infiltration into groundwater. Any water lost by infiltration 
does not show up in downstream links.

The user can specify "None" (default) if pond infiltration is not being considered. The 
user can specify two alternative ways of entering pond infiltration rates:

1. a Constant Flow rate given in flow units

2. an Average Infiltration rate in depth per unit time which is multipied by the area of 
the pond surface at that time step to determine the infiltration rate.

In applying either method, the model also has a stability filter when the pond water 
depth is below 0.5 ft so that the infiltration rate will linearly reduce to zero as the 
depth decreases to zero.
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Chapter

Calculating Your Model
Calculation Options Manager
You create calculation profiles in the Calculation Options Manager. The Calculation 
Options Manager consists of a list pane that displays all of the calculation profiles 
associated with the current project, and a toolbar that contains some common 
commands.

To display the Calculation Options Manager, select View > Calculation Options.

The Calculation Options manager allows you to create option profiles that contain 
various calculation settings. The dialog box contains a list pane that displays all of the 
option profiles currently contained in the project, along with a toolbar.

The toolbar contains the following buttons: 

If the Property Editor is open, highlighting a option profile in the list causes the 
settings that make up the profile appear there. If the Property Editor is not open, you 
can display the settings that make up the profile by highlighting the desired profile and 
clicking the Properties button in the Calculation Options Manager.

New Creates a new calculation profile. Define 
the attributes for the profile in the 
Property Editor.

Delete Deletes the currently highlighted option 
profile.

Rename Lets you rename the currently 
highlighted calculation profile.

Help Displays online help for the Calculation 
Options manager.
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Creating Calculation Profiles
Calculation profiles contain attributes that define how your model is calculated in 
Bentley SewerGEMS V8i. You create calculation profiles in the Calculation Options 
Manager. You can create several calculation profiles with different attributes 
depending on the requirements of your project.

Bentley SewerGEMS V8i contains a default calculation profile called “Base Calcula-
tion Options.” If you do not create additional calculation profiles, Bentley Sewer-
GEMS V8i will use this default profile whenever you calculate your model.

Creating a Calculation Profile

To create a calculation profile:

1. Open the Calculation Options Manager by selecting View > Calculation 
Options.

2. Click the New button. A new profile appears in the list with a default name.

3. Type a new name for the profile.

4. Double-click the new profile to display its attributes in the Property Editor. Edit 
the attributes as required.

Editing a Calculation Profile

You edit the attributes of a calculation profile in the Property Editor. 

If you select a calculation profile while the Property Editor is open, the attributes for 
that profile appear there. If the Property Editor is not open, you can display the 
attributes of the calculation profile by double-clicking the profile in the Calculation 
Options Manager.

Deleting a Calculation Profile

To delete a calculation profile:

1. Open the Calculation Options Manager by selecting View > Calculation 
Options.

2. Select the profile you want to delete.

3. Press the Delete key, click the Delete button in the Calculation Options Manager, 
or right-click the profile and select Delete from the shortcut menu.
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Renaming a Calculation Profile

To rename a calculation profile:

1. Open the Calculation Options Manager by selecting View > Calculation 
Options.

2. Select the profile you want to rename.

3. Click the Rename button or right-click and select Rename from the shortcut 
menu.

4. Type a new name for the profile, then press Enter.

Calculation Profile Attributes

A Calculation Options Profile contains the information described in the following 
table.

Table 8-1: Calculation Profile Attributes

Attribute Description

General

Label Lets you specify a name for the options profile.

Notes Lets you enter descriptive text to be associated with the current 
calculation profile.

Calculation Options

Engine Type Lets you choose between the Implicit and Explicit (SWMM 
5) calculation engines. Selecting Explicit (SWMM 5) as the 
engine type makes several SWMM attribute fields available in 
the Property Editor for elements. For more information on 
Property Editor element attributes, see “Editing Attributes in 
the Property Editor” on page 15-821.

Note: If a catchment is using the EPA SWMM 
runoff method and not using the default 
infiltration method specified in the SWMM 
calc options then neither hydrology or 
network will calculate.

If the user is not using the EPA SWMM 
runoff method, then any combination of 
other runof methods can be used. 
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Base Date Select the calendar date on which the simulation begins.

Analysis 
Start Time

Select the clock time at which the simulation begins.

Output 
Increment

Lets you set the Output Increment you want to use to display 
the output hydrographs of a network analysis.

Total 
Simulation 
Time

Lets you specify the duration of the simulation.

Calculation 
Time Step 

Lets you specify the computational time step in hydrodynamic 
calculations. See “Troubleshooting DynamicWave Model 
Calculations” on page 8-448 for more information. 

Hydrologic 
Time Step

Lets you specify the computational time step in hydrology 
runoff calculations.

Pattern 
Setup

Pattern setups allow you to match unit sanitary (dry weather) 
loads with appropriate loading patterns. Specify a default 
Pattern Setup to associate with each Calculation Option 
profile. Each scenario can use a different Pattern Setup, thus 
allowing you to model different loading alternatives for 
different extended period simulations.

Receding 
Limb 
Multiplier

Helps define the shape of the modified rational hydrograph. 
The receding limb of all modified rational hydrographs are 
taken to occur over a duration obtained by multiplying this 
value by the Tc. Refer to local design policy and practices to 
determine the appropriate value of Tc. The default value is 1.0.

Pressure 
Friction 
Method

Lets you select a default friction method for all pressure pipes 
in your model. Select Mannings, Hazen-Williams, Darcy-
Weisbach, or Kutters. The Property Editor attributes for 
pressure pipes are updated with the default friction method 
selected here.

Advanced Calculation Options

Y Iteration 
Tolerance

Implicit numerical scheme Newton iteration converge criteria 
for depth/elevation. We strongly recommend using the default 
value.

Table 8-1: Calculation Profile Attributes

Attribute Description
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LPI 
Coefficient

A coefficient for advanced LPI supercritical-subcritical mix 
flow computation algorithm. We strongly recommend using 
the default value.

NR 
Weighting 
Coefficient

Implicit numerical scheme Newton iteration weighting factor. 
A Larger value tends to increase stability, but at the cost of 
performance. We suggest using the default value or values 
between 0.6 and 0.85, but values between 0.1 and 1.0 are valid. 
Use 0.98 - 1.0 in very difficult cases. See “Troubleshooting 
DynamicWave Model Calculations” on page 8-448 for more 
information. 

NR 
Iterations

 Allowed maximum Newton iterations in one time step during 
the numerical solution process. This attribute value is used to 
prevent the numerical solver from unlimited iterations under 
situations when the solver is unable to reach convergence.

Relaxation 
Weighting 
Coefficient

Implicit numerical scheme relaxation factor for network 
computations. The range of valid values is between 0.5 and 
0.9.

Computatio
n Distance

Implicit numerical scheme computational distance interval. 
The model will automatically insert additional computational 
sections based on this value, a small value increases stability 
while large value increases performance.
Computational distance is the lesser of

• one half the pipe length

or

• default distance

See “Troubleshooting DynamicWave Model Calculations” on 
page 8-448 for more information. 

Table 8-1: Calculation Profile Attributes

Attribute Description
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Start Type By default the engine assumes a dry condition to start the 
simulation; i.e., all inflows are zero and all depths are zero in 
all elements at the beginning. For situations in which you want 
a non-zero starting flow or the catchments’ hydrology 
calculations to give none-zero flows, the model provides two 
options to start the simulation: select Warm Up Time for a 
warm-up start or Transition Start for a transitional start. In a 
warm-up start, the model estimates initial depths based on 
none-zero inflows and uses a user-specified warm-up time 
(entered in the Warm Up Time field) to approach steady state 
conditions prior to starting the actual simulation. In a transition 
start, the model initiates the simulation from zero flows and 
immediately reaches the actual none-zero flows in the first 
time step and continued the simulation. See “Troubleshooting 
DynamicWave Model Calculations” on page 8-448 for more 
information. 

Warm Up 
Time

Lets you enter a warm-up time for warm-up starts. This field is 
available only when you select Warm Up Time as the Start 
Type.

SWMM Options

Inertial 
Terms

Lets you define how the inertial terms in the St. Venant 
momentum equation will be handled:

• Keep—Maintains these terms at their full value under all 
conditions.  

• Dampen—Reduces the terms as flow comes closer to 
being critical and ignores them when flow is supercritical.  

• Ignore—Drops the terms altogether from the momentum 
equation, producing what is essentially a Diffusion Wave 
solution. 

Allow 
Ponding at 
Gravity 
Structures

Lets you select whether or not to allow excess water to collect 
at gravity structures and be re-introduced into the system as 
conditions permit. Select True to allow ponding at gravity 
structures in your model. In order for ponding to actually occur 
at a particular node, you must enter a non-zero value for the 
node’s Ponded Area attribute. 

Table 8-1: Calculation Profile Attributes

Attribute Description
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Antecedent 
Dry Period

Lets you enter the number of days with no rainfall prior to the 
start of the simulation. This value is used to compute an initial 
buildup of pollutant load on the subcatchment surfaces.

Use Variable 
Time Step?

Lets you select whether or not to use a variable time step. The 
variable step is computed for each time period to prevent an 
excessive change in water depth at each node. Select True to 
use a variable time step. a safety factor (between 10 and 200%) 
that will be applied against the variable time step as 
automatically derived to preserve the Courant stability 
criterion.

Time Step 
Multiplier 
(%)

Lets you enter a safety factor (between 10 and 200%) to be 
applied against the variable time step as automatically derived 
to preserve the Courant stability criterion. This field is 
available only if you select True in the Use Variable Time 
Step? field.

Default 
Infiltration 
Method

Lets you determine how to model infiltration of rainfall into 
the upper soil zone of subcatchments. Select Horton, Green-
Ampt, or SCS CN. If you change this attribute, you will have 
to re-enter values for the infiltration parameters in each 
subcatchment. 

Routing 
Method

Lets you determine which method to use to route flows 
through the conveyance system. Select Uniform Flow, 
Kinematic Wave, or Dynamic Wave.

Table 8-1: Calculation Profile Attributes

Attribute Description
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What is the Difference Between the Implicit and SWMM Engines?

The "engine" refers to the type of numerical finite difference solution used to solve the 
St. Venant equations, which describe unsteady one-dimensional, free surface flow. 
Bentley SewerGEMS V8i contains two types of engines:

• The implicit engine uses a four-point implicit finite difference solver which tends 
to be more stable than an explicit solver. The implicit engine in Bentley Sewer-
GEMS V8i is based on the solver in the National Weather Service FLDWAV 
model. 

• The SWMM engine uses the solver from the EPA Stormwater Management 
Model version 5. This is an explicit solver which, while more prone to stability 
problems, exactly matches the results from SWMM 5.

Inflow hydrographs are also handled differently by the two engines. The implicit 
engine interpolates flows between the final flow in the hydrograph and the end time. 
The SWMM engine assumes that all flows after the final inflow point are zero.

You select the engine you want to use in the Calculation Options manager.

Integration 
Method

Lets you determine which integration method to use: Modified 
Euler or Picard Iterations (a method of successive 
approximations). 

Minimum 
Surface 
Area (Acres)

Lets you enter the minimum surface area to be used at nodes 
when computing changes in water depth. If you enter 0, then 
the default value of 12.566 ft2 (i.e., the area of a 4-ft diameter 
manhole) is used.

Time Step 
For Conduit 
Lengthening

Lets you enter the time step, in seconds, used to artificially 
lengthen conduits so that they meet the Courant stability 
criterion under full-flow conditions (i.e., the travel time of a 
wave will not be smaller than the specified conduit 
lengthening time step). As this value is decreased, fewer 
conduits will require lengthening. A value of 0 means that no 
conduits will be lengthened.

Dry Step 
(hours)

Enter the time step length used for runoff computations 
(consisting essentially of pollutant buildup) during periods 
when there is no rainfall and no ponded water. This must be 
greater or equal to the hydrologic time step.

Table 8-1: Calculation Profile Attributes

Attribute Description
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Note: If a catchment is using the EPA SWMM runoff method and not 
using the default infiltration method specified in the SWMM 
calculation options then neither hydrology or network will 
calculate.

If the user is not using the EPA SWMM runoff method, then any 
combination of other runof methods can be used.

SWMM Treats Pump and Their Discharge Lines Differently Than 
the Implicit Engine. How Do I Handle the Differences, Especially If I 
Want to Use Both Engines?

SWMM can "model" a force main without accounting for the hydraulics of the force 
main from the pump. You simply specify the discharge node for the force main and the 
water arrives there. In Bentley SewerGEMS V8i, the hydraulics of the discharge 
conduit are explicitly considered. 

If you want to get consistent results for a pump line in SWMM and the Bentley Sewer-
GEMS V8i implicit engine, the force main should be represented as a "Virtual 
conduit" in Bentley SewerGEMS V8i. For more information about virtual conduits, 
see “What Is A Virtual Conduit?” on page 6-259.

Calculation Executive Summary Dialog Box
The Calculation Executive Summary dialog box opens automatically after you 
compute a model. This dialog box reports a summary of the calculations performed on 
your model. You can also see this report by clicking Report > Calculation Executive 
Summary.

Click Detailed Summary for more information about the calculation (see “Calcula-
tion Detailed Summary Dialog Box” on page 8-440) or Close to close the dialog box.

The Executive Summary dialog box displays the following information:

Scenario Label Displays the currently selected scenario.

Run Completed Displays the date and time at which the run was 
completed.

Storm Event Label Displays the currently selected hydrology 
alternative.

Global Storm Event Displays the current global storm event.

Return Event Displays the recurrence period of the global storm 
event.
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Calculation Detailed Summary Dialog Box
The Calculation Detailed Summary dialog box provides a detailed reports of the 
calculations performed on your model. You can open this dialog box by calculating 
your model and clicking Detailed Summary in the Calculation Executive Summary 
dialog box. You can also see this report by clicking Report > Calculation Detailed 
Summary.

Click the tabs in the Calculation Detailed Summary dialog box to review the details of 
the report:

Total Inflow Volume Displays the total volume of flow that enters the 
model during the course of the analysis.

Total System Overflow 
Volume

Displays the total volume of flow that exits the 
system due to overflows. This value does not 
include volume of flow that exits at outfalls.

Total Gutter Volume 
Change

Displays the gutter flow volume difference 
between the initial state and the state at the end of 
the computation.

Total System Outflow 
Volume

Displays the total volume of flow that exits the 
outfalls during the course of the analysis.

Total System Volume 
Change

Displays the total system flow volume difference 
between the initial state and the state at the end of 
the computation.

Continuity Error Displays the total system computational continuity 
balance error which accounts for total inflows into 
the system, outflows, flow losses due to 
overflows, and volume changes. Generally 
speaking, a high continuity error (>5%) is an 
indication that the system is hydraulically very 
challenging and the hydraulic engine may have 
difficulty achieving stable results. 

Total N-R Iterations Displays the number of Newton iterations used in 
the calculation. This attribute value is used to 
prevent the numerical solver from unlimited 
iterations under situations when the solver is 
unable to reach convergence. A more 
hydraulically-complex model requires a larger 
number of iterations than a less complex model.
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• “Calculation Options Tab” on page 8-441

• “Catchment Summary Tab” on page 8-442

• “General Summary Tab” on page 8-443

• “Node Summary Tab” on page 8-444

• “Gutter Summary Tab” on page 8-445

Calculation Options Tab

This tab displays the current settings in the Property Editor for calculation options. To 
change this, click View > Calculation Options and change the settings in the Prop-
erty Editor.

The Calculation Options tab displays the following information:

Label Displays the currently selected calculation 
options.

Total Simulation Time Displays the duration of the model simulation.

Calculation Time Step Displays the calculation time step used in 
calculations of your model. See “Troubleshooting 
DynamicWave Model Calculations” on page 8-
448 for more information. 

Output Increment Displays the output increment used in the 
calculation of your model.

Hydrologic Time Step Displays the hydrologic time step used in 
calculations of your model.

Y Iteration Tolerance Displays the Y iteration tolerance used in 
calculations of your model.

LPI Coefficient Displays the LPI coefficient used in calculations 
of your model. 
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Catchment Summary Tab

This tab displays a table of data about catchments in your model. You cannot modify 
the table, it is read-only. To edit a catchment, select it in the Drawing Pane and edit its 
attributes in the Property Editor. 

The Catchment Summary tab displays the following information:

NR Weighting 
Coefficient

Implicit numerical scheme Newton iteration 
weighting factor. A Larger value tends to increase 
stability, but at the cost of performance. We 
suggest using the default value or values between 
0.6 and 0.85, but values between 0.1 and 1.0 are 
valid. Use 0.98 - 1.0 in very difficult cases. See 
“Troubleshooting DynamicWave Model 
Calculations” on page 8-448 for more 
information. 

NR Iterations Allowed maximum Newton iterations in one time 
step during the numerical solution process. This 
attribute value is used to prevent the numerical 
solver from unlimited iterations under situations 
when the solver is unable to reach convergence.

Relaxation Weighting Displays the relaxation weighting used in 
calculations of your model. 

Computational 
Distance

Displays the computational distance used in 
calculations of your model. See “Troubleshooting 
DynamicWave Model Calculations” on page 8-
448 for more information. 

Label Displays the label of each catchment in your 
model.

Runoff Method Displays the runoff method associated with each 
catchment.

Loss Method Displays the loss method associated with each 
catchment.

Total Rainfall Depth Displays the total rainfall depth.

Area Displays the catchment size.
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General Summary Tab

This tab displays a table of calculations for elements in your model. You cannot 
modify the table, it is read-only. To edit an element, select it in the Drawing Pane and 
edit its attributes in the Property Editor.

The General Summary tab displays the following information:

Runoff Volume Displays the calculated runoff volume.

Flow (Peak) Displays the calculated peak flow.

Time to Peak Displays how long after the simulation starts that 
peak runoff happens.

Label Displays the label of each element in your model.

Element Type Displays the kind of element being reported on.

Branch Provides information for engineers who are 
troubleshooting a model or looking to simplify a 
particularly complex model.
The Bentley SewerGEMS V8i calculation engine 
includes a heuristic routine that decomposes a 
network into its component branches, and each 
branch is solved independently using an implicit 
solver. Each branch comprises a series of 
connected elements. Elements with the same 
branch ID are solved together.

Time to Max Flow Displays how long after the simulation starts that 
maximum flow happens.

Flow (Maximum) Displays the calculated flow through elements.

Velocity (Maximum) Displays the calculated velocity of flow through 
elements.

Maximum HGL Displays the calculated maximum hydraulic grade 
line for each element.
Bentley SewerGEMS V8i User’s Guide 8-443



Calculation Detailed Summary Dialog Box
Node Summary Tab

This tab displays a table of calculations for nodes in your model. Nodes include catch 
basins, manholes, outfalls, ponds (but not cross-sections, catchments, etc.). You 
cannot modify the table, it is read-only. To edit a node, select it in the Drawing Pane 
and edit its attributes in the Property Editor.

The Node Summary tab displays the following information:

Label Displays the label of each node in your model.

Element Type Displays the kind of node being reported on.

Branch Provides information for engineers who are 
troubleshooting a model or looking to simplify a 
particularly complex model.The Bentley 
SewerGEMS V8i calculation engine includes a 
heuristic routine that decomposes a network into 
its component branches, and each branch is solved 
independently using an implicit solver. Each 
branch comprises a series of connected elements. 
Elements with the same branch ID are solved 
together.

Time to Max Inflow Displays how long after the simulation starts that 
maximum flow into the nodes occurs.

Flow (Maximum in) Displays the calculated flow into the nodes. 
(Outfalls cannot have inflow.)

Time to Maximum 
Inlet Flow

Displays how long after the simulation starts that 
maximum flow into the nodes occurs.

Flow (Surface 
Maximum)

Displays the maximum flow into each of the nodes 
of your model.

Time to Max Captured 
Flow

Displays how long after the simulation starts that 
maximum captured flow occurs in each catch 
basin.

Flow (Captured 
Maximum)

Displays the calculated captured flow in each 
catch basin.

Time to Maximum 
Overflow

Displays how long after the simulation starts that 
maximum overflow occurs at each of the nodes in 
your model.
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Gutter Summary Tab

This tab displays a table of data about gutters in your model. You cannot modify the 
table, it is read-only. To edit a gutter, select it in the Drawing Pane and edit its 
attributes in the Property Editor.

The Gutter Summary tab displays the following information:

SWMM Engine Summary Report
When a SWMM engine run finishes it produces a summary report which is written to 
Notepad (as opposed to the Calculation Summary report when the Implicit engine 
solves). This report is a Notepad file and is not saved with the model once the file is 
closed. This report provides useful overall information on the run. If you want to 
review this result later in the session, you can minimize it instead of closing it. If you 
want to save it for later  use, execute a File > Save command.

User Notifications
User notifications are messages about your model. These messages can warn you 
about potential issues with your model, such as slopes that might be too steep or 
elements that slope in the wrong direction. These messages also point you to errors in 
your model that prevent Bentley SewerGEMS V8i from solving your model.

Flow (Overflow 
Maximum)

Displays the maximum overflow at each of the 
nodes of your model.

Label Displays the label of each gutter in your model.

Open Cross Section Displays the kind of open cross section that 
defines the gutter.

Flow (Maximum) Displays the calculated flow through the gutters.

Time to Max Flow Displays how long after the simulation starts that 
maximum flow happens.

Velocity (Maximum) Displays the calculated velocity of flow through 
gutters.

Maximum HGL Displays the calculated maximum hydraulic grade 
line for each gutter.
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To see user notifications:

1. Compute your model.

2. If needed, open the User Notification manager by clicking View > User 
Notifications (Ctrl + 3).

3. Or, if the calculation fails to compute because of an input error, when your model 
is finished computing, Bentley SewerGEMS V8i prompts you to view user notifi-
cations to validate the input data.

You must fix any errors identified by red circles before Bentley SewerGEMS V8i 
can compute a result.

Errors identified by orange circles are warnings that do not prevent the computa-
tion of the model.

4. In the User Notifications manager, if a notification pertains to a particular 
element, you can double-click the notification to magnify and display the element 
in the center of the drawing pane.

5. As needed, use the element label to identify the element that generates the error 
and use the user notification message to edit the element’s properties to resolve 
the error.

User Notifications Manager

The User Notifications Manager displays warnings and error messages that are turned 
up by Bentley SewerGEMS V8i’s validation routines. If the notification references a 
particular element, you can zoom straight to that element by either double-clicking the 
notification, or right-clicking it and selecting the Zoom To command.

• Warnings are denoted by an orange icon and do not prevent the model from 
calculating successfully.

• Errors are denoted by a red icon, and the model will not successfully calcu-
late if errors are found.

The User Notifications Manager consists of a toolbar and a tabular view containing a 
list of warnings and error messages. The toolbar consists of the following buttons: 
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The User Notification Manager displays warnings and error messages in a tabular 
view. The table includes the following columns:

Details Displays the User Notification Details 
dialog box, which includes information 
about any warning or error messages. For 
more information, see “User Notification 
Details Dialog Box” on page 8-448.

Save Saves the user notifications as a comma-
delimited .csv file. You can open the .csv 
file in Microsoft Excel or Notepad.

Report Displays a User Notification Report.

Copy Copies the currently highlighted warning or 
error message to the Windows clipboard.

Zoom To If the warning or error message is related to 
a specific element in your model, click this 
button to center the element in question in 
the drawing pane.

Help Displays online help for the User 
Notification Manager.

Message ID This column displays the message ID associated 
with the corresponding message. 

Scenario ID This column displays the scenario associated with 
the corresponding message. This column will 
display “Base” unless you ran a different scenario.

Element Type This column displays the element type associated 
with the corresponding message.

Element ID This column displays the element ID associated 
with the corresponding message. 

Label If the notification is caused by a specific element, 
this column displays the label of the element 
associated with the corresponding message.
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User Notification Details Dialog Box

This dialog lists the elements that are referred to by a time-sensitive user notification 
message. In the User Notification dialog, there is a time column that displays the time-
step during which time-sensitive messages occur. These messages will say “during 
this time-step” or “for this time-step”, and do not display information about the refer-
enced element or elements. Double-clicking one of these messages in the User Notifi-
cations dialog opens the User Notification Details dialog, which does provide 
information about the referenced element(s).

You can double-click messages in the User Notification Details dialog to zoom the 
drawing pane view to the referenced element.

Troubleshooting DynamicWave Model Calculations
If your model does not successfully calculate, try the following steps:

1. If you are running hydrology (rainfall on catchments) as well as hydraulics, check 
the outflow hydrographs from catchments to make certain they are reasonable.

2. Check the model for errors:

– Use the Validate command and look at the warnings and/or errors that are 
reported.

– When you Calculate the model, validation routines are performed that are not 
included during a Validate operation. Review the warnings and/or errors that 
are returned from both levels of validation.

– Common data problems to look for include:

- Incorrect channel or conduit slopes: Reasonable slopes are generally 
small and rarely negative. You can view slopes along a reach visually by 
using the Profiles feature. You can find unusually large or negative slopes 
through User Notifications and FlexTable reports. You can Color Code 
link elements by Slope and look for excessive values. If the model has 
parallel conduits connected by a flat (slope value of 0) conduit, try 
making that conduit Inactive.

Message This column displays the description associated 
with the corresponding message.

Time If the user notification occurred during a specific 
time step, this column displays the time step. 
Otherwise, this column is left blank.

Source This column displays the validation routine that 
triggered the corresponding message.
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- Incorrect Channel or Conduit size: Look for unusual size changes along a 
reach. Color code drawing by Diameter to look for this type of discrep-
ancy.

- Very low flows: If flows are less than 0.01 cfs (0.001 m3/s), depths may 
fall below accuracy tolerances.

– Look for areas displaying common modeling difficulties to verify input data is 
correct:

- Flow splits at weirs and orifices that are dry at certain points during an 
extended period simulation.

- Hydrograph rapidly changes within a short time (minutes).

- Very sharp flood wave.

- Near-critical slopes.

- Significant and abrupt changes in the conduit size, shape and/or slope.

- Looped networks.

- Backwater up to a control structure.

- Significant backwater conditions.

- Flow control structures on relatively small storage nodes (ponds, wet-
wells).

- System inflows vastly exceeding the system capacity resulting in mass 
flooding.

- Unusually small ponds compared to their inflow.

- Many pumping stations in the system.

- Look for a mix of very long and very small pipes, especially when using 
the SWMM engine. Eliminate or combine short pipes because their effect 
on routing is small.  Break exceptionally long pipes into mutliple pipes 
that are each roughly the same length as other pipes in the network.

- Examine the User Notifications that are displayed after calculating.

- Examine Graphs and water surface Profiles. Create Flow plots at splits 
and at pump discharge areas and look for jagged peaks in the plot.

3. Default values for calculation options will work for the majority of cases, but 
some systems need small adjustments to converge. When the calculation is 
moving very slowly (you can observe that the model is stuck at certain times) or 
the results show apparent instabilities, it is an indication that the model is experi-
encing difficulties in converging to a stable and robust result. Try adjusting calc 
options in this order:

– Initial conditions: Options include warm start or transitional start. Try both 
and see if one gives better results for your system.
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– Computational Distance, Calculation Time Step, and NR Weighting Coeffi-
cient: Loop through the following process:

– Try an NR Weighting Coefficient value of between 0.9 and 0.99 with the 
default Computational Distance and Calculation Time Step.

– Set NR back to default and try reducing the Computational Distance value.

– Set Computational Distance back to default and try reducing the Calculation 
Time Step value.

– Keep the Calculation Time Step the same and repeat the above steps.

– Try increasing the the NR Iterations to 20.

Note: There is no absolute rule on whether the time step or the NR 
weighting coefficient should be changed or to what specific 
value; normally you should reduce the time step and increase 
the NR coefficient but sometimes the opposite can also help. 

4. Isolate problems areas: Isolate the problem area by incrementally deleting small 
sections of your model and re-computing. This may help you narrow down the 
source data that the engine has trouble with.  It may expose data entry issues or 
areas that are exhibiting common modeling difficulties.

5. Determine at what time step the problem occurs. Look for what is happening at 
that time. Is a weir beginning to overflow? Is it the first time a large pump comes 
on?

6. Switch to using the SWMM numerical engine. If there are problems when using 
the SWMM engine, try changing the Routing Method from Dynamic Wave 
(default) to Kinematic Wave or Uniform Flow. These methods do not handle 
backups as accurately as dynamic wave but they tend to be more stable.

Note: Headlosses at nodes are ignored during periods of supercritical 
flow.
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Chapter

Using Scenarios and
Alternatives
Scenarios and alternatives let you create, analyze, and recall an unlimited number of 
variations of your model. In Bentley SewerGEMS V8i powerful two-level design, 
scenarios contain alternatives to give you precise control over changes to the model. 

Understanding Scenarios and Alternatives
Scenario management in Bentley SewerGEMS V8i can dramatically increase your 
productivity in the "What If?" areas of modeling, including calibration, operations 
analysis, and planning. 

If you’ve never used scenarios and alternatives before, we recommend reading all of 
the topics in this section to gain a complete understanding of how they work. By 
investing a little time now to understand management, you can avoid unnecessary 
editing and data duplication. Take advantage of scenario management to get a lot more 
out of your model, with much less work and expense. 

Topics in this section include: 

• “Advantages of Automated Scenario Management” on page 9-452

• “A History of What-If Analyses” on page 9-452

• “The Scenario Cycle” on page 9-454

• “Scenario Attributes and Alternatives” on page 9-456

• “A Familiar Parallel” on page 9-456

• “Inheritance” on page 9-457

• “Local and Inherited Values” on page 9-459

• “Minimizing Effort through Attribute Inheritance” on page 9-459

• “Minimizing Effort through Scenario Inheritance” on page 9-460
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Advantages of Automated Scenario Management

In contrast to the old methods of scenario management (editing or copying data), auto-
mated scenario management using inheritance gives you significant advantages: 

• A single project file makes it possible to generate an unlimited number of "What 
If?" conditions without becoming overwhelmed with numerous modeling files 
and separate results.

• Because the software maintains the data for all the scenarios in a single project, it 
can provide you with powerful automated tools for directly comparing scenario 
results. Any set of results is immediately available at any time.

• The Scenario / Alternative relationship empowers you to mix and match groups of 
data from existing scenarios without having to re-declare any data.

• With inheritance, you do not have to re-enter data if it remains unchanged in a 
new alternative or scenario, avoiding redundant copies of the same data. Inherit-
ance also enables you to correct a data input error in a parent scenario and auto-
matically update the corrected attribute in all child scenarios.

These advantages, while obvious, may not seem compelling for small projects. It is as 
projects grow to hundreds or thousands of network elements that the advantages of 
true scenario inheritance become clear. On a large project, being able to maintain a 
collection of base and modified alternatives accurately and efficiently can be the 
difference between evaluating optional improvements and being forced to ignore 
them.

A History of What-If Analyses

The history of what-if analyses can be divided into two periods:

• “Before Haestad Methods - Distributed Scenarios” on page 9-452

• “With Haestad Methods: Self-Contained Scenarios” on page 9-454

Before Haestad Methods - Distributed Scenarios

Traditionally, there have only been two possible ways of analyzing the effects of 
change on a software model: 

• Change the model, recalculate, and review the results

• Create a copy of the model, edit that copy, calculate, and review the results
9-452 Bentley SewerGEMS V8i User’s Guide



Using Scenarios and Alternatives
Although either of these methods may be adequate for a relatively small system, the 
data duplication, editing, and re-editing becomes very time-consuming and error-
prone as the size of the system and the number of possible conditions increase. Also, 
comparing conditions requires manual data manipulation, because all output must be 
stored in physically separate data files.

Figure 9-1: Before Haestad Methods: Manual Scenarios
Bentley SewerGEMS V8i User’s Guide 9-453



Understanding Scenarios and Alternatives
With Haestad Methods: Self-Contained Scenarios

Effective scenario management tools need to meet these objectives: 

• Minimize the number of project files the modeler needs to maintain (one, ideally).

• Maximize the usefulness of scenarios through easy access to things such as input 
and output data, and direct comparisons.

• Maximize the number of scenarios you can simulate by mixing and matching data 
from existing scenarios (data reuse)

• Minimize the amount of data that needs to be duplicated to consider conditions 
that have a lot in common

The scenario management feature in Bentley SewerGEMS V8i successfully meets all 
of these objectives. A single project file enables you to generate an unlimited number 
of What If? conditions, edit only the data that needs to be changed, and quickly 
generate direct comparisons of input and results for desired scenarios. 

The Scenario Cycle

The process of working with scenarios is similar to the process of manually copying 
and editing data, but without the disadvantages of data duplication and troublesome 
file management. This process lets you cycle through any number of changes to the 
model, without fear of overwriting critical data or duplicating important information. 
Of course, it is possible to directly change data for any scenario, but an audit trail of 
scenarios can be useful for retracing the steps of a calibration series or for under-
standing a group of master plan updates.

Figure 9-2: Before Haestad Methods: Manual Scenarios 
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Scenario Attributes and Alternatives

Before we explore scenario management further, a few key terms should be defined: 

• Attribute—An attribute is a fundamental property of an object, and is often a 
single numeric quantity. For example, the attributes of a pipe include diameter, 
length, and roughness.

• Alternative—An alternative holds a family of related attributes so pieces of data 
that you are most likely to change together are grouped for easy referencing and 
editing. For example, a physical properties alternative groups physical data for the 
network's elements, such as elevations, sizes, and roughness coefficients.

• Scenario—A scenario has a list of referenced alternatives (which hold the 
attributes), and combines these alternatives to form an overall set of system condi-
tions that can be analyzed. This referencing of alternatives enables you to easily 
generate system conditions that mix and match groups of data that have been 
previously created. Note that scenarios do not actually hold any attribute data—
the referenced alternatives do.

A Familiar Parallel

Although the structure of scenarios may seem a bit difficult at first, anyone who has 
eaten at a restaurant should be able to relate fairly easily. A meal (scenario) is 
comprised of several courses (alternatives), which might include a salad, an entrée, 
and a dessert. Each course has its own attributes. For example, the entrée may have a 
meat, a vegetable, and a starch. Examining the choices, we could present a menu as in 
the following figure:

Figure 9-3: A Restaurant Meal Scenario
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The restaurant does not have to create a new recipe for every possible meal (combina-
tion of courses) that could be ordered. They can just assemble any meal based on what 
the customer orders for each alternative course. Salad 1, Entrée 1, and Dessert 2 might 
then be combined to define a complete meal. 

Generalizing this concept, we see that any scenario references one alternative from 
each category to create a big picture that can be analyzed. Note that different types of 
alternatives may have different numbers and types of attributes, and any category can 
have an unlimited number of alternatives to choose from. 

Figure 9-4: Generic Scenario Anatomy 

Inheritance

The separation of scenarios into distinct alternatives (groups of data) meets one of the 
basic goals of scenario management: maximizing the number of scenarios you can 
develop by mixing and matching existing alternatives. Two other primary goals have 
also been addressed: a single project file is used, and easy access to input data and 
calculated results is provided in numerous formats through the intuitive graphical 
interface. 

But what about the other objective: minimizing the amount of data that needs to be 
duplicated to consider conditions that have a lot of common input? Surely an entire set 
of pipe diameters should not be re-specified if only one or two change? 

The solution is a familiar concept to most people: inheritance. 
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In the natural world, a child inherits characteristics from a parent. This may include 
such traits as eye-color, hair color, and bone structure. There are two significant differ-
ences between the genetic inheritance that most of us know and the way inheritance is 
implemented in software: 

• “Overriding Inheritance” on page 9-458

• “Dynamic Inheritance” on page 9-458

Overriding Inheritance

Overriding inheritance is the software equivalent of cosmetics. A child can override 
inherited characteristics at any time by specifying a new value for that characteristic. 
These overriding values do not affect the parent, and are therefore considered local to 
the child. Local values can also be removed at any time, reverting the characteristic to 
its inherited state. The child has no choice in the value of his inherited attributes, only 
in local attributes. 

For example, suppose a child has inherited the attribute of blue eyes from his parent. 
Now the child puts on a pair of green- tinted contact lenses to hide his natural eye 
color. When the contact lenses are on, we say his natural eye color is overridden 
locally, and his eye color is green. When the child removes the tinted lenses, his eye 
color instantly reverts to blue, as inherited from his parent. 

Dynamic Inheritance

Dynamic inheritance does not have a parallel in the genetic world. When a parent's 
characteristic is changed, existing children also reflect the change. Using the eye-color 
example, this would be the equivalent of the parent changing eye color from blue to 
brown, and the children's eyes instantly inheriting the brown color also. Of course, if 
the child has already overridden a characteristic locally, as with the green lenses, his 
eyes will remain green until the lenses are removed. At this point, his eye color will 
revert to the inherited color, now brown. 

This dynamic inheritance has remarkable benefits for applying wide-scale changes to 
a model, fixing an error, and so on. If rippling changes are not desired, the child can 
override all of the parent's values, or a copy of the parent can be made instead of a 
child. 
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Local and Inherited Values

Any changes that are made to the model belong to the currently active scenario and 
the alternatives that it references. If the alternatives happen to have children, those 
children will also inherit the changes unless they have specifically overridden that 
attribute. The following figure demonstrates the effects of a change to a mid-level 
alternative. Inherited values are shown as gray text, local values are shown as black 
text.

Figure 9-5: A Mid-level Hierarchy Alternative Change 

Minimizing Effort through Attribute Inheritance

Inheritance has an application every time you hear the phrase, "just like x except for 
y." Rather than specifying all of the data from x again to form this new condition, we 
can create a child from x and change y appropriately. Now we have both conditions, 
with no duplicated effort. 

We can even apply this inheritance to our restaurant analogy as follows. Inherited 
values are shown as gray text, local values are shown as black text. 

Note: Salad 3 could inherit from Salad 2, if we prefer: "Salad 3 is just 
like Salad 2, except for the dressing." 

• "Salad 2 is just like Salad 1, except for the dressing."

• "Salad 3 is just like Salad 1, except for the dressing."
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Note: If the vegetable of the day changes (say from green beans to 
peas), only Entrée 1 needs to be updated, and the other entrées 
will automatically inherit the vegetable attribute of "Peas" 
instead of "Green Beans." 

• "Entrée 2 is just like Entrée 1, except for the meat and the starch."

• "Entrée 3 is just like Entrée 2, except for the meat."

Note: Dessert 3 has nothing in common with the other desserts, so it 
can be created as a "root" or base alternative. It does not inherit 
its attribute data from any other alternative. 

• "Dessert 2 is just like Dessert 1, except for the topping."

Minimizing Effort through Scenario Inheritance

Just as a child alternative can inherit attributes from its parent, a child scenario can 
inherit which alternatives it references from its parent. This is essentially still the 
phrase just like x except for y, but on a larger scale. 

Carrying through on our meal example, consider a situation where you go out to 
dinner with three friends. The first friend places his order, and the second friend orders 
the same thing except for the dessert. The third friend orders something totally 
different, and you order the same meal as hers except for the salad. 

The four meal scenarios could then be presented as follows (inherited values are 
shown as gray text, local values are shown as black text): 

• "Meal 2 is just like Meal 1, except for the dessert." The salad and entrée alterna-
tives are inherited from Meal 1.
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• "Meal 3 is nothing like Meal 1 or Meal 2." A totally new base or root is created.

• "Meal 4 is just like Meal 3, except for the salad." The entrée and dessert alterna-
tives are inherited from Meal 3.

Scenario Example - Simple Water Distribution 
System
Let us consider a fairly simple water distribution system: a single reservoir supplies 
water by gravity to three junction nodes.

Figure 9-6: Example Water Distribution System

Although true water distribution scenarios include such alternative categories as initial 
settings, operational controls, water quality, and fire flow, we are going to focus on the 
two most commonly changed sets of alternatives: demands and physical properties. 
Within these alternatives, we are going to concentrate on junction baseline demands 
and pipe diameters.
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Building the Model (Average Day Conditions)

During model construction, probably only one alternative from each category is going 
to be considered. This model is built with average demand calculations and prelimi-
nary pipe diameter estimates. At this point we can name our scenario and alternatives, 
and the hierarchies look like the following (showing only the items of interest):

Analyzing Different Demands (Maximum Day Conditions)

In our example, the local planning board also requires analysis of maximum day 
demands, so a new demand alternative is required. No variation in demand is expected 
at J-2, which is an industrial site. As a result, the new demand alternative can inherit J-
2’s demand from Average Day while the other two demands are overridden.

Now we can create a child scenario from Average Day that inherits the physical alter-
native, but overrides the selected demand alternative. As a result, we get the following 
scenario hierarchy:
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Since no physical data (pipe diameters) have been changed, the physical alternative 
hierarchy remains the same as before.

Another Set of Demands (Peak Hour Conditions)

Based on pressure requirements, the system is adequate to supply maximum day 
demands. Another local regulation requires analysis of peak hour demands, with 
slightly lower allowable pressures. Since the peak hour demands also share the indus-
trial load from the Average Day condition, Peak Hour can be inherited from Average 
Day. In this instance, Peak Hour could inherit just as easily from Maximum Day.

Another scenario is also created to reference these new demands, as shown below:

Note again that we did not change any physical data, so the physical alternatives 
remain the same.

Correcting an Error

This analysis results in acceptable pressures, until it is discovered that the industrial 
demand is not actually 500 gpm—it is 1,500 gpm. Because of the inheritance within 
the demand alternatives, however, only the Average Day demand for J-2 needs to be 
updated. The changes ripple through to the children. After the single change is made, 
the demand hierarchy is as follows:

Notice that no changes need to be made to the scenarios to reflect these corrections. 
The three scenarios can now be calculated as a batch to update the results.
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When these results are reviewed, it is determined that the system does not have the 
ability to adequately supply the system as it was originally thought. The pressure at J-
2 is too low under peak hour demand conditions.

Analyzing Improvement Suggestions

To counter the headloss from the increased demand load, two possible improvements 
are suggested:

• A much larger diameter is proposed for P-1 (the pipe from the reservoir). This 
physical alternative is created as a child of the Preliminary Pipes alternative, 
inheriting all the diameters except P-1’s, which is overridden.

• Slightly larger diameters are proposed for all pipes. Since there are no commonal-
ities between this recommendation and either of the other physical alternatives, 
this can be created as a base (root) alternative.

These changes are then incorporated to arrive at the following hierarchies:

This time, the demand alternative hierarchy remains the same since no demands were 
changed. The two new scenarios (Peak, Big P-1, Peak, All Big Pipes) can be batch run 
to provide results for these proposed improvements. 

Next, features like Scenario Comparison Annotation (from the Scenario Manager) and 
comparison Graphs (for extended period simulations, from the element editor dialog 
boxes) can be used to directly determine which proposal results in the most improved 
pressures.
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Finalizing the Project

It is decided that enlarging P-1 is the optimum solution, so new scenarios are created 
to check the results for average day and maximum day demands. Notice that this step 
does not require handling any new data. All of the information we want to model is 
present in the alternatives we already have!

Also note that it would be equally effective in this case to inherit the Avg. Day, Big P-
1 scenario from Avg. Day (changing the physical alternative) or to inherit from Peak, 
Big P-1 (changing the demand alternative). Likewise, Max. Day, Big P-1 could inherit 
from either Max. Day or Peak, Big P-1.

Neither the demand nor physical alternative hierarchies were changed in order to run 
the last set of scenarios, so they remain as they were.

Summary

In contrast to the old methods of scenario management (editing or copying data), auto-
mated scenario management using inheritance gives you significant advantages:

• A single project file makes it possible to generate an unlimited number of What 
If? conditions without becoming overwhelmed with numerous modeling files and 
separate results.
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• Because the software maintains the data for all the scenarios in a single project, it 
can provide you with powerful automated tools for directly comparing scenario 
results. Any set of results is immediately available at any time.

• The Scenario / Alternative relationship empowers you to mix and match groups of 
data from existing scenarios without having to re-declare any data.

• With inheritance, you do not have to re-enter data if it remains unchanged in a 
new alternative or scenario, avoiding redundant copies of the same data. Inherit-
ance also enables you to correct a data input error in a parent scenario and auto-
matically update the corrected attribute in all child scenarios.

These advantages, while obvious, may not seem compelling for small projects. It is as 
projects grow to hundreds or thousands of network elements that the advantages of 
true scenario inheritance become clear. On a large project, being able to maintain a 
collection of base and modified alternatives accurately and efficiently can be the 
difference between evaluating optional improvements and being forced to ignore 
them.

To learn more about actually using scenario management in our software, start by 
running the scenario management tutorial from the Help menu or from within the 
scenario manager itself. Then load one of the SAMPLE projects and explore the 
scenarios defined there. For context-sensitive help, press F1 or the Help button any 
time there is a screen or field that puzzles you.

Scenarios
A Scenario contains all the input data (in the form of Alternatives), calculation 
options, results, and notes associated with a set of calculations. Scenarios let you set 
up an unlimited number of “What If?” situations for your model, and then modify, 
compute, and review your system under those conditions.

You can create scenarios that reuse or share data in existing alternatives, submit 
multiple scenarios for calculation in a batch run, switch between scenarios, and 
compare scenario results—all with a few mouse clicks. There is no limit to the number 
of scenarios that you can create.
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Base and Child Scenarios

Note: The calculation options are not inherited between scenarios, but 
are duplicated when the scenario is first created. The 
alternatives and data records, however, are inherited. There is a 
permanent, dynamic link from a child back to its parent.

There are two types of scenarios: 

• Base Scenarios—Contain all of your working data. When you start a new project, 
you begin with a default base scenario. As you enter data and calculate your 
model, you are working with this default base scenario and the alternatives it 
references.

• Child Scenarios—Inherit data from a base scenario, or other child scenarios. 
Child scenarios allow you to freely change data for one or more elements in your 
system. Child scenarios can reflect some or all of the values contained in their 
parent. This is a very powerful concept, giving you the ability to make changes in 
a parent scenario that will trickle down through child scenarios, while also giving 
you the ability to override values for some or all of the elements in child 
scenarios.

Creating Scenarios

You create new scenarios in the Scenario Manager. A new scenario can be a Base 
scenario or a Child scenario. For information about the differences between the two 
types of scenarios, see “Base and Child Scenarios” on page 9-467. 

To create a new scenario:

1. Select View > Scenarios to open the Scenario Manager, or click the Scenario 
Manager tab.

2. Click the New button and select whether you want to create a Base scenario or a 
Child Scenario. When creating a Child scenario, you must first highlight the 
scenario from which the child is derived in the Scenario Manager tree view.

By default, a new scenario comprises the Base Alternatives associated with each 
alternative type.

3. Double-click the new scenario to edit its properties in the Property Editor.

Editing Scenarios

You edit scenarios in two places in Bentley SewerGEMS V8i:
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• The Scenario Manager lists all of the project’s scenarios in a hierarchical tree 
format, and displays the Base/Child relationship between them. 

• The Property Editor displays the alternatives that make up the scenario that is 
currently highlighted in the Scenario Manager, along with the scenario label, any 
notes associated with the scenario, and the calculation options profile that is used 
when the scenario is calculated.

To edit a scenario:

1. Select View > Scenarios to open the Scenario Manager, or click the Scenario 
Manager tab.

2. Double-click the scenario you want to edit to display its properties in the Property 
Editor.

3. Edit any of the following properties as desired:

– Scenario label - This is the same operation as renaming the scenario in the 
Scenario Manager.

– Notes - Add any notes or comments in the Notes field

– Alternatives

– Calculation Options

Running Multiple Scenarios at Once (Batch Runs)

Performing a batch run lets you set up and run calculations for multiple scenarios at 
once. This is helpful if you want to queue a large number of calculations, or manage a 
group of smaller calculations as a set. The list of selected scenarios for the batch run 
remain with your project until you change it.

To perform a batch run:

1. Selecting View > Scenarios to open the Scenario Manager, or click the Scenario 
Manager tab.

2. Click the Compute Current Scenario button, then select Batch Run from the 
shortcut menu.

The Batch Run Editor dialog box appears.

3. Check the scenarios you want to run, then click the Batch button. Each scenario is 
calculated. You can cancel the batch run between any scenario calculation. The 
selected scenarios run consecutively.
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When the batch run is completed, the scenario that was current stays current, even 
if it was not calculated.

4. Select a calculated scenario from the Scenario toolbar drop-down list to see the 
results throughout the program.

Batch Run Editor Dialog Box

The Batch Run Editor dialog box contains the following controls:

Scenario Manager

The Scenario Manager lets you create, edit, and manage scenarios. There is one built-
in default scenario—the Base scenario. If you wish, you only have to use this one 
scenario. However, you can save yourself time by creating additional scenarios that 
reference the alternatives needed to perform and recall the results of each of your 
calculations. There is no limit to the number of scenarios that you can create. 

Note: When you delete a scenario, you are not losing data records 
because scenarios never actually hold calculation data records 
(alternatives do). The alternatives and data records referenced 
by that scenario exist until you explicitly delete them. By 
accessing the Alternative Manager, you can delete the 
referenced alternatives and data records.  

The Scenario Manager consists of a hierarchical tree view and a toolbar. 

Scenario List Displays a list of all current scenarios. Click the 
check box next to the scenarios you want to run in 
batch mode.

Batch Starts the batch run of the selected scenarios.

Select Displays a drop-down menu containing the 
following commands:

• Select All - Selects all scenarios listed.

• Clear Selection - Clears all selected 
scenarios.

Close Closes the Batch Run Editor dialog box.

Help Displays context-sensitive help for the Batch Run 
Editor dialog box.
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The tree view displays all of the scenarios in the project. If the Property Editor is open, 
highlighting a scenario in the list causes the alternatives that make up the scenario 
appear there. If the Property Editor is not open, you can display the alternatives and 
scenario information by highlighting the desired scenario and clicking the Properties 
button in the Scenario Manager. 

The toolbar contains the following controls:

New Scenario Opens a submenu containing the following 
commands:

• Child Scenario—Lets you create a new 
Child scenario from the currently highlighted 
Base scenario.

• Base Scenario—Lets you create a new 
Base scenario.

Delete Removes the currently selected scenario.

Rename Lets you rename the currently selected scenario.

Go Opens a submenu containing the following 
commands: 

• Scenario—Lets you calculate the currently 
highlighted scenario. 

• Hierarchy—Lets you calculate the entire 
currently highlighted branch—the Base 
scenario and all Child scenarios currently 
associated with it. 

• Children—Lets you calculate all of the 
Child scenarios associated with the 
currently highlighted scenario. 

• Batch Run—Lets you run a user-defined 
group of scenarios at once.

Make Current Causes the currently selected scenario to 
become the active one, and to be displayed in 
the drawing pane.

Help Displays online help for the Alternative 
Manager.
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Alternatives
Alternatives are the building blocks behind scenarios (for more information, see 
“Scenarios” on page 9-466). They are categorized data sets that create scenarios when 
placed together. Alternatives hold the input data in the form of records. A record holds 
the data for a particular element in your system. 

Scenarios are composed of alternatives, as well as other calculation options (see 
“Calculation Options” on page 9-497), allowing you to compute and compare the 
results of various changes to your system. Alternatives can vary independently within 
scenarios, and can be shared between scenarios.

Scenarios allow you to specify the alternatives you wish to analyze. In combination 
with scenarios, you can perform calculations on your system to see what effect each 
alternative has. Once you have determined an alternative that works best for your 
system, you can permanently merge changes from the preferred alternative to the base 
alternative if you wish. 

When you first set up your system, the data that you enter is stored in the various base 
alternative types. If you wish to see how your system behaves, for example, by 
increasing the diameter of a few select pipes, you can create a child alternative to 
accomplish that. You can make another child alternative with even larger diameters, 
and another with smaller diameters. There is no limit to the number of alternatives that 
you can create.

Types of Alternatives

The exact properties of each alternative are discussed in their respective sections. By 
breaking up alternatives into these different types, we give you the ability to mix 
different alternatives any way that you want within any given scenario.

Bentley SewerGEMS V8i includes these types of alternatives:

• “Active Topology Alternative” on page 9-475

• “Physical Alternatives” on page 9-478

• “Boundary Condition Alternatives” on page 9-505

• “Initial Conditions Alternative” on page 9-507

• “Hydrology Alternatives” on page 9-508

• “Output Alternatives” on page 9-514

• “Inflow Alternatives” on page 9-516

• “Rainfall Runoff Alternative” on page 9-520

• “Water Quality Alternative” on page 9-522
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Base and Child Alternatives

There are two kinds of alternatives: Base alternatives and Child alternatives. Base 
alternatives contain local data for all elements in your system. Child alternatives 
inherit data from base alternatives, or even other child alternatives, and contain data 
for one or more elements in your system. The data within an alternative consists of 
data inherited from its parent, and the data altered specifically by you (local data).

Remember that all data inherited from the base alternative are changed when the base 
alternative changes. Only local data specific to a child alternative remain unchanged.

Creating Alternatives

New alternatives are created in the Alternative Manager dialog box. A new alternative 
can be a Base scenario or a Child scenario. Each alternative type contains a Base alter-
native in the Alternative Manager tree view. 

Note: For information regarding the differences between the two types 
of alternatives, see “Base and Child Alternatives” on page 9-472. 

To create a new Alternative:

1. Select View > Alternatives to open the Alternative Manager, or click the Alterna-
tive Manager tab.

2. To create a new Base alternative, highlight the type of alternative you want to 
create, then click the New button.

3. To create a new Child alternative, right-click the Base alternative from which the 
child will be derived, then select New > Child Alternative from the submenu.

4. Double-click the new alternative to edit its properties in the Alternative Editor.

Editing Alternatives

You edit the properties of an alternative in its own alternative editor. The first column 
in an alternative editor contains check boxes, which indicate the records that have 
been changed in this alternative. 

• If the box is checked, the record on that line has been modified and the data is 
local, or specific, to this alternative. 

• If the box is not checked, it means that the record on that line is inherited from its 
higher-level parent alternative. Inherited records are dynamic. If the record is 
changed in the parent, the change is reflected in the child. The records on these 
rows reflect the corresponding values in the alternative’s parent.
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To edit an existing alternative, you can use one of two methods:

• Double-click the alternative to be edited in the Alternative Manager.

or

• Highlight the alternative to be edited in the Alternative Manager and click the 
Properties button.

In either case, the Alternative Editor dialog box for the specified alternative appears, 
allowing you to view and define settings as desired.

Alternative Manager

The Alternative Manager lets you create, view, and edit the alternatives that make up 
the project scenarios. The dialog box consists of a pane that displays folders for each 
of the alternative types which can be expanded to display all of the alternatives for that 
type, and a toolbar.

The toolbar consists of the following buttons: 

New Opens a submenu containing the following 
commands: 

• Base Alternative—Creates a new Base 
Alternative of the currently highlighted 
type. 

• Child Alternative—Creates a new 
Child Alternative from the currently high-
lighted Base Alternative.

Delete Deletes the currently highlighted alternative. 
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Alternative Editor Dialog Box

This dialog box presents in tabular format the data that makes up the alternative being 
edited. Depending on the alternative type, the dialog box contains a separate tab for 
each element that possesses data contained in the alternative. 

Note: Note:  As you make changes to records, the check box 
automatically becomes checked. If you want to reset a record to 
its parent's values, clear the corresponding check box. 

Many columns support Global Editing (see Globally Editing 
Data), allowing you to change all values in a single column. 
Right-click a column header to access the Global Edit option. 

The check box column is disabled when you edit a base 
alternative.  

The Alternative Editor displays all of the records held by a single alternative. These 
records contain the values that are active when a scenario referencing this alternative 
is active. They allow you to view all of the changes that you have made for a single 
alternative. They also allow you to eliminate changes that you no longer need. 

There is one editor for each alternative type. Each type of editor works similarly and 
allows you to make changes to a different aspect of your system. The first column 
contains check boxes, which indicate the records that have been changed in this alter-
native. 

If the check box is selected, the record on that line has been modified and the data is 
local, or specific, to this alternative. 

Properties Opens the Alternative Editor dialog box for 
the currently highlighted alternative.

Rename Lets you rename the currently highlighted 
alternative.

Report Lets you generate a report of the currently 
highlighted alternative.

Help Displays online help for the Alternative 
Manager.
9-474 Bentley SewerGEMS V8i User’s Guide



Using Scenarios and Alternatives
If the check box is cleared, it means that the record on that line is inherited from its 
higher-level parent alternative. Inherited records are dynamic. If the record is changed 
in the parent, the change is reflected in the child. The records on these rows reflect the 
corresponding values in the alternative's parent. 

Active Topology Alternative

The Active Topology Alternative lets you temporarily remove areas of the network 
from the current analysis. This is useful for comparing the effect of proposed 
construction and to gauge the effectiveness of redundancy that may be present in the 
system.

The Active Topology dialog box is divided into tabs for each element type:

• Pump

• Manhole

• Catch basin

• Outfall

• Pond outlet structure

• Cross section node

• Wet well

• Pressure junction

• Junction chamber

• Conduit

• Channel 

• Gutter

• Pressure Pipe

• Catchment

• Pond

For each tab, the same setup applies—the tables are divided into three columns. The 
first column displays whether the data is Base or Inherited, the second column is the 
element Label, and the third column allows you to choose whether or not the corre-
sponding element is Active in the current alternative.

To make an element Inactive in the current alternative, clear the check box in the Is 
Active? field that corresponds to that element’s Label.
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Creating an Active Topology Child Alternative

When creating an active topology child alternative, you may notice that the elements 
added to the child scenario also appear in your model when the base scenario is the 
current scenario. 

To create an active topology alternative so that the elements added to the child 
scenario do not show up as part of the base scenario:

1. Create a new project.

2. Open the Property Editor.

3. Open the Scenario Manager and make sure the Base scenario is current (active).

4. Create your model by adding elements in the drawing pane.

5. Create a new child scenario and a new child active topology alternative as 
described in the following steps:

a. In the Scenario Manager, click the New button and select Child Scenario 
from the submenu.

b. In the Property Editor, which should now display the properties for the newly 
created scenario, select <New...> in the Active Topology field.

c. In the Create New Alternative dialog box, type the name of the new child 
active topology alternative name then click OK.

6. In the Scenario Manager, select the new child scenario then click the Make 
Current button to make the child scenario the current (active) scenario.

7. Add new elements to your model. These elements will be active only in the new 
child alternative.

8. To verify that this worked as expected:

a. In the Scenario Manager, select the base scenario then click the Make 
Current button to make the base scenario the current (active) scenario. The 
new elements are shown as inactive (they appear grayed out in the drawing 
pane).

b. In the Scenario Manager, select the new child scenario then click the Make 
Current button to make the child scenario the current (active) scenario. The 
new elements are shown as active.
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Note: If you add new elements in the base scenario, they will show up 
in the child scenario.  This is normal.

Active Topology Selection Dialog Box 

While it is possible to make elements active or inactive by:

1. Checking or unchecking the "Is active?" box in the alternative manager under the 
Active Topology Manager, 

2. Unchecking the "Is active?" box in a FlexTable, or 

3. Picking True of False in property grid next to "Is active?" for individual elements,

another way of making elements active or inactive is the Active Topology Selection 
Tool, which is accessed through Tools>Active Topology Selection.

When the user starts Active Topology Selection, a Select tool opens. Clicking 
elements in the drawing view while the selection tool is enabled can make them active 
or inactive according to the commands below. 

Making an element "inactive" means that the element remains in the data file but it is 
not included in any hydraulic analysis calculations. Inactive elements will appear in 
FlexTables but calculated values will be set to NA.

Changing the active status using this tool only affects the Active Topology Alternative 
of the current scenario.

The Select tool consists of the following controls: 

• Done: Select Done when you are finished selecting elements. This brings the user 
back to the drawing pane.

• Add: When this button is selected, clicking elements highlights the elements and 
makes them Inactive. Clicking on an element that is already inactive causes the 
tool to give a beep and the element remains inactive.

• Remove: While in this mode, clicking on elements that are inactive deselects 
them, making them Active. Clicking on active elements has no effect.

• Clear: Clicking on this button causes all elements to become active in the current 
scenario. 

Right clicking while the Selection tool is open (i.e. opening the right click context 
menu) brings up a list which enables the user to switch between Add, Remove or 
Done.
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Note: Selecting a node element to become Inactive will also select all 
adjacent pipes to become Inactive. This is because all pipes 
must end at a node. 

In AutoCAD mode, you cannot use the right-click context menu 
command Repeat to re-open the Active Topology Selection 
dialog box.

Physical Alternatives

Each type of network element has a specific set of physical properties that are stored 
in a physical properties alternative, as listed below:

• “Physical Alternative for Pumps” on page 9-478

• “Physical Alternative for Manholes” on page 9-480

• “Physical Alternative for Catch Basins” on page 9-482

• “Physical Alternative for Outfalls” on page 9-483

• “Physical Alternative for Pond Outlet Structures” on page 9-484

• “Physical Alternative for Cross Section Nodes” on page 9-484

• “Physical Alternative for Wet Wells” on page 9-487

• “Physical Alternative for Pressure Junctions” on page 9-488

• “Physical Alternative for Junction Chambers” on page 9-488

• “Physical Alternative for Conduits” on page 9-489

• “Physical Alternative for Channels” on page 9-498

• “Physical Alternative for Gutters” on page 9-500

• “Physical Alternative for Pressure Pipes” on page 9-503

• “Physical Alternative for Ponds” on page 9-501

Physical Alternative for Pumps

The physical alternative editor for pumps is used to create various data sets for the 
physical characteristics of pumps. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Pump Curve Allows you to select the pump curve that is 
associated with each pump in the alternative. 
Clicking the Ellipsis (…) button opens the Pump 
Curve Definitions dialog box.

Elevation Displays the ground elevation for each node in the 
alternative.

Column Description
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Physical Alternative for Manholes

The physical alternative editor for manholes is used to create various data sets for the 
physical characteristics of manholes. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Bolted Cover Indicates that the associated manhole has a bolted 
cover. If the manhole cover is bolted, then the 
hydraulic grade line is not reset to the rim 
elevation at the downstream end of the upstream 
pipes in the case of a flooding situation (the 
calculated HGL being higher than the rim 
elevation).

Width Displays the width of each box manhole in the 
alternative.

Length Displays the length of each box manhole in the 
alternative.

Diameter Displays the diameter of each circular manhole in 
the alternative.

Structure Shape Type Indicates whether the manhole is circular or box 
shaped. Clicking a field displays a list box that 
allows you to switch between the two.

Area (Constant 
Surface)

Lets you define the area in which ponding occurs 
at the currently selected element. It is available 
only when the Surface Storage Type attribute is set 
to Ponded Area.

Surface Storage Type Contains list boxes for each manhole that allow 
you to specify whether the manhole uses the 
Default Storage Equation or a Surface Depth-Area 
Curve.
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Surface Depth Area 
Curve

Clicking the Ellipsis (…) button in this field opens 
the Surface Depth-Area Curve editor, allowing 
you to define the Surface Depth- Area curve for 
each element in the alternative that uses the 
Surface Depth-Area Curve Surface Storage Type.

Elevation (Rim) Lets you define the top elevation of a manhole 
structure. This elevation is typically flush with the 
ground surface. However in some cases, the rim 
elevation may be slightly below the ground 
surface elevation (sunk) or slightly above the 
ground surface elevation (raised).

Set Rim to Ground 
Elevation

Enables or disables a data entry shortcut. If the 
box is checked, the manhole rim elevation is set 
equal to the ground elevation automatically.

Elevation (Invert) Lets you define the elevation at the bottom of the 
manhole.

Elevation (Ground) Displays the ground elevation for each node in the 
alternative.

Headloss Coefficient Lets you define the headloss coefficient of each 
manhole in the alternative. This column is only 
available for manholes that use the Standard 
Headloss method.

Headloss Coefficient 
Start

Lets you define the headloss coefficient of the 
element upstream of the manhole. This column is 
only available for manholes that use the Generic 
Headloss method.

Headloss Coefficient 
Stop

Lets you define the headloss coefficient of the 
element downstream of the manhole. This column 
is only available for manholes that use the Generic 
Headloss method.

Absolute Headloss Lets you define the absolute headloss of manholes 
in the alternative. This column is only available 
for manholes that use the Absolute Headloss 
method.

Column Description
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Physical Alternative for Catch Basins

The physical alternative editor for catch basins is used to create various data sets for 
the physical characteristics of catch basins. The following columns are available:

Headloss Method Lets you specify the headloss method that is used 
by the associated manhole.

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Capture Curve Clicking the Ellipsis (…) button in this field opens 
the Inflow Capture Curve editor, allowing you to 
define the inflow capture curve for each element 
in the alternative that uses the Inflow Capture 
Curve Inlet Type.

Flow (Maximum in) Lets you define the maximum inflow for catch 
basins of the Maximum Inflow Inlet Type.

Inlet Type Indicates whether the catch basin is Rating Curve 
or Maximum Inflow type. Clicking a field 
activates a list box allowing you to switch between 
the two.

Width Displays the width of each box catch basin in the 
alternative.

Length Displays the length of each box catch basin in the 
alternative.
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Physical Alternative for Outfalls

The physical alternative editor for outfalls is used to create various data sets for the 
physical characteristics of outfalls. The following columns are available:

Diameter Displays the diameter of each circular catch basin 
in the alternative.

Structure Shape Type Indicates whether the catch basin is circular or box 
shaped. Clicking a field activates a list box that 
allows you to switch between the two.

Surface Depth Area 
Curve

Clicking the Ellipsis (…) button in this field opens 
the Surface Depth-Area Curve editor, allowing 
you to define the surface depth area curve for each 
element in the alternative that uses the Surface 
Depth-Area Curve Surface Storage Type.

Area (Constant 
Surface)

Lets you define the area in which ponding occurs 
at the currently selected element. It is available 
only when the Surface Storage Type attribute is set 
to Ponded Area.

Surface Storage Type Contains a drop-down list box that allow you to 
specify whether the manhole uses the Default 
Storage Equation or a Surface Depth-Area Curve.

Elevation (Rim) —Lets you define the top elevation of a catch 
basin structure. This elevation is typically flush 
with the ground surface. In some cases, the rim 
elevation may be slightly below the ground 
surface elevation (sunk) or slightly above the 
ground surface elevation (raised).

Set Rim to Ground 
Elevation

Enables or disables a data entry shortcut. If the 
box is checked, the catch basin rim elevation is set 
equal to the ground elevation automatically.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.
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Physical Alternative for Pond Outlet Structures

The physical alternative editor for pond outlet structures is used to create various data 
sets for the physical characteristics of pond outlet structures. The following columns 
are available:

Physical Alternative for Cross Section Nodes

The physical alternative editor for cross section nodes is used to create various data 
sets for the physical characteristics of cross section nodes. The following columns are 
available:

Label Displays the label for each element in the 
alternative.

Elevation (Ground) Displays the ground elevation for each node in the 
alternative.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Control Structure Lets you specify the previously defined control 
structure associated with the outlet structure

Has Control Structure Specifies whether or not the pond has an outlet 
control structure.

Upstream Pond Displays the label of the upstream pond.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Manning’s n Lets you define the Manning’s roughness value for 
all of the cross sections in the alternative. This 
column is available only when the Single 
Manning’s n Roughness Type is specified.

Channel Manning’s n Lets you specify the Manning’s roughness value 
for each cross section node in the alternative. This 
column is only available for cross section nodes 
that have a Trapezoidal Channel or Overbank 
Channel Section Type.

Right Overbank 
Manning’s n

Lets you specify the Manning’s roughness value 
for the right overbank of each cross section node 
in the alternative. This column is only available 
for cross section nodes that have a Trapezoidal 
Channel or Irregular Channel Section Type.

Left Overbank 
Manning’s n

Lets you specify the Manning’s roughness value 
for the left overbank of each cross section node in 
the alternative. This column is only available for 
cross section nodes that have a Trapezoidal 
Channel or Irregular Channel Section Type.

Roughness Type Lets you specify the roughness type of each cross 
section in the alternative.

Transition Length Lets you define the transition length when the 
Abrupt Transition Type is chosen.

Transition Type Lets you specify the transition type of the 
currently highlighted element. If Abrupt is chosen 
here, the Transition Length field becomes 
available for input.

Elevations Modifier The Elevations modifier is a constant value that 
will be added to each elevation value. This 
attribute is only used during SWMM calculations.

Stations Modifier The Stations modifier is a factor by which the 
distance between each station will be multiplied 
when the transect data is processed by SWMM. 
Use a value of 0 if no such factor is needed. This 
attribute is only used during SWMM calculations.

Column Description
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Right Bank Station The distance values appearing in the Station/
Elevation grid that mark the end of the left 
overbank and the start of the right overbank. Use 0 
to denote the absence of an overbank.

Left Bank Station The distance values appearing in the Station/
Elevation grid that mark the end of the left 
overbank and the start of the right overbank. Use 0 
to denote the absence of an overbank.

Material Lets you enter the name of the material used. 
Alternatively, clicking the Ellipsis (…) button 
opens the Material Engineering Library, allowing 
you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value 
will change accordingly.

Manning’s n Flow 
Curve

Clicking the Ellipsis (…) button in this field opens 
the Manning’s n Flow Curve editor, allowing you 
to define the Manning’s roughness vs. flow curve 
for each element in the alternative that uses the 
Manning’s n Flow Curve Roughness Type.

Manning’s n Depth 
Curve

Clicking the Ellipsis (…) button in this field opens 
the Manning’s n Depth Curve editor, allowing you 
to define the Manning’s roughness vs. depth curve 
for each element in the alternative that uses the 
Manning’s n Flow Curve Roughness Type.

Bottom Width Displays the bottom width of each element in the 
alternative. This column is only available for 
Trapezoidal cross section types.

Elevation (Invert) Lets you define the invert elevation for all cross 
section nodes in the alternative. This column is 
only available for Trapezoidal cross section types.

Slope (Left Side) Lets you define the left side slope for all cross 
section nodes in the alternative. This column is 
only available for Trapezoidal cross section types.

Slope (Right Side) Lets you define the right side slope for all cross 
section nodes in the alternative. This column is 
only available for Trapezoidal cross section types.

Column Description
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Physical Alternative for Wet Wells

The physical alternative editor for wet wells is used to create various data sets for the 
physical characteristics of wet wells. The following columns are available:

Height Lets you define the height, or channel depth for all 
cross section nodes in the alternative. This column 
is only available for Trapezoidal cross section 
types.

Section Type Lets you specify the cross section type for all cross 
section nodes in the alternative. The choices 
include Trapezoidal and Generic cross section 
types.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Exponent Lets you set the exponent of the area function for 
the currently highlighted element. It is available 
only when Wet Well Area Function is chosen as 
the Wet Well Volume Type.

Coefficient Lets you set the coefficient of the area function for 
the currently highlighted element. It is available 
only when Wet Well Area Function is chosen as 
the Wet Well Volume Type.

Area Allows you to define the area of each wet well in 
the alternative.

Wet Well Depth-Area 
Curve

Clicking the Ellipsis (…) button in this field opens 
the Wet Well Depth-Area Curve editor, allowing 
you to define the depth-area curve for each wet 
well in the alternative that uses the Wet Well 
Depth-Area Curve Wet Well Volume Type.
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Physical Alternative for Pressure Junctions

The physical alternative editor for pressure junctions is used to create various data sets 
for the physical characteristics of pressure junctions. The following columns are avail-
able:

Physical Alternative for Junction Chambers

The physical alternative editor for junction chambers is used to create various data 
sets for the physical characteristics of junction chambers. The following columns are 
available:

Wet Well Volume Type Lets you specify the volume type of each wet well 
in the alternative. The type chosen here will affect 
the availability of other fields in the alternative.

Ponded Area Lets you define the ponded area of the wet well.

Max. Level Lets you define the maximum water surface 
elevation of the wet well.

Elevation (Invert) Lets you define the invert elevation of each wet 
well in the alternative.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Elevation Lets you define the elevation of each pressure 
junction in the alternative.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Physical Alternative for Conduits

The physical alternative editor for conduits is used to create various data sets for the 
physical characteristics of conduits. The following columns are available:

Diameter Lets you set the diameter of the currently 
highlighted element.

Elevation (Bottom) Lets you set the bottom elevation of the currently 
highlighted element.

Elevation (Top) Lets you set the top elevation of the currently 
highlighted element.

Elevation (Ground) Lets you set the ground elevation of the currently 
highlighted element.

Headloss Coefficient Lets you set the headloss coefficient for the 
manhole. This field is only available if you 
selected the Standard Headloss Method.

Headloss Coefficient 
Start

Lets you set the headloss coefficient at the start 
section. This field is only available if you selected 
the Generic Headloss Method. 

Headloss Coefficient 
Stop

Lets you set the headloss coefficient at the stop 
section. This field is only available if you selected 
the Generic Headloss Method.

Absolute Headloss Lets you enter a value for the headloss. This field 
is only available if you selected the Absolute 
Headloss Method. 

Headloss Method Lets you select the headloss method to use: 
Absolute, HEC-22, Generic, or Standard. 

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Egg Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have an egg Section Type.

Number of Barrels Lets you specify the number of hydraulically 
identical conduit barrels that make up the conduit. 
This column is only available for elements whose 
Conduit Type is Closed Conduit.

Horseshoe Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have a horseshoe Section Type.

Horseshoe Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have a horseshoe Section Type.

Ellipse Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have a an ellipse Section Type.

Ellipse Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have an ellipse Section Type.

Basket Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have a basket-handle Section Type.

Basket Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have a basket-handle Section Type.

Box Equation Form Lets you specify the form of equation that should 
be used when applying culvert data. This column 
is only available for box conduits that do Apply 
Culvert Data.

Box Kr Lets you define the reverse flow loss value for the 
associated conduit. This column is only available 
for box conduits that do Apply Culvert Data.

Box Ke Lets you define the entrance loss value for the 
associated conduit. This column is only available 
for box conduits that do Apply Culvert Data.

Column Description
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Box Slope Correction 
Factor

Lets you define the Slope Correction Factor to be 
used in inlet control calculations. Normally this 
factor is –0.5, but for mitered inlets, HDS No. 5 
suggests +0.7. This column is only available for 
box conduits that do Apply Culvert Data.

Box Y Lets you define the Y equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for box conduits that do 
Apply Culvert Data.

Box M Lets you define the M equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
box conduits that do Apply Culvert Data.

Box C Lets you define the C equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for box conduits that do 
Apply Culvert Data.

Box K Lets you define the K equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
box conduits that do Apply Culvert Data.

Box Inlet Description Lets you enter an inlet description for the 
associated conduit. This column is only available 
for box conduits that do Apply Culvert Data.

Box Apply Culvert 
Data

Lets you specify whether the associated box 
conduit does or does not apply culvert data.

Box Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have an box Section Type.

Box Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have an box Section Type.

Column Description
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Circle Equation Form Contains list boxes that allow you to specify the 
form of equation that should be used when 
applying culvert data. This column is only 
available for circle conduits that do Apply Culvert 
Data.

Circle Kr Lets you define the reverse flow loss value for the 
associated conduit. This column is only available 
for circle conduits that do Apply Culvert Data.

Circle Ke Lets you define the entrance loss value for the 
associated conduit. This column is only available 
for box conduits that do Apply Culvert Data.

Circle Slope 
Correction Factor

Lets you define the Slope Correction Factor to be 
used in inlet control calculations. Normally this 
factor is –0.5, but for mitered inlets, HDS No. 5 
suggests +0.7. This column is only available for 
circle conduits that do Apply Culvert Data.

Circle Y Lets you define the Y equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for circle conduits that do 
Apply Culvert Data.

Circle M Lets you define the M equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
circle conduits that do Apply Culvert Data.

Circle C Lets you define the C equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for circle conduits that do 
Apply Culvert Data.

Circle K Lets you define the K equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
circle conduits that do Apply Culvert Data.

Circle Inlet 
Description

Lets you enter an inlet description for the 
associated conduit. This column is only available 
for circle conduits that do Apply Culvert Data. 

Column Description
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Circle Apply Culvert 
Data

Lets you specify whether the associated box 
conduit does or does not apply culvert data.

Diameter Lets you define the diameter of the associated 
conduits. This column is only available for 
circular conduits.

Slope (Left Side) Lets you define the left side slope of the associated 
conduits. This column is only available for 
conduits that have a Trapezoidal Section Type.

Slope (Right Side) Lets you define the right side slope of the 
associated conduits. This column is only available 
for conduits that have a Trapezoidal Section Type.

Trapezoidal Channel 
Depth

Lets you define the depth of the associated 
conduits. This column is only available for 
conduits that have a Trapezoidal Section Type.

Base Width Lets you define the base width of the associated 
conduits. This column is only available for 
conduits that have a Trapezoidal Section Type.

Section Type Lets you specify the section type for each conduit 
in the alternative. The value that is chosen affects 
the available input data for other columns.

Outlet Structure Lets you specify the previously defined outlet 
structure associated with the conduit.

Has Control Structure Lets you specify whether or not the associated 
conduit has a control structure.

Length (User Defined) Lets you define the length of each channel in the 
alternative that has a user—defined length.

Has User Defined 
Length

Lets you specify whether the channel has a user-
defined or schematic length.

Channel Manning’s n Lets you specify the Manning’s roughness value 
for each channel in the alternative. This column is 
only available for conduits that have a Trapezoidal 
Channel or Overbank Channel Section Type.

Column Description
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Right Overbank 
Manning’s n

Lets you specify the Manning’s roughness value 
for the right overbank of each channel in the 
alternative. This column is only available for 
conduits that have a Trapezoidal Channel or 
Irregular Channel Section Type.

Left Overbank 
Manning’s n

Lets you specify the Manning’s roughness value 
for the left overbank of each channel in the 
alternative. This column is only available for 
conduits that have a Trapezoidal Channel or 
Irregular Channel Section Type.

Elevations Modifier The Elevations modifier is a constant value that 
will be added to each elevation value. This 
attribute is only used during SWMM calculations.

Stations Modifier The Stations modifier is a factor by which the 
distance between each station will be multiplied 
when the transect data is processed by SWMM. 
Use a value of 0 if no such factor is needed. This 
attribute is only used during SWMM calculations.

Right Bank Station The distance values appearing in the Station/
Elevation grid that mark the end of the left 
overbank and the start of the right overbank. Use 0 
to denote the absence of an overbank.

Left Bank Station The distance values appearing in the Station/
Elevation grid that mark the end of the left 
overbank and the start of the right overbank. Use 0 
to denote the absence of an overbank.

Material Lets you enter the name of the material used. 
Alternatively, clicking the Ellipsis (…) button 
opens the Material Engineering Library, allowing 
you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value 
will change accordingly.

Invert (Stop) Lets you define the downstream pipe invert.

Set Invert to Stop Node Lets you automatically set the upstream pipe 
invert to the elevation of the upstream node.

Column Description
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Invert (Start) Lets you define the upstream pipe invert.

Set Invert to Start 
Node

Lets you automatically set the upstream pipe 
invert to the elevation of the downstream node.

Exit Loss Coefficient Lets you define the exit loss coefficient for the 
associated conduits.

Entrance Loss 
Coefficient

Lets you define the entrance loss coefficient for 
the associated conduits.

Contraction Loss 
Coefficient

Lets you define the contraction loss of the conduit. 
The contraction loss is due to flow transitioning 
from large-area, low-velocity flow to small-area, 
high-velocity flow, such as flow exiting a structure 
and entering a downstream pipe

Expansion Loss 
Coefficient

Lets you define the expansion loss of the conduit. 
Expansion losses are encountered when small-
area, high-velocity flow meets a large-area, low-
velocity flow, such as a pipe discharging into a 
structure.

Stop Control Structure Lets you design a stop control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to 
open the Conduit Control Structure dialog box to 
set up the control structure you want to use.

Has Stop Control 
Structure

Lets you define whether or not the currently 
highlighted element has a stop control structure, 
and if so, which type. The value chosen here 
affects the availability of the other fields. If this is 
set to True, an icon displays at the start/stop—end 
of the conduit to display the presence of the 
structure.

Start Control Structure Lets you design a start control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to 
open the Conduit Control Structure dialog box to 
set up the control structure you want to use.

Column Description
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Has Start Control 
Structure

Lets you define whether or not the currently 
highlighted element has a start control structure, 
and if so, which type. The value chosen here 
affects the availability of the other fields. If this is 
set to True, an icon displays at the start/stop—end 
of the conduit to display the presence of the 
structure.

Flap Gate? Lets you choose whether or not the highlighted 
element has a flap gate. If this is set to True, and 
icon displays at the stop-end of the conduit to 
display the presence of the structure. If this is set 
to True and you design control structures without 
flap gates selected, the flap gate check box will be 
enabled for your control structures and a message 
displayed.

Manning’s n Flow 
Curve

Lets you define points that describe a roughness-
flow curve for the currently highlighted element. 
Click in the field to display an Ellipsis (…) button, 
and click the Ellipsis (…) button to use the 
Manning’s n-Flow Curve dialog box. To use this 
field, you must set Roughness Type attribute is set 
to Manning’s n-Flow.

Manning’s n Depth 
Curve

Lets you define points that describe a roughness-
depth curve for the currently highlighted element. 
Click in the field to display an Ellipsis (…) button, 
and click the Ellipsis (…) button to use the 
Manning’s n-Depth Curve dialog box. To use this 
field, you must set Roughness Type attribute is set 
to Manning’s n-Depth Curve.

Manning’s n Lets you define the Manning’s roughness value for 
the associated conduits. This column is only 
available for conduits that use the Single 
Manning’s n Roughness Type.

Roughness Type Lets you specify the roughness type for each 
conduit in the alternative.

Arch Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have an arch Section Type. 

Column Description
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Arch Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have an arch Section Type.

Catalog Pipe Equation 
Form

Let you specify the form of equation that should 
be used when applying culvert data. This column 
is only available for catalog pipe conduits that do 
Apply Culvert Data.

Catalog Pipe Kr Lets you define the reverse flow loss value for the 
associated conduit. This column is only available 
for catalog pipe conduits that do Apply Culvert 
Data.

Catalog Pipe Ke Lets you define the entrance loss value for the 
associated conduit. This column is only available 
for box conduits that do Apply Culvert Data.

Catalog Pipe Slope 
Correction Factor

Lets you define the Slope Correction Factor to be 
used in inlet control calculations. Normally this 
factor is –0.5, but for mitered inlets, HDS No. 5 
suggests +0.7. This column is only available for 
catalog pipe conduits that do Apply Culvert Data.

Catalog Pipe Y Lets you define the Y equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for circle conduits that do 
Apply Culvert Data.

Catalog Pipe M Lets you define the M equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
circle conduits that do Apply Culvert Data.

Catalog Pipe C Lets you define the C equation coefficient that is 
used in the submerged inlet control equation. This 
column is only available for circle conduits that do 
Apply Culvert Data.

Catalog Pipe K Lets you define the K equation coefficient that is 
used in both forms of the unsubmerged inlet 
control equation. This column is only available for 
circle conduits that do Apply Culvert Data.

Column Description
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Physical Alternative for Channels

The physical alternative editor for channels is used to create various data sets for the 
physical characteristics of channels. The following columns are available:

Catalog Pipe Inlet 
Description

Lets you enter an inlet description for the 
associated conduit. This column is only available 
for circle conduits that do Apply Culvert Data.

Catalog Pipe Apply 
Culvert Data

Contains list boxes that allow you to specify 
whether the associated box conduit does or does 
not apply culvert data.

Catalog Pipe Number 
of Barrels

Lets you specify the number of hydraulically 
identical conduit barrels that make up the conduit. 
This column is only available for elements whose 
Conduit Type is Closed Conduit.

Catalog Pipe Lets you specify the previously defined catalog 
pipe associated with the conduit.

Semi-Ellipse Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have a semi-ellipse Section Type.

Semi-Ellipse Rise Lets you define the rise (height) of the associated 
conduit. This column is only available for 
conduits that have a semi-ellipse Section Type.

Egg Span Lets you define the span (width) of the associated 
conduit. This column is only available for 
conduits that have an egg Section Type. 

Design Percent Full Design Capacity lets you enter the percentage full 
that you would like the link to maintain. If you 
want the pipe to be 75% full, enter in the 75 in the 
field. This value in no way affects the network 
calculations. It is informational only.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.
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Label Displays the label for each element in the 
alternative.

Scaled Length Displays the scaled (as opposed to user defined) 
length of each channel in the alternative. This is a 
calculated field for channels that do not have a 
user-defined length.

Set Invert to Start 
Node

Lets you automatically set the upstream channel 
invert to the elevation of the upstream node.

Invert (Start) Lets you define the upstream channel invert.

Set Invert to Stop Node Lets you automatically set the downstream 
channel invert to the elevation of the downstream 
node.

Start Control Structure Lets you design a start control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to 
open the Channel Control Structure dialog box to 
set up the control structure you want to use.

Has Stop Control 
Structure

Lets you define whether or not the currently 
highlighted element has a stop control structure, 
and if so, which type. The value chosen here 
affects the availability of the other fields. If this is 
set to True, an icon displays at the start/stop-end of 
the conduit to display the presence of the 
structure.

Stop Control Structure Lets you design a stop control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to 
open the Channel Control Structure dialog box to 
set up the control structure you want to use

Has Start Control 
Structure

Lets you design a stop control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to 
open the Channel Control Structure dialog box to 
set up the control structure you want to use.

Column Description
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Physical Alternative for Gutters

The physical alternative editor for gutters is used to create various data sets for the 
physical characteristics of gutters. The following columns are available:

Flap Gate? Lets you choose whether or not the highlighted 
element has a flap gate. If this is set to True, and 
icon displays at the stop-end of the conduit to 
display the presence of the structure. If this is set 
to True and you design control structures without 
flap gates selected, the flap gate check box will be 
enabled for your control structures and a message 
displayed.

Invert (Stop) Lets you define the downstream channel invert.

Length (User Defined) Lets you define the length of each channel in the 
alternative that has a user-defined length.

Has User Defined 
Length

Lets you specify whether the channel has a user-
defined or schematic length.

Material Lets you enter the name of the material used. 
Alternatively, clicking the Ellipsis (…) button 
opens the Material Engineering Library, allowing 
you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value 
will change accordingly.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Manning’s n (Gutter) Lets you define the Manning’s roughness of each 
gutter in the alternative.

Gutter Material Lets you specify the material of each gutter in the 
alternative.
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Physical Alternative for Ponds

The physical alternative editor for ponds is used to create various data sets for the 
physical characteristics of ponds. The following columns are available:

Length (User Defined) Lets you define the length of each gutter in the 
alternative that has a user defined length.

Has User Defined 
Length

Lets you specify whether the channel has a user-
defined or schematic length.

Depth Lets you define the depth of the trapezoidal gutter. 
This column is only available for gutters that have 
a Trapezoid Open Cross Section type.

Slope (Right Side) Lets you define the right side slope of the 
trapezoidal gutter. This column is only available 
for gutters that have a Trapezoid Open Cross 
Section type.

Slope (Left Side) Lets you define the left side slope of the 
trapezoidal gutter. This column is only available 
for gutters that have a Trapezoid Open Cross 
Section type.

Bottom Width Lets you define the width of the bottom of the 
trapezoidal gutter. This column is only available 
for gutters that have a Trapezoid Open Cross 
Section type.

Open Cross Section Lets you specify whether the cross section is 
Generic or Trapezoidal for each gutter in the 
alternative.

Irregular Channel Clicking the Ellipsis (…) button in this field opens 
the Irregular Channel editor, allowing you to 
define the shape of each gutter in the alternative 
that uses the Irregular Channel Open Cross 
Section type.

Column Description
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Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Infiltration (Average) Specify the average infiltration rate for the pond. 
This value only applies when the Pond Infiltration 
Method is set to Average Infiltration.

Constant Flow The flow that exits the pond via infiltration during 
each time step. This value only applies when the 
Pond Ifiltration Method is set to Constant Flow.

Pond Infiltration 
Method

Ponds can lose water by infiltration into 
groundwater. Any water lost by infiltration does 
not show up in downstream links.
You can specify "None" (default) if pond 
infiltration is not being considered, or you can use 
one of the following ways to enter pond 
infiltration rates:
1. a Constant Flow rate given in flow units
2. an Average Infiltration rate in depth per unit 
time which is multipied by the area of the pond 
surface at that time step to determine the 
infiltration rate.
In applying either method, the model also has a 
stability filter when the pond water depth is below 
0.5 ft so that the infiltration rate will linearly 
reduce to zero as the depth decreases to zero.

Invert (Stop) Lets you define the downstream invert of the 
pipes. This column is available only when the 
Volume method is Pipe.

Invert (Start) Lets you define the upstream invert of the pipes. 
This column is available only when the Volume 
method is Pipe. 

Volume Type Specifies which of the four volume methods 
(Elevation-Area, Elevation-Volume, Pipe, or 
Functional) is used for each pond in the 
alternative. Clicking a field in this column allows 
you to switch between them.
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Physical Alternative for Pressure Pipes

The physical alternative editor for pressure pipes is used to create various data sets for 
the physical characteristics of pressure pipes. The following columns are available:

Pond Constant “C” value in the expression A*Depth^B+C for 
Depth in feet. This field is available only when the 
Functional Volume Type is chosen.

Pond Exponent “B” value in the expression A*Depth^B+C for 
Depth in feet. This field is available only when the 
Functional Volume Type is chosen.

Pond Coefficient “A” value in the expression A*Depth^B+C for 
Depth in feet. This field is available only when the 
Functional Volume Type is chosen.

Depth (Maximum) Lets you define the maximum depth, or water 
surface elevation, of the pond.

Elevation (Invert) Lets you define the invert elevation of each pond 
in the alternative.

Number of Barrels Lets you define the number of barrels the Pipe 
Volume uses. This column is available only when 
the Volume method is Pipe.

Length Lets you define the length of the pipes. This 
column is available only when the Volume method 
is Pipe.

Pipe Diameter Lets you define the diameter of the pipes. This 
column is available only when the Volume method 
is Pipe.

Elevation-Volume 
Curve

Opens the Elevation-Volume Curve dialog box, 
allowing you to define the elevation-volume curve 
for each pond in the alternative that uses the 
Elevation-Volume Curve Volume Type.

Elevation-Area Curve Opens the Elevation-Area Curve dialog box, 
allowing you to define the elevation-area curve for 
each pond in the alternative.

Column Description
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Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Length (User Defined)/
Scaled Length

Lets you enter a value for the length of the 
currently highlighted element. To use this field, 
you must check the check box in the Has User 
Defined Length field. If you clear the check box in 
that field, the Length (User Defined) field displays 
the scaled length for the currently highlighted 
element.

Has User Defined 
Length?

Lets you choose whether the highlighted element 
uses scaled or user-defined length. If check box in 
this field is checked, the Length (User Defined) 
field is activated. 

Manning’s n Lets you enter a value for the Manning's 
roughness of the currently highlighted element.

Hazen-Williams C Lets you enter a value for the Hazen-Williams C 
coefficient of the currently highlighted element. 

Diameter Lets you set the diameter of the currently 
highlighted element.

Material Lets you enter the name of the material used. 
Alternatively, clicking the Ellipsis (...) button 
opens the Material Engineering Library, allowing 
you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value 
will change accordingly. 

Invert (Stop) Lets you set the stop invert for the currently 
highlighted element.

Set Invert to Stop 
Node?

Lets you choose whether to set the invert to the 
stop node. When the check box checked, the invert 
is set to the stop node.

Invert (Start) Lets you set the stop invert for the currently 
highlighted element.
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Boundary Condition Alternatives

The boundary condition alternative allows you to define boundary condition settings 
for outfall elements. The following columns are available:

Set Invert to Start 
Node?

Lets you choose whether to set the invert to the 
start node. When the check box checked, the 
invert is set to the stop node.

Minor Loss Coefficient Lets you set the minor loss coefficient for the 
currently highlighted element.

Minor Loss Collection Clicking the Ellipsis (…) button in this field opens 
the Minor Loss Collection dialog box, allowing 
you to define a collection of minor loss elements 
for each pressure pipe in the alternative.

Column Description

Column Description

ID Displays the unique identifier for each element in the 
alternative.

Label Displays the label for each element in the alternative.

Elevation (User 
Defined Tailwater)

Lets you enter the user defined tailwater value. This 
column is only available for elements that use the User 
Defined Tailwater Boundary Condition Type.
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Boundary Condition 
Type

Lets you specify the type of boundary condition to be 
used at the associated outfall element. The following 
choices are available:

• Free Outfall—For a free outfall control, it is 
assumed that the downstream discharge condi-
tions do not directly affect the hydraulic response 
of the structure. This is equivalent to assuming that 
the downstream TW elevation never rises above 
the controlling structure outfall invert of the struc-
ture.

• Time-Elevation Curve—For this type of boundary 
condition, a time-elevation curve is specified to 
establish at the outfall a tailwater condition that 
varies over time.

• Elevation (User Defined Tailwater)—This type of 
boundary condition allows you to directly enter a 
tailwater value.

• Elevation Flow Curve—For this type of boundary 
condition, an elevation-flow table is specified to 
simulate at the outfall a channel or outlet structure 
where flow rate varies over time.

• Boundary Pond—This type of boundary condition 
allows you to specify a pond element as the outfall.

• Normal—When this type of boundary condition is 
chosen, the boundary condition is the normal 
depth of the upstream link. If there is more than 
one upstream link, the one with the highest normal 
depth is used as the boundary condition.

• Tidal—For this type of boundary condition, a cyclic 
time-elevation curve is specified to establish at the 
outfall a tailwater condition that varies over time in 
a cyclical fashion.

Tidal Gate Lets you specify whether or not there is a tidal gate at 
each outfall in the alternative.

Cyclic Time-Elevation 
Curve

Clicking the Ellipsis (…) button in this field opens the 
Cyclic Time-Elevation Curve editor, allowing you to 
define the cyclic time vs. elevation curve for each 
outfall in the alternative that uses the Tidal Boundary 
Condition Type.

Column Description
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Initial Conditions Alternative

Ponds and wet wells have a specific set of initial condition properties that define the 
corresponding settings at the beginning of a simulation. These conditions are stored in 
an initial conditions alternative, as listed below:

• “Initial Conditions Alternative for Ponds” on page 9-507

• “Initial Conditions Alternative for Wet Wells” on page 9-508

Initial Conditions Alternative for Ponds

The initial conditions alternative for ponds allows you to define the initial settings for 
ponds. The following conditions are available:

Boundary Element Contains list boxes that display all of the elements that 
are available to be used as boundary ponds. This 
column is available only when the Boundary Pond 
Boundary Condition is specified.

Time-Elevation Curve Clicking the Ellipsis (…) button in this field opens the 
Time-Elevation Curve editor, allowing you to define 
the time vs. elevation curve for each outfall in the 
alternative that uses the Time-Elevation Curve 
Condition Type.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Elevation (Initial) Lets you define the initial water surface elevation 
for each of the ponds in the alternative.

Initial Elevation Type Allows you to choose the initial elevation type for 
each of the ponds in the alternative.
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Initial Conditions Alternative for Wet Wells

The initial conditions alternative for wet wells allows you to define the initial settings 
for ponds. The following conditions are available:

Hydrology Alternatives

The hydrology alternative allows you to define hydrologic settings for catchments. 
The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Elevation (Initial) Lets you define the initial water surface elevation 
for each wet well in the alternative that uses the 
User Defined Initial Elevation Initial Elevation 
Type.

Initial Elevation Type Lets you specify whether each wet well in the 
alternative has a user defined initial elevation or 
initially uses the invert value as the starting 
elevation

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Groundwater Flow 
Coefficient

Value of A1 in the groundwater flow formula.

Surface Elevation Elevation of ground surface for the subcatchment 
that sits above the aquifer.
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Receiving Node Lets you choose the node to which flow 
discharges from the currently highlighted element. 
To use this feature, click Select in the Outfall 
Node field. Move the cursor over the drawing 
pane and click the element you want to select for 
the outflow node.

Aquifer Lets you assign a predefined aquifer to each 
catchment in the alternative, or create a new one 
by clicking the Ellipsis (…) button.

Area Lets you define the area of the associated 
catchments. This column is only available for 
catchments using the Unit Hydrograph Runoff 
Method. 

Initial Abstraction Lets you define the initial abstraction (Ia) for each 
of the catchments in the alternative. The initial 
abstraction is a parameter that accounts for all 
losses prior to runoff and consists mainly of 
interception, infiltration, evaporation, and surface 
depression storage. This column is only available 
for catchments that use the Unit Hydrograph 
Runoff Method and the Generic Horton Loss 
Method. 

Recovery Constant Dry weather regeneration rate constant for the 
Horton curve. This attribute is active only when 
the Loss Method attribute is set to (Generic) 
Horton.

Maximum Volume Lets you define the maximum volume for each of 
the catchments in the alternative.

Moisture Deficit Lets you set the value for Moisture Deficit, which 
is the saturated moisture content minus the 
original moisture content, for each of the 
catchments in the alternative that use the Green 
and Ampt Runoff Loss Method. This column is 
only available for catchments that use the Unit 
Hydrograph Runoff Method and the Green and 
Ampt Loss Method.

Column Description
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SCS CN Allows you to define the SCS Cn value for 
elements that use the SCS Cn Loss Method. This 
column is only available for catchments that use 
the SCS Cn Loss Method 

K Lets you define the decay coefficient for each of 
the catchments in the alternative. This column is 
only available for catchments that use the Unit 
Hydrograph Runoff Method and the Generic 
Horton Loss Method.

fo Lets you define the initial infiltration rate at the 
time that infiltration begins for each of the 
catchments in the alternative. This column is only 
available for catchments that use the Unit 
Hydrograph Runoff Method and the Generic 
Horton Loss Method.

fc Lets you define the steady—state infiltration rate 
that occurs for a sufficiently large time period for 
each of the catchments in the alternative. This 
column is only available for catchments that use 
the Unit Hydrograph Runoff Method and the 
Generic Horton Loss Method.

CN Area Collection Clicking the Ellipsis (…) button in this field opens 
the Cn Area Collection editor, allowing you to 
define the Cn area collection for each catchment in 
the alternative that uses the SCS Cn Loss Method.

Storage (Impervious 
Depression)

Lets you define the depth of impervious storage 
for each of the catchments in the alternative that 
use the EPA-SWMM Runoff Method.

Slope Lets you define the slope of the associated 
catchments. This column is only available for 
catchments that use the EPA-SWMM Runoff 
Method.

Column Description
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Ks Lets you set the saturated hydraulic conductivity 
(the rate at which water travels through the soil 
when it is saturated) for each of the catchments in 
the alternative. This column is only available for 
catchments that use the Unit Hydrograph Runoff 
Method and the Green and Ampt Loss Method.

Capillary Suction Lets you define the capillary suction value for the 
soil type associated with each of the catchments in 
the alternative that use the Green and Ampt 
Runoff Loss Method. This column is only 
available for catchments that use the Unit 
Hydrograph Runoff Method and the Green and 
Ampt Loss Method.

fLoss Lets you define the fLoss absorption value for 
each of the catchments in the alternative. This 
column is only available for catchments that use 
the Unit Hydrograph Runoff Method and the 
fLoss Loss Method. 

Loss Method Lets you specify the loss method used by the 
associated catchments. Other columns become 
available/unavailable depending on the value 
chosen here.

Subarea Routing Lets you define the type of subarea routing at the 
currently highlighted element. This attribute is 
available only when the Runoff Method attribute 
is set to EPA-SWMM Runoff.

Percent Routed Lets you set the percent of runoff routed between 
subareas. This attribute is available only when the 
Runoff Method attribute is set to EPA-SWMM 
Runoff.

Percent Impervious 
Zero Storage

Lets you set the percent of the impervious area 
with no depression storage. This attribute is 
available only when the Runoff Method attribute 
is set to EPA-SWMM Runoff.

Column Description
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Storage (Pervious 
Depression)

Lets you define the depth of pervious storage for 
each of the catchments in the alternative that use 
the EPA-SWMM Runoff Method. This column is 
only available for catchments that use the EPA-
SWMM Runoff Method.

Manning’s n 
(Pervious)

Lets you define the depth of pervious storage for 
each of the catchments in the alternative that use 
the EPA-SWMM Runoff Method. This column is 
only available for catchments that use the EPA-
SWMM Runoff Method.

Manning’s n 
(Impervious)

Lets you define the depth of impervious storage 
for each of the catchments in the alternative that 
use the EPA-SWMM Runoff Method. This 
column is only available for catchments that use 
the EPA-SWMM Runoff Method.

Percent Impervious Lets you define the percentage of impervious 
storage for each of the catchments in the 
alternative that use the EPA-SWMM Runoff 
Method. This column is only available for 
catchments that use the EPA-SWMM Runoff 
Method.

Characteristic Width Lets you define the characteristic width value for 
each of the catchments in the alternative that use 
the EPA-SWMM Runoff Method. This column is 
only available for catchments that use the EPA-
SWMM Runoff Method.

Runoff Method Lets you specify the runoff method for each 
catchment in the alternative.

Tc Data Collection Clicking the Ellipsis (…) button in this field opens 
the Tc Data Collection editor, allowing you to 
define the Tc data for each catchment in the 
alternative that uses the SCS Unit Hydrograph 
Runoff Method.

Column Description
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Tc Lets you define the time of concentration for each 
of the catchments in the alternative that use SCS 
Unit Hydrograph Method. This column is only 
available for catchments that use the SCS Unit 
Hydrograph Runoff Method.

Convolution Time Step Lets you define the convolution time step. This 
column is only available for catchments that use 
the Unit Hydrograph Runoff Method and the 
Generic Unit Hydrograph Method.
Convolution Time Step has two uses: 

• It represents the time step by which the input 
unit-hydrograph data is subdivided when used 
in a calculation.

• It represents the duration of excess rainfall 
that generated the unit hydrograph.

Unit Hydrograph 
Method

Lets you specify the unit hydrograph method to be 
used with the associated catchment.

Runoff Method This column contains list boxes that allow you to 
specify the runoff method that is used by the 
associated catchments. This column is only 
available for elements that are set to the Unit 
Hydrograph Runoff Method.

Unit Hydrograph Data Clicking the Ellipsis (…) button in this field opens 
the Unit Hydrograph Data dialog box, allowing 
you to define Time vs. Flow unit hydrographs for 
each element in the alternative.

Outflow Node Lets you specify the element to which flow the 
catchment outfalls

Apply Groundwater Specify whether or not the associated element 
applies groundwater.

Fixed Surf. Water 
Depth

Fixed depth of surface water at receiving node (ft. 
or m) (set to zero if surface water depth will vary 
as computed by flow routing).

Surface-GW 
Interaction Coefficient

Value of A3 in the groundwater flow formula.

Column Description
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Output Alternatives

The output alternative lets you define output options for network elements, as listed 
below:

• “Output Alternative for Conduits” on page 9-514

• “Output Alternative for Channels” on page 9-515

Output Alternative for Conduits

The output alternative editor for conduits is used to create various data sets for the 
output options of conduits. The following columns are available:

Surf. Water Flow 
Exponent

Value of B2 in the groundwater flow formula.

Surf. Water Flow 
Coefficient

Value of A2 in the groundwater flow formula.

Groundwater Flow 
Exponent

Value of B1 in the groundwater flow formula.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Output Alternative for Channels

The output alternative editor for channels is used to create various data sets for the 
output options of channels. The following columns are available:

Output Options Contains list boxes that allow you to specify 
whether the Sections Results type is Summary 
Results or Detailed Results for the associated 
element.

When Summary Results is selected, the result 
attributes are displayed for the start, end, and 
middle of the conduit.

SewerGEMS V8i breaks a conduit up into a 
number of longitudinal sections as detailed in the 
topic “Section Count” on page 14-723. When 
Detailed Results is selected, the result attributes 
are displayed for each of the longitudinal sections 
of the conduit.

Only Summary Results are displayed in the graphs 
and reports for conduits. To create a report 
containing the Detailed Results for each calculated 
section, you must use the report command in the 
“Sections Results Dialog Box” on page 6-206.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Inflow Alternatives

The inflow alternative lets you define loading data for elements capable of accepting 
an inflow, as listed below:

• “Inflow Alternative for Manholes” on page 9-516

• “Inflow Alternative for Catch Basins” on page 9-517

• “Inflow Alternative for Outfalls” on page 9-517

• “Inflow Alternative for Catchments” on page 9-518

• “Inflow Alternative for Ponds” on page 9-518

• “Inflow Alternative for Cross Section Nodes” on page 9-518

• “Inflow Alternative for Wet Wells” on page 9-519

• “Inflow Alternative for Pressure Junctions” on page 9-519

Inflow Alternative for Manholes

The inflow alternative for manholes allows you to define loading data for manholes. 
The following columns are available:

Output Options Contains list boxes that allow you to specify 
whether the Sections Results type is Summary 
Results or Detailed Results for the associated 
element.

When Summary Results is selected, the result 
attributes are displayed for the start, end, and 
middle of the channel.

SewerGEMS V8i breaks a channel up into a 
number of longitudinal sections as detailed in the 
topic “Section Count” on page 14-723. When 
Detailed Results is selected, the result attributes 
are displayed for each of the longitudinal sections 
of the channel.

Only Summary Results are displayed in the graphs 
and reports for channels. To create a report 
containing the Detailed Results for each calculated 
section, you must use the report command in the 
“Sections Results Dialog Box” on page 6-206.

Column Description
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Inflow Alternative for Catch Basins

The inflow alternative for catch basins allows you to define loading data for catch 
basins. The following columns are available:

Inflow Alternative for Outfalls

The inflow alternative for outfalls allows you to define loading data for outfalls. The 
following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.
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Inflow Alternative for Catchments

The inflow alternative for catchments allows you to define loading data for catch-
ments. The following columns are available:

Inflow Alternative for Ponds

The inflow alternative for ponds allows you to define loading data for ponds. The 
following columns are available:

Inflow Alternative for Cross Section Nodes

The inflow alternative for cross section nodes allows you to define loading data for 
cross section nodes. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.
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Inflow Alternative for Wet Wells

The inflow alternative for wet well nodes allows you to define loading data for wet 
well nodes. The following columns are available:

Inflow Alternative for Pressure Junctions

The inflow alternative for pressure junctions allows you to define loading data for 
pressure junctions. The following columns are available:

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Inflow Collection Contains an Ellipsis (...) button that allows you to 
access the Inflow Collection dialog box for the 
associated element.
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Rainfall Runoff Alternative

The rainfall runoff alternative allows you to define runoff data for catchment, pond, 
and wet well elements, as listed below:

• “Rainfall Runoff Alternative for Global Rainfall” on page 9-520

• “Rainfall Runoff Alternative for Catchments” on page 9-520

• “Rainfall Runoff Alternative for Ponds” on page 9-521

• “Rainfall Runoff Alternative for Wet Wells” on page 9-522

Rainfall Runoff Alternative for Global Rainfall

The rainfall runoff alternative for global rainfall displays information about global 
storm events in your project. The following fields are available:

Rainfall Runoff Alternative for Catchments

The rainfall runoff alternative for catchments allows you to define runoff data for 
catchment elements. The following columns are available:

Field Description

Global Storm Event Lists all of the rainfall curves that have been 
defined for the current project in the Storm Events 
dialog box, which is accessible by clicking the 
Ellipsis (...) button.

Source Displays the location of the library file for storm 
events that are derived from an engineering library 
entry. 

Return Event Displays the return event that is associated with 
the storm event. The return event is a value that 
reflects the average time between similar storm 
events. 

Depth Displays the rainfall depth of the storm as defined 
by the currently selected storm event. 

Duration Displays the duration of the storm as defined by 
the currently selected storm event. 
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Rainfall Runoff Alternative for Ponds

The rainfall runoff alternative for ponds allows you to define runoff data for pond 
elements. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Runoff Hydrograph Provides access to the User-Defined Hydrograph 
dialog box for the associated element through the 
Ellipsis (…) button.

Use Local Rainfall Contains check boxes that allow you to specify 
whether or not the associated catchment uses local 
rainfall. 

Local Storm Contains list boxes that allow you to choose from 
a list of rainfall curves that have already been set 
up in the current project. This column is available 
only when for catchments that Use Local Rainfall.

Duration Lets you define the duration of the storm for each 
catchment in the alternative. This column is only 
available for catchments that Use Local Rainfall. 

Depth Lets you define the depth of rainfall for each 
catchment in the alternative. This column is 
available only when for catchments that Use Local 
Rainfall.

Return Event Lets you specify the return frequency of the storm 
for each catchment in the alternative.

Runoff Hydrograph Clicking the Ellipsis (…) button in this field opens 
the User Defined Hydrograph editor, allowing you 
to define a hydrograph for each element in the 
alternative.
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Rainfall Runoff Alternative for Wet Wells

The rainfall runoff alternative for wet wells allows you to define runoff data for wet 
well elements. The following columns are available:

Water Quality Alternative

The water quality alternative allows you to define runoff data for manhole, catch 
basin, outfall, catchment, pond, and wet well elements, as listed below:

• “Water Quality Alternative for Manholes” on page 9-523

• “Water Quality Alternative for Catch Basins” on page 9-523

• “Water Quality Alternative for Outfalls” on page 9-524

• “Water Quality Alternative for Catchments” on page 9-524

• “Water Quality Alternative for Ponds” on page 9-525

• “Water Quality Alternative for Wet Wells” on page 9-525

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Evaporation Factor Fraction of evaporation rate realized. This 
attribute is only used during SWMM calculations.

Field Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Evaporation Factor Fraction of evaporation rate realized. This 
attribute is only used during SWMM calculations.
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Water Quality Alternative for Manholes

The water quality alternative allows you to define water quality data for manhole 
elements. The following columns are available:

Water Quality Alternative for Catch Basins

The water quality alternative allows you to define water quality data for catch basin 
elements. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.
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Water Quality Alternative for Outfalls

The water quality alternative allows you to define water quality data for outfall 
elements. The following columns are available:

Water Quality Alternative for Catchments

The water quality alternative allows you to define water quality data for catchment 
elements. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.
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Water Quality Alternative for Ponds

The water quality alternative allows you to define water quality data for pond 
elements. The following columns are available:

Water Quality Alternative for Wet Wells

The water quality alternative allows you to define water quality data for wet well 
elements. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Treatment Lets you define SWMM treatment functions that 
will be applied at the currently highlighted 
element. This field is only used during SWMM 
calculations.

Apply Treatment Lets you specify whether or not treatment is 
applied at the currently highlighted element. This 
field is only used during SWMM calculations.
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Sanitary Loading Alternative

The sanitary loading alternative lets you define sanitary loading data for manholes, 
catch basins, wet wells, and pressure junctions, as listed below:

• “Sanitary Loading Alternative for Manholes” on page 9-526

• “Sanitary Loading Alternative for Catch Basins” on page 9-526

• “Sanitary Loading Alternative for Wet Wells” on page 9-527

• “Sanitary Loading Alternative for Pressure Junctions” on page 9-527

Sanitary Loading Alternative for Manholes

The sanitary loading alternative for manholes allows you to define sanitary loading 
data for manhole elements. The following columns are available:

Sanitary Loading Alternative for Catch Basins

The sanitary loading alternative for catch basins allows you to define sanitary loading 
data for catch basin elements. The following columns are available:

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Sanitary Loads Clicking the Ellipses (...) button allows you to 
enter sanitary loads in the Sanitary (Dry Weather) 
Flow dialog box for the currently highlighted 
element.

Known Flow Lets you set the known flow for the currently 
highlighted element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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Sanitary Loading Alternative for Wet Wells

The sanitary loading alternative for wet wells allows you to define sanitary loading 
data for wet well elements. The following columns are available:

Sanitary Loading Alternative for Pressure Junctions

The sanitary loading alternative for pressure junctions allows you to define sanitary 
loading data for pressure junction elements. The following columns are available:

Sanitary Loads Clicking the Ellipses (...) button allows you to 
enter sanitary loads in the Sanitary (Dry Weather) 
Flow dialog box for the currently highlighted 
element.

Known Flow Lets you set the known flow for the currently 
highlighted element.

Column Description

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.

Sanitary Loads Clicking the Ellipses (...) button allows you to 
enter sanitary loads in the Sanitary (Dry Weather) 
Flow dialog box for the currently highlighted 
element.

Known Flow Lets you set the known flow for the currently 
highlighted element.

Column Description

ID Displays the unique identifier for each element in 
the alternative.

Label Displays the label for each element in the 
alternative.
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User Data Extensions Alternative

The User Data Alternative allows you to edit the data defined in the User Data Exten-
sion command for each of the network element types. The User Data Alternative 
editor contains a tab for each type of network element. 

Calculation Options
Each scenario is associated with a set of calculation options. Calculation options are 
stored in a discrete Calculation Options Profile. 

For more information on Calculation Options Profiles, see “Creating Calculation 
Profiles” on page 8-432 and “Calculation Profile Attributes” on page 8-433.

Sanitary Loads Clicking the Ellipses (...) button allows you to 
enter sanitary loads in the Sanitary (Dry Weather) 
Flow dialog box for the currently highlighted 
element.

Known Flow Lets you set the known flow for the currently 
highlighted element.

Column Description
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Chapter

Presenting Your
Results
Using Background Layers
Use background layers to display pictures behind your network. For example, you 
might want to display a picture of a neighborhood behind your network, so you can 
relate elements in your network to structures and roads depicted in the picture. You 
can add, delete, edit and rename background layers in the Background Layers 
Manager.

You can add multiple pictures to your project for use as background layers, and turn 
off the ones you don't want to show and turn on those you do. Additionally, you can 
create groups of pictures in folders, so you can hide or show an entire folder or group 
of pictures at once. 

To add or delete background layers, open the Background Layers manager: click View 
> Background Layers (Ctrl+6).

You can use shapefiles, AutoCAD DXF files, and raster (also called bitmap) pictures 
as background images for your model. These raster image formats are supported: 
bmp, jpg, jpeg, jpe, jfif, gif, tif, tiff, png, and sid.

Background Layer Manager

Note: When multiple background layers are overlaid, priority is given 
to the one that appears highest in the list. In other words, a layer 
in the first list position is drawn “on top of” all other layers, 
since they are all below it on the list. 

The Background Layer manager lets you add, edit, and remove and manage the back-
ground layers that are associated with the project. The dialog box contains a list pane 
that displays each of the layers currently contained within the project, along with a 
number of button controls.
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When a background layer is added, it appears in the Background Layers list pane, 
along with an associated check box that is used to control that layer’s visibility. 
Selecting the check box next to a layer causes that layer to become visible in the main 
drawing pane; clearing it causes it to become invisible. If the layers in the list pane are 
contained within one or more folders, clearing the check box next to a folder causes all 
of the layers within that folder to become invisible.

The toolbar consists of the following buttons: 

New Opens a submenu containing the following 
commands:

• File—Opens a browse dialog box that 
allows you to choose the file to use as a 
background layer.

• Folder—Creates a folder in the Back-
ground Layers list pane.

Delete Removes the currently highlighted 
background layer.

Rename Lets you rename the currently highlighted 
layer.

Edit Opens the background layer properties 
dialog box that corresponds with the 
currently highlighted background layer.

Shift Up Moves the currently highlighted object up in 
the list pane.

Shift Down Moves the currently highlighted object 
down in the list pane.

Expand All Expands all of the branches in the hierarchy 
displayed in the list pane.

Collapse All Collapses all of the branches in the 
hierarchy displayed in the list pane.

Help Displays online help for the Background 
Layer Manager.
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Working with Background Layer Folders

You can create folders in the Background Layers Manager to organize your back-
ground layers and create a group of background layers that can be turned off as one 
entity. You can also create folders within folders. When you start a new project, 
Bentley SewerGEMS V8i displays an empty folder in the Background Layers 
Manager called Background Layers. New background layer files and folders are 
added to the Background Layers folder by default.

To add a background layer folder:

1. Click View > Background Layers to open the Background Layers Manager.

2. In the Background Layers Manager, click the New button, then click New Folder 
from the shortcut menu. 

Or select the default Background Layers folder, then right-click and select New > 
Folder from the shortcut menu.

– If you are creating a new folder within an existing folder, select the folder, 
then click New > New Folder. Or right-click, then select New > Folder from 
the shortcut menu.

3. Right-click the new folder and select Rename from the shortcut menu.

4. Type the name of the folder, then press Enter.

To delete a background layer folder:

1. Click View > Background Layers to open the Background Layers Manager.

2. In the Background Layers Managers, select the folder you want to delete, then 
click the Delete button. 

– You can also right-click a folder to delete, then select Delete from the shortcut 
menu.

To rename a background layer folder:

1. Click View > Background Layers to open the Background Layers Manager.

2. In the Background Layers Managers, select the folder you want to rename, then 
click the Rename button. 

– You can also right-click a folder to rename, then select Rename from the 
shortcut menu.

3. Type the new name of the folder, then press Enter.

– You can also rename a background layer folder by selecting the folder, then 
modifying its label in the Properties Editor.
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Adding Background Layers

You add background layers to your project using the Background Layers Manager. 
When you start a new project, Bentley SewerGEMS V8i displays an empty folder in 
the Background Layers Manager called Background Layers. New background layer 
files and folders are added to the Background Layers folder by default.

To add a background layer: 

1. Click View > Background Layers to open the Background Layers Manager.

2. In the Background Layers Managers, click the New button, then click New File 
from the shortcut menu.

Or right-click on the default Background Layers folder and select New > File 
from the shortcut menu.

– To add a new background layer file to an existing folder in the Background 
Layer Manager, select the folder, then click New > New File. Or right-click, 
then select New > File from the shortcut menu.

3. Navigate to the file you want to add as a background layer and select it.

– If you select a .dxf file, the DXF Properties dialog box opens. For more infor-
mation, see “DXF Properties Dialog Box”.

– If you select a .shp the ShapeFile Properties dialog box opens. For more infor-
mation, see “Shapefile Properties Dialog Box”.

– If you select a .bmp, .jpg, .jpeg, .jpe, .jfif, .gif, .tif, .tiff, .png, or .sid file, the 
Image Properties dialog box opens. For more information, see “Image Proper-
ties Dialog Box”.

4. After you add the background layer, you might have to use the Pan button to move 
the layer within the drawing area; Zoom Extents does not center a background 
image.

Deleting Background Layers

To delete a background layer:

Select the background layer you want to delete, then click the Delete button. 

Or, right-click the background layer, then select Delete from the shortcut menu. 
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Editing Background Layers

You can edit a background layer in two ways: you can edit its properties or its position 
in a list of background layers displayed in the Background Layers Manager. 

To edit the properties of a background layer: 

1. Select the background layer you want to edit.

2. Click the Edit button. A Properties dialog box opens.

– You can also right-click the background layer, then select Edit from the 
shortcut menu.

To change the position of a background layer in the list of background layers:

The order of a background layer determines its Z level and what displays if you use 
more than one background layer. Background layers at the top of the list display on 
top of the other background layers in the drawing pane; so, background layers that are 
lower than the top one in the list might be hidden or partially hidden by layers above 
them in the list. 

Select the background layer whose position you want to change in the list of Back-
ground Layers Manager, then click the Shift Up or Shift Down buttons to move the 
selected background layer up or down in the list. 

Renaming Background Layers

To rename a background layer:

Select the background layer you want to rename, then click the Rename button. 

Or, right-click the background layer that you want to rename, then select Rename 
from the shortcut menu. 

Turning Background Layers On and Off

You can choose to turn your background layers off by clearing the check box next to 
the background layer file or folder than contains it in the Background Layers Manager.

Image Properties Dialog Box

This dialog box opens when you are adding or editing a background-layer image other 
than a .dxf or .shp. Use the following controls to define the properties of the back-
ground layer: 
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Image Filter Lets you more clearly display background images 
that you resize. Set this to Point, Bilinear, or 
Trilinear. These are methods of displaying your 
image on-screen.

• Point works well when you are not changing 
the size of the image in the display, for 
example, when you are displaying a 500 x 500 
pixel image at 100% using 500 x 500 pixels 
on-screen.

• Bilinear and Trilinear work well when you 
display your image on-screen using more or 
fewer pixels than your image contains, such 
as displaying a 500 x 500 pixel image at by 
stretching it to 800 x 800 pixels on-screen. 
Trilinear gives you smoother transitions when 
you zoom in and out of the image.

Transparency Lets you set the transparency level of the 
background layer. Bentley SewerGEMS V8i lets 
you add transparency to any image type you use as 
a background. Bentley SewerGEMS V8i ignores 
any transparency that exists in the image before 
you use it as a background.

Resolution Lets you select the clarity for MrSID® images that 
you use as background images. Because using a 
higher level of clarity or resolution increases the 
time it takes to display a MrSID image, you can 
select the resolution that best meets your needs. 
For formats other than MrSID, this drop-down list 
contains only one selection.
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You can also use BMP and JPG image files. For more information, see “How Do I 
Enter the Scale of a Background Image If it is a File Type without an Inherent Scale?” 
on page 16-917.

Shapefile Properties Dialog Box

The Shapefile Properties dialog box lets you define a shapefile background layer. Use 
the following controls to define the properties of the background layer:

Use Compression This checkbox lets you compress the image in 
memory so that it takes up less RAM while it is 
being loaded. When you check this option, you 
may see slight color distortion in the image. 

Note: The way the image is 
compressed depends on your 
computer’s video card. Not all 
video cards support this 
feature. If you check this option 
but your computer’s video card 
does not support image 
compression, the request for 
compression will simply be 
ignored and the image will be 
loaded uncompressed.

Image Position Table Lets you position the background layer with 
respect to your drawing.

• X/Y Image displays the size of the image you 
are using for a background and sets its posi-
tion with respect to the origin of your drawing. 
You cannot change this data.

• X/Y Drawing displays where the corners of the 
image your are using will be positioned rela-
tive to your drawing. By default, no scaling is 
used. However, you can scale the image you 
are using by setting different locations for the 
corners of the image you are importing. The 
locations you set are relative to the origin of 
your Bentley SewerGEMS V8i drawing.

Filename Lists the path and filename of the shapefile to use 
as a background layer.
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To access the Shapefile Properties dialog box, click New File in the Background 
Layers manager, then select an .shp file.

DXF Properties Dialog Box

The DXF Properties dialog box lets you define a .dxf file as the background layer. Use 
the following controls to define the properties of the background layer:

Browse Opens a browse dialog box, letting you select the 
file to be used as a background layer.

Label Identifies the background layer.

Unit Lets you select the unit associated with the spatial 
data within the shapefile. For example, if the X 
and Y coordinates of the shapefile represent feet, 
choose ft. from the drop-down list.

Transparency Lets you specify the transparency level of the 
background layer, where 0 has the least 
transparency and 100 has the most.

Line Color Sets the color of the layer elements. Click the 
Ellipsis (...) button to open a Color palette 
containing more color choices.

Line Thickness Sets the thickness of the outline of the layer 
elements. Use values beginning at 0, where 0 is 
the minimum thickness and larger values are 
thicker.

Fill Color Sets the fill color of the layer elements. Click the 
Ellipsis (...) button to open a Color palette 
containing more color choices.

Fill Figure Lets you show or hide the selected fill color for the 
layer elements. Select this check box to display 
the selected background color; clear it to turn off 
the background color and only the outline 
displays.

Filename Lists the path and filename of the .dxf file to use 
as a background layer.
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To access the .dxf properties, click New File In the Background Layers manager, then 
select a .dxf file.

Annotating Your Model
You can annotate any of the element types in Bentley SewerGEMS V8i.

To work with annotations, open the Element Symbology manager: click View > 
Element Symbology (Ctrl+5). 

Browse Opens a browse dialog box, letting you select the 
file to be used as a background layer.

Label Identifies the background layer.

Unit Lets you select the unit associated with the spatial 
data within the shapefile. For example, if the X 
and Y coordinates of the shapefile represent feet, 
choose ft. from the drop-down list.

Transparency Lets you specify the transparency level of the 
background layer, where 0 has the least 
transparency and 100 has the most.

Line Color Sets the color of the layer elements. Click the 
Ellipsis (...) button to open a Color palette 
containing more color choices.

Default Color Lets you use the line color included in the .dxf file 
or lets you use a custom color that you select in the 
Line Color field. Select this check box to use the 
default color included in the .dxf file. cleared this 
check box if you want to choose a custom color 
from the Line Color field.

Symbol Lets you choose the symbol that is displayed for 
each point element in the .dxf.

Size Sets the size of the symbol for each point element 
in the .dxf.
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Element Symbology Manager

The Element Symbology manager allows you to control the way that elements and 
their associated labels are displayed. The dialog box contains a pane that lists each 
element type along with the following buttons:

The toolbar consists of the following buttons: 
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New Opens a submenu containing the following 
commands: 

• New Annotation—Opens the Annota-
tion Properties dialog box, allowing you 
to define annotation settings for the 
highlighted element type.

• New Color Coding—Opens the Color 
Coding Properties dialog box, allowing 
you to define annotation settings for the 
highlighted element type.

• Add Folder—Creates a folder under the 
currently highlighted element type, 
allowing you to manage the various 
color coding and annotation settings 
that are associated with an element. 
You can turn off all of the symbology 
settings contained within a folder by 
clearing the check box next to the folder. 
When a folder is deleted, all of the 
symbology settings contained within it 
are also deleted. 

Delete Deletes the currently highlighted Color 
Coding or Annotation Definition or folder.

Rename Lets you rename the currently highlighted 
object.

Annotate Opens a shortcut menu containing the 
following options:

• Refresh Annotation—If you change an 
annotation’s prefix or suffix in the Prop-
erty Editor, or directly in the database, 
selecting this command refreshes the 
annotation.

• Update Annotation Offset—If you 
have adjusted the Initial X or Y offsets, 
selecting this command resets all anno-
tation Initial X or Y offsets to their default 
location (or new default location).

• Update Annotation Height—If you’ve 
adjusted the height multiplier, selecting 
this command resets all annotation 
height multiplier to their default values.
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Using Folders in the Element Symbology Manager

Use folders in the Element Symbology Manager to create a collection of color coding 
and/or annotation that can be turned off as one entity.

Adding Folders

Use element symbology folders to control whether related annotations and/or color 
coding displays. To create a folder in the Element Symbology Manager:

1. Click View > Element Symbology.

2. In the Element Symbology Manager, right-click an element and select New > 
Folder.

Or, select the element to which you want to add the folder, click the New button, 
then select New Folder.

3. Name the folder.

4. You can drag and drop existing annotations and color coding into the folder you 
create, and you can create annotations and color coding within the folder by right-
clicking the folder and selecting New > Annotation or New > Color Coding.

5. Use the folder to collectively turn on and off the annotations and color coding 
within the folder.

Shift Up Moves the currently highlighted object up in 
the list pane.

Shift Down Moves the currently highlighted object 
down in the list pane.

Expand All Expands each branch in the tree view pane.

Collapse All Collapses each branch in the tree view pane.

Help Displays online help for the Element 
Symbology Manager.
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Note: You can refresh the display of all color-codings/annotations 
within a folder by right-clicking the folder and selecting the 
Refresh Group command.

In the MicroStation version, the Refresh Group command will 
override any local modifications made to color or weight 
settings applied to individual elements using MicroStation 
commands. These elements will revert to the SewerGEMS V8i 
symbology settings after a Refresh Group command is initiated.

Deleting Folders

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the theme folder you want to delete, then select Delete. 

Or, select the folder you want to delete, then click the Delete button.

Renaming Folders

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the theme folder you want to rename, then select Rename. 

Or, select the folder you want to rename, then click the Rename button.

Adding Annotations

To add an annotation:

1. Click View > Element Symbology.

2. In the Element Symbology Manager, right-click an element and select New > 
Annotation.

Or, select the element to which you want to add the annotation, click the New 
button, and select New Annotation.

3. The Annotation Properties dialog box opens. Select the annotation you want in the 
Field drop-down list.

If you don’t find the Field you want to use immediately, look carefully through the 
list of available field selections from top to bottom to make sure you didn’t miss 
the field you want.

4. If needed, set a Prefix or Suffix. Anything you type as a prefix is added directly to 
the beginning of the label, and anything you type as a suffix is added to the end 
(so, you may want to include spaces as part of your prefix and suffix).
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Note: If you add an annotation that uses units, you can type “%u” in 
the prefix or suffix field to display the units in the drawing pane.

5. Select the initial X- and Y- offset for the annotation. Offset is measured from the 
center of the node or polygon or midpoint of the polyline.

6. If needed, set an initial height multiplier. Use a number greater than 1 to make the 
annotation larger, and a number between 0 and 1 to make the annotation smaller. 
If you use a negative number, the annotation is flipped (rotated 180 degrees).

7. If you have created selection sets, you can apply your annotation only to a partic-
ular selection set by selecting that set from the Selection Set drop-down list. If you 
have not created any selection sets, then the annotation is applied to all elements 
of the type you are using.

8. After you finish defining your annotation, click OK to close the Annotation Prop-
erties dialog box and create your annotation, or Cancel to close the dialog box 
without creating an annotation.

Deleting Annotations

Click View > Element Symbology. In the Element Symbology Manager, right-click 
an annotation you want to delete, then select Delete. 

Or, select the annotation you want to delete, then click the Delete button.

Editing Annotations

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the annotation you want to edit, then select Edit. 

Or, select the annotation you want to edit, then click the Edit button.

Note: Changes to annotation settings may not be visible in the 
drawing pane immediately. To refresh the drawing view to reflect 
any changes that have been made, you can right-click the 
annotation that was edited in the Element Symbology Manager 
and select the Re-Apply Annotation command from the 
submenu that appears.

Renaming Annotations

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the annotation you want to rename, then select Rename. 

Or, select the annotation you want to rename, then click the Rename button.
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Annotation Properties Dialog Box

The Annotation Properties dialog box allows you to define annotation settings for 
each element type. 

This dialog box allows you to define annotation settings for each element type. The 
dialog box consists of a list pane on the left and a control section on the right. The 
control section in the right side of the dialog allow you to edit the settings for the 
annotation that is currently highlighted in the list pane.

The dialog box consists of the following buttons:

and the following controls:

New Creates a new annotation in the list pane.

Delete Deletes the annotation that is currently 
highlighted in the list pane.

Rename Lets you rename the annotation that is 
currently highlighted in the list pane.

List Pane

Label Displays the name of the current annotation 
definition.

Initial X Offset Displays the initial X-axis offset of the 
annotation in feet.

Initial Y Offset Displays the initial Y-axis offset of the 
annotation in feet.

Selected Annotation

Field Name Lets you specify the attribute that is displayed 
by the annotation definition.

Prefix Lets you specify a prefix that is displayed before 
the attribute value annotation for each element 
to which the definition applies.
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Zoom Dependent Visibility

Available through the Properties dialog box of each layer in the Element Symbology 
manager, this feature can be used to cause elements, decorations, and annotations to 
only appear in the drawing pane when the view is within the zoom range specified by 
the Minimum and Maximum Zoom values.

• Enabled: Set to true to enable and set to false to disable Zoom Dependent Visi-
bility.  

Suffix Lets you specify a suffix that is displayed after 
the attribute value annotation for each element 
to which the definition applies.

Note: If you add an annotation that 
uses units, you can type 
“%u” in the prefix or suffix 
field to display the units in 
the drawing pane.

Selection Set Lets you specify a selection set to which the 
annotation settings will apply. If the annotation 
is to be applied to all elements, select the <All 
Elements> option in this field. <All Elements> 
is the default setting.

Initial Offset If checked, the values in the X and Y fields will 
be applied to all annotations (that are associated 
with the current annotation definition) in the 
drawing when the Apply button is clicked.

X Sets the initial horizontal offset for an 
annotation. Set this at the time you create the 
annotation.

Y Sets the initial vertical offset for an annotation. 
Set this at the time you create the annotation.

Initial Multiplier If checked, the value in the Height Multiplier 
field will be applied to all annotations (that are 
associated with the current annotation 
definition) in the drawing when the Apply 
button is clicked.

Initial Height Multiplier Sets the initial size of the annotation text. Set 
this at the time you create the annotation.
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• Minimum Zoom (%): The lowest zoom level at which the element will appear in 
the drawing pane.  

• Maximum Zoom (%) : The highest zoom level at which the element will appear 
in the drawing pane.  

• Apply to Element: Set to true to apply the zoom minimums and maximums to the 
symbols in the drawing.  

• Apply to Decorations: Set to true to apply the zoom minimums and maximums 
to flow arrows, check valves, and constituent sources in the drawing.  

• Apply to Annotations: Set to true to apply the zoom minimums and maximums 
to labels in the drawing.

Color Coding Your Model
Use color coding to help you quickly see what's going on in your Bentley Sewer-
GEMS V8i model. Use color coding to change the color and/or size of elements based 
on the value of data that you select, such as flow or element size. 

To work with color coding, open the Element Symbology manager: click View > 
Element Symbology (Ctrl+5). 

Adding Color-Coding

To add color coding, including element sizing:

1. Click View > Element Symbology.

2. In the Element Symbology Manager, right-click an element and select New > 
Color Coding.

Or, select the element to which you want to add the color coding, click the New 
button, and select New Color Coding.

3. The Color Coding Properties dialog box opens. Select the properties for which 
you want to color code from the Field and Selection Set drop-down lists.

4. In the Options drop-down list, select whether you want to apply color and/or size 
to the elements you are coding.

a. Click Calculate Range. This automatically sets the maximum and minimum 
values for your coding. If you want, you can set these values manually.

b. Click Initialize. This automatically creates values and colors in the Color 
Map. If you want, you can set these values manually.
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5. After you finish defining your color coding, click OK to close the Color Coding 
Properties dialog box and create your color coding, or Cancel to close the dialog 
box without creating a color coding.

6. Click Compute to compute your network.

7. To see the network color coding and/or sizing change over time:

a. Click View > EPS Results Browser, if needed, to open the EPS Results 
Browser dialog box.

b. Click Play to use the EPS Results Browser to review your color coding over 
time.

Deleting Color-Coding

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the color coding you want to delete, then select Delete. 

Or, select the color coding you want to delete, then click the Delete button.

Editing Color-Coding

Click View > Element Symbology. In the Element Symbology Manager, right-click 
the color coding you want to edit, then select Edit. 

Or, select the color coding you want to edit, then click the Edit button.

Note: Changes to color coding settings may not be visible in the 
drawing pane immediately. To refresh the drawing view to reflect 
any changes that have been made, you can right-click the 
annotation that was edited in the Element Symbology Manager 
and select the Refresh Color Coding command from the 
submenu that appears.

Renaming Color-Coding

Click View > Element Symbology. In the Element Symbology manager, right-click 
the color coding you want to rename, then select Rename. 

Or, select the color coding you want to rename, then click the Rename button.
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Color-Coding Properties Dialog Box

This dialog box allows you to define color coding for each element type. The dialog 
box consists of the following controls:

Properties

Field Name Lets you select the attribute by which the color 
coding is applied.

Selection Set Lets you apply a color coding to a previously 
defined selection set.

Calculate Range Automatically finds the minimum and maximum 
values for the selected attribute and enters them in 
the appropriate Min. and Max fields.

Min Lets you define the minimum value of the attribute 
to be color coded.

Max Lets you define the maximum value of the 
attribute to be color coded.

Steps Lets you specify how many rows are created in the 
color maps table when you click Initialize. When 
you click Initialize, a number of values equal to the 
number of Steps are created in the color maps 
table. The low and high values are set by the Min 
and Max values you set.

Color Map

Options Lets you select whether you want to use color 
coding, sizing, or both to code and display your 
elements.
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Using Profiles
A profile is a graph that plots a particular attribute across a distance, such as ground 
elevation along a section of piping. As well as these side or sectional views of the 
ground elevation, profiles can be used to show other characteristics, such as hydraulic 
grade, pressure, and constituent concentration. 

You define profiles by selecting a series of adjacent elements. Only conduits, chan-
nels, and gutters can be part of a profile. The profile you create displays the structures 
you selected, plus the relative ground and water elevations. 

Color Maps Table Lets you map colors to value ranges for the 
attribute being color coded. The following buttons 
are found along the top of the table:

• New—Creates a new row in the Color 
Maps table.

• Delete—Deletes the currently high-
lighted row from the Color Maps table.

• Initialize—Finds the range of values for 
the specified attribute, divides it into 
equal ranges based on the number of 
Steps you have set, and assigns a color to 
each range.

• Ramp—Generates a gradient range 
between two colors that you specify. 
Pick the color for the first and last 
values in the list, then Bentley SewerGEMS 
V8i automatically sets intermediate colors for 
the other values. For example, picking red as 
the first color and blue as the last color 
produces varying shades of purple for the 
other values.

Above Range Color Displays the color that is applied to elements 
whose value for the specified attribute fall outside 
the range defined in the color maps table. This 
selection is available if you choose Color or Color 
and Size from the Options list.

Above Range Size Displays the size that is applied to elements whose 
value for the specified attribute fall outside the 
range defined in the color maps table. This 
selection is available if you choose Size or Color 
and Size from the Options list.
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To create or use a profile, you must first open the Profiles manager. The Profiles 
manager is a dockable window that lets you add, delete, rename, edit, and view 
profiles.

Profiles Manager

The Profiles Manager allows you to create, view, and edit profile views of elements in 
the network. The dialog box contains a list pane that displays all of the profiles 
currently contained within the project, along with a toolbar.

The toolbar contains the following buttons:

Viewing Profiles

To view a profile:

1. Click Compute to calculate flows.

2. Click View > Profiles to open the Profile manager.

3. In the Profile manager, select the profile you want to view, then click the View 
button (or double-click the profile you want to view).

New Opens the Profile Setup dialog box, 
allowing you to create a new profile.

Delete Deletes the currently highlighted profile.

Rename Lets you rename the currently highlighted 
profile.

Edit Opens the Profile Setup dialog box, 
allowing you to modify the settings of the 
currently highlighted profile.

View Opens the Profile Element Viewer, allowing 
you to view the currently highlighted 
profile.

Help Displays online help for the Profile 
Manager.
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Note: You can edit your list of profile elements at any time and 
compute your network with the Profile Viewer dialog box open, 
but you must click Refresh to update the display of that dialog 
box if you do make changes.

4. The Profile Viewer dialog box opens. For more information, see “Profile Viewer 
Dialog Box” on page 10-555.

5. If necessary, you can click Chart Settings to change the look of the profile, and 
use Print Preview and Print to print the profile.

Animating Profiles

Animate a profile by:

1. Click Compute to calculate flows.

2. Click View > Profiles to open the Profiles manager.

3. In the Profiles manager, select the profile you want to see and click the Profile 
button to open the profile in Profile Viewer.

4. If the Scenario Animation dialog box is not open, select View > Scenario Anima-
tion to open it.

5. If needed, click the Scenario Animation Option button to setup the animation.

6. In the Scenario Animation dialog box, move the Time slider or click one of the 
animation buttons and watch the profile change over time in the Profile Viewer. 
As needed, click the Pause button in the Scenario Animation dialog box, to study 
the profile at a given time.

EPS Results Browser Dialog Box

The EPS Results Browser dialog box allows you to change the currently displayed 
time step and to animate the main drawing pane. The dialog box contains the 
following controls:

Time Display Shows the current time step that is displayed 
in the drawing pane.

Time Slider Lets you manually move the slider 
representing the currently displayed time step 
along the bar, which represents the full length 
of time that the scenario encompasses.

Rewind (Full) Sets the currently displayed time step to the 
beginning of the simulation.
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Animation Options Dialog Box

This dialog box allows you to define the animation settings that are applied when the 
drawing pane is animated. It contains the following controls: 

Play (Backwards) Sets the currently displayed time step from the 
end to the beginning.

Rewind (Single 
Time Step)

Returns the currently displayed time step to 
the previous time step.

Pause Stops the animation. Restarts it again with 
another click.

Forward (Single 
Time Step)

Advances the currently displayed time step to 
the following time step.

Play Advances the currently displayed time step 
from beginning to end.

Forward (Full) Sets the currently displayed time step to the 
end of the simulation.

Speed Slider Lets you control the length of the delay 
between time steps during animations.

Options Opens the Scenario Animation Options dialog 
box.

Help Opens Bentley SewerGEMS V8i online help.

Frame Options

Increment Controls the smoothness of the animation. 
Each time step in a scenario counts as one 
animation frame. This slider allows you to 
specify the number of frames that are skipped 
for each step in the animation. For example, if 
there are time steps every 3 minutes in the 
scenario and the slider is set at 3 frames, each 
step in the animation represents 9 minutes of 
scenario time when you click the Play button.

Looping Options
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Creating a New Profile

To create a new profile:

1. Click View > Profiles or click the Profiles Manager button on the View toolbar to 
open the Profiles manager.

2. Right-click in the Profiles manager and select New, or click the New button.

3. The Profile Setup dialog box opens. For more information, see “Profile Setup 
Dialog Box” on page 10-554.

4. Select the Elements you want to use: 

a. Click Select from Drawing. The Select dialog box appears:

You must select one path of contiguous elements; you cannot select diverging 
paths. You can select upstream and downstream elements, but if you begin at 
an upstream element, select downstream, and then make upstream selections 
to finish, your profile will be V-shaped, with higher elevations at the begin-
ning and end of the profile than in the middle. Instead, what you might want 
to do is select elements beginning at a high elevation and selecting elements at 
increasingly lower elevations towards an outfall.

No Loop Stops the animation at the end of the 
simulation, if selected.

Loop Animation Restarts the animation automatically, if 
selected. When this option is selected, the 
animation reaches the end of the simulation 
and then restarts from the beginning.

Rocker Animation Restarts the animation automatically in 
reverse. When this option is selected, the 
animation reaches the end of the simulation 
and then plays the simulation in reverse. 
When the beginning of the simulation is 
reached, the animation advances towards the 
end again, and so on.
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b. To add elements to the profile, click elements in the drawing pane. (By 
default, the Add button is active in the Select dialog box.) You can only add 
elements to either end of your selection—all selected elements must be 
contiguous.

When there is a plus sign next to the cursor, you can select elements to add to 
the profile; elements that you successfully select are highlighted red.

c. To remove elements from the profile, click the Remove button in the Select 
dialog box. Thereafter, elements you select in the drawing pane are removed 
from the profile. You can only remove elements from either end of your selec-
tion—all selected elements must be contiguous.

When there is a minus sign next to the cursor, you can remove elements from 
the profile; unselected elements are not highlighted.

d. When you are finished adding elements to your profile, click the Done button 
in the Select dialog box.

5. The Profile Setup dialog box opens and displays a list of the elements you 
selected. If necessary, use the Reverse button to reverse the order of these 
elements, and the Select from Drawing or Remove buttons to add or remove 
elements from the list.

Note: You can edit your list of profile elements at any time and 
compute your network with the Profile Viewer dialog box open, 
but you must click Refresh to update the display of that dialog 
box if you do make changes.

6. Click Close and Open Profile to close the Profile Setup dialog box and open the 
Profile Viewer dialog box.

Editing Profiles

You can edit a profile to change the elements that it uses or the order in which those 
elements are used. To edit a profile:

1. Click View > Profiles to open the Profiles manager.

2. In the Profiles manager, right-click the profile you want to edit, then select Edit.

Or, select the profile you want to edit, then click the Edit button.

3. The Profile Setup dialog box opens. Modify the profile as needed and click OK to 
save your changes or Cancel to exit without saving your changes.
Bentley SewerGEMS V8i User’s Guide 10-553



Using Profiles
Deleting Profiles

Click View > Profiles to open the Profiles manager. In the Profiles manager, right-
click the profile you want to delete, then select Delete. 

Or, select the profile you want to delete, then click the Delete button.

Renaming Profiles

Click View > Profiles to open the Profiles manager. In the Profiles manager, right-
click the profile you want to rename, then select Rename. 

Or, select the profile you want to rename, then click the Rename button.

Profile Setup Dialog Box

Setting up a profile is a matter of selecting the adjacent elements on which the profile 
is based. The Profile Setup dialog box includes the following options:

Label Displays the list of elements that define the 
profile.

Select From Drawing Lets you select and clear elements for the profile. 
You can select channels, conduits, and ponds for 
inclusion in your profile.

Note: In AutoCAD mode, you cannot 
use the shortcut menu, you 
must re-open the Profile Setup 
dialog box.

Reverse Lets you reverse the profile, so the first node in the 
list becomes the last, and the last node becomes 
the first.

Remove All Removes all elements from the profile.

Remove All Previous Removes all elements that appear before the 
selected element in the list. If the selected element 
is a pipe, the associated node is not removed.

Remove All Following Removes all elements that appear after the 
selected element in the list. If the selected element 
is a pipe, the associated node is not removed.
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After everything is set up to your satisfaction, click OK to generate the plot of the 
profile.

Profile Viewer Dialog Box

This dialog box displays the profile view of the profile run that is plotted from the 
Profile Manager. It consists of the profile display pane and the following controls:

Open Profile Closes the Profile Setup dialog box and opens the 
Profile Viewer dialog box.

Zoom Window Lets you magnify or reduce the display of a 
section of the graph. To zoom or magnify an area, 
select the Zoom Window tool, click to the left of 
the area you want to magnify, then drag the mouse 
to the right, across the area you want to magnify, 
so that the area you want to magnify is contained 
within the marquee that the Zoom Window tool 
draws. After you have selected the area you want 
to magnify, release the mouse button to stop 
dragging.
To zoom out, or reduce the magnification, drag the 
mouse from right to left across the magnified 
image.

Zoom Extents Magnifies the profile so that the entire graph is 
displayed.

Chart Settings Opens the Chart Options dialog box, letting you 
view and modify the display settings for the 
current profile plot. For more information, see 
“Chart Options Dialog Box” on page 10-587.

Warning! Never delete or rename any 
of the series entries on the 
Series Tab of the Chart 
Options dialog box. These 
series were specifically 
designed to enable the 
display of the Profile Plots.

Display Labels Lets you display or hide labels for the elements in 
your profile plot.
Bentley SewerGEMS V8i User’s Guide 10-555



Using Profiles
Copy Copies the contents of the Profile Viewer dialog 
box as an image to the Windows clipboard, from 
where you can paste it into another application, 
such as Microsoft® Word® or Adobe® 
Photoshop®.

Print Prints the current view of the profile to your 
default printer. If you want to use a printer other 
than your default, use Print Preview to change the 
printer and print the profile.

Print Preview Opens a print preview window containing the 
current view of the profile. You can use the Print 
Preview dialog box to select a printer and preview 
the output before you print it.

Note: Do not change the print 
preview to grayscale, as doing 
so might hide some elements 
of the display.

Refresh Updates the profile view to reflect changes in 
input data and results.

EPS Results Browsers The following EPS Results Browsers are found to 
the right of the Refresh button:

• Rewind (Full)—Sets the currently displayed 
time step to the beginning of the simulation.

• Pause—Stops the animation. Restarts it again 
with another click.

• Play—Advances the currently displayed time 
step from beginning to end.

• Time Display—Shows the current time step 
that is displayed in the drawing pane.

• Time Slider—Lets you manually move the 
slider representing the currently displayed 
time step along the bar, which represents the 
full length of time that the scenario encom-
passes
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Viewing and Editing Data in FlexTables
FlexTables lets you view input data and results for all elements of a specific type in a 
tabular format. You can use the standard set of FlexTables or create customized 
FlexTables to compare data and create reports.

FlexTables lets you view all elements in the project, all elements of a specific type, or 
any subset of elements. Additionally, to ease data input and present output data for 
specific elements, FlexTables can be:

• Filtered (see “Sorting and Filtering FlexTable Data” on page 10-566)

• Globally edited (see “Globally Editing Data” on page 10-565)

• Sorted (see “Sorting and Filtering FlexTable Data” on page 10-566) 

If you need to edit a set of properties for all elements of a certain type in your network, 
you might consider creating a FlexTable and making your changes there, rather than 
editing each element one at a time, in sequence.

FlexTables can also be used to create results reports that you can print, save as a file, 
or copy to the Windows clipboard for copying into word processing or spreadsheet 
software.

To work with FlexTables, select the FlexTables manager or use View > FlexTables 
(Ctrl+7) to open the FlexTables manager if it is closed.

FlexTables Manager

The FlexTables Manager allows you to create, manage, and delete custom tabular 
reports. The dialog box contains a list pane that displays all of the custom FlexTables 
currently contained within the project, along with a toolbar.

The toolbar contains the following buttons:
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:

Working with FlexTable Folders

You can add, delete, and rename folders in the FlexTable Manager to organize your 
FlexTables into groups of that can be turned off as one entity. You can also create 
folders within folders. When you start a new project, Bentley SewerGEMS V8i 
displays two items in the FlexTable Manager: Tables - Project (for project-level 
FlexTables) and Tables - Shared (for FlexTables shared by more than one Bentley 
SewerGEMS V8i project). You can add new FlexTables and FlexTable folders to 
either item or to existing folders.

New Opens a submenu containing the following 
commands:

• FlexTable—Creates a new tabular 
report and opens the FlexTable Setup 
dialog box, allowing you to define the 
element type that the FlexTable 
displays, and the columns that are 
contained in the table.

• Folder—Creates a folder in the list 
pane, allowing you to group custom 
FlexTables.

Delete Deletes the currently highlighted FlexTable.

Rename Lets you rename the currently highlighted 
FlexTable.

Edit Opens the FlexTable Setup dialog box, 
allowing you to make changes to the format 
of the currently selected table

Open Lets you open the currently highlighted 
FlexTable.

Help Displays online help for the FlexTable 
Manager.
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To add a FlexTable folder:

1. Click View > FlexTables to open the FlexTables Manager.

2. In the FlexTable Manager, select either Tables - Project or Tables - Shared, then 
click the New button.

– If you are creating a new folder within an existing folder, select the folder, 
then click the New button.

3. Click New Folder from the shortcut menu.

4. Right-click the new folder and select Rename from the shortcut menu.

5. Type the name of the folder, then press Enter.

To delete a FlexTable folder:

1. Click View > FlexTables to open the FlexTables Manager.

2. In the FlexTables Manager, select the folder you want to delete, then click the 
Delete button. 

– You can also right-click a folder to delete, then select Delete from the shortcut 
menu.

To rename a FlexTable folder:

1. Click View > FlexTables to open the FlexTables Manager.

2. In the FlexTables Manager, select the folder you want to rename, then click the 
Rename button. 

– You can also right-click a folder to rename, then select Rename from the 
shortcut menu.

3. Type the new name of the folder, then press Enter.

– You can also rename a FlexTable folder by selecting the folder, then modi-
fying its label in the Properties Editor.

FlexTable Dialog Box

FlexTables are displayed in the FlexTable dialog box. The dialog box contains a 
toolbar, the rows and columns of data in the FlexTable, and a status bar.

The toolbar contains the following buttons:
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Export to File Export to a Shapefile .shp, a Tab Delimited 
file .txt, or a Comma Delimited File .csv. 

Copy Lets you copy the contents of the selected 
table cell, rows, and/or columns for the 
purpose of pasting into a different row or 
column or into a text editing program such 
as Notepad.

Paste Lets you paste the contents of the Windows 
clipboard into the selected table cell, row, or 
column. Use this with the Copy button.

Edit Opens the FlexTable Setup dialog box, 
allowing you to make changes to the format 
of the currently selected table
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The status bar at the bottom of the FlexTable dialog box contains the following items:

• x of x elements displayed—Number of elements displayed in the FlexTable of 
the total possible number of that type of element.

Zoom To Lets you zoom into and center the drawing 
pane on the currently selected element in the 
FlexTable.

Report Lets you create and view a report of your 
FlexTable for either the current time step or 
all time steps.

Options Opens a submenu containing the following 
commands:

• Create Selection Set—Lets you create 
a new static selection set ( a selection 
set based on selection) containing the 
currently selected elements in the 
FlexTable.

• Add to Selection Set—Lets you add 
the currently selected elements in the 
FlexTable to an existing selection set.

• Remove from Selection Set—
Removes the currently selected 
elements from an existing selection set.

• Relabel—Opens an Element Relabeling 
box where you can Replace, Append, or 
Renumber

Select In Drawing Opens a submenu containing the following 
commands:

• Select In Drawing—Selects the 
currently highlighted element(s) in the 
drawing pane.

• Add to Selection—Adds the currently 
highlighted element(s) to the group that 
is currently highlighted in the drawing 
pane.

• Remove From Selection—Removes 
the currently highlighted element(s) from 
the group that is currently highlighted in 
the drawing pane.
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• FILTERED—If you have applied a filter to the FlexTable, this appears in the 
status bar. Hold the mouse cursor over this panel to display a tool tip, which lists a 
summary of active filters.

• SORTED—If you have sorted the order of any items in the FlexTable, this 
appears in the status bar. Hold the mouse cursor over this panel to display a tool 
tip, which lists a summary of active sorting.

Statistics Dialog Box

The Statistics dialog box displays statistics for the elements in a FlexTable. You can 
right-click any unitized input or output column and choose the Statistics command to 
view the count, maximum value, mean value, minimum value, standard deviation, and 
sum for that column.

Opening FlexTables

You open FlexTables from within the FlexTable Manager.

To open FlexTables:

1. Click View > FlexTables or click the FlexTables button on the View toolbar to 
open the FlexTables Manager.

2. Perform one of the following steps:

– Right-click the FlexTable you want to open, then select Open.

– Select the FlexTable you want to open, then click the Open button.

– Double-click the FlexTable you want to open.
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Creating a New FlexTable

You can create project-level or shared FlexTables.

• Project-level FlexTables are available only for the project in which you create 
them.

• Shared tables are available in all Bentley SewerGEMS V8i projects.

To create a new FlexTable:

Project-level and shared FlexTables are created the same way:

1. Click View > FlexTables or click the FlexTables button on the View toolbar to 
open the FlexTables Manager.

2. In the FlexTables Manager, right-click Tables - Project or Tables - Shared, then 
select New > FlexTable.

Or, select Tables - Project or Tables - Shared, click the New button, then select 
FlexTable.

3. The Table Setup dialog box opens.

4. Select the Table Type you want to create. This lets you filter your table by element 
type.

5. Select the items you want in the FlexTable by moving them to the Selected 
Columns pane.

6. Click OK.

7. The table displays in the FlexTables Manager; you can type to rename the table or 
accept the default name.

Deleting FlexTables

Click View > FlexTables to open the FlexTables Manager. In the FlexTables manager, 
right-click the FlexTable you want to delete, then select Delete. 

Or, select the FlexTable you want to delete, then click the Delete button. You cannot 
delete predefined FlexTables.

Note: You cannot delete predefined FlexTables.

Naming and Renaming FlexTables

You name and rename FlexTables in the FlexTable Manager.
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To rename FlexTables:

1. Click View > FlexTables or click the FlexTables button on the View toolbar to 
open the FlexTables Manager.

2. Perform one of the following steps:

– Right-click the FlexTable you want to rename, then select Rename.

– Select the FlexTable you want to rename, then click the Rename button.

– Click the FlexTable you want to rename, to select it, then click the name of 
the FlexTable.

Note: You cannot rename predefined FlexTables.

Editing FlexTables

You can edit a FlexTable to change the columns of data it contains or the values in 
some of those columns.

Editable columns: Columns that contain data you can edit are displayed 
with a white background. You can change these 
columns directly in the FlexTable and your changes 
are applied to your model when you click OK.

The content in the FlexTable columns can be 
changed in other areas of Bentley SewerGEMS V8i, 
such as in a Property Editor or managers; but, it 
might be more efficient to make changes to 
numerous elements in a FlexTable rather than the 
Property Editor or a manager.

If you make a change that affects a FlexTable outside 
the FlexTable, the FlexTable is updated automatically 
to reflect the change.

Non-editable columns: Columns that contain data you cannot edit are 
displayed with a yellow background, and correspond 
to model results calculated by the program and 
composite values.

The content in these columns can be changed in other 
areas of Bentley SewerGEMS V8i, such as in a 
Property Editor and by running a computation.

If you make a change that affects a FlexTable outside 
the FlexTable, the FlexTable is updated automatically 
to reflect the change.
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To edit a FlexTable:

1. Click View > FlexTables to open the FlexTables Manager, then you can:

– Right-click the FlexTable, then select Edit.

– Double-click the FlexTable to open it, then click Edit.

– Click the FlexTable, to select it, then click the Edit button.

2. The Table dialog box opens. .

3. Use the Table dialog box to include and exclude columns and change the order in 
which the columns appear in the table.

4. Click OK after you finish making changes, to save your changes and close the 
dialog box; or, click Cancel to close the dialog box without making changes.

Editing Column-Heading Text

To change the text of a column heading:

1. Click View > FlexTables to open the FlexTables Manager.

2. In the FlexTables manager, open the FlexTable you want to edit.

3. Right-click the column heading and select Edit Column Label.

4. Type the new name for the label and click OK to save those changes and close the 
dialog box or Cancel to exit without making any changes.

Changing Units, Format, and Precision in FlexTables

To change the units, format, or precision in a column of a FlexTable:

1. Click View > FlexTables to open the FlexTables Manager.

1. In the FlexTables manager, open the FlexTable you want to edit.

2. Right-click the column heading and select Units.

3. Make the changes you want and click OK to save those changes or Cancel to exit 
without making any changes.

Navigating in Tables

The arrow keys, Ctrl+Home, Ctrl+End, PgUp, PgDn, and Ctrl+arrow keys navigate to 
different cells in a table.

Globally Editing Data
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Using FlexTables, you can globally edit all of the values in an entire editable column. 
Globally editing a FlexTable column can be more efficient for editing properties of an 
element than using the Properties Editor or managers to edit each element in your 
model individually. 

To globally edit the values in a FlexTable column:

1. Click View > FlexTables to open the FlexTables Manager.

2. In the FlexTables manager, open the FlexTable you want to edit and find the 
column of data you want to change.

If necessary, you might need to first create a FlexTable or edit an existing one to 
make sure it contains the column you want to change.

3. Right-click the column heading and select Global Edit.

4. In the Operation field, select what you want to do to data in the column: Add, 
Divide, Multiply, Set, or Subtract.

Note: The Operation field is only available for numeric data.

5. In the Global Edit field, type or select the value you want—for numeric data, you 
typically type a new value, for other data you might select from a drop-down list 
or select a check box.

Sorting and Filtering FlexTable Data

You can sort and filter your FlexTables to focus on specific data or present your data 
in one of the following ways:

To sort the order of columns in a FlexTable:

You can sort the order of columns in a FlexTable in two ways:

• Edit the FlexTable (see “Editing FlexTables”), to open the Table dialog box and 
change the order of the selected tables using the up and down arrow buttons.

The top-most item in the Selected Columns pane appears furthest to the left in the 
resulting FlexTable.

• Open the FlexTable, click the heading of the column you want to move, then click 
again and drag the column to the new position. You can only move one column at 
a time.

To sort the contents of a FlexTable:

1. Open the FlexTable you want to edit

2. Right-click a column heading to rank the contents of the column.
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3. Select Sort Ascending Sort Descending, or Custom.

– Sort Ascending—Sorts alphabetically from A to Z, from top to bottom. Sorts 
numerically from negative to positive, from top to bottom. Sorts selected 
check boxes to the top and cleared ones to the bottom.

– Sort Descending—Sorts alphabetically from Z to A, from top to bottom. 
Sorts numerically from positive to negative, from top to bottom. Sorts cleared 
check boxes to the top and selected ones to the bottom.

– Custom—Opens the Custom Sort dialog box, which allows you to choose an 
attribute to sort by in ascending or descending order.

To filter a FlexTable:

You filter a FlexTable by creating a query.

1. Open the FlexTable you want to filter.

2. Right-click the column heading you want to filter, and select Filter.

The Query Builder dialog box opens.

3. All input and results fields for the selected element type appear in the Fields list 
pane, available SQL operators and keywords are represented by buttons, and 
available values for the selected field are listed in the Unique Values list pane. 
Perform the following steps to construct your query:

a. Double-click the field you wish to include in your query. The database 
column name of the selected field appears in the preview pane.

b. Click the desired operator or keyword button. The SQL operator or keyword 
is added to the SQL expression in the preview pane.

c. Click the Refresh button above the Unique Values list pane to see a list of 
unique values available for the selected field. The Refresh button is becomes 
disabled after you use it for a particular field.

d. Double-click the unique value you want to add to the query. The value is 
added to the SQL expression in the preview pane.

e. Click the Validate button above the preview pane to validate your SQL 
expression. If the expression is valid, the word “VALIDATED” is displayed in 
the lower right corner of the dialog box.

f. Click the Apply button above the preview pane to execute the query. If you 
didn’t validate the expression, the Apply button validates it before executing 
it.

g. Click OK.
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The FlexTable displays columns of data for all elements returned by the query and 
the word “FILTERED” is displayed in the FlexTable status bar.

To reset a filter:

1. Right-click the column heading you want to filter.

2. Select Filter.

3. Click Reset.

The status pane at the bottom of the Table window always shows the number of rows 
displayed and the total number of rows available (e.g., 10 of 20 elements displayed). 
When a filter is active, this message is highlighted.

Preview pane

Validate 
button

Apply button

Click the desired operator 
or keyword button to add it 
to the SQL expression in 
the preview pane

Double-click the 
desired field to add it 
to the preview pane

Double-click the 
desired unique 
value to add it to 
the SQL 
expression in the 
preview pane

Click the Refresh 
button to display the 
list of available 
unique values
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Note: Table filtering lets you perform global editing (see “Editing 
FlexTables”) on any subset of elements. Only the elements that 
appear in the filtered table can be edited.

Custom Sort Dialog Box

This dialog box allows you to choose an attribute to sort by, and whether to sort in 
asending or descending order. You can choose multiple attributes to sort by. When 
multiple sort attributes are specified, the first attribute specified will take precedence, 
then the second, and so on.

Customizing Your FlexTable

There are several ways to customize tables to meet a variety of output requirements:

• Changing the Report Title—When you print a table, the table name is used as 
the title for the printed report. You can change the title that appears on your 
printed report by renaming the table. For more information, see “Naming and 
Renaming FlexTables” on page 10-563.

• Adding/Removing Columns—You can add, remove, and change the order of 
columns from the Table Setup dialog box. For more information, see “Editing 
FlexTables” on page 10-564 and “Sorting and Filtering FlexTable Data” on 
page 10-566.

• Drag/Drop Column Placement—With the Table window open, select the 
column heading of the column that you would like to move and drag the column 
to its new location. For more information, see “Sorting and Filtering FlexTable 
Data” on page 10-566.
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• Resizing Columns—With the Table open, click the vertical separator line 
between column headings. Notice that the cursor changes shape to indicate that 
you can resize the column. Drag the column separator to the left or right to stretch 
the column to its new size.

• Changing Column Headings—With the Table window open, right-click the 
column heading that you wish to change and select Edit Column Label.

FlexTable Setup Dialog Box

The Table Setup dialog box allows you to customize any table through the following 
options: 

Table Type Lets you specify the type of elements that appear 
in the table. It also provides a filter for the 
attributes that appear in the Available Columns 
list. When you choose a table type, the available 
list only contains attributes that can be used for 
that table type. For example, only manhole 
attributes are available for a manhole table.

Available Columns Contains all the attributes that are available for 
your table design. The Available Columns list is 
located on the left side of the Table Setup dialog 
box. This list contains all of the attributes that are 
available for the type of table you are creating. 
The attributes displayed in yellow represent non-
editable attributes, while those displayed in white 
represent editable attributes.

Selected Columns Contains attributes that appear in your custom 
designed FlexTable. When you open the table, the 
selected attributes appear as columns in the table 
in the same order that they appear in the list. You 
can drag and drop or use the up and down buttons 
to change the order of the attributes in the table.
The Selected Columns list is located on the right-
hand side of the Table Setup dialog box. To add 
columns to the Selected Columns list, select one 
or more attributes in the Available Columns list, 
then click the Add button [>] or drag and drop the 
highlighted attributes to the Selected Columns list.
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Column Manipulation 
Buttons

Lets you select or clear columns to be used in the 
table, as well as to arrange the order in which the 
columns appear.
The Add and Remove buttons are located in the 
center of the Table Setup dialog box.

• [  >  ] Adds the selected items from the Avail-
able Columns list to the Selected Columns list.

• [ >> ] Adds all of the items in the Available 
Columns list to the Selected Columns list.

• [  <  ] Removes the selected items from the 
Selected Columns list.

• [ << ] Removes all items from the Selected 
Columns list.

Note: You can select multiple 
attributes in the Available 
Columns list by holding down 
the Shift key or the Control key 
while clicking with the mouse. 
Holding down the Shift key 
provides group selection 
behavior. Holding down the 
Control key provides single 
element selection behavior.

To rearrange the order of the attributes in the 
Selected Columns list, highlight the item to be 
moved, then move it up or down in the list by 
dragging or clicking the up or down button located 
below the Selected Columns list.
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Element Relabeling Dialog Box

This dialog is where you perform global element relabeling operations for the Label 
column of the FlexTable.

The element relabeling tool allows you to perform three types of operations on a set of 
element labels: Replace, Renumber, and Append. The active relabel operation is 
chosen from the list box in the Relabel Operations section of the Relabel Elements 
dialog box. The entry fields for entering the information appropriate for the active 
relabel operation appear below the Relabel Operations section. The following list 
presents a description of the available element relabel operations. 

• Replace—This operation allows you to replace all instances of a character or 
series of characters in the selected element labels with another piece of text. For 
instance, if you selected elements with labels CO-1, CO-2, CO-12, and CO-5, you 
could replace all the COs with the word Conduit by entering CO in the Find field, 
Conduit in the Replace With field, and clicking the Apply button. The resulting 
labels are Conduit-1, Conduit-2, Conduit-12, and Conduit-5. You can also use this 
operation to delete portions of a label. Suppose you now want to go back to the 
original labels. You can enter Conduit in the Find field and leave the Replace With 
field blank to reproduce the labels CO-1, CO-2, CO-12, and CO-5. There is also 
the option to match the case of the characters when searching for the characters to 
replace. This option can be activated by checking the box next to the Match Case 
field.

• Renumber—This operation allows you to generate a new label, including suffix, 
prefix, and ID number for each selected element. For example, if you had the 
labels CO-1, CO-4, CO-10, and Conduit-12, you could use this feature to 
renumber the elements in increments of five, starting at five, with a minimum 
number of two digits for the ID number field. You could specify a prefix CO- and 
a suffix -Z1 in the Prefix and Suffix fields, respectively. The prefix and suffix are 
appended to the front and back of the automatically generated ID number. The 
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value of the new ID for the first element to be relabeled, 5, is entered in the Next 
field. The value by which the numeric base of each consecutive element is in 
increments, 5, is entered in the Increment field. The minimum number of digits in 
the ID number, 2, is entered in the Digits field. If the number of digits in the ID 
number is less then this value, zeros are placed in front of it. Click the Apply 
button to produce the following labels: CO-05-Z1, CO-10-Z1, CO-15-Z1, and 
CO-20-Z1. 

• Append—This operation allows you to append a prefix, suffix, or both to the 
selected element labels. Suppose that you have selected the labels 5, 10, 15, and 
20, and you wish to signify that these elements are actually conduits in Zone 1 of 
your system. You can use the append operation to add an appropriate prefix and 
suffix, such as CO- and -Z1, by specifying these values in the Prefix and Suffix 
fields and clicking the Apply button. Performing this operation yields the labels 
CO-5-Z1, CO-10-Z1, CO-15-Z1 and CO-20-Z1. You can append only a prefix or 
suffix by leaving the other entry field empty. However, for the operation to be 
valid, one of the entry fields must be filled in.

The Preview field displays an example of the new label using the currently defined 
settings.

Copying, Exporting, and Printing FlexTable Data

You can output your FlexTable several ways: 

• Copy FlexTable data via the clipboard

• Export FlexTable data as a text file

• Create a FlexTable report

To copy FlexTable data via the clipboard:

You can copy your FlexTable data via the clipboard and paste it into another Windows 
application, such as a word-processing application as tab-delimited text.

1. Click View > FlexTables to open the FlexTables manager.

2. In the FlexTables manager, open the FlexTable you want to use.

3. Click Copy. The contents of the FlexTable are copied to the Windows clipboard.
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Caution: Make sure you paste the data you copied before you copy 
anything else to the Windows clipboard. If you copy 
something else to the clipboard before you paste your 
FlexTable data, your FlexTable data will be lost from the 
clipboard.

4. Paste (Ctrl+v) the data into other Windows software, such as your word-
processing application.

To export FlexTable data as a text file:

You can export the data in a FlexTable as tab- or comma-delimited ASCII text, for use 
in other applications, such as Notepad, spreadsheet, or word processing software.

1. Click View > FlexTables to open the FlexTables manager.

2. In the FlexTables manager, open the FlexTable you want to use.

3. Click File > Export data.

4. Select either Tab Delimited or Comma Delimited.

5. When prompted, set the path and name of the .txt file you want to create.

To create a FlexTable report:

Create a FlexTable Report if you want to print a copy of your FlexTable and its values.

1. Click View > FlexTables to open the FlexTables manager.

2. In the FlexTables manager, open the FlexTable you want to use.

Note: Instead of Print Preview, you can click Print to print the report 
without previewing it.

3. Click Report. A print preview of the report displays to show what your report will 
look like if printed using your default printer. 

Note: You cannot edit the format of the report.

4. Click Print to open the Print dialog box and print the report to a printer that you 
select.

Using Predefined Tables

Element tables are read-only, predefined FlexTables. There is one predefined table for 
every element available in Bentley SewerGEMS V8i. You can access the element 
tables by clicking Report > Element Tables or from the FlexTable manager. Use 
these tables to review data about the elements in your model.
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Reporting
Use reporting to create printable content based on some aspect of your model, such as 
element properties or results.

You need to compute your model before you can create reports about results, such as 
the movement of water in your network. But, you can create reports about input data 
without computing your model, such as conduit diameters. (To compute your model, 
after you set up your elements and their properties, click the Compute button.)

You can access reports by:

• Clicking the Report menu

• Right-clicking any element, then selecting Report

Reporting includes:

• “Using Standard Reports” on page 10-575

• “Reporting on Element Data” on page 10-576

Using Standard Reports

There are several standard reports available. To access the standard reports, click the 
Report menu, then select the report you want.

You can use these standard reports:

• “Creating a Project Inventory Report” on page 10-575

• “Creating a Scenario Summary Report” on page 10-575

Creating a Project Inventory Report

To create a report that provides an overview of your network, click Report > Project 
Inventory. The report dialog box opens and displays your report. You cannot format 
the report, but you can print it by clicking the Print button.

Creating a Scenario Summary Report

To create a report that summarizes your scenario, click Report > Scenario Summary. 
The report dialog box opens and displays your report. You cannot format the report, 
but you can print it by clicking the Print button.
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Reporting on Element Data

You can create reports for specific elements in your network by computing the 
network, right-clicking the element, then selecting Report. You cannot format the 
report, but you can print it by clicking the Print button.

Report Options

The Report Options dialog box offers control over how a report is displayed.

The header and footer can be fully customized and you can edit text to be displayed in 
the cells or select a pre-defined dynamic variable from the cell's menu. 

• %(Company) - The name specified in the project properties.

• % (DateTime) - The current system date and time.

• % (BentleyInfo) - The standard Bentley company information.

• % (BentleyName) - The standard Bentley company name information.

Load factory default 
settings to current view

Changes the display settings 
used by the current repor to 
the factory default.

Load global settings to 
current view

Changes the display settings 
used by the current report to 
the previously saved global 
settings.

Save current view settings 
to global settings

Saves the display settings 
used by the current report as 
the new global settings.
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• % (Pagination) - The report page out of the maximum pages.

• % (ProductInfo) - The current product and its build number.

• % (ProjDirectory) - The directory path where the project file is stored.

• % (ProjEngineer) - The engineer specified in the project properties.

• % (ProjFileName) - The full file path of the current project.

• % (ProjStoreFileName) - The full file path of the project.

• % (ProjTitle) - The name of the project specified in the project properties.

• % (ReportTitle) - The name of the report.

• % (Image) - Opens up the Select Image file window.

You can also select fonts, text sizes, and customize spacing. 

Graphing
Use graphing to visualize some aspect of your model, such as element properties or 
results. You need to compute your model before you can create graphs. To compute 
your model, after you set up your elements and their properties, click the Compute 
button.

Graph Manager

The Graph Manager lets you recall a graph you have created and saved in the current 
session or in a previous session of Bentley SewerGEMS V8i. Graphs listed in the 
Graph Manager retain any customizations you have applied.

To use the Graph Manager:

1. Compute your model and resolve any errors. (Press F9 or click Analysis > 
Compute.)

2. Open the Graph Manager, click View > Graphs.

3. Create your graph. (For more information, see “Creating a Graph” on page 10-
578.)

4. After you create a graph, it is available in the Graph Manager. You can select it by 
double-clicking it. Also, you can right-click a graph listed in Graph Manager to:

– Delete it

– Rename the graph’s label

– Open it, by selecting Properties
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Graphs are not saved in Graph Manager after you close Bentley SewerGEMS V8i.

Graph Manager

The Graph Manager contains a toolbar with the following buttons:

Creating a Graph

You can graph computed values, such as flow and velocity. To create a graph:

1. Compute your Bentley SewerGEMS V8i network.

2. If necessary, use Shift+click to select multiple elements.

3. Right-click an element and select Graph. The Graph dialog box opens (see 
“Graph Dialog Box” on page 10-579).

4. If needed, use the Scenarios drop-down list (for more information, see “Scenario 
Manager” on page 9-469) to select check boxes to include different or multiple 
scenarios in the graph. Click Refresh after you make any changes, so the graph 
displays your changes. 

5. If needed, use the Elements drop-down list to select check boxes to include 
different or multiple element properties in the graph. Click Refresh after you 
make any changes, so the graph displays your changes.

New Inserts a new graph of the currently selected 
elements in your model. If no elements are 
selected, you are prompted to select one or 
more elements to graph.

Delete Deletes the currently highlighted graph.

Rename Lets you rename the currently highlighted 
graph.

View Opens the Graph dialog box, allowing you 
to view the currently highlighted graph.

Help Displays online help for the Graph Manager.
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Note: Bentley SewerGEMS V8i assumes initial flow—flow at time 0—in 
all networks to be 0; thus, graphs of flow begin at 0 for time 0.

6. If needed, click Chart Settings to change the display of the graph. For more 
information, see “Graph Manager” on page 10-577.

Tip: If you want your graph to display over more time (for example, it 
displays a 24-hour time period and you want to display a 72-hour 
period), click View > Calculation Options and change Total 
Simulation Time in the Property Editor (for more information, 
see “Editing Attributes in the Property Editor” on page 15-821).

Printing a Graph

To print a graph, click the Print button to open the print dialog box or click the Print 
Preview button to see what your graph looks like before clicking Print.

Working with Graph Data: Viewing and Copying

Bentley SewerGEMS V8i lets you view the data that your graphs are based on. To 
view your data, create a graph, then, after the Graph dialog box opens, click the Data 
tab.

You can copy this data to the Windows clipboard for use in other applications, such as 
word-processing software. To copy this data:

1. Click in the top-most cell of the left-most column to select the entire table, click a 
column heading to select an entire column, or click a row heading to select an 
entire row.

2. Press Ctrl+C to copy the selected data to the clipboard.

3. As needed, press Ctrl+V to paste the data as tab-delimited text into other soft-
ware.

Tip: To print out the data for a graph, copy and paste it into another 
application, such as word-processing software or Notepad, and 
print the pasted content.

Graph Dialog Box

The Graph dialog box allows you to view graphs and modify graph settings as desired. 
After you create a graph, you view it in the Graph dialog box.

The following controls are available:
Bentley SewerGEMS V8i User’s Guide 10-579



Graphing
Graph Tab

Add to Graph Manager Lets you save the Graph to the graph 
manager. When you click this button, 
the graph options (i.e., attributes to 
graph for a specific scenario) and the 
graph settings (i.e., line color, font 
size) are saved with the graph. If you 
want to view a different set of data 
(for example, a different scenario), 
you must change the scenario in the 
Graph Series Options dialog box. 
Simply switching the active scenario 
will not change the graph. Graphs 
that you add to the Graph manager 
are saved when you save your model, 
so that you can use the graph after 
you close and reopen Bentley 
SewerGEMS V8i.

Graph Series Options Lets you control what your graph 
displays. For more information, see 
“Graph Series Options Dialog Box” 
on page 10-583.

Chart Settings Opens the Chart Options dialog box, 
allowing you to change graph 
display settings.

Print Prints the current view in the graph 
display pane.

Print Preview Opens the “Print Preview Window”, 
displaying the graph exactly as it will 
be printed.

Copy Copies the current view in the graph 
display pane to the Windows 
Clipboard.

Zoom Extents Zooms out so that the entire graph is 
displayed
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Zoom Window Zooms in on a section of the graph. 
When the tool is toggled on, you can 
zoom in on any area of the graph by 
clicking on the chart to the left of the 
area to be zoomed, holding the 
mouse button, then dragging the 
mouse to the right (or, the opposite 
extent of the area to be magnified) 
and releasing the mouse button when 
the area to be zoomed has been 
defined.
To zoom back out, click and hold the 
mouse button, drag the mouse in the 
opposite direction (right to left), and 
release the mouse button.
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Time (VCR) Controls Lets you evaluate plots over time.

• If you click Restart, the Time 
resets to zero and the vertical 
line that marks time resets to the 
left edge of the Graph display.

• If you click Pause, the vertical 
line that moves across the graph 
to mark time pauses, as does the 
Time field.

• If you click Play, a vertical line 
moves across the graph and the 
Time field increments.

The following controls are also 
available:

• Time—Displays the time loca-
tion of the vertical black bar in 
the graph display. This is a read-
only field, to set a specific time, 
use the slider button.

• Slider—Lets you set a specific 
time for the graph. A vertical line 
moves in the graph display and 
intersects your plots to show the 
value of the plot at a specific 
time. Use the slider to set a 
specific time value.

Graph Display Pane Displays the graph.

Data Tab
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The Data tab is shown below.

Graph Series Options Dialog Box

Click the Graph Series Options button in the Graph dialog box (“Graph Dialog Box” 
on page 10-579) to use the Graph Series Options dialog box to customize your graph.

Data Table The Data tab displays the data that 
comprise your graphs. If there is 
more than one item plotted, the data 
for each plot is provided.
You can copy and paste the data from 
this tab to the clipboard for use in 
other applications, such as Microsoft 
Excel. 
To select an entire column or row, 
click the column or row heading. To 
select the entire contents of the Data 
tab, click the heading cell in the top-
left corner of the tab. Use Ctrl+C and 
Ctrl+V to paste your data. The 
column and row headings are not 
copied.
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This dialog box lets you choose which scenarios, elements, and fields you want to plot 
(this affects both the Graph and Data tabs). Click to select the check boxes next to 
those items you want to plot and clear the check boxes for those items you do not want 
to plot. Click Close after you have made your selections and the graph is updated to 
display the items you chose.

Filter Dialog Box 

The Filter dialog box lets you specify your filtering criteria. Each filter criterion is 
made up of three items: 

• Attribute—The attribute to filter.

• Operator—The operator to use when comparing the filter value against the data 
in the specific column (operators include: =, >, >=, <, <=, < >).

• Value—The comparison value.

Any number of criteria can be added to a filter. Multiple filter criteria are implicitly 
joined with a logical AND statement. When multiple filter criteria are defined, only 
rows that meet all of the specified criteria will be displayed. A filter will remain active 
for the associated table until the filter is reset. 

The status pane at the bottom of the Table window always shows the number of rows 
displayed and the total number of rows available (e.g., 10 of 20 elements displayed). 
When a filter is active, this message will be highlighted. 

Observed Data Dialog Box

Use this feature to display user-supplied time variant data values alongside calculated 
results in the graph display dialog. Model competency can sometimes be determined 
by a quick side by side visual comparison of calculated results with those observed 
and collection in the field.  

• Get familiar with your data - If you obtained your observed data from an outside 
source, you should take the time to get acquainted with it. Be sure to identify units 
of time and measurement for the data. Be sure to identify what the data points 
represent in the model; this helps in naming your line or bar series as it will appear 
in the graph.

• Preparing your data - Typically, observed data can be organized as a collection 
of points in a table. In this case, the time series data can simply be copied to the 
clipboard directly from the source and pasted right into the observed data input 
table.  Ensure that your collection of data points is complete. That is, every value 
must have an associated time value. Oftentimes data points are stored in tab or 
comma delimited text files; these two import options are available as well. See the 
“Sample Observed Data Source” topic for an example of the observed data source 
file format.
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• Specifying the characteristics of your data - The following charecteristics must 
be defined:

– Time from Start - An offset of the start time for an EPS scenario.

– Y Dimension - Unit class for the observed data point(s).

– Numeric Formatter - Group of units that correspond to the selected value.

– Y Unit - A preview of the current displayed unit for the selected format.

Note: Go to Tools > Options > Units for a complete list of formats.

Caution: Observed data can only be saved if the graph is saved.

To create Observed Data

1. Click New .

2. Set hours, dimension, and formatter.

3. Add hours and Y information (or import a .txt or .csv file ).

4. Click Graph  to view the Observed data.

5. Click Close.

Sample Observed Data Source

Below is an example of an Observed Data source for import and graph comparison. 
The following table contains a flow meter data collection retreived in the field for a 
given pipe. We will bring this observed data into the model for a quick visual inspec-
tion against our model's calculated pipe flows.

Table 10-1: Observed Flow Meter Data (Time in Hours)

Time (hrs) Flow (gpm)

0.00 125

0.60 120

3.00 110
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With data tabulated as in the table above, we could simply copy and paste these rows 
directly into the table in the Observed Data dialog.  However if we had too many 
points to manage, natively exporting our data to a comma delimited text file may be a 
better import option.  Text file import is also a better option when our time values are 
not formatted in units of time such as hours, as in the table below.

Below is a sample of what a comma-delimited (*.csv) file would look like:

0:00,125

0:36,120

3:00,110

9:00,130

9.00 130

13.75 100

18.20 125

21.85 110

Table 10-2: Observed Flow Meter Data (24-Hr Clock)

Time (24-hr 
clock)

Flow (gpm)

00:00 125

00:36 120

03:00 110

09:00 130

13:45 100

18:12 125

21:51 110

Table 10-1: Observed Flow Meter Data (Time in Hours)

Time (hrs) Flow (gpm)
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13:45,100

18:12,125

21:51,110

Note: Database formats (such as MS Access) are preferable to simple 
spreadsheet data sources. The sample described above is 
intended only to illustrate the importance of using expected data 
formats.

To import the comma delimited data points:

1. Click the Import toolbar button from the Observed Data dialog.

2. Pick the source .csv file.

3. Choose the Time Format that applies, in this case, HH:mm:ss, and click OK. 

Chart Options Dialog Box
Use the Chart Options dialog box to format a graph. 

Note: Changes you make to graph settings are not retained for use 
with other graphs.

To open Chart Options dialog box:

1. Open your project and click Compute.

2. Select one or more elements, right-click, then select Graph.

3. Click the Chart Settings button.

Chart Options Dialog Box - Chart Tab

The Chart tab lets you define overall chart display parameters. This tab is subdivided 
into second-level sub-tabs:

• “Series Tab”

• “Panel Tab”

• “Axes Tab”

• “General Tab”

• “Titles Tab”
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• “Walls Tab”

• “Paging Tab”

• “Legend Tab”

• “3D Tab”

Series Tab

Use the Series tab to display the series that are associated with the current graph. To 
show a series, select the check box next to the series’ name. To hide a series, clear its 
check box. The Series tab contains the following controls:

Panel Tab

Use the Panel tab to set how your graph appears in the Graph dialog box. The Panel 
tab includes the following sub-tabs:

Borders Tab

Use the Borders tab to set up a border around your graph. The Borders tab contains the 
following controls:

Up/Down arrows Lets you select the printer you want to use.

Add Adds a new series to the current graph. The 
TeeChart Gallery opens, see “TeeChart Gallery 
Dialog Box”.

Delete Lets you remove the currently selected series.

Title Lets you rename the currently selected series.

Clone Creates a duplicate of the currently selected series.

Change Lets you edit the currently selected series. The 
TeeChart Gallery opens, see “TeeChart Gallery 
Dialog Box”.

Border Lets you set the border of the graph. The Border 
Editor opens, see “Border Editor Dialog Box”.

Bevel Outer Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the outside of the chart border.
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Background Tab

Use the Background tab to set a color or image background for your graph. The Back-
ground tab contains the following controls:

Gradient Tab

Color Lets you set the color for the bevel effect that you 
use; inner and outer bevels can use different color 
values.

Bevel Inner Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the inside of the chart border.

Size Lets you set a thickness for the bevel effect that 
you use; inner and outer bevels use the same size 
value.

Color Lets you set a color for the background of your 
graph. The Color Editor opens, see “Color Editor 
Dialog Box”.

Pattern Lets you set a pattern for the background of your 
graph. The Hatch Brush Editor opens, see “Hatch 
Brush Editor Dialog Box”.

Transparent Makes the background of the graph transparent.

Background Image Lets you set an existing image as the background 
of the graph. Click Browse, then select the image 
(including .bmp, .tif, .jpg, .png,. and .gif). After 
you have set a background image, you can remove 
the image from the graph by clicking Clear.
You can control the Style of the background 
image:

• Stretch—Resizes the background image to fill 
the entire background of the graph.

• Tile—Repeats the background image as 
many times as needed to fill the entire back-
ground of the graph.

• Center—Puts the background image in the 
horizontal and vertical center of the graph.

• Normal—Puts the background image in the 
top-left corner of the graph.
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Use the Gradient tab to create a gradient color background for your graph. The 
Gradient tab contains the following subtabs and controls:

Format Tab

Visible Determines whether a gradient displays or not. 
Select this check box to display a gradient you 
have set up, clear this check box to hide the 
gradient.

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient. 
Opens the Color Editor dialog box.

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient. 
Opens the Color Editor dialog box.

End Lets you select the final color for your gradient. 
Opens the Color Editor dialog box.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you set the location on the chart background 
of the gradient’s end color.
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Shadow Tab

Use the Shadow tab to create a shadow for your graph. The Shadow tab contains the 
following controls:

Axes Tab

Use the Axes tab set how your axes display. It includes the following controls and 
subtabs:

Sigma Focus Lets you use the options controls. Select this 
check box to use the controls in the Options tab.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.

Visible Lets you display a shadow for your graph. Select 
this check box to display the shadow, clear this 
check box to turn off the shadow effect.

Size Set the size of the shadow by increasing or 
decreasing the numbers for Horizontal and/or 
Vertical Size.

Color Lets you set a color for the shadow of your graph. 
You might set this to gray but can set it to any 
other color.

Pattern Lets you set a pattern for the shadow of your 
graph. The Hatch Brush Editor opens, see “Hatch 
Brush Editor Dialog Box”.

Transparency Lets you set transparency for your shadow, where 
100 is completely transparent and 0 is completely 
opaque.

Visible When checked, displays all of your graph’s axes; 
clear it to hide all of the graph’s axes.

Behind When checked, displays all of your graph’s axes 
behind the series display; clear it to display the 
axes in front of the series display.
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Caution: Do not delete the axes called Custom 0 and Custom 1, as 
these are reserved axes that are needed by Bentley 
SewerGEMS V8i.

Scales Tab

Use the Scales tab to define your axes scales. The Scales tab contains the following 
controls:

Axes Select the axis you want to edit. The Scales, 
Labels, Ticks, Title, Minor, and Position tabs and 
their controls pertain only to the selected axis.

Automatic Lets you automatically or manually set the 
minimum and maximum axis values. Select this 
check box if you want TeeChart to automatically 
set both minimum and maximum, or clear this 
check box if you want to manually set either or 
both.

Visible Displays the axis if selected, hides the axis if 
cleared.

Inverted Reverses the order in which the axis scale 
increments. If the minimum value is at the origin, 
then selecting Inverted puts the maximum value at 
the origin.

Change Lets you change the increment of the axis.

Increment Displays the increment value you set for the axis.

Logarithmic Lets you use a logarithmic scale for the axis.

Log Base If you select a logarithmic scale, set the base you 
want to use in the text box.

Minimum Tab

Auto Lets you automatically or manually set the 
minimum axis value.

Change Lets you enter a value for the axis minimum.
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Labels Tab

Use the Labels tab to define your axes text. The Labels tab contains the following 
subtabs and controls:

Offset Lets you adjust the axis scale to change the 
location of the minimum or maximum axis value 
with respect to the origin.

Maximum Tab

Auto Lets you automatically or manually set the 
maximum axis value.

Change Lets you enter a value for the axis maximum.

Offset Lets you adjust the axis scale to change the 
location of the minimum or maximum axis value 
with respect to the origin.

Style Tab

Visible Lets you show or hide the axis text.

Multi-line Lets you split labels or values into more than one 
line if the text contains a space. Select this check 
box to enable multi-line text.

Round first Controls whether axis labels are automatically 
rounded to the nearest magnitude.

Label on axis Controls whether Labels just at Axis Minimum 
and Maximum positions are shown. This applies 
only if the maximum value for the axis matches 
the label for extreme value on the chart.

Size Determines distance between the margin of the 
graph and the placement of the labels.

Angle Sets the angle of the axis labels. In addition to 
using the up and down arrows to set the angle in 
90° increments, you can type an angle you want to 
use.

Min. Separation % Sets the minimum distance between axis labels.
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Style Lets you set the label style.

• Auto—Lets TeeChart automatically set the 
label style.

• Value—Sets axis labeling based on minimum 
and maximum axis values.

• Text—Uses text for labels. Since Bentley 
SewerGEMS V8i uses numeric values, this is 
not implemented; don’t use it.

• None—Turns off axis labels.

• Mark—Uses SeriesMarks style for labels. 
Since Bentley SewerGEMS V8i uses numeric 
values, this is not implemented; don’t use it.

Format Tab

Exponential Displays the axis label using an exponent, if 
appropriate.

Values Format Lets you set the numbering format for the axis 
labels.

Default Alignment Lets you select and clear the default TeeChart 
alignment for the right or left axes only.

Text Tab

Font Lets you set the font properties for axis labels. 
This opens the Windows Font dialog box.

Color Lets you select the color for the axis label font. 
Double-click the colored square between Font and 
Fill to open the Color Editor dialog box (see 
“Color Editor Dialog Box”).

Fill Lets you set a pattern the axis label font. The 
Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.
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Ticks Tab

Use the Ticks tab to define the major ticks and their grid lines. The Ticks tab contains 
the following controls:

Shadow —Lets you set a shadow for the axis labels.

• Visible—Lets you display a shadow for the 
axis labels. Select this check box to display 
the axis label shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Axis Lets you set the properties of the selected axis. 
Opens the Border Editor dialog box.

Grid Lets you set the properties of the graph’s grid lines 
that intersect the selected axis. Opens the Border 
Editor dialog box.

Ticks Lets you set the properties of the tick marks that 
are next to the labels on the label-side of the 
selected axis. Opens the Border Editor dialog box.

Len Sets the length of the Ticks or Inner ticks.

Inner Lets you set the properties of the tick marks that 
are next to the labels on the graph-side of the 
selected axis. Opens the Border Editor dialog box.

Centered Lets you align between the grid labels the graph’s 
grid lines that intersect the selected axis.

At Labels Only Sets the axis ticks and axis grid to be drawn at 
labels only. Otherwise, they are drawn at all axis 
increment positions.
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Title Tab

Use the Title tab to set the axis titles. The Title tab contains the following subtabs and 
controls:

Style Tab

Title Lets you type a new axis title.

Angle Sets the angle of the axis title. In addition to using 
the up and down arrows to set the angle in 90° 
increments, you can type an angle you want to use.

Size Determines distance between the margin of the 
graph and the placement of the labels.

Visible Check box that lets you display or hide the axis 
title.

Text Tab

Font Lets you set the font properties for axis title. This 
opens the Windows Font dialog box.

Color Lets you select the color for the axis title font. 
Double-click the colored square between Font and 
Fill to open the Color Editor dialog box (see 
“Color Editor Dialog Box”).

Fill Lets you set a pattern the axis title font. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”
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Minor Tab

Use the Minor tab to define those graph ticks that are neither major ticks. The Minor 
tab contains the following controls and tabs:

Position Tab

Use the Position tab to set the axes position for your graph. The Position tab contains 
the following controls:

Shadow Lets you set a shadow for the axis title.

• Visible—Lets you display a shadow for the 
axis title. Select this check box to display the 
axis label shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Ticks Lets you set the properties of the minor tick 
marks. The Border Editor opens, see “Border 
Editor Dialog Box”.

Length Sets the length of the minor tick marks.

Grid Lets you set the properties of grid lines that align 
with the minor ticks. The Border Editor opens, see 
“Border Editor Dialog Box”.

Count Sets the number of minor tick marks.

Position % Sets the position of the axis on the graph in pixels 
or as a percentage of the graph’s dimensions.
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General Tab

Use the General tab to preview a graph before you print it and set up scrolling and 
zooming for a graph. It includes the following controls:

Zoom Tab

Start % Sets the start of the axis as percentage of width 
(horizontal axis) and height (vertical axis) of the 
graph. The original axis scale is fitted to new axis 
height/width.

End % Sets the end of the axis as percentage of width 
(horizontal axis) and height (vertical axis) of the 
graph. The original axis scale is fitted to new axis 
height/width.

Units Lets you select pixels or percentage as the unit for 
the axis position.

Z % Sets the Z dimension as a percentage of the 
graph’s dimensions. This is unused by Bentley 
SewerGEMS V8i.

Print Preview Lets you see the current view of the document as it 
will be printed and lets you define the print 
settings, such as selecting a printer to use. Opens 
the Print Preview dialog box.

Margins Lets you specify margins for your graph. There are 
four boxes, each corresponding with the top, 
bottom, left, and right margins, into which you 
enter a value that you want to use for a margin.

Units Lets you set pixels or percentage as the units for 
your margins. Percentage is a percentage of the 
original graph size.

Cursor Lets you specify what your cursor looks like. 
Select a cursor type from the drop-down list, then 
click Close to close the TeeChart editor, and the 
new cursor style displays when the cursor is over 
the graph.
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Use the Zoom tab to set up zooming on, magnifying, and reducing the display of a 
graph. The Zoom tab contains the following controls:

Scroll Tab

Use the Scroll tab to set up scrolling and panning across a graph. The Scroll tab 
contains the following controls:

Titles Tab

The Titles tab lets you define titles to use for your graph. It includes the following 
controls and tabs:

Allow Lets you magnify the graph by clicking and 
dragging with the mouse.

Animated Lets you set a stepped series of zooms.

Steps Lets you set the number of steps used for 
successive zooms if you selected the Animated 
check box.

Pen Lets you set the thickness of the border for the 
zoom window that surrounds the magnified area 
when you click and drag. The Border Editor 
opens, see “Border Editor Dialog Box”.

Pattern The Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.

Minimum pixels Lets you set the number of pixels that you have to 
click and drag before the zoom feature is 
activated.

Direction Lets you zoom in the vertical or horizontal planes 
only, as well as both planes.

Mouse Button Lets you set the mouse button that you use to click 
and drag when activating the zoom feature.

Allow Scroll Lets you scroll and pan over the graph. Select this 
check box to turn on scrolling, clear the check box 
to turn it off.

Mouse Button Lets you set the mouse button that you click to use 
the scroll feature.
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Style Tab

Use the Style tab to display and create a selected title. Type the text of the title in the 
text box on the Style tab. The Style tab contains the following controls:

Position Tab

Use the Position tab to set the placement of the selected title. The Position tab contains 
the following controls:

Format Tab

Use the Format tab to set and format a background shape behind the selected title. The 
Format tab contains the following controls:

Title Lets you set the location of the titles you want to 
use. The Titles sub tabs apply to the Title that is 
currently selected in the Title drop-down list. 

Visible Lets you display the selected title.

Adjust Frame Lets you wrap the frame behind the selected title 
to the size of the title text.
Each title can have a frame behind it (see “Format 
Tab”). By default, this frame is transparent. If you 
turn off transparency to see the frame, the frame 
can be sized to the width of the graph or set to 
snap to the width of the title text.
Select the Adjust Frame check box to set the 
width of the frame to the width of the title text; 
clear this check box to set the width of the frame 
to the width of the graph.

Alignment Lets you set the alignment of the selected title.

Custom Lets you set a custom position for the selected 
title. Select this check box to set a custom 
position.

Left/Top Lets you set the location of the selected title 
relative to the left and top of the graph. If you 
select the Custom check box, use these settings to 
position the selected title.
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Text Tab

Use the Text tab to format the text used in the selected title. The Text tab contains the 
following controls:

Color Lets you set a color for the fill of the shape you 
create behind the selected title. The Color Editor 
opens, see “Color Editor Dialog Box”.

Frame Lets you define the outline of the shape you create 
behind the selected title. The Border Editor opens, 
see “Border Editor Dialog Box”.

Pattern Lets you set a pattern for the fill of the shape you 
create behind the selected title. The Hatch Brush 
Editor opens, see “Hatch Brush Editor Dialog 
Box”.

Round Frame Lets you round the corners of the rectangular 
shape you create behind the selected title. Select 
this check box to round the corners of the shape.

Transparent Lets you set the fill of the shape you create behind 
the selected title as transparent. If the shape is 
completely transparent, you cannot see it, so clear 
this check box if you cannot see a shape that you 
expect to see.

Transparency Lets you set transparency for the shape, where 100 
is completely transparent and 0 is completely 
opaque.

Font Lets you set the font properties for the text. This 
opens the Windows Font dialog box.

Color Lets you select the color for the text. Double-click 
the colored square between Font and Fill to open 
the Color Editor dialog box (see “Color Editor 
Dialog Box”).

Fill Lets you set a pattern for the text. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.
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Gradient Tab

Note: To use the Gradient tab, clear the Transparent check box in the 
Chart > Titles > Format tab.

Use the Gradient tab to create a gradient color background for your axis title. The 
Gradient tab contains the following controls:

Shadow Lets you set a shadow for the text.

• Visible—Lets you display a shadow for the 
text. Select this check box to display the axis 
label shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Format Tab

Visible Sets whether a gradient displays or not. Select this 
check box to display a gradient you have set up, 
clear this check box to hide the gradient.

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient.
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Shadow Tab

Use the Shadow tab to create a shadow for the background for the selected title. The 
Shadow tab contains the following controls:

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient.

End Lets you select the final color for your gradient.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you use the options controls. Select this 
check box to use the controls in the Options tab.

Sigma Focus Lets you set the location on the chart background 
of the gradient’s end color.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.

Visible Lets you display a shadow. Select this check box 
to display the shadow, clear this check box to turn 
off the shadow effect.

Size Set the size of the shadow by increasing or 
decreasing the numbers for Horizontal and/or 
Vertical Size.

Color Lets you set a color for the shadow. You might set 
this to gray but can set it to any other color. The 
Color Editor opens, see “Color Editor Dialog 
Box”.
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Bevels Tab

Note: To use the Gradient tab, clear the Transparent check box in the 
Chart > Titles > Format tab.

Use the Bevels tab to create rounded effects for the background for the selected title. 
The Bevels tab contains the following controls:

Walls Tab

Use the Walls tab to set and format the edges of your graph. The Walls tab contains the 
following subtabs:

Left/Right/Back/Bottom Tabs

Use the Left, Right, Back, and Bottom tabs to select the walls that you want to edit. 
You might have to turn off the axes lines to see the effects (see “Axes Tab” on 
page 10-591) for the back wall and turn on 3D display to see the effects for the left, 
right, and bottom walls (see “3D Tab” on page 10-612).

The Left, Right, Back, and Bottom tabs contain the following controls:

Pattern Lets you set a pattern for the shadow. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Transparency Lets you set transparency for your shadow, where 
100 is completely transparent and 0 is completely 
opaque.

Bevel Outer Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the background for the selected 
title.

Color Lets you set the color for the bevel effect that you 
use; inner and outer bevels can use different color 
values.

Bevel Inner Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the inside of the background for 
the selected title.

Size Lets you set a thickness for the bevel effect that 
you use; inner and outer bevels use the same size 
value.
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Paging Tab

Use the Paging tab to display your graph over several pages. The Paging tab contains 
the following controls:

Color The Color Editor opens, see “Color Editor Dialog 
Box”.

Border The Border Editor opens, see “Border Editor 
Dialog Box”.

Pattern The Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.

Gradient Lets you set a color gradient for your walls. The 
Gradient Editor opens, see “Gradient Editor 
Dialog Box”.

Visible Lets you display the walls you set up.

Dark 3D Lets you automatically darken the depth 
dimension for visual effect. Select a Size 3D larger 
than 0 to enable this check box.

Size 3D Lets you increase the size of the wall in the 
direction perpendicular to it’s length (the graph 
resizes automatically as a result).

Transparent Lets you set transparency for your background, 
where 100 is completely transparent and 0 is 
completely opaque.

Points per Page Lets you scale the graph to fit on one or many 
pages. Set the number of points you want to 
display on a single page of the graph, up to a 
maximum of 100.

Scale Last Page Scales the end of the graph to fit the last page.

Current Page Legend Shows only the current page items when the chart 
is divided into multiple pages.

Show Page Number Lets you display the current page number on the 
graph.
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Legend Tab

Use the Legend tab to display and format a legend for your graph. The Legend tab 
includes the following controls:

Style Tab

Use the Style tab to set up and display a legend for your graph. The Style tab contains 
the following controls:

Position Tab

Use the Position tab to control the placement of the legend. The Position tab contains 
the following controls:

Arrows Lets you navigate through a multi-page graph. 
Click the single arrows to navigate one page at a 
time. Click the double arrows to navigate directly 
to the last or first pages of the graph.

Visible Lets you show or hide the legend for your graph.

Inverted Lets you draw legend items in the reverse 
direction. Legend strings are displayed starting at 
top for Left and Right Alignment and starting at 
left for Top and Bottom Legend orientations.

Check boxes Activates/deactivates check boxes associated with 
each series in the Legend. When these boxes are 
unchecked in the legend, the associated series are 
invisible. 

Font Series Color Sets text in the legend to the same color as the 
graph element to which it applies.

Legend Style Lets you select what appears in the legend.

Text Style Lets you select how the text in the legend is 
aligned and what data it contains.

Vert. Spacing Controls the space between rows in the legend.

Dividing Lines Lets you use and define lines that separate 
columns in the legend. The Border Editor opens, 
see “Border Editor Dialog Box”.
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Symbols Tab

Use the Symbols tab to add to the legend symbols that represent the series in the 
graph. The Symbols tab contains the following controls:

Position Lets you place the legend on the left, top, right, or 
bottom of the chart.

Resize Chart Lets you resize your graph to accommodate the 
legend. If you do not select this check box, the 
graph and legend might overlap.

Margin Lets you set the amount of space between the 
graph and the legend.

Position Offset % Determines the vertical size of the Legend. Lower 
values place the Legend higher up in the display

Custom Lets you use the Left and Top settings to control 
the placement of the legend. 

Left/Top Lets you enter a value for custom placement of the 
legend. 

Visible Lets you display the series symbol next to the text 
in the legend.

Width Lets you resize the symbol that displays in the 
legend. You must clear Squared to use this 
control.

Width Units Lets you set the units that are used to size the 
width of the symbol.

Default border Lets you use the default TeeChart format for the 
symbol. If you clear this check box, you can set a 
custom border using the Border button.

Border Lets you set a custom border for the symbols. You 
must clear Default Border to use this option. The 
Border Editor opens, see “Border Editor Dialog 
Box”.

Position Lets you put the symbol to the left or right of its 
text.
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Format Tab

Use the Format tab to set and format the box that contains the legend. The Format tab 
contains the following controls:

Text Tab

Continuous Lets you attach or detach legend symbols. If you 
select this check box, the color rectangles of the 
different items are attached to each other with no 
vertical spacing. If you clear this check box, the 
legend symbols are drawn as separate rectangles. 

Squared Lets you override the width of the symbol, so you 
can make the symbol square shaped.

Color Lets you set a color for the fill of the legend’s box. 
The Color Editor opens, see “Color Editor Dialog 
Box”.

Frame Lets you define the outline of the legend’s box. 
The Border Editor opens, see “Border Editor 
Dialog Box”.

Pattern Lets you set a pattern for the fill of the legend’s 
box. The Hatch Brush Editor opens, see “Hatch 
Brush Editor Dialog Box”.

Round Frame Lets you round the corners of the legend’s box. 
Select this check box to round the corners of the 
shape.

Transparent Lets you set the fill of the legend’s box as 
transparent. If the shape is completely transparent, 
you cannot see it, so clear this check box if you 
cannot see a shape that you expect to see.

Transparency Lets you set transparency for the legend’s box, 
where 100 is completely transparent and 0 is 
completely opaque.
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Use the Text tab to format the text used in the legend. The Text tab contains the 
following controls:

Gradient Tab

Use the Gradient tab to create a gradient color background for your legend. The 
Gradient tab contains the following controls:

Font Lets you set the font properties for the text. This 
opens the Windows Font dialog box.

Color Lets you select the color for the text. Double-click 
the colored square between Font and Fill to open 
the Color Editor dialog box (see “Color Editor 
Dialog Box”).

Fill Lets you set a pattern for the text. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Shadow Lets you set a shadow for the text.

• Visible—Lets you display a shadow for the 
text. Select this check box to display the axis 
label shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Format Tab

Visible Sets whether a gradient displays or not. Select this 
check box to display a gradient you have set up, 
clear this check box to hide the gradient.
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Shadow Tab

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient.

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient.

End Lets you select the final color for your gradient.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you use the options controls. Select this 
check box to use the controls in the Options tab.

Sigma Focus Lets you set the location on the chart background 
of the gradient’s end color.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.
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Use the Shadow tab to create a shadow for the legend. The Shadow tab contains the 
following controls:

Bevels Tab

Use the Bevels tab to create a rounded effects for the legend. The Bevels tab contains 
the following controls:

Visible Lets you display a shadow. Select this check box 
to display the shadow, clear this check box to turn 
off the shadow effect.

Size Set the size of the shadow by increasing or 
decreasing the numbers for Horizontal and/or 
Vertical Size.

Color Lets you set a color for the shadow. You might set 
this to gray but can set it to any other color. The 
Color Editor opens, see “Color Editor Dialog 
Box”.

Pattern Lets you set a pattern for the shadow. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Transparency Lets you set transparency for your shadow, where 
100 is completely transparent and 0 is completely 
opaque.

Bevel Outer Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the background for the selected 
title.

Color Lets you set the color for the bevel effect that you 
use; inner and outer bevels can use different color 
values.

Bevel Inner Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the inside of the background for 
the selected title.

Size Lets you set a thickness for the bevel effect that 
you use; inner and outer bevels use the same size 
value.
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3D Tab

Use the 3D tab to add a three-dimensional effect to your graph. The 3D tab contains 
the following controls:

3 Dimensions Lets you display the chart in three dimensions. 
Select this check box to turn on three-dimensional 
display.

3D % Lets you increase or decrease the three-
dimensional effect. Set a larger percentage for 
more three-dimensional effect, or a smaller 
percentage for less effect.

Orthogonal Lets you fix the graph in the two-dimensional 
work plane or, if you clear this check box, lets you 
use the Rotation and Elevation controls to rotate 
the graph freely.

Zoom Text Lets you magnify and reduce the size of the text in 
a graph when using the zoom tool. clear this check 
box if you want text, such as labels, to remain the 
same size when you use the zoom tool.

Quality Lets you select how the graph displays as you 
manipulate and zoom on it.

Clip Points Trims the view of a series to the walls of your 
graph’s boundaries, to enhance the three-
dimensional effect. Turn this on to trim the graph. 
You only see this effect when the graph is in 
certain rotated positions.

Zoom Lets you magnify and reduce the display of the 
graph in the Graph dialog box.

Rotation Lets you rotate the graph. You must clear 
Orthogonal to use this control.

Elevation Lets you rotate the graph. You must clear 
Orthogonal to use this control.

Horiz. Offset Lets you adjust the left-right position of the graph.

Vert. Offset Lets you adjust the up-down position of the graph.
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Chart Options Dialog Box - Series Tab

Use the Series tab to set up how the series in your graph display. Select the series you 
want to edit from the drop-down list at the top of the Series tab. 

The Series tab is organized into second-level sub-tabs:

• “Format Tab”

• “Point Tab”

• “General Tab”

• “Data Source Tab”

• “Marks Tab”

Format Tab

Use the Format tab to set up how the selected series appears. The Format tab contains 
the following controls:

Perspective Lets you rotate the graph. You must clear 
Orthogonal to use this control.

Border Lets you format the graph of the selected series. 
The Border Editor opens, see “Border Editor 
Dialog Box”.

Color Lets you set a color for the graph of the selected 
series. The Color Editor opens, see “Color Editor 
Dialog Box”.

Pattern Lets you set a pattern for the graph of the selected 
series. This might only be visible on a three-
dimensional graph (see “3D Tab”). The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Dark 3D Lets you automatically darken the depth 
dimension for visual effect.

Color Each Assigns a different color to each series indicator.

Clickable This is unused by Bentley SewerGEMS V8i.
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Point Tab

Use the Point tab to set up how the points that make up the selected series appear. The 
Point tab contains the following controls:

Color Each line Lets you enable or disable the coloring of 
connecting lines in a series. This is unused by 
Bentley SewerGEMS V8i.

Height 3D Lets you set a thickness for the three-dimensional 
effect in three-dimensional graphs.

Stack Lets you control how multiple series display in the 
Graph dialog box.

• None—Draws the series one behind the 
other. 

• Overlap—Arranges multiple series with the 
same origin using the same space on the 
graph such that they might overlap several 
times.

• Stack—Lets you arrange multiple series so 
that they are additive.

• Stack 100%—Lets you review the area under 
the graph curves.

Transparency Lets you set transparency for your series, where 
100 is completely transparent and 0 is completely 
opaque.

Stairs Lets you display a step effect between points on 
your graph.

Inverted Inverts the direction of the stairs effect

Outline Displays an outline around the selected series. The 
Border Editor opens.

Visible Lets you display the points used to create your 
graph.

3D Lets you display the points in three dimensions.

Dark 3D Lets you automatically darken the depth 
dimension for visual effect.
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General Tab

Use the General tab to modify basic formatting and relationships with axes for series 
in a graph. The General tab contains the following controls:

Inflate Margins Adjusts the margins of the points to display points 
that are close to the edge of the graph. If you clear 
this option, points near the edge of the graph 
might only partly display.

Pattern Lets you set a pattern for the points in your series. 
The Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”. You must clear Default to use 
this option.

Default Lets you select the default format for the points in 
your series. This overrides any pattern selection.

Color Each Assigns a different color to each series indicator.

Style Lets you select the shape used to represent the 
points in the selected series.

Width/Height Lets you set a size for the points in the selected 
series. 

Border Lets you set the outline of the shapes that 
represent the points in the selected series. The 
Border Editor opens, see “Border Editor Dialog 
Box”.

Transparency Lets you set transparency for the points in the 
selected series, where 100 is completely 
transparent and 0 is completely opaque.

Show in Legend Lets you show the series title in the legend. To use 
this feature, the legend style has to be Series or 
LastValues (see “Style Tab”).

Cursor Lets you specify what your cursor looks like. 
Select a cursor type from the drop-down list, then 
click Close to close the TeeChart editor, and the 
new cursor style displays when the cursor is over 
the graph.
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Data Source Tab

Use this tab to connect a TeeChart series to another chart, table, query, dataset, or 
Delphi database dataset.

This lets you set the number of random points to generate and overrides the points 
passed by Bentley SewerGEMS V8i to the chart control. The Data Source feature can 
be useful in letting you set its sources as functions and do calculations between the 
series created by Bentley SewerGEMS V8i.

• Random—xxxx not sure 

• Number of sample values—xxxx not sure 

• Default—xxxx not sure 

• Apply—xxxx not sure 

Depth Lets you set the depth of the three-dimensional 
effect (see “3D Tab”).

Auto Lets you automatically size the three-dimensional 
effect. clear and then select this check box to reset 
the depth of the three-dimensional effect.

Values Controls the format of the values displayed when 
marks are on and they contain actual numeric 
values

Percents Controls the format of the values displayed when 
marks are on and they contain actual numeric 
values.

Horizontal Axis Lets you define which axis belongs to a given 
series, since you can have multiple axes in a chart.

Vertical Axis Lets you define which axis belongs to a given 
series, since you can have multiple axes in a chart.

Date Time This is unused by Bentley SewerGEMS V8i.

Sort Sorts the points in the series using the labels list.
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Marks Tab

Use the Marks tab to display labels for points in the selected series. Series-point labels 
are called marks. The Marks tab contains the following tabs and controls:

Style Tab

Use the Style tab to set how the marks display. The Style tab contains the following 
controls:

Arrow Tab

Use the Arrow tab to display a leader line on the series graph to indicate where the 
mark applies. The Arrow tab contains the following controls:

Visible Lets you display marks.

Clipped Lets you display marks outside the graph border. 
clear this check box to let marks display outside 
the graph border, or select it to clip the marks to 
the graph border.

Multi-line Lets you display marks on more than one line. 
Select this check box to enable multi-line marks.

All Series Visible Lets you display marks for all series.

Style Lets you set the content of the marks.

Draw every Sets the interval of the marks that are displayed. 
Selecting 2 would display every second mark, and 
3 would display every third, etc.

Angle Lets you rotate the marks for the selected series.

Border Lets you set up the leader line. The Border Editor 
opens, see “Border Editor Dialog Box”.

Pointer Lets you set up the arrow head (if any) used by the 
leader line. The Pointer dialog box opens, see 
“Pointer Dialog Box”.

Arrow head Lets you select the kind of arrow head you want to 
add to the leader line.

Size Lets you set the size of the arrow head.
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Format Tab

Use the Format tab to set and format the boxes that contains the marks. The Format 
tab contains the following controls:

Text Tab

Use the Text tab to format the text used in the marks. The Text tab contains the 
following controls:

Length Lets you set the size of the leader line and arrow 
head, or just the leader line if there is no arrow 
head.

Distance Lets you set the distance between the leader line 
and the graph of the selected series.

Color Lets you set a color for the fill of the boxes. The 
Color Editor opens, see “Color Editor Dialog 
Box”.

Frame Lets you define the outline of the boxes. The 
Border Editor opens, see “Border Editor Dialog 
Box”.

Pattern Lets you set a pattern for the fill of the boxes. The 
Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.

Round Frame Lets you round the corners of the boxes. Select 
this check box to round the corners of the shape.

Transparent Lets you set the fill of the boxes as transparent. If 
the shape is completely transparent, you cannot 
see it, so clear this check box if you cannot see a 
shape that you expect to see.

Transparency Lets you set transparency for the boxes, where 100 
is completely transparent and 0 is completely 
opaque.

Font Lets you set the font properties for the text. This 
opens the Windows Font dialog box.
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Gradient Tab

Use the Gradient tab to create a gradient color background for your marks. The 
Gradient tab contains the following subtabs and controls:

Color Lets you select the color for the text. Double-click 
the colored square between Font and Fill to open 
the Color Editor dialog box (see “Color Editor 
Dialog Box”).

Fill Lets you set a pattern for the text. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Shadow Lets you set a shadow for the text.

• Visible—Lets you display a shadow for the 
text. Select this check box to display the axis 
label shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Format Tab

Visible Sets whether a gradient displays or not. Select this 
check box to display a gradient you have set up, 
clear this check box to hide the gradient.

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.
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Shadow Tab

Use the Shadow tab to create a shadow for the marks. The Shadow tab contains the 
following controls:

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient.

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient.

End Lets you select the final color for your gradient.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you use the options controls. Select this 
check box to use the controls in the Options tab.

Sigma Focus Lets you set the location on the chart background 
of the gradient’s end color.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.

Visible Lets you display a shadow. Select this check box 
to display the shadow, clear this check box to turn 
off the shadow effect.

Size Set the size of the shadow by increasing or 
decreasing the numbers for Horizontal and/or 
Vertical Size.
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Bevels Tab

Use the Bevels tab to create a rounded effects for your marks. The Bevels tab contains 
the following controls:

Chart Options Dialog Box - Tools Tab

Use the Tools tab to add special figures in order to highlight particular facts on a given 
chart. For more information, see “Chart Tools Gallery Dialog Box” on page 10-632. 
The Tools tab contains the following controls:

Color Lets you set a color for the shadow. You might set 
this to gray but can set it to any other color. The 
Color Editor opens, see “Color Editor Dialog 
Box”.

Pattern Lets you set a pattern for the shadow. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Transparency Lets you set transparency for your shadow, where 
100 is completely transparent and 0 is completely 
opaque.

Bevel Outer Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the background for the selected 
title.

Color Lets you set the color for the bevel effect that you 
use; inner and outer bevels can use different color 
values.

Bevel Inner Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the inside of the background for 
the selected title.

Size Lets you set a thickness for the bevel effect that 
you use; inner and outer bevels use the same size 
value.

Add Lets you add a tool from the Chart Tools Gallery. 
To be usable in the current graph, a tool needs to 
be added and set to Active.
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Note: Each tool has its own parameters, see “Chart Tools Gallery Dialog 
Box”.

Chart Options Dialog Box - Export Tab

Use the Export tab to save your graph for use in another application. The Export tab 
contains the following controls:

Picture Tab

Use the Picture tab to save your graph as a raster image or to copy the graph as an 
image to the clipboard. The Picture tab contains the following controls and subtabs:

Delete Deletes the selected tool from the list of those 
available in the current graph.

Active Activates a selected tool for the current graph. To 
be usable in the current graph, a tool needs to be 
added and set to Active.

Up/Down arrow These are unused by Bentley SewerGEMS V8i.

Copy Lets you copy the contents of the graph to the 
Windows clipboard, so you can paste it into 
another application. You must consider the type of 
data you have copied when choosing where to 
paste it. For example, if you copy a picture, you 
cannot paste it into a text editor, you must paste it 
into a photo editor or a word processor that 
accepts pictures. Similarly, if you copy data, you 
cannot paste it into an image editor, you must 
paste it into a text editor or word processor.

Save Lets you create a new file from the contents of the 
graph.

Format Lets you select the format of the picture you want 
to save. GIF, PNG, and JPEG are supported by the 
Worldwide Web, a metafile is a more easily 
scalable format. A Bitmap is a Microsoft BMP file 
that is widely supported on Windows operating 
systems, whereas TIFF pictures are supported on a 
variety of Microsoft and non-Microsoft operating 
systems.
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Note: Changing the size of a graph using these controls might cause 
some loss of quality in the image. Instead, try saving the graph 
as a metafile and resizing the metafile after you paste or insert it 
into its destination.

Native Tab

The Native tab contains the following controls:

Data Tab

The Data tab contains the following controls:

Options Tab

Colors Lets you use the default colors used by your graph 
or to convert the picture to use grayscale. This 
feature is used when you save the picture as a file, 
not by the copy option.

Size Tab

Width/Height Lets you change the width and height of the 
picture. These values are measured in pixels and 
are used by both the Save and Copy options

Keep aspect ratio Lets you keep the relationship between the height 
and width of the picture the same when you 
change the image size. If you clear this check box, 
you can distort the picture by setting height or 
width sizes that are not proportional to the original 
graph.

Include Series Data This is unused by Bentley SewerGEMS V8i. 

File Size Displays the size of an ASCII file containing the 
data from the current graph.

Series Lets you select the series from which you copy 
data.

Format Lets you select a file type to which you can save 
the data. This is not used by the Copy function.

Include Select the data you want to copy.
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Chart Options Dialog Box - Print Tab

Use the Print tab to preview and print your graph. The Print tab contains the following 
controls and subtabs:

Text separator Lets you specify how you want rows of data 
separated. This is supported by the Save function 
and only by the Copy function if you first saved 
using the text separator you have selected, before 
you copy.

Printer Lets you select the printer you want to use.

Setup Lets you configure the printer you want to use. For 
example, if the selected printer supports printing 
on both sides of a page, you might want to turn on 
this feature.

Print Prints the displayed graph to the selected printer.

Page Tab

Orientation Lets you set up the horizontal and vertical axes of 
the graph. Many graphs print better in Landscape 
orientation because of their width:height ratio.

Zoom Lets you magnify the graph as displayed in the 
print preview window. Use the scrollbars to 
inspect the graph if it doesn’t fit within the 
preview window after you zoom. Changing the 
zoom does not affect the size of the printed output.

Margins Lets you set up top, bottom, left, and right margins 
that are used when you print.

Margin Units Lets you set the units used by the Margins 
controls: percent or hundredths of an inch.

Format Tab

Print Background When checked, prints the background of the 
graph.
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Border Editor Dialog Box

The Border Editor dialog box lets you define border properties for your graph. The 
Border Editor dialog box contains the following controls:

Quality You do not need to change this setting. The box is 
cleared by default.

Proportional Lets you change the graph from proportional to 
non-proportional. When you change this setting, 
the preview pane is automatically updated to 
reflect the change. This box is checked by default.

Grayscale Prints the graph in grayscale, converting colors 
into shades of gray. 

Detail Resolution Lets you adjust the detail resolution of the 
printout. Move the slider to adjust the resolution.

Preview Pane Displays a small preview of the graph printout.

Visible Displays or hides the border. Select this check box 
to display the border.

Color Lets you select a color for the border. The Color 
Editor dialog box opens, see “Color Editor Dialog 
Box”.

Ending Lets you set the ending style of the border.

Dash Lets you select the dash style, if you have a 
selection other than Solid set for the border style.

Width Lets you set the width of the border.

Style Lets you set the style for the border. Solid is an 
uninterrupted line.

Transparency Lets you set transparency for your border, where 
100 is completely transparent and 0 is completely 
opaque.
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Gradient Editor Dialog Box

Use the Gradient Editor dialog box to set a blend of two or three colors as the fill. 
Click OK to apply the selection. The Gradient Editor contains the following controls 
and tabs:

Format Tab

Visible Sets whether a gradient displays or not. Select this 
check box to display a gradient you have set up, 
clear this check box to hide the gradient.

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient.

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient.

End Lets you select the final color for your gradient.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you use the options controls. Select this 
check box to use the controls in the Options tab.
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To access the Gradient Editor dialog box, click Chart Settings in the Graph dialog box, 
then click the Tools tab. Select the Axis tab and Color Band tool, then click the 
Gradient button.

Color Editor Dialog Box

Use the Color Editor dialog box to select a color. Click the basic color you want to use 
then click OK to apply the selection. The Color Editor dialog box contains the 
following controls:

To access the Color Editor dialog box, click a Color button in the Chart Options dialog 
box.

Color Dialog Box

Use the Color dialog box to select a basic color or to define a custom color. After you 
select the color you want to use, click OK to apply the selection.

Sigma Focus Lets you set the location on the chart background 
of the gradient’s end color.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.

Transparency Lets you set transparency for your color, where 
100 is completely transparent and 0 is completely 
opaque.

Custom Lets you define a custom color to use. The Color 
dialog box opens, see “Color Dialog Box”.

OK/Cancel Click OK to use the selection. Click Cancel to 
close the dialog box without making a selection.

Basic colors Lets you click a color to select it.

Custom colors Displays colors you have created and selected for 
use.

Color matrix Lets you use the mouse to select a color from a 
range of colors displayed.

Color|Solid Displays the currently defined custom color.
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To access the Color dialog box, click the Custom button in the Color Editor dialog 
box.

Hatch Brush Editor Dialog Box

Use the Hatch Brush Editor dialog box to set a fill. The Hatch Brush Editor dialog box 
contains the following controls and tabs:

• “Hatch Brush Editor Dialog Box - Solid Tab”

• “Hatch Brush Editor Dialog Box - Hatch Tab”

• “Hatch Brush Editor Dialog Box - Gradient Tab”

• “Hatch Brush Editor Dialog Box - Image Tab”

Hatch Brush Editor Dialog Box - Solid Tab

Use the Solid tab to set a solid color as the fill. The Solid tab contains the following 
controls:

Hue/Sat/Lum Lets you define a color by entering values for hue, 
saturation, and luminosity.

Red/Green/Blue Lets you define a color by entering values of red, 
green, and blue colors.

Add to Custom Colors Adds the current custom color to the Custom 
colors area.

Visible Displays or hides the pattern. Select this check 
box to display the selected pattern.

Transparency Lets you set transparency for your color, where 
100 is completely transparent and 0 is completely 
opaque.

Custom Lets you define a custom color to use. The Color 
dialog box opens, see “Color Dialog Box”.

OK/Cancel Click OK to use the selection. Click Cancel to 
close the dialog box without making a selection.
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Hatch Brush Editor Dialog Box - Hatch Tab

Use the Hatch tab to set a pattern as the fill. Click OK to apply the selection. The 
Hatch tab contains the following controls:

Hatch Brush Editor Dialog Box - Gradient Tab

Use the Gradient tab to set a blend of two or three colors as the fill. Click OK to apply 
the selection. The Gradient tab contains the following controls:

Hatch Style Select the pattern you want to use. These display 
using the currently selected background and 
foreground colors.

Background/
Foreground

Select the color you want to use for the 
background and foreground of the pattern. This 
opens the Color Editor, see “Color Editor Dialog 
Box”.

% Lets you set transparency for your color, where 
100 is completely transparent and 0 is completely 
opaque.

Format Tab

Visible Sets whether a gradient displays or not. Select this 
check box to display a gradient you have set up, 
clear this check box to hide the gradient.

Direction Sets the direction of the gradient. Vertical causes 
the gradient to display from top to bottom, 
Horizontal displays a gradient from right to left, 
and Backward/Forward diagonal display gradients 
from the left and right bottom corners to the 
opposite corner.

Angle Lets you customize the direction of the gradient 
beyond the Direction selections.

Colors Tab

Start Lets you set the starting color for your gradient.

Middle Lets you select a middle color for your gradient. 
The Color Editor opens. Select the No Middle 
Color check box if you want a two-color gradient.
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Hatch Brush Editor Dialog Box - Image Tab

Use the Image tab to select an existing graphic file or picture to use as the fill. Click 
OK to apply the selection. The Image tab contains the following controls:

End Lets you select the final color for your gradient.

Gamma Correction Lets you control the brightness with which the 
background displays to your screen; select or clear 
this check box to change the brightness of the 
background on-screen. This does not affect printed 
output.

Transparency Lets you set transparency for your gradient, where 
100 is completely transparent and 0 is completely 
opaque.

Options Tab

Sigma Lets you use the options controls. Select this 
check box to use the controls in the Options tab.

Sigma Focus Lets you set the location on the chart background 
of the gradient’s end color.

Sigma Scale Lets you control how much of the gradient’s end 
color is used by the gradient background.

Browse Lets you navigate to then select the graphic file 
you want to use. When selected, the graphic 
displays in the tab.

Style Lets you define how the graphic is used in the fill.

• Stretch—Resizes the image to fill the usable 
space.

• Tile—Repeats the image to fill the usable 
space.

• Center—Puts the image in the horizontal and 
vertical center.

• Normal—Puts the image in the top-left corner
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Pointer Dialog Box

Use the Pointer dialog box to set up a pointers for use with leader lines. The Pointer 
dialog box contains the following controls:

To access the Pointer dialog box, click Chart Settings in the Graph dialog box, then 
click Series > Marks > Arrow.

Visible Sets whether a pointer displays or not.

3D Lets you display the pointer in three dimensions.

Dark 3D Lets you automatically darken the depth 
dimension for visual effect.

Inflate Margins Adjusts the margins of the pointers to display 
pointers that are close to the edge of the graph. If 
you clear this option, pointers near the edge of the 
graph might only partly display.

Pattern Lets you set a pattern for the pointers. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”. You must clear Default to use this 
option.

Default Lets you select the default format for the pointers. 
This overrides any pattern selection.

Color Each Assigns a different color to each pointer.

Style Lets you select the shape used to represent the 
pointers.

Width/Height Lets you set a size for the pointers.

Border Lets you set the outline of the shapes that 
represent the pointers. The Border Editor opens, 
see “Border Editor Dialog Box”.

Transparency Lets you set transparency for the pointers, where 
100 is completely transparent and 0 is completely 
opaque.
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Change Series Title Dialog Box

Use the Change Series Title dialog box to change the title of a selected series. Type the 
new series title, then click OK to apply the new name or Cancel to close the dialog 
box without making a change.

To access the Change Series title dialog box, click Chart Settings in the Graph dialog 
box, then click the Series tab, then the Title button.

Chart Tools Gallery Dialog Box

Use the Chart Tools Gallery dialog box to add tools to your graph. For more informa-
tion, see “Chart Options Dialog Box - Tools Tab” on page 10-621.

Click one of the following links to learn more about the Chart Tools Gallery dialog 
box:

• “Chart Tools Gallery Dialog Box - Series Tab”

• “Chart Tools Gallery Dialog Box - Axis Tab”

• “Chart Tools Gallery Dialog Box - Other Tab”

Chart Tools Gallery Dialog Box - Series Tab

Use the Series tab to add tools related to the series in your chart. The Series tab 
contains the following tools:

Cursor

Displays a draggable cursor line on top of the series. After you have added the Cursor 
tool to your graph, you can modify the following settings:

Series Lets you select the series to which you want to 
apply the tool.

Style Lets you select a horizontal line, vertical line, or 
both as the format of the tool.

Snap Causes the cursor tool to adhere to the selected 
series.

Follow Mouse Causes the cursor tool to follow your movements 
of the mouse.
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Drag Marks

Lets you drag series marks. To use this tool, you must display the marks for a selected 
series, see “Marks Tab”. After you have added the Drag Marks tool to your graph, you 
can modify the following settings:

Drag Point

Lets you drag a series point. After you have added the Drag Point tool to your graph, 
you can modify the following settings:

Draw Line

Lets you draw a line on the graph by dragging. After you have added the Draw Line 
tool to your graph, you can modify the following settings:

Pen Lets you define the cursor tool. The Border Editor 
opens, see “Border Editor Dialog Box”.

Series Lets you select the series to which you want to 
apply the tool.

Reset Positions Moves any marks you have dragged back to their 
original position.

Series Lets you select the series to which you want to 
apply the tool.

Style Lets you constrain the movement of the series 
point to one axis or both (no constraint).

Mouse Button Lets you select the mouse button you click to drag.

Cursor Lets you select the appearance of the cursor when 
using the tool.

Series Lets you select the series to which you want to 
apply the tool.

Pen Lets you define the line. The Border Editor opens, 
see “Border Editor Dialog Box”.

Button Lets you select the mouse button you click to drag.
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Gantt Drag

Lets you move and resize Gantt bars by dragging. This is unused by Bentley Sewer-
GEMS V8i.

Image

Displays a picture using the selected series axes as boundaries. After you have added 
the Image tool to your graph, you can modify the following settings:

Enable Draw Enables the Draw Line tool. Select this check box 
to let you draw lines, clear it to prevent you from 
drawing lines.

Enable Select Lets you select and move lines that you have 
drawn. Select this check box, then click and drag 
the line you want to move. clear this check box if 
you want to prevent lines from being moved.

Remove All Removes all lines you have drawn.

Series Lets you select the series to which you want to 
apply the tool.

Browse Lets you navigate to and select the image you 
want to use. Browse is unavailable when there is a 
selected image. To select a new image, first clear 
the existing one.

Clear Lets you remove a selected image. Clear is 
unavailable when there is no selected image.

Mode Lets you set up the image you select.

• Normal—Puts the background image in the 
top-left corner of the graph.

• Stretch—Resizes the background image to fill 
the entire background of the graph. The image 
you select conforms to the series to which you 
apply it.

• Center—Puts the background image in the 
horizontal and vertical center of the graph.

• Tile—Repeats the background image as 
many times as needed to fill the entire back-
ground of the graph.
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Mark Tips

Displays data in tooltips when you move the cursor over the graph. After you have 
added the Mark Tips tool to your graph, you can modify the following settings:

Nearest Point

Lets you define and display an indicator when you are near a point in the selected 
series. After you have added the Nearest Point tool to your graph, you can modify the 
following settings:

Pie Slices

Outlines or expands slices of pie charts when you move the cursor or click them. This 
is unused by Bentley SewerGEMS V8i.

Series Lets you select the series to which you want to 
apply the tool

Style Lets you select what data the tooltips display.

Action Sets when the tooltips display. Select Click if you 
want the tooltips to display when you click, or 
select Move if you want the tooltips to display 
when you move the mouse.

Delay Lets you delay how quickly the tooltip displays.

Series Lets you select the series to which you want to 
apply the tool.

Fill Lets you set the fill for the nearest-point indicator. 
The Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.

Border Lets you set the outline of the nearest-point 
indicator. The Border Editor opens, see “Border 
Editor Dialog Box”.

Draw Line Creates a line from the tip of the cursor to the 
series point.

Style Sets the shape for the indicator

Size Sizes the indicator.
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Series Animation

Animates series points. After you have added the Series Animation tool to your graph, 
you can modify the following settings:xxxx seems broken.

Chart Tools Gallery Dialog Box - Axis Tab

Use the Axis tab to add tools related to the axes in your chart. The Axis tab contains 
the following tools:

Axis Arrows

Lets you add arrows to the axes. The arrows permit you to scroll along the axes. After 
you have added the Axis Arrows tool to your graph, you can modify the following 
settings:

Series Lets you select the series to which you want to 
apply the tool.

Steps Lets you select the steps used in the animation. Set 
this control towards 100 for smoother animation 
and away from 100 for quicker, but less smooth 
animation.

Start at min. value Lets you start the animation at the series’ 
minimum value. clear this check box to set your 
own start value.

Start value Sets the value at which the animation starts. To use 
this control, you must clear Start at min. value.

Execute! Starts the animation.

Axis Select the axis to which you want to add arrows.

Border Lets you set the outline of the arrows. The Border 
Editor opens, see “Border Editor Dialog Box”.

Fill Lets you set the fill for the arrows. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Length Lets you set the length of the arrows.

Inverted Scroll Lets you change the direction in which the arrows 
let you scroll.
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Color Band

Lets you apply a color band to your graph for a range of values you select from an 
axis. After you have added the Color Band tool to your graph, you can modify the 
following settings:

Scroll Changes the magnitude of the scroll. Set a smaller 
percentage to reduce the amount of scroll caused 
by one click of an axis arrow, or set a larger 
percentage to increase the amount of scroll caused 
by a click.

Position Lets you set an axis arrow at the start, end, or both 
positions of the axis.

Axis Select the axis that you want to use to define the 
range for the color band.

Border Lets you set the outline of the color band. The 
Border Editor opens, see “Border Editor Dialog 
Box”.

Pattern Lets you set the fill of the color band. The Hatch 
Brush Editor opens, see “Hatch Brush Editor 
Dialog Box”.

Gradient Lets you set a gradient for the color band. A 
gradient overrides any solid color fill you might 
have set. The Gradient Editor opens, see “Gradient 
Editor Dialog Box”.

Color Lets you set a solid color for the color band. The 
Color Editor opens, see “Color Editor Dialog 
Box”.

Start Value Sets where the color band begins. Specify a value 
on the selected axis.

End Value Sets where the color band ends. Specify a vale on 
the selected axis.

Transparency Lets you set transparency for your color, where 
100 is completely transparent and 0 is completely 
opaque.
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Color Line

Lets you apply a color line, or plane in three dimensions, at a point you set at a value 
on an axis. After you have added the Color Line tool to your graph, you can modify 
the following settings:

Draw Behind Lets you position the color band behind the 
graphs. If you clear this check box, the color band 
appears in front of your graphs and hides them, 
unless you have transparency set.

Axis Select the axis that you want to use to define the 
location for the line.

Border Lets you set the outline of the color line. The 
Border Editor opens, see “Border Editor Dialog 
Box”.

Value Sets where the color line is. Specify a value on the 
selected axis.

Allow Drag Lets you drag the line or lock the line in place. 
Select this check box if you want to permit 
dragging. clear this check box if you want the line 
to be fixed in one location.

Drag Repaint Lets you smooth the appearance of the line as you 
drag it.

No Limit Drag Lets you drag the line beyond the axes of the 
graph, or constrain the line to boundaries defined 
by those axes. Select this check box to permit 
unconstrained dragging.

Draw Behind Lets you position the color line behind the graphs. 
If you clear this check box, the color band appears 
in front of your graphs. This is more noticeable in 
3D graphs.

Draw 3D Lets you display the line as a 2D image in a 3D 
chart. If you have a 3D chart (see “3D Tab”), clear 
this check box to display the line as a line rather 
than a plane.
10-638 Bentley SewerGEMS V8i User’s Guide



Presenting Your Results
Chart Tools Gallery Dialog Box - Other Tab

Use the Other tab to add tools to your chart, including annotations. The Other tab 
contains the following tools:

3D Grid Transpose

Swaps the X and Z coordinates to rotate the series through 90 degrees. This is unused 
by Bentley SewerGEMS V8i. 

Annotation

Lets you add text to the chart. After you have added the Annotation tool to your graph, 
you can modify the following settings:

Options Tab

Text Lets you enter the text you want for your 
annotation.

Text alignment Sets the alignment of the text inside the annotation 
box.

Cursor Lets you set the style of the cursor when you move 
it over the annotation.

Position Tab

Auto Lets you select a standard annotation position.

Custom Lets you select a custom position for the 
annotation. Select this check box to override the 
Auto setting and enable the Left and Top controls.

Left/Top Lets you set a position from the Left and Top 
edges of the graph tab for the annotation.

Callout Tab

Border Lets you set up the leader line. The Border Editor 
opens, see “Border Editor Dialog Box”.

Pointer Lets you set up the arrow head (if any) used by the 
leader line. The Pointer dialog box opens, see 
“Pointer Dialog Box”.

Position Sets the position of the callout.
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Distance Lets you set the distance between the leader line 
and the graph of the selected series.

Arrow head Lets you select the kind of arrow head you want to 
add to the leader line.

Size Lets you set the size of the arrow head.

Format Tab

Color Lets you set a color for the fill of the boxes. The 
Color Editor opens, see “Color Editor Dialog 
Box”.

Frame Lets you define the outline of the boxes. The 
Border Editor opens.

Pattern Lets you set a pattern for the fill of the boxes. The 
Hatch Brush Editor opens, see “Hatch Brush 
Editor Dialog Box”.

Round Frame Lets you round the corners of the boxes. Select 
this check box to round the corners of the shape.

Transparent Lets you set the fill of the boxes as transparent. If 
the shape is completely transparent, you cannot 
see it, so clear this check box if you cannot see a 
shape that you expect to see

Transparency Lets you set transparency for the boxes, where 100 
is completely transparent and 0 is completely 
opaque.

Text Tab

Font Lets you set the font properties for text. This 
opens the Windows Font dialog box.

Color Lets you select the color for the text font. Double-
click the colored square between Font and Fill to 
open the Color Editor dialog box.

Fill Lets you set a pattern for the text font. The Hatch 
Brush Editor opens.
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Shadow Lets you set a shadow for the text.

• Visible—Lets you display a shadow for the 
text. Select this check box to display the 
shadow.

• Size—Lets you set the location of the shadow. 
Use larger numbers to offset the shadow by a 
large amount.

• Color—Lets you set a color for the shadow. 
You might set this to gray but can set it to any 
other color. The Color Editor opens.

• Pattern—Lets you set a pattern for the 
shadow. The Hatch Brush Editor opens.

• Transparency—Lets you set transparency for 
your shadow, where 100 is completely trans-
parent and 0 is completely opaque.

Gradient Tab

Format Format—Lets you set up the gradient’s 
properties.

• Visible—Sets whether a gradient displays or 
not. Select this check box to display a gradient 
you have set up, clear this check box to hide 
the gradient.

• Direction—Sets the direction of the gradient. 
Vertical causes the gradient to display from 
top to bottom, Horizontal displays a gradient 
from right to left, and Backward/Forward diag-
onal display gradients from the left and right 
bottom corners to the opposite corner.

• Angle—Lets you customize the direction of 
the gradient beyond the Direction selections.
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Colors Lets you set the colors used for your gradients. 
The Start, Middle, and End selections open the 
Color Editor, see “Color Editor Dialog Box”.

• Start—Lets you set the starting color for your 
gradient. 

• Middle—Lets you select a middle color for 
your gradient. The Color Editor opens. Select 
the No Middle Color check box if you want a 
two-color gradient.

• End—Lets you select the final color for your 
gradient.

• Gamma Correction—Lets you control the 
brightness with which the background 
displays to your screen; select or clear this 
check box to change the brightness of the 
background on-screen. This does not affect 
printed output.

• Transparency—Lets you set transparency for 
your gradient, where 100 is completely trans-
parent and 0 is completely opaque.

Options Lets you control the affect of the start and end 
colors on the gradient, the middle color is not 
used.

• Sigma—Lets you use the options controls. 
Select this check box to use the controls in the 
Options tab.

• Sigma Focus—Lets you set the location on 
the chart background of the gradient’s end 
color.

• Sigma Scale—Lets you control how much of 
the gradient’s end color is used by the 
gradient background.

Shadow Tab

Visible Lets you display a shadow. Select this check box 
to display the shadow, clear this check box to turn 
off the shadow effect.

Size Set the size of the shadow by increasing or 
decreasing the numbers for Horizontal and/or 
Vertical Size.
10-642 Bentley SewerGEMS V8i User’s Guide



Presenting Your Results
Page Number

Lets you add a page number annotation. For more information, see “Annotation”.

Rotate

Lets you rotate the chart by dragging. After you have added the Rotate tool to your 
graph, you can modify the following settings:

Color Lets you set a color for the shadow. You might set 
this to gray but can set it to any other color. The 
Color Editor opens.

Pattern Lets you set a pattern for the shadow. The Hatch 
Brush Editor opens.

Transparency Lets you set transparency for your shadow, where 
100 is completely transparent and 0 is completely 
opaque.

Bevels Tab

Bevel Outer Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the outside of the legend.

Color Lets you set the color for the bevel effect that you 
use; inner and outer bevels can use different color 
values.

Bevel Inner Lets you set a raised or lowered bevel effect, or no 
bevel effect, for the inside of the legend.

Size Lets you set a thickness for the bevel effect that 
you use; inner and outer bevels use the same size 
value.

Inverted Reverses the direction of the rotation with respect 
to the direction you move the mouse.

Style Lets you rotate horizontally, vertically, or both. 
Rotation is horizontal rotation about a vertical 
axis, whereas elevation is vertical rotation about a 
horizontal axis.

Outline Lets you set the outline. The Border Editor opens, 
see “Border Editor Dialog Box”.
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TeeChart Gallery Dialog Box

Use the TeeChart Gallery dialog box to change the appearance of a series.

Series

The available series chart designs include:

• Standard 

• Stats 

• Financial 

• Extended 

• 3D 

• Other 

• View 3D—Lets you view the chart design in two or three dimensions. Select this 
check box to view the charts in 3D, clear it to view them in 2D.

• Smooth—Smooths the display of the charts. Select this check box to smooth the 
display, clear it to turn off smoothing.

Functions

The available function chart designs include:

• Standard 

• Financial 

• Stats 

• Extended 

• View 3D—Lets you view the chart design in two or three dimensions. Select this 
check box to view the charts in 3D, clear it to view them in 2D.

• Smooth—Smooths the display of the charts. Select this check box to smooth the 
display, clear it to turn off smoothing.
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Customizing a Graph

To customize a graph:

1. If you do not have your own model, open Sample-1.swg, one of the sample 
models that is included with Bentley SewerGEMS V8i.

2. Create a graph.

a. Click Compute.

b. Close the Calculation Executive Summary.

c. Save your model.

d. Right click an element, in Sample-1.swg, shift+click CO-11, CO-3, and CO-
7 to select them, then right-click one of them and select Graph.

e. Click Save in the Graph dialog box, to add the graph to the Graph manager.

3. Move the legend.

a. Click Chart Settings, to open the Chart Options dialog box.

b. Click the Chart button, Legend tab, and Position subtab.

c. Click the Right button in the Position area to set the legend to the right side of 
the graph. You can use other controls on this subtab to move the legend.
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4. Change the line colors and weights.

a. Click Chart Settings, to open the Chart Options dialog box.

b. In the Chart, Series tab click the series that you want to edit, to select and 
highlight it. You can select more than one series by Ctrl+ or Shift+clicking 
them.

c. Click Series and select the Format tab.
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d. Click the Color button and select a new color, to change the color of the line. 
The Color Editor dialog box opens (for more information, see “Color Editor 
Dialog Box” on page 10-627). 

e. Click OK after you click the color you want to use. The series that are 
changed are those that you highlighted in the Chart, Series tab.

f. Click Outline to change the thickness of a line. The Border Editor dialog box 
open (for more information, see “Border Editor Dialog Box” on page 10-625).

g. Select Visible.

h. Change the Width.

i. Make sure the Transparency is set to 0 if you want the line to appear opaque.

j. Click OK after you define the line width and attributes. The series that are 
changed are those that you highlighted in the Chart, Series tab.

5. Change the interval between labels, grid, and ticks.

a. Click Chart > Axes > Scales > Change to change the interval between labels 
on the axes. 

b. Select the Axis you want to change from the list of axes in the Axes area.
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c. In the Increment dialog box, type the new value and click OK. This also 
changes the distance between major and minor ticks.

d. If needed, change the axis you have selected for changes.

e. Click Chart > Axes > Minor and change the Count to change the interval 
between minor ticks on the axes.
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6. You can show and hide a grid associated with the major ticks.

a. Click Chart > Axes > Ticks and click Grid.

b. Select the axis on which you want to change the grid.

c. In the Border Editor dialog box, select or clear Visible to show or hide the 
grid. (For more information, see “Border Editor Dialog Box” on page 10-
625.)

7. You can show and hide a grid associated with the minor ticks.

a. Click Chart > Axes > Minor and click Grid.

b. Select the axis on which you want to change the grid.

c. In the Border Editor dialog box, select or clear Visible to show or hide the 
grid.

8. You can set the minimum and maximum range for an axis.

a. Click Chart > Axes > and select Scales.

b. Select the axis on which you want to change the grid.

c. Use the Minimum tab to change the minimum value for an axis. Clear the 
Auto check box.

d. Click Change.

e. Set the minimum value for the axis.

f. Use the Maximum tab to change the maximum value for an axis. Clear the 
Auto check box.

g. Click Change.

h. Set the maximum value for the axis.
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9. Change the background colors.

a. Click Chart > Panel > and select Background.

b. Use the Color and Pattern buttons to set a background color and/or pattern 
for the graph (see “Color Editor Dialog Box” on page 10-627 and “Hatch 
Brush Editor Dialog Box” on page 10-628).

10. Change the number of decimal places used in axis labels.

a. Click Chart > Axes > Labels and select Format.

b. Select the axis you want to change.

c. Change the number of decimal places by making a selection from the Values 
Format drop-down list.

11. Change the fonts used by the axes and titles.

a. Click Chart > Axes > Labels and select Text.

b. Select the axis you want to change.

c. Click Font to open the Font dialog box and change the format of the fonts 
used by the axis labels.

d. Click Chart > Axes > Title and select Text.
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e. Select the axis you want to change.

f. Click Font to open the Font dialog box and change the format of the fonts 
used by the axis title.

12. Add a text box to the graph.

a. Click Tools > Add > Other > Annotation.

b. In the Text pane, type the text you want in your annotation.

13. Plot rainfall and flow on the same graph for a catchment.

a. Open Sample-1.swg.

b. Click Compute.

c. Right-click CM-5 and select Graph.

d. In the Graph dialog box, click Graph Series Options.

e. In the Graph Series Options dialog box, select Precipitation (Cumulative) 
and Total Outflow, then click Close. The Graph dialog box displays two 
graphs, one for total outflow and the other for cumulative precipitation.

f. Click Chart Settings. The Graph Options dialog box opens.

g. Click the Precipitation (Cumulative) series to select it.
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h. Click Change.

i. Click the Bar graph type, to select it, then click OK.

j. Change the axis used by the bar graph.

k. Click Series, then select Precipitation (Cumulative) in the drop-down list.

l. Click the General subtab, then change Vertical Axis from Left to Custom 0.

m. To disable marks, click the Series > Marks > Style subtab, and clear the 
Visible check box.

n. If you want to invert the Y-axis for the Precipitation (Cumulative) series, click 
Chart > Axis, select the Custom 0 axis from the Axes list, and select the 
Inverted check box.

o. Close the Chart Options dialog box when you finish.
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Time Series Field Data

The Time Series Field Data dialog allows you to enter your observed field data and 
compare it to the calculated results from the model in graph format. The dialog is 
accessed by clicking the Components menu and selecting Time Series Field Data.
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Use this feature to display user-supplied time variant data values alongside calculated 
results in the graph display dialog. Model competency can sometimes be determined 
by a quick side by side visual comparison of calculated results with those observed 
and collection in the field

• Get familiar with your data - If you obtained your observed data from an outside 
source, you should take the time to get acquainted with it. Be sure to identify units 
of time and measurement for the data. Be sure to identify what the data points 
represent in the model; this helps in naming your line or bar series as it will appear 
in the graph.

• Preparing your data - Typically, observed data can be organized as a collection 
of points in a table. In this case, the time series data can simply be copied to the 
clipboard directly from the source and pasted right into the observed data input 
table. Ensure that your collection of data points is complete. That is, every value 
must have an associated time value. Oftentimes data points are stored in tab or 
comma delimited text files; these two import options are available as well. 

• Specifying the characteristics of your data - To add time series field data, select 
the element for which the data applies and click the New button. Select the associ-
ated attribute for the data and click OK. You can change the label of the data set 
by highlighting it and clicking the Rename button. This label will appear in the 
Graph Series Options dialog when you create a graph. The following information 
must also be defined:

– Start Date Time - Specify the date and time the field data was collected. This 
data will not affect the graph, but is valuable to you as a reference.
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– Element - Choose the element that represents the field data measurement 
location. Click the ellipsis button to select the element from the drawing.

– Time From Start - Specify an offset of the start time and date for an EPS 
scenario.

– Attribute Value - Enter the value for the specified attribute at the specified 
Time from Start.

You can perform a quick graphical check on the data import by clicking the Graph 
button at the top of the data table. 

If the number of observations is large, it is best to use the Copy/Paste commands. 
Copy the data from the original source to the clipboard, then go to the top of the Time 
from Start or Property (e.g. Flow) column and hit CTRL-V to paste the values into the 
appropriate column. 

Click the Close button when done. 

The data is saved with the model file. If you modify the source data file, the changes 
will not appear until time series data is imported again. 

To add the time series field data to a graph, first create the graph of the property from 
an EPS model run (e.g. right click on element and pick Graph). In the Graph options 
dialog, select Time Series Field Data and then the name of the time series (in the Field 
pane (right pane). The field data will appear in the graph as points (by default) while 
the model results will appear as a continuous line. This can be changed using the Chart 
Settings button at the top of the graph (third from left). 

Select Associated Modeling Attribute Dialog Box

This dialog appears when you create a new field data set in the Time Series Field Data 
dialog. Choose the attribute represented in the time series data source. The available 
attributes will vary depending on the element type chosen.
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Print Preview Window
The Print Preview window can be used to print documents from Bentley SewerGEMS 
V8i, such as reports and graphs. This window lets you see the current view of the 
document as it will be printed and lets you define the print settings, such as selecting a 
printer to use.

The following controls are available in the Print Preview window: 

Contents Displays a table of contents for the document, if 
one is created.

Print Opens the Print dialog box and lets you print the 
document as it appears in the preview pane. You 
can change printers in the Print dialog box, if you 
want.

Copy Copies the document to the Windows clipboard, 
so you can paste it into other applications.

Find Lets you search for words in the document. To 
find a word, click Find, in the Find dialog box, 
type the word you want to find, then click Find 
Next. Words that are found are highlighted in the 
print preview; click Find Next to continue 
searching the document.

Single/Multiple Page 
View

Displays the document as a single page or multiple 
pages in the preview pane.

Zoom In/Out Enlarges or reduces the display of the document in 
the print preview.

Note: Changing the zoom only affects 
how the document displays on-
screen, it does not affect how 
the document prints.

Zoom Combo Lets you select or type the amount of zoom used to 
display the document, where 100% is full size.

Previous Page Displays to the previous page in the document.

Next Page Displays the next page in the document.
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Contours
Using SewerGEMS V8i you can visually display calculated results for many attributes 
using contour plots.

The Contours dialog box is where all of the contour definitions associated with a 
project are stored. Choose View > Contours to open the Contours dialog box.

The dialog box contains a list pane that displays all of the contours currently contained 
within the project, along with a toolbar.

Page Displays the current page number and the total 
pages in the current chart. You can type the page 
number you want to display, and press Enter to 
display it.

Backward/Forward Displays the page that was previously displayed. 
Backward and Forward are based on your 
navigation in the document and not on the page 
order of the document. For example, if you 
navigated from page 2 directly to page 6, clicking 
Backward would display page 2 again; if you 
then clicked Forward, page 6 would display 
again.

New Opens the Contour Definition dialog box, 
allowing you to create a new contour.

Delete Deletes the currently selected contour.

Rename Renames the currently selected contour.

Edit Opens the Contour Definition dialog box, 
where you can modify the settings of the 
currently selected contour.
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Contour Definition

The Contour Definition dialog box contains the information required to generate 
contours for a calculated network.

Export Clicking this button opens a submenu 
containing the following commands:
• Export to Shapefile - Exports the 

contour to a shapefile, opening the 
Export to File Manager to select the 
shapefile.

• Export to DXF - Exports the contour as 
a .dxf drawing.

• Export to Native Format - Opens the 
Shapefile Properties dialog box, 
allowing you to add it to the Background 
Layers Manager.

View 
Contour 
Browser

Opens the Contour Browser dialog, 
allowing you to display detailed contour 
results for points in the drawing view.

Refresh Regenerates the contour.

Shift Up Moves the currently selected contour up in 
the list pane.

Shift 
Down

Moves the currently selected contour down 
in the list pane.

Help Displays online help for the Contours.

Contour

Field Select the attribute to apply the contour.
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Selection Set Apply an attribute to a previously defined 
selection set or to one of the following predefined 
options:
• All Elements - Calculates the contour based 

on all elements in the model, including spot 
elevations.

• All Elements Without Spots - Calculates the 
contour based on all elements in the model, 
except for spot elevations.

Minimum Lowest value to be included in the contour map. It 
may be desirable to use a minimum that is above 
the absolute minimum value in the system to avoid 
creating excessive lines near a pump or other high-
differential portions of the system.

Maximum Highest value for which contours will be 
generated.

Increment Step by which the contours increase. The contours 
created will be evenly divisible by the increment 
and are not directly related to the minimum and 
maximum values. For example, a contour set with 
10 minimum, 20 maximum, and an increment of 3 
would result in the following set: [ 12, 15, 18 ] not 
[ 10, 13, 16, 19 ].

Index Increment Value for which contours will be highlighted and 
labeled. The index increment should be an even 
multiple of the standard increment.

Smooth Contours The Contour Smoothing option displays the results 
of a contour map specification as smooth, curved 
contours. 

Line Weight The thickness of contour lines in the drawing view. 
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Contour Plot

The Contour Plot window displays the results of a contour map specification as accu-
rate, straight-line contours.

View the changes in the mapped attribute over time by using the animation feature. 
Choose Analysis > EPS Results Browser and click the Play button to automatically 
advance through the time step increments selected in the Increment bar.

The plot can be printed or exported as a .DXF file. Choose File > Export > DXF to 
export the plot.

Color by Range Contours are colored based on attribute ranges. 
Use the Initialize button to create five evenly 
spaced ranges and associated colors.

Initialize—This button, located to the right of the 
Contour section, will initialize the Minimum, 
Maximum, Increment, and Index Increment values 
based on the actual values observed for the 
elements in the selection set.

Tip: Initialization can be 
accomplished by clicking the 
Initialize button to automatically 
generate values for the 
minimum, maximum, 
increment, and index increment 
to create an evenly spaced 
contour set. 

Ramp—Automatically generate a gradient range 
between two colors that you specify. Pick the color 
for the first and last values in the list and the 
program will select colors for the other values. 

Color by Index The standard contours and index contours have 
separately controlled colors that you can make the 
contours more apparent.
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Tip: Although the straight-line contours generated by this program 
are accurate, smooth contours are often more desirable for 
presentation purposes. You can smooth the contours by clicking 
Options and selecting Smooth Contours.

Note: Contour line index labels can be manually repositioned in this 
view before sending the plot to the printer. The Contour Plot 
Status pane displays the Z coordinate at the mouse cursor.

Contour Browser Dialog Box

The Contour Browser dialog box displays the X and Y coordinates and the calculated 
value for the contour attribute at the location of the mouse cursor in the drawing view.

Enhanced Pressure Contours

Normal contouring routines only include model nodes, such as junctions, tanks and 
reservoirs. When spot elevations are added to the drawing, however, you can create 
more detailed elevation contours and enhanced pressure contours.

These enhanced contours include not only the model nodes but also the interpolated 
and calculated results for the spot elevations. Enhanced pressure contours can help the 
modeler to understand the behavior of the system even in areas that have not been 
included directly in the model.

Using Named Views
The Named View dialog box is where you can store the current views X and Y coordi-
nates. When you set a view in the drawing pane and add a named view, the current 
view is saved as the named view. You can then center the drawing pane on the named 
view with the Go To View command. 

Choose View > Named Views to open the Named View dialog box.
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The toolbar contains the following controls: 

Using Aerial View

The Aerial View is a small navigation window that provides a graphical overview of 
your entire drawing. You can toggle the Aerial View window on or off by selecting 
View > Aerial View to open the Aerial View window.

A Navigation Rectangle is displayed in the Aerial View window. This Navigation 
Rectangle provides a you-are-here indicator showing you current zoom location 
respective of the overall drawing. As you pan and zoom around the drawing, the Navi-
gation Rectangle will automatically update to reflect your current location. 

You can also use the Aerial View window to navigate around your drawing. To pan, 
click the Navigation Rectangle to drag it to a new location. To zoom, click anywhere 
in the window to specify the first corner of the Navigation Rectangle, and click again 
to specify the second corner. 

New Contains the following commands:

• Named View—Opens a Named View 
Properties box to create a new named 
view.

• Folder—Opens a Named Views Folder 
Properties box to enter a label for the 
new folder.

Delete Deletes the named view or folder that is 
currently selected.

Rename Rename the currently selected named view 
or folder.

Go to View Centers the drawing pane on the named 
view.

Shift Up and Shift 
Down

Moves the selected named view or folder up 
or down.

Expand All or 
Collapse All

Expands or collapses the named views and 
folders.

Help Displays online help for Named Views.
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In AutoCAD mode, see the AutoCAD online help for a detailed explanation.

In Stand-Alone mode, with Aerial View window enabled (by selecting the View > 
Aerial View), click and drag to draw a rectangular view box in the aerial view. The 
area inside this view box is displayed in the main drawing window. Alternately, any 
zooming or panning action performed directly in the main window updates the size 
and location of the view box in the Aerial View window.

The Aerial View window contains the following buttons: 

Zoom Extents—Display the entire drawing in the Aerial View window.

Zoom In—Decrease the area displayed in the Aerial View window.

Zoom Out—Increase the area displayed in the Aerial View window.

Help—Opens the online help.

To resize the view box directly from the Aerial View window, click to define the new 
rectangular view box. To change the location of the view box, hover the mouse cursor 
over the current view rectangle and click to drag the view box frame to a new location.
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Chapter

Working in ArcGIS
Mode
GIS Basics
Bentley SewerGEMS V8i provides three environments in which to work: Bentley 
SewerGEMS V8i Modeler Mode, AutoCAD Integrated Mode, and ArcMap Integrated 
Mode. Each mode provides access to differing functionality—certain capabilities that 
are available within Bentley SewerGEMS V8i Modeler mode may not be available 
when working in ArcMap Integrated mode, and vice-versa. In addition, you can use 
ArcCatalog to perform actions on any Bentley SewerGEMS V8i database. Some of 
the advantages of working in GIS mode include: 

• Full functionality from within the GIS itself, without the need for data import, 
export, or transformation

• The ability to view and edit multiple scenarios in the same geodatabase

• Minimizes data replication

• GIS custom querying capabilities

• Lets you build models from scratch using practically any existing data source

• Utilize the powerful reporting and presentation capabilities of GIS

A firm grasp of GIS basics will give you a clearer understanding of how Bentley 
SewerGEMS V8i interacts with GIS software. Click one the following links to learn 
more:

• “GIS Terms and Definitions”

• “ArcGIS Integration”

• “ArcGIS Applications”
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GIS Terms and Definitions

ArcObjects: ArcObjects is the framework upon which ArcGIS has 
been built. It is a collection of software components 
based on the COM protocol, which allows for the 
customization and extension of the core software 
functionality.

Coverage: A collection of data that has a common theme, and is 
considered a single unit. 

Feature Class: 1. A classification describing the format of 
geographic features and supporting data in a 
coverage. Coverage feature classes for representing 
geographic features include point, arc, node, route-
system, route, section, polygon and region. One or 
more coverage features are used to model geographic 
features; for example, arcs and nodes can be used to 
model linear features such as street centerlines. The 
tic, annotation, link, and boundary feature classes 
provide supporting data for coverage data 
management and viewing. 

2. The conceptual representation of a geographic 
feature. When referring to geographic features, 
feature classes include point, line, area, and surface.

Feature Dataset: A feature dataset is a collection of feature classes that 
share the same spatial reference. 

GEMS Datastore: The relational database that Bentley SewerGEMS 
V8i uses to store model data. Each Bentley 
SewerGEMS V8i project uses two main files for data 
storage, the datastore (.MDB) and the Bentley 
SewerGEMS V8i Modeler-specific data (.swg). 
Although the Bentley SewerGEMS V8i datastore is 
an .mdb file, cannot be a geodatabase.

Geocode: The process of identifying the coordinates of a 
location given its address. For example, an address 
can be matched against a TIGER street network to 
determine the location of a home. Also referred to as 
address geocoding. 

Geodatabase: Short for geographic database, a geodatabase stores 
spatial and descriptive data in an efficient manner. 
Geodatabases are the standard file format for ArcGIS 
v8 and later.
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Layer: Layers contain spatial data according to similar 
subject matter. Conceptually, layers in a database or 
map library environment are exactly like coverages. 
Layers are the standard GIS data format for ArcView 
3.x and earlier.

Metadata: Additional information (aside from tabular and 
spatial data) that makes the data useful. Includes 
characteristics and information that are required to 
use the data but are not contained within the data 
itself.

Relate: A temporary connection between table records using 
a common item shared by both tables. Each record in 
one table is connected to those records in the other 
table that share the same value for the common item. 

Relational Database: A database in which the data is structured in such a 
way as to associate tables according to attributes that 
are shared by the tables.

Relational Join: The process of merging two attribute tables using a 
common item.

Shapefile: A file format that stores spatial and attribute data for 
the spatial features within the dataset. A shapefile 
consists of a main file, an index file, and a dBASE 
table. Shapefiles were the standard file storage 
format for ArcView 3.x and earlier.

Spatial Reference: The spatial reference for a feature class describes its 
coordinate system (for example, geographic, UTM, 
and State Plane), its spatial domain, and its precision. 
The spatial domain is best described as the allowable 
coordinate range for X and Y coordinates, m- 
(measure) values, and z-values. The precision 
describes the number of system units per one unit of 
measure. A spatial reference with a precision of 1 
will store integer values, while a precision of 1000 
will store three decimal places. 

ArcGIS Integration

Bentley SewerGEMS V8i features full integration with ESRI’s ArcGIS software, 
including ArcView, ArcEdit, and ArcInfo. The following is a description of the func-
tionality available with each of these packages:

• ArcView—ArcView provides the following capabilities:

– Data Access
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– Mapping

– Customization

– Spatial Query

– Simple Feature Editing

ArcView can edit shapefiles and personal geodatabases that contain simple 
features such as points, lines, polygons, and static annotation. Rules and relation-
ships can not be edited with ArcView.

• ArcEdit—ArcEdit provides all of the capabilities available with ArcView in addi-
tion to the following:

– Coverage and geodatabase editing

ArcEdit can edit shapefiles, coverages, personal geodatabases, and multi-user 
geodatabases.

• ArcInfo—ArcInfo provides all of the capabilities available with ArcEdit in addi-
tion to the following:

– Advanced geoprocessing

– Data conversion

– ArcInfo Workstation

ArcInfo can edit shapefiles, coverages, personal geodatabases, and multi-user 
geodatabases.

ArcGIS Integration with Bentley SewerGEMS V8i

When you install Bentley SewerGEMS V8i after you install ArcGIS, integration 
between the two is automatically configured when you install Bentley SewerGEMS 
V8i.

If you install ArcGIS after you install Bentley SewerGEMS V8i, you must manually 
integrate the two by selecting Run > All Programs > Haestad Methods >Bentley 
SewerGEMS V8i > Integrate Bentley SewerGEMS V8i with AutoCAD-ArcGIS. The 
integration utility runs automatically. You can then run Bentley SewerGEMS V8i in 
ArcGIS mode.
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ArcGIS Applications

ArcView, ArcEdit, and ArcInfo share a common set of applications, each suited to a 
different aspect of GIS data management and map presentation. These applications 
include ArcCatalog and ArcMap.

• ArcCatalog—ArcCatalog is used to manage spatial data, database design, 
and to view and record metadata.

• ArcMap—ArcMap is used for mapping, editing, and map analysis. ArcMap 
can also be used to view, edit, and calculate your Bentley SewerGEMS V8i 
model.

Using ArcCatalog with a Bentley SewerGEMS V8i 
Database
You can use ArcCatalog to manage spatial data, database design, and to view and 
record metadata associated with your Bentley SewerGEMS V8i databases.

For more information, see the following topic:

• “ArcCatalog Geodatabase Components” on page 11-669

ArcCatalog Geodatabase Components

Many of the components that can make up a geodatabase can be directly correlated to 
familiar Bentley SewerGEMS V8i/Bentley SewerGEMS V8i conventions. The 
following diagram illustrates some of these comparisons.

The Bentley SewerGEMS V8i ArcMap Client
The Bentley SewerGEMS V8i ArcMap client refers to the environment in which 
Bentley SewerGEMS V8i is run. As the ArcMap client, Bentley SewerGEMS V8i 
runs within ESRI’s ArcMap interface, allowing the full functionality of both programs 
to be utilized simultaneously.

Getting Started with the ArcMap Client

An ArcMap Bentley SewerGEMS V8i project consists of:
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• A Bentley SewerGEMS V8i .mdb file—this file contains all modeling data, and 
includes everything needed to perform a calculation.

• A Bentley SewerGEMS V8i .swg file—this file contains data such as annotation 
and color-coding definitions.

• A geodatabase association—a project must be linked to a new or existing geoda-
tabase.

Note: You must be in an edit session (Click the ArcMap Editor button 
and select the Start Editing command) to access the various 
Bentley SewerGEMS V8i editors (dialogs accessed with an 
ellipsis (...) button) through the Property Editor, Alternatives 
Editor, or FlexTables, even if you simply wish to view input data 
and do not intend to make any changes.

There are a number of options for creating a model in the ArcMap client:

• Create a model from scratch—You can create a model in ArcMap. You’ll first 
need to create a new project and attach it to a new or existing geodatabase. See 
“Managing Projects In ArcMap” on page 11-676 and “Attach Geodatabase 
Dialog” on page 11-678 for further details. You can then lay out your network 
using the Bentley SewerGEMS V8i toolbar. See “Laying out a Model in the 
ArcMap Client” on page 11-678.

.
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• Open a previously created Bentley SewerGEMS V8i project—You can open a 
previously created Bentley SewerGEMS V8i model. If the model was created in 
the Stand Alone version, you must attach a new or existing geodatabase to the 
project. See “Managing Projects In ArcMap” on page 11-676 and “Attach Geoda-
tabase Dialog” on page 11-678 for further details.

• Import a model that was created in another modeling application—You can 
import a model that was created in SewerCAD or EPA SWMM. See “Importing 
Data From Other Models” on page 4-162 for further details.

Warning! You cannot use a Bentley SewerGEMS V8i .mdb file as a 
geodatabase. Make sure that you do not attempt to use the 
same file name for both the Bentley SewerGEMS V8i 
database (swg.mdb) and the geodatabase .mdb.

Bentley SewerGEMS V8i Toolbar

The SewerGEMS V8i toolbar offers the following functionality:

• Project—The Project menu contains the following commands:

– Add New Project—Creates a new Bentley SewerGEMS V8i project. When 
you select this command, a Save As dialog box appears, allowing you to 
define a name and directory location for the new project. 

– Add Existing Project—Opens an existing project. When you select this 
command, an Open dialog box appears, allowing you to browse to the project 
to be opened.

– ProjectWise—The ProjectWise submenu contains the following commands:

- Open—Allows you to open a Bentley SewerGEMS V8i project from a 
ProjectWise datasource. You must have a ProjectWise license to perform 
this operation.

- Save As—Allows you to save the current project to a ProjectWise data-
source. You must have a ProjectWise license to perform this operation.

- Change Datasource—Allows you to change the default ProjectWise 
datasource. You must have a ProjectWise license to perform this opera-
tion.

– Import—Opens a submenu containing the following commands:

- SWMM v4—Opens a Windows Browse dialog box, allowing you to 
choose the SWMM v4 file to import.
Bentley SewerGEMS V8i User’s Guide 11-671



The Bentley SewerGEMS V8i ArcMap Client
Note: Refer to the SWMM Readme.txt file for more information 
regarding the SWMM 4 to SWMM 5 Converter application

- SWMM v5—Opens a Windows Browse dialog box, allowing you to 
choose the SWMM v5 file to import.

- Bentley SewerGEMS V8i Database—Lets you import a Bentley Sewer-
GEMS V8i project database file.

- SewerCAD Exchange Database—Lets you import a SewerCAD export 
file (.mdb file).

– Export—Opens a submenu containing the following command:

- SWMM v5—Lets you export the current project to SWMM format.

– Project Properties—Opens the Project Properties dialog.

• Edit—The Edit menu contains the following commands:

– Select All—Selects all of the elements in the network.

– Select By Element—Opens a submenu listing all available element types. 
Select one of the element types from the submenu to select all elements of that 
type in the model.

– Clear Selection—Deselects the currently selected element(s).

– Find Element—Lets you find a specific element by entering the element’s 
label.

• Analysis—The Analysis menu contains the following commands:

– LoadBuilder—Opens the LoadBuilder Manager dialog.

– Storm Events—Opens the Storm Events dialog box, which lets you create, 
edit, and delete storm events. These storms are available for you to select for a 
catchment.

– Global Storm Events—Opens the Global Storm Event Settings dialog box, 
which lets you define project-wide global storm event data.

– Pipe Catalog—Opens the Catalog Pipe dialog box, which lets you create, 
edit, and view catalog pipes. Catalog pipes are an efficient way to reuse 
common physical pipe definitions.

– Pump Curve Definitions—Opens the Pump Curve Definitions dialog box, 
which lets you view, edit, and create pump curve definitions.

– SWMM Extensions—Opens a submenu containing the following SWMM-
specific commands:

- Evaporation—Opens the Evaporation dialog box, allowing you to view 
and edit evaporation data for use in SWMM calculations.

- Aquifers—Opens the Aquifers dialog box, allowing you to view and edit 
aquifer data for use in SWMM calculations.
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- Control Sets—Opens the Control Sets dialog box, allowing you to view, 
edit, and create control sets for use in SWMM calculations.

- Pollutants—Opens the Pollutants dialog box, allowing you to view and 
edit pollutant data for use in SWMM calculations.

- Land Uses—Opens the Land Use dialog box, allowing you to view and 
edit land use data for use in SWMM calculations.

– Unit Sanitary Loads—Opens the Unit Sanitary (Dry Weather) Loads dialog 
box, which lets you create, edit, and delete unit sanitary loads. 

– Patterns—Opens the Pattern Manager where you can create and edit diurnal 
loading patterns for use with extended period simulations. 

– Pattern Setups—Opens the Pattern Setup Manager where you can associate 
diurnal patterns with the appropriate unit sanitary loads for a given scenario.

– Validate—Runs a diagnostic check on the network data to alert you to 
possible problems that may be encountered during calculation. This is the 
manual validation command, and it checks for input data errors. It differs in 
this respect from the automatic validation that SewerGEMS V8i runs when 
the compute command is initiated, which only checks for network connec-
tivity errors.

– Compute Hydrology—Lets you perform the hydrologic calculations for the 
current scenario.

– Compute—Calculates the network. Before calculating, an automatic valida-
tion routine is triggered, which checks the model for network connectivity 
errors. Note that this automatic validation does not check for input data errors; 
to check for these types of errors, you must manually validate the model using 
the Validate command. 

– Always Compute Hydrology—Lets you turn hydrology calculations on and 
off whenever the model is calculated. Turning hydrology computation off 
improves performance and is recommended when the hydrology input will 
not change.

• View—The View menu contains the following commands:

– Project Manager—Opens the Project Manager dialog. (See “Managing 
Projects In ArcMap” on page 11-676)

– Scenarios—Opens the Scenario Manager, which lets you create, view, and 
manage project scenarios.

– Alternatives—Opens the Alternative Manager, which lets you create, view, 
and manage alternatives.

– Calculation Options—Opens the Calculation Options Manager, which lets 
you create, view, and manage calculation settings for the project.

– User Notifications—Opens the User Notifications Manager, allowing you to 
view warnings and errors uncovered by the validation process.
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– Selection Sets—Opens the Selection Sets Manager, which lets you create, 
view, and manage selection sets associated with the project.

– Network Navigator—Opens the Network Navigator manager, which lets you 
quickly navigate to and review any group of elements.

– Properties—Turns the Properties Editor display on or off.

– Flextables—Opens the FlexTables Manager, which lets you create, view, and 
manage the tabular reports for the project.

– Graphs—Opens the Graph Manager, which lets you create, view, and 
manage graphs for the project.

– Profiles—Opens the Profile Manager, which lets you create, view, and 
manage the profiles for the project.

– EPS Results Browser—Opens the Scenario Animation manager, which lets 
you manipulate the currently displayed time step and to animate the drawing 
pane.

– Auto-Refresh—Turns automatic updates to the main window view on or off 
whenever changes are made to the Bentley SewerGEMS V8i datastore. When 
selected, a check mark appears next to this menu command, indicating that 
automatic updates are turned on.

– Refresh Drawing—Updates the main window view according to the latest 
information contained in the Bentley SewerGEMS V8i datastore.

– Apply SewerGEMS V8i Renderer—Allows you to toggle the Bentley 
SewerGEMS V8i renderer on/off. When the renderer is On, Bentley Sewer-
GEMS V8i color coding settings are applied and inactive elements are 
displayed in the color specified in the Inactive Topology Color field of the 
Bentley SewerGEMS V8i Global Options tab (to access Options, click the 
Bentley SewerGEMS V8i menu and select the Tools...Options command.)

– Show Flow Arrows—Allows you to toggle on/off flow arrow visibility.

• Tools—The Tools menu contains the following commands:

– ModelBuilder—Opens the ModelBuilder Connections Manager. (See 
“ModelBuilder Connections Manager” on page 5-173)

– Thiessen Polygon—Opens the Thiessen Polygon Input dialog. (See “Gener-
ating Thiessen Polygons” on page 11-691)

– Engineering Libraries—Opens the Engineering Libraries Manager.

– Database Utilities—Opens a submenu containing the following commands:
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- Compact Database—When you delete data from a Bentley SewerGEMS 
V8i project, such as elements or alternatives, the database store that 
Bentley SewerGEMS V8i uses can become fragmented, causing data 
storage to be inefficient. This can cause unnecessarily large data files, 
which impact performance substantially. Compacting the database elimi-
nates the empty data records, thereby defragmenting the datastore and 
improving the performance of the file.

Note: Every tenth time a file is opened, Bentley SewerGEMS V8i will 
automatically prompt you to compact the database. Click Yes to 
compact the database, or no to close the prompt dialog box 
without compacting. Since compacting the database can take 
time, especially for larger models, you way want to postpone the 
compact procedure until a later time.

- Synchronize Drawing—Synchronizes the current model with the project 
database.

– Options—Opens the Options dialog box, which lets you change global 
settings such as display pane settings, units, display precision and format 
used, and element labeling.

• Report—The Report menu contains the following commands:

– Element Tables—Opens a submenu containing a command for each of the 
element types, each of which opens a tabular report containing all of the input 
data and results for every instance of the selected element in the model.

– Layer Symbology—Opens the Color Coding Properties dialog. Bentley 
SewerGEMS V8i color coding settings are only applied when the Bentley 
SewerGEMS V8i Renderer is toggled On (to turn on the Bentley Sewer-
GEMS V8i renderer, click the Bentley SewerGEMS V8i menu and select the 
View...Apply Bentley SewerGEMS V8i Renderer command).

– Scenario Summary—Opens the Scenario Summary Report.

– Calculation Executive Summary—Opens the calculation executive 
summary report, which reports a summary of the calculations performed 
on your model.

– Calculation Detailed Summary—Opens the calculation detailed summary 
report, which reports the details of the calculations performed on your 
model.

– Project Inventory—Opens the Project Inventory Report, which contains the 
number of each of the various element types that are in the network.

• Help—The Help menu contains the following commands:

– Bentley SewerGEMS V8i Help—Opens the online help Table of Contents.

– Reference Tables—Opens the online help to the Reference Tables help topic.
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– Introduction to SewerGEMS V8i—Starts the Introduction to Bentley Sewer-
GEMS V8i multimedia presentation.

– QuickStart Lessons—Opens the online help to the Quick Start Lessons 
Overview topic.

– Check for Updates—Opens your Web browser to our Web site, allowing you 
to check for Bentley SewerGEMS V8i updates.

– Training—Opens your browser to the Continuing Education page of our Web 
site.

– Services—Opens a submenu containing the following commands:

- Contents—Opens a locally stored htm page containing links for Haestad 
Methods products and services.

- Multimedia CD—Starts the Virtual Tour, a multimedia presentation that 
includes information about Haestad Methods products and services.

- Online Forums—Opens your browser to the online forum page of our 
Web site.

- Haestad.com—Opens your browser to the main page of our Web site.

- CivilQuiz.com—Opens your browser to our CivilQuiz Web site.

– About SewerGEMS V8i—Opens the About Bentley SewerGEMS V8i dialog 
box, which displays copyright information about the product, registration 
information, and the current version number of this release.

Managing Projects In ArcMap

The Bentley SewerGEMS V8i ArcMap client utilizes a Project Manager to allow you 
to disconnect and reconnect a model from the underlying geodatabase, to view and 
edit multiple projects, and to display multiple projects on the same map.

The Project Manager lists all of the projects that have been opened during the ArcMap 
session. The following controls are available:

• Add—Clicking the Add button opens a submenu containing the following 
commands:

– Add New Project—Opens a Save As dialog, allowing you to specify a 
project name and directory location. After clicking the Save button, the 
Attach Geodatabase dialog opens, allowing you to specify a new or existing 
geodatabase to be connected to the project.
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– Add Existing Project—Opens an Open dialog, allowing you to browse to the 
Bentley SewerGEMS V8i project to be added. If the Bentley SewerGEMS 
V8i project is not associated with a geodatabase, the Attach Geodatabase 
dialog opens, allowing you to specify a new or existing geodatabase to be 
connected to the project.

• Open Project—Opens the project that is currently highlighted in the Project 
Manager list pane. You can only edit projects that are currently open. This 
command is available only when the currently highlighted project is closed.

• Save Project—Saves the project that is currently highlighted in the Project 
Manager list pane. This command is available only when changes have been made 
to the currently highlighted project.

• Close Project—Closes the project that is currently highlighted in the Project 
Manager list pane. Closed projects cannot be edited, but the elements within the 
project will still be displayed in the map. This command is available only when 
the currently highlighted project is open.

• Remove Project—Removes the project that is currently highlighted in the Project 
Manager list pane. This command permanently breaks the connection to the 
geodatabase associated with the project. 

• Make Current—Makes the project that is currently highlighted in the Project 
Manager list pane the current project. Edits made in the map are applied to the 
current project. This command is available only when the currently highlighted 
project is not marked current.

• Help—Opens the online help.

To add a new project:

1. From the Project Manager, click the Add button and select the Add New Project 
command. Or, from the Bentley SewerGEMS V8i menu, click the Project menu 
and select the Add New Project command.

2. In the Save As dialog that appears, specify a name and directory location for the 
new project, then click the Save button.

3. In the Attach Geodatabase dialog that appears, click the Attach Geodatabase 
button. Browse to an existing geodatabase to import the new project into, or create 
a new geodatabase by entering a name for the geodatabase and specifying a direc-
tory. Click the Save button.

4. Enter a dataset name.

5. You can assign a spatial reference to the project by clicking the Change button, 
then specifying spatial reference data in the Spatial Reference Properties dialog 
that appears.

6. In the Attach Geodatabase dialog, click the OK button to create the new project.
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To add an existing project:

1. From the Project Manager, click the Add button and select the Add Existing 
Project command. Or, from the Bentley SewerGEMS V8i menu, click the Project 
menu and select the Add Existing Project command.

2. In the Open dialog that appears, browse to the location of the project, highlight it, 
then click the Open button.

3. If the project is not associated with a geodatabase, the Attach Geodatabase dialog 
opens, allowing you to specify a new or existing geodatabase to be connected to 
the project. Continue to Step 4. If the project has already been associated with a 
geodatabase, the Attach Geodatabase will not open, and the project will be added. 

4. In the Attach Geodatabase dialog, click the Attach Geodatabase button. Browse to 
an existing geodatabase to import the new project into, or create a new geodata-
base by entering a name for the geodatabase and specifying a directory. Click the 
Save button.

Attach Geodatabase Dialog

The Attach Geodatabase dialog allows you to associate a Bentley SewerGEMS V8i 
project with a new or existing geodatabase, and also provides access to the ArcMap 
Spatial Reference Properties dialog, allowing you to define the spatial reference for 
the geodatabase.

The following controls are available:

• Geodatabase Field—This field displays the path and file name of the geodata-
base that was selected to be associated with the project.

• Geodatabase Button—This button opens an Import To or Create New Geodata-
base dialog, where you specify an existing geodatabase or enter a name and direc-
tory for a new one.

• Dataset Name—Allows you to enter a name for the dataset.

• Spatial Reference Pane—Displays the spatial reference currently assigned to the 
geodatabase.

• Change Button—Opens the Spatial Reference Properties dialog, allowing you to 
change the spatial reference for the geodatabase.

Laying out a Model in the ArcMap Client

The Bentley SewerGEMS V8i toolbar contains a set of tools similar to the Stand-
Alone version. See “Layout Toolbar” on page 2-33 for descriptions of the various 
element layout tools. 
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You must be in an edit session (Click the ArcMap Editor button and select the Start 
Editing command) to lay out elements or to enter element data in ArcMap. You must 
then Save the Edits (Click the ArcMap Editor button and select the Save Edits 
command) when you are done editing. The tools in the toolbar will be inactive when 
you are not in an edit session.

Using LoadBuilder to Assign Loading Data
LoadBuilder simplifies and expedites the process of assigning loading data to 
your model, using a variety of source data types. LoadBuilder is available from 
within the ArcMap client interface only.

Note: The loading output data generated by LoadBuilder is a Base 
Flow, i.e., a single value that remains constant over time.

After running LoadBuilder and exporting the results, you may 
need to modify your data to reflect changes over time by 
applying patterns to the base flow values.

LoadBuilder includes:

• “LoadBuilder Manager” on page 11-680

• “LoadBuilder Wizard” on page 11-680
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LoadBuilder Manager

The LoadBuilder manager provides a central location for the creation, storage, and 
management of Load Build templates. The following buttons are available from this 
dialog box:

LoadBuilder Wizard

The LoadBuilder wizard assists you in the creation of a new load build template by 
stepping you through the procedure of creating a new load build template. Depending 
on the load build method you choose, the specific steps presented in the wizard will 
vary.

Note: The loading output data generated by LoadBuilder is a Base 
Flow, i.e., a single value that remains constant over time.

After running LoadBuilder and exporting the results, you may 
need to modify your data to reflect changes over time by 
applying patterns to the base flow values.

LoadBuilder wizard includes:

• “Step 1: Load Method to Use” on page 11-681

• “Step 2: Input Data” on page 11-683

New Opens the LoadBuilder Wizard.

Delete Deletes an existing LoadBuilder template.

Rename Rename an existing LoadBuilder template.

Edit Opens the LoadBuilder Wizard, with the 
settings associated with the currently 
highlighted definition loaded.

Help Opens the context-sensitive online help.
11-680 Bentley SewerGEMS V8i User’s Guide



Working in ArcGIS Mode
• “Step 3: Calculation Summary” on page 11-689

• “Step 4: Results Preview” on page 11-690

• “Step 5: Completing the LoadBuilder Wizard” on page 11-690

Step 1: Load Method to Use

In this step, the Load Method to be used is specified. The next steps will vary 
according to the load method that is chosen. The load methods are divided into three 
categories; the desired category is selected by clicking the corresponding button. Then 
the method is chosen from the Load Demand types pane.

The available load methods are as follows:

Allocation 

• Billing Meter Aggregation—This loading method assigns all meters within a 
service polygon to the specified loading node for that service polygon.

• Nearest Node—This loading method assigns customer meter loads to the closest 
loading junction.

• Nearest Pipe—This loading method assigns customer meter loads to the closest 
pipe, then distributes loads using user-defined criteria.
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• Flow Monitoring Distribution—This loading method asigns loading data from a 
point load monitoring layer to upstream loading nodes. This method automatically 
identifies all the upstream manholes up to its adjacent next upstream load monitor, 
works out the sub-total load contribution of the manhole between the load moni-
tors (the load difference between the monitors) and then equally distributes the 
effective load to all the contributing manholes.

Distribution

• Equal Flow Distribution—This loading method equally divides the total flow 
contained in a flow boundary polygon and assigns it to the nodes that fall within 
the flow boundary polygon.

• Proportional Distribution by Area—This load method proportionally distrib-
utes a lump-sum flow among a number of loading nodes based upon the ratio of 
total service area to the area of the node’s corresponding service polygon.

• Proportional Distribution by Population—This load method proportionally 
distributes a lump-sum load among a number of loading nodes based upon the 
ratio of total population contained within the node’s corresponding service 
polygon.
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Projection

• Projection by Land Use—This method allocates loads based upon the density 
per land use type of each service polygon.

• Load Estimation by Population—This method allocates loads based upon user-
defined relationships between load per capita and population data.

In addition to the controls described above, there is also a check box and a menu near 
the bottom of the dialog box, entitled Initialize From Previous Run. If a previously 
created LoadBuilder template exists in the LoadBuilder Manager display, the settings 
for this template can be applied to a new LoadBuild of the same type.

Step 2: Input Data

This step will vary according to the load method type that was specified in Step 1, as 
follows:

• Billing Meter Aggregation—Input Data—The following fields require data to be 
specified:

– Service Area Layer—This field allows you to specify the polygon feature 
class or shapefile that defines the service area for each demand node.

– Manhole ID Field—This field allows you to specify the source database field 
that contains identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Billing Meter Layer—This field allows you to specify the point feature class 
or shapefile that contains the geocoded billing meter data.
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– Load Type Field—This field allows you to specify the source database field 
that contains load type data. Load Type is an optional classification that can 
be used to assign composite loads to nodes, which enables different behaviors, 
multipliers, and patterns to be applied in various situations. For example, 
possible load types may include Residential, Commercial, Industrial, etc. To 
make use of the Load Type classification, your source database must include a 
column that contains this data.

– Usage Field—This field allows you to specify the source database field that 
contains usage data. The usage field in the source database must contain flow 
data.

– Usage Field Units—This drop-down list allows you to select the unit associ-
ated with the usage field value.

• Nearest Node—Input Data—The following fields require data to be specified:

– Node Layer—This field allows you to specify the feature class or shapefile 
that contains the nodes that the loads will be assigned to.

– Node ID Field—This field allows you to specify the feature class database 
field that contains the unique identifying label data.

Note: ElementID is the preferred node ID value because it is always 
unique to any given element.

– Billing Meter Layer—This field allows you to specify the feature class or 
shapefile that contains the geocoded billing meter data.

– Load Type Field—This field allows you to specify the source database field 
that contains load type data. Load Type is an optional classification that can 
be used to assign composite loads to nodes, which enables different behaviors, 
multipliers, and patterns to be applied in various situations. For example, 
possible load types may include Residential, Commercial, Industrial, etc. To 
make use of the Load Type classification, your source database must include a 
column that contains this data.

– Usage Field—This field allows you to specify the source database field that 
contains usage data.

– Usage Field Units—This drop-down list allows you to select the unit associ-
ated with the usage field value.

– Use Previous Run—LoadBuilder’s most time-consuming calculation when 
using the Nearest Node strategy is the spatial calculations that are performed 
to determine proximity between the meter elements and the node elements. 
When this box is checked, the proximity calculations that were generated 
from a previous run are used, thereby increasing the overall calculation 
performance.

• Nearest Pipe—Input Data—The following fields require data to be specified:
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– Pipe Layer—This field allows you to specify the line feature class or shape-
file that contains the pipes that will be used to determine meter-to-pipe prox-
imity. Note that the pipes in this layer must connect to the nodes contained in 
the Node Layer.

– Pipe ID Field—This field allows you to specify the source database field that 
contains the unique identifying label data.

Note: ElementID is the preferred Pipe ID value because it is always 
unique to any given element.

– Load Assignment—This field allows you to specify the method that will be 
used to distribute the metered loads that are assigned to the nearest pipe to the 
end nodes of said pipe. Options include:

- Distance Weighted—This method assigns a portion of the total load 
assigned to a pipe based on the distance between the meter(s) and the 
nodes at the pipe ends. The closer a meter is to the node at the end of the 
pipe, the more load will be assigned to it.

- Closest Node—This method assigns the entire total load assigned to the 
pipe end node that is closest to the meter.

- Farthest Node—This method assigns the entire total load assigned to the 
pipe end node that is farthest from the meter.

- Equal Distribution—This method assigns an equal portion of the total 
load assigned to a pipe to each of the pipe’s end nodes.

– Node Layer—This field allows you to specify the point feature class or 
shapefile that contains the nodes that will be used to determine node-to-pipe 
proximity. Note that the nodes in this layer must connect to the pipes 
contained in the Pipes Layer.

– Node ID Field—This field allows you to specify the source database field 
that contains the unique identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Use Previous Run—LoadBuilder’s most time-consuming calculation when 
using the Nearest Pipe strategy is the spatial calculations that are performed to 
determine proximity between the meter elements, the pipe elements, and the 
node elements. When this box is checked, the proximity calculations that 
were calculated from a previous runs are used, thereby increasing the overall 
calculation performance.

– Billing Meter Layer—This field allows you to specify the point or polyline 
feature class or shapefile that contains the geocoded billing meter data.
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– Meter Assignment Type—When a polyline meter layer is selected, this field 
will be activated. When multiple pipes are associated with (overlapped by) a 
polyline meter, the option chosen in this field determines the method that will 
be used to divide the polyline meter load among them. The available options 
are:

- Equal Distribution—This option will distribute the load equally among 
the pipes associated with (overlapping) the meter.

- Proportional Distribution—This option will divide the load proportion-
ally according to the ratio of the length of pipe that is associated with 
(overlapping) the meter to the total length of the meter.

– Billing Meter ID Field—Billing Meter ID is used to identify the unique 
meter. When polylines are used to represent water consumption meters, 
multiple polylines (multiple records) may designate one actual meter, but each 
(record in the attribute Table) of the polylines contains the same consumption 
data with the same billing meter ID.

– Load Type Field—This field allows you to specify the source database field 
that contains load type data. Load Type is an optional classification that can 
be used to assign composite loads to nodes, which enables different behaviors, 
multipliers, and patterns to be applied in various situations. For example, 
possible load types may include Residential, Commercial, Industrial, etc. To 
make use of the Load Type classification, your source database must include a 
column that contains this data.

– Usage Field—This field allows you to specify the source database field that 
contains usage data.

– Usage Field Units—This drop-down list allows you to select the unit associ-
ated with the usage field value.

• Flow Monitoring Distribution—Input Data—The following fields require data 
to be specified:

– Node Layer—This field allows you to specify the point feature class or 
shapefile that contains the nodes that the flow will be assigned to.

– Node ID Field—This field allows you to specify the source database field 
that contains identifying label data.

Note: ElementID is the preferred Node ID value because it is always 
unique to any given element.

– Flow Monitoring Layer—This field allows you to specify the point feature 
class that contains the flow monitoring meter data.

– Usage Field—This field allows you to specify the source database field that 
contains usage data. The usage field in the source database must contain flow 
data.
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– Usage Field Units—This drop-down list allows you to select the unit associ-
ated with the usage field value.

• Equal Flow Distribution—Input Data—The following fields require data to be 
specified:

– Manhole Layer—This field allows you to specify the point feature class or 
shapefile that contains the manhole data.

– Manhole ID Field—This field allows you to specify the source database field 
that contains identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Flow Boundary Layer—This field allows you to specify the polygon feature 
class or shapefile that contains the flow boundary data.

– Load Type Field—This field allows you to specify the source database field 
that contains the Load Type data.

– Load Type Field Units—This drop-down list allows you to select the unit 
associated with the flow field value.

• Proportional Distribution by Area—Input Data—The following fields require 
data to be specified:

– Service Area Layer—This field allows you to specify the polygon feature 
class or shapefile that defines the service area for each node.

– Manhole ID Field—This field allows you to specify the source database field 
that contains the unique identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Flow Boundary Layer—This field allows you to specify the polygon feature 
class or shapefile that contains the flow boundary data.

– Boundary Field—This field allows you to specify the source database field 
that contains the boundary label.

– Load Type Field—This field allows you to specify the source database field 
that contains the load type data.

– Load Type Field Units—This drop-down list allows you to select the unit 
associated with the Load Type Field value.

• Proportional Distribution by Population—Input Data—The following fields 
require data to be specified:

– Service Area Layer—This field allows you to specify the polygon feature 
class or shapefile that defines the service area for each node.
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– Manhole ID Field—This field allows you to specify the source database field 
that contains the unique identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Flow Boundary Layer—This field allows you to specify the polygon feature 
class or shapefile that contains the flow boundary data.

– Boundary Field—This field allows you to specify the source database field 
that contains the boundary label. 

– Load Type Field—This field allows you to specify the source database field 
that contains the load data.

– Load Type Field Units—This drop-down list allows you to select the unit 
associated with the load type field value.

– Population Layer—This field allows you to specify the polygon feature class 
or shapefile that contains population data.

– Population ID Field—This field allows you to specify the source database 
field that contains population data.

– Land Type Field—This field is optional. It allows you to specify the source 
database field that contains land use type.

• Demand Estimation by Land Use—Input Data—The following fields require 
data to be specified:

– Service Area Layer—This field allows you to specify the polygon feature 
class or shapefile that defines the service area for each node.

– Manhole ID Field—This field allows you to specify the source database field 
that contains the unique identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Land Use Layer—This field allows you to specify the polygon feature class 
or shapefile that contains the land use data.

– Land Type Field—This field is optional. It allows you to specify the source 
database field that contains land use type.

– Load Densities Per Area—This table allows you to assign load density 
values to the various load types contained within your land use layer.

• Demand Estimation by Population—Input Data—The following fields require 
data to be specified:

– Service Area Layer—This field allows you to specify the polygon feature 
class or shapefile that defines the service area for each node.
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– Manhole ID Field—This field allows you to specify the source database field 
that contains identifying label data.

Note: ElementID is the preferred Junction ID value because it is always 
unique to any given element.

– Population Layer—This field allows you to specify the polygon feature class 
or shapefile that contains the population data.

– Population Density Type Field—This field is optional. It allows you to 
specify the source database field that contains the population density type 
data.

– Population Density Field—This field allows you to specify the source data-
base field that contains population density data.

– Load Densities Per Capita—This table allows you to assign load density 
values to the various load types contained within your population density 
layer.

Step 3: Calculation Summary

This step displays the Results Summary pane, which displays the total load, load 
multiplier, and hydraulic pattern associated with each load type in a tabular format. 
The number of entries listed will depend on the load build method and data types 
selected in Step 1. The Results Summary pane contains the following columns:

• Load Type—This column contains an entry for each load type contained within 
the database column specified in step one. (Examples include residential, 
commercial, industrial, etc.)

• Consumption—This column displays the total load associated with each load 
type entry.

• Multiplier—This column displays the multiplier that is applied to each load type 
entry. Multipliers can be used to account for peak loads, expected future loads, or 
to reflect unaccounted-for-loads. This field is editable.

• Pattern—This column displays the hydraulic pattern associated with each 
demand type entry. A different pattern can be specified using the menu contained 
within each cell of this column. New patterns cannot be created from this dialog 
box; see the Pattern manager help topic for more information regarding the 
creation of new patterns.

In addition to the functionality provided by the tabular summary pane, the following 
controls are also available in this step:
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• Global Multiplier—This field allows you to apply a multiplier to all of the 
entries contained within the Results Summary Pane. Any changes are automati-
cally reflected in the Total Load text field. Multipliers can be used to account for 
peak loads, expected future loads, or to reflect unaccounted-for-loads. The Global 
Multiplier should be used when the conditions relating to these considerations are 
identical for all usage types and elements.

• Total Load—This field displays an updated total of all of the entries contained 
within the Results Summary Pane, as modified by the local and global multipliers 
that are in effect.

Step 4: Results Preview

This step displays the calculated results in a tabular format. The table consists of the 
following information:

• ElementID—ElementID is the unique identifying label assigned to all geodata-
base elements by the GIS.

• Label—Label is the unique identifying label assigned by Bentley SewerGEMS 
V8i Modeler.

• Load Type—Load Type is an optional classification that can be used to assign 
different behaviors, multipliers, and patterns in various situations. For example, 
possible load types may include Residential, Commercial, Industrial, etc. To make 
use of the Load Type classification, your source database must include a column 
that contains this data.

• Pattern—Allows you to assign a previously created pattern to each load type in 
the table.

Step 5: Completing the LoadBuilder Wizard

In this step, the load build template is given a label and the results are exported to an 
existing or new load alternative. This step contains the following controls:

• Label—This field allows a unique label to be assigned to the load build template.

• Override an Existing Alternative—Choosing this option will cause the calcu-
lated loads to overwrite the loads contained within the existing load alternative 
that is selected.

• Append to an Existing Alternative—Choosing this option will cause the calcu-
lated loads to be appended to the loads contained within the existing load alterna-
tive that is selected. Loads within the existing alternative that are assigned to a 
specific node will not be overwritten by newly generated loads assigned to the 
same node; the new loads will simply be added to them.
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• New Alternative—Choosing this option will cause the calculated loads to be 
applied to a new load alternative. The text field next to this button lets you enter a 
label for the new load alternative. The Parent Alternative field will only be active 
when this option is selected.

• Export to SewerCAD—When this option is chosen, a delimited text file 
containing flow data will be created that can then be imported in SewerCAD.

LoadBuilder Run Summary

The LoadBuilder Run Summary dialog box details important statistics about the 
results of a completed LoadBuilder run, including the number of successfully added 
loads, file information, and informational and/or warning messages.

Generating Thiessen Polygons
A Thiessen polygon is a Voronoi Diagram that is also referred to as the Dirichlet 
Tessellation. Given a set of points, it defines a region around each point. A Thiessen 
polygon divides a plane such that each point is enclosed within a polygon and assigns 
the area to a point in the point set. Any location within a particular Thiessen polygon 
is nearer to that polygon’s point than to any other point. Mathematically, a Thiessen is 
constructed by intersecting perpendicular bisector lines between all points. 

Thiessen polygon has many applications in different location-related disciplines such 
as business planning, community services, transportation and hydraulic/hydrological 
modeling. For water distribution modeling, the Thiessen Polygon generation utility 
was developed to quickly and easily define the service areas of demand nodes. Since 
each customer within a Thiessen polygon for a junction is nearer to that node than any 
others, it is assumed that the customers within a particular Thiessen polygon are 
supplied by the same demand node.

The following diagrams illustrate how Thiessen polygons would be generated manu-
ally. The Thiessen polygon generator does not use this method, although the results 
produced by the generator are consistent with those that would be obtained using this 
method.

The first diagram shows a simple pipe and junction network.
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In the second diagram, the circles are drawn around each junction.
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In the third diagram, bisector lines are added by drawing a line where the circles inter-
join.

In the final diagram, the network is overlaid with the polygons that are created by 
connecting the bisector lines.
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Thiessen Polygon Input Dialog Box

The Thiessen Polygon Creator allows you to quickly create polygon layers for use 
with the LoadBuilder demand allocation module. This utility creates polygon layers 
that can be used as service area layers for the following LoadBuilder loading strate-
gies:

• Billing Meter Aggregation

• Proportional Distribution By Area

• Proportional Distribution By Population

• Projection by Land Use

• Load Estimation by Population.
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The Thiessen Polygon Creator dialog box consists of the following steps:

Step 1: Node Data Source

• Node Data Source—Select the data source to use.

– Node Layer—This lists the valid point feature classes and shapefiles that 
Thiessen Polygon Creator can use. 

– Current Selection—Click if the current feature data set contains a previously 
created selection set. 

– Include active elements only—Click to activate.

– Selection—This option allows you to create a selection on the fly for use with 
the Thiessen Polygon Creator. To use this option, use the ArcMap Select 
Features tool to select the point features that you want before opening the 
Thiessen Polygon Creator.

Step 2: Boundary Layer

• Buffering Percentage—This percentage value is used for calculating the 
boundary for a collection of points. In order to make the buffer boundary big 
enough to cover all the points, the boundary is enlarged based upon the value 
entered in this field as it relates to the percentage of the area enclosed by drawing 
a polygon that connects the outermost nodes of the model. 

• Polygon Boundary Layer—Select the boundary polygon feature class or shape-
file, if one has already been created. A boundary is specified so that the outermost 
polygons do not extend to infinity. 
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Note: For more information about boundary layers, see “Creating 
Boundary Polygon Feature Classes”.

Step 3: Output Layer

• Output File—Specify the name of the shapefile that will be created.

Note: The Thiessen Polygon Creator is flexible enough to generate 
Thiessen polygons for unusual boundary shapes, such as 
borders with cutouts or holes that Thiessen polygons should not 
be created inside. To accomplish this, the boundary polygon 
must be created as one complex (multi-part) polygon. For more 
information about creating boundary polygon feature classes, 
see your ArcGIS documentation.

Creating Boundary Polygon Feature Classes

The Thiessen polygon generator requires a boundary to be specified around the area in 
which Thiessen Polygons will be created. This is to prevent the outside edge of the 
polygons along the perimeter of this area from extending to infinity. The generator can 
automatically create a boundary using the Buffering Point Area Percentage value, or 
it can use a previously created polygon feature class as the boundary.

A border polygon feature class can be created in ArcCatalog, and edited in ArcMap.

To create a border feature class, you will need a Bentley SewerGEMS V8i model that 
has had at least one scenario published as an ESRI feature dataset. Then, follow these 
steps:

1. In the directory structure pane of ArcCatalog, right-click the Bentley SewerGEMS 
V8i feature dataset and select New...Feature Class.

2. A dialog box will open, prompting you to name the new feature class. Enter a 
name and click Next.

3. In the second step, you are prompted to select the database storage configuration. 
Do so, and click Next.

4. In the third step, click the Shape cell under the Field Name column, and ensure 
that the Geometry Type is Polygon. Click Finish.

5. In ArcMap, click the Add Data button and select your Bentley Sewer-
GEMS V8i feature dataset.

6. Click the Editor button and select Start Editing. Ensure that the border 
feature class is selected in the Target drop-down list. 

7. Draw a polygon around the point features (generally manholes) that you wish to 
be used to generate the polygons. When you are finished drawing the polygon, 
click Editor...Stop Editing. Choose Yes when prompted to save your edits.
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The polygon feature class you just created can now be used as the boundary during 
Thiessen polygon generation. For more information about creating and editing feature 
classes, see your ArcGIS documentation.

ModelBuilder
For detailed information on how to use ModelBuilder, see “Using Modelbuilder” on 
page 5-171.

Using GeoTables
A GeoTable is a flexible table definition provided by Bentley SewerGEMS V8i. 
Bentley SewerGEMS V8i creates feature classes with a very simple schema.  The 
schema consists solely of the Geometry, the Bentley SewerGEMS V8i ID and Bentley 
SewerGEMS V8i feature type.  what Bentley SewerGEMS V8i provides is a dynamic 
join of this data to our trademarked GeoTable.  The join is then managed so that it will 
be automatically updated on a change to the GeoTable definition for each element 
type.

GeoTables allow for a dynamic view on the data.  The underlying data will represent 
the data for the current scenario, the current timestep and the unit definition of the 
GeoTable. By using these GeoTables, Bentley SewerGEMS V8i provides ultimate 
flexibility for using the viewing and rendering tools provided by the ArcMap environ-
ment.

Note that the GeoTable settings are not project specific, but are stored on your local 
machine - any changes you make will carry across all projects. This means that if you 
have ArcMap display settings based on attributes contained in customized GeoTables, 
you will have to copy the AttributeFlexTables.xml file (located in the C:\Documents 
and Settings\All Users\Application Data\Haestad\Bentley SewerGEMS V8i\1 folder) 
for these display settings to work on another computer.

Using GeoTables, you can:

• Apply ArcMap symbology definitions to map elements based on Bentley Sewer-
GEMS V8i data

• Use the ArcMap Select By Attributes command to select map elements based on 
Bentley SewerGEMS V8i data

• Generate ArcMap reports and graphs that include Bentley SewerGEMS V8i data
Bentley SewerGEMS V8i User’s Guide 11-697



Using GeoTables
To Edit a GeoTable:

1. In the FlexTable Manager list pane, expand the GeoTables node if necessary. 
Double-click the GeoTable for the desired element.

2. By default, only the ID, Label, and Notes data is included in the GeoTable. To add 
attributes, click the Edit button.

3. In the Table setup dialog that appears, move attributes from the Available 
Columns list to the Selected columns list to include them in the GeoTable. This 
can be accomplished by double-clicking an attribute in the list, or by highlighting 
attributes and using the arrow buttons (a single arrow button moves the high-
lighted attribute to the other list; a double arrow moves all of them).

4. When all of the desired attributes have been moved to the selected columns, click 
OK.
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Features of the
MicroStation Version
Bentley SewerGEMS V8i features support for MicroStation integration. You run 
Bentley SewerGEMS V8i in both MicroStation and stand-alone mode.

The MicroStation functionality has been implemented in a way that is the same as the 
Bentley SewerGEMS V8i base product. Once you become familiar with the stand-
alone mode, you will not have any difficulty using the product in MicroStation mode.

In MicroStation mode, you will have access to the full range of functionality available 
in the MicroStation design and drafting environment. The standard environment is 
extended and enhanced by using MicroStation’s MDL (MicroStation Development 
Language) client layer that lets you create, view, and edit the native Bentley Sewer-
GEMS V8i network model while in MicroStation.

MDL is a complete development environment that lets applications take full advan-
tage of the power of MicroStation and MicroStation-based vertical applications. MDL 
can be used to develop simple utilities, customized commands or sophisticated 
commercial applications for vertical markets.

Some of the advantages of working in MicroStation mode include:

• Lay out network links and structures in fully-scaled mode in the same design and 
drafting environment that you use to develop your engineering plans. 

• You will have access to any other third party applications that you currently use, 
along with any custom MDL applications. 

• Use native MicroStation insertion snaps to precisely position Bentley Sewer-
GEMS V8i elements with respect to other entities in the MicroStation drawing.

• Use native MicroStation commands on Bentley SewerGEMS V8i model entities 
with automatic update and synchronization with the model database. 

• Control destination levels for model elements and associated label text and anno-
tation, giving you control over styles, line types, and visibility of model elements.
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Note: Bentley SewerGEMS V8i supports MicroStation 2004 
Geographics Edition only.

Additional features of the MicroStation version includes:

• “MicroStation Environment” on page 12-700

• “MicroStation Project Files” on page 12-701

• “Bentley SewerGEMS V8i Element Properties” on page 12-701

• “Working with Elements” on page 12-703

• “MicroStation Commands” on page 12-705

• “Undo/Redo” on page 12-706

• “Special Considerations” on page 12-707

MicroStation Environment
The MicroStation environment includes:

• “MicroStation Mode Graphical Layout” on page 12-700

MicroStation Mode Graphical Layout

In MicroStation mode, our products provide a set of extended options and function-
ality beyond those available in stand-alone mode. This additional functionality 
provides enhanced control over general application settings and options and extends 
the command set, giving you control over the display of model elements within 
MicroStation.

Key differences between MicroStation and stand-alone mode include:

• Full element symbol editing functionality is available through the use of custom 
cells. All elements and graphical decorations (flow arrows, control indicators, 
etc.) are contained within a SewerGEMS V8i .cel file.

You can control the appearance and destination of all model elements using the 
Element Levels command under the View menu. For example, you can assign a 
specific level for all outlets, as well as assign the label and annotation text style to be 
applied.
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Note: Any MicroStation tool that deletes the target element (such as 
Trim and IntelliTrim) will also remove the connection of that 
element to SewerGEMS V8i. After the SewerGEMS V8i 
connection is removed, the element is no longer a valid CSD link 
and will not show properties on the property grid. Storm.

MicroStation Project Files
When using Bentley SewerGEMS V8i in MicroStation mode, there are three files that 
fundamentally define a Bentley SewerGEMS V8i model project:

• Drawing File (.DGN)—The MicroStation drawing file contains the elements that 
define the model, in addition to the planimetric base drawing information that 
serves as the model background.

• Model File (.CSD)—The model file contains model data specific to SewerGEMS 
V8i, including project option settings, color-coding and annotation settings, etc. 
Note that the MicroStation .dgn that is associated with a particular model may not 
bave the same filename as the model’s .csd file.

• Database File (.MDB)—The model database file that contains all of the input and 
output data for the model. Note that the MicroStation .dgn that is associated with a 
particular model may not bave the same filename as the model’s .mdb file.

To send the model to another user, all three files are required.

It is important to understand that archiving the drawing file is not sufficient to repro-
duce the model. You must also preserve the associated .CSD and .MDB files.

Bentley SewerGEMS V8i Element Properties
Bentley SewerGEMS V8i element properties includes:

• “Element Properties” on page 12-702

• “Levels” on page 12-702

• “Text Styles” on page 12-703
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Element Properties

When working in the MicroStation mode, this feature will display a dialog box 
containing fields for the currently selected element’s associated properties. To modify 
an attribute, click each associated grid cell.

You can also review or modify MicroStation drawing information about an 
element(s), such as its type, attributes, and geometry, by using the Element Informa-
tion dialog. To access the Element Information dialog, click the Element Information 
button or click the Element menu and select the Information command. 

Levels

To control display of elements in the selected levels, use the Level Display dialog box. 
To access the Level Display dialog, click the Settings menu and select the Level > 
Display command.

If you want to freeze elements in levels, select Global Freeze from the View Display 
menu in the Level Display dialog.

You can create new Levels in the Level Manager. To access the Level Manager, click 
the Settings menu and select the Level > Manager command.

To control the display of levels, use level filters. Within MicroStation, you can also 
create, edit, and save layer filters to DWG files in the Level Manager. To access the 
Level Manager, click the Settings menu and select the Level > Manager command. 
Layer filters are loaded when a DWG file is opened, and changes are written back 
when the file is saved. To create and edit Level Filters,

Element Levels Dialog

This dialog allows you to assign newly created elements and their associated annota-
tions to specific MicroStation levels.

To assign a level, use the pulldown menu next to an element type (under the Element 
Level column heading) to choose the desired level for that element. You can choose a 
seperate level for each element and for each element’s associated annotation.

You cannot create new levels from this dialog; to create new levels use the MicroSta-
tion Level Manager. To access the Level Manager, click the Settings menu and select 
the Level > Manager command.
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Text Styles

You can view, edit, and create Text Style settings in MicroStation mode by clicking 
the Element menu and selecting the Text Styles command to open the Text Styles 
dialog.

Working with Elements
Working with elements includes:

• “Edit Elements” on page 12-704

• “Deleting Elements” on page 12-704

• “Modifying Elements” on page 12-704

Edit Elements

Elements can be edited in one of two ways in MicroStation mode:

Element Properties Dialog: To access the Element Properties dialog, click the 
SewerGEMS V8i View menu and select the Properties command. 

FlexTables: To access the FlexTables dialog, click the SewerGEMS V8i View menu 
and select the FlexTables command.
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Deleting Elements

In MicroStation mode, you can delete elements by clicking on them using the Delete 
Element tool, or by highlighting the element to be deleted and clicking your 
keyboard’s Delete key.

Note: Any MicroStation tool that deletes the target element (such as 
Trim and IntelliTrim) will also remove the connection of that 
element to SewerGEMS V8i. After the SewerGEMS V8i 
connection is removed, the element is no longer a valid CSD link 
and will not show properties on the property grid. Storm. 

Modifying Elements

In MicroStation mode, these commands are selected from the shift-right-click shortcut 
menu (hold down the Shift key while right-clicking). They are used for scaling and 
rotating model entities.

Change Pipe Widths

In MicroStation mode, you can change the line width through the Element Informa-
tion dialog. To access the Element Information dialog, click the Element menu and 
select the Information command. To change the width of a pipe, select it and open the 
Element Information dialog. Then change the value in the Weight pulldown menu

Edit Elements

In MicroStation mode, this menu command is used to open a spreadsheet FlexTable 
editor or a selection of one or more network figures. You are prompted to select 
figures on which to build a table.

Working with Elements Using MicroStation Commands

Working with elements using MicroStation commands includes:

“Bentley SewerGEMS V8i Custom MicroStation Entities” on page 12-705

“MicroStation Commands” on page 12-705

“Moving Elements” on page 12-705

“Moving Element Labels” on page 12-705

“Snap Menu” on page 12-706
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Bentley SewerGEMS V8i Custom MicroStation Entities

The primary MicroStation-based Bentley SewerGEMS V8i element entities—pipes, 
channels, gutter links, manholes, catch basins, outfalls, pond outlet structures, and 
cross section nodes—are all implemented using native MicroStation elements. These 
elements have feature linkages to define them as SewerGEMS V8i objects.

This means that you can perform standard MicroStation commands (see “MicroSta-
tion Commands” on page 12-705) as you normally would, and the model database 
will be updated automatically to reflect these changes.

It also means that the model will enforce the integrity of the network topological state. 
Therefore, if you delete a nodal element such as a junction, its connecting pipes will 
also be deleted since their connecting nodes topologically define model pipes.

Using MDL technology ensures the database will be adjusted and maintained during 
Undo and Redo transactions.

MicroStation Commands

When running in MicroStation mode, Haestad Methods products make use of all the 
advantages that MicroStation has, such as plotting capabilities and snap features. 
Additionally, MicroStation commands can be used as you would with any design 
project. For example, our products’ elements and annotation can be manipulated using 
common MicroStation commands.

RELATED TOPICS

Moving Elements

When using MicroStation mode, the MicroStation commands Move, Scale, Rotate, 
Mirror, and Array can be used to move elements. 

To move a node, execute the MicroStation command by either typing it at the 
command prompt or selecting it. Follow the MicroStation prompts, and the node and 
its associated label will move together. The connecting pipes will shrink or stretch 
depending on the new location of the node.

RELATED TOPICS

Moving Element Labels

When using MicroStation mode, the MicroStation commands Move, Scale, Rotate, 
Mirror, and Array can be used to move element text labels. 
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To move an element text label separately from the element, click the element label you 
wish to move. The grips will appear for the label. Execute the MicroStation command 
either by typing it at the command prompt, by selecting it from the tool palette, or by 
selecting it from the right-click menu. Follow the MicroStation prompt, and the label 
will be moved without the element.

Snap Menu

When using MicroStation mode, you can enable the Snaps button bar by clicking the 
Settings menu and selecting the Snaps > Button Bar command. See the MicroStation 
documentation for more information about using snaps.

Polygon Element Visibility

By default, polygon elements are sent to the back of the level order when they are 
drawn. If the level order is modified, polygon elements can interfere with the visibility 
of other elements. This can be remedied using the MicroStation Level Manager (Click 
the Settings menua and select the Level > Manager command.).

To access the MicroStation Level Manager, click the Settings menu and select the 
Level > Manager command.

Undo/Redo
If you use the native MicroStation undo, you are limited to a single redo level. 

If you undo using the MicroStation undo/redo and you restore Bentley SewerGEMS 
V8i elements that have been previously deleted, some model state attributes such as 
diameters or elevations may be lost, even though the locational and topological state is 
fully consistent. This will only happen in situations where the Bentley SewerGEMS 
V8i command history has been deleted. In such cases, you will be warned to check 
your data carefully.

In MicroStation mode, you have two types of undo/redo available to you. From the 
Edit menu, you have access to Bentley SewerGEMS V8i undo and redo. Alternatively, 
you can perform the native MicroStation undo and redo by typing at the MicroStation 
command line. The implementations of the two different operation types are quite 
distinct.

The menu-based undo and redo commands operate exclusively on Bentley Sewer-
GEMS V8i elements by invoking the commands directly on the model server. The 
main advantage of using the specialized command is that you will have unlimited 
undo and redo levels. This is an important difference, since in layout or editing it is 
quite useful to be able to safely undo and redo an arbitrary number of transactions.
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Whenever you use a native MicroStation undo, the server model will be notified when 
any Bentley SewerGEMS V8i entities are affected by the operation. Bentley Sewer-
GEMS V8i will then synchronize the model to the drawing state. Wherever possible, 
the model will seek to map the undo/redo onto the model server’s managed command 
history. If the drawing’s state is not consistent with any pending undo or redo transac-
tions held by the server, Bentley SewerGEMS V8i will delete the command history. In 
this case, the model will synchronize the drawing and server models.

Special Considerations
Special considerations include:

• “Import Bentley SewerGEMS V8i” on page 12-707

• “Annotation Display” on page 12-707

• “Use SewerGEMS V8i Z Order Command” on page 12-707

Import Bentley SewerGEMS V8i

When running Bentley SewerGEMS V8i in MicroStation mode, this command 
imports a selected Bentley SewerGEMS V8i data (.CSD) file for use in the current 
drawing. The new project file will now correspond to the drawing name, such as, 
CurrentDrawingName.CSD. Whenever you save changes to the network model 
through Bentley SewerGEMS V8i, the associated .CSD data file is updated and can be 
loaded into Bentley SewerGEMS V8i 4.0 or higher.

Warning! A SewerGEMS V8i Project can only be imported to a new, 
empty MicroStation design model.

Annotation Display

Some fonts do not correctly display the full range of characters used by SewerGEMS 
V8i’s annotation feature because of a limited character set. If you are having problems 
with certain characters displaying improperly or not at all, try using another font.

Use SewerGEMS V8i Z Order Command

When this control is toggled on, SewerGEMS V8i will parse the elements when the 
screen is redrawn.  It takes significant time to do this parsing, so for larger models 
performance can be improved by toggling this control off
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Working in AutoCAD
Mode
Caution: If you previously installed Bentley ProjectWise and turned 
on AutoCAD integration, you must add the following key to 
your system registry using the Windows Registry Editor. 
Before you edit the registry, make a backup copy.

HKEY_LOCAL_MACHINE\SOFTWARE\Bentley\ProjectWise 
iDesktop Integration\XX.XX\Configuration\AutoCAD"

String value name: DoNotChangeCommands

Value: 'On'

To access the Registry Editor, click Start > Run, then type 
regedit. Using the Registry Editor incorrectly can cause 
serious, system-wide problems that may require you to re-
install Windows to correct them. Always make a backup 
copy of the system registry before modifying it.

Bentley SewerGEMS V8i features support for AutoCAD integration. You can deter-
mine if you have purchased AutoCAD functionality for your license of Bentley 
SewerGEMS V8i by using the Help > About menu option. Click the Registration 
button to view the feature options that have been purchased with your application 
license. If AutoCAD support is enabled, then you will be able to run your Bentley 
SewerGEMS V8i application in both AutoCAD and stand-alone mode.

The AutoCAD functionality has been implemented in a way that is the same as the 
SewerGEMS V8i base product. Once you become familiar with the stand-alone mode, 
you will not have any difficulty using the product in AutoCAD mode.

Some of the advantages of working in AutoCAD mode include:

• Layout network links and structures in fully-scaled mode in the same design and 
drafting environment that you use to develop your engineering plans. You will 
have access to any other third party applications that you currently use, along with 
any custom LISP, ARX, or VBA applications that you have developed. 
Bentley SewerGEMS V8i User’s Guide 13-709



The AutoCAD Workspace
• Use native AutoCAD insertion snaps to precisely position Bentley SewerGEMS 
V8i elements with respect to other entities in the AutoCAD drawing.

• Use native AutoCAD commands such as ERASE, MOVE, and ROTATE on 
Bentley SewerGEMS V8i model entities with automatic update and synchroniza-
tion with the model database. 

• Control destination layers for model elements and associated label text and anno-
tation, giving you control over styles, line types, and visibility of model elements.

• “AutoCAD Project Files” on page 13-712

The AutoCAD Workspace
In AutoCAD mode, you will have access to the full range of functionality available in 
the AutoCAD design and drafting environment. The standard environment is extended 
and enhanced by an AutoCAD ObjectARX Bentley SewerGEMS V8i client layer that 
lets you create, view, and edit the native Bentley SewerGEMS V8i network model 
while in AutoCAD.

Click one of the following links to learn more about Bentley SewerGEMS V8i 
AutoCAD environment:

• “AutoCAD Integration with SewerGEMS V8i” on page 13-710

AutoCAD Integration with SewerGEMS V8i

When you install SewerGEMS after you install AutoCAD, integration between the 
two is automatically configured.

If you install AutoCAD after you install SewerGEMS, you must manually integrate 
the two by selecting Start > All Programs > Haestad Methods >SewerGEMS > 
Integrate SewerGEMS with AutoCAD-ArcGIS. The integration utility runs auto-
matically. You can then run SewerGEMS in AutoCAD mode. 

The Integrate SewerGEMS with AutoCAD-ArcGIS command can also be used to fix 
problems with the AutoCAD configuration file. For example, if you have Sewer-
GEMS installed on the same system as Bentley SewerGEMS V8i and you uninstall or 
reinstall SewerGEMS, the AutoCAD configuration file becomes unusable. To fix this 
problem, you can delete the configuration file then run the Integrate SewerGEMS with 
AutoCAD-ArcGIS command.
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AutoCAD Mode Graphical Layout

In AutoCAD mode, our products provide a set of extended options and functionality 
beyond those available in stand-alone mode. This additional functionality provides 
enhanced control over general application settings and options and extends the 
command set, giving you control over the display of model elements within 
AutoCAD.

Note: In AutoCAD, you must hold down the mouse button to keep the 
submenu open while selecting an element from the layout 
toolbar. Alternate layout methods include using the right-click 
menu to select elements or using the command line.

Menus

In AutoCAD mode, in addition to AutoCAD’s menus, the following Bentley Sewer-
GEMS V8i menus are available:

• Analysis

• View

• Tools

• Report

In addition, Bentley SewerGEMS V8i adds its own Help menu commands to 
AutoCAD’s Help menu.

The Bentley SewerGEMS V8i menu commands work the same way in AutoCAD and 
the Stand-Alone Editor. For complete descriptions of Bentley SewerGEMS V8i menu 
commands, see “Menus” on page 2-11.

Toolbars

In AutoCAD mode, in addition to AutoCAD’s toolbars, the following Bentley Sewer-
GEMS V8i toolbars are available:

• Layout

• View

• Compute

• Scenarios

• Analysis

• Links
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The Bentley SewerGEMS V8i toolbars work the same way in AutoCAD and the 
Stand-Alone Editor. For complete descriptions of Bentley SewerGEMS V8i toolbars, 
see “Toolbars” on page 2-25.

Drawing Setup

When working in the AutoCAD mode, you may work with our products in many 
different AutoCAD scales and settings. However, Haestad Methods product elements 
can only be created and edited in model space.

Symbol Visibility

Note: In AutoCAD, it is possible to delete element label text using the 
ERASE command. You should not use ERASE to control 
visibility of labels. If you desire to control the visibility of a 
selected group of element labels, you should move them to 
another layer that can be frozen or turned off.

In AutoCAD mode, you can control display of element labels using the check box in 
the Drawing Options dialog box.

AutoCAD Project Files
When using Bentley SewerGEMS V8i in AutoCAD mode, there are three files that 
fundamentally define a Bentley SewerGEMS V8i model project:

• Drawing File (.dwg)—The AutoCAD drawing file contains the custom entities 
that define the model, in addition to the planimetric base drawing information that 
serves as the model background.

• Model File (.swg)—The native Bentley SewerGEMS V8i model database file 
that contains all the element properties, along with other important model data. 
Bentley SewerGEMS V8i .swg files can be loaded and run using the Stand-Alone 
Editor. These files may be copied and sent to other Bentley SewerGEMS V8i 
users who are interested in running your project. This is the most important file 
for the Bentley SewerGEMS V8i model. 

• SewerCAD Exchange Database (.srw.mdb)—The intermediate format for 
SewerCAD project files. When you import a SewerCAD file into Bentley Sewer-
GEMS V8i, you first export it from SewerCAD into this format, then import the 
.srw.mdb file into Bentley SewerGEMS V8i. Note that this works the same in the 
Stand-Alone Editor and in AutoCAD. For more information on importing 
SewerCAD files, see “Importing Data from SewerCAD” on page 4-163.
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The three files have the same base name. It is important to understand that archiving 
the drawing file is not sufficient to reproduce the model. You must also preserve the 
associated .swg and srw.mdb file.

Since the .swg file can be run and modified separately from the .dwg file using the 
Stand-Alone Editor, it is quite possible for the two files to get out of sync. Should you 
ever modify the model in the Stand-Alone Editor and then later load the AutoCAD 
.dwg file, the Bentley SewerGEMS V8i program compares file dates, and automati-
cally use the built-in AutoCAD synchronization routine.

Click one of the following links to learn more about AutoCAD project files and 
Bentley SewerGEMS V8i:

• “Drawing Synchronization” on page 13-713

• “Saving the Drawing as Drawing*.dwg” on page 13-714

Drawing Synchronization

Whenever you open a Bentley SewerGEMS V8i-based drawing file in AutoCAD, the 
Bentley SewerGEMS V8i model server will start. The first thing that the application 
will do is load the associated Bentley SewerGEMS V8i model (.SWG) file. If the time 
stamps of the drawing and model file are different, Bentley SewerGEMS V8i will 
automatically perform a synchronization. This protects against corruption that might 
otherwise occur from separately editing the Bentley SewerGEMS V8i model file in 
stand-alone mode, or editing proxy elements at an AutoCAD station where the 
Bentley SewerGEMS V8i application is not loaded.

The synchronization check will occur in two stages:

• First, Bentley SewerGEMS V8i will compare the drawing model elements with 
those in the server model. Any differences will be listed. Bentley SewerGEMS 
V8i enforces network topological consistency between the server and the drawing 
state. If model elements have been deleted or added in the .SWG file during a 
SewerGEMS V8i session, or if proxy elements have been deleted, Bentley Sewer-
GEMS V8i will force the drawing to be consistent with the native database by 
restoring or removing any missing or excess drawing custom entities.

• After network topology has been synchronized, Bentley SewerGEMS V8i will 
compare other model and drawing states such as location, labels, and flow direc-
tions.

You can run the Synchronization check at any time using the following command:

SWRGSYNCHRONIZE

Or by selecting Tools > Database Utilities > Synchronize Drawing.
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Saving the Drawing as Drawing*.dwg

Note: If this situation inadvertently occurs (save on quit for example), 
restart AutoCAD, use the Open command to open the 
Drawing*.dwg file from its saved location, and use the Save As 
command to save the drawing and model data to a different 
name.

AutoCAD uses Drawing*.dwg as its default drawing name. Saving your drawing as 
the default AutoCAD drawing name (for instance Drawing1.dwg) should be avoided, 
as it makes overwriting model data very likely. When you first start AutoCAD, the 
new empty drawing is titled Drawing*.dwg, regardless of whether one exists in the 
default directory. Since our modeling products create model databases associated with 
the AutoCAD drawing, the use of Drawing*.dwg as the saved name puts you at risk of 
causing synchronization problems between the AutoCAD drawing and the modeling 
files.

Working with Elements Using AutoCAD Commands
This section describes how to work with elements using AutoCAD commands, 
including:

• “SewerGEMS Custom AutoCAD Entities” on page 13-714

• “AutoCAD Commands” on page 13-715

• “Explode Elements” on page 13-715

• “Moving Elements” on page 13-716

• “Moving Element Labels” on page 13-716

• “Snap Menu” on page 13-716

• “Polygon Element Visibility” on page 13-716

SewerGEMS Custom AutoCAD Entities

The primary AutoCAD-based SewerGEMS element entities—conduits, channels, 
gutters, pressure pipes, manholes, catch basins, outfalls, ponds, catchments, pond 
outlet structures, cross section nodes, pressure junctions, junction chambers, wet 
wells, and pumps—are all implemented using ObjectARX custom objects. Thus, they 
are vested with a specialized model awareness that ensures that any editing actions 
you perform will result in an appropriate update of the model database.

This means that you can perform standard AutoCAD commands (see “AutoCAD 
Commands” on page 13-715) as you normally would, and the model database will be 
updated automatically to reflect these changes.
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It also means that the model will enforce the integrity of the network topological state. 
Therefore, if you delete a nodal element such as a junction, its connecting pipes will 
also be deleted since their connecting nodes topologically define model pipes.

Using ObjectARX technology ensures the database will be adjusted and maintained 
during Undo and Redo transactions.

Related Topics

• “AutoCAD Commands” on page 13-715

• “Explode Elements” on page 13-715

• “Moving Elements” on page 13-716

• “Moving Element Labels” on page 13-716

• “Snap Menu” on page 13-716

AutoCAD Commands

When running in AutoCAD mode, Haestad Methods products make use of all the 
advantages that AutoCAD has, such as plotting capabilities and snap features. Addi-
tionally, AutoCAD commands can be used as you would with any design project. For 
example, our products’ elements and annotation can be manipulated using common 
AutoCAD commands.

• “SewerGEMS Custom AutoCAD Entities” on page 13-714

Explode Elements

In AutoCAD mode, running the AutoCAD Explode command will transform all 
custom entities into equivalent AutoCAD native entities. When a custom entity is 
exploded, all associated database information is lost. Be certain to save the exploded 
drawing under a separate filename.

Use Explode to render a drawing for finalizing exhibits and publishing maps of the 
model network. You can also deliver exploded drawings to clients or other individuals 
who do not own a Bentley Systems Product license, since a fully exploded drawing 
will not be comprised of any ObjectARX proxy objects. For more information, see 
“Working with Proxies” on page 13-718.

• “SewerGEMS Custom AutoCAD Entities” on page 13-714
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Moving Elements

When using AutoCAD mode, the AutoCAD commands Move, Scale, Rotate, Mirror, 
and Array can be used to move elements. 

To move a node, execute the AutoCAD command by either typing it at the command 
prompt or selecting it. Follow the AutoCAD prompts, and the node and its associated 
label will move together. The connecting pipes will shrink or stretch depending on the 
new location of the node.

• “SewerGEMS Custom AutoCAD Entities” on page 13-714

Moving Element Labels

When using AutoCAD mode, the AutoCAD commands Move, Scale, Rotate, Mirror, 
and Array can be used to move element text labels. 

To move an element text label separately from the element, click the element label you 
wish to move. The grips will appear for the label. Execute the AutoCAD command 
either by typing it at the command prompt, by selecting it from the tool palette, or by 
selecting it from the right-click menu. Follow the AutoCAD prompt, and the label will 
be moved without the element.

• “SewerGEMS Custom AutoCAD Entities” on page 13-714

Snap Menu

When using AutoCAD mode, the Snap menu is a standard AutoCAD menu that 
provides options for picking an exact location of an object. See the Autodesk 
AutoCAD documentation for more information.

• “SewerGEMS Custom AutoCAD Entities” on page 13-714

Polygon Element Visibility

By default, polygon elements are sent to the back of the draw order when they are 
drawn. If the draw order is modified, polygon elements can interfere with the visibility 
of other elements. This can be remedied using the AutoCAD Draw Order toolbar.

To access the AutoCAD Draw Order toolbar, right-click on the AutoCAD toolbar and 
click the Draw Order entry in the list of available toolbars.
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By default, polygon elements are filled. You can make them unfilled (just borders 
visible) using the AutoCAD FILL command. After turning fill mode OFF, you must 
REGEN to redraw the polygons.

Undo/Redo
Note: If you use the native AutoCAD undo, you are limited to a single 

redo level. The Bentley SewerGEMS V8i undo/redo is faster than 
the native AutoCAD undo/redo. If you are rolling back Bentley 
SewerGEMS V8i model edits, it is recommended that you use the 
menu-based Bentley SewerGEMS V8i undo/redo. 

If you undo using the AutoCAD undo/redo and you restore 
Bentley SewerGEMS V8i elements that have been previously 
deleted, morphed, or split, some model state attributes such as 
diameters or elevations may be lost, even though the locational 
and topological state is fully consistent. This will only happen in 
situations where the Bentley SewerGEMS V8i command history 
has been deleted. In such cases, you will be warned to check 
your data carefully.

In AutoCAD mode, you have two types of undo/redo available to you. From the Edit 
menu, you have access to Bentley SewerGEMS V8i undo and redo. Alternatively, you 
can perform the native AutoCAD undo and redo by typing at the AutoCAD command 
line. The implementations of the two different operation types are quite distinct.

The menu-based undo and redo commands operate exclusively on Bentley Sewer-
GEMS V8i elements by invoking the commands directly on the model server. The 
main advantage of using the specialized command is that you will have unlimited 
undo and redo levels. This is an important difference, since in layout or editing it is 
quite useful to be able to safely undo and redo an arbitrary number of transactions.

Whenever you use a native AutoCAD undo, the server model will be notified when 
any Bentley SewerGEMS V8i entities are affected by the operation. Bentley Sewer-
GEMS V8i will then synchronize the model to the drawing state. Wherever possible, 
the model will seek to map the undo/redo onto the model server’s managed command 
history. If the drawing’s state is not consistent with any pending undo or redo transac-
tions held by the server, Bentley SewerGEMS V8i will delete the command history. In 
this case, the model will synchronize the drawing and server models.

Special Considerations
There are special considerations to remember when you perform the following tasks 
in AutoCAD mode:

• “Importing SewerGEMS Data” on page 13-718
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• “Working with Proxies” on page 13-718

Importing SewerGEMS Data

When running SewerGEMSin AutoCAD mode, this command imports a selected 
SewerGEMS data (.swg) file for use in the current drawing. The new project file will 
now correspond to the drawing name, such as, CurrentDrawingName.swg. Whenever 
you save changes to the network model through SewerGEMS, the associated .swg 
data file is updated and can be loaded into SewerGEMS.

Warning! A SewerGEMS Project can only be imported to a new, empty 
AutoCAD drawing.

Related Topic

• “Working with Proxies” on page 13-718

Working with Proxies

If you open a Bentley SewerGEMS V8i drawing file on an AutoCAD workstation that 
does not have the Bentley SewerGEMS V8i application installed, you will get an 
AutoCAD Proxy Information message box. This is because the executable logic for 
managing the AutoCAD entities is not available, and the Bentley SewerGEMS V8i 
modeling elements are not associated with the Bentley SewerGEMS V8i native data-
base.

Bentley SewerGEMS V8i proxy objects can be moved and erased. However, doing so 
will put the drawing state out of sync with the model database if the drawing is saved 
with its original name. If this happens, and you later reload the drawing on an 
AutoCAD station that is running a Bentley SewerGEMS V8i application, the applica-
tion will automatically load and will attempt to reconcile any differences it finds by 
automatically loading its Database Synchronization routine. (For more information, 
see “Drawing Synchronization” on page 13-713).

• “Importing SewerGEMS Data” on page 13-718
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Chapter

Theory
Fundamental Solution of the Gravity Flow System
With increasing urbanization and urban renewal impacts driving the drainage and 
water quality regulatory framework, the design and analysis of storm water systems 
are becoming increasingly complex.   The hydraulics characteristics of a drainage 
system often exhibit many complicated features, such as tidal or other hydraulic 
obstructions influencing backwater at the downstream discharge location, confluence 
interactions at junctions of a pipe network, interchanges between surcharged pressure 
flow and gravity flow conditions, street-flooding from over-loaded pipes, integrated 
detention storage, bifurcated pipe networks, and various inline and offline hydraulic 
structures.   The time variations of the storm drainage design flow event are increas-
ingly important in verifying total performance and achieving a measure of regulatory 
or design policy compliance.  To better understand these complicated hydraulic 
features and accurately simulate flows in a complicated storm water handling system 
hydrodynamic flow models are necessary. 

To simulate unsteady flows in storm water collection systems, numerical computa-
tional techniques have been the primary tools, and the results from numerical models 
are widely used for planning, designing and operational purposes.   Since an urban 
drainage system can be composed of hundreds of pipes and many hydraulic control 
structures, the hydraulics in storm system can exhibit very complicated flow condi-
tions. Consequently the numerical stability, computational performance, capabilities 
and robustness in handling complicated hydraulic conditions and computational accu-
racy are the major factors when deciding which approach to use to solve the hydraulic 
system.

Although many numerical methods have been developed to simulate the unsteady 
flows in sewer and storm water systems, including those based on explicit numerical 
schemes and those based on implicit schemes, limitations in most of models exist.  
SewerGEMS V8i features engines capable of solving the dynamic solution using both 
schemes. Users may select to either user EPA SWMM’s native explicit solver or a 
custom implicit solver as more fully described in this section. The implicit solver is 
the default solver used in SewerGEMS V8i.
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Flows in sewers are usually free surface open-channel flows, therefore the Saint-
Venant equations of one-dimensional unsteady flow in non-prismatic channels or 
conduits are the basic equations for unsteady sewer flows.  The dynamic model solu-
tion uses the following complete and extended equations:

(14.1)

(14.2)

A weighted four-point implicit scheme is used to solve the Saint-Venant equations.  
An implicit method is preferred over explicit since these methods have the advantage 
of maintaining good stability for large computational time steps and exhibit robustness 
in modeling systems that integrate the complex hydraulic interactions encountered in 
gravity sewer systems.  The scheme was adopted since it handles unequal distance 

Where t = time

x = the distance along the longitudinal axis of the 
sewer reach

y = flow-depth

A = the active cross-sectional area of flow

A0 = the inactive (off-channel storage) cross-sectional 
area of flow

q = lateral inflow or outflow

â = the coefficient for nonuniform velocity 
distribution within the cross section

g = gravity constant

So = sewer or channel slope

Sf = friction slope due to boundary turbulent shear 
stress and determined by Manning’s equation

Se = slope due to local severe expansion-contraction 
effects (large eddy loss)

L = the momentum effect of lateral flow
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steps, its stability-convergence properties can be conveniently modified, and the 
internal (any hydraulic structures, such as dams, weirs, pumps, manholes etc) and 
external boundary conditions can be easily applied.  The dynamic model is developed 
using the following four-point finite-difference scheme:

(14.3)

(14.4)

(14.5)

in which θ is a weighting factor and the weighted four-point implicit scheme is uncon-
ditionally stable for  >0.5.  The value of θ of 0.6-0.8 is found to be optimal in main-
taining stability and accuracy for large computational time steps.

The Newton-Raphson iteration method is used to solve the finite-difference equations 
derived from applying Equations 3 to 4 to Equations 1 and 2. Exceptional computa-
tional efficiency is achieved by special algorithm to iterate banded matrixes.

Application of the St. Venant Equation in Branched and Looped 
Networks

A model network could comprise only one or two branches or it could be as compli-
cated as a system of hundreds of branches with cross-connections and various junc-
tions containing different hydraulic structures and facilities, such as weirs and pumps.   
In many situations, the mutual flow interaction must be accounted for to achieve real-
istic results, particularly for unsteady flows since those confluence junctions can have 
significant effects due to the traveling dynamic waves traveling in a sewer system. 

An extended relaxation technique is used in SewerGEMS V8i to achieve a balanced 
solution.  This extended relaxation algorithm decomposes the storm network into indi-
vidual branches and loops and solves each component using a four-point implicit 
scheme. In doing so, the algorithm treats the influences of interconnecting branches as 
a combination lateral flows and stage and discharge boundary condition. 

1 1
1 1

2

j j j j
i i i i

j

f f f f f
t t

+ +
+ +∂ + − −

=
∂ ∆

1 1
1 1( ) (1 )( )j j j j

i i i i

i

f f f f f
x x

θ θ+ +
+ +∂ − + − −

=
∂ ∆

1 1
1 1( ) (1 )( )

2

j j j j
i i i if f f ff θ θ+ +

+ ++ + − +
=

Bentley SewerGEMS V8i User’s Guide 14-721



Fundamental Solution of the Gravity Flow System
Branches are ranked and ordered by a network parsing heuristic that traverses in 
depth-first fashion that sequences and weights according to conduit and channel 
conveyance characteristics (larger is ranked lower) and confluence angles (smaller is 
ranked lower). Loop-forming branches are isolated as part of a pre-traversal phase and 
are identified principally on the basis of localized slope and connectivity consider-
ations. Generally, the lower the rank or branch number, the greater the branches 
hydraulic contribution to the total network response. Loops, if any, will typically have 
higher branch numbers.

Each branch confluence has two cross sections, which are located, just upstream and 
downstream of each of its junctions with connecting branches.  During the numerical 
solution process, as each branch is solved by the Newton-Raphson iteration, an 
assumed lateral inflow or outflow is added at each junction reach to replace the 
confluence branch. The branches are automatically ranked such that the dendritic 
branches are always treated before those branches that form interconnecting loops.  
Also, a connecting branch ranked after the branch into which it is connected.  This 
numbering scheme enables a stage boundary condition at the downstream of a branch 
to be determined using the average computed stages at the two confluence cross 
sections at the junction which the branch joins. In this way, each branch is indepen-
dently solved one by one using the estimated lateral flows at each of the branch junc-
tions.  If the system has a total of J junctions, the relaxation is to iterate these J 
junction-related lateral flows.  The relaxation equation for the lateral flows is:

(14.6)

Values of α between 0.8 and 0.9 provide the most efficient convergence for the relax-
ation iteration.  Extensive tests have shown that the relaxation iteration convergence is 
achieved within one to three iterations for almost all situations using α = 0.6. 

Branches

The implicit dynamic engine solves the St. Venant equations along straight branches 
of conduit or channel starting at the most downstream outfall. Branch 1 starts at the 
outfall and upstream until it reaches the first junction. There it follows the junction 
with the largest conduit and/or the conduit with the alignment that matches the outlet 

Where q* = the estimated confluence lateral flow for the next 
iteration

q** = the previous estimated lateral flow

Q = the computed discharge at the downstream end of 
the connecting branch in the previous iteration

á = a weighting factor (0<α<1.0)

* **(1 )q q Qα α= − +
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pipe alignment. This continues until the branch reaches the most upstream node. At 
this point a second branch starts from the largest pipe from the first junction that was 
not in branch 1. This branch continues to its most upstream point. Once these branches 
are numbered, branches that start at pump station wet wells are traced out to their 
source.

An example of the branch labeling is shown in the figure below. The red numbers 
indicate branches. In the figure, branch 1 is made up of 30 in. pipes; branch 2 is made 
up of 24 in. pipes while the other branches consist of 18 in. pipes.

Figure 14-1: Branch Labeling

Section Count

The element property Section Count refers to the number of spatial sections into 
which the element is divided along its length by the implicit numerical engine. For any 
element there will be a minimum of five sections. Depending on the value of the 
Computational Distance property, which you set in the Property Editor for Calculation 
Options, additional sections are added for longer pipes. The default computational 
distance is 50 feet so that there will be five sections for any element up to 250 ft. 
Beyond that length, a section is added for each 50 ft of length. You can control the 
number of sections by increasing or decreasing the computational distance, which will 
decrease or increase the number of sections accordingly.
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Special Considerations

Gravity sewer collection systems are subject to a number of special hydraulic condi-
tions that must be considered in developing a full and complete solution scheme. 
These special conditions challenge the basic algorithm since they are not explicitly 
accounted for in the basic solution for 1-D gravity flow. The hydraulics engine has 
been extended to account for these conditions and the numerical adaptations are 
described in this section, which includes the following topics:

• “Pressurized Flow” on page 14-724

• “Mixed (Transcritical) Flow” on page 14-726

• “Dry Bed (Low Flow)” on page 14-727

• “Steep Reaches” on page 14-728

• “Flooding” on page 14-728

Related Topics:

• “Fundamental Solution of the Gravity Flow System” on page 14-719

• “Application of the St. Venant Equation in Branched and Looped Networks” on 
page 14-721

• “Section Hydraulics” on page 14-729

Pressurized Flow

The typical gravity sewer network is dominated by circular pipe segments.  These 
pipes are all closed and characterized by a converging top where the hydraulic top 
width approaches zero as flow transitions from free surface to pressure. The Preiss-
mann slot method is used for simulating pressure or surcharged flows by adapting the 
conceptualization of pressurized flow to fit a free surface model.  The slot extends 
vertically from pipe crown to infinity and over the entire length the pipe, and the width 
of the slot is usually 1% of the characteristic pipe dimension (diameter for a circular 
pipe) but not large than 0.02 ft.
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Figure 14-2: Transition of a Circular Pipe to the Slot

Since a circular conduit width changes dramatically near the crown and in order to 
maintain a smooth transition between conduit width and the slot width, the 

s  
where 0.98<y/d<1.2
b/d = 0.001 and 
y/d>1.2, and

The maximum width allowed in the slot is 0.01 ft.  Also, when the flow depth is above 
the diameter d the area remains the full circular section area therefore the slot will 
have no impact on the flow continuity.

The significant advantages in using this hypothetical slot are apparent in simulating 
the moving transitional interface between open-channel flow and pressure flow, which 
can happen anywhere at any time in a sewer system. Since the model applies a unified 
set of consistent equations and numerical schemes, it makes no special switches 
between open-channel flows and pressure flows, giving rise to a robust solution.

Related Topics:

Where b = conduit and slot width

d = circular conduit diameter

y = flow depth

320.980.28( )
/

b
d y d
=
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• “Mixed (Transcritical) Flow” on page 14-726

• “Dry Bed (Low Flow)” on page 14-727

• “Steep Reaches” on page 14-728

• “Flooding” on page 14-728

Mixed (Transcritical) Flow

One of the challenging features in the unsteady flows in a sewer or storm water 
drainage system is the interchanging or moving interface of different flow regimes 
between subcritical and supercritical flows.  This is largely due to the fact that an 
urban hydraulic system can experience a large range of slopes of conduits and it is 
common to have significant slope changes at many pipe junctions.   A good numerical 
model for sewer and storm water system has to be able to handle the mixed flow 
regimes and interchanges with great robustness.

When modeling unsteady flows, the dynamic routing technique using the four-point 
implicit numerical scheme tends to be less numerically stable than the diffusion (zero 
inertia) routing technique for certain mixed flows, especially in the near critical range 
of the Froude number (Fr) or mixed flows with moving supercritical/subcritical inter-
faces. It has been observed that the diffusion technique, which eliminates the two iner-
tial terms in the momentum equation, produces stable numerical solutions for flows 
where Fr is in the range of critical flow (Fr=1.0) and for supercritical flows.  To take 
advantage of the diffusion method's stability and retain the accuracy of the fully 
dynamic method, the Local Partial Inertia modification (LPI) technique is used in the 
dynamic sewer model.   In the LPI technique, the momentum equation, Equation 11.2, 
is modified by a numerical filter, σ, so that the inertial terms are partially or totally 
omitted based on the time-dependent local hydraulic conditions. 

The modified equation and numerical filter are:

(14.7)

in which σ is a numerical modifier and its value for every finite-difference box 
(between xi and xi+1) will be determined at each time step by the following equation:

(14.8)
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in which m is a user specified constant and m ≥ 1.0.  It is found that smaller values of 
m tend to stabilize the solution in some cases while larger values of m provide more 
accuracy.

The LPI technique was developed by Dr. Ming Jin and Dr. Danny Fread and this tech-
nique has been adapted by Federal dynamic models such as NWS Fldwav model, 
USACE HEC-RAS unsteady flow model and EPA-SWMM model.

Related Topics:

• “Pressurized Flow” on page 14-724

• “Dry Bed (Low Flow)” on page 14-727

• “Steep Reaches” on page 14-728

• “Flooding” on page 14-728

Dry Bed (Low Flow)

For the dry flow condition, the numerical model applies a very small initial steady 
flow (virtual flow) at the start the simulation. This virtual flow is applied system-wide 
and has negligible effect on the computational results over the full simulation. The 
engine distributes and manages the virtual flow allocation and de-allocation dynami-
cally across all the network branches and loops over the full course of the simulation, 
and sophisticated algorithms are developed to distribute the virtual flows in the way 
that they will not be accumulative and they have only local impacts on the very low 
flow conditions. These virtual flow assignments are based on a tiny threshold value 
that is dynamically adjusted over the duration of the analysis. A virtual flow filter 
algorithm adjusts the results for the virtual flow quantities and depths by subtracting 
the virtual flow effects from the hydraulic results at each time step at each solution 
point over the network.

To users, these virtual flows are invisible and there is no practical impact on the 
computational results.

Related Topics:

• “Pressurized Flow” on page 14-724

• “Mixed (Transcritical) Flow” on page 14-726

• “Steep Reaches” on page 14-728

• “Flooding” on page 14-728
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Steep Reaches

Unlike a natural river, a storm drainage system can often have pipes of very steep 
slopes, sometimes more than 30%.  The flows in such steep pipes are overwhelmingly 
very supercritical.  A kinematical treatment is applied on such very steep pipes in 
which the Manning equation is used to replace the momentum equation during the 
solution process. 

Related Topics:

• “Pressurized Flow” on page 14-724

• “Mixed (Transcritical) Flow” on page 14-726

• “Dry Bed (Low Flow)” on page 14-727

• “Flooding” on page 14-728

Flooding

A unique hydraulic condition in the storm sewer modeling is the overcharged-flow- 
resulted street surface flooding.  This is the condition in which the drainage flow into 
the sewer pipe is much larger than the sewer capacity and the depth is built higher than 
the ground surface elevation. In addition, at the sewer junctions (manholes) where 
there may be open access to the ground, the flow starts to go upward through the 
manhole openings, overtop the manhole rims.

There are two scenarios after the street flooding occurs:

• If there is a surface gutter or channel connected to the manhole, the overflowing 
water will join the surface gutter or channel and will be accounted for and simu-
lated as part of the flows in the gutter subsystem.  These flows may drain back to 
the sewer subsystem somewhere downstream.

• If there is no surface gutter or channel connected to the overflowed manhole, the 
overtopped flows leave the sewer system and these flows are lost to the system; 
this will be reflected by a flow volume loss. In this condition, there may also be a 
storage area above the ground elevation and below the user-specified overtop 
elevation. The water stored in the storage area will drain back to the manhole 
when the water elevation recesses.  Users can specify the storage areas and the 
street-flooding-overtop elevation.  A default overtop elevation is the ground rim 
elevation, assuming there is no storage effects.

The implicit hydraulic engine treats the street overtopping overflow as weir flow and 
uses a weir equation to determine the overflow. The weir crest elevation is the user-
specified street overtop elevation and the weir length is determined by an empirical 
equation:
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(14.9)

Related Topics:

• “Pressurized Flow” on page 14-724

• “Mixed (Transcritical) Flow” on page 14-726

• “Dry Bed (Low Flow)” on page 14-727

• “Steep Reaches” on page 14-728

Section Hydraulics

Within the hydraulics solver the decomposed network branches and loops comprise a 
series of reach segments and/or structures that are logically ordered from upstream to 
downstream by the numerical engine. Each reach segment consists of either a pris-
matic conduit section or a natural channel segment described by separately defined 
upstream and downstream open channel sections.

This section includes the following topics:

• “Conduit Shapes” on page 14-729

• “Natural Reach Shapes” on page 14-741

• “Virtual Link Types” on page 14-742

• “Roughness Models” on page 14-742

Conduit Shapes

The supported conduit shapes are shown in Figures 11-2 to 11-21. Each shape is 
parameterized by one, two, or more characteristic dimensions as shown in the refer-
ence figure. In this model, a conduit is taken to be a prismatic (constant-shaped) 
conveyance segment that is defined by a single shape. Conduits do not have to be 
closed sections, so prismatic design channels can be modeled using conduit elements. 

The allowable conduit shapes include:

Where WL = overflow weir crest length 

dh = the head over the overflow weir

W dhL = +6 0 1. ( )
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• “Circular Channel” on page 14-731

• “Trapezoidal Channel” on page 14-731

• “Basket Handle” on page 14-732

• “Ellipse” on page 14-732

• “Horseshoe” on page 14-733

• “Egg” on page 14-733

• “Semi-ellipse” on page 14-734

• “Pipe-Arch” on page 14-735

• “Semi-Circle” on page 14-736

• “Catenary” on page 14-736

• “Gothic” on page 14-737

• “Modified Basket Handle” on page 14-737

• “Triangle” on page 14-738

• “Rectangular Channel” on page 14-738

• “Irregular Open Channel” on page 14-739

• “Irregular Closed Section” on page 14-739

• “Rectangular-Rounded” on page 14-740

• “Rectangular-Triangular” on page 14-740

• “Power” on page 14-741

• “Parabola” on page 14-741

In addition, SewerGEMS V8i supports the following:

• “Natural Reach Shapes” on page 14-741

• “Virtual Link Types” on page 14-742
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Circular Channel

Figure 14-3: Circular Channel Shape

Trapezoidal Channel

Figure 14-4: Trapezoidal Channel Shape
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Basket Handle

Figure 14-5: Basket-Handle Shape

Ellipse

Figure 14-6: Ellipse Shape
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Horseshoe

Figure 14-7: Horseshoe Shape

Egg

Figure 14-8: Egg Shape
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Semi-ellipse

Figure 14-9: Semi-Ellipse Shape
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Pipe-Arch

Figure 14-10: Pipe-Arch Shape

RC

RB

RT

Span

B

Rise
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Semi-Circle

Figure 14-11: Semi-Circular Shape

Catenary

Figure 14-12: Catenary Shape
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Gothic

Figure 14-13: Gothic Shape

Modified Basket Handle

Figure 14-14: Modified Basket-Handle Shape
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Triangle

Figure 14-15: Triangle Shape

Rectangular Channel

Figure 14-16: Rectangular Channel Shape
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Irregular Open Channel

Figure 14-17: Irregular Open Channel Shape

Irregular Closed Section

Figure 14-18: Irregular Closed Section Shape
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Rectangular-Rounded

Figure 14-19: Rectangular-Rounded Shape

Rectangular-Triangular

Figure 14-20: Rectangular-Triangular Shape
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Power

Figure 14-21: Power Shape

Parabola

Figure 14-22: Parabola Shape

Natural Reach Shapes

As in most river models, a natural channel branch can be taken as a series of gradually 
varying sections. Natural channels segments that describe a branch are defined using 
an upstream and downstream open channel section element. The following section 
shapes may be used to define natural channels:

• Irregular Closed Section

• Trapezoidal
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For natural sections, the engine will automatically insert the required computational 
sections along the reach by interpolating a top width versus elevation table that is 
dynamically built according to the maximum number of input points that describes 
either end-section.

Note: The SWMM engine does not support the notion of a natural 
channel described between two open channels cross-sections. 
So, when solving using the SWMM engine, each open channel 
reach will be modeled using the upstream section shape. Using 
a conduit element with an irregular shape will provide 
computational consistency between the SWMM and implicit 
engines.

Virtual Link Types

The model includes a virtual link type that can be used to achieve fidelity with the 
SWMM modeling abstraction as applied to certain hydraulic element types such as 
weirs, orifices, and pumps. Since SWMM treats each of these elements as a logical 
topological link that is contrary to spatial reality, a virtual section can be supplied to 
treat these nodal elements in a way that matches the SWMM model. In the model, a 
virtual link is a placeholder element that conveys flow directly while suppressing all 
hydraulic effects on the network.

Roughness Models

The SewerGEMS V8i solver uses the Manning's equation to evaluate the friction 
slope term, Sf , in Equation 11-3:

(14.10)

The Manning’s n is a user-defined value that introduces the effects of conduit, 
channel, or gutter roughness. The K that is actually applied for a segment between two 
interpolated locations along the computational stream is evaluated by averaging the K 
values computed for the two locations.

Where n = Manning coefficient for friction

µ = unit conversion factor (1.49 for US Customary 
and 1.0 for SI units)

R = hydraulic radius

K = flow conveyance factor

2

2 2 4/3 2f

n Q Q Q Q
S

A R Kµ
= =
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For more information on the application of this roughness model, see “Implementa-
tions” on page 14-743.

Implementations

This section describes the applications of the roughness model available in Bentley 
SewerGEMS V8i.

Single Roughness

The simplest application of the Manning's model is to supply a single roughness value 
to the segment being modeled.

Horizontal Variation

The modeler can describe the horizontal variation of roughness across a natural 
section. Horizontally varied roughness is automatically pre-processed and described 
to the engine as a vertical variation using Pavloskii’s Method:

(14.11)

Overbank Segments

This roughness model is widely applied in floodplain analysis and is a useful way to 
describe the overbank and channel components of a river reach. In these circum-
stances the conveyance factor for the section is computed as follows:

Where n = Roughness coefficient

P = Weighted perimeter

Subscripts represents subdivisions of one given 
section

n
P n

P

Pn P n P n

P

N N

N

N N= = + + ⋅⋅⋅ +∑ ( )2

1 1 1
2

2 2
2 2
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L
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n
µ

=
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C
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n
µ
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Overbank segment manning types are converted to horizontal variation roughness 
types, which can be converted to vertical variation types using Pavlovskii’s Method.

Vertical Variation

A Manning's n versus depth relationship can be supplied. In the case of irregular 
sections, the engine simply interpolates the roughness value to apply for each interpo-
lated internal top width value that is developed by the algorithm for the section.

Flow Roughness

Describing Manning's n versus flow is a roughness model that can be used in natural 
river applications where the flow record can be used to calibrate the n. 

Hydraulic Boundaries
In order to numerically solve the Saint Venant equations, boundary conditions are 
needed in the model to provide the necessary additional equations to form a complete 
set of equations. 

There are two types of hydraulic boundaries:

• “External Boundaries” on page 14-745

• “Internal Boundaries” on page 14-745

Where L = left floodplain

C = channel

R = right floodplain

2/3
R R R

R

K A R
n
µ

=

L C RK K K K= + +
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External Boundaries

External boundaries in a sewer system include outfalls at the downstream ends and 
very first section at the upstream ends. For the upstream end boundaries, usually a 
simple zero flow is used as upstream boundary condition or a flow time series can be 
used as upstream boundary condition.

There are a few different boundary conditions users can select for the outfall at the 
downstream end:

• A constant user-defined tail water elevation.

• A user-defined water elevation time series (time-elevation curve), such as a tide 
surface elevation time series.

• A user-defined tabular relation between the outfall water elevation and outflow 
discharge (elevation-flow curve), often called as single-valued rating curve or 
simply rating curve.  Sometimes more than one outfall discharges to one receiving 
point; in this situation, the discharge in the rating curve would be the summation 
of all the flows from these discharging pipes.

• A free outfall, which means that the outflow is freely discharged without any 
anticipated backwater effects. In this case, the model automatically applies the 
proper boundary equation, either a normal flow equation or a critical flow equa-
tion, to the outfall boundary based on the dynamic hydraulic condition at the 
boundary. The normal flow equation will be used if the flow is in supercritical 
condition and the critical flow equation will be used if the flow is subcritical.

In the first three cases, the control elevation h at the downstream boundary (outfall) is 
determined from the curves at each time step. It can be replaced by normal or critical 
flow elevations if it falls below those normal or critical elevations.

The dynamic model also supports boundary elements, such as ponds or storage nodes, 
as downstream boundaries even when there are no further outflow outlets from there.  
In this case, a storage equation is used as a boundary condition. If there are no outlets 
from these boundary elements, then these elements are treated as internal regular 
elements.

Internal Boundaries

Along a sewer pipeline, there are hydraulic structures and control devices, such as 
manholes, weirs, and orifices where the flow is often rapidly varied rather then gradu-
ally varied in space. The Saint-Venant equations are not applicable at these locations 
since the gradually varied flow assumption in the Saint-Venant equations derivation is 
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no longer valid. Instead these locations are treated as hydraulic internal boundaries; 
usually alternative empirical internal boundary equations are used for these internal 
local computational reaches (a computational reach is a link between two computa-
tional sections).

Typical internal boundaries are:

• “Manholes and Sewer Junctions” on page 14-746

• “Flow Control Structures” on page 14-748

• “Culverts” on page 14-754

Manholes and Sewer Junctions

Manholes and sewer junctions are the most common internal boundaries.  Hydrauli-
cally they represent significant changes in many properties such as bottom slope, 
boundary roughness, and cross section shape. They may have different vertical and 
horizontal alignments, such as drop manhole or perched manhole.  As a consequence 
of these significant hydraulic property changes, the dynamic hydraulic conditions in 
manholes and junctions are very complicated and modeling these conditions is one of 
the most challenging aspects in sewer dynamic modeling.

Usually a manhole and a junction has a storage area and may have open access to 
ground surface (the user would be able to set a manhole as bolted so that the access to 
the ground is turned off). SewerGEMS’ dynamic model applies a manhole storage 
equation (a form of continuity equation) as one of the internal boundary equations.  
When the water elevation is above the ground rim elevation, additional street storage 
and street flooding may occur. For more information about flooding, see “Flooding” 
on page 14-728.

Related Topics:

• “Junction Headloss Methods” on page 14-746

• “Minor Losses” on page 14-747

• “Flow Control Structures” on page 14-748

• “Culverts” on page 14-754

Junction Headloss Methods

Another internal boundary equation is the energy equation, in which a user selects 
different head loss methods to calculate the head loss in a manhole and a junction:

• Standard loss method - a user-defined loss coefficient is used to calculate the 
head loss based on the velocity head of the exit conduit.
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• Absolute loss method - a user-defined loss amount (in feet) is used as the head 
loss. 

• HEC-22 loss method - a procedure of calculating the junction head loss specified 
in DOT HEC-22 manual is used to calculate the head loss.

• Generic loss method - a user defined loss coefficient is used to calculate the head 
loss based on the velocity head difference between entry and exit conduits.

• “Manholes and Sewer Junctions” on page 14-746

Minor Losses

Minor losses in pressure pipes are caused by localized areas of increased turbulence 
that create a drop in the energy and hydraulic grades at that point in the system. The 
magnitude of these losses is dependent primarily upon the shape of the fitting, which 
directly affects the flow lines in the pipe.

The equation most commonly used for determining the loss in a fitting, valve, meter, 
or other localized component is:

(14.12)

Typical values for the fitting loss coefficient are included in the Fittings Table at the 
end of this chapter.

Generally speaking, more gradual transitions create smoother flow lines and smaller 
headlosses. For example, the figure below shows the effects of a radius on typical pipe 
entrance flow lines.

Where hm = Loss due to the minor loss element (m, ft)

V = Velocity (m/s, ft/s)

g = Gravitational acceleration constant (m/s2, ft/s2)

K = Loss coefficient for the specific fitting

h K
V

gm =
2

2
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• “Manholes and Sewer Junctions” on page 14-746

Flow Control Structures

Flow regulating structures, also known as control structures, are very common in 
storm water drainage systems and in combined sewer systems.  The most common 
control structures are weirs and orifices.

In SewerGEMS V8i, you can attach a weir or orifice at either the upstream end or the 
downstream end of a conduit, or at both ends of the conduit. A control can also have a 
flap gate which allows flow to travel in only one direction.  Hydraulically these 
controls are treated as internal boundaries, i.e., the empirical weir or orifice equations 
are used to replace the momentum equations in the Saint Venant equations and the 
continuity equation is simply that the flow is the same between the upstream face and 
the downstream face of the internal boundary (control structure).

For more information on flow control structures, see:

• “Weirs” on page 14-748

• “Orifices” on page 14-753

• “Rating Curves” on page 14-754

• “Manholes and Sewer Junctions” on page 14-746

Weirs

Weirs are classified by their flow-diversion purpose as either a side weir or a trans-
verse weir, as described in the following definitions:
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• Side weirs or overflow weirs are used to divert extra high flows to overflow 
waterways. Typically a side weir is a weir parallel to the main sewer pipe and with 
enough high crest elevation to prevent any discharge of dry-weather flow, but it is 
also low and long enough to discharge required excess of wet weather flow.  Weirs 
in an outlet of a detention pond can be treated as one of the control elements in the 
composite outlet control structure. Another example of a side weir is the emer-
gency overflow weir or spillway at the top of a detention pond.

• Transverse weirs or inline weirs are typically placed directly cross the sewer pipe, 
perpendicular to the sewer flow and act like a small dam, to direct the low flow, 
usually dry weather flow, to diversion pipe such as dry weather flow interceptor 
sewer pipe.

Weirs are also classified by their cross section shapes, such as rectangular, V-notch, 
trapezoidal, and irregular.  Accordingly the computational equations for the weirs are 
different, the discharge through a rectangular weir is proportional to the 1.5 exponent 
of the head above the weir crest, and the exponent for the V-notch weir becomes 2.5.

Bentley SewerGEMS V8i users need to specify the weir discharge coefficient. Typi-
cally a weir discharge coefficient ranges between 2.65 and 3.10 (English units).  Since 
the weirs in a sewer system are mostly sharp-crested weirs, a value of 3.0 is a common 
default assumption without knowing the weir specifics and hydraulic conditions.  

There are three types of in-line weirs:

• “In-Line (Rectangular) Weir” on page 14-750

• “Trapezoidal Weir” on page 14-751

• “V-Notch (Triangular) Weir” on page 14-752
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In-Line (Rectangular) Weir

The flow is given by:

(14.13)

The weir coefficient can be further given (for weirs stretching across the channel) by:

(14.14)

Where B = weir length, L 

h = effective head, L 

C = weir coefficient 

n = number (0,1,2) of end contractions

Datum

Invert of

Upstream

Node

In-line Weir

Crest

Elevation

No side slope

Structure

Top

Elevation

Weir Length

Q C B n h h= -( )( . ) .0 1 1 5

Q C g b Hv e e= 2
3 2 1 5.
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Trapezoidal Weir

The following illustration assumes that the trapezoidal weir is equivalent to a rectan-
gular channel and a V-notch weir.

Where g = gravity

be = effective width (essentially the width)

He = effective head (essentially the head)

Cv = 0.602 + 0.075 h/p  for full width weir
0.587 - 0.023 h/p   for fully contracted weir

where 
p = depth of weir crest above channel bottom
h = head

Trapezoidal Weirs
Weir

Length

Structure
Top
Elevation

Side
Slope

Crest
Elevation

Datum

1
z
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V-Notch (Triangular) Weir

The parameter, Θ, must be given in degrees (not radians). The flow for a V-notch weir 
is given by:

(14.15)

(14.16)

Elevations for weirs must be specified relative to the datum for the problem, not the 
invert of the channel. In general:

Invert elevation < Crest Elevation < Structure Top Elevation

Where h = head above weir crest, L 

Where Cv = 0.58 for fully contracted weirs with h > 1.2p 

C = approximately 1.4 for SI units and 2.5 for U.S. 
customary units

Triangular Weirs (V-notch) No Side Slope
No Crest Length

Invert of
Upstream
Node

Crest
Elevation

Datum

Structure
Top
Elevation

0

Q C h= tan( / ) .q 2 2 5

C gCv= ( )8
15 2
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Orifices

Orifices are usually circular or rectangular openings in the wall of a tank or in a plate 
normal to the axis of the conduit.  Orifices can be oriented in a variety of ways, such 
as side outlet or bottom outlet.  SewerGEMS V8i can also treat an orifice as one of the 
controlling elements in a detention pond composite control structure; other controlling 
elements within a composite control structure include weirs, risers and culverts. 

Orifices are treated the same as weirs to be internal boundaries except that the flow 
equation of an orifice is used to calculate the discharge.  There are different flow 
conditions in an orifice and the calculation of the discharge through the orifice is 
different:

• The discharge through the orifice is proportional to the 0.5 exponent of the head if 
the orifice is fully submerged.

• A weir equation is usually used for unnumbered conditions of the orifice.

• Special treatment is necessary for a smooth transition between unsubmerged and 
submerged conditions due to the calculating equation switch.

The orifice discharge coefficients typically range between 0.6 and 0.7 (English units).  
Without knowing the orifice specifics, a default value of 0.65 is commonly used.

Datum

Profile view of all weirs

Crest

Elevation

Structure

Top

Elevation
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Rating Curves

Another generic control structure can be a rating curve in which a tabular relationship 
of discharge and head (or elevation) for the structure is prepared offline in advance by 
the user, then assigned to a weir or orifice by simply specifying that a rating curve is 
used. In this case, the model uses this rating curve to calculate the discharge at any 
time base on the dynamic head. 

In general, a rating curve table can be used for any internal control structure to repre-
sent its flow-head relationship if there are no anticipated backwater effects. A single-
valued-rating-curve can not be used in cases where there are backwater effects since 
the rating curves assumes no such backwater effects.

Culverts

Culverts are common hydraulic elements in a sewer system. There can be stand-alone 
culverts under highway embankments or conduit vaults in detention pond outlet struc-
tures.  In SewerGEMS V8i, a culvert can be a conduit specified as a culvert or one of 
controlling elements in a composite control structure.  Since a culvert is a type of 
hydraulic structure that transports water as full or partially full, culvert hydraulics is 
more complicated than other control structures. 

Hydraulically a culvert can be under inlet control or outlet control conditions. The 
computational procedures for these conditions are very different:

• Inlet control - A culvert is under inlet control if the culvert barrel hydraulic 
capacity is higher than that of the inlet (entrance) and there is no backwater from 
downstream. In this condition, the relationship of flow and headwater is mainly 
dependent on the inlet configurations.

• Outlet control - A culvert is under outlet control when the culvert barrel is not 
capable of conveying as much flow as the inlet opening will accept.  When the 
culvert is under outlet control, the flow will depend not only on the headwater but 
also the tailwater.

• EQT curves - Dynamic culvert conditions are complicated in that the flow can 
change from inlet control to outlet control or vice versa. As a result of this 
complexity, the computation of culverts can be tedious. In SewerGEMS V8i, a 
sophisticated procedure has been developed to build up a comprehensive EQT 
data set for any culvert configuration. The EQT represents the headwater (E), flow 
(Q), and tailwater (T) tabular curves in the way it covers all possible operating 
ranges of the headwater and tailwater so that any hydraulic conditions are 
accounted for by the EQT. The SewerGEMS V8i dynamic engine builds the EQT 
for every culvert and uses the EQT for culvert computation dynamically at any 
time step. 

• “Manholes and Sewer Junctions” on page 14-746
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Dynamic Storage Routing
Pond outflow is determined by the types of pond outlet structures which are associated 
with a given pond. The pond outlet can simply represent a connection point between 
the pond and a downstream conduit, or a more complex composite outlet structure.

The composite outlet structure at a pond outlet is a parallel set of outlet components 
which empty into the pond outlet's downstream link.

Composite outlets consist of the following types of structures:

• “Riser Structures” on page 14-755 

• “Orifices” on page 14-757 

• “Weirs” on page 14-759

Riser Structures

Risers are represented as a single opening at some elevation above the invert of the 
pond. The flow from the riser is then controlled by the flow through the downstream 
conduit of the pond outlet with which the riser is associated.

A riser can be represented as either a stand pipe or a inlet box. The only distinction 
between the two is essentially the open area and perimeter of the opening. In other 
words, the area and perimeter for a stand pipe are determined from the input diameter, 
while the area and perimeter for an inlet box are input directly. 

Flow Stages on a Riser

As water rises in a pond the riser structure will exhibit three distinct flow stages:

• “Weir Stage” on page 14-755

• “Orifice Stage” on page 14-756

• “Full Riser Barrel Flow Stage” on page 14-756

Weir Stage

As the pond stage begins to go over the riser crest elevation, flow into the riser acts 
like a weir with the perimeter of the opening being the weir length. The following 
equation dictates the flow into the riser for low pond stages relative to the crest eleva-
tion.

(14.17)
Q C L H= * * /3 2
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Orifice Stage

As the pond stage rises relative the crest elevation, the riser will then act like an 
orifice, and the flow is defined by the following equation.

(14.18)

Note: For the type of orifices found in most ponds, C = 0.6.

A Note on Weir to Orifice Transition

The transition between the weir and orifice flow hydraulics is a turbulent transition 
which is computationally abrupt.  To enhance convergence characteristics, Bentley 
SewerGEMS V8i supports the formulation of a weir to orifice transition zone. You can 
specify a hydraulic transition zone height which is (by default) centered about the 
theoretical transition point. Over this transition range, Bentley SewerGEMS V8i will 
linearly interpolate the stand pipe flow between the lower transition elevation at which 
weir flow governs to the upper transition elevation at which orifice flow governs.

Full Riser Barrel Flow Stage

Whenever the downstream conduit is undersized with respect to the standpipe 
capacity, full riser barrel flow will occur if the pond water surface elevation rises high 
enough. In these cases, the program assumes a negligible loss through the riser barrel 
and sets the riser flow equal to the downstream conduit flow rate.

If there are other orifices (perforations), slots (weirs), etc, flowing into the riser or 
inlet box, their flow rates are set equal to zero since the upstream elevation (pond 
water surface) and downstream elevation (inlet box headwater elevation) are identical 
(i.e., drop in head equals zero across these elements).

Where C = weir coefficient (US, SI forms)

L = effective weir length

H = depth of flow at the standpipe crest (ft, m)

Where C = contraction and energy loss coefficient

A = effective orifice area (sq. ft, sq. m)

g = acceleration due to gravity

H = orifice head (ft, m)

Q C A gH= * * ( )2
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A Note on Perforations and Slots in Risers

If components of a particular composite outlet structure contains a riser structure in 
addition to orifice and weirs with elevations lower then the crest elevation riser, then 
Bentley SewerGEMS V8i treats the orifices and weirs as perforations and slots in the 
riser structure, and calculates the overall composite structure accordingly.

Orifices

There are two types of orifices that are associated with a pond outlet’s complex outlet 
structure: 

• Circular

• Orifice area

Both structures are defined by behaviors when submerged and unsubmerged. 

Submerged Orifice Hydraulics

When the orifice is submerged, the flow is defined by the following equation for both 
orifice types:

(14.19)

The orifice head, H, is measured as the difference between the water surface elevation 
and the greater of the center elevation of the circular orifice or the controlling tail-
water elevation.

By inspection it can be seen that the equation is mathematically invalid whenever H is 
less than zero (i.e., the water surface is below the centroid during unsubmerged condi-
tions).

Also, for the equation to be applied correctly, assume that the flow area must be fully 
submerged.

Where C = contraction and energy loss coefficient

A = effective orifice area (sq. ft, sq. m)

g = acceleration due to gravity

H = orifice head (ft, m)

Q C A gH= * * ( )2
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Circular Unsubmerged Hydraulics

To develop a continuous discharge rating relation for an orifice structure, it is neces-
sary to handle flow situations in which the orifice opening is not fully submerged.

For circular orifices, Bentley SewerGEMS V8i models partially submerged orifices 
by balancing specific energy across the culvert opening. This is implemented in the 
program by assuming a thin culvert (L = 0.002 ft). This approach makes friction 
conditions negligible.  The inlet loss, Ke, is calibrated so that it matches the results of 
the orifice flow at the "just submerged" elevation.

Orifice Area Unsubmerged Hydraulics

To develop a continuous discharge rating relation for an orifice structure, it is neces-
sary to handle flow situations in which the orifice opening is not fully submerged. For 
area-based orifice calculations, Bentley SewerGEMS V8i performs a straightline 
interpolation, setting the flow by multiplying the full flow, Qt, (at unsubmerged head, 
Ht) by the ratio of actual H to Ht.

(14.20)

Heads are measured from the opening invert or from the controlling tailwater, which-
ever is greater.

Orifice Orientation

Bentley SewerGEMS V8i supports modeling area-based orifice openings which are 
aligned horizontally and vertically, expressed as oriented parallel or perpendicular to 
flow direction, respectively. Orifices which are oriented parallel to flow do not require 
a datum input (since it is assumed to be equal to the opening invert).

In Bentley SewerGEMS V8i, circular orifices are all oriented perpendicular to flow. 
To model an opening oriented parallel with flow, use the Orifice-Area option, or a 
Stand Pipe.

Where Qu = unsubmerged discharge

Qt = full discharge at Ht

Hu = unsubmerged head

Ht = height of the orifice opening

Q Q H Hu t u t= * /
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Weirs

Weirs associated with pond outlets can be one of three types:

• “Rectangular Weirs” on page 14-759

• “V-Notch Weirs” on page 14-760

• “Irregular Weirs” on page 14-760

Rectangular Weirs

In Bentley SewerGEMS V8i, a rectangular weir is characterized by two equations: 
suppressed and contracted.

Suppressed weirs prevent the contraction of the flow through the weir and hence the 
associated losses. These types of weirs are usually, but not solely, associated with 
broad crested weirs, and are defined by the following equation:

(14.21)

Flow over a contracted weir does contract as it goes over the crest of the weir. These 
types of weirs are often associated with the sharp crested types of weirs, and are 
defined by the following equation:

(14.22)

Where Q = flow (cfs, cms)

C = weir coefficient (US, SI forms)

L = length (ft, m)

H = head (ft, m)

Where Q = flow (cfs, cms)

C = weir coefficient (US, SI forms)

L = length (ft, m)

H = head (ft, m)

Q C L H= * * /3 2

Q C L H H= −*( . )* /0 2 3 2
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V-Notch Weirs

V-Notch weirs are defined in Bentley SewerGEMS V8i by the following equation:

(14.23)

H is measured from the water level to the bottom crest of the weir.

Irregular Weirs

Whenever the culvert headwater begins to rise above the minimum elevation of the 
roadway, overtopping will occur. The weir x-y structure can be used to model overtop-
ping.

Overtopping flow is modeled as a special type of weir flow expressed by the general 
broad-crested weir equation.

Note: Do not use the irregular structure to model an overflow channel. 
The equations which define the irregular weir are different then 
channel equations and would result in significantly different 
flows.

Broad-Crested Weir

A broad-crested weir has a crest that extends horizontally in the direction of flow far 
enough to support the nappe (sheet of water flowing over the crest of the weir) so that 
hydrostatic pressures are fully developed for at least some short distance.

In order to model Embankment or Roadway overtopping, the Federal Highway 
Administration (FHWA) has developed a methodology that can be found in the 
manual FHWA, HDS No. 5, Hydraulic Design of Highway Culverts, 1985, which uses 
the general broad-crested weir equation.

(14.24)

Where Q = flow (cfs, cms)

C = coefficient of discharge (US, SI forms)

g = gravitational constant

è = angle of notch (degrees)

H = head above the bottom of the notch (ft, m)

Q C g H= *( / )* ( ) * tan( / )* /8 15 2 2 5 2θ

Q C LHd r= 3 2
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Figure 14-23: Broad-Crested Weir

The overtopping discharge coefficient Cd is a function of the submergence using the 
equation:

(14.25)

The variables Kt and Cr are defined in the following figures, reproduced from the 
manual FHWA, HDS No.5, Hydraulic Design of Highway Culverts, 1985. The first 
two figures are used by Bentley SewerGEMS V8i to derive the base weir coefficient 
Cr resulting from deep and shallow overtopping, respectively. The submergence 
correction Kt is determined implicitly using the third figure.

Where Q = Discharge over weir (m3/sec., ft3/sec.)

Cd = Weir coefficient

L = Length of roadway crest (m, ft)

Hr = Overtopping depth (m, ft)

H

L

h

r

tr

C K Cd t r=
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Figure 14-24: Discharge Coefficient Cr, for Hr/L > 0.15

Figure 14-25: Discharge Coefficient Cr, for Hr/L ≤ 0.15
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Figure 14-26: Submergence Factor, k

Pumps

Pump Station Configuration

A single pump station icon in the program represents a collection of individual pumps  
arranged in parallel with a single source element, which is defined at the pump. The 
pumps then can be staggered on and off based on the HGL/water surface elevation at 
the source node.

The source element can either be a pressure pipe or a source node such as a wet well, 
manhole, or pond, etc. Intuitively, if the source element for the pump station is a pipe, 
then the HGL of the node on the upstream end of the pipe will dictate the behavior of 
the pump.

Each pump in the pump station is defined by a pump definition (the pump curve), an 
initial status (on or off), and the conditions by which the pump turns on and off during 
the simulation.

Pump Definition Types

There are four types of pump definitions in Bentley SewerGEMS V8i. These are 
described below.
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Type I - Volume Discharge Rating

This pump definition type is best suited for pumps which have either wet wells or 
ponds as the source element. The curve relates the volume of the source element to the 
outflow of the pump station. As the volume increases, the discharge increases.

Type II - Elevation Discharge Rating

This pump definition type simply relates the depth of flow of the source element to the 
outflow of the pump. As the depth increase, the discharge increases incrementally.

Type III -Declining Head Curve (Depth Discharge Rating

This is the most standard pump definition type. It relates the head difference between 
the upstream and downstream nodes to the discharge of the pump. As the head differ-
ence increases, the amount of discharge decreases. 

Type IV - Variable Speed Pump

This pump definition type also relates the depth of the source node to the discharge of 
the pump. As the depth increases, the discharge increases continuously.

Storage Elements

This section describes how the following volume/storage elements in Bentley Sewer-
GEMS V8i are defined:

• “Wet Wells” on page 14-764

• “Ponds” on page 14-765

• “Catch Basins, Manholes, and Surface Storage” on page 14-766

Wet Wells

The Wet Well volume can be determined by one of three ways:

• Depth-Area curve

• Constant area

• Area function

Depth-Area Curve

This option allows for the modeling of an irregular shaped volume associated with the 
wet well. The curve is then translated to volumes using conic sections. 
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Constant Area

Sets up the volume using with a constant cross sectional area. The volume is analo-
gous to a cylinder.

Area Function

The Area is determined based on the following function which calculates the surface 
area for a given depth.

(14.26)

Ponds

Pond volumes are defined one of four ways:

• Elevation-Area Curve

• Elevation-Volume Curve

• Functional

• Pipe Volume

Elevation-Area Curve

Volumes are typically defined as a series of Elevation-Area points, which are easily 
pulled from the contour map. The simulation then computes the volumes based on the 
changes in area between two elevations.

Where Area = surface Area at given depth

Coeff = user input value which is derived from existing 
area data

Depth = distance from the invert of the pond

Exp = user input value which is derived from existing 
area data

Constant = the area at the bottom of the pond and is a user 
input value

*Area Coeff DepthExp Constant= +
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Elevation-Volume Curve

This option defines the volume directly by a series of elevation volume points.  This 
allows for more complex storage structures that don't lend themselves to an Elevation-
Area curve.  If for example you have a fill, or obstructions in the pond you can enter 
the volume directly without having to work out adjustments to the areas.

Functional

The volume is determined based on the following function which calculates the 
surface area for a given depth.

(14.27)

Pipe Volume

The Pipe Volume option supports modeling horizontal, vertical, or sloped pipes. Typi-
cally, the upsized pipes are significantly larger than would be required to simply 
convey the runoff from the site. For this reason upsized pipes will be terminated by an 
orifice or small diameter pipe stub which will provide the necessary peak discharge 
control.

The Pipe option automatically generates the cumulative volume rating table needed 
for the simulation. It should be emphasized that in upsized pipe systems the assump-
tion is that the water surface elevation in the upsized pipe is taken to be level. This 
means that inflow into the upstream end of the pipe is immediately translated to the 
downstream end of the pipe - the standard detention routing assumption.

Catch Basins, Manholes, and Surface Storage

In addition to the negligible volumes assigned to manholes and catch basin structures, 
you can define the surface storage volumes above the structure's rim elevation.

Where Area = Surface Area at given depth

Coeff = User input value which is derived from existing 
volume data

Depth = Distance from the invert of the pond

Exp = User input value which is derived from existing 
volume data

Constant = The area at the bottom of the pond and is a user 
input value

*Area Coeff DepthExp Constant= +
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The surface storage can be defined one of four ways:

• No Storage - When this option is selected the HGL at the element is determined 
based solely on hydraulics.

• Default Storage Equation - The surface volume above the rim is automatically 
established by the engine by extrapolating from the rim elevation.  

• Area (Constant Surface) - The volume above the rim elevation is based on a 
volume with a constant surface area.

• Surface Depth-Area Curve - The surface volume is defined by a depth-area 
curve where the volume is determined with conic sections.

Surface (Gutter) System
Storm sewer systems are typically designed and constructed for smaller, more 
frequent storms. Runoff from large, less frequent events is usually not entirely 
conveyed by storm sewers; rather, it flows over the land surface in roadways and in 
natural and constructed open channels.  Therefore storm sewer conveyance networks 
and surface gutter drainage and conveyance networks are integrated into a whole 
urban storm sewer infrastructure system.  SewerGEMS V8i is capable of modeling a 
complete integrated subsurface storm sewer and surface gutter (channel) drainage 
system.

Gutter System Hydraulics

Stormwater from runoff enters the subsurface sewer conveyance system through catch 
basin inlets in roadway gutters, parking lots, depressions, ditches, and other locations, 
and often not all runoff water from the catch basin enters the inlet and additional water 
flows in gutters further downstream.  There are a few hydraulic aspects to be consid-
ered in order to properly model the catch basin-inlet-gutter subsystem:

• Inlets are designed to have certain drainage capacities, and these capacities play 
an important role in the interaction between sewer subsystems and gutter 
subsystems. There are well-established design procedures to design inlets based 
on the design storm event.  Once an inlet is set with specific dimensions, its 
capacity or hydraulic performance is known.  In a SewerGEMS V8i model, this 
Bentley SewerGEMS V8i User’s Guide 14-767



Hydrology
would be a user input. It can be an inlet capacity rating curve, in which a tabular 
relationship between total catch basin drainage flow and the inlet captured flow is 
presented, or a maximum inlet capacity flow amount.  The model dynamically 
determines the inlet flow.

• When the inlet capacity is set, the excess water above its capacity will flow in the 
gutter to a downstream point.  The gutter can also represent an open channel. 
SewerGEMS V8i lets the user specify the gutter cross section just like an open 
channel; it can be a trapezoidal or generic irregular section, and the user would 
also specify its Manning’s friction coefficient. 

Fundamental Solution of the Gutter System

The SewerGEMS V8i model simulates the gutter subsurface flows using diffusion 
routing algorithms. A nonlinear Muskingum-Cunge routing method is used to route 
the flows in gutters and the Manning’s equation is used to compute water depths in the 
gutters. 

An inlet receives both runoff flow from the catch basin and flows from gutters.  Since 
it is an open pathway to subsurface sewers, it is possible that the subsurface sewers 
can become pressurized and as the overloaded flow increases and sewer water eleva-
tion rises above the inlet elevation so that "street flood" or "overflow" occurs in which 
water flows from the subsurface sewer to the ground through the manhole and the 
inlet.  Under this condition, the water also finds its way to gutters and flows down-
stream if there is a gutter connected to the catch basin. This reverse interaction 
between subsurface sewer and surface gutter is also properly modeled by Sewer-
GEMS V8i model.  Therefore a gutter can carry excessive flow from an inlet or over-
flow from a catch basin.

There is a difference between a gutter as a surface drainage network and an open 
channel as part of a sewer network in a SewerGEMS V8i model.  A gutter (or channel) 
in a surface network is always associated with a catch basin inlet and the main source 
of its flow comes from the excess water of the inlet or the overflow from the over-
charged sewer catch basin. On the other hand, an open channel can be a part of the 
subsurface sewer system and a channel can be directly linked to a conduit.

Hydrology
Hydrologic theory gives you a behind-the-scenes look at what the SewerGEMS V8i 
software is using to manipulate the data you enter.

• “Rainfall” on page 14-769

• “Time of Concentration” on page 14-787

• “Rational Method” on page 14-794
14-768 Bentley SewerGEMS V8i User’s Guide



Theory
• “SCS CN Runoff Equation” on page 14-797

• “SCS Peak Discharge” on page 14-803

• “Hydrograph Methods” on page 14-807

Rainfall

SewerGEMS V8i considers rainfall in terms of:

• “Design Storms” on page 14-769

• “I-D-F Data” on page 14-770

• “Rainfall Curves” on page 14-773

Design Storms

SewerGEMS V8i design storms include:

• Rational design storms

• Cumulative rainfall curve storms

Rational Design Storms

Design storms for use with the Rational method can be created with one of two 
methods.

• The I-D-F table method uses a table of duration versus intensity values to describe 
rainfall events of a particular frequency (return period).

• The e, b, d coefficients method uses a collection of three coefficients (e, b, d) to 
define a mathematical relationship between the rainfall intensity and the duration 
of the rainfall event for a given frequency.

Both methods yield the equivalent of a rainfall I-D-F curve, and therefore must be 
created for use in a particular geographic location.

Cumulative Rainfall Curve Storms

Hydrograph methods, such as the SCS Unit Hydrograph procedure, cannot use I-D-F 
curves for rainfall data (as used in the Rational method). Instead, complex hydrograph 
methods require time-based rainfall curves. Design storms for use with the 
hydrograph methods (e.g., SCS Unit Hydrograph) can be created with one of two 
methods: time-depth or synthetic.
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Time-depth: The time-depth curve method uses a table of time 
versus rainfall depth values to describe the rainfall 
event. This method is typically used when gauged 
data from actual storm events is available.

Synthetic: The synthetic curve method uses a table of time 
versus rainfall depth fraction values, a duration 
multiplier, and a total rainfall depth to describe the 
rainfall event. This arrangement is very flexible 
because the same rainfall event shape can be used for 
storms of various durations and total depth.

I-D-F Data

Intensity-duration-frequency (I-D-F) data includes:

• “I-D-F Curves” on page 14-770

• “I-D-F Tables” on page 14-772

• “I-D-F e, b, d Equation” on page 14-772

I-D-F Curves

Note: The rainfall intensities that are used with the Rational method 
are generally determined by regulatory agencies. Historical 
rainfall information is analyzed and compiled into I-D-F curves 
based on the frequency of the storm events. These curves give 
the engineer a quick reference to determine the intensity of 
rainfall that occurs at given return periods.

I-D-F (Intensity-Duration-Frequency) curves provide the engineer with a way of 
determining the rainfall intensity for a given storm frequency and duration.
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Reading an I-D-F Curve

For example, a 5-year frequency, the resulting average intensity is 5 inches an hour for 
12 minutes. In other words, if an average intensity of 5 inches/hour falls for a period 
lasting 12 minutes, it would be considered a 5-year event.

Figure 14-27: I-D-F Curve
Bentley SewerGEMS V8i User’s Guide 14-771



Hydrology
I-D-F Tables

SewerGEMS V8i lets you enter I-D-F data into a table and saves the data so you may 
use it again for other projects. Entering the design intensities is a very simple process 
of looking up data from a graph and entering it into the I-D-F Table.

I-D-F e, b, d Equation

I-D-F curves can be fit to equations. The most common form of these equations is:

(14.28)

Where I = rainfall intensity (in/hr.)

T = rainfall duration (min.)

e, b, d = rainfall equation coefficients

i b

T d+( )e
--------------------=
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This equation represents the mathematical relationship between the rainfall intensity 
and the rainfall duration for a storm of a given frequency and a given geographical 
location. The rainfall equation coefficients vary with storm event frequency and storm 
event location.

To use rainfall equations properly requires that they yield results that are consistent 
with the historical rainfall data for the design locale. If the preceding equation does 
not provide such consistency, then it is not appropriate for your design.

Rainfall Curves

Rainfall curves fall into two categories:

• “Gauged (Time versus Depth)” on page 14-773

• “Synthetic Rainfall Distributions” on page 14-777

Gauged (Time versus Depth)

A rainfall curve is the measure of total rainfall depth as it varies throughout a gauged 
storm. A good way to understand a rainfall curve is to visualize the Y-axis as a rainfall 
gauge (see “Gauged Rainfall Event” on page 14-774). As the storm progresses, the 
gauge begins to fill. The curve describes the gauged rainfall depth at each point during 
the storm.

A steeper slope on the curve indicates the gauge is filling faster than it would for a 
less-steep curve; hence, the rate of rainfall is more intense. The most intense portion 
of the storm occurs between 0.1 and 0.2 hours and again between 0.5 and 0.6 hours 
(about 0.6 inches over 0.1 hour = 6 inches-per-hour intensity).
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Figure 14-28: Gauged Rainfall Event

Rainfall curves are a mathematical means for simulating different storms. The next 
figure, “Conditions for Two Storms” on page 14-775, shows conditions for two types 
of storms. The other two (“Comparison of Two Storms” on page 14-775 and “Hydro-
graphs for Two Storms” on page 14-776)display dramatic differences between these 
two rainfall events, even though the total depth and volume are the same for each 
storm.
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Figure 14-29: Conditions for Two Storms

Figure 14-30: Comparison of Two Storms
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Figure 14-31: Hydrographs for Two Storms

Rainfall Tables

Rainfall hydrographs can be represented by tables. The table relates the cumulative 
rainfall depth to the time from the beginning of a storm. The following table is an 
example of a time versus depth rainfall table developed from data taken from a 
recording rain gauge.

Table 14-1: Time versus Depth 

Time (hr.) Accumulated 
Rainfall (in)

0.0 0.00

0.3 0.37

0.6 0.87

0.9 1.40

1.2 1.89
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Synthetic Rainfall Distributions

In most cases, drainage engineers design facilities for future rainfall events (not actual 
gauged storms). Rainfall distributions provide a way to model statistically predicted 
events of various magnitudes. These distributions are sometimes referred to as 
synthetic storms, since they are not actual gauged events.

1.5 2.24

1.8 2.48

2.1 2.63

2.4 2.70

2.7 2.70

3.0 2.70

3.3 2.71

3.6 2.77

3.9 2.91

4.2 3.20

4.5 3.62

4.8 4.08

5.1x 4.43

5.4 4.70

5.7 4.90

6.0 5.00

Table 14-1: Time versus Depth  (Cont’d)

Time (hr.) Accumulated 
Rainfall (in)
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Rainfall distributions fall into two categories:

• Dimensionless Depth—The Y-axis for these distributions range from 0.0 to 1.0 
(0% to 100%) of total rainfall depth. The total storm duration is defined on the X-
axis, in units of time. 

• Dimensionless Depth and Time—These are similar to dimensionless depth 
curves, except that the X-axis is also dimensionless.

Dimensionless Depth: SCS Distributions

The SCS 24-hr. rainfall distributions are classic examples of dimensionless depth rain-
fall distributions. The Y-axis is dimensionless so that different rainfall depths can be 
applied to the distributions to create rainfall curves for various storm magnitudes and 
geographic locations.

The following figure displays four SCS distributions used in the United States (Types 
I, IA, II, and III).

Figure 14-32: 24-Hour Rainfall Distributions
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The approximate geographic boundaries for these rainfall distributions are shown 
below.

Figure 14-33: Approximate Boundaries

TYPE  I

TYPE  III

TYPE  II

TYPE  IA

TYPE  I

TYPE  I

TYPE  IA

TYPE  II

TYPE  III

TYPE  III
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Modeling Storms with SCS Distributions

To create a design rainfall curve, multiply the Y-axis by the 24-hour total rainfall 
depth. The following figure shows what each distribution looks like when applied to a 
24-hour total depth of 3.1 inches. Differences in storm magnitude and geographic 
variations can be modeled by changing the total rainfall depth on the Y-axis.

Figure 14-34: SCS Distribution, 24-Hour P = 3.1 in.

Dimensionless Depth and Time

These rainfall curve distributions are typically developed based on statistical analyses 
of storm events for different durations. When developed properly for a specific loca-
tion, these types of rainfall distributions provide the flexibility of modeling a variety 
of storms other than the standard 24-hour event.

The basic philosophy of this approach is that longer-duration storms are expected to 
behave differently than shorter-duration storms. For example, the most intense portion 
of a 24-hour storm is expected to differ from the most intense portion of a 1-hour 
storm.
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Typically, these types of curves are dimensionless on both the X and Y axes, so they 
can be applied to a wide range of durations and rainfall depths. The following graph 
displays dimensionless rainfall curves established for different ranges of durations. To 
create a rainfall depth curve, select the curve for the desired duration. Then, multiply 
the X-axis by total storm duration and multiply the Y-axis by the total rainfall depth 
for that given duration.

Figure 14-35: Dimensionless Time and Depth Curve

Example: Dimensionless Time and Depth Curves

Statistical analyses were performed using updated rainfall information for a 
certain geographic location in the United States. This study yielded the statistical 
distributions shown in the figure below. 

Given: A 10 year return event for a certain area has the 
following total rainfall depths corresponding to 
various durations:

• 1 hr. P = 2.11 in.

• 6 hr. P = 3.37 in.

• 12 hr. P = 3.91 in.

• 18 hr. P = 4.13 in.
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• 24 hr. P = 4.49 in.

Find: Rainfall curves (time versus depth) for the 1-, 6-, 
12-, 18-, and 24-hour durations, using the statistically 
derived distributions in the following figure.

Solution: First, select the distribution that corresponds to each 
desired duration. Then multiply the Y-axis by the 
total rainfall depth for that duration and the X-axis by 
that duration.

Figure 14-36: Solution to Example

The figure displays the results of this example. Different curve types (A, B and C 
from the previous graph) were used to model different duration storms. Note how 
the total depth increases, but overall intensity (slope of the curve) decreases as the 
duration is lengthened.
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Synthetic Rainfall Tables

A synthetic rainfall curve is a plot of rainfall depth versus time that can be used in lieu 
of actual rainfall event data. A synthetic rainfall distribution is useful because it incor-
porates maximum rainfall intensities for a given event frequency arranged in a 
sequence that produces peak runoff. Therefore, a single rainfall distribution can be 
used to determine peak runoff rates for watersheds of various sizes and times of 
concentration.

Bulletins 70/71

The following sections describe the use of the data used in rainfall tables:

• “Rainfall Time-Distribution Information” on page 14-783

• “Watershed Area” on page 14-783

• “Rainfall Duration” on page 14-784

• “Data Sources” on page 14-784

• “Data Format” on page 14-785

• “Bulletin 70/71 Data” on page 14-786

• “Circular 173 Data” on page 14-786

Rainfall Time-Distribution Information

Illinois State Water Survey Bulletin 70 and Bulletin 71 and Circular 173 data contains 
synthetic rainfall time-distribution curves for heavy rainstorms in the Midwestern 
United States. This information comes from Circular 173 (Huff 1990). Rainfall time-
distribution curves are used for runoff computations related to the design and opera-
tion of runoff control structures.

Time-distribution curves are divided into four categories, corresponding to first-, 
second-, third- and fourth-quartile storms. Time distributions are represented as cumu-
lative fractions of the storm rainfall depth and the storm duration.

The Bulletin 70/71 data contains median (exceedance probability of 50%) curves. The 
Circular 173 data gives the curves for exceedance probabilities of 10% and 90%.

Watershed Area

Time-distribution curves vary with the watershed area. Three time distribution types 
have been presented here depending on the watershed size:

• point distributions (area from 0 to 10 square miles)
Bentley SewerGEMS V8i User’s Guide 14-783



Hydrology
• intermediate distributions (area from 10 to 50 square miles)

• area average distributions (area from 50 to 400 square miles)

The curves presented here are applicable only for relatively small watersheds (area 
less than or equal to 400 square miles).

Rainfall Duration

Storms with durations of 6 hours or less tend to be associated more often with first-
quartile distributions, and those lasting more than 6 hours and less than or equal to 12 
hours are most commonly the second-quartile type. Storms having durations longer 
than 12 and less than or equal to 24 hours most commonly follow the third-quartile 
distribution. Storms with a duration longer than 24 hours are most frequently associ-
ated with the fourth-quartile distributions. However, a particular storm from any dura-
tion may be associated with any of the four quartile types.

We recommend the use of the most common quartile for the design storms. A design 
storm with a duration less than or equal to 6 hours should be a first-quartile type 
storm. The second quartile type design storms should be used for durations longer 
than 6 and up to 12 hours. For storms longer than 12 hours in duration and less than or 
equal to 24 hours, we recommend the use of the third-quartile time distribution. 
Finally, design storms longer in duration than 24 hours should be modeled using the 
fourth quartile type.

Data Sources

The rainfall time-distribution data given here are obtained from Circular 173 (Huff 
1990). Wherever the tabular data was available in Circular 173 it was used to develop 
rainfall tables. However, tabular data in Circular 173 is given only for every 5% of the 
time distribution. The tables available in the engineering catalogs give data for every 
1% of the rainfall time duration. The data in between tabular values have been 
obtained from the figures in Circular 173. Due to the interpolation procedure used to 
develop graphs, a slight discordance between tables and figures occurs in the tails of 
the distributions. Where this was the case, higher precedence was given to the tabular 
data.

Additional differences between the data presented here and the Circular 173 tables 
comes from the precision used in Circular 173. While Circular 173 rounds the data to 
the first 1%, the data presented in the Bentley SewerGEMS V8i engineering libraries 
has a precision of 0.01%. However, due to the statistical nature of the data presented, 
these differences are negligible.
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Data Format

Data presented here is reported in dimensionless (fractional) distributions both in time 
and rainfall depth space. The temporal axes starts at 0.0 and ends at 1.0 with a time 
step of 0.01. Duration Multipliers should be used in SewerGEMS V8i to convert the 
dimensionless time to the desired rainstorm duration.

Quartile distributions are identified using the following notation:

• 1stQ—the first quartile time distribution

• 2ndQ—the second quartile time distribution

• 3rdQ—the third quartile time distribution

• 4thQ—the fourth quartile time distribution

Watershed area ranges are identified using the following notation:

• 00-10—point distributions (0 to 10 square miles)

• 10-50—intermediate distributions (10 to 50 square miles)

• 50-400—area distributions (50 to 400 square miles)

Exceedance probabilities are identified using the following notation:

• 50%—median distributions (for design storms)

• 10% - 90%—exceedance distributions (for analysis storms)

• 90% - 10%—exceedance distributions (for analysis storms)
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Bulletin 70/71 Data

The Bulletin 70/71 tables contain the median (exceedance probability of 50%) time 
distribution curves. Median distribution curves represent the most common rainfall 
types and should be used for design purposes. Median temporal distribution curves are 
given for point distributions, intermediate distributions, and areal distributions 
containing all four distribution types.

Circular 173 Data

The Circular 173 (Huff 1990) tables contain the 10% and 90% exceedance probability 
time-distribution curves. These curves could be used for the analysis of extreme cases 
(what-if scenarios). These temporal distribution curves are given for point distribu-
tions and areal distributions, containing all four distribution types.

Rainfall Curves: Build from I-D-F Data

Intensity-Duration-Frequency (I-D-F) data can be used to build center peaking rainfall 
curves for any duration contained within that I-D-F curve.

The total rainfall depth is computed by multiplying the intensity corresponding to the 
desired storm duration and the duration. For example, the total depth for a 5 hour 
storm whose intensity (found from the I-D-F curve) is 0.469 in./hr. is 2.345 in. This 
total depth is then temporally distributed throughout the duration of the storm 
according to a center peaking pattern. The center peaking storm pattern dictates that 
the most intense portion of the storm is during the middle of the storm, and that the 
beginning and end of the storm are less intense.
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Time of Concentration

The time of concentration (Tc) is found by summing the time for each individual flow 
segment within the drainage area. Both single and multiple flow segments are 
modeled with the Tc calculator.

Figure 14-37: The General Equation for Tc

(14.29)

(14.30)

Where Tc = Total time of concentration

Ti = Flow travel time through segment i

Where Li = Length of flow segment i

Vi = Average velocity through segment i

Tc Ti
n

i 1=

∑=

Ti
Li
Vi
-----=
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The Tc equations provided in Bentley SewerGEMS V8i can be categorized into two 
broad categories:

• Equations that solve for velocity, then use velocity to solve for the travel time 
through a flow segment

• Equations that directly solve for the travel time through a flow segment—in these 
cases, Bentley SewerGEMS V8i back solves for velocity and includes it in the 
output report

Note: Some types of Tc equations can apply to flow segments within a 
multiple-segment Tc calculation (see preceding diagram). Other 
Tc methods are equations intended to model the entire average 
subarea flow distance and slope in one single flow segment. 
When combining multiple flow segments to compute Tc, it is up 
to you to only combine Tc methods that can be modeled in 
combination with multiple flow segments.

There are 13 different methods for computing the time for an individual flow segment. 
Each of the 13 methods has different data input requirements:

• “User-Defined” on page 14-789

• “Carter” on page 14-789

• “Eagleson” on page 14-789

• “Espey/Winslow” on page 14-790

• “Federal Aviation Agency” on page 14-790

• “Kerby/Hathaway” on page 14-790

• “Kirpich (PA)” on page 14-791

• “Kirpich (TN)” on page 14-791

• “Length and Velocity” on page 14-791

• “SCS Lag” on page 14-792

• “TR-55 Sheet Flow” on page 14-792

• “TR-55 Shallow Concentrated Flow” on page 14-793

• “TR-55 Channel Flow” on page 14-793
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Minimum Time of Concentration

Certain hydrologic methods for computing runoff hydrographs require the time of 
concentration to be greater than some minimum value. For example the TR-55 meth-
odology dictates that the minimum Tc to be used is 0.1 hr.

The minimum Tc is used in lieu of the calculated Tc whenever the calculated Tc is 
smaller than the minimum.

User-Defined

The user-defined time of concentration (Tc) is a method that allows the direct input of 
the Tc rather than using an equation to calculate it. This method would be used when 
the Tc needs to be calculated using a methodology that is not supported by Bentley 
SewerGEMS V8i, or when a quick estimate of Tc is sufficient for the analysis. 

Carter

(14.31)

Eagleson

(14.32)

Where Tc = Time of concentration (hr.)

Lm = Flow length (mi)

Sm = Slope (ft/mi)

Tc 1.7Lm
0.6Sm

0.3∠=

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

n = Manning’s n

R = Hydraulic radius (ft)

Sf = Slope (ft/ft)

Tc 0.0001852LfnR 2 3⁄∠ Sf
1 2⁄∠=
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Espey/Winslow

(14.33)

Federal Aviation Agency

(14.34)

Kerby/Hathaway

(14.35)

Where Tc = Time of concentration (hr.)

φ = Espey Channelization factor

Lf = Flow length (ft)

Sf = Slope (ft/ft)

Ip = Impervious area (%)

Tc 0.52ΦLf
0.29Sf

0.145∠ Ip
0.6∠=

Where Tc = Time of concentration (hr.)

C = Rational C coefficient

L = Length of overland pipe flow (ft)

S = Slope (%)

Tc 0.03 1.1 C∠( )L0.5S 0.333∠=

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

n = Manning’s n

Sf = Slope (ft/ft)

Tc 0.01377Lf
0.47n0.47Sf

0.235∠=
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Kirpich (PA)

(14.36)

Kirpich (TN)

(14.37)

Length and Velocity

(14.38)

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

Sf = Slope (ft/ft)

Mt = Tc Multiplier (Tc adjustment)

Tc 0.00002167Lf
0.77Sf

0.5∠ Mt=

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

Sf = Slope (ft/ft)

Mt = Tc Multiplier (Tc adjustment)

Tc 0.00013Lf
0.77Sf

0.385∠ Mt=

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

V = Velocity (ft/sec.)

Tc
Lf
V

------⎝ ⎠
⎛ ⎞ 1hr.

3600sec.
---------------------⎝ ⎠
⎛ ⎞=
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SCS Lag

Note: There is a factor of 0.6 built into this equation (in the constant 
0.0000877) to convert this equation from a lag time to a time of 
concentration.

(14.39)

TR-55 Sheet Flow

This number represents the sheet flow time computed for each column of sheet flow 
data. Flow time for sheet flow is computed as:

(14.40)

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

n = Manning’s n

Sf = Slope (ft/ft)

Tc 0.0000877Lf
0.8 1000

CN
------------ 9∠⎝ ⎠
⎛ ⎞ 0.7

Sf
0.5∠=

Where T = Sheet flow time (hr.)

n = Manning’s roughness coefficient from TR-55 
table

L = Flow length (ft)

P2 = Two-year, 24-hour rainfall (in)

Sf = Slope (ft/ft)

T 0.007 nL( )0.8

P2( )0.5Sf
0.4

--------------------------------=
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TR-55 Shallow Concentrated Flow

This number represents the sheet flow time computed for each column of shallow 
concentrated flow data. Flow velocity for this flow time is computed as:

(14.43)

TR-55 Channel Flow

This number represents the channel flow time computed for each column of channel 
flow data. Flow velocity for this flow time is computed as:

(14.44)

where

(14.45)

Unpaved Surfaces Paved Surfaces

(14.41) (14.42)

Where V = Average velocity (ft/sec.)

Sf = Slope of hydraulic grade line (ft/ft)

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

V = Average velocity (ft/sec.)

V 16.1345Sf
0.5= V 20.3282Sf

0.5=

Tc
Lf
V

-------⎝ ⎠
⎛ ⎞ 1hr.

3600sec.
---------------------⎝ ⎠
⎛ ⎞=

Tc
Lf
V

-------⎝ ⎠
⎛ ⎞ 1hr.

3600sec.
---------------------⎝ ⎠
⎛ ⎞=

V
1.49R2 3⁄ Sf

1 2⁄

n
-----------------------------------=
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Rational Method

The Rational method solves for peak discharge based on watershed area, Rational 
coefficient, and rainfall intensity for the watershed. The following equation is used to 
compute flow using the Rational method:

(14.46)

Note: A conversion factor of 1.008 acre inches/hour per cfs makes the 
Rational equation unit-consistent, and is used by PondPack.

Some localities have C adjustment factors for different storm 
frequencies.

C, the Rational coefficient, is the parameter that is most open to engineering judge-
ment. In many cases, an area weighted average of C coefficients is used as the C for 
the entire drainage area. SewerGEMS V8i calculates the weighted C for drainage 
areas.

Where Tc = Time of concentration (hr.)

Lf = Flow length (ft)

V = Average velocity (ft/sec.)

R = Hydraulic radius (ft)

Sf = Average slope (ft/ft)

n = Manning’s roughness value

Where Q = Flow (cfs) for drainage area A

C = Weighted runoff coefficient for drainage area A

i = Intensity (in/hr.) for the given design frequency 
and storm duration (this value is taken from the I-
D-F curves for your design area)

A = Drainage area (acres)

Q CiA=
14-794 Bentley SewerGEMS V8i User’s Guide



Theory
Weighting C Values

If the drainage area consists of more than one subarea, a weighted C value for the area 
must be computed. The weighted C for a drainage area is computed by dividing the 
sum of all subarea CAs by the total area, where CA is the subarea C value multiplied 
by the area of the subarea. 

Example: An engineer wants to compute the weighted C value for the composite 
drainage area shown below. In this example the C values are not adjusted for storm 
frequencies.

Total Area, A = 2.6 + 3.4 + 1.2 = 7.2 acres

(14.47)

Q (cfs) is computed by:

(14.48)

Where i = Rainfall intensity (in/hr.) for given design 
frequency and duration

2.6 0.97×( ) 3.4 0.47×( ) 1.2 0.98×( )+ +
7.2

---------------------------------------------------------------------------------------------------- 0.736 0.74≈=

Q CiA Q→ 0.74( )i 7.2( )= =
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Modified Rational Method

The Modified Rational Method provides a way to calculate the hydrograph from a 
catchment based on rational method C values and the peak intensity.  There is no "loss 
method" associated with the modified rational method. The underlying assumption is 
that the peak intensity is maintained for a long enough duration to reach peak flow at 
the outlet of the catchment. This results in a trapezoidal hydrograph as shown below.

Qpeak is determined from the rational method (link to rational method topic)

Q = C i A

When using English units i is intensity in in/hr, A = area, acres, Q = flow, cfs and C is 
runoff coefficient, dimensionless.

The time to reach the peak is based on the time of concentration in the catchment 
which the user can manually enter or calculate using a variety of methods (“Rational 
Method” on page 14-794).

The length of the recession leg is based on the time of concentration times a recession 
multiplier which is set in the calculations options.

The intensity and duration are taken from the IDF curves (tables) based on the dura-
tion and frequency (return period) of the storm.
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SCS CN Runoff Equation

The SCS Runoff equation is used with the SCS Unit Hydrograph method to turn rain-
fall into runoff. It is an empirical method that expresses how much runoff volume is 
generated by a certain volume of rainfall.

The variable input parameters of the equation are the rainfall amount for a given dura-
tion and the basin’s runoff curve number (CN). For convenience, the runoff amount is 
typically referred to as a runoff volume even though it is expressed in units of depth 
(in., mm). In fact, this runoff depth is a normalized volume since it is generally distrib-
uted over a sub-basin or catchment area.

In hydrograph analysis the SCS runoff equation is applied against an incremental burst 
of rain to generate a runoff quantity. This runoff quantity is then distributed according 
to the unit hydrograph procedure, which ultimately develops the full runoff 
hydrograph.
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The general form of the equation (U.S. customary units) is:

(14.49)

The initial abstraction includes water captured by vegetation, depression storage, 
evaporation, and infiltration. For any P, this abstraction must be satisfied before any 
runoff is possible. The universal default for the initial abstraction is given by the equa-
tion:

(14.50)

The ratio, 0.2, is rarely, if ever, modified.

The potential maximum retention after runoff begins, S, is related to the soil and land 
use/vegetative cover characteristics of the watershed by the equation:

(14.51)

Where the runoff curve number is developed by coincidental tabulation of soil/land 
use extents in the weighted runoff curve number parameter, CN.

The Runoff Curve Number

In SewerGEMS V8i, the sub-basin runoff is defined solely by the CN input for each 
watershed. Bentley SewerGEMS V8i features built-in spreadsheet forms that aid you 
by automatically computing weighted CN values as a function of soil hydrologic class 
and cover characteristics.

Where Q = Runoff depth (in)

P = Rainfall (in)

S = Maximum retention after runoff begins (in)

Ia = Initial abstraction

Q
P Ia∠( )2

P Ia∠( ) S+
------------------------------=

Ia 0.2S=

S 1000
CN

------------ 10∠=
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The USDA has classified its soil types into four hydrologic soil groups. The CN 
values for various land uses and cover characteristics for each soil classification are 
described below. To describe a sub-basin using CN, you must overlay a land cover 
layer over a hydrologic soil mapping overlay and a delineated drainage basin mapping 
overlay. You then determine the component CN areas that comprise each sub-basin, 
and enter these into SewerGEMS V8i, which develops the actual weighted CN for use 
in hydrograph generation.

Definition of SCS Hydrologic Soil Groups

Group A: Group A soils have low runoff potential and high 
infiltration rates even when thoroughly wetted. They 
consist chiefly of deep, well to excessively drained 
sands or gravels and have a high rate of water 
transmission (greater than 0.30 in./hr.).

Group B: Group B soils have moderate infiltration rates when 
thoroughly wetted and consist chiefly of moderately 
deep to deep, moderately well to well drained soils 
with moderately fine to moderately course textures. 
These soils have a moderate rate of water 
transmission (0.15 to 0.30 in./hr.).

Group C: Group C soils have low infiltration rates when 
thoroughly wetted and consist chiefly of soils with a 
layer that impedes downward movement of water 
and soils with moderately coarse textures. These 
soils have a moderate rate of water transmission 
(0.05-0.15 in./hr.).

Group D: Group D soils have high runoff potential. They have 
very low infiltration rates when thoroughly wetted 
and consist chiefly of clay soils with a high swelling 
potential, soils with a permanent high water table, 
soils with a claypan or clay layer at or near the 
surface, and shallow soils over nearly impervious 
material. These soils have a very low rate of water 
transmission (0.00 to 0.05 in./hr.).

TR-55 provides an extensive table detailing different land uses, soil types and their 
associated CN values.

Runoff Volume (CN Method)

The amount of actual runoff from a watershed is dependent upon the amount of 
precipitation that occurs, the initial amount of precipitation that is intercepted, infil-
trates, or is stored before runoff begins, the actual retention that occurs after rainfall 
begins, and the potential maximum retention that can occur after rainfall begins.
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The SCS method for estimating the volume of direct runoff from storm rainfall relates 
the initial abstractions, and retention parameters to watershed properties as described 
by the curve number (CN).

The potential maximum retention after runoff occurs is related to the CN as follows:

(14.52)

The initial abstraction is related to the potential maximum retention as follows:

(14.53)

The runoff volume is related to the precipitation and the potential maximum runoff as 
follows:

(14.54)

For complex watersheds that consist of several subareas each having a distinct CN, the 
total actual runoff volume can be computed in two different ways.

Where S = Potential maximum retention after runoff begins

CN = Curve number

Where Ia = Initial abstraction (includes interception, surface 
storage, and infiltration)

S = Potential maximum retention after runoff begins

Where Q = Actual runoff volume

P = Rainfall (P >= Q)

S = Potential maximum retention after runoff begins

S 1000
CN

------------ 10∠=

Ia 0.2S=

Q P 0.2S∠( )2

P 0.8S+( )
-----------------------------=
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• The cumulative volume method computes the actual runoff occurring from each 
subarea individually (using the individual CNs and areas), and then sums these 
runoff volumes to determine the total for the watershed.

• The composite volume method computes the actual runoff using a composite CN 
and the total watershed area.

CN Weighting

Note: Figures and tables referred to in this help section are referring to 
the TR-55 document. The tables are reproduced, see: “Reference 
Tables” on page B-927.

These sections are reproduced from TR-55, Urban Hydrology for Small Watersheds 
(U.S. Soil Conservation Service 1986b):

• “Antecedent Runoff Condition” on page 14-801

• “Urban Impervious area Modifications” on page 14-801

• “Connected Impervious Areas” on page 14-801

• “Unconnected Impervious Areas” on page 14-802

Antecedent Runoff Condition

The index of runoff potential before a storm event is the antecedent runoff condition 
(ARC). ARC is an attempt to account for the variation in CN at a site from storm to 
storm. The CN for the average ARC at a site is the median value as taken from sample 
rainfall and runoff data. For more information on the CNs for the average ARC, which 
is used primarily for design applications, see “Runoff Curve Number Tables” on 
page B-899. See the National Engineering Handbook (U.S. Soil Conservation Service 
1969) and TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation 
Service 1986b) for more detailed discussion of storm-to-storm variation and a demon-
stration of upper and lower enveloping curves.

Urban Impervious area Modifications

Several factors, such as the percentage of impervious areas and the means of 
conveying runoff from impervious areas to the drainage system, should be considered 
in computing CN for urban areas (U.S. Soil Conservation Service 1986b). For 
example, do the impervious areas connect directly to the drainage system, or do they 
outlet onto lawns or other pervious areas where infiltration can occur?

Connected Impervious Areas

An impervious area is considered connected if runoff from it flows directly into the 
drainage system. It is also considered connected if runoff from it occurs as concen-
trated shallow flow that runs over a pervious area and then into a drainage system.
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Urban CNs (for more information, see “Runoff Curve Numbers for Urban Areas” on 
page B-899) were developed for typical land use relationships based on specific 
assumed percentages of impervious area. These CN values were developed on the 
assumptions that:

• Pervious urban areas are equivalent to pasture, in good hydrologic conditions.

• Impervious areas have a CN of 98 and are directly connected to the drainage 
system. Some assumed percentages of impervious area are shown in “Table B-1: 
Runoff Curve Numbers for Urban Areas”on page B-899.

If all of the impervious area is directly connected to the drainage system, but the 
impervious area percentages or the pervious land use assumptions in “Table B-1: 
Runoff Curve Numbers for Urban Areas”on page B-899 are not applicable, use Figure 
2-3 from TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation 
Service 1986b) to compute a composite CN. For example, “Table B-1: Runoff Curve 
Numbers for Urban Areas”on page B-899 gives a CN of 70 for a 1/2-acre lot in HSG 
B, with an assumed impervious area of 25 percent. However, if the lot has 20 percent 
impervious area and a pervious area CN of 61, the composite CN obtained from 
Figure 2-3 (U.S. Soil Conservation Service 1986b) is 68. The CN difference between 
70 and 68 reflects the difference in percent impervious area.

Unconnected Impervious Areas

Runoff from these areas is spread over a pervious area as sheet flow. To determine CN 
when all or part of the impervious area is not directly connected to the drainage 
system, (1) use Figure 2-4 from TR-55, Urban Hydrology for Small Watersheds (U.S. 
Soil Conservation Service 1986b) if total impervious area is less than 30 percent, or 
(2) use Figure 2-3 (U.S. Soil Conservation Service 1986b) if the total impervious area 
is equal to or greater than 30 percent, because the absorptive capacity of the remaining 
pervious areas do not significantly affect runoff.

When impervious area is less than 30 percent, obtain the composite CN by entering 
the right half of Figure 2-4 (U.S. Soil Conservation Service 1986b) with the 
percentage of total impervious area and the ratio of total unconnected impervious area 
to total impervious area. Then move left to the appropriate pervious CN and read 
down to find the composite CN. For example, for a one acre lot with 20 percent total 
impervious area (75 percent of which is unconnected) and pervious CN of 61, the 
composite CN from Figure 2-4 (U.S. Soil Conservation Service 1986b) is 66. If all of 
the impervious area is connected, the resulting CN from Figure 2-3 (U.S. Soil Conser-
vation Service 1986b) would be 68.

Equation for composite CN with connected impervious area:

(14.55)
CNc CNp

Pimp
100

------------⎝ ⎠
⎛ ⎞ 98 CNp∠( )+=
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Equation for composite CN with unconnected impervious areas and total impervious 
area less than 30%:

(14.56)

SCS Peak Discharge

SCS Peak Discharge includes:

• “TR-55 Graphical Peak Discharge (SCS Graphical Peak)” on page 14-803

• “TR-55 Pond Storage Estimate (SCS Storage Estimate)” on page 14-806

TR-55 Graphical Peak Discharge (SCS Graphical Peak)

This option uses the Graphical Peak Discharge method to compute the peak discharge 
for up to three different storm events. The following information is required:

• The drainage area in acres (Bentley SewerGEMS V8i automatically converts it to 
sq. mi.)

• Amount of pond and swamp areas (percentage of total drainage areas)

• The 24-hr. precipitation (P) for the selected return period

• The appropriate rainfall distribution (Type I, IA, II, or III)

• The time of concentration, Tc

• The runoff curve number, CN

Where CNc = Composite runoff curve number

CNp = Pervious runoff curve number

Pimp = Percent imperviousness

Where R = Ratio of unconnected impervious area to total 
impervious area

CNc CNp
Pimp
100

------------⎝ ⎠
⎛ ⎞ 98 CNp∠( ) 1 0.5R∠( )+=
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Initial Abstraction, Ia (in)

The initial abstraction is computed from the precipitation and CN number and inserted 
in this field. For more information, see Ia/P, and Chapter 2 of TR-55, Urban Hydrology 
for Small Watersheds (U.S. Soil Conservation Service 1986b).

Ia/P Ratio

The initial abstraction (Ia) is divided by the precipitation (P) and printed in this field. 
For more information on Ia/P, see TR-55, Urban Hydrology for Small Watersheds 
(U.S. Soil Conservation Service 1986b).

Unit Discharge, qu (csm/in.)

The unit discharge (qu) for the watershed is computed and printed into this field. 
Graphs depicting the relationship between time of concentration (Tc), Ia/P, and qu 
(csm) are displayed in Exhibit 4-I, 4-IA, 4-II, and 4-III in TR-55, Urban Hydrology for 
Small Watersheds (U.S. Soil Conservation Service 1986b). These graphs are described 
in the equation below from Appendix F, in TR-55, Urban Hydrology for Small Water-
sheds (U.S. Soil Conservation Service 1986b).

(14.57)

Bentley SewerGEMS V8i computes two qu values by selecting C0, C1, C2 coeffi-
cients corresponding to the specified distribution type and the two Ia/P values that are 
closest to the computed Ia/P for the watershed. Bentley SewerGEMS V8i then linearly 
interpolates between the two computed qu values to obtain the actual qu used to 
compute peak discharge. If the watershed’s computed Ia/P ratio exceeds the limits of 
Table F-1, the limiting value for Ia/P is used to compute qu (csm).

Where qu = Unit peak discharge (csm/in)

Tc = Time of concentration (hr.) (minimum Tc = 0.10 
hr., maximum Tc = 10.0 hr.)

C0, C1, C2 = Coefficients from Table F-1 in TR-55, Urban 
Hydrology for Small Watersheds (U.S. Soil 
Conservation Service 1986b)

qu( )log C0 C1 Tc( )log C2 Tc( )log[ ]2+ +=
14-804 Bentley SewerGEMS V8i User’s Guide



Theory
Runoff, Q (in.)

Runoff (inches) is computed from the CN and precipitation (P). For more information, 
see Chapter 2 in TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conserva-
tion Service 1986b).

Pond and Swamp Adjustment Factor

The pond and swamp adjustment factor (Fp) is selected from the values given in Table 
4-2 in TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation Service 
1986b). If the value entered for pond and swamp areas does not exist in Table 4-2, the 
nearest adjustment factor (Fp) is used. 

Peak Discharge, qp (cfs)

The peak discharge for a given storm is computed by the equation below, from 
Chapter 4 in TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation 
Service 1986b). This value is computed from the watershed’s area (sq. mi.), runoff 
(in.), and unit discharge (csm/in.).

(14.58)

Where qp = Peak discharge (cfs)

qu = Unit peak discharge (csm/in)

Am = Drainage area (mi2)

Q = Runoff (in)

Fp = Pond and swamp adjustment factor

qp quAmQFp=
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TR-55 Pond Storage Estimate (SCS Storage Estimate)

This option estimates storage requirements using the method discussed in Chapter 6 in 
TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation Service 
1986b). This is an extremely approximate method.

Information required:

1. Compute peak flow (qi, cfs), using either the Graphical Peak Discharge method or 
the Tabular Hydrograph method. Do not use peak discharges computed with any 
other method. When using the Tabular Hydrograph method to compute qi, only 
use peak discharge associated with Tt = 0.0.

2. The inflow runoff (Q, in); this parameter is computed for you whenever you use 
the Graphical Peak Discharge method with this estimation option. See Chapter 2 
of TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation Service 
1986b) for discussion on runoff, Q.

3. The peak outflow rate (qo, cfs).

Theory for Computed Spreadsheet Values

qo/qi ratio: This value is the peak outflow rate (qo) divided by 
the peak inflow rate (qi). This parameter is used to 
compute Vs/Vr.

Vs/Vr ratio: This number represents the ratio of detention storage 
volume to inflow volume. Bentley SewerGEMS V8i 
uses the equation below to compute Vs/Vr (see also 
Appendix F, SCS TR-55 document). The coefficients 
C0, C1, C2, and C3 are selected for the specified 
distribution type.

(14.59)

Where Vs/Vr = Ratio of storage volume (Vs) to runoff volume 
(Vr)

q0/qi = Ratio of peak outflow (q0) to peak inflow (qi)

C0, C1, C2, C3 = Coefficients from Table F-2, in TR-55, Urban 
Hydrology for Small Watersheds (U.S. Soil 
Conservation Service 1986b)

Vs Vr⁄ C0 C1 q0 qi⁄( )2 C2 q0 qi⁄( )2 C3 q0 qi⁄( )3+ + +=
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Inflow Volume, Vr (ac-ft): The inflow volume represents the total runoff volume 
for the given inflow storm. It is computed by 
multiplying the watershed area by the runoff. With 
area in acres, runoff (Q) in inches, the runoff volume 
in acre-ft. would be computed by the equation below.

(14.60)

Storage Volume, Vs (acre-ft): This number is the computed value for the estimated 
detention storage that is required. It is computed by 
multiplying the inflow volume Vr by Vs/Vr as shown 
in the equation below.

(14.61)

Hydrograph Methods

Hydrograph methods include:

• “Soil Conservation Service (SCS)” on page 14-809

Unit Hydrograph Methodology

The Unit Hydrograph theory assumes that the watershed is a linear system. This 
means that the outflow is proportional to the inflow regardless of the magnitude of the 
inflow. This is generally not the case however. When the flow in stream channels and 
on overland flow surfaces increases, the velocity also increases, causing a reduction in 
the time of travel to the outlet. Yet, for most natural streams, the velocity increases as 
the depth increases only until overbank flow begins. At this point, the velocity tends to 
remain constant, which satisfies the requirement of linearity. Therefore, unit hydro-
graphs should be derived only from the larger floods for a particular watershed.

The Unit Hydrograph theory also assumes that the input rainfall excess is uniform 
over the watershed, and that the response to this input is invariable. Typically, the 
spatial variation of rainfall, and the difference in watershed characteristics can cause 
the rate of runoff to vary widely from place to place at any time. However, many 
watersheds do experience similar patterns of rainfall from event to event, and there-
fore the response to that rainfall excess can be effectively characterized by the unit 
hydrograph.

Vr Area acres( ) Q in( )
12 in/ft( )
---------------------×=

Vs Vr
Vs
Vr
-----=
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The unit hydrograph theory depends on the principle of superposition. This principle 
states that a flood hydrograph for a particular storm event can be built up from the unit 
hydrograph applied to the incremental rainfall excess during each period. In other 
words, the unit hydrograph can be applied to a series of inputs, and the resulting 
hydrographs can be added together to form the total hydrograph.

Generic Unit Hydrographs

You can directly associate a user-defined unit hydrograph to a catchment for runoff 
calculations. The unit hydrograph is a time versus flow curve which represents a one-
inch volume of rainfall for a given excess duration of rainfall, DD, for a set watershed 
area.

DD is equivalent to the convolution time steps, which tell Bentley SewerGEMS V8i 
how to subdivide the entered unit hydrograph into equal steps and serves as the 
internal calculation increment.

For each plug of runoff generated over a single time step, an individual runoff 
hydrograph is generated. All the successive unit hydrographs are superimposed to 
form the ultimate runoff hydrograph for the catchment. The underlying theory is 
described in Stormwater Conveyance Modeling and Design, by Bentley Institue Press 
(pp. 158-162) or Wastewater Collection System Modeling and Design, by Bentley 
Institue Press (pp. 252-254).

The fundamental equation for this method is show below.

(14.62)

The theory behind unit hydrographs is that the volume of water, calculated as the area 
under the hydrograph curve, should correspond to 1 inch of excess precipitation over 
the area. The user needs to check if this is true.

Where Qk = flow at time step k, cfs

Pi = precipitation during time step i, in./hr

Uk-i+1 = flow at time step k from rain during time step 
I, cfs/in

k = duration of rain in time steps + duration of 
hydrograph

1
1

k

k i k i
i

Q PU − +
=

= ∑
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For example, over a 2 acre area, the volume of water calculated under the unit 
hydrograph should be 2 acre-in (7,260 cubic feet).  If there is 1.5 in of excess precipi-
tation (precipitation – losses) over this catchment, the volume of water calculated 
using the unit hydrograph method should be 3 acre-in (10,890 cubic feet). This runoff 
volume is displayed under the Catchment tab of the Detailed Calculation Summary.

Soil Conservation Service (SCS)

This section includes:

• “SCS Unit Hydrograph” on page 14-809

• “Governing Equations” on page 14-809

SCS Unit Hydrograph

A unit hydrograph can be a natural hydrograph (i.e., a hydrograph obtained directly 
from observed flows in a gauged stream), or a synthetic hydrograph (i.e., a 
hydrograph that simulates a natural hydrograph by using watershed parameters and 
storm characteristics). Specifically, a unit hydrograph is the hydrograph that results 
from one inch of direct runoff occurring uniformly over a watershed in a specified 
amount of time. L.K. Sherman first advanced the theory of the unit hydrograph in 
1932, and then Victor Mockus derived the unit hydrograph used by the SCS (from a 
large number of natural unit hydrographs from both large and small watersheds).

Governing Equations

The SCS Unit Hydrograph is an extremely flexible tool. It is a dimensionless curvi-
linear graph with ordinate values expressed in a dimensionless ratio Q/Qp (discharge 
at time t to total discharge) or Qa/Q (accumulated volume at time t to total volume) 
and its abscissa values as T/Tp (a selected time from the beginning of the rise to the 
peak). A watershed specific unit hydrograph can be developed from the dimensionless 
graph utilizing certain watershed parameters. This watershed specific unit graph can 
then be used to build a flood hydrograph resulting from a given storm.

The unit hydrograph for any regularly shaped watershed can be constructed once the 
values of Qp and Tp are defined. An irregularly shaped watershed should be divided 
into hydrological units of uniformly shaped areas, such that the drainage area of any 
unit should be less than 20 square miles and have a homogeneous drainage pattern. 
Unit hydrographs should be developed for each of the divisions, and then combined to 
form the watershed unit graph.

Excerpted from NEH-4: The dimensionless curvilinear unit hydrograph has 37.5% of 
the total volume in the rising side, which is represented by one unit of time and one 
unit of discharge. This dimensionless unit hydrograph also can be represented by an 
equivalent triangular hydrograph having the same units of time and discharge, thus 
having the same percent of volume in the rising side of the triangle.
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Figure 14-38: Dimensionless Unit Hydrograph

The peak discharge for the hydrograph can be found from the following equation:

(14.63)

The time to peak is defined as:

(14.64)

The average relationship of watershed lag to the time of concentration is:

(14.65)

Where qp = Peak discharge (cfs)

A = Drainage area (mi2)

Q = Depth of runoff (in)

Tp = Time to peak (hr.)

484 = 645.33 x 0.75m, where 645.33 is a conversion 
factor from in x mi2/hr. to ft3/sec.

Where ∆D = Duration of unit excess rainfall (hr.)

L = Watershed lag (hr.)

Where Tc = Time of concentration (hr.)

qp
484AQ

Tp
-----------------=

Tp
∆D
2

-------- L+=

L 0.6Tc=
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The duration of unit excess rainfall is related to the time of concentration as:

(14.66)

Unit Hydrograph Runoff Methods

Bentley SewerGEMS V8i provides various methods for computing the incremental 
runoff for pervious and directly connected impervious areas to compute the weighted 
runoff depth for each hydrograph increment. The SCS Unit Hydrograph option can 
compute runoff using either of the following methods:

Note: In either case, you can use the storage depression method for 
computing runoff for the directly connected impervious area 
(i.e., the runoff for impervious areas equals the rainfall greater 
than a specified storage depression depth).

1. You can enter a value in the fLoss field that represents a constant infiltration loss 
rate (in./hr.) that occurs throughout the entire duration of the storm.

2. You can use the SCS Runoff Curve Number method by entering CN values for 
the pervious and impervious areas.

3. You can use the Green and Ampt method and calculate a variable rate of absorp-
tion for your subarea.

4. You can use the Horton (generic) method to calculate non-constant infiltration for 
your subarea.

The following approach is used whenever CN values are entered for the pervious and 
impervious areas.

Pervious Area

If P(t) is less than 0.2Sp then Rp(t) = 0.0. Otherwise:

(14.67)

∆D 0.133Tc=

Where Rp(t) = Pervious area runoff (in) during time step t

P(t) = Rainfall (in) during time step t

Sp = 1000/CNp - 10

CNp = Pervious area runoff curve number

Rp t( )
P t( ) 0.2Sp+[ ]2

P t( ) 0.8Sp+[ ]
--------------------------------------=
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Directly Connected Impervious Area

If P(t) is less than 0.2Si then Ri(t) = 0.0. Otherwise:

(14.68)

Depression Storage

If a value greater than 0 for depression storage depth is entered, the following method 
is used for computing Ri(t) (the SCS CN method is not used).

Ri(t) = 0.0 when Pa(t) is less than Ds. Otherwise:

(14.69)

Weighted Incremental Runoff

(14.70)

Where Ri(t) = Impervious area runoff (in) during time step t

P(t) = Rainfall (in) during time step t

Si = 1000/CNi - 10

CNi = Impervious area runoff curve number

Ri t( )
P t( ) 0.2Si∠[ ]2

P t( ) 0.8Si+[ ]
--------------------------------------=

Where Ri(t) = Impervious area runoff (in) during time step t

Pa(t) = Cumulative rainfall (in) through time step t

Ds = Storage depression depth (in)

i t( ) Pa t( ) Ds∠[ ] Pa t 1∠( ) Ds∠[ ]∠ Pa t( ) Pa t 1∠(∠= =

R t( ) Rp t( ) Ap×[ ] Ri t( ) Ai×[ ]+( ) Ap Ai+( )⁄=
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fLoss Rate

Whenever you enter a value for fLoss, Bentley SewerGEMS V8i computes the runoff 
for each hydrograph time increment using an average uniform infiltration rate that 
does not vary with time or total depth.

Green and Ampt

While the Horton method was empirically derived to describe the exponential decay 
of infiltration rate over time, the Green and Ampt method is based on a theoretical 
derivation of Darcy’s law, which relates flow velocity to the permeability of the soil 
and the Law of Conservation of Mass. The resulting equation inversely relates the 
infiltration rate f to the total accumulated infiltration F as:

(14.71)

The benefit of the Green and Ampt method is that the infiltration rate can be calcu-
lated based on physical, measurable soil parameters, as opposed to the more amor-
phous decay coefficients of the Horton method.

Where Rp(t) = Pervious area runoff (in) during time step t

Ap = Pervious area (acres)

Ri(t) = Impervious area runoff (in) during time step t

Ai = Impervious area (acres)

Where f = Infiltration rate (in/hr, cm/hr)

Ks = Saturated hydraulic conductivity (permeability) (in/hr, 
cm/hr)

Ψ = Capillary suction (in, cm)

θs = Volumetric moisture content (water volume ÷ unit soil 
volume) under saturated conditions

θi = Volumetric moisture content under initial conditions

F = Total accumulated infiltration (in, cm)

f Ks
ψ θs θi∠( )

F
--------------------------- 1+⎝ ⎠
⎛ ⎞=
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In order to calculate the infiltration rate at a given time, the total infiltration up to that 
time must be calculated. This value can be determined by integrating the previous 
equation with respect to time (starting at time = 0) and solving for F.

(14.72)

The equation cannot be explicitly solved, and thus requires the application of a numer-
ical method such as Newton-Rhapson or the bisection method to solve for F.

Horton

The Horton equation (Horton 1939) is a widely-used method of representing the infil-
tration capacity of a soil. The Horton equation models a decreasing rate of infiltration 
over time, which implies that the rate of infiltration decreases as the soil becomes 
more saturated. For conditions in which the rainfall intensity is always greater than the 
infiltration capacity (that is, the rainwater supply for infiltration is not limiting), this 
method expresses the infiltration rate as:

(14.73)

It can be shown theoretically that the steady-state infiltration rate fc is equal to the 
saturated vertical hydraulic conductivity of the soil.

Estimation of the parameters fc, f0, and k in the previous equation can be difficult 
because of the natural variabilities in antecedent moisture conditions and soil proper-
ties. The following table provides some values recommended by Rawls et al. (1976), 
though such tabulations should be used with caution. Singh (1992) recommends that 
f0 be taken as roughly 5 times the value of fc.

Where t = time (hr.)

F Ks t ψ θs θi∠( ) 1 F
ψ θs θi∠( )
---------------------------+⎝ ⎠

⎛ ⎞ln+⋅=

Where f(t) =  Infiltration rate (in/hr. or mm/hr.) at time t (min.)

fc = Steady-state infiltration rate that occurs for 
sufficiently large t

f0 = Initial infiltration rate at the time that infiltration 
begins (that is, at time t = t0)

k (min.-1) = Decay coefficient 

f t( ) fc f0 fc∠( )e
k∠ t t0∠( )

+=
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• (Source: Rawls et al. 1976.)

Often, the rainfall intensity during the early part of a storm is less than the potential 
infiltration capacity of the soil; thus, the supply of rainwater is a limiting factor on the 
infiltration rate. During the time period when the water supply is limiting, the actual 
infiltration rate is equal to the rate at which rainwater is supplied to the ground 
surface. Later in the storm when the rainfall rate is greater than the infiltration rate, the 
actual infiltration rate will be greater than that predicted by the previous equation, 
because infiltration was limited in the early in the storm.

An integrated version of the Horton method can account for the underestimation of 
infiltration rate due to limiting rainfall intensity early in a storm (Viessman et al. 1977; 
Bedient and Huber 1992; Chin 2000), as can more complicated infiltration models 
such as the Green and Ampt (1911) model. Nevertheless, the simple Horton model is 
often used in practice as it yields a larger amount of effective precipitation than does 
the integrated version of the Horton model, and is thus conservative. Depending on 
selected parameter values, Horton may or may not yield more effective rainfall than 
does, for example, the Green and Ampt model (for more information, see “Green and 
Ampt” on page 14-813).

RTK Methods

The RTK method is based on representing unit hydrographs by a set of triangular 
hydrographs, which can described by three parameters R, T and K. R is the fraction of 
runoff that show up as precipitation; T is the time to peak of the hydrograph and K is 
the ratio of the recession time to time to peak. 

Table 14-2: Typical Values of Horton Infiltration Parameters

Soil Type f0 (in./hr.) fc (in./hr.) k (min.-1)

Alphalpha loamy sand 19.0 1.4 0.64

Carnegie sandy loam 14.8 1.8 0.33

Dothan loamy sand 3.5 2.6 0.02

Fuquay pebbly loamy 
sand

6.2 2.4 0.08

Leefield loamy sand 11.3 1.7 0.13

Tooup sand 23.0 1.8 0.55
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A typical hydrograph is shown in the figure below.

Figure 14-39: A Typical Hydrograph

Most RDII hydrographs do not look like the simple triangular plot above but are really 
influenced by several different phenomena such as direct inflow and infiltration 
through groundwater. Investigators have suggested that there should actually be three 
unit hydrographs representing these processes:

• Rapid inflow

• Moderate infiltration

• Slow infiltration

In Bentley SewerGEMS V8i, you determine the nine numerical values: three parame-
ters for each of the three processes. Each hydrograph is generated and they are 
summed as shown below.

The R values depend on the problems with the sewers (e.g. leaks, illegal connections, 
sump pumps, roof leaders, etc.). In theory, R should be zero in a sanitary sewer 
system. The sum of all the R's should be significantly less that one because some 
water flows to storm systems, some seeps into the ground and some is lost to depres-
sion storage and evapotranspiration. The R's are usually around 0.1 but depend 
heavily on the condition of the system.
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The T values depend on the size of the catchment with the rapid inflow T much 
smaller than the long term infiltration T. K depends on the relative length of the reces-
sion curve but is usually on the order of 1.5 to 3, with 1.67 being a typical value (value 
used in SCS triangular curves).

Procedure

The procedure for developing and applying RTK hydrographs comprises two overall 
steps:

1. Use precipitation and flow meter data to develop R, T and K values.

2. Given a hyetograph, create a hydrograph for a given storm and place it on loading 
nodes.The simulation model performs the second step.

Developing Hydrographs

During a model run, you enter a precipitation hyetograph and the R, T and K values 
convert those values into a hydrograph. The first step is to use the precipitation, area, 
and R values to determine the three peak flow values:

(14.74)

P is used here as precipitation although it should be excess precipitation after losses 
are subtracted out. However, for the RTK method in sanitary sewers, you would most 
likely set the losses to zero and base everything on precipitation.

As with any unit hydrograph method, we are interested in the time from the i-th hour 
of precipitation. To get the flow in any hour, the model sums up the hydrographs from 
all the previous rainfall hours. Each of those values will be based on a sum of the three 
hydrographs. With that in mind, the individual triangular hydrographs are determined 
by the following equations:

0for  t < ti (14.75)

Where Qpj(i) = Hydrograph peak flow for i-th rainfall value for j-
th triangular hydrograph, cfs

P(i) = Precipitation in i-th hour of event, inches

A = Drainage area, ac

Rj = R value for j-th hydrograph component

Qp (i) = 2.017P(i) Rj jA K T/(( ) )1+
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Qpj(i) (t/T)for 0 < t < T (14.76)

Qj(t) =

for T < t < (!+K)T (14.77)

0for  t > (1+K)T (14.78)

Now that the individual component hydrographs have been created, they are summed  
to get:

(14.79)

Now that the hydrographs have been determined for each interval of 0.2T, the hydro-
graphs for the individual units of rain are summed to obtain the overall hydrograph for 
the catchment.

Thiessen Polygon Generation Theory
“Naïve Method” on page 14-818

“Plane Sweep Method” on page 14-819

Naïve Method

A Thiessen polygon of a site, also called a Voronoi region, is the set of points that are 
closer to the site than to any of the other sites. 

Let P = {p1, p2,…pn} be the set of sites and V = {v(p1), v(p2),…v(pn)} represent the 
Voronoi regions or Thiessen polygons for Pi, which is the intersection of all of the half 
planes defined by the perpendicular bisectors of pi and the other sites. Thus, a naïve 
method for constructing Thiessen Polygons can be formulated as follows:

Where ti = The start of i-th precipitation hour

Qp i
t T

KTj ( ) 1− −⎛
⎝⎜

⎞
⎠⎟

Q t Q ti j i
j

( ) ( )=
=

∑
1

3

14-818 Bentley SewerGEMS V8i User’s Guide



Theory
Step 1 For each i such that i = 1, 2,…, n, generate n - 1 half planes H(pi,pj), 1 </= j </
= n, i <> j, and construct their common intersection v(pi).

Step 2 Report V = {v(p1), v(p2),…v(pn)} as the output and stop.

This naïve procedure is, however, very inefficient for generating Thiessen polygons. 
The computation time increases exponentially as the number of sites increases. There 
are many other more competent methods for constructing a Thiessen polygon.

Plane Sweep Method

The plane sweep technique is a fundamental method for solving two-dimensional 
geometric problems. It works with a special line called a sweepline, a vertical line 
sweeping the plane from left to right. It hits objects one by one as the sweepline 
moves. Whenever it crosses an object, a portion of the problem is solved. Therefore, it 
enables a two-dimensional problem to be solved in a sequence of one-dimension 
processing. Sweep plane technique provides a conceptually simple and efficient algo-
rithm. Steven Fortune (1986; 1987) has developed a sweepline algorithm for 
constructing Thiessen polygons. This algorithm has been implemented in the Sewer-
GEMS V8i Thiessen Polygon Generator. The detailed working algorithm is given as 
follows:

1. Q <------- P.

2. Choose and delete the left-most point, say pi from Q.

3. L <------- the list consisting of a single region ϕ(V(pi).

4. While Q is not empty, repeat Steps 1-3.

5. If w is a site, say w = pi, do:

a. Find region ϕ(V(pi) on L containing pi.

b. Replace ϕ(V(pi) on L by the sequence (ϕ(V(pj), h-(pi, pj), (ϕ(V(pi)), h+(pi, pj), 
ϕ(V(pj).

c. Add to Q the intersection of h-(pi, pj) with the intermediate lower half hyper-
bola on L and the intersection of h+(pi, pj) with the immediate upper half 
hyperbola on L.

6. If w is an intersection, say w = ϕ(qt), do:

a. Replace sub-sequence (h±(pi, pj), ϕ(V(pi)), h±(pi, pk)) on L by h = h-(pi, pk) or 
h = h+(pi, pk) appropriately.

b. Delete from Q any intersection of h±(pi, pj) or h±(pi, pk) with others.
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c. Add to Q any intersection of h with its immediate upper half hyperbola and its 
immediate lower half parabola on L.

d. Mark ϕ(qt) as a Voronai vertex incident to h±(pi, pj), h±(pi, pk), and h.

7. Repeat all half hyperbolas ever listed on L, all the Voronai vertices marked in the 
preceding step, and the incidence relations among them.

The sweepline algorithm is an efficient technique for constructing a Thiessen polygon. 
The computation time required for the worst case is O(nlog n). It produces a far more 
competent method than the naïve method and provides satisfactory performance for 
generating Thiessen polygons for a large number of points. 
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Chapter

Editing Attributes in
the Property Editor
The Property Editor is a manager (titled, “Properties”) that lets you define and view 
the data that defines your model. If it is not open, press F4 or click View > Properties 
to open the Property Editor.

Note: Some data described in this chapter may not appear in the 
Property Editor but are available for use when you set up a 
FlexTable. For more information on FlexTables, see “Viewing and 
Editing Data in FlexTables” on page 10-557.

• “Pressure Pipe Attributes” on page 15-821

• “Junction Chamber Attributes” on page 15-905

• “Pressure Junction Attributes” on page 15-910

Pressure Pipe Attributes
The pressure pipe attributes comprise the following categories:

• “Pressure Pipe—General” on page 15-822

• “Pressure Pipe—Geometry” on page 15-823

• “Pressure Pipe—Physical” on page 15-823

• “Pressure Pipe—Physical: Minor Losses” on page 15-824

• “Pressure Pipe—Active Topology” on page 15-825

• “Pressure Pipe—Results” on page 15-825
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Pressure Pipe Attributes
Pressure Pipe—General

Table 15-1: Pressure Pipe—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Node 
Reversal

Lets you reverse the direction of the currently highlighted 
element. Click in the field to display an Ellipsis (…) button. 
Clicking the ellipsis button in this field causes the start node 
and stop node to be exchanged with one another, which 
reverses the direction of the currently highlighted element.

Start Node ID Displays the start, or upstream, node of the currently 
highlighted element. This field is not editable.

Stop Node ID Displays the stop, or downstream, node of the currently 
highlighted element. This field is not editable.
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Editing Attributes in the Property Editor
Pressure Pipe—Geometry

Pressure Pipe—Physical

Table 15-2: Pressure Pipe—Geometry Attributes

Attribute Description

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click in the field to display an Ellipsis (…) 
button, and click the Ellipsis (…) button to use the Polyline 
Vertices feature. For more information, see “Polyline Vertices 
Dialog Box” on page 6-198.

Has User 
Defined 
Length

Lets you choose whether the highlighted element uses scaled 
or user-defined length. If this field is set to True, the Length 
(User Defined) field is activated. 

Length (User 
Defined)/
Scaled 
Length

Lets you enter a value for the length of the currently 
highlighted element. To use this field, you must set Has User 
Defined Length field to True. If you set this field to False, it 
displays the scaled length for the currently highlighted 
element.

Table 15-3: Pressure Pipe—Physical Attributes

Attribute Description

Diameter Lets you enter a value for the diameter of the cross section of 
the currently highlighted element.

Material Lets you enter the name of the material used. Alternatively, 
clicking the ellipsis button opens the Material Engineering 
Library, allowing you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value will change 
accordingly.

Manning’s n Lets you enter a value for the Manning’s roughness of the 
currently highlighted element. This field is available only if you 
selected Mannings as the default Pressure Friction Method in 
the Calculation Options Manager.

Hazen-
Williams C

Lets you enter a value for the Hazen-Williams roughness of the 
currently highlighted element. This field is available only if you 
selected Hazen-Williams as the default Pressure Friction 
Method in the Calculation Options Manager.
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Pressure Pipe Attributes
Pressure Pipe—Physical: Minor Losses

Darcy-
Weisbach e

Lets you enter a value for the Darcy-Weisbach roughness of 
the currently highlighted element. This field is available only if 
you selected Darcy-Weisbach as the default Pressure Friction 
Method in the Calculation Options Manager.

Kutter’s n Lets you enter a value for the Kutter’s roughness of the 
currently highlighted element. This field is available only if you 
selected Kutters as the default Pressure Friction Method in the 
Calculation Options Manager.

Invert (Start) Lets you enter a value for the start, or upstream, invert of the 
currently highlighted element.

Set Invert to 
Start Node?

Sets the start invert of the current element to the elevation of 
the start node (upstream). Set this to False to enter a value for 
the elevation of the invert, or set this field to True to use the 
start-node elevation.

Invert (Stop) Lets you enter a value for the stop, or downstream, invert of 
the currently highlighted element.

Slope Lets you enter a value for the slope.

Table 15-3: Pressure Pipe—Physical Attributes

Attribute Description

Table 15-4: Pressure Pipe—Minor Losses Attributes

Attribute Description

Minor Loss 
Coefficient

Lets you enter a value for the minor loss coefficient of the 
currently highlighted element. Alternatively, clicking the ellipse 
button opens the Minor Loss Collection dialog box, which lets 
you generate composite minor loss coefficients to be applied 
to the pressure pipe. For more information, see “Adding a 
Minor Loss Collection to a Pressure Pipe” on page 6-196.
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Pressure Pipe—Active Topology

Pressure Pipe—Results

Conduit Attributes
The conduit attributes comprise the following categories:

• “Conduit—General” on page 15-826

• “Conduit—Geometry” on page 15-827

• “Conduit—Infiltration” on page 15-827

• “Conduit—Output Filter” on page 15-828

• “Conduit—Physical” on page 15-829

• “Conduit—Physical: Additional Losses” on page 15-833

• “Conduit—Physical: Control Structure” on page 15-833

• “Conduit—Physical: Section Type: Culvert” on page 15-834

• “Conduit—Active Topology” on page 15-836

• “Conduit—Results” on page 15-837

• “Conduit—Results: Capacities” on page 15-838

Table 15-5: Pressure Pipe—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-6: Pressure Pipe—Result Attributes

Attribute Description

Flow Representative calculated flow in the pressure pipe. The flow 
calculated in the middle section of the pressure pipe. This is a 
calculated results field and is not editable.

Velocity Representative calculated velocity of the flow in the pressure 
pipe. The velocity calculated in the middle section of the 
pressure pipe. This is a calculated results field and is not 
editable.
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Conduit Attributes
• “Conduit—Results: Engine Parsing” on page 15-839

Conduit—General

Table 15-7: Conduit—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Node 
Reversal

Lets you reverse the direction of the currently highlighted 
element. Click in the field to display an Ellipsis (…) button. 
Clicking the ellipsis button in this field causes the start node 
and stop node to be exchanged with one another, which 
reverses the direction of the currently highlighted element.

Start Node ID Displays the start, or upstream, node of the currently 
highlighted element. This field is not editable.

Stop Node ID Displays the stop, or downstream, node of the currently 
highlighted element. This field is not editable.
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Editing Attributes in the Property Editor
Conduit—Geometry

Conduit—Infiltration

Table 15-8: Conduit—Geometry Attributes

Attribute Description

Has User 
Defined 
Length

Lets you choose whether the highlighted element uses scaled 
or user-defined length. If this field is set to True, the Length 
(User Defined) field is activated. 

Length (User 
Defined)/
Scaled 
Length

Lets you enter a value for the length of the currently 
highlighted element. To use this field, you must set Has User 
Defined Length field to True. If you set this field to False, it 
displays the scaled length for the currently highlighted 
element.

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click in the field to display an Ellipsis (…) 
button, and click the Ellipsis (…) button to use the Polyline 
Vertices feature. For more information, see “Polyline Vertices 
Dialog Box” on page 6-198.

Table 15-9: Conduit—Infiltration Attributes

Attribute Description

Infiltration 
Load Type

Lets you select the type of infiltration load associated with the 
selected conduit. You can select Pipe Length, Pipe Rise-
Length, Pipe Surface Area, Count Based, Hydrograph, 
Pattern Load, or None.

Flow 
(Infiltration)

Lets you enter any additional infiltration flow at the selected 
conduit.

Infiltration 
Loading Unit

Lets you select the unit of measure for the infiltration load. To 
use this field, you must set the Infiltration Loading Type to Pipe 
Length, Pipe Rise-Length, or Pipe Surface Area.

Infiltration 
Rate per 
Loading Unit

Lets you enter the infiltration rate per load for the selected 
conduit. To use this field, you must set the Infiltration Loading 
Type to Pipe Length, Pipe Rise-Length, Pipe Surface Area, 
or Count Based.
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Conduit Attributes
Conduit—Output Filter

Infiltration 
Unit Count

Lets you enter the infiltration unit count for the selected 
conduit. To use this field, you must set the Infiltration Loading 
Type to Count Based.

Hydrograph 
Curve

Lets you define the infiltration load for the selected conduit as 
a hydrograph. Click the Ellipsis (…) button in this field to 
display the Hydrograph Curve dialog box, where you can 
define the Time vs. Flow data points that make up the 
hydrograph curve. To use this field, you must set the Infiltration 
Loading Type to Hydrograph.

Infiltration 
Pattern

Lets you define the infiltration load as a pattern. You can select 
Fixed (the default value), an existing pattern, or Edit Pattern. 
When you select Edit Pattern, the Patterns dialog box appears. 
To use this field, you must set the Infiltration Loading Type to 
Pattern Load.

Flow 
(Infiltration 
Base)

Lets you enter the base infiltration flow for the selected 
conduit. To use this field, you must set the Infiltration Loading 
Type to Pattern Load.

Table 15-9: Conduit—Infiltration Attributes

Attribute Description

Table 15-10: Conduit—Output Filter Attributes

Attribute Description

Output 
Options

Lets you switch between summary and detailed versions of the 
calculation results.

Select Detailed Results to include all the section results for 
the link in the project file. Select Summary Results to include 
results only for the start, middle, and stop sections of a link.
Selecting Summary Results, which stores less data than 
Detailed Reports, might make color coding, annotation, and 
other processes quicker than Detailed Results for larger 
projects. You might use Detailed Results only for a small 
section of a large model.
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Editing Attributes in the Property Editor
Conduit—Physical

Table 15-11: Conduit—Physical Attributes

Attribute Description

Section Type Lets you choose the cross-sectional shape of the currently 
highlighted element: Irregular Open Section, Trapezoidal, 
Circle, Box, Basket-Handle, Ellipse, Horseshoe Conduit, 
Egg, Semi-Ellipse, Catalog Pipe, Pipe-Arch, Virtual, Semi-
Circle, Catenary, Gothic, Modified Basket-Handle, 
Rectangular-Round, Rectangular-Triangle, Power, 
Parabola, Triangle, Rectangular, or Irregular Closed 
Section. The value chosen here affects the availability of the 
following fields.

Station-
Depth Curve

Lets you define station-depth points that describe the shape of 
the irregular channel. Click in the field to display an Ellipsis (…) 
button, and click the Ellipsis (…) button to use the Station-
Depth Curve dialog box. To use this field, you must set the 
Section type to Irregular Channel.

Elevations 
Modifier

The Elevations modifier is a constant value that will be added 
to each elevation value. This attribute is only used during 
SWMM calculations.

Left Bank 
Station

The station value (horizontal distance) in the Station-Depth 
table that marks the end of the left overbank (set to zero or to 
the minimum station value in the Station-Depth curve to denote 
the absence of an overbank). To use this field, you must set 
the Section type to Irregular Channel.

Stations 
Modifier

The Stations modifier is a factor by which the distance between 
each station will be multiplied when the transect data is 
processed by SWMM. Use a value of 0 if no such factor is 
needed. This attribute is only used during SWMM calculations.

Right Bank 
Station

The station value (horizontal distance) in the Station-Depth 
table that marks the start of the right overbank (set to the 
maximum station value in the Station-Depth curve to denote 
the absence of an overbank). To use this field, you must set 
the Section type to Irregular Channel.

Base Width Lets you enter a value for the width at the base of the cross 
section of the currently highlighted element. To use this field, 
you must set The Section Type to Trapezoidal Channel.
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Conduit Attributes
Height Lets you enter a value for the height of the cross section of the 
currently highlighted element. To use this field, you must set 
Section Type to Trapezoidal Channel.

Slope (Right 
Side)

Lets you enter a value for the right slope of the cross section of 
the currently highlighted element. To use this field, you must 
set Section Type to Trapezoidal Channel.

Slope (Left 
Side)

Lets you enter a value for the left slope of the cross section of 
the currently highlighted element. To use this field, you must 
set Section Type to Trapezoidal Channel.

Diameter Lets you enter a value for the diameter of the cross section of 
the currently highlighted element. To use this field, you must 
set The Section Type to Circle.

Fill Depth Is the amount of sedimentation that a section has. To use this 
field, you must set the Section Type to Circle. Only the SWMM 
engine uses this in calculating your model.

Rise Lets you enter a value for the rise (height or vertical 
dimension) of the currently highlighted element. To use this 
field, you must set Section Type to any of the types except 
Circle, Irregular Open Section, Irregular Closed Section, 
Trapezoidal, and Catalog Pipe.

Span Lets you enter a value for the span (width or horizontal 
dimension) of the currently highlighted element. To use this 
field, you must set Section Type to any of the types except 
Circle, Irregular Channel and Trapezoidal Channel.

Number of 
Barrels

Lets you set the number of barrels that comprise the currently 
highlighted element. Note that the diameter, rise, and/or span 
values are applied to each barrel. To use this field, you must 
set Section Type to any of the types except Irregular Open 
Section, Irregular Closed Section, and Trapezoidal.

Catalog Pipe Lets you define or select a catalog pipe for the selected 
conduit. Click in the field to display an Ellipsis (…) button, and 
click the Ellipsis (…) button to use the Catalog Pipe dialog 
box. To use this field, you must set the Section type to Catalog 
Pipe.

Rect Bottom 
Radius

Lets you enter the radius of the circular portion of the 
Rectangular-Round section. To use this field, you must set the 
Section Type to Rectangular-Round.

Table 15-11: Conduit—Physical Attributes

Attribute Description
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Editing Attributes in the Property Editor
Rect Triangle 
Triangle 
Height

Lets you enter the height of the triangular portion of the 
Rectangular-Triangle section. To use this field, you must set 
the Section Type to Rectangular-Triangle.

Power 
Exponent

Lets you enter the power exponent for the Power section. To 
use this field, you must set the Section Type to Power.

Depth-Width 
Curve

Lets you define depth-width points that describe the shape of 
the irregular closed section. Click in the field to display an 
Ellipsis (…) button, and click the Ellipsis (…) button to use the 
Depth-Width Curve dialog box. To use this field, you must set 
the Section type to Irregular Closed Section.

Material Lets you enter the name of the material used. Alternatively, 
clicking the ellipsis button opens the Material Engineering 
Library, allowing you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value will change 
accordingly.

Manning’s n Lets you enter a value for the Manning’s roughness of the 
currently highlighted element. This attribute is active only when 
the Roughness Type attribute is set to Single Manning’s n.

Manning’s n-
Depth Curve

Lets you define points that describe a roughness-depth curve 
for the currently highlighted element. Click in the field to 
display an Ellipsis (…) button, and click the Ellipsis (…) button 
to use the Manning’s n-Depth Curve dialog box. To use this 
field, you must set Roughness Type attribute is set to 
Manning’s n-Depth Curve.

Manning’s n-
Flow

Lets you define points that describe a roughness-flow curve for 
the currently highlighted element. Click in the field to display 
an Ellipsis (…) button, and click the Ellipsis (…) button to use 
the Manning’s n-Flow Curve dialog box. To use this field, you 
must set Roughness Type attribute is set to Manning’s n-
Flow.

Roughness 
Type

Lets you set the roughness method for the currently 
highlighted: Single Manning’s n, Manning’s - Depth Curve, 
or Manning’s n - Flow. The value chosen here affects the 
availability of some fields in the Physical section of the 
Property Editor.

Table 15-11: Conduit—Physical Attributes

Attribute Description
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Set Invert to 
Start Node?

Sets the start invert of the current element to the elevation of 
the start node (upstream). Set this to False to enter a value for 
the elevation of the invert, or set this field to True to use the 
start-node elevation.

Invert (Start) Lets you enter a value for the start, or upstream, invert of the 
currently highlighted element. To use this field, you must set 
Set Invert to Start Node? to False.

Set Invert to 
Stop Node

Sets the stop invert of the current element to the elevation of 
the stop node (downstream). Set this to False to enter a value 
for the elevation of the invert, or set this field to True to use the 
stop-node elevation.

Invert (Stop) Lets you enter a value for the stop, or downstream, invert of 
the currently highlighted element. To use this field, you must 
set Set Invert to Stop Node to False.

Slope The difference between the start invert and stop invert divided 
by the length of the conduit. This is a calculated results field 
and is not editable.

Roughness 
Type

Lets you select the roughness type for the conduit. For more 
information see “Roughness Models” on page 14-742.

Overbank 
Channel

Lets you specify different roughness values for the left 
overbank flow, the channel flow, and the right overbank flow. 
To use this field, you must set the Section type to Irregular 
Channel.

Horizontal 
Segment

Lets you specify a different roughness for each horizontal 
segment of the channel. This information is entered in the 
Station-Depth curve. To use this field, you must set the Section 
Type to Irregular Channel.

Left 
Overbank 
Manning’s n

The Manning's roughness coefficient for overbank flow on the 
left side of the channel (between the minimum station value on 
the Station-Depth curve and the Left Bank Station). To use this 
field, you must set the Section Type to Irregular Channel and 
the Roughness Type to Overbank Channel.

Right 
Overbank 
Manning’s n

The Manning's roughness coefficient for overbank flow on the 
right side of the channel (between the Right Bank Station and 
the maximum station value on the Station-Depth curve). To use 
this field, you must set the Section Type to Irregular Channel 
and the Roughness Type to Overbank Channel.

Table 15-11: Conduit—Physical Attributes

Attribute Description
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Editing Attributes in the Property Editor
Conduit—Physical: Additional Losses

Conduit—Physical: Control Structure

Table 15-12: Conduit—Additional Loss Attributes

Attribute Description

Entrance 
Loss 
Coefficient

Lets you define entrance loss coefficients, if any, for the 
currently highlighted element.

Exit Loss 
Coefficient

Lets you define exit loss coefficients, if any, for the currently 
highlighted element.

Table 15-13: Conduit—Control Structure Attributes

Attribute Description

Start Control 
Structure 
Type

Lets you choose whether to use an Inline or Side Start Control 
Structure for the selected conduit. Inline start control structures 
are used for inline flow regulation while side start control 
structures are used for flow diversion.

Flap Gate? Lets you choose whether or not the highlighted element has a 
flap gate. If this is set to True, and icon displays at the stop-
end of the conduit to display the presence of the structure.
If this is set to True and you design control structures without 
flap gates selected (see “Defining a Control Structure in a 
Conduit” on page 6-192), the flap gate check box will be turned 
on for your control structures and a message displayed.

Has Start/
Stop Control 
Structure?

Lets you define whether or not the currently highlighted 
element has a control structure, and if so, which type. The 
value chosen here affects the availability of the other fields. If 
this is set to True, an icon displays at the start/stop-end of the 
conduit to display the presence of the structure.

Start/Stop 
Control 
Structure

Lets you design a start and/or stop control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to open the 
Conduit Control Structure dialog box to set up the control 
structure you want to use. 
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Conduit—Physical: Section Type: Culvert

To use these attributes, you must set Section Type to Circle or Box. 

Table 15-14: Conduit—Culvert Attributes

Attribute Description

Is Culvert? Lets you choose whether or not the section type for the 
selected conduit is a culvert. If you select True, the other 
Culvert attributes are enabled in the Property Editor. If you 
select False, none of the other Culvert attributes are available 
in the Property Editor.

Inlet 
Description

Lets you type or select a description for the inlet. Click the 
Ellipse (...) button to display the Culvert Inlet Coefficient 
Engineering Library, where you can select an existing culvert.

Culvert 
Equation 
Form

Lets you select Form 1 or Form 2. To use this field, you must 
set the Section Type to Circle or Box and the Is Culvert? 
attribute to True.

C Lets you define the C equation coefficient that is used in the 
submerged inlet control equation. To use this field, you must 
set the Section Type  to Circle or Box and Is Culvert? to True.

M Lets you define the M equation coefficient that is used in both 
forms of the unsubmerged inlet control equation. To use this 
field, you must set the Section Type  to Circle or Box and Is 
Culvert? to True.

K Lets you define the K equation coefficient that is used in both 
forms of the unsubmerged inlet control equation. To use this 
field, you must set the Section Type to Circle or Box and Is 
Culvert? to True.

Y Lets you define the Y equation coefficient that is used in the 
submerged inlet control equation. To use this field, you must 
set the Section Type  to Circle or Box and Is Culvert? to True.

Ke Lets you define the entrance loss value for the associated 
conduit. To use this field, you must set the Section Type to 
Circle or Box and Is Culvert? to True.

Kr Lets you define the reverse flow loss value for the associated 
conduit. To use this field, you must set the Section Type  to 
Circle or Box and Is Culvert? to True.
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Slope 
Correction 
Factor

Lets you define the Slope Correction Factor to be used in inlet 
control calculations. Normally this factor is –0.5, but for mitered 
inlets, HDS No. 5 suggests +0.7.To use this field, you must set 
the Section Type  to Circle or Box and Is Culvert? to True.

Has 
Overtopping 
Weir?

If True, this allows the user to specify a section of roadway that 
acts as an overtopping weir in the event that the culvert 
headwater elevation exceeds the roadway elevation. When set 
to true, SewerGEMS V8i will include the overtopping weir in 
the elevation-discharge-tailwater (EQT) calculations for the 
culvert crossing. Weir flow is computed assuming the road 
acts as a broad-crested weir. Flow that passes over the 
overtopping weir will discharge to the same downstream node 
as the culvert.

Elevation 
(Roadway 
Crest)

The elevation of the roadway crest. If the culvert headwater 
elevation exceeds this elevation, flow will overtop the roadway 
and the roadway will act like a weir.

Roadway 
Cross 
Section 
Length

The length of the roadway section acting as a weir when flow 
is overtopping the road. Often this is set equal the top width of 
flow in the channel upstream of the culvert. 

Use Weir C-
Depth Table?

If True, this lets you define a table of weir coefficient versus 
flow depth values to simulate a weir coefficient that changes as 
the flow depth changes.

C-Depth 
Table

A table of weir coefficient versus flow depth values. To use this 
field you must set the 'Use Weir C-Depth Table?' field to True.

Roadway 
Weir 
Coefficient

The weir coefficient for the roadway (typically between 2.5 and 
3.1 for US units, or between 1.4 and 1.7 for SI units). This 
coefficient is considered dimensionless and is used in the 
broad crested weir equation (see “Broad-Crested Weir” on 
page 14-760) to compute the flow that overtops the roadway. 
To use this field you must set the 'Use Weir C-Depth Table?' 
field to False.

Table 15-14: Conduit—Culvert Attributes

Attribute Description
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Conduit—Active Topology

Depth 
(Maximum 
Overtopping)

This value is used to determine the maximum headwater 
elevation to use when computing the culvert EQT table 
(maximum headwater equals 'Elevation (Roadway Crest)' plus 
'Depth (Maximum Overtopping). To ensure accurate 
calculations this value should be set higher than the maximum 
expected depth of flow over the weir; however users should 
note that using very large values for this field may slow down 
model computations. If the headwater exceeds the highest 
elevation in the EQT table SewerGEMS V8i will linearly 
extrapolate the values.

Increment The depth increment used to generate EQT curves. A small 
value provides more accuracy but reduces the performance.

User Defined 
Tailwater?

If True, this lets the user specify the maximum tailwater 
elevation used when computing the culvert EQT table. If False, 
SewerGEMS V8i will chose a maximum tailwater elevation 
based on the geometry of the downstream element (for 
example if the culvert discharges to a channel downstream, 
SewerGEMS V8i will use the channel's top water level)

Elevation 
(Maximum 
Tailwater)

Lets you define the maximum tailwater elevation used when 
computing the culvert EQT table. To ensure accurate 
calculations, this elevation should be greater that the highest 
expected water surface elevation at the element immediately 
downstream from the culvert; however users should note that 
using very large values for this field may slow down model 
computations. To use this field you must set the 'User Defined 
Tailwater?' field to True.

Table 15-14: Conduit—Culvert Attributes

Attribute Description

Table 15-15: Conduit—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Conduit—Results

The hydraulic grade, flow, and depth/rise presented in the Property Editor are the 
values associated with the middle section of the link. Obviously these values don't 
give you the full sense of what is going on, so the middle, start, and stop values are 
also available through the FlexTables, and you can also look at the profile. (For more 
information, see “Viewing and Editing Data in FlexTables” on page 10-557 and 
“Using Profiles” on page 10-548.)

Table 15-16: Conduit—Result Attributes

Attribute Description

Flow Representative calculated flow in the conduit. The flow 
calculated in the middle section of the conduit. This is a 
calculated results field and is not editable.

Velocity Representative calculated velocity of the flow in the conduit. 
The velocity calculated in the middle section of the conduit. 
This is a calculated results field and is not editable.

Sections 
Results

Lets you view the calculated flow variables at the start, middle 
and end of the conduit section. Clicking the Ellipses (...) 
button displays the Sections Results dialog box.

Pollutants Lets you view calculated results for pollutants. Clicking the 
Ellipses (...) button displays the Pollutants Results dialog box.
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Conduit—Results: Capacities

Table 15-17: Conduit—Result: Capacity Attributes

Attribute Description

Capacity (Full) The normal full flow depth of the conduit. This is a calculated 
results field and is not editable.

Capacity 
(Excess Full)

The difference between the flow in the conduit and the 
Capacity (Full). This is a calculated results field and is not 
editable.

Flow/Full Flow 
Capacity

The ratio of the flow in the conduit to the Capacity (Full). This is 
a calculated results field and is not editable.

Design 
Percent Full

Lets you enter the percentage full that you would like the link to 
maintain. If you want the pipe to be 75% full, enter in the 75 in 
the field. These values do not affect network calculations; they 
are informational only.
In the Results attributes is a field called Capacity (Calculated 
Design). This displays the result of calculating with the 
Manning’s equation the amount of flow going through the link if 
it were full to the percentage you set in Design Percent Full (in 
this example, the amount of flow if the link were 75% full).

Capacity 
(Calculated 
Design)

The normal flow calculated based on the percent of full flow 
established by the design percent full. This is a calculated 
results field and is not editable.

Capacity 
(Excess 
Design)

The difference between the flow in the conduit and the 
Capacity (Calculated Design). This is a calculated results field 
and is not editable.

Flow/Design 
Capacity

The ratio of the flow in the conduit to the Capacity (Calculated 
Design). This is a calculated results field and is not editable.
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Conduit—Results: Engine Parsing

Table 15-18: Conduit—Result: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.

Section Count The number of sections that the implicit engine divides the 
conduits into during an analysis. Not available during a SWMM 
analysis. This is a calculated results field and is not editable. 
For more information, see “Section Count” on page 14-723.
Bentley SewerGEMS V8i User’s Guide 15-839



Channel Attributes
Channel Attributes
The channel attributes comprise the following categories:

• “Channel—General” on page 15-840

• “Channel—Geometry” on page 15-841

• “Channel—Active Topology” on page 15-843

• “Channel—Output Filter” on page 15-842

• “Channel—Physical” on page 15-842

• “Channel—Physical: Control Structure” on page 15-843

• “Channel—Results” on page 15-844

• “Channel—Results: Engine Parsing” on page 15-844

Channel—General

Table 15-19: Channel—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.
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Channel—Geometry

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Node 
Reversal

Lets you reverse the direction of the currently highlighted 
element. Click in the field to display an Ellipsis (…) button. 
Clicking the ellipsis button in this field causes the start node 
and stop node to be exchanged with one another, which 
reverses the direction of the currently highlighted element.

Start Node ID Displays the start, or upstream, node of the currently 
highlighted element. This field is not editable.

Stop Node ID Displays the stop, or downstream, node of the currently 
highlighted element. This field is not editable.

Table 15-19: Channel—General Attributes

Attribute Description

Table 15-20: Channel—Geometry Attributes

Attribute Description

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click the Ellipsis (…) button in this field to 
open the Polyline Vertices dialog box. For more information, 
see “Polyline Vertices Dialog Box” on page 6-198.

Has User 
Defined 
Length

Lets you choose whether the highlighted element uses scaled 
or user-defined length. If this field is set to True, the Length 
(User Defined) field is activated.

Length (User 
Defined)/
Scaled 
Length

Lets you enter a value for the length of the currently 
highlighted element. This attribute is active only when the Has 
User Defined Length attribute is set to True. If this field is set to 
False, it displays the scaled length for the currently highlighted 
element.
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Channel—Output Filter

Channel—Physical

Manning's n is not a property of a channel but a property of the cross-section 
nodes along the channel. The cross-section defines the shape and other phys-
ical properties of the channel (except for length). The properties between two 
cross sections are interpolated. For more information, see “Cross Section—Phys-
ical” on page 15-875.

Table 15-21: Channel—Output Filter Attributes

Attribute Description

Output 
Options

Lets you switch between summary and detailed versions of the 
calculation results. 

Select Detailed Results to include all the section results for 
the link in the project file. Select Summary Results to include 
results only for the start, middle, and stop sections of a link.
Selecting Summary Results, which stores less data than 
Detailed Reports, might make color coding, annotation, and 
other processes quicker than Detailed Results for larger 
projects. You might use Detailed Results only for a small 
section of a large model.

Table 15-22: Channel—Physical Attributes

Attribute Description

Invert (Start) Lets you enter a value for the start, or upstream, invert of the 
currently highlighted element.

Invert (Stop) Lets you enter a value for the stop, or downstream, invert of 
the currently highlighted element.

Slope The difference between the start invert and stop invert divided 
by the length of the channel. This is a calculated results field 
and is not editable.
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Channel—Physical: Control Structure

Channel—Active Topology

Table 15-23: Channel—Control Structure Attributes

Attribute Description

Start Control 
Structure 
Type

Lets you choose whether to use an Inline or Side Start Control 
Structure for the selected conduit. Inline start control structures 
are used for inline flow regulation while side start control 
structures are used for flow diversion. A side control is applied 
to control structures which generally divert flow at higher levels 
and an inline structure is applied to the primary flow direction.

Flap Gate? Lets you choose whether or not the highlighted element has a 
flap gate. If this is set to True, and icon displays at the stop-
end of the conduit to display the presence of the structure.
If this is set to True and you design control structures without 
flap gates selected, the flap gate check box will be turned on 
for your control structures and a message displayed.

Has Start/
Stop Control 
Structure?

Lets you define whether or not the currently highlighted 
element has a control structure, and if so, which type. The 
value chosen here affects the availability of the other fields. If 
this is set to True, an icon displays at the start/stop-end of the 
conduit to display the presence of the structure.

Start/Stop 
Control 
Structure

Lets you design a start and/or stop control structure, or choose 
a preexisting one. Click the Ellipsis (…) button to open the 
Conduit Control Structure dialog box to set up the control 
structure you want to use. 

Table 15-24: Channel—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Channel Attributes
Channel—Results

The hydraulic grade, flow, and depth/rise presented in the Property Editor are the 
values associated with the middle section of the link. Obviously these values don't 
give you the full sense of what is going on, so the middle, start, and stop values are 
also available through the FlexTables, and you can also look at the profile. (For more 
information, see “Viewing and Editing Data in FlexTables” on page 10-557 and 
“Using Profiles” on page 10-548.)

Channel—Results: Engine Parsing

Table 15-25: Channel—Result Attributes

Attribute Description

Flow Representative calculated flow in the channel. The flow is 
calculated in the middle section of the channel. This is a 
calculated results field and is not editable.

Velocity Representative calculated velocity of the flow in the channel. 
The velocity is calculated in the middle section of the channel. 
This is a calculated results field and is not editable.

Sections 
Results

Lets you view the calculated flow variables at the start, middle 
and end of the channel section. Clicking the Ellipses (...) 
button displays the Sections Results dialog box.

Pollutants Lets you view calculated results for pollutants. Clicking the 
Ellipses (...) button displays the Pollutants Results dialog box.

Table 15-26: Channel—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.

Section Count The number of sections that the implicit engine divides the 
channels into during an analysis. Not available during a 
SWMM analysis. This is a calculated results field and is not 
editable. For more information, see “Section Count” on 
page 14-723.
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Gutter Attributes
The gutter attributes comprise the following categories:

• “Gutter—General” on page 15-845

• “Gutter—Geometry” on page 15-846

• “Gutter—Physical” on page 15-846

• “Gutter—Active Topology” on page 15-847

• “Gutter—Results” on page 15-848

Gutter—General

Table 15-27: Gutter—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Node 
Reversal

Lets you reverse the direction of the currently highlighted 
element. Click in the field to display an Ellipsis (…) button. 
Clicking the ellipsis button in this field causes the start node 
and stop node to be exchanged with one another, which 
reverses the direction of the currently highlighted element.

Start Node ID Displays the start, or upstream, node of the currently 
highlighted element. This field is not editable.

Stop Node ID Displays the stop, or downstream, node of the currently 
highlighted element. This field is not editable.
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Gutter Attributes
Gutter—Geometry

Gutter—Physical

Table 15-28: Gutter—Geometry Attributes

Attribute Description

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click the Ellipsis (…) button in this field to 
open the Polyline Vertices dialog box. For more information, 
see “Polyline Vertices Dialog Box” on page 6-198.

Has User 
Defined 
Length

Lets you choose whether the highlighted element uses scaled 
or user-defined length. If this field is set to True, the Length 
(User Defined) field is activated.

Length (User 
Defined)/
Scaled 
Length

Lets you enter a value for the length of the currently 
highlighted element. This attribute is active only when the Has 
User Defined Length attribute is set to True. If this field is set to 
False, it displays the scaled length for the currently highlighted 
element.

Table 15-29: Gutter—Physical Attributes

Attribute Description

Open Cross 
Section

Lets you choose the cross-sectional shape of the currently 
highlighted element. The value chosen here (Trapezoidal or 
Irregular) affects the availability of the following fields.

Irregular 
Channel

Lets you define station-elevation points that describe the 
shape of the irregular channel. Click in the field to display an 
Ellipsis (…) button, and click the Ellipsis (…) button to use the 
Irregular Channel dialog box. To use this field, you must set 
Open Cross-Section attribute to Irregular Channel.

Bottom Width Lets you enter a value for the width at the base of the cross 
section of the currently highlighted element. To use this field, 
you must set Open Cross-Section attribute to Trapezoidal 
Channel.

Slope (Left 
Side)

Lets you enter a value for the left slope of the cross section of 
the currently highlighted element. To use this field, you must 
set Open Cross-Section attribute to Trapezoidal Channel.
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Gutter—Active Topology

Slope (Right 
Side)

Lets you enter a value for the right slope of the cross section of 
the currently highlighted element. To use this field, you must 
set the Open Cross-Section attribute to Trapezoidal Channel.

Trapezoidal 
Channel 
Depth

Lets you enter a value for the depth.To use this field, you must 
set the Open Cross-Section attribute to Trapezoidal Channel.

Gutter 
Material

Lets you enter the name of the material used. Alternatively, 
clicking the ellipsis button opens the Material Engineering 
Library, allowing you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value will change 
accordingly.

Manning’s n 
(Gutter)

Lets you enter a value for the Manning’s roughness of the 
currently highlighted gutter. Click in the field to display an 
Ellipsis (…) button, and click the Ellipsis (…) button to use the 
Engineering Library to select a Manning’s n value for the gutter 
material you are using.

Slope Lets you enter a value for the slope of the gutter.

Table 15-29: Gutter—Physical Attributes

Attribute Description

Table 15-30: Gutter—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Manhole Attributes
Gutter—Results

Manhole Attributes
The manhole attributes comprise the following categories:

• “Manhole—General” on page 15-849

• “Manhole—Geometry” on page 15-849

• “Manhole—Physical” on page 15-850

• “Manhole—Physical: Structure Losses” on page 15-851

• “Manhole—Physical: Surface Storage” on page 15-852

• “Manhole—Sanitary Loading” on page 15-852

• “Manhole—SWMM Extended Data” on page 15-853

• “Manhole—Active Topology” on page 15-853

• “Manhole—Inflow” on page 15-853

• “Manhole—Results” on page 15-854

• “Manhole—Results: Engine Parsing Attributes” on page 15-854

• “Manhole—Results: Extended Node Attributes” on page 15-855

• “Manhole—Results: Flows Attributes” on page 15-855

Table 15-31: Gutter—Results Attributes

Attribute Description

Flow Representative calculated flow in the gutter. The flow is 
calculated in the middle section of the gutter. This is a 
calculated results field and is not editable.

Velocity Representative calculated velocity of the flow in the gutter. The 
velocity is calculated in the middle section of the gutter. This is 
a calculated results field and is not editable.

Depth/Rise The ratio of the depth of flow in the channel divided by the 
height of the gutter. This is a calculated results field and is not 
editable.

Depth The depth of flow measured from the invert of the gutter. A 
gutter is assumed to have the same depth throughout the link 
(i.e., there is no middle, start, and stop depths, just a constant).
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Manhole—General

Manhole—Geometry

Table 15-32: Manhole—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-33: Manhole—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Manhole—Physical

Table 15-34: Manhole—Physical Attributes

Attribute Description

Elevation 
(Ground)

Displays the ground elevation for the currently highlighted 
node.

Set Rim to 
Ground 
Elevation?

Enables or disables a data entry shortcut. If the value is True, 
the node’s rim elevation is set equal to the ground elevation 
automatically. 

Elevation 
(Rim)

Lets you define the top elevation of the currently highlighted 
node. This elevation is typically flush with the ground surface. 
In some cases, the rim elevation may be slightly below the 
ground surface elevation (sunk) or slightly above the ground 
surface elevation (raised).

Elevation 
(Invert)

Lets you define the elevation at the bottom of the currently 
highlighted node.

Structure 
Shape Type

Lets you choose the shape of the currently highlighted 
element. You can select Rectangular Structure or Circular 
Structure. The value chosen here affects the availability of 
other fields.

Diameter Lets you enter a value for the diameter of the currently 
highlighted element. This field is available only when the 
Structure Shape Type attribute is set to Circular Structure. 

Length Lets you enter a value for the length of the currently 
highlighted element. This field is available only when the 
Structure Shape Type attribute is set to Rectangular 
Structure.

Width Lets you enter a value for the width of the currently highlighted 
element. This field is available only when the Structure Shape 
Type attribute is set to Rectangular Structure.

Bolted Cover Lets you set whether a manhole has a bolted cover or not. A 
value of True in this field indicates that the associated 
manhole has a bolted cover. If the manhole cover is bolted, 
then the hydraulic grade line is not reset to the rim elevation at 
the downstream end of the upstream pipes in the case of a 
flooding situation (the calculated HGL being higher than the 
rim elevation).
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Manhole—Physical: Structure Losses

Table 15-35: Manhole—Structure Loss Attributes

Attribute Description

Headloss 
Method

Lets you select the headloss method to use: Absolute, HEC-
22, Generic, or Standard.

Absolute 
Headloss

Lets you enter a value for the headloss. This field is only 
available if you selected the Absolute Headloss Method.

Headloss 
Coefficient 
Stop

Lets you enter a value for the headloss coefficient at the stop 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient 
Start

Lets you enter a value for the headloss coefficient at the start 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient

Lets you enter a value for the headloss coefficient for the 
manhole. This field is only available if you selected the 
Standard Headloss Method.
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Manhole Attributes
Manhole—Physical: Surface Storage

Manhole—Sanitary Loading

Table 15-36: Manhole—Surface Storage Attributes

Attribute Description

Surface 
Storage Type

Lets you choose how surface storage is handled. The value 
chosen here affects the availability of other fields: select 
Default Storage Equation, Surface Depth-Area Curve, No 
Storage, or Ponded Area.The Default Storage Equation uses 
the following formula:

Area = 0.262 y - 0.068 y2   + 0.006 y3              (y<4.0 ft)
Area=0.344                                                        (y>4.0 ft)
 
where Y is the depth above the ground.

Surface 
Depth-Area 
Curve

Lets you describe the volume of the surface storage by 
defining depth vs. area points. Click the Ellipsis (…) button in 
this field to open the Surface Depth-Area dialog box (see 
“Surface Depth-Area Curve Editor” on page 6-210). This field 
is available only when the Surface Storage Type attribute is set 
to Surface Depth-Area Curve.

Area 
(Constant 
Surface)

Lets you define the area in which ponding occurs at the 
currently selected element. It is available only when the 
Surface Storage Type attribute is set to Ponded Area.

Table 15-37: Manhole—Sanitary Loading Attributes

Attribute Description

Sanitary 
Loads

Lets you define a sanitary (dry weather) flow collection for the 
selected manhole. Click the Ellipses (...) button to display the 
Sanitary (Dry Weather) Flow Collection Editor, which lets you 
define collections of sanitary (dry weather) loads.
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Manhole—SWMM Extended Data

Manhole—Active Topology

Manhole—Inflow

Table 15-38: Manhole—SWMM Extended Data Attributes

Attribute Description

Apply 
Treatment?

Lets you specify whether or not treatment is applied at the 
currently highlighted element. Select True to apply treatment. 
This field is only used during SWMM calculations.

Treatment Lets you add a collection of pollutants and their associated 
treatment functions that will be applied at the currently 
highlighted element. This field is used only during SWMM 
calculations and is available only if Apply Treatment? is set to 
True. For more information, see “Adding Treatment to a Node” 
on page 6-321.

Pollutograph
s

Lets you define a pollutograph collection for the selected 
manhole. Click the Ellipses (...) button to display the 
Pollutograph Collection dialog box, which lets you add multiple 
pollutographs to the collection. For more information, see 
“Adding Pollutographs to a Node” on page 6-307.

Table 15-39: Manhole—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-40: Manhole—Inflow Attributes

Attribute Description

Inflow 
Collection

Lets you define an inflow collection for the selected manhole. 
Click the Ellipsis (…) button to display the Inflow Collection 
dialog box for the associated element (see “Defining Inflow 
Collections” on page 7-378).
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Manhole Attributes
Manhole—Results

Manhole—Results: Engine Parsing Attributes

Table 15-41: Manhole—Results Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the manhole. 
This is a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded? If this field displays True, flooding occurs at the currently 
highlighted element during the current time step. For manhole 
and catch basin elements, this field will display True if the HGL 
goes above the rim elevation. This is a calculated results field 
and is not editable.

Total Outflow Sum of all flows leaving manhole. This is a calculated results 
field and is not editable.

Overflow Flow that exits system during analysis. This is a calculated 
results field and is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.

Table 15-42: Manhole—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
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Manhole—Results: Extended Node Attributes

Manhole—Results: Flows Attributes

Catch Basin Attributes
The catch basin attributes comprise the following categories:

• “Catch Basin—General” on page 15-856

• “Catch Basin—Geometry” on page 15-857

Table 15-43: Manhole—Results: Extended Node Attributes

Attribute Description

Freeboard 
Height

Distance between the top of the manhole and the water 
surface. This is a calculated results field and is not editable.

Depth 
(Flooding)

Depth between top of manhole and the water surface when the 
manhole is flooded. This is a calculated results field and is not 
editable.

Volume Calculated volume at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded 
Ever?

If this field displays True, flooding occurs at least once during 
the simulation at the currently highlighted element. This is a 
calculated results field and is not editable.

Table 15-44: Manhole—Result: Flow Attributes

Attribute Description

Local Inflow? This field displays True if there is a user-defined flow at the 
element, and False if there is not. This is a calculated results 
field and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Total Surface 
Inflow

Total flow coming into manhole from runoff. This is a calculated 
results field and is not editable.

Flow (Total 
In)

Sum of all flows coming into manhole. This is a calculated 
results field and is not editable.
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Catch Basin Attributes
• “Catch Basin—Physical” on page 15-857

• “Catch Basin—Physical: Structure Losses” on page 15-858

• “Catch Basin—Physical: Surface Storage” on page 15-859

• “Catch Basin—Sanitary Loading” on page 15-859

• “Catch Basin—SWMM Extended Data” on page 15-860

• “Catch Basin—Active Topology” on page 15-860

• “Catch Basin—Inflow” on page 15-860

• “Catch Basin—Inlet” on page 15-861

• “Catch Basin—Results” on page 15-861

• “Catch Basin—Results: Engine Parsing Attributes” on page 15-862

• “Catch Basin—Results: Extended Node Attributes” on page 15-863

• “Catch Basin—Results: Flows Attributes” on page 15-863

• “Catch Basin—Results: Inlet Capture” on page 15-864

Catch Basin—General

Table 15-45: Catch Basin—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.
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Catch Basin—Geometry

Catch Basin—Physical

Table 15-46: Catch Basin—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 

Table 15-47: Catch Basin—Physical Attributes

Attribute Description

Elevation 
(Ground)

Displays the ground elevation for the currently highlighted 
node.

Set Rim to 
Ground 
Elevation?

Enables or disables a data entry shortcut. If the value is True, 
the node’s rim elevation is set equal to the ground elevation 
automatically. If this value is set to False, you must manually 
enter the rim elevation.

Elevation 
(Rim)

Lets you define the top elevation of the currently highlighted 
node. This elevation is typically flush with the ground surface. 
In some cases, the rim elevation may be slightly below the 
ground surface elevation (sunk) or slightly above the ground 
surface elevation (raised). You can only enter a value in this 
field if Set Rim to Ground Elevation? is set to False.

Elevation 
(Invert)

Lets you define the elevation at the bottom of the currently 
highlighted node.
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Catch Basin Attributes
Catch Basin—Physical: Structure Losses

Structure 
Shape Type

Lets you choose the shape of the currently highlighted 
element. You can select Rectangular Structure or Circular 
Structure. The value chosen here affects the availability of 
other fields.

Diameter Lets you enter a value for the diameter of the currently 
highlighted element. This field is available only when the 
Structure Shape Type attribute is set to Circular Structure. 

Length Lets you enter a value for the length of the currently 
highlighted element. This field is available only when the 
Structure Shape Type attribute is set to Rectangular 
Structure.

Width Lets you enter a value for the width of the currently highlighted 
element. This field is available only when the Structure Shape 
Type attribute is set to Rectangular Structure.

Table 15-47: Catch Basin—Physical Attributes

Attribute Description

Table 15-48: Catch Basin—Structure Loss Attributes

Attribute Description

Headloss 
Method

Lets you select the headloss method to use: Absolute, HEC-
22, Generic, or Standard.

Absolute 
Headloss

Lets you enter a value for the headloss. This field is only 
available if you selected the Absolute Headloss Method.

Headloss 
Coefficient 
Stop

Lets you enter a value for the headloss coefficient at the stop 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient 
Start

Lets you enter a value for the headloss coefficient at the start 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient

Lets you enter a value for the headloss coefficient for the 
manhole. This field is only available if you selected the 
Standard Headloss Method.
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Catch Basin—Physical: Surface Storage

Catch Basin—Sanitary Loading

Table 15-49: Manhole—Surface Storage Attributes

Attribute Description

Surface 
Storage Type

Lets you choose how surface storage is handled. The value 
chosen here affects the availability of other fields: select 
Default Storage Equation, Surface Depth-Area Curve, No 
Storage, or Ponded Area.The Default Storage Equation uses 
the following formula:

Area = 0.262 y - 0.068 y2   + 0.006 y3              (y<4.0 ft)
Area=0.344                                                        (y>4.0 ft)
 
where Y is the depth above the ground.

Surface 
Depth-Area 
Curve

Lets you describe the volume of the surface storage by 
defining depth vs. area points. Click the Ellipsis (…) button in 
this field to open the Surface Depth-Area dialog box (see 
“Surface Depth-Area Curve Editor” on page 6-210). This field 
is available only when the Surface Storage Type attribute is set 
to Surface Depth-Area Curve.

Area 
(Constant 
Surface)

Lets you define the area in which ponding occurs at the 
currently selected element. It is available only when the 
Surface Storage Type attribute is set to Ponded Area.

Table 15-50: Catch Basin—Sanitary Loading Attributes

Attribute Description

Sanitary 
Loads

Lets you define a sanitary (dry weather) flow collection for the 
selected catch basin. Click the Ellipses (...) button to display 
the Sanitary (Dry Weather) Flow Collection Editor, which lets 
you define collections of sanitary (dry weather) loads.
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Catch Basin Attributes
Catch Basin—SWMM Extended Data

Catch Basin—Active Topology

Catch Basin—Inflow

Table 15-51: Catch Basin—SWMM Extended Data Attributes

Attribute Description

Apply 
Treatment?

Lets you specify whether or not treatment is applied at the 
currently highlighted element. Select True to apply treatment. 
This field is only used during SWMM calculations.

Treatment Lets you add a collection of pollutants and their associated 
treatment functions that will be applied at the currently 
highlighted element. This field is used only during SWMM 
calculations and is available only if Apply Treatment? is set to 
True. For more information, see “Adding Treatment to a Node” 
on page 6-321.

Pollutographs Lets you define a pollutograph collection for the selected 
manhole. Click the Ellipses (...) button to display the 
Pollutograph Collection dialog box, which lets you add multiple 
pollutographs to the collection. For more information, see 
“Adding Pollutographs to a Node” on page 6-307.

Table 15-52: Catch Basin—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-53: Catch Basin—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see “Defining 
Inflow Collections” on page 7-378). 
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Editing Attributes in the Property Editor
Catch Basin—Inlet

Catch Basin—Results

Table 15-54: Catch Basin—Inlet Attributes

Attribute Description

Inlet Type Lets you choose the type of element associated with the 
currently highlighted element: Maximum Capacity, Inflow-
Capture Curve, or Full Capture. The value chosen here 
affects the availability of the other fields described below.

Flow 
(Maximum 
in)

Lets you define the maximum inflow accepted by the inlet 
associated with the currently highlighted element. This field is 
available only when the Inlet Type attribute is set to Maximum 
Capacity.

Inflow-
Capture 
Curve

Lets you define inflow vs. capture percentage points for the 
currently highlighted element. Clicking the Ellipsis (…) button 
in the field opens the Inflow-Capture Curve dialog box (see 
“Inflow-Capture Curve Dialog Box” on page 6-208). This field is 
available only when the Inlet Type attribute is set to Inflow-
Capture Curve.

Table 15-55: Catch Basin—Results Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the catch basin. 
This is a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.
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Catch Basin Attributes
Catch Basin—Results: Engine Parsing Attributes

Is Flooded? If this field displays True, flooding occurs at the currently 
highlighted element during the current time step. For manhole 
and catch basin elements, this field will display True if the HGL 
goes above the rim elevation. This is a calculated results field 
and is not editable.

Total Outflow Sum of all flows leaving catch basin. This is a calculated 
results field and is not editable.

Overflow Flow that exits system during analysis. This is a calculated 
results field and is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.

Table 15-55: Catch Basin—Results Attributes

Attribute Description

Table 15-56: Catch Basin—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
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Catch Basin—Results: Extended Node Attributes

Catch Basin—Results: Flows Attributes

Table 15-57: Catch Basin—Results: Extended Node Attributes

Attribute Description

Freeboard 
Height

Distance between the top of the catch basin and the water 
surface. This is a calculated results field and is not editable.

Depth 
(Flooding)

Depth between top of catch basin and the water surface when 
the catch basin is flooded. This is a calculated results field and 
is not editable.

Volume Calculated volume at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded 
Ever?

If this field displays True, flooding occurs at least once during 
the simulation at the currently highlighted element. This is a 
calculated results field and is not editable.

Table 15-58: Catch Basin—Result: Flow Attributes

Attribute Description

Local Inflow? This field displays True if there is a user-defined flow at the 
element, and False if there is not. This is a calculated results 
field and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Total Surface 
Inflow

Total flow coming into catch basin from runoff. This is a 
calculated results field and is not editable.

Flow (Total 
In)

Sum of all flows coming into catch basin. This is a calculated 
results field and is not editable.
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Outfall Attributes
Catch Basin—Results: Inlet Capture

Outfall Attributes
The outfall attributes comprise the following categories:

• “Outfall—General” on page 15-865

• “Outfall—Geometry” on page 15-865

• “Outfall—Boundary Condition” on page 15-866

• “Outfall—Physical” on page 15-868

• “Outfall—Active Topology” on page 15-869

• “Outfall—SWMM Extended Data” on page 15-868

• “Outfall—Inflow” on page 15-869

• “Outfall—Results” on page 15-869

• “Outfall—Results: Flows” on page 15-870

Table 15-59: Catch Basin—Result: Inlet Capture Attributes

Attribute Description

Flow 
(Captured)

Total amount of flow captured at the currently highlighted 
element. This is a calculated results field and is not editable.

Capture 
Efficiency

Percentage of flow that is captured at the currently highlighted 
element. This is a calculated results field and is not editable.
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Outfall—General

Outfall—Geometry

Table 15-60: Outfall—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-61: Outfall—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Outfall Attributes
Outfall—Boundary Condition

Table 15-62: Outfall—Boundary Condition Attributes

Attribute Description

Boundary 
Condition 
Type

Lets you define what type of boundary condition the currently 
highlighted element is operating under. The value chosen here 
affects the availability of other fields. You can choose from:
Free Outfall - No tailwater condition. No further input is 
necessary.
Time-Elevation Curve - Enables Time-Elevation Curve field.
Elevation (User Defined Tailwater) - Enables the User 
Defined Tailwater field.
Elevation-Flow Curve - Enables Elevation Flow Curve field.
Boundary Element - Enables Boundary Element field, 
allowing you to specify the element to which flow received by 
the outfall is discharged.
Normal - No further input is necessary. Normal in this case 
means that the depth at the outlet is the normal depth for the 
last conduit or channel before the outlet.
Tidal - Enables the Cyclic Time-Elevation Curve field.

Time-
Elevation 
Curve

Lets you describe the elevation changes at the boundary 
condition over time. Click the Ellipsis (…) button in this field to 
open the Time-Elevation Curve dialog box (see “Time-
Elevation Curve Dialog Box” on page 6-223). It is available 
only when the Boundary Condition Type attribute is set to 
Time-Elevation Curve. 
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Elevation 
(User 
Defined 
Tailwater)

Lets you enter a value for tailwater at the boundary. It is 
available only when the Boundary Condition Type is set to 
User Defined Tailwater.

Elevation-
Flow Curve

Lets you define the elevation changes at the boundary 
condition over a range of flows. Click the Ellipsis (…) button in 
this field to open the Elevation-Flow Curve dialog box (see 
“Elevation-Flow Curve Dialog Box” on page 6-225). This 
property is available only when the Boundary Condition Type 
attribute is set to Elevation-Flow Curve.

Boundary 
Element

Lets you choose the boundary element for the currently 
highlighted element from all of the valid elements in the 
network. 

To use this feature, click Select in the Boundary Element field. 
Move the cursor over the drawing pane and click the element 
you want to select for the boundary. This property is available 
only when the Boundary Condition Type attribute is set to 
Boundary Element.

Tip: Press the Esc key to exit out of “Select” 
mode.

Cyclic Time-
Elevation 
Curve

Lets you describe the elevation changes at the boundary 
condition that repeat over time. Click the Ellipsis (…) button in 
this field to open the Cyclic Time-Elevation Curve dialog box 
(see “Time-Elevation Curve Dialog Box” on page 6-223). It is 
available only when the Boundary Condition Type attribute is 
set to Tidal.

Table 15-62: Outfall—Boundary Condition Attributes

Attribute Description
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Outfall Attributes
Outfall—Physical

Outfall—SWMM Extended Data

Table 15-63: Outfall—Physical Attributes

Attribute Description

Elevation 
(Ground)

Lets you define the elevation of the currently highlighted 
element.

Set Invert 
Equal to 
Ground 
Elevation?

Sets the invert of the current element to the value specified in 
the Ground Elevation field.

Elevation 
(Invert)

Lets you define the elevation at the bottom of the currently 
highlighted node.

Table 15-64: Outfall—SWMM Extended Data Attributes

Attribute Description

Apply 
Treatment?

Lets you specify whether or not treatment is applied at the 
currently highlighted element. This field is only used during 
SWMM calculations.

Treatment Lets you add a collection of pollutants and their associated 
treatment functions that will be applied at the currently 
highlighted element. This field is used only during SWMM 
calculations and is available only if Apply Treatment? is set to 
True. For more information, see “Adding Treatment to a Node” 
on page 6-321.

Pollutograph
s

Lets you define a pollutograph collection for the selected 
manhole. Click the Ellipses (...) button to display the 
Pollutograph Collection dialog box, which lets you add multiple 
pollutographs to the collection. For more information, see 
“Adding Pollutographs to a Node” on page 6-307.
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Outfall—Active Topology

Outfall—Inflow

Outfall—Results

Table 15-65: Outfall—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-66: Outfall—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see “Defining 
Inflow Collections” on page 7-378).

Table 15-67: Outfall—Result Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the outfall. This is 
a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Total Outflow Sum of all flows leaving outfall. This is a calculated results field 
and is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.
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Outfall Attributes
Outfall—Results: Flows

Table 15-68: Outfall—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at outfall. This is a calculated results field 
and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Flow (Total 
In)

Sum of all flows coming into outfall. This is a calculated results 
field and is not editable.
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Pond Outlet Structure Attributes
The pond outlet structure attributes comprise the following categories:

• “Pond Outlet Structure—General” on page 15-871

• “Pond Outlet Structure—Geometry” on page 15-872

• “Pond Outlet Structure—Pond Outlet” on page 15-872

• “Pond Outlet Structure—Active Topology” on page 15-872

• “Pond Outlet Structure—Results” on page 15-873

Pond Outlet Structure—General

Table 15-69: Pond Outlet Structure—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.
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Pond Outlet Structure Attributes
Pond Outlet Structure—Geometry

Pond Outlet Structure—Pond Outlet

Pond Outlet Structure—Active Topology

Table 15-70: Pond Outlet Structure—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 

Table 15-71: Pond Outlet Structure—Pond Outlet Attributes

Attribute Description

Upstream 
Pond

Lets you choose the upstream pond for the currently 
highlighted element from a list of all of the valid ponds in the 
network.

Has Control 
Structure?

Lets you choose whether the highlighted element has a control 
structure. If this field is set to True, the Control Structure field is 
activated. 

Control 
Structure

Lets you define the components that make up the control 
structure. Click the Ellipsis (…) button in this field to open the 
Composite Outlet Structure dialog box (see “Composite Outlet 
Structures Dialog Box” on page 6-214). This field is active only 
when the Has Control Structure? attribute is set to Yes.

Table 15-72: Pond Outlet Structure—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Pond Outlet Structure—Results

Cross Section Attributes
The cross section attributes comprise the following categories:

• “Cross Section—General” on page 15-874

• “Cross Section—Geometry” on page 15-874

• “Cross Section—Physical” on page 15-875

• “Cross Section—Active Topology” on page 15-877

• “Cross Section—Inflow” on page 15-878

• “Cross Section—Results” on page 15-878

• “Cross Section—Results: Engine Parsing Attributes” on page 15-878

• “Cross Section—Results: Flows” on page 15-879

Table 15-73: Pond Outlet Structure—Result Attributes

Attribute Description

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.
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Cross Section Attributes
Cross Section—General

Cross Section—Geometry

Table 15-74: Cross Section—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-75: Cross Section—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Cross Section—Physical

Table 15-76: Cross Section—Physical Attributes

Attribute Description

Section Type Lets you choose the cross-sectional shape of the currently 
highlighted element. You can select Trapezoidal Cross 
Section or Irregular Channel. The value chosen here affects 
the availability of other fields.

Station-
Elevation 
Curve

Lets you define station-elevation points that describe the 
shape of the irregular channel. Click the Ellipsis (…) button in 
this field to open the Station-Elevation Curve dialog box (see 
“Station-Elevation Curve/Depth Dialog Box” on page 6-200). 
This field is available only when the Section Type attribute is 
set to Irregular Channel.

Elevations 
Modifier

The Elevations modifier is a constant value that will be added 
to each elevation value. This attribute is only used during 
SWMM calculations.

Stations 
Modifier

The Stations modifier is a factor by which the distance between 
each station will be multiplied when the transect data is 
processed by SWMM. Use a value of 0 if no such factor is 
needed. This attribute is only used during SWMM calculations.

Elevation 
(Invert)

Lets you define the invert elevation at the currently highlighted 
element. This attribute is active only when the Section Type 
attribute is set to Trapezoidal Channel.

Bottom Width Lets you enter a value for the width at the base of the cross 
section of the currently highlighted element. This attribute is 
active only when the Section Type attribute is set to 
Trapezoidal Channel.

Slope (Left 
Side)

Lets you enter a value for the left slope of the cross section of 
the currently highlighted element. This attribute is active only 
when the Section Type attribute is set to Trapezoidal 
Channel.

Slope (Right 
Side)

Lets you enter a value for the right slope of the cross section of 
the currently highlighted element. This attribute is active only 
when the Section Type attribute is set to Trapezoidal 
Channel.

Height Lets you enter a value for the height of the cross section of the 
currently highlighted element. This attribute is active only when 
the Section Type attribute is set to Trapezoidal Channel.
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Cross Section Attributes
Roughness 
Type

Lets you set the roughness method for the currently 
highlighted: Single Manning’s n, Manning’s - Depth Curve, 
or Manning’s n - Flow. The value chosen here affects the 
availability of some fields in the Physical section of the 
Property Editor.

Material Lets you enter the name of the material used. Alternatively, 
clicking the ellipsis button opens the Material Engineering 
Library, allowing you to select a pre-defined material. If a pre-
defined material is chosen, the roughness value will change 
accordingly.

Left Bank 
Station

The distance values appearing in the Station/Elevation grid 
that mark the end of the left overbank and the start of the right 
overbank. Use 0 to denote the absence of an overbank.

Right Bank 
Station

The distance values appearing in the Station/Elevation grid 
that mark the end of the left overbank and the start of the right 
overbank. Use 0 to denote the absence of an overbank.

Manning’s n Lets you enter a value for the Manning’s roughness of the 
currently highlighted element. This attribute is active only when 
the Roughness Type attribute is set to Single Manning’s n.

Table 15-76: Cross Section—Physical Attributes

Attribute Description
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Cross Section—Active Topology

Manning’s n-
Depth Curve

Lets you define points that describe a roughness-depth curve 
for the currently highlighted element. Click the Ellipsis (…) 
button in this field to open the Manning’s n-Depth Curve dialog 
box (see “Manning’s n–Depth Curve Dialog Box” on page 6-
202). This attribute is active only when the Roughness Type 
attribute is set to Manning’s n-Depth Curve.

Manning’s n-
Flow

Lets you define points that describe a roughness-flow curve for 
the currently highlighted element. Click the Ellipsis (…) button 
in this field to open the Manning’s n-Flow Curve dialog box 
(see “Manning’s n–Flow Curve Dialog Box” on page 6-203). 
This attribute is active only when the Roughness Type attribute 
is set to Manning’s n-Flow.

Transition 
Type

When you connect a channel to a conduit at a cross-section 
node, a transition part is added between the channel cross-
section and the conduit cross-section. This field lets you 
specify the transition type of the currently highlighted cross-
section node. You can select either Gradual or Abrupt. If you 
select Abrupt, the top width of the channel cross-section node 
is used as the length of the transition part. If you select 
Gradual, the Transition Length field is made available. If the 
Transition Length is larger than the top width of the cross-
section node, the Transition Length value is used as the length 
of the transition part.

Note: Transition Type and Transition Length are 
not used for cross-section nodes that 
connect two channels.

Transition 
Length

Lets you define the length of the transition between a channel 
cross-section and a conduit cross-section. This field is 
available only if you select Gradual as the Transition Type.

Table 15-76: Cross Section—Physical Attributes

Attribute Description

Table 15-77: Cross Section—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Cross Section—Inflow

Cross Section—Results

Cross Section—Results: Engine Parsing Attributes

Table 15-78: Cross Section—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see “Defining 
Inflow Collections” on page 7-378).

Table 15-79: Cross Section—Result Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the cross section. 
This is a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Overflow Flow that exits system during analysis. This is a calculated 
results field and is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.

Table 15-80: Cross Section—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
15-878 Bentley SewerGEMS V8i User’s Guide



Editing Attributes in the Property Editor
Cross Section—Results: Flows

Pump Attributes
The pump attributes comprise the following categories:

• “Pump—General” on page 15-880

• “Pump—Geometry” on page 15-880

• “Pump—Physical” on page 15-881

• “Pump—Active Topology” on page 15-881

• “Pump—Results” on page 15-882

• “Pump—Results: Engine Parsing Attributes” on page 15-882

Table 15-81: Cross Section—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at cross section. This is a calculated 
results field and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.
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Pump Attributes
Pump—General

Pump—Geometry

Table 15-82: Pump—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Downstream 
Link

Displays the ID of the downstream link element to which the 
pump is connected.

Table 15-83: Pump—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Pump—Physical

Pump—Active Topology

Table 15-84: Pump—Physical Attributes

Attribute Description

Suction 
Element ID

This field allows you to define the upstream, or suction-side 
node for the current pump. Select Select Suction Element 
from the drop-down menu; your mouse cursor changes to a 
Pick Element tool, allowing you to click on the desired element 
in the Drawing Pane. After you have selected the suction-side 
node, the pump and the node are connected by a dotted line in 
your model.

Elevation Lets you define the elevation of the currently highlighted 
element.

Pumps Lets you define pump settings for the currently highlighted 
element. Click the Ellipsis (…) button in this field to open the 
Pumps dialog box (see “Pumps Dialog Box” on page 6-230).

Table 15-85: Pump—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.
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Pump—Results

Pump—Results: Engine Parsing Attributes

Wet Well Attributes
The wet well attributes comprise the following categories:

• “Wet Well—General” on page 15-883

• “Wet Well—Geometry” on page 15-883

• “Wet Well—Physical” on page 15-884

• “Wet Well—Sanitary Loading” on page 15-885

Table 15-86: Pump—Results

Attribute Description

Head Calculated pump head for the currently highlighted pump. This 
is a calculated results field, and as such is not editable.

Flow (Pump) Calculated flow at the currently highlighted pump. This is a 
calculated results field, and as such is not editable.

Upstream 
Head

Calculated head on the upstream side of the currently 
highlighted pump. This is a calculated results field, and as 
such is not editable.

Downstream 
Head

Calculated head on the downstream side of the currently 
highlighted pump. This is a calculated results field, and as 
such is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.

Table 15-87: Pump—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
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• “Wet Well—Simulation Initial Condition” on page 15-885

• “Wet Well—SWMM Extended Data” on page 15-886

• “Wet Well—Active Topology” on page 15-886

• “Wet Well—Inflow” on page 15-886

• “Wet Well—Results” on page 15-887

• “Wet Well—Results: Extended Node” on page 15-887

• “Wet Well—Results: Flows” on page 15-888

Wet Well—General

Wet Well—Geometry

Table 15-88: Wet Well—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-89: Wet Well—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Wet Well—Physical

The following illustration shows a typical wet well.

Table 15-90: Wet Well—Physical Attributes

Attribute Description

Wet Well 
Volume Type

Lets you choose the method used to define volume for the 
currently highlighted element: Wet Well Depth-Area Curve, 
Wet Well Constant Area, or Wet Well Area Function. The 
value chosen here affects the availability of other attributes.

Wet Well 
Depth-Area 
Curve

Lets you define the size of the currently highlighted element by 
entering points in the depth vs. area table. Click the Ellipsis 
(…) button in this field to open the Wet Well Depth-Area Curve 
dialog box (see “Wet Well Depth-Area Curve Dialog Box” on 
page 6-228). This field is available only when Wet Well Depth-
Area Curve is chosen as the Wet Well Volume Type.

Area Lets you define the area of the currently highlighted element. It 
is available only when Wet Well Constant Area is chosen as 
the Wet Well Volume Type.

Max. Level Lets you set the maximum depth for the wet well. It is available 
only when Wet Well Constant Area or Wet Well Area 
Function is chosen as the Wet Well Volume Type.

Max Depth Freeboard
Height

On Elevation

Initial
Elevation

Off
Elevation

PumpStop Invert
Upstream
Conduit

Wet Well
Invert Elevation

Datum

Max Depth Freeboard
Height

On Elevation

Initial
Elevation

Off
Elevation

PumpStop Invert
Upstream
Conduit

Wet Well
Invert Elevation

Datum
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Wet Well—Sanitary Loading

Wet Well—Simulation Initial Condition

Coefficient Lets you set the coefficient of the area function for the currently 
highlighted element. It is available only when Wet Well Area 
Function is chosen as the Wet Well Volume Type. 

Exponent Lets you set the exponent of the area function for the currently 
highlighted element. It is available only when Wet Well Area 
Function is chosen as the Wet Well Volume Type. 

Constant Lets you set the constant of the area function for the currently 
highlighted element. It is available only when Wet Well Area 
Function is chosen as the Wet Well Volume Type.

Elevation 
(Invert)

Lets you define the invert, or bottom, elevation for the currently 
highlighted element.

Table 15-90: Wet Well—Physical Attributes

Attribute Description

Table 15-91: Wet Well—Sanitary Loading Attributes

Attribute Description

Sanitary 
Loads

Lets you define a sanitary (dry weather) flow collection for the 
selected wet well. Click the Ellipses (...) button to display the 
Sanitary (Dry Weather) Flow Collection Editor, which lets you 
define collections of sanitary (dry weather) loads.

Table 15-92: Wet Well—Simulation Initial Condition Attributes

Attribute Description

Initial 
Elevation 
Type

Lets you choose which type of initial condition type to be 
applied to the currently highlighted element: Invert or User 
Defined Initial Elevation. The value chosen here affects the 
availability of other attributes.

Elevation 
(Initial)

Lets you define the initial water surface elevation for the 
currently highlighted element. It is available only when the 
User Defined Initial Elevation value is selected for the Initial 
Elevation Type attribute.
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Wet Well—SWMM Extended Data

Wet Well—Active Topology

Wet Well—Inflow

Table 15-93: Wet Well—SWMM Extended Data Attributes

Attribute Description

Evaporation 
Factor

Fraction of evaporation rate realized. This attribute is only 
used during SWMM calculations.

Apply 
Treatment?

Lets you specify whether or not treatment is applied at the 
currently highlighted element. Select True to apply treatment. 
This field is only used during SWMM calculations.

Treatment Lets you add a collection of pollutants and their associated 
treatment functions that will be applied at the currently 
highlighted element. This field is used only during SWMM 
calculations and is available only if Apply Treatment? is set to 
True. For more information, see “Adding Treatment to a Node” 
on page 6-321.

Pollutograph
s

Lets you define a pollutograph collection for the selected 
manhole. Click the Ellipses (...) button to display the 
Pollutograph Collection dialog box, which lets you add multiple 
pollutographs to the collection. For more information, see 
“Adding Pollutographs to a Node” on page 6-307.

Table 15-94: Wet Well—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-95: Wet Well—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see 
“Defining Inflow Collections” on page 7-378).
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Wet Well—Results

Wet Well—Results: Extended Node

Table 15-96: Wet Well—Results Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the wet well. This 
is a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded? If this field displays True, flooding occurs at the currently 
highlighted element during the current time step. For Ponds 
and Wet Wells, this field will display True if the water surface 
elevation goes above the highest elevation defined for the 
element. This is a calculated results field and is not editable.

Total Outflow Sum of all flows leaving wet well. This is a calculated results 
field and is not editable.

Overflow Flow that exits system during analysis. This is a calculated 
results field and is not editable.

Pollutants Lets you view calculated results for pollutants for the node. 
Clicking the Ellipses (...) button displays the Pollutants Results 
dialog box.

Table 15-97: Wet Well—Results: Extended Node Attributes

Attribute Description

Freeboard 
Height

Distance between the top of the wet well and the water 
surface. This is a calculated results field and is not editable.

Depth 
(Flooding)

Depth between top of wet well and the water surface when the 
wet well is flooded. This is a calculated results field and is not 
editable.

Volume Calculated volume at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded 
Ever?

If this field displays True, flooding occurs at least once during 
the simulation at the currently highlighted element. This is a 
calculated results field and is not editable.
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Wet Well Attributes
Wet Well—Results: Flows

Table 15-98: Wet Well—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at wet well. This is a calculated results field 
and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Total Surface 
Inflow

Total flow coming into wet well from runoff. This is a calculated 
results field and is not editable.

Flow (Total 
In)

Sum of all flows coming into wet well. This is a calculated 
results field and is not editable.
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Catchment Attributes
The catchment attributes comprise the following categories:

• “Catchment—General” on page 15-889

• “Catchment—Geometry” on page 15-890

• “Catchment—Catchment” on page 15-890

• “Catchment—Runoff” on page 15-891

• “Catchment—SWMM Extended Data” on page 15-894

• “Catchment—Active Topology” on page 15-896

• “Catchment—Inflow” on page 15-896

• “Catchment—Rainfall” on page 15-896

• “Catchment—Results” on page 15-897

• “Catchment—Results: Extended Catchment” on page 15-897

• “Catchment—Results: Flows” on page 15-898

Catchment—General

Table 15-99: Catchment—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.
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Catchment Attributes
Catchment—Geometry

Catchment—Catchment

Table 15-100: Catchment—Geometry Attributes

Attribute Description

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click in the field to display an Ellipsis (…) 
button, and click the Ellipsis (…) button to use the Polyline 
Vertices feature. For more information, see “Polyline Vertices 
Dialog Box” on page 6-198.

Scaled Area Displays the scaled area of the currently highlighted element. 
This field in not editable.

Table 15-101: Catchment—Catchment Attributes

Attribute Description

Area Lets you define the area of the currently highlighted element. 
Clicking the ellipsis button in this field opens the Cn Area 
Collection dialog box (see “Defining CN Area Collections for 
Catchments” on page 7-387), allowing you to define SCS 
values and the pervious/impervious ratio for the currently 
highlighted element.

Outflow 
Node

Lets you choose the node to which flow flows from the 
currently highlighted element. To use this feature, click Select 
in the Outfall Node field. Move the cursor over the drawing 
pane and click the element you want to select for the outflow 
node.
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Catchment—Runoff

Table 15-102: Catchment—Runoff Attributes

Attribute Description

Runoff 
Method

Lets you set what type of runoff method the currently 
highlighted element uses. The value chosen here affects the 
availability of other fields. You can select Unit Hydrograph, 
EPA-SWMM Runoff, User-Defined Hydrograph, None, or 
Modified Rational Method.

Characteristic 
Width

Characteristic width of the currently highlighted catchment. 
This attribute is available only when the Runoff Method 
attribute is set to EPA-SWMM Runoff.

Storage 
(Impervious 
Depression)

Depth of depression storage on impervious portion of the 
catchment. This attribute is available only when the Runoff 
Method attribute is set to EPA-SWMM Runoff.

Storage 
(Pervious 
Depression)

Depth of depression storage on the pervious portion of the 
catchment. This attribute is available only when the Runoff 
Method attribute is set to EPA-SWMM Runoff.

Manning’s n 
(Impervious)

Manning's N for overland flow over the impervious portion of 
the currently highlighted catchment. This attribute is available 
only when the Runoff Method attribute is set to EPA-SWMM 
Runoff.

Manning’s n 
(Pervious)

Manning's N for overland flow over the pervious portion of the 
currently highlighted catchment. This attribute is available only 
when the Runoff Method attribute is set to EPA-SWMM 
Runoff.

Percent 
Impervious

Percent of land area which is impervious. This attribute is 
available only when the Runoff Method attribute is set to EPA-
SWMM Runoff.

Slope Average slope, in percent, of the currently highlighted 
catchment. This attribute is available only when the Runoff 
Method attribute is set to EPA-SWMM Runoff.

Percent 
Impervious 
Zero Storage

Percent of the impervious area with no depression storage. 
This attribute is available only when the Runoff Method 
attribute is set to EPA-SWMM Runoff.

Subarea 
Routing

Lets you define the type of subarea routing at the currently 
highlighted element. This attribute is available only when the 
Runoff Method attribute is set to EPA-SWMM Runoff.
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Percent 
Routed

Percent of runoff routed between subareas. This attribute is 
available only when the Runoff Method attribute is set to EPA-
SWMM Runoff.

Runoff 
Hydrograph

Lets you define time vs. flow points for the currently highlighted 
element. Click the Ellipsis (…) button in this field to open the 
User Defined Hydrograph dialog box (see “Specifying a Time 
of Concentration (Tc) Method for a Catchment” on page 6-
239). This attribute is available only when the Runoff Method 
attribute is set to User Defined Hydrograph.

Loss Method Lets you define what type of loss method the currently 
highlighted element uses. You can select fLoss, Green and 
Ampt, SCS CN, or (Generic) Horton. The value chosen here 
affects the availability of other fields. 

fLoss Lets you define the initial infiltration rate at the time that 
infiltration begins for the currently highlighted element. This 
attribute is active only when the Loss Method attribute is set to 
fLoss. 

Capillary 
Suction

Lets you define the capillary suction value for the soil type 
associated with the currently highlighted element. This 
attribute is active only when the Loss Method attribute is set to 
Green and Ampt.

Ks Lets you set the saturated hydraulic conductivity (the rate at 
which water travels through the soil when it is saturated) for 
the currently highlighted element. This attribute is active only 
when the Loss Method attribute is set to Green and Ampt.

Moisture 
Deficit

Lets you set the value for moisture deficit, which is the 
saturated moisture content minus the original moisture 
content, for the currently highlighted element. This attribute is 
active only when the Loss Method attribute is set to Green and 
Ampt.

SCS CN Lets you set a Cn value for the catchment. You can either type 
a value in the field or click the Ellipsis (…) button to open the 
Cn Area Collection dialog box (see “Defining CN Area 
Collections for Catchments” on page 7-387). This attribute is 
active only when the Loss Method attribute is set to SCS CN.

SCS CN 
(Composite)

The weighted CN value. This attribute is a calculated field and 
is active only when the Loss Method attribute is set to SCS 
CN.

Table 15-102: Catchment—Runoff Attributes

Attribute Description
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fc Lets you define  for the currently highlighted element. This 
attribute is active only when the Loss Method attribute is set to 
(Generic) Horton.

fo Lets you define the initial infiltration rate at the time that 
infiltration begins for the currently highlighted element. This 
attribute is active only when the Loss Method attribute is set to 
(Generic) Horton.

Initial 
Abstraction

Lets you define the initial abstraction (Ia) for the currently 
highlighted element. The initial abstraction is a parameter that 
accounts for all losses prior to runoff and consists mainly of 
interception, infiltration, evaporation, and surface depression 
storage. This attribute is active only when the Loss Method 
attribute is set to (Generic) Horton.

K This field allows you to define the decay coefficient for the 
currently highlighted element. This attribute is active only when 
the Loss Method attribute is set to (Generic) Horton.

Recovery 
Constant

Dry weather regeneration rate constant for the Horton curve. 
This attribute is active only when the Loss Method attribute is 
set to (Generic) Horton.

Maximum 
Volume

This attribute is available only when the Runoff Method 
attribute is set to EPA-SWMM Runoff and the Loss Method 
attribute is set to (Generic) Horton.

Unit 
Hydrograph 
Method

Lets you define the type of unit hydrograph method the 
currently highlighted element uses. The value chosen here 
affects the availability of other fields. You can select Generic 
Unit Hydrograph, SCS Unit Hydrograph, or RTK Unit 
Hydrograph.

RTK Set Lets you assign an RTK table to the catchment. If there is no 
RTK table associated with your project, click the Ellipsis (…) 
button in this field to open the RTK Tables dialog box 
(“Creating an RTK Table and Assigning it to a Catchment” on 
page 7-418), where you can create new RTK tables. This field 
is available only when the Unit Hydrograph Method is set to 
RTK Unit Hydrograph.

Tc Lets you set the time of concentration for the currently 
highlighted element. It is available only when the Unit 
Hydrograph Method attribute is set to SCS Unit Hydrograph.

Table 15-102: Catchment—Runoff Attributes

Attribute Description
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Catchment—SWMM Extended Data

Tc 
(Composite)

The total summed Tc value derived from the individual Tc 
Methods in the Tc Data Collection.

Generic Unit 
Hydrograph

Lets you define time vs. flow points for the currently highlighted 
element. Click the Ellipsis (…) button in this field to open the 
Unit Hydrograph Data dialog box (“Adding Generic Unit 
Hydrographs” on page 7-411). This field is available only when 
the Unit Hydrograph Method is set to Generic Hydrograph.

Convolution 
Time Step

Lets you define the time step for the currently highlighted 
element. It is available only when the Unit Hydrograph Method 
is set to Generic Unit Hydrograph.

Tc Data 
Collection

Contains individual Tc components for calculating the total 
composite Tc for the current catchment. 

Rational C The Rational C coefficient of the catchment section. This field 
is available when the Runoff Method attribute is set to 
Modified Rational Method.

Table 15-102: Catchment—Runoff Attributes

Attribute Description

Table 15-103: Catchment—SWMM Extended Data Attributes

Attribute Description

Curb Length The length of curb on the catchment. This is used to normalize 
water quality calculations.

Land Uses Collection of Land Uses applied to the catchment for use 
during Water Quality calculations. Clicking the Ellipses (...) 
button opens the Land Uses Collection dialog box, where you 
can add land use entries to the collection. This field is available 
when you select EPA-SWMM Runoff as the Runoff Method.

Initial Buildup 
Collection

Lets you specify the initial quantities of pollutant buildup over 
the catchment in a collection. Clicking the Ellipses (...) button 
opens the Initial Buildup Collection dialog box, where you can 
add initial buildup entries to the collection. This field is 
available when you select EPA-SWMM Runoff as the Runoff 
Method.

Apply 
Groundwater

Lets you apply groundwater to the catchment. If you select 
True, several additional fields become available.
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Aquifer Select the aquifer to apply to the catchment or select Edit... 
from the drop-down menu and click the Ellipses (...) button to 
define new aquifers in the SWMM Aquifers dialog box.

Surface 
Elevation

The elevation of ground surface for the subcatchment that sits 
above the aquifer.

Groundwater 
Flow 
Coefficient

The groundwater flow formula is described as:

where Qgw = groundwater flow (cfs per acre or cms per 
hectare) 
Hgw = elevation of groundwater table (ft or m) 
Hsw = elevation of surface water at receiving node (ft or m) 
E = elevation of node invert (ft or m) 
The groundwater flow coefficient is the value of A1 in the 
groundwater flow formula.

Groundwater 
Flow 
Exponent

The value of B1 in the groundwater flow formula.

Surf. Water 
Flow 
Coefficient

Value of A2 in the groundwater flow formula. 

Surf. Water 
Flow 
Exponent

Value of B2 in the groundwater flow formula.

Surface-GW 
Interaction 
Coefficient

Value of A3 in the groundwater flow formula. 

Fixed Surf. 
Water Depth

This is the fixed depth of surface water at the receiving node 
(in feet or meters). This is set to zero if the surface water depth 
varies as computed by flow routing.

Receiving 
Node

Lets you select the receiving node by clicking on the desired 
node in the drawing pane.

Table 15-103: Catchment—SWMM Extended Data Attributes

Attribute Description

Q  = A1(H  - E)B1 - A2(H  - E)B2 + A3H Hgw gw sw gw sw 
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Catchment Attributes
Catchment—Active Topology

Catchment—Inflow

Catchment—Rainfall

Table 15-104: Cross Section—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-105: Catchment—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see “Defining 
Inflow Collections” on page 7-378).

Table 15-106: Catchment—Rainfall Attributes

Attribute Description

Use Local 
Rainfall?

Lets you define whether or not the currently highlighted 
element uses local rainfall, and if so, which type. Select True 
to display the Local Storm Event field. The value chosen here 
affects the availability of other fields.

Local Storm 
Event

Lets you create or select a storm event from those previously 
created. 
Select a storm event from the drop-down list in this field, select 
the Ellipsis (…) item in the drop down list, or select the New 
(…) item to open the Rainfall Curves dialog box (see “Adding 
Storm Events” on page 7-395) and edit an existing storm event 
or create a new one.
This field is available only when the Use Local Rainfall? 
attribute is set to True.

Return Event Lets you define the frequency of the storm at the currently 
highlighted element. This attribute is available only when the 
Use Local Rainfall? attribute is set to True.
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Editing Attributes in the Property Editor
Catchment—Results

Catchment—Results: Extended Catchment

Table 15-107: Catchment—Result Attributes

Attribute Description

Total Outflow Sum of all flows leaving catchment. This is a calculated results 
field and is not editable.

Pollutants Lets you view calculated results for pollutants assigned to the 
node. Clicking the Ellipses (...) button displays the Pollutants 
Results dialog box.

Table 15-108: Catchment—Results: Extended Catchment Attributes

Attribute Description

Precipitation 
(Cumulative)

Total rainfall on catchment up until current time step. This is a 
calculated results field, and as such is not editable.

Loss 
(Cumulative)

Total amount of rainfall that has infiltrated into catchment up 
until current time step. This is a calculated results field, and as 
such is not editable.

Precipitation 
(Incremental)

The depth of precipitation over the catchment for the current 
time step.

Loss 
(Incremental)

The amount of precipitation that is lost or absorbed over the 
catchment for the current time step.
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Pond Attributes
Catchment—Results: Flows

Pond Attributes
The pond attributes comprise the following categories:

• “Pond—General” on page 15-899

• “Pond—Geometry” on page 15-899

• “Pond—Physical” on page 15-900

• “Pond—Simulation Initial Condition” on page 15-901

• “Pond—SWMM Extended Data” on page 15-902

• “Pond—Active Topology” on page 15-902

• “Pond—Inflow” on page 15-902

• “Pond—Results” on page 15-903

• “Pond—Results: Engine Parsing Attributes” on page 15-903

• “Pond—Results: Extended Node” on page 15-904

• “Pond—Results: Flows” on page 15-904

For an overview of the physical characteristics of ponds, see “Physical Characteristics 
of Ponds” on page 6-244

Table 15-109: Catchment—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at catchment. This is a calculated results 
field and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Flow (Total 
In)

Sum of all flows coming into catchment. This is a calculated 
results field and is not editable.
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Editing Attributes in the Property Editor
Pond—General

Pond—Geometry

Table 15-110: Pond—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-111: Pond—Geometry Attributes

Attribute Description

Geometry Lets you view and edit the coordinates of points along a 
selected element. Click in the field to display an Ellipsis (…) 
button, and click the Ellipsis (…) button to use the Polyline 
Vertices feature. For more information, see “Polyline Vertices 
Dialog Box” on page 6-198.

Scaled Area Displays the scaled area of the currently highlighted element. 
This field in not editable.
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Pond Attributes
Pond—Physical

Table 15-112: Pond—Physical Attributes

Attribute Description

Volume Type Lets you select the volume type that gets used: Elevation-
Area Curve, Elevation-Volume Curve, Pipe Volume, 
Functional. The value chosen here affects the availability of 
other fields.

Elevation-
Area Curve

Lets you define points to describe the shape of the currently 
highlighted element. Click the Ellipsis (…) button in this field 
to open the Elevation-Area Curve dialog box (“Elevation-Area 
Curve Dialog Box” on page 6-249). This attribute is active only 
when the Volume Type attribute is set to Elevation-Area 
Curve.

Elevation-
Volume 
Curve

Lets you define points to describe the shape of the currently 
highlighted element. Click the Ellipsis (…) button in this field 
to open the Elevation-Volume Curve dialog box (“Elevation-
Volume Curve Dialog Box” on page 6-251). This attribute is 
active only when the Volume Type attribute is set to Elevation-
Volume Curve.

Number of 
Barrels

Lets you define the number of barrels that comprise the 
currently highlighted element. Note that the diameter, length, 
and invert values are applied to each barrel. This field is 
available only when the Volume Type attribute is set to Pipe 
Volume.

Length Lets you define the length of the currently highlighted element. 
It is available only when the Volume Type attribute is set to 
Pipe Volume.

Invert (Start) Lets you enter a value for the start, or upstream, invert of the 
currently highlighted element. It is available only when the 
Volume Type attribute is set to Pipe Volume.

Invert (Stop) Lets you enter a value for the stop, or downstream, invert of 
the currently highlighted element. It is available only when the 
Volume Type attribute is set to Pipe Volume.

Pipe 
Diameter

Lets you define the diameter of the currently highlighted 
element. It is available only when the Volume Type attribute is 
set to Pipe Volume.
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Editing Attributes in the Property Editor
Pond—Simulation Initial Condition

Pond 
Coefficient

“A” value in expression A*Depth^B+C for Depth in feet. This 
field is available only when the Functional Volume Type is 
chosen. 

Pond 
Exponent

“B” value in expression A*Depth^B+C for Depth in feet. This 
field is available only when the Functional Volume Type is 
chosen.

Elevation 
(Invert)

The invert elevation of the currently highlighted pond.

Depth 
(Maximum)

Lets you set the maximum depth of the pond.

Pond 
Constant

“C” value in expression A*Depth^B+C for Depth in feet. This 
field is available only when the Functional Volume Type is 
chosen.

Table 15-112: Pond—Physical Attributes

Attribute Description

Table 15-113: Pond—Simulation Initial Condition Attributes

Attribute Description

Initial 
Elevation 
Type

Lets you choose which type of initial condition type to be 
applied to the currently highlighted element: Invert or User 
Defined Initial Elevation. The value chosen here affects the 
availability of other attributes.

Elevation 
(Initial)

Lets you define the initial water surface elevation for the 
currently highlighted element. It is available only when the 
User Defined Initial Elevation value is selected for the Initial 
Elevation Type attribute.
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Pond Attributes
Pond—SWMM Extended Data

Pond—Active Topology

Pond—Inflow

Table 15-114: Pond—SWMM Extended Data Attributes

Attribute Description

Evaporation 
Factor

Fraction of evaporation rate realized. This attribute is only 
used during SWMM calculations.

Apply 
Treatment?

Lets you specify whether or not treatment is applied at the 
currently highlighted element. Select True to apply treatment. 
This field is only used during SWMM calculations.

Treatment Lets you add a collection of pollutants and their associated 
treatment functions that will be applied at the currently 
highlighted element. This field is used only during SWMM 
calculations and is available only if Apply Treatment? is set to 
True. For more information, see “Adding Treatment to a Node” 
on page 6-321.

Pollutograph
s

Lets you define a pollutograph collection for the selected 
manhole. Click the Ellipses (...) button to display the 
Pollutograph Collection dialog box, which lets you add multiple 
pollutographs to the collection. For more information, see 
“Adding Pollutographs to a Node” on page 6-307.

Table 15-115: Pond—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-116: Pond—Inflow Attributes

Attribute Description

Inflow 
Collection

Contains an Ellipsis (…) button that lets you access the Inflow 
Collection dialog box for the associated element (see “Defining 
Inflow Collections” on page 7-378).
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Editing Attributes in the Property Editor
Pond—Results

Pond—Results: Engine Parsing Attributes

Table 15-117: Pond—Results Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the pond. This is 
a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded? If this field displays True, flooding occurs at the currently 
highlighted element during the current time step. For Ponds 
and Wet Wells, this field will display True if the water surface 
elevation goes above the highest elevation defined for the 
element. This is a calculated results field and is not editable.

Total Outflow Sum of all flows leaving pond. This is a calculated results field 
and is not editable.

Overflow Flow that exits system during analysis. This is a calculated 
results field and is not editable.

Pollutants Lets you view calculated results for pollutants assigned to the 
node. Clicking the Ellipses (...) button displays the Pollutants 
Results dialog box.

Table 15-118: Catch Basin—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
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Pond Attributes
Pond—Results: Extended Node

Pond—Results: Flows

Table 15-119: Pond—Results: Extended Node Attributes

Attribute Description

Freeboard 
Height

Distance between the top of the pond and the water surface. 
This is a calculated results field and is not editable.

Depth 
(Flooding)

Depth between top of pond and the water surface when the 
pond is flooded. This is a calculated results field and is not 
editable.

Volume Calculated volume at the currently highlighted element. This is 
a calculated results field and is not editable.

Is Flooded 
Ever?

If this field displays True, flooding occurs at least once during 
the simulation at the currently highlighted element. This is a 
calculated results field and is not editable.
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Editing Attributes in the Property Editor
Junction Chamber Attributes

The junction chamber attributes comprise the following categories:

• “Junction Chamber—General” on page 15-906

• “Junction Chamber—Geometry” on page 15-906

• “Junction Chamber—Physical” on page 15-907

• “Junction Chamber—Physical: Structure Losses” on page 15-907

• “Junction Chamber—Active Topology” on page 15-908

• “Junction Chamber—Results” on page 15-908

• “Junction Chamber—Results: Engine Parsing Attributes” on page 15-908

• “Junction Chamber—Results: Flows” on page 15-909

Table 15-120: Wet Well—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at pond This is a calculated results field 
and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.

Total Surface 
Inflow

Total flow coming into pond from runoff. This is a calculated 
results field and is not editable.

Flow (Total 
In)

Sum of all flows coming into pond. This is a calculated results 
field and is not editable.
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Junction Chamber Attributes
Junction Chamber—General

Junction Chamber—Geometry

Table 15-121: Junction Chamber—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.

Table 15-122: Junction Chamber—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 
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Editing Attributes in the Property Editor
Junction Chamber—Physical

Junction Chamber—Physical: Structure Losses

Table 15-123: Junction Chamber—Physical Attributes

Attribute Description

Diameter Lets you enter a value for the diameter of the currently 
highlighted element. 

Elevation 
(Ground)

Lets you enter a value for the ground elevation for the currently 
highlighted node.

Elevation 
(Top)

Lets you enter a value for the top elevation for the currently 
highlighted node.

Elevation 
(Bottom)

Lets you enter a value for the bottom elevation for the currently 
highlighted node.

Table 15-124: Junction Chamber—Physical: Structure Losses 
Attributes

Attribute Description

Headloss 
Method

Lets you select the headloss method to use: Absolute, HEC-
22, Generic, or Standard.

Absolute 
Headloss

Lets you enter a value for the headloss. This field is only 
available if you selected the Absolute Headloss Method.

Headloss 
Coefficient 
Start

Lets you enter a value for the headloss coefficient at the start 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient 
Stop

Lets you enter a value for the headloss coefficient at the stop 
section. This field is only available if you selected the Generic 
Headloss Method.

Headloss 
Coefficient

Lets you enter a value for the headloss coefficient for the 
manhole. This field is only available if you selected the 
Standard Headloss Method.
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Junction Chamber Attributes
Junction Chamber—Active Topology

Junction Chamber—Results

Junction Chamber—Results: Engine Parsing Attributes

Table 15-125: Junction Chamber—Active Topology

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-126: Junction Chamber—Results Attributes

Attribute Description

Hydraulic 
Grade

Representative calculated hydraulic grade at the junction 
chamber. This is a calculated results field and is not editable.

Depth (Node) Depth of the water at the currently highlighted element. This is 
a calculated results field and is not editable.

Maximum 
HGL

TimeToMaxi
mumHGL

Table 15-127: Junction Chamber—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.
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Editing Attributes in the Property Editor
Junction Chamber—Results: Flows

Table 15-128: Junction Chamber—Results: Flow Attributes

Attribute Description

Flow (Total 
In)

Sum of all flows coming into junction chamber. This is a 
calculated results field and is not editable.
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Pressure Junction Attributes
Pressure Junction Attributes
The pressure junction attributes comprise the following categories:

• “Pressure Junction—General” on page 15-910

• “Pressure Junction—Geometry” on page 15-911

• “Pressure Junction—Physical” on page 15-911

• “Pressure Junction—Sanitary Loading” on page 15-911

• “Pressure Junction—Active Topology” on page 15-912

• “Pressure Junction—Inflow” on page 15-912

• “Pressure Junction—Results” on page 15-912

• “Pressure Junction—Results: Engine Parsing Attributes” on page 15-913

• “Pressure Junction—Results: Flows” on page 15-913

Pressure Junction—General

Table 15-129: Pressure Junction—General Attributes

Attribute Description

ID Displays the unique identifier for the currently highlighted 
element. The ID is automatically assigned to each discrete 
block of data in the project data store (the .mdb file) by the 
program. It is not editable.

Label Displays the label for the currently highlighted element. The 
Label can be edited.

Notes Lets you enter descriptive text that is associated with the 
currently highlighted element.

Hyperlinks Lets you add, edit, delete, and view external files that are 
associated with the element using the Hyperlinks feature. Click 
in the field to display an Ellipsis (…) button, and click the 
Ellipsis (…) button to use the Hyperlinks feature. For more 
information about the Hyperlink Manager, see “Adding 
Hyperlinks to Elements” on page 6-324.
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Editing Attributes in the Property Editor
Pressure Junction—Geometry

Pressure Junction—Physical

Pressure Junction—Sanitary Loading

Table 15-130: Pressure Junction—Geometry Attributes

Attribute Description

X Contains the coordinate of the currently highlighted element 
along the X (horizontal) axis.

Y Contains the coordinate of the currently highlighted element 
along the Y (vertical) axis 

Table 15-131: Pressure Junction—Physical Attributes

Attribute Description

Elevation 
(Ground)

Lets you enter a value for the ground elevation of the currently 
highlighted element.

Elevation Lets you enter a value for the elevation of the currently 
highlighted element. 

Pressure Junction—Sanitary Loading Attributes

Attribute Description

Sanitary 
Loads

Lets you define sanitary loads for the pressure junction. 
Clicking the Ellipse (...) button displays the Sanitary (Dry 
Weather) Flow Collection Editor, which lets you define 
Hydrographs, Unit Loads, and Pattern Loads.
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Pressure Junction Attributes
Pressure Junction—Active Topology

Pressure Junction—Inflow

Pressure Junction—Results

Table 15-132: Pressure Junction—Active Topology Attributes

Attribute Description

Is Active Lets you choose whether or not the corresponding element is 
active in the current alternative. Select True to make the 
element active in the current alternative.

Table 15-133: Pressure Junction—Inflow Attributes

Attribute Description

Inflow 
Collection

Lets you define an inflow collection for the selected pressure 
junction. Clicking the Ellipse (...) button displays the Inflow 
Collection Editor, which lets you create collections containing 
Fixed Inflows, Hydrograph Inflows, and Pattern Inflows.

Table 15-134: Pressure Junction—Results Attributes

Attribute Description

Total Outflow Sum of all flows leaving the pressure junction. This is a 
calculated results field and is not editable.

Maximum 
HGL

TimeToMaxi
mumHGL

Pressure The pressure value at the junction for the current time step.

HGL
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Editing Attributes in the Property Editor
Pressure Junction—Results: Engine Parsing Attributes

Pressure Junction—Results: Flows

Table 15-135: Pressure Junction—Results: Engine Parsing Attributes

Attribute Description

Branch Returns the ID of the branch which the current element is part 
of. The branch is determined during the calculations using the 
implicit engine. This is a calculated results field and is not 
editable. For more information, see “Branches” on page 14-
722.

Table 15-136: Pressure Junction—Results: Flow Attributes

Attribute Description

Local Inflow? User defined inflow at the pressure junction. This is a 
calculated results field and is not editable.

Flow (Total 
In)

Sum of all flows coming into the pressure junction. This is a 
calculated results field and is not editable.

Total Local 
Inflow

Sum of all user defined inflows. This is a calculated results 
field and is not editable.
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Chapter

Frequently Asked
Questions
This chapter contains answers to some of the frequently asked questions about using 
Bentley SewerGEMS V8i.

The following FAQs are included:

• “What Project Files Does Bentley SewerGEMS V8i Maintain?” on page 16-915

• “What Kind of Graphs Can I Create and How Do I Create Them?” on page 16-
916

• “How Do I Enter the Scale of a Background Image If it is a File Type without an 
Inherent Scale?” on page 16-917

• “What is the Difference Between a Drop Manhole and a Regular Manhole?” on 
page 16-917

• “How Do I Manage the Size of My Database Files?” on page 16-918

What Project Files Does Bentley SewerGEMS V8i 
Maintain?
These are filename extensions of the files associated with a Bentley SewerGEMS V8i 
project:

• Project files—.swg, .dwh, .mdb

• Results files—.out (model output), .bin, .gut, .eqt, .hyg (hydrology output), .cul, 
.swm (SWMM data file). There is one set per scenario.

The .mdb file is the most important file because it contains all modeling data, and 
includes everything needed to perform a calculation. This file is an open access data-
base format file and can be viewed and edited.

The .swg file contains data such as annotation and color-coding definitions. This file is 
an open .xml format file and can be viewed and edited.
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What Kind of Graphs Can I Create and How Do I Create Them?
The .dwh file is used by the Stand-Alone mode only, and contains the drawing. This is 
a binary format file.

Whenever you create a file with a name of Filename, three files are created:

• Filename.mdb

• Filename.swg

• Filename.dwh

When you move a file and speed is important, it is best to place all three in a .zip file, 
which will greatly reduce file size. Then copy or move the zip file and unzip it.

Every time you save the file, you not only overwrite the previous version but you also 
convert the old files to .bak files. Each file will have it's original file name plus the 
extension .bak, for example Filename.swg.bak.

If your file becomes corrupted or you accidentally delete it, you can go back to the 
previous version by simply removing the .bak suffix from the file name and using that 
file (after deleting the corrupted file if necessary).

You can usually delete the results files because they you can regenerated them by 
rerunnng your model.

To send your model to other Bentley SewerGEMS V8i users:

To send your SewerGEMS V8i model to other SewerGEMS V8i users, you only need 
to send the project files (.swg, .dwh, and .mdb). The results files will be recreated 
when the scenarios associated with the model are calculated.

What Kind of Graphs Can I Create and How Do I 
Create Them?
In Bentley SewerGEMS V8i, there are two kinds of graphical displays: profiles and 
graphs (charts). Profiles show cross sections of the network to scale along some path 
through the network and are described in “Using Profiles” on page 10-548. Graphs are 
plots of some attribute or group of attributes vs. time at one or more elements. Profiles 
and graphs can only be drawn for results of model runs; in order to view a graph or 
profile, you must first successfully compute your model (run the model successfully).

• For details on how create a graph, see “Creating a Graph” on page 10-578. 
Bentley SewerGEMS V8i contains a powerful graph editing tool to help you 
customize your graphs. 

• For more information about this tool, see “Graph Dialog Box” on page 10-579. 
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Frequently Asked Questions
How Do I Enter the Scale of a Background Image If it 
is a File Type without an Inherent Scale?
Image file formats such as BMP or JPG do not have scales inherently associated with 
them.

When you create a new background layer (by clicking New File in the Background 
Layer manager, then selecting the image file to use), Bentley SewerGEMS V8i 
displays the Image properties dialog box (see “Image Properties Dialog Box” on 
page 10-533). In the Image Properties dialog box, you can specify the true distances of 
the corners of the drawing from the bottom left corner, which in the image is consid-
ered by default to be 0,0. If you know the coordinates of each corner of the map, you 
can enter them in the Image Properties dialog box as well.

The image scale is used internally by Bentley SewerGEMS V8i, while the drawing 
scale represents the actual length and is used to determine scaled lengths in Bentley 
SewerGEMS V8i.

What is the Difference Between a Drop Manhole and 
a Regular Manhole?
A drop manhole is used in areas with a steep slope when one or more of the inlet pipes 
has an invert elevation significantly higher than the invert of the outlet pipe. Typically 
the invert elevation of the "stop" end of the inlet pipe is set to the invert elevation of 
the manhole. However, in the case of a drop manhole, the stop invert of the pipe is not 
set to the manhole invert elevation but is at a significantly higher elevation.
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How Do I Manage the Size of My Database Files?
The following illustration shows a drop manhole.

Figure 16-1: Drop Manhole

How Do I Manage the Size of My Database Files?
If your database files are getting too large, you can compress them by compacting the 
database. This operation eliminates much of the wasted space in your file. To do this, 
select Tools > Database Utilities > Compact Database. To be able to use this feature, 
you must select the Compact Database Enabled option on the Global tab of the 
Options dialog box.

For more information, see “Tools Menu” on page 2-22 and “Options Dialog Box - 
Global Tab” on page 4-147.
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Appendix

About Haestad
Methods
Bentley Systems, Incorporated provides software for the lifecycle of the world’s infra-
structure. The company’s comprehensive portfolio for the building, plant, civil, and 
geospatial vertical markets spans architecture, engineering, construction (AEC) and 
operations. Bentley is the leading provider of AEC software to the Engineering News-
Record Design 500 and major owner-operators. For more information, visit the 
Bentley Web site at http://www.bentley.com.

Bentley Systems, Inc. offers software solutions to civil engineers throughout the world 
for analyzing, modeling, and designing all sorts of hydrologic and hydraulic systems, 
from municipal water and sewer systems to stormwater ponds, open channels, and 
more. With point-and-click data entry, flexible units, and report-quality output, 
Bentley Systems, Inc. is the ultimate source for your modeling needs.

In addition to the ability to run in Stand-Alone mode with a CAD-like interface, four 
of our products—WaterCAD, StormCAD, SewerCAD, and Bentley SewerGEMS 
V8i—can be totally integrated within AutoCAD. These three programs also share 
numerous powerful features, such as scenario management, unlimited undo/redo, 
customizable tables for editing and reporting, customizable GIS, database and spread-
sheet connection, and annotation. 

Be sure to contact us or visit our Web site at http://www.bentley.com to find out about 
our latest software, books, training, and open houses.

Software
Bentley Systems, Inc. software includes:

• “CivilStorm”

• “WaterGEMS”

• “WaterCAD”

• “SewerCAD”

• “StormCAD”
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Software
• “PondPack”

• “FlowMaster”

• “CulvertMaster”

• “HAMMER”

• “GISConnect”

• “GISConnect”

CivilStorm

CivilStorm revolutionizes municipal stormwater management. Whether your concern 
is a stormwater master plan, localized flooding, GASB34 requirements, water quality 
BMPs, NPDES permitting, or just simply being able to do faster and smarter designs 
every day, CivilStorm fits your needs. It is the only commercially available software 
package that lets you analyze all your system elements in one package. CivilStorm 
also gives you the ability to perform analyses using either the SWMM algorithm or 
CivilStorm’s own implicit solution of full Saint-Venant equations.

CivilStorm provides numerical solutions for the toughest interconnected pipe, pond, 
and open channel networks, and provides stunning graphics and reporting tools for 
visualizing your storm systems in action.

Use CivilStorm For:

• Comprehensive Stormwater Master Plans 

• Watershed-Based Master Planning 

• Analysis of Open-channel, Closed-conduit and Combination systems 

• Floodplain Studies 

• Complex Flow Regime Analysis 

• Water Quality Assessments 

• Integrated Stormwater Quantity and Quality Assessments 

• NPDES Permitting 

CivilStorm can be run in a MicroStation integrated interface, a Stand-Alone graphical 
user interface, or an AutoCAD integrated interface. 
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About Haestad Methods
WaterGEMS

WaterGEMS brings the concept of water modeling and GIS integration to the next 
level. It is the only water-distribution modeling software that provides full, completely 
seamless integration with GIS applications. Now the combined functionality of 
WaterCAD and GIS can be utilized simultaneously, synthesizing the distinct advan-
tages of each application to create a modeling tool with an unprecedented level of 
freedom, power, efficiency, and usability. 

You can create, display, edit, run, map, and design water models from within the GIS 
environment, and view the results of the simulations as native GIS maps or with tradi-
tional Haestad Methods modeling tools. These abilities, in conjunction with the cross-
product functionality provided by the core Unified Data and Object Model architec-
ture, provide a powerful cutting-edge solution for your modeling projects.

WaterGEMS works within your choice of environments: MicroStation, ArcView, 
ArcEdit, ArcInfo, AutoCAD, or the standalone WaterGEMS Modeler interface.

WaterCAD

WaterCAD is the definitive model for complex pressurized-pipe networks, such as 
municipal water-distribution systems. You can use WaterCAD to perform a variety of 
functions, including steady-state and extended-period simulations of pressure 
networks with pumps, tanks, control valves, and more.

WaterCAD’s abilities also extend into public safety and long-term planning issues, 
with extensive water quality features, automated fire protection analyses, comprehen-
sive scenario management, and enterprise-wide data-sharing capabilities.

WaterCAD is available with your choice of a MicroStation integrated interface, Stand-
Alone graphical user interface, and an AutoCAD integrated interface. 

SewerCAD

SewerCAD is a powerful design and analysis tool for modeling sanitary sewage 
collection and pumping systems. With SewerCAD, you can develop and compute 
sanitary loads, track and combine loads from dry-weather and wet-weather sources. 
You can also simulate the hydraulic response of the entire system (gravity collection 
and pressure force mains), observe the effects of overflows and diversions, and even 
automatically design selected portions of the system. Output covers everything from 
customizable tables and detailed reports to plan and profile sheets.
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Software
StormCAD

StormCAD is a highly efficient model for the design and analysis of storm sewer 
collection systems. From graphical layout and intelligent network connectivity to flex-
ible reports and profiles, StormCAD covers all aspects of storm-sewer modeling.

Surface inlet networks are independent of pipe connectivity and inlet hydraulics 
conform to FHWA HEC-22 methodologies. Gradually varied flow algorithms and a 
variety of popular junction-loss methods are the foundation of StormCAD’s robust 
gravity piping computations, which handle everything from surcharged pipes and 
diversions to hydraulic jumps.

PondPack

PondPack is a comprehensive, Windows-based hydrologic modeling program that 
analyzes a tremendous range of situations, from simple sites to complex networked 
watersheds. PondPack analyzes pre- and post-developed watershed conditions and 
estimates required storage ponds. PondPack performs interconnected pond routing, 
and also computes outlet rating curves with tailwater effects, multiple outfalls, pond 
infiltration, and pond-detention times. 

PondPack builds customized reports organized by categories, automatically creating 
section and page numbers, tables of contents, and indexes. You can quickly create an 
executive summary for an entire watershed or build an elaborate drainage report 
showing any or all report items. Graphical displays, such as watershed diagrams, rain-
fall curves, and hydrographs, are fully compatible with other Windows software.

FlowMaster

FlowMaster is an efficient program for the design and analysis of a wide variety of 
hydraulic elements, such as pressure pipes, open channels, weirs, orifices, and inlets. 
FlowMaster’s Hydraulics Toolbox can create rating tables and performance curves for 
any variables, using popular friction methods. Inlet calculations follow the latest 
FHWA guidelines, and weighting of irregular section roughness can be based on any 
popular techniques.
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About Haestad Methods
CulvertMaster

CulvertMaster helps engineers design new culverts and analyze existing culvert 
hydraulics, from single-barrel crossings to complex multibarrel culverts with roadway 
overtopping. CulvertMaster computations use HDS No. 5 methodologies, allowing 
you to solve for whatever hydraulic variables you do not know, such as culvert size, 
peak discharge, and headwater elevation. Output capabilities include comprehensive 
detailed reports, rating tables, and performance curves.

HAMMER

HAMMER is the premier software in the world for analyzing hydraulic transients, 
surge control devices, and water hammer effects. HAMMER models any hydraulic 
element, transient source or surge protection devices, including:

• Transients for flow, head, or entrained vapor 

• Pressurized pipelines and networks 

• Ingress of contaminants into pipe networks 

• Surcharged sewers or storage tunnels 

• Pump start and shut down scenarios 

• Flow shifting via pumps or valves 

• Power or pump failure 

• Rapid valve closure 

• Catastrophic pipe or pump breaks 

HAMMER can easily import steady-state model results from industry-standard 
models such as WaterCAD, WaterGEMS, EPANET, or EXTRAN (for line filling). 
Users can also build their own models using the advanced graphical interface or 
robust database connections.

GISConnect

Run your GIS inside AutoCAD®. GISConnect is the long anticipated product that 
brings together the data management power of ArcGIS® and the drawing capabilities 
of AutoCAD®. Master your company's existing CAD expertise to deliver the GIS 
solutions that your clients demand. 
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Bentley Institute Press
Bentley Institute Press
Bentley Institute Press provides civil engineering professionals with affordable, 
quality reference and textbooks dedicated to the practical application of engineering 
theory to hydraulics and hydrology. Bentley Institute Press publications include: 

References and Textbooks: Authored by industry-recognized experts, Bentley 
Institute Press offers a complete line of reference 
books for use in both academic and professional 
settings. 

Technical Journals: With an eye towards computer technology, journals 
like “Current Methods” address the latest innovations 
in water-resources modeling and practical modeling 
case studies, as well as offering credit towards 
certification. 

Independent Papers: Bentley Institute Press also provides funding for 
engineers to write case studies of their projects, with 
potential publication in a variety of industry journals 
and magazines.

Books from Bentley Institute Press:

Advanced Water Distribution Modeling and Management, first edition
Haestad, Walski, Chase, Savic, Grayman, Beckwith, and Koelle

Computer Applications in Hydraulic Engineering, fifth edition
Haestad, Walski, Barnard, Durrans, and Meadows

Floodplain Modeling Using HEC-RAS, first edition
Haestad, Dyhouse, Hatchett, and Benn

Proceedings of the First Annual Water Security Summit, first edition
Haestad

Stormwater Conveyance Modeling and Design, first edition
Haestad and Durrans

Wastewater Collection System Modeling and Design, first edition
Haestad, Walski, Barnard, Merritt, Harold, Walker, and Whitman

Water Distribution Modeling, first edition
Haestad, Walski, Chase, and Savic

To order or to receive additional information on these or any other Bentley Institute 
Press titles, please call 800-727-6555 (U.S. and Canada) or +1-203-755-1666 (world-
wide) or visit www.bentley.com/books.
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About Haestad Methods
Training
The Bentley Institute manages professional training programs to ensure consistent, 
high quality, user training for a variety of Bentley products and varying levels of 
application experience. Bentley Institute training is developed to maximize your 
productivity by using examples relevant to your day-to-day project efforts. Training is 
developed concurrently with software applications to provide knowledge of the latest 
tools and features. Additionally, all Bentley Institute faculty meet rigorous certifica-
tion requirements.

The Bentley Institute offers complete training for Haestad Methods products.These 
training programs are famous for efficiently and effectively teaching engineers how to 
apply hydraulic theory and state-of-the-art software to real-world design situations.

• Modelers can become certified in a variety of water-related fields, through an 
assortment of teaching methods including: 

• JumpStart Seminars 

• Comprehensive Workshops 

• Publication-Based Programs 

To obtain more information about Bentley Systems, Inc. certification programs or to 
see upcoming events in a city near you, visit http://www.bentley.com.

Accreditations 

Bentley Systems has achieved the highest levels of accreditation from both the Inter-
national Association for Continuing Education and Training (IACET) and the Profes-
sional Development Registry for Engineers and Surveyors (PDRES). In addition to 
our own prestigious certifications, these endorsements enable modelers to earn 
Continuing Education Units (CEUs) and Professional Development Hours (PDHs) for 
their satisfactory participation in various training and educational programs.
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Appendix

Reference Tables
“Manning’s n Coefficients” on page B-927

“Inlet Design Coefficients” on page B-930

“Headloss Coefficients for Junctions” on page B-933

“Roughness Values—Manning’s Equation” on page B-935

Manning’s n Coefficients
Table B-1: Manning’s n Coefficient Table 

Lined Channels Manning’s n

Concrete, with surfaces as indicated Formed, no finish 0.013 – 0.017

Trowel finish 0.012 – 0.014

Float finish 0.013 – 0.015

Float finish, gravel on bottom 0.015 – 0.017

Gunite, good section 0.016 – 0.019

Gunite, wavy section 0.018 – 0.022

Concrete, bottom float-finished, sides as 
indicated

Dressed stone in mortar 0.015 – 0.017

Random stone in mortar 0.017 – 0.020

Cement rubble masonry 0.020 – 0.025

Cement rubble masonry, plastered 0.016 – 0.020

Dry rubble (riprap) 0.020 – 0.030

Gravel bottom, sides as indicated Formed concrete 0.017 – 0.020
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Manning’s n Coefficients
Random stone in mortar 0.020 – 0.023

Dry rubble (riprap) 0.023 – 0.033

Brick 0.014 – 0.017

Asphalt Smooth 0.013

Rough 0.016

Wood, planed, clean 0.011 – 0.013

Concrete-lined excavated rock Good section 0.017 – 0.020

Irregular section 0.022 – 0.027

Unlined Channels Manning’s n

Earth, uniform section Clean, recently completed 0.016 – 0.018

Clean, after weathering 0.018 – 0.020

With short grass, few weeds 0.022 – 0.027

In gravely soil, uniform section, clean 0.022 – 0.025

Earth, fairly uniform section No vegetation 0.022 – 0.025

Grass, some weeds 0.025 – 0.030

Dense weeds or aquatic plants in deep 
channels 0.030 – 0.035

Sides clean, gravel bottom 0.025 – 0.030

Sides clean, cobble bottom 0.030 – 0.040

Dragline excavated or dredged No vegetation 0.028 – 0.033

Light brush on banks 0.035 – 0.050

Rock: Based on design section 0.035

Based on actual mean section Smooth and uniform 0.035 – 0.040

Jagged and irregular 0.040 – 0.045

Channels not maintained, weeds and brush 
uncut

Dense weeds, high as flow depth 0.08 – 0.12

Clean bottom, brush on sides 0.05 – 0.08

Clean bottom, brush on sides, highest stage 
of flow 0.07 – 0.11

Table B-1: Manning’s n Coefficient Table  (Cont’d)
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Reference Tables
Dense brush, high stage 0.10 – 0.14

Highway Channels and Swales with Maintained Vegetation Manning’s n

(Values shown are for velocities of 2 and 5 fps) 

Depth of flow up to 0.7 ft. 

Bermuda grass, Kentucky bluegrass, buffalo 
grass

Mowed to 2 in. 0.07 – 0.045

Length 4 to 6 in. 0.09 – 0.05

Good Stand, any grass Length about 12 in. 0.18 – 0.09

Length about 24 in. 0.30 – 0.15

Fair stand, any grass Length about 12 in. 0.14 – 0.08

Length about 24 in. 0.25 – 0.13

Depth flow 0.7 ft. to 1.5 ft. 

Bermuda grass, Kentucky bluegrass, buffalo 
grass

Mowed to 2 in. 0.05 – 0.035

Length 4 to 6 in. 0.06 – 0.04

Good Stand, any grass Length about 12 in. 0.12 – 0.07

Length about 24 in. 0.20 – 0.10

Fair stand, any grass Length about 12 in. 0.10 – 0.06

Length about 24 in. 0.17 – 0.09

Gutters Manning’s n

Concrete gutter Troweled finish 0.012

Asphalt pavement Smooth texture 0.013

Rough texture 0.016

Concrete gutter with asphalt pavement Smooth 0.013

Rough 0.015

Concrete pavement Float finish 0.014

Broom finish 0.016

For gutters with small slope, where sediment may accumulate, increase all above values 
of n by 0.002

Table B-1: Manning’s n Coefficient Table  (Cont’d)
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Inlet Design Coefficients
(Source: Searcy 1973.)

• (Source: U.S. Soil Conservation Service 1986.)

1. The n values are a composite of information compiled by Engman (1986).

2. Includes species such as weeping lovegrass, bluegrass, buffalo grass, blue grama 
grass, and native grass mixtures.

3. When selecting n, consider cover to a height of about 0.1 ft. This is the only part 
of the plant cover that obstructs sheet flow.

Inlet Design Coefficients
Table B-2: Coefficients for Inlet Control Design Equations

 
Unsubmerged

Submerged

Chart 
No.

Shape and 
Material

Nomograph 
Scale

Inlet edge 
description

FORM K M C Y

1 Circular Concrete 1 Square edge with 
headwall 1 0.0098 2 0.0398 0.67

2 Groove end with 
head wall 1 0.0018 2 0.0292 0.74

3 Groove end 
projecting 1 0.0045 2 0.0317 0.69

2 Circular CMP 1 Headwall 1 0.0078 2 0.0379 0.69

2 Mitered to slope 1 0.021 1.33 0.0463 0.75

3 Projecting 1 0.034 1.5 0.0553 0.54

3 Circular A Beveled ring, 45° 
bevels 1 0.0018 2.5 0.0300 0.74

B Beveled ring, 33.7° 
bevels 1 0.0018 2.5 0.0243 0.83

8 Rectangular Box 1 30° to 75° wingwall 
flares 1 0.026 1 0.0347 0.81

2 90° to 15° wingwall 
flares 1 0.061 0.75 0.0400 0.8

3 0° wingwall flares 1 0.061 0.75 0.0423 0.82

9 Rectangular Box 1 45° Wingwall flare, 
d=.0430 2 0.51 0.667 0.0309 0.80
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Reference Tables
2 18°-33.7° wingwall 
flare, d=.0830 2 0.486 0.667 0.0249 0.83

10 Rectangular Box 1 90° headwall with 
¾ chamfers 2 0.515 0.667 0.0375 0.79

2 90° headwall with 
45° bevels 2 0.495 0.667 0.0314 0.82

3 90° headwall with 
33.7° bevels 2 0.486 0.667 0.0252 0.865

11 Rectangular Box 1 ¾ chamfers; 45° 
skewed headwall 2 0.545 0.667 0.0505 0.73

2 ¾ chamfers; 30° 
skewed headwall 2 0.533 0.667 0.0425 0.705

3 ¾ chamfers; 15° 
skewed headwall 2 0.522 0.667 0.0402 0.68

4 45° bevels; ¾ 
skewed headwall 2 0.498 0.667 0.0327 0.75

12 Rectangular Box – 
¾ Chamfers 1 45° non-offset 

wingwall flares 2 0.497 0.667 0.0339 0.803

2 18.4° non-offset 
wingwall flares 2 0.493 0.667 0.0361 0.806

3
18.4° non-offset 
wingwall flares, 30° 
skewed barrel

2 0.495 0.667 0.0386 0.71

13 Rectangular Box – 
Top Bevels 1 45° wingwall flares 

– offset 2 0.497 0.667 0.0302 0.835

2 33.7° wingwall 
flares – offset 2 0.495 0.667 0.0252 0.881

3 18.4° wingwall 
flares – offset 2 0.493 0.667 0.0227 0.887

16-19 C M Boxes 2 90° headwall 1 0.0083 2 0.0379 0.69

3 Thick wall 
projecting 1 0.0145 1.75 0.0419 0.64

Table B-2: Coefficients for Inlet Control Design Equations (Cont’d)

 
Unsubmerged

Submerged

Chart 
No.

Shape and 
Material

Nomograph 
Scale

Inlet edge 
description

FORM K M C Y
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Inlet Design Coefficients
5 Thin wall projecting 1 0.034 1.5 0.0496 0.57

29 Horizontal Ellipse 
– Concrete 1 Square edge with 

headwall 1 0.01 2 0.0398 0.67

2 Groove end with 
head wall 1 0.0018 2.5 0.0292 0.74

3 Groove end 
projecting 1 0.0045 2 0.0317 0.69

30 Vertical Ellipse – 
Concrete 1 Square edge with 

headwall 1 0.01 2 0.0398 0.67

2 Groove end with 
head wall 1 0.0018 2.5 0.0292 0.74

3 Groove end 
projecting 1 0.0095 2 0.0317 0.69

34 Pipe Arch 18" 
Corner Radius CM 1 90° headwall 1 0.0083 2 0.0379 0.69

2 Mitered to slope 1 0.03 1 0.0463 0.75

3 Projecting 1 0.034 1.5 0.0496 0.57

35 Pipe Arch 18" 
Corner Radius CM 1 Projecting 1 0.0300 1.5 0.0496 0.57

2 No Bevels 1 0.0088 2 0.0368 0.68

3 33.7° bevels 1 0.003 2 0.0269 0.77

36 Pipe Arch 31" 
Corner Radius CM 1 Projecting 1 0.0300 1.5 0.0496 0.57

2 No Bevels 1 0.0088 2 0.0368 0.68

3 33.7° bevels 1 0.003 2 0.0269 0.77

40-42 Arch CM 1 90° headwall 1 0.0083 2 0.0379 0.69

2 Mitered to slope 1 0.03 1 0.0463 0.75

3 Thin wall projecting 1 0.034 1.5 0.0496 0.57

Table B-2: Coefficients for Inlet Control Design Equations (Cont’d)

 
Unsubmerged

Submerged

Chart 
No.

Shape and 
Material

Nomograph 
Scale

Inlet edge 
description

FORM K M C Y
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Reference Tables
Headloss Coefficients for Junctions

These are typical headloss coefficients used in the standard method for estimating 
headloss through manholes and junctions.

55 Circular 1 Smooth tapered 
inlet throat 2 0.534 0.555 0.0196 0.90

2 Rough tapered 
inlet throat 2 0.519 0.64 0.0210 0.90

56 Elliptical Inlet Face 1 Tapered inlet – 
beveled edges 2 0.536 0.622 0.0368 0.83

2 Tapered inlet – 
square edges 2 0.5035 0.719 0.0478 0.8

3 Tapered inlet – thin 
edge projecting 2 0.547 0.8 0.0598 0.75

57 Rectangular 1 Tapered inlet throat 2 0.475 0.667 0.0179 0.97

58 Rectangular 
Concrete 1 Side tapered – less 

favorable edges
2 0.56 0.667 0.0466 0.85

2
Side tapered – 
more favorable 
edges

2
0.56 0.667 0.0378 0.87

59
Rectangular 
Concrete 1

Slope tapered – 
less favorable 
edges

2
0.5 0.667 0.0466 0.65

2
Slope tapered – 
more favorable 
edges

2
0.5 0.667 0.0378 0.71

Table B-2: Coefficients for Inlet Control Design Equations (Cont’d)

 
Unsubmerged

Submerged

Chart 
No.

Shape and 
Material

Nomograph 
Scale

Inlet edge 
description

FORM K M C Y
Bentley SewerGEMS V8i User’s Guide B-933



Inlet Design Coefficients
Table B-3: Typical Headloss Coefficients

Type of Manhole Diagram Headloss 
Coefficient

Trunkline only with no bend at the 
junction

0.5

Trunkline only with 45° bend at the 
junction

0.6

Trunkline only with 90° bend at the 
junction

0.8
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Reference Tables
Roughness Values—Manning’s Equation

Commonly used roughness values for different materials are:

Trunkline with one lateral

Small 0.6
Large 0.7

Two roughly equivalent entrance lines 
with angle < 90° between lines

0.8

Two roughly equivalent entrance lines 
with angle > 90° between lines

0.9

Three or more entrance lines

1.0

Table B-3: Typical Headloss Coefficients

Type of Manhole Diagram Headloss 
Coefficient
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Inlet Design Coefficients
Table B-4: Manning’s Coefficients n for Closed-Metal Conduits Flowing 
Partly Full

Channel Type and Description Min. Normal Max.

a. Brass, smooth 0.009 0.010 0.013

b. Steel

1. Lockbar and welded 0.010 0.012 0.014

2. Riveted and spiral 0.013 0.016 0.017

c. Cast iron

1. Coated 0.010 0.013 0.014

2. Uncoated 0.011 0.014 0.016

d. Wrought iron

1. Black 0.012 0.014 0.015

2. Galvanized 0.013 0.016 0.017

e. Corrugated metal

1. Subdrain 0.017 0.019 0.021

2. Storm drain 0.021 0.024 0.030
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Glossary

Alternative: A categorized data set that create scenarios when placed 
together. Alternatives hold the input data in the form of 
records. A record holds the data for a particular element 
in your system.

Aquifer: A sub-surface groundwater area used to model the 
vertical movement of water infiltrating from the 
subcatchments which lie above them. Aquifers also 
permit the infiltration of groundwater into the 
conveyance system, or exfiltration of surface water from 
the conveyance system, depending on the hydraulic 
gradient that exists.

Backflow: The backing up of water through a conduit or channel in 
the direction opposite to normal flow.

Basin: An area having a common outlet for its surface runoff.

Batch Run: A set of multiple scenarios that are computed together. 
This is helpful if you want to queue a large number of 
calculations, or manage a group of smaller calculations as 
a set.

bmp: File name extension for bitmap image files, which can be 
used as background layers in SewerGEMS V8i.

Branch: In Bentley SewerGEMS V8i, a series of connected 
elements. The Bentley SewerGEMS V8i calculation 
engine includes a heuristic routine that decomposes a 
network into its component branches, and each branch is 
solved independently using an implicit solver. Each 
branch comprises a series of connected elements. 
Elements with the same branch ID are solved together.

Calculation Options Profile: A set of calculation options associated with a specific 
scenario.

Flow (Captured): The portion of the inlet flow which actually drains into 
the catch basin. The captured flow is dependent on the 
inlet capacity of the catch basin.
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Catalog Pipes: User-defined re-usable data sets that define common 
physical characteristics of pipes.

Catch basin: The geographical area that "catches" the rainfall and 
directs it towards a common discharge point within the 
storm collection network.

Catchment: The area drained by a stream, lake or other body of water 
in a sewer or stormwater system. 

Channel: A channel refers to a channel that changes geometry from 
the upstream cross section to the downstream cross 
section. Channels can be used to model natural streams or 
swales which are not prismatic in cross section. Channels 
must have a cross section element at each end and 
properties are interpolated along the channel.

CN: SCS Curve Number

Collection: Bentley SewerGEMS V8i uses the term Collection to 
identify some fields where you enter a set of data instead 
of a single value. To use this feature, click the field in 
which the word Collection appears, then click the 
Ellipsis (…) button to open a dialog box into which you 
enter data.

Composite Hydrograph: A graph of the total flow over time from multiple defined 
fixed/unit loads, hydrographs, and pattern loads.

Conduit: An open- or closed-section element through which water 
moves. A conduit has a constant roughness and cross 
section shape along its entire length. In Bentley 
SewerGEMS V8i, a conduit can refer to any prismatic 
channel or pipe that conveys flow. The cross section of a 
conduit must remain constant from one end to the next.

Cross Section Node: An element which is perpendicular to flow across a 
channel.

DD: Excess duration rainfall.

Diurnal Curve: A pattern that relates to the changes in loads over the 
course of the day, reflecting times when people are using 
more or less water than average.

Drag: Dragging is an action you perform with the mouse to 
select items in the drawing pane. Click in the drawing 
pane, hold down the mouse button, and move the mouse 
to form a rectangle around the elements you want to 
select. After you have formed the rectangle around the 
items you want to select, let go of the mouse button.
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dwh: File name extension for the binary format file used by the 
SewerGEMS V8i Stand-Alone mode only. The .dwh file 
contains the drawing.

dxf: File name extension for Data Exchange File format 
image files, which can be used as background layers in 
SewerGEMS V8i. Dxf files store vector data for 
drawings typically produced in CAD programs.

Dynamic Manager: A dialog box that can be displayed floating above the 
workspace or attached (docked) to any one of the sides of 
the workspace.

Dynamic selection set: A selection created by running a query.

English: E-Q-TWU.S. customary units, such as inch or acre

Element Symbology: Refers to the way in which elements and their associated 
labels are displayed in Bentley SewerGEMS V8i You use 
the Element Symbology manager to manage element 
annotations and color coding.

Element Table: A read-only, predefined FlexTable that you can use to 
review data about a specific element type. There is one 
predefined table for every element available in Bentley 
SewerGEMS V8i.

E-Q-TW: Elevation-flow-tailwater rating curves

Extended Period Simulation:A calculation type where the model is analyzed over a 
specified duration of time.

FlexTable: A customizable table that lets you view input data and 
results for all elements of a specific type in a tabular 
format. You can use the standard set of FlexTables or 
create your own FlexTables to compare data and create 
reports.

Freeboard: The difference between the top of dam elevation and the 
water surface elevation.

gif: File name extension for Graphic Image Format image 
files, which can be used as background layers in 
SewerGEMS V8i.

GIS: Geographic information system

Global storm event: In Bentley SewerGEMS V8i, project-wide storm 
events, usually applied to catchments that do not use 
local rainfall. Project-wide global storm events are 
typically associated with Hydrology alternatives.
Bentley SewerGEMS V8i User’s Guide D-941



Gutter: An open-section element that models overflow. Gutters 
are used in Bentley SewerGEMS V8i only to model the 
water which exceeds the capacity of in catch basin inlet 
and must flow through a surface gutter to the next catch 
basin. A Bentley SewerGEMS V8i gutter can only 
receive water from a catch basin.

Hydrograph: A graph of discharge versus time.

Hyetograph: A graphical representation of rainfall intensity with 
respect to time.

Hyperlink: In Bentley SewerGEMS V8i, a link to an external file, 
such as an image or movie file, for the purpose of 
associating the file with a specific element.

Ia: Initial abstraction

ICPM: Interconnected Pond Modeling

IDF/I-D-F: Intensity-Duration-Frequency

Implicit Engine: One of two calculation engines available in Bentley 
SewerGEMS V8i. The implicit engine uses a four-point 
implicit finite difference solver which tends to be more 
stable than an explicit solver. The implicit engine in 
Bentley SewerGEMS V8i is based on the solver in the 
National Weather Service FLDWAV model.

Infiltration: Water that enters the system from the ground through 
defective pipes, pipe joints, connections, or manhole 
walls

Inflow: Inflow is specified at a manhole or wet well as the total 
amount of wet weather inflow.  Together with the 
infiltration along the pipes, the inflow forms the wet 
weather part of the sewer load.

Inflow Collection: A collection of any combination of fixed, hydrograph, or 
pattern inflows for an element.

Inlet flow: Flows added to the manholes, catch basins, ponds, and 
wet wells in your model, including runoffs from 
catchments, user input hydrographs, and flows from 
other sources, such as pumps.

inp: File name extension for SWMM v5 project files.

jpg: File name extension for image files produced using the 
Joint Photographic Experts Group (JPEG) standard. 
JPEG files, which can also have the file name extension 
jpeg, can be used as background layers in SewerGEMS 
V8i.
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Junction chamber: A structure in which flow can be mixed or split. In 
combined sewers systems, flow can be split between that 
going to treatment and that going to an overflow.

Ke: Entrance loss coefficient

Kr: Reverse flow loss coefficient

Land Uses: Categories of activities or land surface characteristics 
that are assigned to catchment elements. Examples of 
land use activities are residential, commercial, industrial, 
and undeveloped.

Manhole: Element that provides access to the system for inspection 
and maintenance. Manholes are usually installed where 
there is a change in horizontal (plan-view) pipe direction 
or pipe slope, where several pipes join, or where the pipe 
size changes.

mdb: File name extension for SewerGEMS V8i database files. 
The .mdb file contains all modeling data, and includes 
everything needed to perform a calculation. This file is an 
open access database format file and can be viewed and 
edited.

MrSID: File name extension for Multi-resolution Seamless Image 
Database format raster image files, which can be used as 
background layers in SewerGEMS V8i.

Orifice Coefficient: For stormwater openings, an orifice coefficient of 0.60 is 
often used.

Outfall: The ultimate termination points in a network.

Overflow: The flow lost when the water surface elevation at a 
manhole or other type of node is above the rim elevation 
or user-specified overtopping elevation.

Pattern: A series of multipliers which describe how the base load 
varies over time.

Pattern Load: A single average base load and a series of dimensionless 
multipliers used to delineate how the load varies over 
time.

Pattern Setup: In SewerGEMS V8i, a pattern setup allows you to match 
unit sanitary (dry weather) loads with appropriate loading 
patterns. Each scenario can use a different pattern setup, 
thus allowing you to model different loading alternatives 
for different extended period simulations.

png: File name extension for Portable Network Graphic 
format image files, which can be used as background 
layers in SewerGEMS V8i.
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Pollutograph: A plot of time vs. concentration or mass rate.

Pond outlet structure: A structure that allows flow to discharge from a pond.

Pressure junction: A connection between two or more pressure pipes of 
varying characteristics. Loads may enter a pressure 
portion of a network through a pressure junction.

Pressure pipe: In SewerGEMS V8i, a type of link element used to 
connect node elements in pressure portions of a network. 

Profile: A graph that plots a particular attribute across a distance, 
such as ground elevation along a section of piping. As 
well as these side or sectional views of the ground 
elevation, profiles can be used to show other 
characteristics, such as hydraulic grade, pressure, and 
constituent concentration. 

Pump: A structure in a wastewater system designed to add the 
energy (head) necessary to overcome elevation 
differences and head losses.

Q: Flow

Query: A SQL expression you build in Bentley SewerGEMS V8i 
to filter a FlexTable or create a selection set.

Sanitary Flow Collection: A collection of loads that contains any combination of 
hydrograph, unit, or pattern loads.

Sanitary Load: A load that results from human activity and are not 
weather-dependent.

Scenario: A set of input data (in the form of alternatives), 
calculation options, results, and notes associated with a 
set of calculations. Scenarios let you set up an unlimited 
number of "What If?" situations for your model, and then 
modify, compute, and review your system under those 
conditions.

Selection Sets: User-defined groups of network elements that let you 
predefine a group of elements to manipulate together.

shp: File name extension for shapefiles, which you can import 
as background layers for your model.

SI: International System of units or metric units.

Static selection set: A selection set created by selecting a group of elements 
in your model.

Storm event: In Bentley SewerGEMS V8i, a single rainfall curve that 
represents one rainfall event for a given recurrence 
interval.
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swg: File name extension for SewerGEMS V8i project files. 
The .swg file contains data such as annotation, color-
coding, and project-level options. This file is an open 
.xml format file and can be viewed and edited.

SWMM Engine: One of two calculation engines available in Bentley 
SewerGEMS V8i. The SWMM engine uses the solver 
from the EPA Stormwater Management Model version 5. 
This is an explicit solver which, while more prone to 
stability problems, exactly matches the results from 
SWMM 5.

Tc: The time of concentration (Tc) is the time it takes for 
runoff to travel from the hydraulically most distant part 
of the watershed subarea to its outfall point. It is 
computed by summing the times it takes the water to 
travel through the different components of the subarea 
drainage system. 

tiff: File name extension for Tagged Image File Format raster 
image files, which can be used as background layers in 
SewerGEMS V8i. The extension .tif is also used for these 
types of files.

Unit Hydrograph: A time versus flow curve that represents a one-inch 
volume of rainfall for a given excess duration of rainfall, 
DD, for a set watershed area.

Unit Sanitary Load: Loading unit count representing the local count of 
loading units for a specified unit dry weather load.

User data extensions: A set of one or more attribute fields that you can define to 
hold data to be stored in the model. User data extensions 
allow you to add your own data fields to your project.

User Notifications: Messages that appear after you compute your model. 
These messages can help you troubleshoot errors in your 
model.

Virtual Conduit: Virtual conduits are a special compatibility element 
included in Bentley SewerGEMS V8i to help modelers 
achieve fidelity between the Bentley SewerGEMS V8i 
model and other storm modeling solutions that model 
pumps and control structures such as weirs, orifices, and 
rating tables as network links. Virtual conduits are 
displayed in your model as dashed lines.
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Watershed: A watershed is a collection of catchments which outfall 
to the same point. In other words, for each storm in the 
selected design storm collection, a hydrograph is 
generated for each catchment. The sum of all those 
hydrographs is the watershed hydrograph.

Wet Weather Load: A load that is not related to rainfall activity, such as 
groundwater infiltration (water leaking into a pipe 
through cracks, joints, and other defects) and structure 
inflow (surface water entering a structure through the 
cover).

Wet well: A boundary condition between the pressure and gravity 
portions of a network. Wet wells serve as a collection 
point for gravity systems, and as an HGL boundary node 
for the pressure system. Dry loads can also enter the 
sewer network at these locations.
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A
active topology 110, 111, 319, 329, 333, 338, 345, 353, 358, 365, 373, 374, 378, 383, 401
active topology alternative 110
alternatives 89, 90

child 89, 90
merge 89

annotations
adding 124
deleting 125
editing 125
renaming 125

AutoCAD 219
commands 229
drawing synchronization 223
entities 228
rebuild figure labels 222
undo/redo 231, 232

AutoCAD mode 219
graphical layout 220
project files 223
toolbars 221

Autodesk 219
B
base alternative 89, 90
batch run 86
begins with 147
C
child

alternative 89, 90
scenario 83, 84

color coding
adding 127
deleting 128
editing 128
renaming 129

column headings
editing for FlexTables 144

composite travel time
definition 432

connection
synchronization 223, 224

contains 147
copying
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FlexTables 151
custom AutoCAD entities 228
custom filter 147
customize

drawing 222
customizing

FlexTables 148
D
data

organization 89
default units 39
delete

elements 226
profile 135

deleting
FlexTables 142

displaying multiple projects 34
drawing

setup (AutoCAD mode) 221
synchronization (AutoCAD mode) 223

drawing scale 38
DWG 223
E
editing

FlexTables 143
numerous elements at once 145

editing column headings
FlexTables 144

editing units
FlexTables 144

element
deleting 226
moving 230

element label project files 41
element labeling settings 41
elements

globally editing data in numerous elements 145
entities

change into pipe 233
in AutoCAD 228
to pipes 233

entity conversion 232
explode elements (AutoCAD mode) 229
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exporting
FlexTables 151

F
filter

resetting 147
filtering

criteria 147
FlexTables

copying data 151
customizing 148
deleting 142
editing 143
editing column headings 144
editing globally 145
editing units 144
exporting data 151
global editing 145
navigating in 144
ordering columns 146
printing 151
reports 151
saving as text 151
shortcut keys 144
sorting column order 146

G
general settings 35
global edit 145
global editing

FlexTables 145
global settings 35
graphical layout

AutoCAD 220
graphing

changing total time period 154
refresh 154

graphs
data 155
printing 155

I
import 234
initial conditions of networks 154
initial flow equals zero 154
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L
label

rebuilding (AutoCAD mode) 222
layer 225
layout

AutoCAD 220
pipe using entity 232

layout settings 36
M
merge

merge
alternatives 89

move
elements 230
labels 230

moving toolbars 22
N
native AutoCAD entities converting 232
navigating in a FlexTables 144
O
object reference not set to an instance of an object 154
opening an existing project 34
opening managers 23
operation 145
options 35
ordering

FlexTable columns 146
organize data 89
P
parent scenario 84
pipe

layout using entity 232
print preview

FlexTables 151
printing

FlexTables 151
profile

editing 134
profiles

animating 132
creating 133

project
files 223
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Project Properties dialog box 34
Q
quick filter 147
R
ranking

FlexTable columns 146
rebuild figure labels 222
redo 231, 232
refresh 154
Remove

Columns 150
reports

FlexTables 151
reset 147

FlexTable filter 147
Reset Workspace 23
S
save

as drawing *.dwg 224
saving FlexTables as text 151
scenario 86

base 84
batch run 86

Scenario Management 82
Example 78

select
layer 225
text style 226

setting options 35
setup 221
shortcut keys

FlexTables 144
snap menu (AutoCAD mode) 231
sorting

FlexTable columns 146
starting a new project 34
symbol

visibility (AutoCAD mode) 222
synchronize (AutoCAD mode) 223
T
Table

Properties 149
Setup 149
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Symbols
Type 149
table

filtering 147
tables

column headings 144
editing FlexTables 143
units 144

Tc definition 431
text 230

style 226
theme folders

renaming 123
theme groups

deleting 123
time of concentration

definition 431
time of simulation 154
Tt definition 432
turning toolbars off 22
turning toolbars on 22
U
undo/redo operations in AutoCAD 231
units 39

editing for FlexTables 144
V
visibility of symbols 222
W
WCD file 223
white

table columns 143
window color settings 36
Y
yellow

table cells 143
Z
zero flow at time 0 154

Symbols

%u 542
.bak files 916
.dwh files 916
.mdb files 915
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A

.pdf 5

.swg files 915

A

about SewerGEMS 1
active 477
active topology 475, 477, 825, 836, 843, 847, 853, 860, 869, 872, 877, 881, 886, 896, 902, 908, 

912
active topology alternative 475
active topology child alternative 476
Active Topology dialog box 475
actual and plan length 268
actual and plan length as a function of slope 269
Add Hyperlinks dialog box 326
Add To Selection Set dialog box 280
adding annotations 541
adding background layers 532
adding color coding 545
adding elements 253
adding fixed loads 357
adding storm events 395
adding treatment to a node 321
adding unit hydrographs 411
adding user defined hydrographs 359
address

See contacting Bentley Systems. 7
Alternative Editor dialog box 474
Alternative Manager 473
alternatives 451, 471, 939

base 472
boundary condition 505
child 472
creating 472
defined 456
editing 472
hydrology 508
initial conditions 507
making elements inactive in 475
merge 471
overview 451, 471
physical 478
rainfall runoff 520
sanitary loading 526
types of 471
water quality 522
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A

analysis menu 16
animating profiles 550
Animation Control Manager 550
Animation Controls 556
Animation Options dialog box 551
Annotation Properties dialog box 543
annotations 537, 538, 543

%u 542
adding 541
deleting 542
displaying units 542
editing 542
renaming 542

antecedent runoff condition 801
Apply Sanitary Load to Selection dialog box 387
aquifers 298, 939
Aquifers dialog box 298
ArcCatalog 669
ArcEdit 668
ArcGIS

integration 667
ArcGIS applications 669
ArcInfo 668
ArcMap 669
ArcObjects 666
ArcView 667
attributes

editing 264
required for ponds 244
scenario 456

attributes for calculation profiles 433
AutoCAD 699, 709, 710

commands 705, 715
drawing synchronization 713
entities 705, 714
importing WaterCAD 707, 718
proxies 718
undo/redo 706, 707, 717

AutoCAD mode 11, 699, 709, 710
graphical layout 700, 711
menus 711
project files 712
toolbars 711

Autodesk 699, 709
automated scenario management 452
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B

B

backflow 939
background layer files

using with ProjectWise 161
Background Layer manager 529
background layers 529, 917

adding 532
deleting 532
dxf files 536
editing 533
image compression 535
renaming 533
shapefiles 535
supported image types 529
turning on and off 533
working with folders 531

backup files 916
base alternative 471
base alternatives 472
Base Calcuation Options 432
basin 939
basket handle shape 732
batch run 468, 939
Batch Run Editor dialog box 469
batch runs 468
Bend command 254
Bentley Institute Press 924
Bentley SELECT 3
Bentley Systems 919

about us 919
accreditations 925
addresses 6
contacting 6
email addresses 7
Haestad Methods products 919
program update 3
training 925
Web site 7

Bentley Wastewater 14
Border Editor dialog box 625
border properties for graphs 625
border tool 252
boundaries 744

external 745
internal 745
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C

boundary condition alternative 505
branced networks 721
branch 443, 939
branch labeling 723
branch ranking 722
branches 722
broad-crested weir 760
buffering point area percentage 695, 696
building a model 255
Bulletins 70/71 783, 786

C

C values 795
calculation detailed summary 440
calculation errors 448
calculation executive summary 439
calculation options 448, 449, 528

friction methods for pressure pipes 434
Calculation Options Manager 431
Calculation Options manager 431
Calculation Options Profile 939
calculation options tab 441
calculation profiles 431

attributes 433
creating 432

calculation report 439
calculation summary 439
calculation summary, SWMM 445
calculation warnings 448
captured flow 939
Carter 789
catalog pipes 291, 940
catch basin 940
catch basins 207

adding inflow-capture curve to 208
adding surface-depth area curves to 210
attributes 855
inflow alternatives for 517
physical alternative for 482
sanitary loading alternative for 526
surface storage 766
water quality alternatives for 523

Catchment Summary tab 442
catchments 238

adding a Tc method to 239
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C

adding unit hydrographs to 411
assigning an RTK table to 419, 422
attributes 889
characteristics of 407
defining CN Area collections for 387, 407
defining geometry of 243
hydrograph methods for 238
inflow alternatives for 518
rainfall runoff alternatives for 520
snowmelt 239
specifying initial pollutant buildup 323
Tc methods 239
water quality alternatives for 524

catenary shape 736
C-Depth Table 835
certification 925
change pipe width 704
Change Series Title dialog box 632
changing the drawing view 270
channels 940

and cross section nodes 206
attributes 840
defining roughness types for 201, 202
physical alternative for 498
split in 264
when to use 259

Chart Options dialog box 587
Chart Tab 587
Export tab 622
Print tab 624
Series Tab 613
Tools tab 621

Chart Tools Gallery dialog box 632
charts 916
child alternative

creating active topology 476
child scenarios 467
Circular 173 783
Circular 173 data 786
circular channel shape 731
circular unsubmerged orifice hydraulics 758
CivilStorm 2005 920
CivilStorm database file

importing 162
clearing element selection 262
CN 940

runoff 798
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C

runoff volume 799
CN Area Collection dialog box 389, 408
CN Area collections 387, 407
coefficients for inlet design 930
Collection 189
collection 940
collections

CN Area 387, 407
inflow 378
minor loss 196
sanitary flow 390

color coding 545
adding 545
deleting 546
editing 546
renaming 546

Color dialog box 627
Color Editor dialog box 627
Color Map Tables 548
Color-Coding Properties dialog box 547, 657
column headings

editing for FlexTables 565
commands (AutoCAD mode) 705, 715
Compact Database Enabled option 148
Component 189
components menu 17
composite curve number equation 802
composite hydrograph 940
composite hydrograph data table window 376
Composite Hydrograph Window 376
composite hydrographs 376, 378
composite outlet structures

defining 213
orifice settings in 217
riser settings in 219
settings for 215
weirs settings in 221

Composite Outlet Structures dialog box 214
Compress Database command 23
compressing large database files 23, 148
computing runoff 811
Conduit Control Structure dialog box 193
conduit control structures

depth-flow curves in 195
functional settings for 194
orifice settings in 194
weir settings in 195
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C

conduit infiltration 356, 427
conduit shapes 729

natural reach shapes 741
conduits 940

attributes 825
defining a control structure in 192
defining as irregular channel 199
defining roughness type for 201, 202
physical alternative for 489
virtual 259
when to use 259

connected impervious area equation 802
connected impervious areas 801
connecting elements 255, 256
connecting pumps to wet wells 260
connection

synchronization 713
connections manager 173
connectivity

explicit 187
implicit 187

constant area 765
Constant Flow 502
constructing a query 332, 568
contacting Bentley Systems

email 7
fax 7
hours 7
mail 7
sales 6
technical support 6
telephone 7

continuity error 440
continuous patterns 361
contour 658, 659, 660

smoothing 659, 660
Contour Browser 658, 661
Contour Manager 657
Contour Plot 660
Contours 657
contracted weirs 759
Control Set dialog box 299
control sets 299
control sets formats 302
control structures

defining in conduits 192
copy 44
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D

copying
FlexTables 573

create Observed Data 585
Create Selection Set dialog box 277
creating

graph 578
creating a model 255
creating a query 330
creating alternatives 472
creating dynamic 277
creating global storm events 405
creating graphs 916
creating profiles 916
creating queries 332, 568
creating reports 575
creating sanitary flow collections 390
creating selection sets 277, 278
creating storm events 395
cross section nodes 940
cross sectional shapes of link elements 199
cross sections 211

attributes 873
controlling channel cross sections at 206
inflow alternatives for 518
physical alternative for 484
transitions types 877

CulvertMaster 923
culverts 754
cumulative rainfall curve storms 769
cumulative storm events 396
Curve 189
curve number

equation 802
curved pipes 254
custom AutoCAD entities 705, 714
customize

drawing 712
customizing

FlexTables 569
customizing graphs 645
cyclic time vs. elevation curves 226
Cyclic Time-Elevation Curve dialog box 226

D

data
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D

organization 471
data types for user data extensions 340
Database Utilities 23
DD 940
decimal point 267
default units 152
defining CN Area collections 387, 407
defining composite outlet structures 213
defining geometry of link elements 198
defining patterns 362
defining pump settings 229
defining sanitary flow collections 390
defining user data extensions 336
deleting

FlexTables 563
deleting annotations 542
deleting background layers 532
deleting color coding 546
deleting elements 263
deleting groups of elements in a selection set 280
deleting profiles 554
depression storage equation 812
Depth (Maximum Overtopping) 836
depth vs. area curves 228
Depth Width Curve dialog box 205
depth-area curve 764
depth-flow curves

in conduit control structures 195
design percent full 838
design storms 769
dialog boxes

rational rainfall curve—I-D-F 772
dimensionless rainfall curve settings 403
dimensionless rainfall curves 396

defining 404
Dimensionless Unit Hydrograph Curves Library Editor 426
Dimensionless Unit Hydrograph Dialog 422
directly connected impervious area 812
disconnect 264
display format 268
Display Precision 267
display precision 267
displaying multiple projects 146
diurnal curve 940
diurnal curves 361
dockable managers 42
downstream node 255
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E

dragging 940
drawing

scale 151
setup (AutoCAD mode) 712
synchronization (AutoCAD mode) 713

drawing scale 151
dry bed 727
dry weather flow collections 390
DWG 713
DXF file

exporting 169
DXF Properties dialog box 236, 277, 280, 404, 405, 536
dynamic inheritance 458
dynamic managers 941

E

e, b, d coefficients 769
equations 772

Eagleson 789
edit elements 704
Edit Hyperlink dialog box 327
edit menu 15
editing

FlexTables 564
numerous elements at once 566

editing alternatives 472
editing annotations 542
editing attributes 821
editing background layers 533
editing color coding 546
editing column headings

FlexTables 565
editing element attributes 264, 265
editing scenarios 467
editing units

FlexTables 565
egg shape 733
element

deleting 704
modify 704
moving 705, 716
relabel 266

element attributes 821
element connectivity 255
element connectivity table 256
Index-962 Bentley SewerGEMS V8i User’s Guide



E

element label project files 155
element labeling settings 155
element properties 702
element relabeling 572
element symbology 941
Element Symbology Manager 538

using folders in 540
element tables 574, 941
elements 191

adding data to link elements 192
adding in the middle of a pipe 263
adding inflow-capture curve to a catchment 208
adding to your model 253
catch basins 207
catchments 238
clearing selection of 262
connecting 191, 255, 256
cross sections 211
defining cross sectional shapes of link elements 199
defining geometry of link elements 198
deleting 261
editing attributes 264
globally editing data in numerous elements 566
junction chambers 211
link 191
manholes 209
moving 261
outfalls 222
overview 191
pond outlet structures 212
ponds 244
pressure junctions 212
pumps 229
reporting on 576
selecting 261
selecting all 262
selecting all of the same type 262
viewing in selection sets 276
wet wells 227

Elevation (Maximum Tailwater) 836
Elevation (Roadway Crest) 835
elevation volume curves 766
elevation vs. area 246

percent void space 248
elevation vs. area curves 249
Elevation vs. Area table 246
elevation vs. flow curves
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E

adding to outfalls 224
elevation vs. volume 247

percent void space 248
elevation vs. volume curves 250
Elevation vs. Volume table 247
Elevation-Area Curve dialog box 249
elevation-area curves 765
Elevation-Flow Curve dialog box 225
Elevation-Volume Curve dialog box 251
ellipse shape 732
email 7
email address 7
engineering libraries 289, 291

adding a storm event in 398
adding unit sanitary loads in 371
overview 288
sharing on a network 291
working with 289

engineering libraries dialog box 291
English units 941
Enhanced Pressure Contours 661
enhanced pressure contours 661
entering additional data to link elements 192
entering data 265
entering SWMM data 294
entities

in AutoCAD 705, 714
enumerated user data extensions 344
Enumeration Editor dialog box 344
EPA SWMM 238, 410

input parameters 414
EPA SWMM runoff method 433, 439
EQT curves

adding to outfalls 224
equations

composite curve number 802
connected impervious 802
Green and Ampt 813
Horton 814
impervious areas 812
peak discharge 805
pervious area 811
unconnected impervious 803

error messages 181
errors 446
Espey/Winslow 790
estimate storage 806
Index-964 Bentley SewerGEMS V8i User’s Guide



F

evaporation 297
Evaporation dialog box 297
Evaporation Type 297
explicit connectivity 187
explode elements (AutoCAD mode) 715
export 169, 170

x/y coordinates 181
exporting

FlexTables 574
exporting data 169

to a DXF file 169
to SWMM 5 169

exporting data to
shapefile 170

exporting FlexTables 573
extended period simulation 941
external boundary conditions 745
External Tool Manager 345

F

F1 4
FAA time of concentration 790
fax 7
feature class 666
Federal Aviation Agency 790
file menu 12
fill depth 830
filter

resetting 568
filtering a FlexTable 567
Find 265
finding elements 265
fixed loads

adding 357
Fixed Point 268
FlexTable dialog box 559
FlexTable Setup dialog box 570
FlexTables 557, 941

copying 573
copying data 573
creating 563
customizing 569
deleting 563
editing 564
editing column headings 565
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F

editing globally 566
editing units 565
exporting 573
exporting data 574
filtering 567
global editing 566
navigating in 565
opening 562
ordering columns 566
printing 573, 574
renaming 564
reports 574
saving as text 574
shortcut keys 565
sorting column order 566

FlexTables Manager 557
folders in 558

FlexTables manager 557
flooding conditions 728
fLoss rate 813
flow control structures 748

weirs 748
flow increment 165
flow roughness 744
FlowMaster 922
folders

in Background Layers Manager 531
in Element Symbology Manager 540
in FlexTables Manager 558

format
unit 267

formulae
See equations.

fourth-quartile distribution 784
freeboard 941
friction methods

Hazen-Williams 823
Kutters 824
Mannings 823

friction methods for pressure pipes 434
full flow capacity 838
functional settings of conduit control structures 194
fundamental solution of gravity flow system 719
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G

GEMS datastore 666
General 268
general settings 148
General Summary tab 443
generic unit hydrographs 808
geocode 666
geodatabase 666
geodatabase support 184
geometric network 185
geometry

defining for a catchment or a pond 243
of link elements 198
polygon vertices 243
polyline vertices 198

GeoTable 697
GIS 941
global edit 566
global editing

FlexTables 566
global rainfall runoff alternatives 520
global settings 147
global storm event 941
Global Storm Event Settings dialog box 406
global storm events 405

adding 405
gothic shape 737
Grade Inlet Hydrologic Rating Table 164
Gradient Editor dialog box 626
graph

copying and pasting data 579, 583
data 583
new 578

Graph dialog box 579
Graph Manager 577, 578
Graph Series Options dialog box 583
graph settings 583
graphical layout

AutoCAD 700, 711
graphing 578

changing total time period 579
refresh 578

graphs 577, 916
customizing 645
data 579
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printing 579
gravity flow system 719
gravity sewer systems

special hydraulic considerations of 724
Green and Ampt

equations 813
method 813

groundwater flow formula 895
group/cover type

A 799
B 799
C 799
D 799

Gutter Summary tab 445
gutter system

fundamental solution of 768
gutter system hydraulics 767
gutters 942

physical alternative for 500
theory 767
when to use 259

H

Haestad Methods
program update 3
training 925

Haestad Press 924
Has Overtopping Weir? 835
Hatch Brush Editor dialog box 628
Hazen-Williams

friction method 823
headloss 450
headloss coefficient

in minor loss collections 198
headloss methods

junctions 746
help menu 24
history of what-if analyses 452
horizontal variation of roughness 743
horseshoe shape 733
Horton

equations 814
method 814

hydraulic boundaries 744
external 745
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internal 745
hydraulic review 346
hydraulic review tool 346
hydraulics

of gutter system 767
hydrograph 942
Hydrograph Curve dialog box 428
hydrograph methods 238
hydrographs

adding based on RTK method 415
methods 807
SCS 809
unit hydrographs 411
user defined 359

hydrographs in the Inflow Collection Editor 269
hydrographs vs. pattern loads 358
hydrology 768
hydrology alternatives 508
hyetograph 942
hyperlinks 324, 942

adding 326
deleting 327
editing 327

Hyperlinks dialog box 324

I

ICPM 942
ICPM settings

in composite outlet structures 216
I-D-F 769, 786

curves 770
curves reading 771
data 770
e, b, d equations 772

I-D-F e, b, d equations 772
IDF storm events 396, 405
I-D-F tables 772
image compression 535
Image Filter 534
Image Properties dialog box 533, 917
impervious areas 801

connected 801
directly connected equation 812
unconnected 802

impliciit engine 438
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implicit connectivity 187
implicit engine 438, 942
Import

WaterCAD 707, 718
import 14, 189

Bentley Wastewater 166
WaterCAD 707, 718

importing
CivilStorm data 162
from SewerCAD 163
from StormCAD 164

importing data 162
inactive 477
inactive elements in alternatives 475
Increment 836
incremental storm events 396
independent papers 924
individual elements

adding to your model 253
infiltration 427, 428, 429, 502, 942
Infiltration (Average) 502
infiltration method 433, 439
inflow 353, 377, 380, 942
inflow alternatives

for catch basins 517
for catchments 518
for cross sections 518
for manholes 516
for outfalls 517
for ponds 518
for pressure junctions 519
for wet wells 519

inflow and infiltration
defining CN Area collections 387, 407

inflow collection 942
Inflow Collection Editor 269, 379, 942
inflow collections

defining 378
inflow control center 380
Inflow Control Center dialog box 380
inflow vs. capture curve 208
Inflow-Capture Curve dialog box 208
inflows 377, 380
inheritance 457, 459

dynamic 458
overriding 458

initial abstraction 799, 804
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initial buildup collection 894
Initial Buildup Collection dialog box 323
initial condition alternative

ponds 507
wet wells 508

initial conditions
specifying in Calculation Options 436

initial conditions alternative 507
initial conditions of networks 579
initial flow equals zero 579
inlet design coefficients 930
inlet flow 942
Inlet Flow Settings 165
Inline Depth-Flow Curve 237
inline depth-flow pump curve

settings for 235
Inline Head-Flow Curve 237
inline head-flow pump curve

settings for 235
inline variable speed pump curve

settings for 235
Inline VSD 237
in-line weirs 749
input parameters for unit hydrograph runoff methods 410
Intensity Duration Inlet Rating Definition 164
intensity storm events 396
intensity-duration-frequency curves 405
internal boundaries 745

culverts 754
flow control structures 748
manholes and sewer junctions 746
orifices 753

internal control stuctures
rating curves as 754

introduction 1
irregular channels 199
irregular closed section shape 739
Irregular Cross Section Dialog Box

accessing 213
irregular open channel shape 739
Irregular Weir Cross Section dialog box 222
irregular weirs 760

J

junction chambers 211
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attributes 905
physical alternative for 488

junction headloss methods 746

K

Kerby/Hathaway 790
Kirpich (PA) 791
Kirpich (TN) 791
knowledgebase 3
Kutters

friction method 824

L

land uses 311, 894, 943
Land Uses Collection dialog box 320
Land Uses dialog box 311

Land Use Buildup tab 312
Land Use tab 312
Land Use Washoff tab 317

layer 667
layout

AutoCAD 700, 711
layout settings 149
layout tool 253
length and velocity 791
lessons 5
library types 289
Like operator 334
line tool 252
link element

defining geometry of 198
link elements 191

defining cross sectional shapes of 199
entering additional data to 192

LoadBuilder 354, 393, 679
manager 680
run summary 691
wizard 680

loading 353
adding fixed loads 357
CN Area collections 387, 407
defining inflow collections 378
hydrographs vs. pattern loads 358
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methods for 353
patterns 360
types of loads 356
user defined hydrographs 359

looped networks 721
low flow conditions 727

M

mail 7
manholes 209, 943

adding surface-depth area curves to 210
as internal boundaries 746
attributes 848
inflow alternatives for 516
physical alternative for 480
sanitary loading alternative for 526
surface storage 766
water quality alternatives for 523

Manning’s equation 742
Manning’s n coefficient table 927
Manning’s n vs. Depth curves 201
Manning’s n vs. Flow curves 202
Manning’s n-Depth Curve dialog box 202
Manning’s n-Flow Curve dialog box 203
Mannings

friction method 823
maximum flow 165
merge

merge
alternatives 471

metadata 667
methods of entering loads 353
minimum time of concentration 789
minor loss collection 196
Minor Loss Collection dialog box 197
minor losses 747
mixed flow 726
model calculations

troubleshooting 448
ModelBuilder

connections manager 173
errors and warnings 181
preparing to use 172
supported formats 171
using 171
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ModelBuilder wizard 175
modeling a split 264
modeling weirs in conduits 260
modified basket handle shape 737
Modified Rational Method 796
modified rational method 238, 410, 427
move

elements 705, 716
labels 705, 716

moving elements 262
moving rainfall from a catchment 260
moving toolbars 39
multiple elements

selecting 262
multiple projects

maximum number of 146
multi-select data sources 180

N

naive method 818
named views 43, 661
natural reach shapes 741
navigating in a FlexTables 565
Network Navigator 281
Node Summary tab 444
Number 268

O

Observed Data 584
Offline Volume-Flow Curve 236
offline volume-flow pump curve

settings for 235
online book 5

See also .pdf.
online help 4
open channel

when the water level exceeds the top elevation 206
opening an existing project 146
opening managers 39
operation 566
options 147

drawing 151
global 147
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labeling 155
project 150
ProjectWise 156
setting 147
units 152

Options Dialog Box
ProjectWise settings 156

ordering
FlexTable columns 566

organize data 471
orifice area unsubmerged hydraulics 758
orifice coefficient 943
orifice hydraulics 757, 758
orifice orientation 758
orifice settings

in conduit control structures 194
orifice settings for composite outlet structures 217
orifices 753, 757
outdoor ponds 246
outfalls 222

adding cyclic time vs. elevation curves to 226
adding elevation vs. flow curves to 224
adding EQT curves to 224
adding tidal curves to 223, 226
adding time vs. elevation curves to 223
attributes 864
boundary condition alternative 505
inflow alternatives for 517
physical alternative for 483
water quality alternatives for 524

outlet structures
for ponds 212

output
tables 557

overbank segments 743
overflow 728, 943
overriding inheritance 458
overtopping 761

P

Pan tool 270
panning 270

using a mousewheel to 270
parabola shape 741
parent scenario 467
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paste 44
pattern 943
pattern load 943
pattern loads 360
pattern setup 943
pattern setups 365
Pattern Setups dialog box 366
patterns 361

continuous 361
defining 362
stepwise 361

Patterns dialog box 363
peak discharge (Qp)

equation 805
peak discharge rate 794
percent connected impervious area 389, 409
percent unconnected impervious area 390, 410
percent void space 248
physical alternatives 478

for catch basins 482
for channels 498
for conduits 489
for cross sections 484
for gutters 500
for junction chambers 488
for manholes 480
for outfalls 483
for pond outlet structures 484
for ponds 501
for pressure junctions 488
for pressure pipes 503
for pumps 478
for wet wells 487

physical characteristics of ponds 244
Pipe Catalog dialog box 291
pipe infilitration 427
pipe length 268
pipe volume 766
pipe volumes 248
pipe-arch shape 735
pipeline infiltration 427
pipes

modeling with curves 254
splitting 263

plane sweep 819
Pointer dialog box 631
pollutant buildup 323
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Pollutant Results dialog box 310
pollutants 305
Pollutants dialog box 305
pollutograph 944
Pollutograph Collection dialog box 310
Pollutograph dialog box 308
pollutographs 307

adding to a node 307
polygon vertices 243
polygonal elements

defining geometry of 243
polyline vertices 198
Polyline Vertices dialog box 198
pond and swamp adjustment factor 805
Pond Infiltration 502
pond infiltration 429
pond outlet structures 212

attributes 871
composite 213
physical alternative for 484

pond volume 249, 250
equation for calculating 248

pond volumes 765
PondPack

upgrade 3
ponds 244

adding elevation vs. area curves to 249
adding elevation vs. volume curves to 250
attributes 898
defining geometry of 243
elevation vs. area 246
elevation vs. volume 247
inflow alternatives for 518
initial condition alternative 507
outdoor ponds 246
overview 244
percent void space 248
physical alternative for 501
rainfall runoff alternatives for 521
required attributes 244
required attributes for 245
storage estimates TR-55 806
volume function for 766
volume options for 244
water quality alternatives for 525

power shape 741
predefined queries 283, 328
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pressure junctions 212
attributes 910
inflow alternatives for 519
physical alternative for 488
sanitary loading alternative for 527

pressure pipes
adding a minor loss collection to 196
attributes 821
physical alternative for 503
selecting default friction method for 434

pressurized flow 724
print preview

FlexTables 574
Print Preview Window 656
printing

FlexTables 574
printing FlexTables 573
printing graphs 579
proejct queries 328
profile 944

editing 553
Profile Setup dialog box 554
Profile Viewer dialog box 555
profiles 548

animating 550
creating 552
deleting 554
renaming 554
viewing 549

Profiles manager 549
project

files 701, 712, 713
project files 915

needed to send model to another user 916
project inventory 575
project properties 146
Project Properties dialog box 146
projects 146
ProjectWise 13, 156

closing projects 158
general guidelines for using 158
guidelines 158
performing operations 159
using background layer files with 161
using with CivilStorm 158
using with SewerGEMS 158
viewing status 159
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ProjectWise options 156
properties

editing 264
Property Editor 265, 821

using Find Element 265
prototypes 285

creating 286
prototypes manager 287
proxies 718
publications 924
pump curve definitions 231
Pump Curve Definitions dialog box 233
Pump Curve dialog box 236
pump curve types 232
pump curves

types of 231
pump definition types 763
pump settings 229
pump station configuration 763
pump types 236
pumps 229

attributes 879
connecting to wet wells 260
defining settings for 229
defining the suction-side node 881
in SWMM 439
physical alternative for 478
types of 236

Pumps dialog box 230

Q

Q 944
quartile distributions 785
queries 327, 332, 568

creating 330
in FlexTables 567
predefined 328
project 328
shared 328
using Like operator in 334

Queries Manager dialog box 328
Query Builder dialog box 332
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R

rainfall 769
24-hr. distributions 778
antecedent runoff condition 801
curves 773
dimensionless depth and time curves 780
dimensionless depth and time distribution 778
dimensionless depth distribution 778
duration 773, 784
gauged storms 773
hydrographs 776
intensity 773
peak discharge 803
runoff computations SCS/SBUH 811
SCS 769
SCS distributions 778
synthetic curves 783
synthetic distributions 777
tables 776

Rainfall Curve Dictionary 404
Rainfall Curve Dictionary dialog box 404
Rainfall Curve Import Setting dialog box 403
rainfall curves 395

definition 774
gauged 773

Rainfall derived infiltration and inflow 394
rainfall derived infiltration and inflow 354
rainfall runoff alternatives 520

for catchments 520
for ponds 521
for wet wells 522
global rainfall 520

ranking
FlexTable columns 566

rating curves 754
Rational design storms 769
Rational method 794

flow equation 794
Rational Method IDF Curve dialog box 405
Rational method storms 769
RDII 354, 394
reconnect 264
rectangular channel shape 738
rectangular weirs 749, 759
rectangular-rounded shape 740
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rectangular-triangular shape 740
redo 706, 707, 717
references and textbooks 924
refresh 578
relabeling elements 266
relational database 667
Remove

Columns 571
removing elements from selection sets 280
renaming

FlexTables 564
renaming annotations 542
renaming background layers 533
report

calculation 439
calculation summary 439

report menu 24
report options 576
reporting

on a group of elements in a selection set 280
reports 575

creating for elements 576
FlexTables 574
scenario 575
standard 575

reset
FlexTable filter 568

Reset Workspace 39
results files 915
riser settings for composite outlet structures 219
Roadway Cross Section Length 835
Roadway Weir Coefficient 835
roughness models 742

implementations of 743
roughness type

defining for conduits and channels 201, 202
rounding of numbers 267
RTK method 415

assembling RTK parameters 417
best use of 416
creating an RTK table 418

RTK methods
procedure for developing hydrographs for 817
theory 815
three processes of 816

RTK table
assigning to a catchment 419, 422
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creating 418
RTK Tables dialog box 420
RTK unit hydrograph method 238
runoff

curve number 798
SCS equation 797

runoff method 410
runoff volume 799

equations 799

S

sales 6
Sanitary (Dry Weather) Flow Collection Editor 391
sanitary flow collection 944
sanitary flow collections

defining 390
sanitary load 944
sanitary load control center 387
sanitary loading 354

unit sanitary loads 368
sanitary loading alternative 526

for catch basins 526
for manholes 526
for pressure junctions 527
for wet wells 527

save
as drawing *.DWG 714

saving FlexTables as text 574
SBUH 811
scaling background layer images 917
scenario example 461
Scenario Management 465

Example 461
Scenario Manager 469
scenario summary 575
scenarios 451, 944

advantages of using 452
attribute inheritance 459
attributes 456
base 467
batch run 468
calculation options for 528
creating new 467
editing 467
inheritance 457
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local and inherited values in 459
overview 451, 454, 466

Scientific 268
SCS 238

peak discharge 803
runoff 797
soil groups 799

SCS Curve Number 387, 407
SCS distributions by type 778
SCS lag 792
SCS rainfall distributions 778
SCS Runoff

equation 797
SCS Unit Hydrograph 769

peak discharge equations 810
SCS Unit Hydrograph method

defined 809
SDE 186
section hydraulics 729

conduit shapes 729
Section Results dialog box 206
select boundary polygon feature class 695
Select in Drawing button

in Query Manager 329
select the point 695
selecting all elements 262
selecting an element 262
selecting elements

all of the same type 262
selecting multiple elements 262
selection 477
Selection by Query dialog box 278
Selection Set Element Removal dialog box 280
selection sets 273, 274, 277, 280, 944

adding a group of elements to 279
adding elements to 279
creating 277, 278
creating from queries 277
group-level operations 280
in FlexTables 561
removing elements from 280
viewing elements in 276, 277

Selection Sets Manager 274
Selection tool 33
semi-circular shape 736
semi-ellipse shape 734
sending your model to another user 916
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Set Field Options dialog box 267
setting the outflow node for a catchment 260
setup 712
sewer junctions 746
SewerCAD 921

importing data from 163
SewerGEMS

about 1
features 1
what is it for? 1

SewerGEMS project files 915
shapefile

defined 667
Shapefile Properties dialog box 535
Shared Field Specification dialog box 343
shared queries 328
sharing engineering libraries on a network 291
sharp crested weirs 260
shortcut keys

FlexTables 565
SI 267, 944
single roughness value 743
smoothing contours 659
snap menu (AutoCAD mode) 706, 716
snowmelt 239
software

upgrades 3
Soil Conservation Service

See SCS.
soil groups 799
solvers 438
sorting

FlexTable columns 566
spatial data 186
spatial database engine 186
specifying initial conditions 436
split 264
splitting pipes 263
St. Venant equation

application in branched and looped networks 721
standard reports 575
starting a new project 146
Station-Elevation Curve dialog box 200
station-elevation curves 199
steep reaches 728
stepwise patterns 361
STMC import 164
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storage elements 244, 764
storm event 944
Storm Event dialog box 403
storm events 406

adding 395
adding global storm events 405
adding in engineering libraries 398

Storm Events dialog box 399
StormCAD 922

importing data from 164
storms

gauged 773
Rational design 769
SCS 769

stormwater flow 354, 394
submerged orifice hydraulics 757
submergence correction 761
subtypes 186
suction-side node

defining for pumps 881
summary 445
supercritical 450
support 6

addresses 7
hours 7

suppressed weirs 759
surface depth vs. area curve 210
Surface Depth-Area Curve Editor 210
surface storage 766
surface system 767
Surface-Depth Area Curve dialog box 210
SWG file 713
SWMM 439, 445

adding treatment to a node 321
aquifers 298
control sets 299
control sets formats 302
evaporation 297
input data 294
land uses 311
pollutants 305
treatment expressions 321

SWMM 5 exporting to 169
SWMM engine 438, 945

differences with implicit engine 438
SWMM hydrology 296
symbol
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visibility (AutoCAD mode) 712
sync 181
synchronize (AutoCAD mode) 713
synchronize existing model 174
synthetic curve 770
synthetic rainfall curves 783
synthetic rainfall distributions 777

T

Table
Properties 570
Type 570

table
setup 570

tables 44
column headings 565
editing FlexTables 564
Manning’s n coefficients 927
units 565

tabular report 557
Tc 427
Tc Data Collection dialog box 239
Tc definition 945
Tc methods 240
Tc methods for catchments 239
technical journals 924
technical support 6
TeeChart Gallery dialog box 644
text 705, 706, 716
text height 152

multiplier 151
text tool 252
The 925
theme folders

renaming 541
theme groups

deleting 541
theory 719

branched and looped networks 721
fundamental solution of gravity flow system 719
gutters 767
hydraulic boundaries 744
hydrology 768
of RTK method 815
roughness models 742
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section hydraulics 729
special hydraulic conditions 724

Thiessen polygon generation 691
Thiessen Polygon Generation Theory 818
third-quartile distribution 784
This 372
tidal curves in outfalls 223, 226
time of concentration 427, 787

Carter 789
definition 945
Eagleson 789
equation 787
Espey/Winslow 790
Federal Aviation Agency 790
Kerby/Hathaway 790
Kirpich (PA) 791
Kirpich (TN) 791
length and velocity 791
minimum 789
SCS lag 792
TR-55 channel flow 793
TR-55 shallow concentrated flow 793
TR-55 sheet flow 792
user-defined 789

Time of Concentration methods 239
time of concentration methods 239
time of simulation 579
Time Settings dialog box 402
time versus depth rainfall

See rainfall curves.
Time vs. Depth storm events 403
time vs. elevation curves 223
Time vs. Intensity storm events 403
time-depth curve 770
Time-Elevation Curve dialog box 223
toolbars 25

customizing 38
tools menu 22
total inflow vs. total captured flow 208
total N-R Iterations 440
TR-55

graphical peak discharge 803
pond storage estimates 806

TR-55 channel flow 793
equations 793

TR-55 shallow concentrated flow 793
TR-55 sheet flow 792
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training 925
transcritical flow 726
transition of circular pipe to the slot 725
transition types 877
trapezoidal channel shape 731
trapezoidal weirs 751
treatment

adding to a node 321
Treatment Collection dialog box 322
treatment collections 322
treatment expressions 321
TRex Wizard 348
TRex wizard 348
triangle shape 738
triangular weirs 752
troubleshooting 445, 448

knowledge database 3
turning background layers on and off 533
turning toolbars off 39
turning toolbars on 39
tutorials 5

See also lessons.
type

IA 778
type I 778
Type I pumps 764
type I, Ia, II, and III rainfall distributions 778
type II 778
Type II pumps 764
type III 778
Type III pumps 764
Type IV pumps 764
types of loads 356

U

U.S. customary 267
unconnected impervious area equation 803
unconnected impervious areas 802
undo/redo operations in AutoCAD 706, 717
Unit 267
unit discharge 804
unit hydrograph 238, 410, 945
Unit Hydrograph Data dialog box 412
unit hydrograph methodology 807
unit hydrographs 411
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computations 811
fLoss 813
Green and Ampt 813
Horton 814
methods 811
theory 807

unit loading 367
unit of measurement 267
Unit Sanitary (Dry Weather) Load dialog box 372
unit sanitary load 945
unit sanitary loading 367
unit sanitary loads 368

adding in engineering libraries 371
types of 368

units 152, 154
displaying in annotations 542
editing for FlexTables 565

units and formatting 267
updating PondPack via the Web 3
upgrade

PondPack 3
upstream node 255
Use Weir C-Depth Table? 835
user data extensions 335, 945

data types 340
enumerated 344

User Data Extensions dialog box 338
User Defined Hydrograph dialog box 359
user defined hydrographs 359
User Defined Tailwater? 836
User Notification Details dialog box 448
user notifications 445, 945
User Notifications Manager 446
user-defined hydrograph 410
user-defined unit hydrograph 269

V

variable speed pumps 764
vertical variation of roughness 744
vertices 198, 243
view

tabular 557
view menu 19
viewing elements in a selection set 276, 277
viewing profiles 549
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virtual conduits 945
virtual link types 742
virutal conduits 259
visibility of symbols 712
V-notch weirs 752, 760
volume function 765
volume options for ponds 244

W

warning messages 181
warnings 446
water level in an open channel 206
water quality alternatives 522

for catch basins 523
for catchments 524
for manholes 523
for outfalls 524
for ponds 525
for wet wells 525

WaterCAD 921
custom AutoCAD entities 705, 714

WaterCAD in AutoCAD 699, 709
WaterGEMS 921
watershed 946
watershed area 783
WCD file 701
Web updates 3
Website 7
weighted C values 795
weir discharge coefficient 749
weir settings

in conduit control structures 195
weir settings for composite outlet structures 221
weirs 260, 748, 751, 752

in-line 749
irregular 760
modeling in conduits 192
rectangular 759
theory 759
trapezoidal 751
types of 749, 759
V-notch 752, 760

weirs in conduits 260
welcome dialog 145
wet weather load 946
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Wet Well Depth-Area Curve dialog box 228
wet wells 227, 884

adding depth vs. area curves to 228
attributes 882
connecting to pumps 260
inflow alternatives for 519
initial condition alternative 508
physical alternative for 487
rainfall runoff alternatives for 522
sanitary loading alternative for 527
volume 764
water quality alternatives for 525

what is SewerGEMS? 1
white

table columns 564
window color settings 149
World Wide Web

See Web. 3

X

X/Y coordinates 181

Y

yellow
table cells 564

Z

Z Order 707
zero flow at time 0 579
zip files

using to copy or move project files 916
Zoom 272
Zoom Center 273
Zoom Center dialog box 273
zoom dependent visibility 544
Zoom Extents 271
Zoom Factor 273
Zoom In 271
Zoom Out 271
Zoom Previous

Zoom Next 272
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Zoom Realtime 272
Zoom Window 271
zooming 270, 273
element tables

See also predefined FlexTables
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